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AnTherm Help 
 

AnTherm®  
Analysis of Thermal behaviour of  

Building Constructions with  
Heat and Vapour Bridges 

 
 

AnTherm® is a powerful application used for the "analysis of thermal behaviour of building components with heat and 
vapour bridges". It calculates temperature distribution and heat flows and/or vapour diffusion flows in building 
structures of arbitrary form and complex material composition - particularly such with thermal bridges. It presents 
critical condensing air humidity (dew point) at all component's surfaces and shows the distribution of partial vapour 
pressure in component's interior. This application is also suitable for analysing dynamic behaviour of building 
components (for periodic, harmonic, transient boundary conditions). 
 
 
 
For the technically qualified designer, AnTherm is a reliable, indispensable tool in meeting the demands of the current 
European standards (EN) for evaluating thermal performance thoroughly and precisely. 
 
In particular the program allows the calculation of: 

 
 steady state (stationary) and transient calculation of temperature distribution of components in two- and three,  
 fully automatic calculation of the matrix of thermal coupling coefficients L2D or L3D, 
 completely automated calculation of linear thermal transmittance Ψ (psi)  
 transient periodic, harmonic calculation of the matrix of dynamic (harmonic) coupling coefficients (with the 

HARMONIC-Option),  
 fully automatic calculation of temperature weighting factors (fRsi, g) at coldest surface points of every spaces,  
 equally appropriate for very detailed modelling (e.g. facade constructions, window frames, ...) and for very large 

calculation cases (e.g. components at ground surface, complete spaces, groups of spaces, ...) ,  
 calculation and presentation of critical condensing air humidity (dew point) at all component's surfaces,  
 calculation and presentation of partial vapour pressure and, by comparing it to the saturation pressure, simple 

identification of condensation risk in component's interior (with the VAPOUR-Option),  
 extensive three dimensional graphical evaluation (visualization) also dynamically, under time dependant, periodic 

boundary conditions. 

 
AnTherm® is fully validated according to EN ISO 10211: AnTherm has been qualified as a "Class A precision tool" – as for 
two- and three-dimensional, steady state precision method. It also fulfils all requirements raised in EN ISO 10077 for the 
simulation program to qualify it as standard method for calculation of heat flow through frames of windows, doors and 
shutters. 
 
Daily experience gained so far by using the program AnTherm® have impressively proven, that the input, calculation and the 
evaluation part of the program satisfy highest demands regarding highest complexity of calculated components. 
 
Very high resolution (e.g. modelling at 1/10 mm ranges or less) as well as very large models (e.g. complete building 
assemblies or components in contact with ground) can be easily dealt with. 
 
Major strengths of that software, like unlimited number of elements, easy to control and flexible graphical evaluations 
even with very large computational cases, direct calculation of thermal coupling coefficients and temperature weighting 
factors, etc. have been implemented very carefully in AnTherm®. 

 

 

 

 

 

 

 

 

 

http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Introduction/81_Dampfdiffusion.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10077.htm
http://help.antherm.eu/Auswertungen.htm
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Essential properties of the program 
 

With respect to input data, AnTherm 

 

 facilitates the generation of geometrical models by supporting a graphic input display of building structures, as well as 
by providing an entirely independent, fully automatic method of fine subdivision (which can also be influenced by the 
user through manual manipulation of parameters).  

 delivers complete input model documentation (geometry of material elements, thermal design values of materials, 
spaces, heat sources...) upon request. 

 allows the precision of numerical solutions to be influenced and controlled by the user (definition of calculation 
parameters). 

 
Evaluation results yielded by AnTherm are conformant to European Standards and include: 

 
 generally applicable results in the form of g-values and conductance matrices. These conform to the 

temperature weighting factors and "thermal coupling coefficients" defined in the European Standards, 
including the required information on calculation precision.  

 specific results, applicable to particular air temperature conditions in spaces thermally coupled by the building 
components analyzed, in the form of surface temperature minima and maxima as well as respective dewpoints.  

 graphic plots and prints of isotherms, surface temperatures or temperatures along an edge (2- or 3-dim. 
models), as well as heat flow diagrams (not limited to 2-dim. models only, but also in 3D). 

 
Furthermore, fully automatic execution of calculation with AnTherm is given even in the event of poorly conditioned 
calculation cases. The maximum quantity of balanceable cells is nearly unlimited (many millions), thus making the 
thorough analysis of large, three-dimensional models feasible. Complex cases are given, for example, by 

 
 components or spaces in contact with ground.  
 entire spatial envelopes or groups of spaces.  
 detailed modelling of complicated assemblies (window frame and installation details, steel structures, etc.). 

 
The thermal performance of building assemblies with overall dimensions of up to app. 100 m can be simulated with 
AnTherm. 
Limitations to the scope of evaluation depend on the PC hardware implemented. 
 
 
 
 

http://help.antherm.eu/Install/Systemvoraussetzungen.htm
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http://help.antherm.kornicki.com/Introduction/65_Overrelaxation.htm
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http://help.antherm.kornicki.com/Introduction/81_Dampfdiffusion.htm
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http://help.antherm.kornicki.com/PrimaryConcepts/50_MethodOfAnalysis.htm
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Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 
 

4 
 

 Editing windows (Input windows) 
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http://help.antherm.kornicki.com/Forms/DescriptionForm/DescriptionForm.htm
http://help.antherm.kornicki.com/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.kornicki.com/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm
http://help.antherm.kornicki.com/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.kornicki.com/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.kornicki.com/Forms/LayerEditorForm/LayerEditorForm.htm
http://help.antherm.kornicki.com/Forms/JoinedMaterialsSurfacesForm/JoinedMaterialsSurfacesForm.htm
http://help.antherm.kornicki.com/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.kornicki.com/Forms/MaterialEditor/MaterialEditor.htm
http://help.antherm.kornicki.com/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.kornicki.com/Forms/BaustoffStammdatenForm/Baustoffkatalog_ON_V_31.htm
http://help.antherm.kornicki.com/Forms/BaustoffStammdatenForm/Baustoffkatalog_OeBox.htm
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http://help.antherm.kornicki.com/Forms/EcoTechBaustoffeForm/EcoTechBaustoffeForm.htm
http://help.antherm.kornicki.com/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.kornicki.com/Forms/SurfaceEditor/SurfaceEditor.htm
http://help.antherm.kornicki.com/Forms/JoinedTransformsForm/JoinedTransformsForm.htm
http://help.antherm.kornicki.com/Forms/TranslateForm/TranslateForm.htm
http://help.antherm.kornicki.com/Forms/StretchForm/StretchForm.htm
http://help.antherm.kornicki.com/Forms/RotateMirrorForm/RotateMirrorForm.htm
http://help.antherm.kornicki.com/Forms/RotateForm/RotateForm.htm
http://help.antherm.kornicki.com/Forms/MirrorForm/MirrorForm.htm
http://help.antherm.kornicki.com/Forms/ObliqueForm/ObliqueForm.htm
http://help.antherm.kornicki.com/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.kornicki.com/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.kornicki.com/Forms/RaportForm/RaportForm.htm
http://help.antherm.kornicki.com/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.kornicki.com/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.kornicki.com/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.kornicki.com/Forms/RadiationTemperaturesForm/RadiationTemperaturesForm2.htm
http://help.antherm.kornicki.com/Forms/PsiValueSimpleCalculatorForm/PsiValueSimpleCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/PsiValueThreeRoomsCalculatorForm/PsiValueThreeRoomsCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
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http://help.antherm.kornicki.com/Forms/RadiationTemperaturesForm/RadiationTemperaturesForm.htm
http://help.antherm.kornicki.com/Forms/Auswertefenster.htm
http://help.antherm.kornicki.com/Forms/TimelinesForm/TimelinesForm.htm
http://help.antherm.kornicki.com/Forms/ReportBuilder/ReportBuilder.htm
http://help.antherm.kornicki.com/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.kornicki.com/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/BoundaryConditionsForm/BoundaryConditionsForm_copy4auswertungen.htm
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http://help.antherm.kornicki.com/Forms/SurfaceTemperaturesForm/SurfaceTemperaturesForm.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
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http://help.antherm.kornicki.com/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.kornicki.com/Forms/RevolveTo3dParamsForm/RevolveTo3dParamsForm.htm
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http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
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http://help.antherm.kornicki.com/Datei/Import/Heat2_Import.htm
http://help.antherm.kornicki.com/Datei/Import/Heat3_Import.htm
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 Import/Export of Excel (XLS) File 
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 Settings file AnTherm.exe.Settings.xml 
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 On calculation of Ψ-values (Psi) for a 3 space case: Special consideration: Unheated Spaces 

 Heat Bridges by Heindl, Kreč, Panzhauser, Sigmund 

 On condensing humidity (dew point) 

 Calculating equivalent thermal transfer coefficient of air cavities 

 On calculation of Ψ-values for building constructions in connection with ground 

 Temperature factor fRsi 

 Multidimensional vapour diffusion processes 

 The air temperature in the unheated basement, a case study 

 Heat losses from large buildings through the ground 

 Methods of thermal heat bridge survey in international perspective 

 On three dimensional simulation of thermal behaviour of buildings 

 On visualization of heat and vapour diffusion stream in three dimensional models 

 The building envelope as thermal heat bridge 

 On the Storage of Heat in Building Components 

 Transient, multidimensional calculations by an example of components in contact with soil  

 Heat Transfer in Building Constructions in consideration of Heat Sources 

 A practical method for the assessment of heat bridges with a view to surface condensation 

 Appropriate responses to the complex problem of finding the cause for mould growth? 

 The concept of thermal conductance  

 Remarks to EN ISO 13786 

 Calculating the specific heat capacity of an equivalent component 

 The effective thermal heat capacity  

 Thermal conductivity and heat storage within planar components (slabs) 

 On the definition of the effective thermal heat capacity 
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 Modelling and Evaluation Tutorial 
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 Graphic results 

 Comparing Results under Different Conditions 
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http://help.antherm.kornicki.com/Theory/BERLIN_1997.htm
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http://help.antherm.kornicki.com/Theory/GI_1993_H1.htm
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http://help.antherm.kornicki.com/Theory/2007_Anmerkungen_zur_EN_ISO_13786_2000.htm
http://help.antherm.kornicki.com/Theory/2007_Berechnung_der_spezifischen_Waermekapazitaet_der_Ersatzkonstruktion.htm
http://help.antherm.kornicki.com/Theory/2007_Die_wirksame_Waermespeicherkapazitaet.htm
http://help.antherm.kornicki.com/Theory/2007_Waermeleitung_und_Waermespeicherung_in_plattenfoermigen_Bauteilen.htm
http://help.antherm.kornicki.com/Theory/2007_Zur_Definition_der_wirksamen_Waermespeicherkapazitaet.htm
http://help.antherm.kornicki.com/Tutorials/index.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/index.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/00_ObjectOfAnalysis.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/10_StagesOfAnalysis.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/2d/2d_00_TwoDimensionalAnalysis.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/2d/2d_10_GeneratingThe2dModel.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/2d/2d_20_CompletingTheTables.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/2d/2d_30_CompletingTheComponent.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/2d/2d_40_ObtainingBasicResults.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/2d/2d_50_GraphicResults.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/2d/2d_60_ComparingResults.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/3d/3d_00_ThreeDimensionalAnalysis.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/3d/3d_10_GeneratingThe3dModel.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/3d/3d_20_CompletingThe3dModel.htm
http://help.antherm.kornicki.com/Tutorials/tutor02en/3d/3d_30_EvaluationAndOutput.htm
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http://help.antherm.kornicki.com/Tutorials/tutor01/00_Start.htm
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 Methoden der Erfassung von Wärmebrücken im internationalen Vergleich (PDF) 
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Copyright 
 
 
 

Information in this document is subject to change without notice and does not represent a commitment on the part of the 
vendor or its representatives. 
 
No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, 
including photocopying, without the written permission of Tomasz Kornicki, Vienna A-1230. 
 
Products named herein may be trademarks of their respective manufacturers and are hereby recognized. Trademarked 
names are used editorially, to the benefit of the trademark owner, with no intent to infringe on the trademark. 
Acknowledgments and Additional Terms of Use 
 
Furthermore the License Terms and Conditions and General Business Terms and Conditions of Kornicki DL in EDV&IT in their 
latest valid version are valid. 
 

Copyright: © Kornicki Dienstleistungen in EDV & IT 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Legal/AdditionalTerms.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://members.chello.at/tkornicki/body/agb_DE.htm
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License Terms and Conditions of Use 
 

The Use of this Software Package is granted by terms and conditions of use shown below. Before opening the package or 
installing the Software you shall have read this contract carefully.  
By installing the Software Package this contract becomes legally binding. The Right of Use, Transfer or Copying is restricted 

by this agreement. 
 
The Software Package contains Data Processing Programs and the related Documentation. For both the term "Works" are 
used below. 
 
The Licensor and other third parties own property right on these Works. Related to property rights of third parties the 
Licensor has sufficient rights to use. Acknowledgments and Additional Terms of Use apply also. 
 
The Licensor grants to the acquirer (later called Licensee) the right to use the Works bound by following conditions: 
 
1. Right of Use 
 
a. Works shall be used on or in combination with only one and single workplace or computer. 
 
b. If Works are being processed or linked with other Works, these other Works shall also be used on only one and single 
workplace computer. 
 
c. Unchanged, processed or linked Works shall be copied in the machine readable or printed form only for the purpose of 
securing the data or to process the Works. Thus 1a also applies for such copies. 
 
d. Any further or different use is not allowed. 
 
2. Copyright Notice 
 
Each part of Works contains a Copyright Notice. Each Copy, each Processing and any Part oft Works, which are linked to 
other Works must show this Notice also. 
 
3. Transfer of the Right to Use 
 
a. The Licensee can transfer his limited Right to Use, which result from 1. and 2, in full to a third party only with additional 
written permission from Kornicki and only if this third party provides a declaration of accepting the terms and conditions of 
this license contract. This Terms and Conditions shall be explicitly pointed out to the third party. 
Kornicki will grant such a written permission, provided that the third party will oblige himself to update the Works to their 
newest available version on his expense and to cover any expenses of extending any Sublicenses to Full Licenses if 
applicable. The third party will also oblige himself to meet the costs of the transfer fee according to the then valid tariff list, 
payable to Kornicki.  
Performing the transfer all Rights to Use granted to the Licensee are terminated, also including all Copies, Processing and 
Linkages. Shall those be not transferred to the third party, they must be irrevocably destroyed. 
 
b. Transfer by the contract of any continuing obligation (e.g. rental, leasing) is prohibited. 
 
4. Acquisition of extended version of the Software Package 
 
Shall the Licensee extend, with these Works, an earlier version of Works or of Works linked to it, he is only granted the right 

to use this extended version. If nothing special has been separately agreed with the Licensor the Licensee is obliged to 

irrevocably destroy or delete all earlier versions and its copies, including the documentation, processing and linkages. 
 
5. Licensor cannot be made liable for the correctness of any processing. 
 
6. Additional terms for surrender of hardware dongles for the purpose of license activation 
 
If the Licensee has opted to activate the license by the means of hardware dongles (instead of binding to the network 
adapter of one computer) the agreement extends as follows: 
 
a. Hardware dongles shall be used only in connection with the use and activation of Works as set in 1. The licensee is 
entitled to install the Works on a maximum of 5 (five) computers but use the Works at one of them only (the one with the 
dongle installed). 
 
b. The hardware dongles and data stored therein are property of the Licensor (The Owner) must not be changed, 
manipulated, simulated, copied, transferred or sold without the consent of the owner. Shall agreement be terminated for 
any reason the Licensee will, at his own expenses and without any additional notice, return hardware dongles to the  
owner immediately. At any time the owner is entitled to claim the return of dongles within 14 days at expense of the 
Licensee. At any time the owner is entitled to check the proper use of hardware dongles in the premises of the licensee or 
by electronic means.  

http://help.antherm.eu/Legal/AdditionalTerms.htm
http://help.antherm.eu/Legal/Copyright.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 
 

10 
 

Loss or damage to the dongles must be reported to the owner immediately. The owner is entitled to charge a fee to the 

Licensee for such replacement. After the payment of the fee by the Licensee the Owner will attempt to replace the dongle as 

soon as possible. If necessary, the entire stock of the dongles at Licensee's hands must be returned to the owner 

immediately. 

 
 
c. With the handover of the dongles to the licensee or his representative or the dispatch to the transportation person, the 
risk goes to the licensee regardless of the fact who has paid for the shipment.  
In case the Licensor is responsible for defect of the hardware dongle, the Licensor is authorized for his election for remedial 
or replacement. Obvious deficiencies must be complained within 14 days after receipt of the hardware dongle. Shall no 
complaints be made within 10 working days after the arrival of dongles at their destination, they shall be deemed approved. 
The guarantee expires at interference, repairs or repair attempts by the Licensee or any unauthorized third parties. The 
transfer of warranty claims is excluded. Replaced parts will also be our property. Same warranties apply to replaced or 
repaired parts. If the Licensor is unwilling or unable for replacement, or at least three remedial fail, the Licensee is entitled to 
rescind the contract. It is expressly stated that due to the wide variety of configurations and the constant developments in 
the peripherals the proper function of dongle modules cannot be assured in each every case. If nothing else has been 
explicitly agreed any further claims by the Licensee - regardless of what legal grounds - are excluded. Licensor cannot is not 
liable for any damages other then the dongle itself, especially not for lost profits or other property damage. 
 
7. General Business Terms and Conditions 
 
The General Business Terms and Conditions of Kornicki DL in EDV&IT in the latest version apply for the rest. 
 
 
 Copyright: ©  Kornicki Dienstleistungen in EDV & IT 
 
 

http://members.chello.at/tkornicki/body/agb_DE.htm
http://help.antherm.eu/Legal/Copyright.htm
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Acknowledgments and additional Terms of Use 
Acknowledgment WAEBRU: 
 

(I)WAEBCOM is part of instationary WAEBRU only marginally related to WAEBRU Package. Interim integration into  
AnTherm “Codename Walter” granted by Dr.K.Krec/T.Kornicki. 

 

DONGLE - Compliance with the CE / FCC regulations (CE) 
 

The manufacturer of dongles has provided following statement: 
 
This equipment has been tested for and approved to comply with the limits for  Class B digital devices. The 
operation is subject to the following conditions: 
1. The device may not cause harmful interference radiation,  
2. The device must be able to process interference radiation, including such radiation which might lead to an undesired 
operation.  
The product meets the limits set in EN55022 Class B, EN50081-1, EN50082-1 and EN55024. 
A change to the product without express consent from the manufacturer, can cause the CE / FCC regulations are no  
longer being met. In such case the right to use the product by the Licensee extinguishes immediately. 

 

Copyright 
 

AnTherm® and all related works are Copyright: ©  Kornicki Dienstleistungen in EDV & IT 
 
 
 
Licence terms and conditions of use 
 

The use of this software package is bound by the License Terms and Conditions of Use. 
 
 

http://help.antherm.eu/Legal/Copyright.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
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 Validation according to EN ISO 10211:2007 
 

The program package AnTherm fulfils all requirements raised in EN ISO 10211:2007 for the simulation program to 
qualify it as two- and three-dimensional, stationary precise method („Class A – Method“). 
 
The EN ISO 10211 "Thermal bridges in building construction — Heat flows and surface temperatures — Detailed 
calculations" in its appendix A provides the validation procedure by which a "thermal bridges program" must conform to, to 
be qualified as "high precision method". The application package AnTherm conforms in its current version to all respective 
criteria specified by EN ISO 10211:2007 for "high precision calculation methods" and thus it qualifies as "two- and three-
dimensional steady-state high precision method (class A method)" 
 
Details of validation and benchmark results are put together the calculation report of validation examples from the EN 
ISO 10211:2007 by the application package Antherm. 
 
 Reference case 1 (two-dimensional; temperature distribution within "half of a square column")  

By the precision set within the standard (1 decimal place after comma) AnTherm provides exactly concordant 
results. By concerning uncertainties resulting from rounding there is full concordance of results calculated by 
AnTherm with values calculated analytically. 

 

 Reference case 2 (two-dimensional; temperature distribution and heat flow within a roof construction)  
This reference is considered shaky due to the temperature and heat flow calculation requirement within the junction 
made of a aluminium bracket nested within insulating material.  
By concerning uncertainties resulting from rounding there is full concordance of results calculated by AnTherm with 
values set in EN ISO 10211:2007. 

 

 Reference case 3 (three-dimensional; temperature distribution and heat flows through the wall-balcony junction) By 
concerning uncertainties resulting from rounding there is full concordance of results calculated by AnTherm with 
values set in EN ISO 10211:2007.  
The difference between heat losses of interior spaces α and β and gains of the exterior (space α) calculated by 
AnTherm and those specified by EN ISO 10211:2007 are smaller than 0.11 %. The requirement set in EN ISO 
10211, that differences of calculated heat flow values must not exceed 1%, is met by AnTherm in full. 

 

 Reference case 4 (three-dimensional; temperature distribution and heat flows within a three dimensional thermal 
bridge consisting of an iron bar penetrating an insulation layer)  
By concerning uncertainties resulting from rounding there is full concordance of results calculated by AnTherm with 
values set in EN ISO 10211:2007  
The difference of 0.43% between the calculated heat flow and the value set by the standard is below the allowed 
tolerance of 1% as required by the reference case; The temperature calculated at the hottest point at exterior surface 
deviates by 0.003K which is below the tolerance of 0.005K set by the standard for that reference case; the criteria are 
met in full by AnTherm. 

 
Read more here: 

 

 Details of validation can be found in the validation report. This report is located at the AnTherm's Web-Site. 

 

See also: Validation according to EN ISO 10077-2:2003, Main menu Help->Example Load... 
 

http://antherm.kornicki.com/Validierung.htm
http://antherm.kornicki.com/Validierung.htm
http://antherm.kornicki.com/Validierung.htm
http://antherm.kornicki.com/
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10077.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10077.htm
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Validation according to EN ISO 10077-2:2003 
 

The program package AnTherm fulfils all requirements raised in EN ISO 10077-2:2003 for the simulation program to 
qualify it as standard method for calculation of heat flow through frames of windows, doors and shutters. 
 
The EN ISO 10077-2:2003 "Thermal performance of windows, doors and shutters - Calculation of thermal transmittance - Part 
2: Numerical method for frames" in its appendix D provides the validation procedure by which a "thermal bridges program" 
must conform to, to be qualified as sufficient for the calculation of heat flow through frames conformant to the standards. 
The application package AnTherm conforms in its current version to all respective criteria and assessments specified by EN 
ISO 10077-2:2003 and thus it can be used as "standard method for calculation of heat flow through frames of windows, 
doors and shutters" 
 
Detailed validation and benchmark results are put collectively into the calculation report of validation examples from the 
EN ISO 10077-2:2003 with the application package Antherm. 
 
 Reference cases 1 through 7 (thermal conductance Lf

2D
 and thermal transmittance Uf of frame profiles)  

By concerning uncertainties resulting from rounding there is full concordance of results calculated by AnTherm with 
values set in EN ISO 10077-2:2003. 
The differences between thermal conductance Lf

2D
 calculated by AnTherm to those specified in the EN ISO 

10077:2003 stay below 1.1%. The requirement set in EN ISO 10077-2, that differences of calculated thermal 
conductance must not exceed 3.0%, is met by AnTherm in full.  
The differences between thermal transmittance Uf calculated by AnTherm to those specified in the EN ISO 
10077:2003 stay below 1.7%. The requirement set in EN ISO 10077-2, that differences of calculated thermal 
transmittance must not exceed 5.0%, is met by AnTherm in full. 

 

 Reference cases 8 and 9 (thermal conductance Lf
2D

 and transmittance U of profiles)  
By concerning uncertainties resulting from rounding there is full concordance of results calculated by AnTherm with 
values set in EN ISO 10077-2:2003. 
The differences between thermal conductance Lf

2D
 calculated by AnTherm to those specified in the EN ISO 

10077:2003 stay below 1.2%. The requirement set in EN ISO 10077-2, that differences of calculated thermal 
conductance must not exceed 3.0%, is met by AnTherm in full.  
The differences between thermal transmittance U calculated by AnTherm to those specified in the EN ISO 
10077:2003 stay below 0.5%. The requirement set in EN ISO 10077-2, that differences of calculated thermal 
transmittance must not exceed 5.0%, is met by AnTherm in full. 

 
 Reference case 10 (thermal conductance Lf

2D
 and linear thermal transmittance Ψ of glazing, spacer and frame 

compound)  
By concerning uncertainties resulting from rounding there is full concordance of results calculated by AnTherm with 
values set in EN ISO 10077-2:2003.  
The difference between the thermal conductance Lf

2D
 calculated by AnTherm to the value specified in the EN ISO 

10077:2003 stays below 0.2%. The requirement set in EN ISO 10077-2, that differences of calculated thermal 
conductance must not exceed 3.0%, is met by AnTherm in full. 

 
The difference between the linear thermal transmittance Ψ calculated by AnTherm to the value specified in the EN 
ISO 10077:2003 stays below 2.4%. The requirement set in EN ISO 10077-2, that difference of calculated linear 
thermal transmittance must not exceed 5.0%, is met by AnTherm in full. 

 
Read more here: 

 
 Details of validation can be found in the validation report. This report is located at the AnTherm's Web-Site. 

 

See also: Validation according to EN ISO 10211:2007, Main menu Help->Example Load... 
 

http://antherm.kornicki.com/Validierung.htm
http://antherm.kornicki.com/Validierung.htm
http://antherm.kornicki.com/Validierung.htm
http://antherm.kornicki.com/
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 
 

14 
 

 
 
System requirements 
 
Hardware requirements 
 

 Compatible PC  
 at least 512 MByte RAM ( ≥ 1 GByte for 3D-visualisation preferred)  
 200 MByte free space on disk  
 Screen resolution at minimum of 1280x1024 ( ≥ 1280x1024 preferred) - see below for further hint  
 Supporting 3D OpenGL graphics (minimum, optimum with 3D accelerated graphics board)  
 B/W Printer A4 (minimum, colour printer preferred)  
 Ethernet Network Adapter (for license identification) or the USB license dongle (purchased separately).  
 Mouse with two buttons and scroll wheel (preferred)  
 Internet connection (optional, eventually required during installation)  
 Multiprocessor/Multicore-processors (optional)  
 Anaglyph Red/Cyan Glasses (optional), Red/Blue Glasses (optional), Crystal Eyes Glasses and Display (optional), 

Dresden Interlaced Display (optional), VRex Interlaced 3D projector (optional) 
 
The license of this program is permanently bound to a special custom license dongle (USB) or to the MAC address of one 
physical Ethernet LAN card. The license key will be computed based on four customer specified text lines (header to all 
reports) and the MAC address. After you complete the purchase process the vendor will contact you via e-mail to obtain 
required data soon. 
 
See also: License terms and conditions 

 

Software requirements 
 

 Windows 10, MS Windows 8 (32bit or 64bit), Windows 7 (32bit or 64bit), Windows Vista (32bit or 64bit), 
Windows XP Professional  

 Microsoft® .NET 4.0 Runtime and .NET 3.5 Runtime installed (incl. V.2.0 and 3.0, will be automatically installed as a 
free option directly from Microsoft during the Setup). 

 
Microsoft®NET4.0 Runtime is no longer required (from AnTherm Versin10 on) 

 
 SAP Crystal Reports for Visual Studio 2010 runtime engine (will be automatically installed as a free option directly 

from SAP during the Setup) 
 A license to use the program AnTherm 

 
SAP Crystal Reports is no longer required (from  AnTherm Versin10 on) 

 
The installation has been thoroughly tested with Windows XP Professional, Windows Vista and Windows 7 and 8. The 
execution of the program on systems like Windows XP Home, Windows NT SP6 or Windows 2000 SP4 shall be possible 
with slight limitations. 
 
See also: Installation of the program, Installation of MS.NET Runtime, License terms and conditions 

 

Memory requirements and license capacity 
 

There is a 32-bit and a 64-bit version of AnTherm. 
 
The 32-bit version has a limit of the memory that can be employed. It is by (theoretically) by 3 GByte. This limit raised by 
the infrastructure applies even when the 32-bit version of AnTherm is executed on a 64-bit system (e.g. 
Vista/Win7/Win8 64bit).  
This technical limit allows solving of systems up to 20.000.000 equations and to receive resulting thermal heat 
conductance and numerical results of temperatures (160.000.000 nodes).  
The limitation for the memory intensive graphical evaluations is (currently) for models holding ca. 2.500.000 
equation cells (10.000.000 nodes). 

 

 

 

 

 

http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
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Optimal display resolution 
 

To comfortably work with AnTherm the display area available to the program shall be large enough. 
 
With AnTherm you receive a highly interactive visualisation application. Modern visualisation technologies used by the 
program, with their roots in the world of supercomputers, raise certain demands and requirements towards capabilities 
of display devices used. 
 
 

During long term experiences in use of the program it has proven, that the minimum requirement of 1280x1024 pixels 
display is the absolute minimum for comfortable interaction with the program - even if the whole display area is devoted 
only to AnTherm reaching some windows is only possible by scrolling. It is all but impossible to avoid overlapping of 
windows - even if the size of windows has been reduced up to the smallest limit, leading to very crowded working and 
output areas. 
 
Optimal interaction conditions start at the resolution of 1280x1024. At resolution of 1600x1200 there is enough space on 
screen for AnTherm and for windows from other applications allowing the user to keep good control of the desktop. 
 
Following graphics shall emphasize the relative sizes: 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

If you click on the picture above it will be shown in its original size on your screen (under certain 
conditions you will have to enable original size display in your browser). 

 
 
The picture below shows AnTherm's window at 1400x1050 pixels. This size is sufficient to comfortably work with the 
software because it provides enough space for all application windows:
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If you click on the picture above it will be shown in its original size on your screen  
(under certain conditions you will have to enable original size display in your browser). 

 
 
Therefore we ask you to consider these minimum requirements when choosing equipment for your workstation. 
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Short reference 
 

 Install the software AnTherm® - by installing the software you explicitly declare your acceptance of license term and 
conditions of use! You will also have to install the license file .  

 Start Antherm via Windows Start Menu Start→Programme→AnThern→AnTherm . To check if installation was 
successful please select Help→About.... 

 Press F1 key to show the application help.  
 If needed you can change the user interface language to English (Englisch) or German (Deutsch)!  
 Please consider also the additional dependencies of country specific localisation setting and the keyboard chosen. 

After changing these settings you will have to restart AnTherm to apply the changes.  
 Open and load some example project via the menu Help→Example Load... . Follow instructions contained in 

tutorials and learn quickly how to effectively use AnTherm. 
 Create your own, new project by selecting the menu File→New→xxx Project  
 Reveal most important data input/entry windows by selecting the menu View→Data Input & Entry→Primay Edit 

Windows  
 If you make a mistaken edit on your data revert your actions via Undo (Ctrl-Z) and Redo (Ctrl-Y) actions.  
 Periodically save your current input data by using the menu File→Save...  
 Request calculation results by selecting the menu Result... or depress the F5 key - after the calculation completes the 

thermal conductance matrix and calculation precision information will be shown.  
 Define boundary conditions (temperatures, power densities) and apply them. The program will find coldest surface 

points and respactive relative dew points together with fRsi values.  
 Create graphical evaluations in 3D (surfaces, slices, colour maps, isolines, streamlines, iso-surfaces and many, 

many more) and export them to other applications for further processing.  
 Finish and exit the program by selecting the menu File→Exit. 

 

Main menu: 

 
 File→New→2D Project: new 2D Model  
 File→New→3D Project: new 3D Model  
 File→New→Layered 3D Project: neues 3D Layered Model  
 File→Load: Open and load a AnTherm project file (also drag&drop of the file over the main window)  
 File→Save/Save As...: saving current project data into a AnTherm project file  
 File→Import→Waebru.?BT : import date from WAEBRU component file  
 File→Import→aCad.DXF: import data from specially prepared DXF file  
 File→Export→Conductance Matrix...: save the conductance matrix into a CSV file for further processing  
 File→Export→Report...: save a report into any of XLS, DOC, PDF, RTF compatible files  
 File→Exit: Finish and exit the application  
 Edit→Settings: application settings  
 Results… (or the F5 key): save project data, execute calculation, entry of boundary conditions, display of result and 

evaluation windows  
 View→Data Input & Entry→...Input windows: input and data entry/modification windows  
 View→Evaluation & Reports→...result and evaluation windows: various result and evaluation windows  
 Window→...: window navigation (MS-Windows specific)  
 Help→...various help: application information and application documentation 

Pressing F1 key shows application help also. 


VAPOUR-option: Analysis of multidimensional vapour diffusion is only possible 
                              with an active VAPOUR-Option of the program 

 
 
Input and data entry windows: Description, Element Editor, Materials, Surfaces, Element browser, Layers, Elements 2D, 
Snap grid, Translate, Rotate, Mirror, Stretch 
 
The context menu of element processing (by pressing the right mouse button over Elements 2D, Element Editor, Element 
browser): 

 
 Edit Element: Show the Element editing window.  
 Add→Append/After/Before Selected: Creates and adds a new element 
 Duplicate: Creates and adds an exact copy of the selected element.  
 Move (Order)→Relegate/Promote: reorders the position of selected element(s) within the element's list  
 Select→By Group/Type/Name/All: Selection of elements  
 Copy, Cut, Paste: Transfer elements to/from clipboard.  
 Undo (Ctrl-Z) and Redo (Ctrl-Y) your selection and editing actions 

http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Starten.htm
http://help.antherm.eu/Forms/frmAbout/frmAbout.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Lokalisierung.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Tutorials/index.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Import/WAEBRU_Import.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Import/DXF_Import.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.eu/Forms/SnapToGridParamsForm/SnapToGridParamsForm.htm
http://help.antherm.eu/Forms/SnapToGridParamsForm/SnapToGridParamsForm.htm
http://help.antherm.eu/Forms/SnapToGridParamsForm/SnapToGridParamsForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
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

Element browser window (use functions of the context menu of element processing - by pressing the right mouse button 
over this window): 

 
 Click in the list: Element selection. Selected element is shown in Elements 2D and Element Editor.  
 Double-click in the list: Element Editor will be shown.  
 Right mouse button: show the context menu of element processing. 

 
Element Editor: (use functions of the context menu of element processing - by pressing the right mouse button over this 
window - and a double-click over material or surface data will reveal Materials/Surfaces lists): 

 
 Use the TAB or Shift-TAB key to confirm data entered into the input field and to move the input focus between the 

fields and controls!  
 Use arrow keys when the element type input field is focused!  

Empty Box – excavating element. Elements „underneath“, i.e. listed earlier in the element list are overlapped with 
"Nothing". 
Material Box – a material cell has material properties, like conductance, assigned to it.  
Space Box – represents Space. A Space cell is used to assign "heat transfer coefficient" to the surface of the 
construction and then, during evaluation, to assign air temperature as the boundary condition for the space.  
Power Box – the Power-Box frame. Material elements „underneath“, i.e. listed earlier in the element list will be 
defined as power sources (in addition to its material property). These areas are then assigned power boundary 
condition during the evaluation.  

 Names of Spaces and Power Sources will be used to create the list of available boundary conditions during 
evaluation. 

 A double-click over material or surface data reveals Materials/Surfaces lists  
 Right mouse button: reveals the context menu of element processing.  
 Use the ENTER key while the button "Duplicate" is focused! 

 
Windows of Materials und Surfaces are used to prepare of the later needed (and reusable) properties of Materials- or 
Surfaces: 

 
 A double-click transfer the selected property onto (selected) element(s)  
 Right mouse button: Shows Material- or Surface properties and the Insert/Delete functions. 

 

Elements 2D Windows (use functions of the context menu of element processing - by pressing the right 
mouse button over this window): 

 
 Dragging with the mouse: pans the view  
 Turning the mouse wheel: scales (zooms) the view  
 Click onto an element's rectangle: element selection (single)  
 Double-click onto an element's rectangle: the Element Editor is shown.  
 SHIFT key held while dragging with the mouse: Element selection with a lasso.  
 Dragging the Edit mark: Changes the coordinates of the element according Snap-To-Grid settings. 

 
Layer browser window: selection and editing of a Layer in a Layered 3D Project 

 
 New/Delete: insert or delete a Layer  
 Move Up/Down: moves the selected layer within the list of layers  
 Click right mouse button: shows the context menu of layer editing functions  
 Click left mouse button selection of a layer from the list of layers. Element browser and Element 2D window will 

show elements of this selected layer. 

 Double-Click left mouse button: show Layer editing window. 

 

Elements 3D window: Is used for continuous visual verification during creation of 3D models. 

 
 Drag with the mouse: rotates and rolls the view following the Track-Ball principle. 

with CTRL-key held roll around the Z axis.  
with SHIFT-key held scales the view. 

 Fit: will show the whole construction in the window.  
 Brightening with More Light, Showing as Solid or as wire frame model  
 Transferring the view via clipboard to another application for further processing. 
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Boundary conditions window: Is used to enter boundary conditions for evaluation (e.g. temperatures). "Apply" start the 
superposition and the evaluation. 
 
Reports: Data Entry Report, Modelling Report, Result Report, Coupling Coefficients Report, Psi-Value Determination:  
Textual output of results 

 
 
 

 Menu File→Print: prints the report  
 Menu File→Export→Report: export/save the report as Acrobat PDF, Excel XLS, Word DOC  
 File→Export→Coupling Coeff. Matrix...: save the matrix of thermal coupling coefficients to a CSV file  
 Controls on the Toolbar: Zoom the display, print, export etc. 

 
Results 3D window: 3D visualisation of temperature distribution, heat stream density, heat stream and surface humidity. 

 
 Drag with the mouse: rotates and rolls the view following the Track-Ball principle. 

with CTRL-key held roll around the Z axis.  
with SHIFT-key held scales the view. 

 Fit: will show the whole construction in the window.  
 Evaluation views: model, isolines / isotherms, iso-surface, probe, slice X,Y,Z, streamlines, vector arrows, profile 

diagram  
 Secondary functions: Active (scalar) function and active vector field: temperature °C, heat stream density W/m², 

relative surface humidity %, saturated vapour pressure hPa, partial vapour pressure hPa, vapour pressure difference 
hPa, relative interstitial core humidity %, vapour stream density mg/m²h, vector field of heat stream W/m², vector field 
of vapour stream mg/m²h. 

 Collecting and interactively moving or picking points of interest  
 Colouring by given colour map, adjusted value range, and opacity/transparency, brightening with More Light  
 Representation as solid or wire frame model  
 Setting and quick restoring of 3D results evaluation parameters and isometrics  
 Transferring the view via clipboard to another application for further processing. 

 
Extensive introduction and introductory tutorials, collections of pictures. 
 
Validation according to EN ISO 10211:2007, Validation according to EN ISO 10077-2:2003 

Further study of theory and background and primary concepts together with related literature. 

Please accept licence terms and conditions including requirements related to copyright marks on printouts. 
 
 
 

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/FixedRange/FixedRange.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Introduction/Einfuehrung.htm
http://help.antherm.eu/Tutorials/index.htm
http://help.antherm.eu/Tutorials/Bilder/Bilder.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/PrimaryConcepts/BasicsAndSomeTheory.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
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Installation of the software 
 

Important note: By installing the software license terms and conditions are in force. 
 
Please check prior to the installation if the requirements for proper execution of this application are sufficiently met. 
 
Important: You will need administrative rights (user logon) which permit you to install software.  
Important: Internet connection might be required if prerequisite components must be downloaded automatically for the 
installation to complete. 
 
To install the program please start the installer Setup.EXE and follow the instructions displayed on the screen.  
Advice: If the software shall be run by different user than the one who installed it, then the installation for all users must be 
chosen (the choice has to be done within the dialog while selecting the installation folder)! If you wish to make the program 
available to all users of the workstation then please choose the option "All Users" at the related stage of the installation. 
 
Important: The end user (or system administrator) MUST use Setup.EXE to download and install all required prerequisites. 
Running the Setup.EXE supplied with the package automates all required download and installation steps. Re-Running the 
Setup.EXE will repair the installation and install prerequisites if needed too. 
 
After the installation completes successfully you can start the program and begin with your work. Learning the software is 
supported by tutorials (cook books). 
 
Important: After completing the installation you shall activate the license with your personalized license file 
AnTherm.HID - see License activation procedure . 

 
The installer will perform following steps automatically: 

 
 The installer Setup.EXE checks and installs additional runtime components prerequisite for the execution (e.g. 

".NET Runtime", "Crystal Reports Runtime") and copies all application files into the installation folder.  
 Note: During the installation of prerequisites the user will be asked to confirm each installed package and accept 

licence terms of the each.  
 Typically the installation folder is placed under "Program Files" folder of Windows (C:\Program 

Files\tkornicki\AnTherm). Example projects, documentation etc. is also copied to this folder.  
 During the installation the installer will add to the user's "Start Menu" (or to the start menu of all users) the menu 

item "Antherm" and submenus allowing the user to start the program an documentation browser.  
 Files with the extension ".antherm" will be associated as "AnTherm project". Later, a double click on the AnTherm 

project file will automatically start AnTherm. 

 
Important: It is possible that the installation script will ask you to install Microsoft® .NET runtime components also. This will 
only happen if these components have not been installed yet on your system. In the absence of the required version of 
MS .NET Runtime it is neither possible to install nor to execute the program. In such case please install runtime components 
by following the instructions displayed. When done restart the installation of AnTherm. Installing Microsoft®.NET runtime 
components is required even if higher version of .NET components is already installed. 
 
Important: If you received the installation package by downloading it, then make a backup copy of it on some 
additional media to have it available if needed later. 

 

Uninstalling the application 
 

To uninstall AnTherm use the System Control panel (Add/Remove Programs / Software). 
 
Note: Prerequisite runtime components installed can be removed via System Control panel only (Add/Remove Programs / 
Software). Uninstalling AnTherm will not automatically uninstall prerequisites which might be required for other 
applications also. 
 
See also: System requirements, Installation of MS.NET Runtime, Installation of Crystal Reports Runtime, License file 
AnTherm.HID, License terms and conditions, Country specific localization 
 
 
 

http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Starten.htm
http://help.antherm.eu/Tutorials/index.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Starten.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Starten.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Lokalisierung.htm
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Installation of MS .NET Runtime and further prerequisite components 
 

Running the Setup.EXE supplied with the installation package automates all required download and installation steps. 
Therefore there shall be no need for the user to bother about it manually. 
 
The explanation below gives you more background information in the case you decide to install prerequisites manually 
and under your full control. 
 
Remark: Directly running the AnTherm...MSI script (instead of Setup.EXE) will not install nor check most of its prerequisites 
thus the application will eventually fail in the case one or more prerequisite components are missing. Example 1: If 
prerequisite component of Crystal Reports is not installed showing any Report within AnTherm will lead to an Exception: 
"Could not load file or assembly 'CrystalDecisions.Windows.Forms, Version=10.5.xxx.... The system cannot find the file 
specified."  
Example 2: Running AnTherm...MSI installer directly will complain if .NET3.5 ist not installed yet and offer manual 
installation from some Microsoft site - internet browser will open showing several download and installation options the 
user has to choose on his own. 

 

Installation instructions for Microsoft® .NET Framework Version 3.5 and Version 4.0 
 

Links shown below will forward you to the download area and to detailed installation instructions of Microsoft® .NET 
Framework Version 3.5 and 4.0 (valid at the time of writing this section). 
 
Please note, that you must be logged on with an account of the user granted installation permissions. 
 
The language version shall be the same as of your operating system: 

 
 Original source of Microsoft related to .NET 4.0 Redistributable Packages (web bootstrapper)  
 or try Microsoft .NET Framework 4 (Standalone Installer) for offline installations (or this link 

alternatively) 
           and 
 Original source of Microsoft related to .NET 3.5 Redistributable Packages (web bootstrapper)  
 or try Microsoft .NET Framework 3.5 Service pack 1 (Full Package) for offline installation 

 
Alternatively you can choose Windows Update (windows menu Start → Windows Update) and then in the group "Custom 
Install/Optional Updates" choose .NET 3.5 and .NET4 installation. 
 
Important: Even if .NET4 is already installed the .NET2 (included in .NET3.5) must be also installed. 
 
Important: Microsoft® NET 4.0 Runtime is no longer required (from AnTherm Versin10 on) 



Installation instructions for SAP Crystal Reports (32bit /64bit) 

Links shown below will forward you to the download area and to detailed installation instructions of SAP Crystal Reports 
for Visual Studio 2010 runtime engine x86 (valid at the time of writing this section). 
 
Please note, that you must be logged on with an account of the user granted installation permissions. 
 
The language version shall be the same as of your operating system: 

 
Original source from SAP Crystal Reports for Visual Studio 2010 runtime engine  
 "START YOUR FREE DOWNLOAD", find "SAP Crystal Reports runtime engine for .NET Framework 4 

(32-bit)")  
 Download the file CRforVS_redist_install_32bit_13_0_1.zip . 

 
Important: For the 32-bit version of AnTherm the 32-bit version of the Crystal Reports runtime has to be installed. For the 
64-bit version of AnTherm the 64-bit version of the Crystal Reports runtime must be installed. 
 
Important: SAP Crystal Reports is no longer required (from AnTherm Versin10 on) 
 
 
See also: System requirements, Installation of the software 

http://help.antherm.eu/Install/Installation.htm
http://go.microsoft.com/fwlink/?LinkID=186913
http://go.microsoft.com/fwlink/?linkid=186916
http://www.microsoft.com/download/en/details.aspx?id=17718
http://www.microsoft.com/download/en/details.aspx?id=17718
http://go.microsoft.com/fwlink/?LinkId=76617
http://www.microsoft.com/download/en/details.aspx?id=25150
http://windowsupdate.microsoft.com/
http://www.businessobjects.com/jump/xi/crvs2010/
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
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The license file AnTherm.HID 
 

All functions of the application have to be activated by applying the license activation procedure. As long as the license 
has not been applied and licensing procedure not fully executed, AnTherm will immediately change to demonstrational 
mode. In this mode many of applications' functions are not available to the user. 
 
To fully activate all licensed program functions the customer specific license file AnTherm.HID has to be copied into the 
installation folder or the alternative location of the license file AnTherm.HID must be set within application settings. 
 
If the license file is missing, or if the license term has expired, the way the program works will be strongly restricted and 
many elements will become not usable. 
 
The information about the currently installed license and its validity can be checked in the About window which can be 
reached from the menu Help->About... . 

 

 

 

License activation procedure 
 

If the activation of the end user license has not been executed yet, one has to apply explicitly for such activation. The 
vendor shall contact you by e-Mail shortly after the purchase of the installation package. 
 
The license of the program is made non-transferable and bound to the physical hardware identification (dedicated 
hardware dongle, a physical Ethernet LAN network adapter card, etc.).  
From the data contained in 

 
 four lines of customer header (heading all reports) and  
 data on the hardware dongle or other physical computer hardware identifiers available for licensing 

 
a license key is being derived. 
 
Provided that data you will receive your personalized license file AnTherm.HID sent to you by e-Mail. 
Extract the file from the archive received if required and: 

 
 copy the license file without any changes into any user folder, public folder or onto network drive  
 (you shall choose any folder writing to which no special administrative credentials are required 

comfortably) and  
 enter that location into the extended application setting "Alternative license file AnTherm.HID" or "Alternative List of 

license files AnTherm.HID",  
and 

 restart the application. 

 
               or (required only for rare very special cases): 

 
 copy that file without any changes into the installation folder of this application (typically 

C:\Programs\tkornicki\AnTherm\)  
 Important: Use this method only if the virtualisation of the installation folder (standard from Windows Vista on) 

has been disabled by acquiring proper administrative credentials prior to executing the copy command. 

 
Important: We advise you to create a backup copy of your personalized license file AnTherm.HID to be able to restore 
it when required later. 

 

 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/frmAbout/frmAbout.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Install/Installation.htm
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Customer specific data (customer header) 
 
. 
Customer specific data of four text lines are printed in the heading of all reports  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

In accordance with license terms and conditions of use the licensee is not allowed to hide, remove or change any of vendor 
and user data shown in result reports. 
 
Exact content of four available lines of text can be defined by the customer. This allows placing of company name, address and 
other information on heading of all reports. One shall only keep these lines short to allow enough space for the optional 
customers' logo placed in the middle of each heading - 50 to 60 characters on each line shall be sufficient in most cases. 
 
The data, prepared in the way shown below, shall be made available by e-Mail to the vendor: 
 
Customer data (maximum of 4 lines, each by max of 60 characters long): 
 
Line 1: .............................................. 
 
Line 2: .............................................. 
 
Line 3: .............................................. 
 
Line 4: .............................................. 
 
Hardware identification: ............................. 
 
Data provided shall identify the licensee truthfully and comprehensibly. The end user agrees that these data will be displayed in 
informational windows of the application and on all outputs produced by using this software. In accordance with license terms 
and conditions of use the licensee is not allowed to hide, remove or change any of vendor and user data shown in result 
reports. 

 

Activating the license with a Hardware-Dongle 
 

The activation with a hardware dongle adds mobility of the license between multiple computers - please verify the license terms 
on regulation of the ownership and the usage rights on one computer only. 
 

DONGLE-option: replaces the binding of the license to one specific computer with the binding of the license 

to the mobile hardware, the USB-Dongle, allowing alternating use of one license on multiple computers. 
 
 

 
Remark: Hardware dongle activation is an additional option which shall be purchased in extension to the license. 
 
The activation of the license is combined with the data of the hardware dongle and stored in the license file. The application is 
able to execute only if the applicable hardware dongle, which is specified in the personalized license file, is plugged into the 
USB port of the computer. 
 

http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Datei/CustomLogoBitmap.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
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Before you execute the application please plug the hardware dongle into any USB port of the computer on which the 
software and the associated license file are installed. There is no need to install any additional software (e.g. device drivers) 
to use the hardware dongle with AnTherm. 
 
 If you'd like to move the hardware dongle to some other computer please save your application data at first, then close  the 
application and, after this, unplug the hardware dongle from the computer finally. 
 
Remark: Never unplug the hardware dongle while the application is running. This might lead to unpredictable behaviour of the 
application or of the whole system or even damage the hardware dongle itself. 
 
Remark: Protect the hardware dongle against loss or damage to avoid eventual blocking fine and repair or replacement costs. 

 

Activating the license bound to physical computer hardware 
 

Activating the license by binding it to physical computer hardware identifier validates the license for this one specific 

device - please verify the license terms on regulation of the ownership and the usage rights on one computer only. 
 
The activation of the license is combined with the data created out of the About window and stored in the license file. The 
application is able to execute only on the computer, which is specified in the personalized license file. In the case of computer 
failure or replacement the license activation procedure must be repeated - incurring additional blocking, change and 
maintenance fees. 
 
Please pass all physical computer hardware identifiers available for licensing directly out of the About window via e-Mail to 
the vendor. See: About window. 

 

Manual failure procedure 
 

In rare cases a fallback to manual determination of device identification must be executed. Shall all the data passed fail to be 
available for licensing procedure the manual fallback identification based on physical MAC addresses of all Ethernet network 
adapters installed in the computer will be used. The physical MAC addresses of one (or even many) Ethernet network adapters 
installed in the computer are listed in the top part of the about window, shown just after the licensing information and the list of 
active active license features: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Note: To readout the MAC address one can also use a helper 
application adaptersAddresses.exe. You will find 
adaptersAddresses.exe in the installation folder of AnTherm. 
 
Note: To readout the MAC address the system command 

"ipconfig /all" can be used also. Listing of MAC addresses  
shown with this command can contain virtual network adapters however which are not suitable as license identification of the 
machine. Therefore please use the output shown in the About window or with the tool adaptersAddresses.exe. 

 

 
 
 

http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Forms/frmAbout/frmAbout.htm
http://help.antherm.eu/Forms/frmAbout/frmAbout.htm
http://help.antherm.eu/Forms/frmAbout/frmAbout.htm
http://help.antherm.eu/Forms/frmAbout/frmAbout.htm
http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Forms/frmAbout/frmAbout.htm
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Demonstrational mode 
 

During execution of AnTherm in its Demo-Mode several application functions are not available. This demonstrational 
behaviour can be turned off by purchasing a permanent or a time limited license. 
 
The license file controlling the demonstrational mode is located in subfolder "DemoLicense" of the installation folder. 
Properties of typical demonstrational license are restricted to following application features: RESULTS, SOLVER, 3DIM, 
30000CELLS. Furthermore, a demonstrational license can be restricted to expire after some date. 

 
 

 While in Demo-Mode the About window will periodically pop up. Each time the user must click it away manually. 

 
 The precision of results will always be worse then requested while in demonstrational mode. The configuration of 

demonstrational mode targets short computational times at the expense of precision loss! The Demo-Mode's 
termination condition (the Delta) is set to 10

-4
 (0.0001); higher precision (required for conformity with valid norms) 

will be reached with terminal condition starting at and below 10
-7

 (0.0000001). 
 For that reason physical interpretation of results produced with demonstrational version is not reasonable! The 

software will show a warning message if the user tries to create more precise results by reducing the termination 
condition: 

 
The termination delta of the Solver-Engine has been reset to 0.0001. The demonstration license targets 

towards short computational time. The results are being computed faster but the precision might suffer. 

 
You shall upgrade your license if you wish to obtain more precise results.  
Please contact the manufacturer or reseller of this application to acquire full featured license. 

 

 
 In Demo-Mode all pictures copied to the clipboard or saved to file will be watermarked with a text „Demonstration“.  
 In Demo-Mode all result reports are watermarked with a text „Demonstration“.  
 In Demo-Mode all 3D pictures will be overlapped transparently with a text „Demonstration“; The license information is 

shown at the upper-left corner of the image also. 
 In Demo-Mode all save and export functions of reports are not available. 

 
Note: If the license is invalid (for example it has expired) intervals of About-window popup will become shorter and after 5 
minutes the application will exit. 
 
Note: Projects save a flag if executed in demo mode (DemoModeApplied). After license upgrade the termination delta will be 
reset to reasonable default value (SolverParameters.DemoModeRevertToNormal). 

 

Features 
 

Which application functions are covered and active within your license is defined within the license file by following 
feature entries: 

 
 2DIM – calculation of 2-dimensional constructions (2D)  
 3DIM – calculation of 3-dimensional constructions (multi-Layered or 3D)  

(without 3D license there is no 3D editing/processing: disabled menus: File->New, File->Convert, File->Import, nor saving 
of 3D/3DS )  

 RESULTS – executing the menu Results…  
 EDURESULTS – executing the menu Results… with a watermark "Educational"  
 DEMORESULTS – executing the menu Results… with a watermark "Demonstration"  
 SOLVER – executing the Solver 
 ROUNDNESS – the roundings   
 50000CELLS – executing the Solver up to 50.000 cells  
 100000CELLS – executing the Solver up to 100.000 cells  
 300000CELLS – executing the Solver up to 300.000 cells  
 1000000CELLS – executing the Solver up to 1.000.000 cells  
 ANYCELLS – executing the Solver without cell limit 
 VERSION number - required for execution 
 NODEMOPOPUP – suppress periodic popup of about windows when in Demo-Mode. 

http://help.antherm.eu/Forms/frmAbout/frmAbout.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
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VAPOUR-Option specific features: 

 
 DAMPF2DIM - solving two dimensional vapour diffusion  
 DAMPF3DIM - solving three dimensional vapour diffusion 

 
HARMONIC/TRANSIENT-Option specific features: 

 
 HARMONIC - solving of the harmonic, periodic, transient heat transfer (e.g. phase shift, harmonic coupling 

coefficients, etc.).  
 Allows solution for only 1 (first) harmonic for the selected period to be calculated. Only harmonic thermal 

conductances will be output. Other evaluations are executed with steady state solution (i.e. 0-th harmonic) and 
steady state boundary conditions (Results, ProbePoints, Results3D).  

 TRANSIENT - in addition to HARMONIC allows solving and evaluating the transient problem with time dependant, 
variable, periodic boundary conditions with higher harmonics.  

 Allows free entry of higher number of harmonics to Solver, specification of Periodic Boundary Conditions and executing 
Time-Based evaluations (Timeline, Results3D Animation). The Results, ProbePoints and Results3D are calculated for some 
chosen Time-Point (SharedTime) also set within boundary conditions (and it "includes" HARMONIC by its nature!). 

 
Additional Features: 

 

   MULTICORE - performance improvement by executing solver distributed on multiple processors or processor 
cores, eg.:  

 Solving the equation system(s) - the Solver  
 Loading the solution vectors from files in solution folder  
 Combining steady and transient state solution vectors at specific boundary conditions (superposition)  
 Harmonic Fourier analysis and synthesis of periodic boundary conditions  
 Fourier synthesis of time dependant solutions  
 Creation of results data for 3D visualization (primary and secondary functions), timelines and animation  

 
 STEREO3DVIEW - allows choice of binocular 3D views on supported devices 
 64 BIT- running the 64bit version 

 

 

 Vapour diffusion solution (VAPOUR-Option) 

 

VAPOUR-option: Analysis of multidimensional vapour diffusion is only           
possible with an active VAPOUR-Option of the program.. 

 

 
 
Computational description of vapour diffusion in building constructions can provide valuable hints for answering the 
questions if there is a risk of, potentially destructive, interstitial vapour condensation within the core of the construction or 
not (Interstitial Condensation Assessment). 
 
Diffusion equations have the same structure as those describing heat transfer and can be solved analytically only for one 
dimensional vapour diffusion. In all higher dimensional cases numerical methods, like the one implemented in AnTherm, 
have to be used. 
 
 

AnTherm calculates two- and three-dimensional distribution of vapour partial pressures in 
building constructions. 

 
 
 

 
See also: Installation of the program, License terms and conditions of use, System requirements, License order form, 
Application setting "Alternative license file AnTherm.HID", "Alternative List of license files AnTherm.HID" 
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http://help.antherm.eu/Introduction/82_Harmonic.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Introduction/83_Transient.htm
http://help.antherm.eu/Introduction/82_Harmonic.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/TimelinesForm/TimelinesForm.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Introduction/86_Multicore.htm
http://help.antherm.eu/Introduction/88_Stereo3D.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Install/Installation.htm
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Introduction 
 
The program AnTherm® is used to calculate stationary (steady state, time independent) and dynamic (transient in time 
periodically) distribution of temperature and heat flux within building construction, especially to determine surface 
temperatures and thermal coupling coefficients. Is is also used to determine vapour diffusion in building constructions. 
Extensive visualization support and extend the analysis.  
For the dynamic, transient case of changing, harmonic, periodic boundary conditions AnTherm will calculate harmonic 
coupling coefficients. 
 
In that simple cases in which the temperature within the building component is only dependant on one location 
coordinate, i.e. in the case of one dimensional heat transport, there is no need for specialized computer programs; the 
calculations can be easily completed by using well known, simple formulas. 
 
If the temperature distribution depends on two Cartesian space coordinates then we have to do with two dimensional heat 
transport and linear thermal bridges. The general, three dimensional case of heat transport shall be considered if the 
temperatures depend from three space coordinates. 
 
The program AnTherm® allows calculation of temperature distribution for the two as well as for three dimensional heat 
transfer. 
 
The program AnTherm® has been developed for model calculation of such building components of which the boundaries are 
parallel to coordinate planes of the orthogonal Cartesian coordinate system. Thanks to such limitation to orthogonal network 
the practical input can be quickly executed. Any construction set up of interconnected or overlapping ashlars and arbitrary 
materials can be simulated. The limitation to orthogonal structures allows relatively finely grained calculation of temperature 
distribution even on typical personal computer. Since the temperatures are calculated not only at cell centres, but also at 
sides, edges and corners of each cell, the simulation of say 20.000 cells provides 80.000 node temperatures in two dimension 
or even 160.000 nodes in three dimension very quickly. For 1.000.000 calculated cell there will be more than 8.000.000 
temperature nodes calculated in 3D! 
 
On one hand the temperature distribution depends on the geometry and physical properties of the component and, on the 
other, from air temperatures within spaces attached to the component (boundary conditions). There can be more than only 
two spaces attached to the component - this is the additional and major difference of two- or three dimensional cases 
compared to one dimensional calculation. 
 
Computational description of vapour diffusion in building constructions can provide valuable hints for answering the 
questions if there is a risk of, potentially destructive, vapour condensation within the construction or not. The 
implementation provided in AnTherm shall be mainly used for answering the question if, and if so where within the 
construction, by given boundary conditions (air temperature and relative air humidity) moisture is produced. 
 
The distinctive feature of AnTherm® is that the relatively laborious calculation of the temperature distribution, which is 
provisioned by solving large system of linear equations, need not be repeated for each different set of boundary conditions. 
Anticipating that need AnTherm determines so called "base solution" during the calculation only once. These base solutions 
are then superposed to temperature distribution under requested boundary conditions leading to significant reduction of 
computational time when several variants of boundary conditions are of interest. 
 
With regard to theoretical background reference should be made to the book ”WÄRMEBRÜCKEN” (Heindl, Kreˇc, 
Panzhauser, Sigmund; Springer-Verlag Wien-New York). 
 
See also: Tutorials and Cookbooks, Primary Concepts, Theoretical background 
 
 
 

http://help.antherm.eu/Introduction/81_Dampfdiffusion.htm
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Two- and Three-Dimensional heat flow Patterns 
 

The method of analysis most commonly practiced today when evaluating the thermal performance of building spaces, 

components, and assemblies is based on a simple, one-dimensional, constant flow model of heat conduction (i.e. the 

assumption of parallel heat flow for the calculation of U-values and areas). Such an assumption often leads not only to 

disappointing results in the thermal performance of realized construction projects, but also to costly consequences due to 

 unforeseeably high energy consumption for heating, as well as 

 damage caused by surface and core condensation and moisture 

 
These potentially negative consequences of over-simplification, inherent to the assumption of one-dimensionality, are 
becoming increasingly critical in today's trend towards highly insulated building structures. If the effects of thermal bridges 
are neglected, drastic errors in estimating heating requirements are bound to result, particularly when assessing energy 
efficient buildings. 
 
Multi-dimensional (i.e. two- and three-dimensional) evaluations of thermally critical regions within a building assembly, 
especially those with thermal heat bridges, during early design phases can provide valuable preliminary information to 
support the decision-making process, thus leading to considerably more reliable design results. 
 
Surface moisture due to condensation (typically occurring in such regions as floor-wall connections, window installations, 
etc.) as well as mould growth in humid environments can also be effectively prevented by means of multi-dimensional 
evaluation during planning and detail design. 
 
See also: Multidimensional Vapour Diffusion, European standards on thermal heat bridges 
 
 
 
 
 
 
 

  
 
                        2D- Results                             3D - Results 
 
 
As this example shows only the 3D evaluation returns the actual minimal surface temperature.

http://help.antherm.eu/PrimaryConcepts/12_ThermalTransmission.htm
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European Standards on Thermal Heat Bridges 
 

The European standards "Thermal Bridges in building construction Heat flows and surface temperatures - Part 1: General 
calculation methods" (EN ISO 10211-1) pertaining to aspects of thermal performance of building constructions are already 
available since 1996. The EN ISO 10211:2007 "Thermal bridges in building construction — Heat flows and surface 
temperatures — Detailed calculations" shows further development of the standardisation. The standard EN ISO 6946 
"Building Components or Building Elements - Calculation of Thermal Transmittance" is also available. The EN ISO 10077-
2:2003 "Thermal performance of windows, doors and shutters - Calculation of thermal transmittance - Part 2: Numerical 
method for frames" shall be also considered. 
 
The ramifications of the adoption of these European Standards became apparent: they describe the substance of 
essential tasks for designers, manufacturers, and builders, as well as their significance for quality control in the field of 
energy conservation. 
 
The purpose of the standard EN ISO 10211 "Thermal Bridges - Calculation of Surface Temperatures and Heat flows" is 
explicitly stated as: 

 
 the calculation of minimum (lowest) surface temperatures in order to assess the risk of surface condensation 

and  
 the calculation of heat flows in order to predict overall heat loss from a building (for the constant, steady state flow 

case; i.e. time independent temperature distribution)  
and 

 determination of linear and point thermal transmittance and surface temperature coefficients (of thermal bridges). 

 
Furthermore, "high precision methods" of calculation are demanded, whereby precision criteria which must be satisfied 
by the method chosen are defined in the standard. 
 
According to EN ISO 6946 "Building Components or Building Elements - Calculation of Thermal Transmittance", calculation 
of heat transfer coefficients of parallel plane surface building components shall be performed based, of course, on one-
dimensional models. For such components, composed of surface parallel layers of thermally homogeneous or non-
homogeneous materials, a well-known method of estimation (ISO-method) can be implemented in order to obtain a design 
thermal resistance - assuming the maximum relative error remains "negligible". 
 
For all other heat flow patterns, i.e. for all cases of more than one dimension, in particular in the presence of thermal 
bridges, the standard EN ISO 10211 "Thermal Heat Bridges" requires the implementation of numerical methods of 
evaluation. 
 
Further standards to be considered (exemplary): 

 

 ISO 7345  "Thermal insulation - Physical quantities and definitions"  
 ISO 10456 "Building materials and products - Hygrothermal properties - Tabulated design values and procedures for 

determining declared and design thermal values" 
 ISO 13370 "Thermal performance of buildings - Heat transfer via the ground - Calculation methods"  
 ISO 13786 "Thermal performance of building components - Dynamic thermal characteristics - Calculation methods"  
 ISO 13788 "Hygrothermal performance of building components and building elements - Internal surface 

temperature to avoid critical surface humidity interstitial condensation - Calculation methods"  
 ISO 13789 "Thermal performance of buildings - Transmission and ventilation heat transfer coefficient - Calculation 

method"  
 ISO 14683 "Thermal bridges in building construction - Linear thermal transmittance - Simplified methods and 

default values" 
 etc. 

 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
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A calculation program as instrument 
 

In order to perform tasks imposed by European regulations in practice, the qualified planner, designer, or expert needs a 
calculation program which: 

 

 meets the demands of the European Standards with respect to input data and more importantly output data 
requirements (evaluation results),  

 is capable of executing calculation with high precision,  
and is sufficiently convenient to the user in application (providing ease and clarity of operation, as well as speed). 
 
 
 
 
 

AnTherm® possesses these instrumental characteristics 
 

 AnTherm facilitates the generation of geometrical models by supporting a graphic input display of building 
structures, as well as by providing an entirely independent, fully automatic method of fine subdivision (which can 
also be influenced by the user through manual manipulation of parameters).  

 It delivers complete input model documentation (geometry of material elements, thermal design values of materials, 
spaces, heat sources...) upon request.  

 It allows the precision of numerical solutions to be influenced and controlled by the user (definition of calculation 
parameters). 

 AnTherm provides results conformant to European standards:  
 generally applicable results in the form of g-values and conductance matrices. These conform to the 

temperature weighting factors and "thermal coupling coefficients" defined in the European Standards, 
including the required information on calculation precision,  

 specific results, applicable to particular air temperature conditions in spaces thermally coupled by the building 
components analyzed, in the form of surface temperature minima and maxima as well as respective dewpoints,  

 It creates graphic plots and prints of isotherms, surface temperatures or temperatures along an edge (2- or 3-dim. 
models), as well as heat flow diagrams (not limited to 2-dim. models only, but also in 3D).  

 AnTherm meets all demands of the European Standards with respect to input data and - more importantly - output 
data requirements (evaluation results) - validated according to EN ISO 10211: AnTherm has been qualified as a "Class 
A" tool – as for two- and three-dimensional, stationary precision method. 

 
See also: Validation according to EN ISO 10211:2007, Validation according to EN ISO 10077-2:2003, Structure of the 
application 
 
 
 
 
 
 

http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
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Structure of the program 
 
 

AnTherm is a package of numerous programs branches which are grouped and coordinated centrally. Although the 
program is composed of several modules (program branches), it can be operated as though it were one single program. 
This is made possible by the unified user interface which independently ensures proper sequencing through the chain of 
programs while thoroughly managing the various objects generated by individual branches of AnTherm. 
 
The program can be divided into following branches: 

 

 the model input branch  
 the calculation branch (or simulation branch)  
 the evaluation branch (or output branch, results branch, analysis branch) 

 
The individual program branches are briefly described here. 
 
The input branch supports the generation of a calculation data suitable for describing the object under consideration. The 
first stage of input entails generating a model of the object with respect to its geometry and the thermal properties of its 
materials together with the specification of attached spaces and their heat transfer coefficients. Optionally one can identify 
areas as heat sources which will supplying specified power to the model. Finally the the level of detail for the equation grid 
has to be specified, i.e. the subdivision of the model into fine network of grid elements required for the calculation. These 
pieces (rectangles or ashlars) of the network are later called "cells". 
 
Having completed the input branch without errors the calculation branch can start with determination of "base solutions" - 
the basis of results. On top of that network a large system of linear equations is set up and solved iteratively. The number of 
equations in the system is equal to the number of cells in the orthogonal grid structure which it describes; thus a very finely 
gridded structure (calculation geometry) can result in lengthy computation. 
 
Final output data is obtained in the evaluation branch, during which the model under consideration (or rather, its 
characterisation through base solutions) is evaluated under specific conditions. The boundary conditions which must be 
specified here include air temperatures for the spaces/cases calculated. In the event that heat source elements have been 
included in the model, power values must be assigned as a condition to these cases as well. Herein lies the advantage of 
the "detour" over base solutions, since these need be calculated only once for a given model. The calculation time required 
for subsequent evaluation of specific temperature distributions under alternate boundary conditions is thus substantially 
reduced by employing the base solutions which have been determined in the calculation branch - instead of repeating the 
entire analysis for each set of conditions. Numeric data is printed here in the final form of evaluation results. 
 
Graphic representations of a given temperature distribution are generated in a form suitable for further evaluation. Within 
the graphical output of temperature distribution - like surface temperatures - one can false colour the temperature 
distribution or emphasize it by displaying isotherms also. Also images of streamlines or stream flux can be shown 
emphasizing the heat flow through the considered construction, often helpful in the identification of weaknesses of the 
construction. 

 

VAPOUR-option: Analysis of multidimensional vapour diffusion is only                                          
possible with an active VAPOUR-Option of the program 

 
 
               
 
 

If material properties of vapour transport have been supplied also partial vapour density and vapour flux can be 
calculated and evaluated here. 
 
The evaluation branch provides printing of numerical results. Graphical results can be easily transferred to other 
applications for further processing. 
 
See also: Input branch, Gridding, Calculation branch, Evaluation branch 
 
 

http://help.antherm.eu/Introduction/09_Eingabeteil.htm
http://help.antherm.eu/Introduction/09_Eingabeteil.htm
http://help.antherm.eu/Introduction/60_Solver.htm
http://help.antherm.eu/Introduction/60_Solver.htm
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The input branch 
 

The input branch supports the generation of a calculation data suitable for describing the object under consideration. The 
first stage of input entails generating a model of the object with respect to its geometry and the thermal properties of its 
materials together with the specification of attached spaces and their heat transfer coefficients. Optionally one can identify 
areas as heat sources which will supplying specified power to the model. 
 
As with any numeric method of analysis, the application of AnTherm with respect to a concrete object requires a 
considerable abstraction of reality. For dependable results, building components must therefore be abstracted to conform 
to the geometric principles governing the numeric analysis performed by AnTherm. 
 
Basics of the input process will be described in further sections for a two dimensional case. For the the dimensional case 
same basic rules apply also. 

 

Abstracting the Geometry 
 
First and foremost, AnTherm operates only within an orthogonal, Cartesian coordinate 
system. This limitation is due to the method of analysis, which, briefly put, first divides the 
model into a network of numerous cells ("gridding") to be mathematically evaluated. The 
mathematical description of these cells is a system of equations. The finer the grid, the 
more exact the evaluation results. However, a finer grid also, logically, increases the 
number of cells to be calculated, that is, the number of equations to be solved. This 
quantity is limited by the particular computer hardware configuration of the user. For 
orthogonally subdivided cells, a relatively simple system of equations suffices to describe 
each cell completely, thereby making it possible to evaluate a very finely gridded structure 
using a personal computer. 
 
Thus, the first abstraction necessary in modelling a building component is to 

approximate the geometry of its elements within a strictly right-angled system. It is 

advisable to prepare a simple, dimensioned sketch of the object to be analysed before 

beginning actual work with the program. Generally it can be said that simplifications 

made in the process of abstraction should be based on thermally relevant criteria in 

order to ensure that the model is thermally equivalent to the "real thing". Though there 

are no hard and fast rules on developing the ideal model (each concrete object must be 

treated individually), certain principles and guidelines should be adhered to. Valuable 

hints are settled within standards - see also EN ISO 10211. 
 
If it can be otherwise avoided, non-right angles in the elements of a building structure should not be approximated by 

"stepping" contours orthogonally in such a way as to severely increase their complexity. A more complicated contour 

generally corresponds to an increase in the surface area of the volume delineated, thereby influencing a key factor in 

determining heat flow patterns. Therefore, non-orthogonal geometries should be simplified by simple "straightening" 

whenever possible, that is, whenever the qualitative effect on heat flow can be expected to be negligible. 
 
When stepping contours has been used to assemble the model then the increase in the surface area of the delineated 
volume must be adequately compensated by adjusting properties of that respective surface. Typically this is the case by 
increasing the value of the surface resistance Rs by the factor of the surface (or length) has grown due to such modelling 
decision. 

 

Scope and scale 
 

The scale of evaluation should be kept in mind when preparing a preliminary model sketch. This means keeping the level of 
detail consistent with the overall dimensions of the region to be analysed. 
 
Though AnTherm requires dimensional data to be entered in millimetres, the total size of a particular model could also 
run up to tens of meters. Over detailing larger spatial structures can cause substantial increases in fine gridding, and 
therefore in calculation time, without the benefit of increasing the precision of relevant information provided by the 
evaluation branch (temperature distributions and heat flow patterns). 
 
Finally, any thermally irrelevant elements of a building structure can and should be eliminated from the model. Such are 
elements which do not primarily influence heat conduction through a building component (e.g. thermally disconnected 
exterior elements such as ventilated siding, handrails, fixtures, etc.). 
 
 
See also: Elements of a component, The component, Overlapping of elements, The room (space) 

http://help.antherm.eu/Introduction/05_Normen.htm
http://help.antherm.eu/Introduction/05_Normen.htm
http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
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Elements of the building component 
 

In the geometric model used by AnTherm to represent a building component, a single rectangular region or volume in 
space which is defined as "filled" with one homogeneous material is referred to as an element. Building materials are 
defined by name (e.g. "concrete masonry unit") and thermal conductivity λ [W/mK]. 
 
For a two dimensional case it will be a rectangle parallel to coordinate system axes. The rectangle (a two dimensional 
interval) is specified geometrically by its extents on two coordinate axes - x1 to x2 and y1 to y2 - thus by entering four such 
coordinates the rectangular element is defined.  
For a three dimensional case the input of further interval dimension is required - z1 and z2 are either provided explicitly or 
they result from the ordering and thickness of 3D layers. 
 
If two such elements share the same region in space and thus they overlap, the element entered later "displaces" 
preceding elements (or any parts thereof). 
 
Spaces at boundaries of a component are defined as "air-filled" elements. The air is characterised by the surface 
resistance Rs [m²K/W] (or the surface heat transfer coefficient α [W/m²K]) appropriate to a designated situation (e.g. 
"exterior", "interior/along glass", etc.). A single space must later be assigned one, unique temperature condition (in the 
evaluation branch). 
 
The necessary information about material and space surface properties can be found in standard literature on this topic. 
This information should be at hand before actually sitting down to work with the program. 
 
Heat sources are defined by an element overlapping one or many other material elements - the name of the heat source is 
used to identify it (a heat source to which no power is assigned in the evaluation stage is treated just as any other non-
emanating building material). 
 
See also: Element type (kind/type of a element) 
 
The definition of a component is provided by the entry of an ordered sequence of elements - these are stored into an 
element list providing the order of element overlapping. 
 
An example shall show the definition of elements to build a simple component - walls surrounding a space. For the sake of 
simplicity any openings are not concerned and we assume walls to be homogenous (built of one material). 
 

 
 
Entry of the component including all surrounding spaces is done in the most efficient way by starting the input by the 
entry of the exterior space (exterior air) rectangle. Any arbitrary size of the rectangle shall be chosen - it is sufficient if it 
extends beyond the exterior of walls which itself surround the interior space.  
Following the entry of the exterior space the wall material rectangle is entered at its exact (exterior) dimensions. Finally, the 
third element, the interior space is entered - this results in overwriting the partial region of the earlier entered material 
element. The entry is finished.  
Of course one could enter the model in some different (circuitous) way: all three different part types - exterior air, material 
and the interior air - could be entered as non overlapping rectangles. This would require much higher number of elements to 
be entered however. 
  

http://help.antherm.eu/Introduction/20_Bauteil.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/40_Raum.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Introduction/41_Waermequelle.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
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Size reduction and adiabatic Cut-Off planes 
 

Although entire buildings can also be evaluated by AnTherm, most practical applications will not be so global in nature. 
Usually only spatially limited problem zones need be scrutinised. Such a problem zone is typically a structural detail or 

region which could prove thermally critical. 
Since thermal bridges are characterised by two- and three-dimensional heat flow 
patterns, regions of a building structure in which heat is expected to flow one-
dimensionally (i.e. perpendicular to material surfaces) are generally of little interest in 
using AnTherm.  
Therefore such regions may be eliminated from the model to be considered without 
affecting any relevant results. The outer boundary of the region to be analysed is defined 
by cut-off planes. These planes are idealised as a non-conducting surface and should 
therefore be placed parallel to the direction of heat flow in a region where one-
dimensional heat flow can be assumed. 
 
Just where to optimally draw the cut-off planes - the nearest regions of a problem zone 
where heat can be expected to flow reasonably normal to planar component surfaces - is 
initially an educated guess, which may, of course, be subject to revision upon evaluation. 
 
To reference the earlier example the input shall be accomplished in the same manner - at first the exterior space is entered 
followed by the material rectangle later excavated again with the interior space rectangle. The most important difference to 
the example above is in that the boundary of the component is only partly covered by space surfaces. The other parts of the 
boundary (emphasized in bold) are cut-off planes implicitly resulting from the arbitrary user choice to cut the thermal heat 
bridge at such boundaries, thus inhibiting the heat flow completely (the normal component of heat flux through a cut-off 
plane is nullified). In this example placing cut-off planes far enough from the corner will be sufficient. 
 
One can also draw upon qualitative characteristics inherent in the geometry of a given object to limit the region to be 
modelled. Particularly axes of local symmetry in a building component, which can be safely assumed to coincide with 
planes parallel to heat flow, should be used to cut down the size of a model wherever possible. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
If the model shown in the image above is thought to continue to the left also two types of symmetries can be identified. 
These are not only the geometrical symmetries, but also the symmetry of temperature distribution which can be expected 
easily. Due to such symmetry there will be no heat flow through such line. The analysis of such model could be reduced to 
the area between the two symmetry lines. 
 
See also: The Component 
 
 
 

http://help.antherm.eu/Introduction/20_Bauteil.htm
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The Building Component 
 

The model of a building component is, generally put, built up with rectangular, possibly 

overlapping, elements. The term "component" need not have to be associated with 

typical architectural or engineering meaning of building assemblies. The "component" 

might resemble an excerpt from the building assembly containing one or more building 

components in its typical meaning - like ceiling junction, window frame connection etc. 
 
Within that application the term "component" does simply mean the ordered sequence 
of input elements composing some arbitrary object. The convenient input principle 
inherent to AnTherm - element overlapping - can facilitate construction input 
considerably if employed properly. 

 

Groups 
 

 

The construction to be simulated might contain some repeatedly appearing details.  
The input branch provides the notion of such details by groping them together (by unique group names) providing the 
method of quick selection, translation, rotation (by multiple of 90°) and mirroring (at axes parallel planes). 
 
The ability to compose any construction from groups is provided as an additional helpful method significantly simplifying 
the input process. 

 

Three dimensional constructions 
 

The input of three dimensional components follows same rules as those for two dimensions. 
 

3D Layered Model 
 

Three-dimensional objects are modelled as a "sandwich" of parallel layers. Each layer 
is composed of one or more elements. The elements of layers are entered to form a 
two-dimensional description (x and y axes), or section, normal to the direction chosen 
for layer depth (z axis). 
 
The thickness of a particular layer is defined by the depth for which a given section is a 
valid description of the structure. In other words, a separate layer must be specified for 
every change in cross-section when working through the layers of a particular model. 
 
This should be taken into consideration from the very beginning in the form of 
orientation sketches showing the number of layers (x/y sections) which will be needed 
in the z direction. 
 
Objects for which a two-dimensional analysis will suffice are modelled as an x-y 

section and evaluated per meter in the z direction. A dimensioned orientation  

sketch should include the origin which will be used for x and y coordinate input (an origin position along a component 
surface is usually the clearest solution). 
 
See also: Project types: Layered 3D Project 

 

3D Model 
 

The 3D Model is created by entering arbitrary triples of coordinates.  
The component's geometry is therefore described by input of ashlars.  
The resulting final 3D project is a sequence of such ashlars. 
The order of ashlars is significant in that ashlars (i.e. three dimensional elements) 
sharing same regions overlap, and those entered later hollow the properties of the 
others - by the same overlapping principle as with two dimensional rectangles. 
 
See also: Elements of a component, Overlapping of elements, Project types 
 
 

 

http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Forms/LayerEditorForm/LayerEditorForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

42 
 

Element overlapping 
 

 

Elements of a shape more complex than a simple rectangle can be built up of sub-elements of 
the same material according to an additive principle. However, in many situations, a simpler 
subtractive principle inherent to AnTherm can be implemented to achieve the same geometry 
more easily: element overlapping. 
 
The principle of element overlapping means that any element entered "displaces" preceding 
elements (or any parts thereof) which share the same region in space. 
 
Thus, for example, a shape such as the corner situation illustrated here can be drawn either as a 
composite of three elements or with a series of two over-lapping elements: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Which element over-rides the other depends solely on the sequence of element input, as reflected in the 
element list. 
 
Warning! Changes to the sequence of elements in the elements list will result in different effect of overlapping. 
 
See also: Elements of a component, Element Browser window 
 
 
 
 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/Introduction/10_Element.htm
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The Space (Room) and the Surface 
 

While defining the modelled building component the entry of spaces (rooms) are the core part of the input, especially the 
input thermal transfer resistance Rsi and Rse [m²K/W] (or thermal transfer coefficients αsi und αse [W/m²K] ) of their surfaces 
appropriate to a designated situation (e.g. "exterior", "interior/along glass", etc.). 
 
Spaces at boundaries of a component are defined as "air-filled" elements of equal temperature (and relative humidity); in 
the sense described here, exterior air is to be treaded as a "space" too. 
 
Distinctive spaces are identified by their unique names (Space Name, e.g. "exterior", "interior", etc.). A single space must 
later (not in input, but in the evaluation branch) be assigned one, unique temperature condition (and eventually relative 
humidity). 
 
The "space" as described here need not be locally coherent but it shall be composed of intentionally separated areas; If all 
such areas receive identical space name they will be treated as one, coherent, space. 
 
Surfaces of different spaces shall not be connected directly to each other, i.e. without placing some material construction 
interconnecting them. 
 
The space may, however, be divided into several elements to account for different surface situations within the space. 
Such "sub-spaces" can then be identified with different transfer resistance (or transfer coefficient) values (surface 
property) but sharing common space name. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

See also: Elements of the building component, Element overlapping, The heat source (power source), Element type 
(kind/type of a element) 
 
 
 
 
The heat source (power source) 
 

The "heat source" describes an spatial area of a component heated with constant power. Distinctive heat sources are 
identified by their unique names (Power Source Name, e.g. "heating stripe"). The specification of the heating power of the 
source is postponed until the evaluation of results is executed. 
 
One heat source in the sense described here can be composed of several, spatially not connected ranges; if all such 
ranges are assigned same name (heat source name) than all theses areas are considered one source. 
 
Different heat sources shall have common boundaries if required. 
 
See also: Creating the grid, Elements of a component, The Space (Room) and Surface, Element type (kind/type of a 
element) 
 
 
 

http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/Introduction/41_Waermequelle.htm
http://help.antherm.eu/Introduction/41_Waermequelle.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Introduction/50_Rasterung.htm
http://help.antherm.eu/Introduction/50_Rasterung.htm
http://help.antherm.eu/Introduction/40_Raum.htm
http://help.antherm.eu/Introduction/40_Raum.htm
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Creating the Grid (Gridding) 
 

Having the input branch completed and prior to obtaining the results crucial decisions have to be taken having major impact 
onto the precision of results and calculation time required to create them. The principle behind the calculation method of 
AnTherm lies in balancing the thermal characterisations of orthogonally subdivided regions. Each subdivision, or cell, is thus 
geometrically bound by orthogonal grid planes; these must be defined such that each resulting cell contains only a single 
building material. Thus, the resulting subdivisions need not to be identical with the input elements. The process of creating 
proper subdivisions is called "gridding". 
 

Minimal Grid  
 
The coarsest grid structure which satisfies the requirement of homogeneous 
cells is referred to as the minimal grid. This can be derived directly from the 
geometric data (elements) of a model. This minimal grid is generated fully 
automatically without any further user intervention. 
 

Fine Grid 
 
 

Since a minimal grid is generally too coarse a subdivision to provide 

dependably accurate results by numerical methods, a further - finer - 

gridding of the model must be performed for calculation. AnTherm offers 

automatic method for generating such auxiliary grid planes. The minimal 

grid thus generated forms the basis for all further gridding, but it does not 

constitute a complete grid structure. A fine grid in some form must be 

generated and stored in a grid file before moving on in the calculation 

branch. 
 
The creation of a fine grid involves inserting additional grid planes. Such 
procedure might be very circuitous and tedious when done manually. 
Therefore AnTherm provides an automatic generation of the fine grid 
controlled with few parameters. The automated process ensures, that most 
critical regions (corners, edges, etc) will receive finest grid. 
The fine-gridding defines the final set of cells (orthogonally subdivided regions) which shall then be balanced The number 
of such cell might be very large! Typical 2D calculation will result in 20.000-50.000 calls to solve with sufficient precision. 
3D calculation will quickly grow to 1.000.000 cells and more! 
 
The gridding (discretization) algorithm of AnTherm subdivides the component model under consideration into cells which 
will be thermally balanced thereafter. The calculation algorithm creates for each such cell the heat balance equation and 
then solves the system of such equations. The solution results describe temperature field with values in the middles of 
cells. 
In the event that a minimal grid would suffice for calculation (e.g. for preliminary evaluation of a model), it can be re-
generated as a fine grid based on the appropriate parameters. 
 
 

Super Fine Grid (The "super" - refinement) 
 

Considering places where temperatures will later be calculated (during the evaluation) not only middle points of each cell 
are of interest - middles of cell sides and cell edges and corners of each cell will be calculated too. 
 
Such super-fine-gridding provides for the two dimensional calculation of 20.000 cell about 80.000 evaluated temperature 
points. Within a three dimensional case with a fine grid of 20.000 cells the evaluation will result in more than 160.000 
temperature values. If the fine grid size is large - e.g. 1.000.000 cells for a 3D case - the number of calculated temperature 
points will grow to more than 8.000.000 possibly requiring longer calculation times during the evaluation. For that reason 
AnTherm will display a warning message when the number of cells within the fine-grid grows to higher value. In such case it 
is worth to consider, if, by adjusting some fine-grid parameters resulting in more coarse grid, sufficient precision can be 
reached faster also. 
 
As the nice result of such refinement the provisioning of much higher number of node values is available for the evaluation, 
hence the evaluation can be much more precise thereafter - for the two dimensional case the number of temperature nodes 
is fourfold the original cell count and in three dimensional case it is eightfold! For example, the calculation with 1.000.000 

http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/Introduction/10_Element.htm
http://help.antherm.eu/Introduction/20_Bauteil.htm
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(one million) balanced cells provides results of thermal balance equations 
 at more than 8.000.000 (eight million) points! - and the operation is accomplished in surprisingly short computation time. 
In the event that a minimal grid would suffice for calculation (e.g. for preliminary evaluation of a model), it can be re-
generated as a fine grid based on the appropriate parameters. 
 
 
 
 
The Calculation (Solver) 
 

Besides the knowledge of geometrical and physical composition of a building construction the calculation the temperature 
distribution within a building construction requires the knowledge of particular boundary conditions also. The approach used 
in this program is founded on top of specific boundary conditions - those defining the air temperature of each space 
connected to the construction. At cut-off planes an implicit adiabatic boundary condition is applied automatically by forcing 
the normal component of heat flux to zero, thus no additional user input is required. Therefore the user needs to provide 
particular air temperatures only. It is to be considered that only uniform air temperature shall be assigned to particular 
space, thus effects like variation of temperature due to air flow layers cannot be input directly. If heat sources are present 
within the construction additional boundary conditions defining the heat density of each particular source have to be 
supplied also. 
 
A characteristic of the program is the division of the procedure for generating a temperature distribution into two stages: 
calculation of base solutions and evaluation under prescribed conditions. 
 
Heat flow in a building construction, as well as the subsequent temperature distribution, can be described mathematically 
by differential equations. Most importantly, these equations are linear and homogenous by nature. This means that one set 
of solutions, calculated for a specific set of conditions, can be "re-used" as the basis for solutions under differing conditions 
by superposition, i.e. by linear combination of selected base solutions (see "Theoretical background"). More specifically, 
base solutions are calculated under the assumption of a "basic" set of boundary conditions: with an air temperature of 1 in 
the selected space, and 0 in all others. 
 
The calculation approach in the program uses this circumstance to minimise over-all evaluation time for user's comfort. 

One set of base solutions need be calculated only once to characterise a given model, which can subsequently be 

considered under varying conditions without repeating the time-consuming computation necessary to solve the primary 

set of differential equations. The superposition under applied boundary conditions is postponed to the evaluation part, 

thus the determination of basic solutions in that step does not require any input of particular boundary conditions. 
 
Computation time is further reduced by utilising the weighting function character of base solutions (normalised such that 

their sum must equal 1). Hence, if N cases have been selected, only N−1 solutions need to actually be calculated. The N-th 

base solution is then very simply derived as a difference of the sum to 1, that is, by a separate stage of superposition. 
 
If heat sources are present within the construction too, respective base solution will be created for each particular heat 
source also. The calculation is provisioned by setting the heat density of particular source to 1 while leaving all other 
boundary conditions at 0. Therefore the total number of base solutions calculated is the sum of the number of spaces and 
the number of heat sources. 
 
The parameters of iteration can be manipulated by the user prior to a calculation run of course. This is of interest when a 
model is particularly complex or when base solutions which have already been calculated prove to be inadequately precise 
during subsequent evaluation. 
 
See also: The Over-Relaxation, Theoretical background, Results & Evaluations 
 
 

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Introduction/65_Overrelaxation.htm
http://help.antherm.eu/Introduction/65_Overrelaxation.htm
http://help.antherm.eu/Introduction/70_Auswertungen.htm
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The Over-Relaxation 
 

In general there is no explicit need for addition input during the calculation. The user can control the solver by choosing 

various parameters of the computation. Such most important control elements shall be described in short below. 
 
Generating a temperature distribution is connected with the numerical solution of a very large linear system of equations. 

Such an equation system is solved through the relaxation method [2] . The relaxation factor ω must be between 1 and 2 . 

 

 

Relaxation factor ω 
 
 
The value of the optimal relaxation factor ωopt , which leads to the most expedient convergence of the calculation method, 
is highly dependant on the size and conditioning of the equation system to be solved. This value differs from case to case and 
is initially unknown. During the initial step of calculation an analysis of the equations system is executed and an estimation of 
ω0 for the optimal relaxation factor is calculated iteratively.  
Due to the fact, that the optimal relaxation factor ωopt, which ensures the fasted method convergence, can only be roughly 
estimated, the value calculated serves as an initial parameter for the relaxation factor ω which is then modified with each 
iteration in the course of the second stage of calculation. In particular, the relaxation factor grows from ωmin towards 
(asymptotically) the value of ωmax. If certain conditions are met it is reset to ωmin and the process continues. 
 
General parameters responsible for the automated variation of ω are set to default values. Under normal condition 
(moderate number of cells calculated, absence of extremely high or low conductance values) the calculation will 
appropriately execute without any user intervention. 
 
If the convergence might be slow in exceptional case the user can speed up the convergence by changing the default 
values. The major indication is provided if the number of cell is very high and the optimal value of ω is just below 2. 
Detailed description of ω–control parameters can be found in the separate section of this manual. 

 

 

Solving the system of equations 
 

 

At each iteration step the method determines the deviation of the value calculated for each network element (cell) 
compared to the previous iteration. The maximum of all absolute values of these differences is used to control the 
convergence and progress of the calculation. If that value continually is below some defined threshold ε during several 
successive iteration steps, the termination condition is considered fulfilled and the calculation finished. 
 
During the evaluation the user shall check if all precision criteria are satisfied and, if required, he can reduce the 
termination condition parameter ε and enforce the calculation to continue. 
 
The computation can be interrupted at any time (e.g. if the computing device is needed for some other purpose) to be 

resumed later. The calculation will resume starting from some intermediate results saved at the time of interruption. 
 
Complete results of the calculation are written to several files, which are then required during the evaluation. There are 
no special output results shown are available for printout during the calculation stage. 
 
See also: Theoretical background, Solver-Parameter, Application settings 
 
 

http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Introduction/70_Auswertungen.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
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Evaluation of results 
 

Final output data is obtained in the evaluation branch, during which the model under consideration (or rather, its 
characterisation through base solutions obtained from the calculation) is evaluated under specific thermal boundary 
conditions. 
 
While thermal coupling coefficients, heat source distribution and weighting factors are boundary condition independent, 
further output data is dependant on air temperatures of spaces calculated and, in the event that heat source elements 
have been included in the model, power density values, which all must be assigned as a boundary conditions to these 
respective base solution cases as well. 

 

 

Thermal coupling coefficients matrix and 
heat source distribution factors 
 
 

                            
 

                      
 
 

As the direct result of the computation the matrix of thermal coupling coefficients is provided. For a two dimensional 
model the matrix shows length related transmittance L

2D 
[Wm

−1
K

−
 
1
] ; for three dimensional construction the matrix 

displays thermal coupling coefficients L
3D

 per se [WK
−1

]. Because thermal coupling coefficients – and as such elements of 
the conductance matrix - are independent from particular boundary conditions, the matrix itself can be output prior to 
any user input of temperatures. 
 
 
Based on the output of thermal coupling coefficients one can calculate the thermal transmittance values (linear thermal 
transmittance Ψ (Psi) for two dimensional linear thermal bridges (see Psi-Value Determination), or point thermal 
transmittance χ (chi) for the three dimensional point thermal bridges). 
 
In the event heat sources are available also, the distribution factor of each source is shown too - like the thermal coupling 
coefficients this values are independent from boundary conditions also. If N spaces are attached to the considered 
construction the distribution table will shown N numbers. The i-th (i = 1,N) value of the distribution table shows the 
percentage of the heat provided by the particular heat source passing to the i-th space. The values of the distribution table 
are therefore from the range 0 to 1; because the steady state calculation does not cover the heat capacity storage, the sum 
of all distribution values must result in 1 (apart from minor rounding errors). 
 
Dynamic, transient problems, in which the heat storage capacity is taken into account, result in the output of harmonic, 
periodic coupling coefficients, also calculated directly and not dependant from any particular boundary conditions, are 
output as a matrix for each specific period length chosen. This results can be used for the analysis of dynamic behaviour of 
the component for example to read out amplitudes and phase shifts / time lags (like Lpe needed within Passivhaus 
Projektierungspaket PHPP) or to calculate effective mass capacities. 
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Boundary conditions 
 

Any further evaluation requires the definition of boundary conditions - these are specified by air temperatures of spaces 
connected to the building component and all power densities of all heat sources. Only after that data has been provided 
further results can be requested. 

 

                   
 
 
 
 

Temperature extremes, dew points, fRsi-temperature factors, g-values 
 

As soon as the boundary conditions have been applied, the application determines locations on the surfaces of all spaces of 
the model at which the minimum temperature is reached for given boundary conditions. The report "Results" lists 
coordinates of such points together with the value of the temperature at that point, the dew point value [1] resulting from 
that temperature and the corresponding temperature factor fRsi. The temperature weighting factors ("g–values") are also 
output for these coldest points. It is worth to mention, that the temperature weighting factors are independent from the 
boundary conditions. Contrary, the location of coldest surface points is dependant on the boundary conditions chosen, and 
therefore the output of weighting factors for coldest points can be provided after boundary conditions have been set. 

 
 

                                    
 
 
 
 

According to the standard conformance requirement of EN ISO 10211 the "Results report" can b output to the printer. 
 
For some special purpose it might be desirable to receive some output of the distribution of g-values within the building 
construction or at it surfaces. This is possible within the evaluation stage also. By using the nature of g-values, which in 
particular are base solution values, the user has to assign the boundary condition of the base solution of interest to 1 to 
receive the kind of "temperature distribution" showing the g-values themselves. The output can then show isolines, false 
coloured images or visualizations of "surface g-values" for example.  
Finally, the output of f-values is also possible because those are special case of g-values. 
 
 
See also: Evaluations and Results 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
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http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Auswertungen.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

49 
 

Visualization - Graphical Evaluation 
 

 

Along with the numerical output formally required by EN ISO 10211 further 

extensive graphical evaluation (visualization) of the calculated results can be 

obtained and eventually passed to printer or other applications. 
 
Quick view onto the calculated temperature distribution of the component 
can be obtained in the form of "false coloured" visualizations. For a two 
dimensional case there is only one such image, three dimensional cases 
can be visualized with slices through the model or arbitrary view onto the 
construction. 
 

 
 Some more detailed representation of            
the temperature distribution is available  
 as isotherm images. Isotherms, i.e. lines of     
onstant temperature, will be shown on the 
slice through the construction for a two 
dimensional model. Detailed appearance and 
content of the information shown can be 
defined by the user by defining the number of 
isotherms drawn - value of the first and last  
isotherm, interval between consecutive isolines etc. can be used to define the meaning of 
each particular isotherm.. 

 
 For a three dimensional case the slice plane at which isotherms shall be drawn can   be 
arbitrarily chosen. Furthermore isotherms can be shown on the surface of the  model to 
emphasize the temperature distribution also. 

 
Furthermore, one can query the value of temperature at any arbitrary point of the 

construction. The definition of points of interest is either provided by the coordinate entry via the menu "Probe points" or 
by setting the position of slice planes - the temperature value at the intersection the three planes will be shown on the 
screen. 
 
Further evaluation of temperatures can be available as a graph of temperature values along an edge (surface) of one 
particular space in two dimensional case. (Remark! This option is currently not available!) 
 
For three dimensional cases one shall request the graph of temperature values along arbitrary line (eventually parallel to 
coordinate axes). Such line might intersect the interior of the component or follow the surface of the construction - thus 
providing the ability to emphasize temperature values at components edges. 
 
 

 

As an alternative to the visualization of calculated temperature distributions one 

shall request results showing dew point values (condensing humidity values) 

resulting from the current temperatures on the surfaces of the model. To achieve 

that simple activation of the switch "secondary functions" is required followed by 

the selection of "Relative Humidity %" within the box "Active function". This 

visualization provides by far much more information compared to the norm 

required printout "Results" because not only the "yes-no-decision" of norm 

conformant construction can be received, but additional, much more detailed 

conclusions about the distribution of dew point values at component's surfaces are 

possible. In particular, for construction non conformant to standards, the ability to 

draw an isoline at the humidity value which is critical by the standard (the value 

above which the condensation or mould growth shall occur) might be  

very instructive. Such an isoline will mark and emphasize the critical area of the components surface. 
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Very helpful hints regarding improvement of the thermal quality of building construction result from the visualization of heat 
streams through (and within) the construction. To receive output related to heat flux one simply needs to activate the switch 
"Secondary functions" and then, within the box "active function" choose the "Heat stream density W/m

2
". Variants of 

visualization options available to the calculated heat stream densities are the same as to temperature distribution. Locations 
of high heat stream densities shall emphasize thermally weak areas of the construction and can be immediately visualized as 
false colour diagrams or isoline views for better identification. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For both, the two as well as for three dimensional cases, the heat flow through the construction can be visualized with a 
streamline. The streamline is shown as soon as the control panel "Streamlines" is activated and coordinates of the starting 
point are chosen by placing the intersection of the slice planes X, Y and Z within the construction. 
 
For two dimensional cases there is possibility to visualize multiple multiple heat flow streamlines. Since the area between 
the two neighbouring streamlines marks exactly the same amount of heat flow, the areas at which the density of 
streamlines is high emphasize potentially weak locations within the construction. 
 
Visualisation of heat flow is also offered as hedge hog field of vector arrows. This display is controlled within Vectors 
(HedgeHog, Arrows) control panel by defining the mesh of points at which the direction of heat flow and eventually its 
magnitude shall be shown. 

 

See also: Evaluations and Results 
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http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Auswertungen.htm
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Multidimensional Vapour Diffusion 
 

Computational description of vapour diffusion in building constructions can provide valuable hints for answering the 
questions if there is a risk of, potentially destructive, interstitial vapour condensation within the core of the construction or 
not (Interstitial Condensation Assessment). 
 
Diffusion equations have the same structure as those describing heat transfer and can be solved analytically only for one 
dimensional vapour diffusion. In all higher dimensional cases numerical methods, like the one implemented in AnTherm, 
have to be used. 
 

 

VAPOUR-option: Analysis of multidimensional vapour diffusion is only possible with an active            
VAPOUR-Option of the program. 
 
 
 

AnTherm calculates two- and three-dimensional distribution of vapour partial pressures in building 
constructions. 
 
Saturation pressure distribution within the construction is computed too - based on the temperature distribution. 
 
The comparison of the partial and saturation pressure distributions provides hint directly related to answering the 
questions if there is quantitative risk of condensation within the construction or not. 
 
All areas at which partial pressure of vapour is higher then the saturation pressure can be accounted as endangered and can 
be visualized as such graphically (e.g..shown as false colours, or as isosurface or an isoline at the zero value of the difference 
of vapour pressures or one specific value of relative interstitial core humidity). 
 
 

Example: Vapour pressure difference and vapour diffusion streams 
 

 

 

 

 

 
 

http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://hilfe.antherm.kornicki.de/Introduction/81_Dampfdiffusion.htm
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This humidity model calculation shows, due to the cold bridge effect caused by a partition wall of stud framing gypsum 
plaster placed directly onto the slab on the one hand, and - due to the interruption of the moisture barrier on the war side, 
just below the heating pavement - the possibility of diffusing water vapour into the floor structure through the partition wall 
on the other, additional regions of higher condensation risk. These are highly distinctive in the surrounding of the bottom U-
Profile of the partition wall. 
Legend: 

 colour mapped vapour pressure difference (black:zero-boundary; blue:negative; light-blue/white:highly-negative) 

 stream lines of the vapour diffusion (white) at 10%-interval of the overall vapour diffusion stream from inside (top) 
to outside (bottom) 

 

 
Transposing this method used in AnTherm onto the commonly used Glaser-Method for one dimensional case means, that 
intersections of vapour partial pressure distribution with saturation pressure distribution are calculated and regions within 
these intersections are interpreted as condensation risk areas. It is well known that the width of such zones is mostly 
overestimated. 
 
It has to be accounted, that when interpreting such results, diffusion is not the only driving factor for vapour transport. 
Especially within massive constructions water and vapour transport can be significantly influenced by capillary transport 
hence diffusion might be less significant then. 
 
The implementation provided in AnTherm shall be mainly used for answering the question if, and if so where within the 

construction, by given boundary conditions (air temperature and relative air humidity) moisture is produced. 

 

Example: Vapour pressure difference and vapour diffusion streams 
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Remark: More exact estimation of condensation zones and moisture amounts is subject for future developments. 
 
See also: Theoretical background, European standards on thermal bridges, EN ISO 13788 
 
 
 

Example: Distribution of the temperature and heat stream lines 
 
 

  

   

 
 

 
This humidity model calculation shows, due to the cold bridge effect caused by a partition wall of stud framing gypsum 
plaster placed directly onto the slab on the one hand, and - due to the interruption of the moisture barrier on the war side, 
just below the heating pavement - the possibility of diffusing water vapour into the floor structure through the partition 
wall on the other, additional regions of higher condensation risk. These are highly distinctive in the surrounding of the 
bottom U-Profile of the partition wall. 
Legend:  

 Isolines of vapour pressure difference (black); 

 stream lines of the vapour diffusion (white) at 10%-interval of the overall vapour diffusion stream from inside (top) 
to outside (bottom) 

 

http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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Partition wall of stud framing gypsum plaster placed directly onto the 30cm thick concrete ceiling above basement garage, 
without thermal insulation on the cold side. 
The EPS heat insulation layer (Röfix 831, zementgebundene Polystyrolflocken) of 13,5 cm thickness has been placed solely on 
top of the concrete plaster - there is no other heat coating at the bottom side of the ceiling. The typical cross section of this 
ceiling construction has been assessed being not critical at all. 
Legend: 

 isotherms (black); 

 colour mapping by temperature 

 heat flow streamlines (white) at 10%-interval of the overall heat stream from inside (top) to outside (bottom) 
 

 
 

Example: Heat flux distribution and heat stream lines 
 

          

    

 

 

 

Partition wall of stud framing gypsum plaster placed directly onto the 30cm thick concrete ceiling above basement garage, 
without thermal insulation on the cold side. 
The EPS heat insulation layer (Röfix 831, zementgebundene Polystyrolflocken) of 13,5 cm thickness has been placed solely on 
top of the concrete plaster - there is no other heat coating at the bottom side of the ceiling. The typical cross section of this 
ceiling construction has been assessed being not critical at all. 
Legend: 

 colour mapped heat flux (flow stream density) (yellow to black: heavy heat bridge impact ) 

 heat flow streamlines (white) at 10%-interval of the overall heat stream from inside (top) to outside (bottom) 
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Harmonic (periodic) dynamic indicators 
 
 
 
The HARMONIC option of AnTherm calculates “harmonic thermal conductivities” of component or building as indicators 
required for transient building energy simulations based on periodic (harmonic) approach. This also includes PHPP 
calculations. Thermal Harmonic Conductivities and further dynamic indicators facilitating heat transport with heat capacity 
capabilities follow the ISO and EN standard EN ISO 13786. 
 

HARMONIC-option: Solving dynamic, periodic problems for determination of Phase Lag in 

response to heat capacity potential is only possible with an active HARMONIC-Option of the 

program. 

 

 
 

The harmonic thermal conductivity is given by the amplitude and phase lag of the heat flow which follows periodically 
changing boundary conditions (either temperatures or heat sources or sinks). Lagging in time with damping of amplitude 
(attenuation) results from heat storage capability of materials.  
Heat losses might lag many months, intermittent heat gains might result also. Cooling infrastructure might become 
obsolete or overheating can be practically resolved with the building own (heat) capacity.  
Transient heat flows are heavily dependent on heat capacity of building components, especially massive, solid or brick 
walls, slab or ground structures. 
 
The Harmonic option of AnTherm can be seen as a small brother of the much more extensive TRANSIENT-Option. The 

purpose of the Harmonic option is to solve transient, periodic heat transmission equation for the 0-th and 1-st 

harmonic. The 0-th harmonic is the steady state solution of the equation corresponding to mean heat flows under 

periodic boundary conditions. The 1-st harmonic provides solutions of amplitude and phase lag for the main period, 

such as day or year.  
When power sources are involved AnTherm’s Harmonic option reports Harmonic Heat Distribution Factors (additionally to  
Harmonic Thermal Conductivities reported for spaces) and are also given by their amplitude and phase lag of the heat 
flow following the oscillation of respective heat source or sink. 
 
By using the harmonic indicators much better approximation of dynamic thermal behaviour of the building can be 

obtained when compared to simplified steady state approach – even with only one first harmonic of the oscillation. 
 
Exact indicators calculated with AnTherm for any 3 dimensional geometry and arbitrary combination of materials are 
indispensible replacement for approximations restricted to few simplified geometries only as those provided in ISO 
13370. 
 
The strength of the HARMONIC tool relies on the fact, that harmonic thermal conductances (complex number, amplitude 
and the phase lag) can be calculated without the need to enter nor to know any boundary conditions – harmonic thermal 
conductances are output just following the steady state thermal conductances L

2D
, L

3D
 in the respective report. There is also 

no need to specify or assume any starting boundary conditions as compared to time step based methods. 
 
It is very important to emphasize, that harmonic thermal conductance are characteristic for the object concerned and by 
that are independent of any boundary conditions. The proper calculation of these harmonic periodic indicators does not 
need to know nor to apply any boundary conditions. Further evaluation of the behaviour of a building component under 
certain and periodically changing boundary conditions is subject to the “TRANSIENT” Option of AnTherm (higher 
harmonics, periodic boundary conditions, animation in time and timeline outputs). 
 
Remark: The HARMONIC Option alone basically offers evaluation under steady state boundary conditions (in addition to 
harmonic, periodic, dynamic indicators). 
 
Remark: The numerical results (stored within the folder of simulation results) shall be passed to the Program THESIM 
(www.thesim.at). 
 

 
See also: Theoretical background, European standards on thermal bridges, EN ISO 13786, EN ISO 13370, Transient, 
multidimensional calculations by an example of components in contact with soil 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Introduction/83_Transient.htm
http://help.antherm.eu/Introduction/83_Transient.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://www.thesim.at/
http://www.thesim.at/
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Theory/Merkblatt_instationaer.htm
http://help.antherm.eu/Theory/Merkblatt_instationaer.htm
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Transient (periodic) time dependant simulation 
 
 

 
The TRANSIENT option of AnTherm calculates, evaluates and visualizes heat flows and temperature distributions in 
building components under boundary conditions changing in time periodically. By that it allows modelling and analysis of 
effects of heat storage in building construction and their response to changing conditions due to heat capacity of materials. 
 
Such simulation approach is also known by “Transient periodic”, “Transient harmonic” or “quasi steady periodic”.  
The efficiency and precision of this simulation approach results from the assumption of periodicity. By assuming periodicity 
of the processes the proper of periodic simulation does not need any starting distribution of temperature field. This is 
especially true for climatic boundary conditions (year, day), utilization scenarios (including the period of one week) or any 
other “repetitive” situation, e.g. periodically turning on and off electric heating appliance. 
 
 

TRANSIENT-option: Solving and evaluating time dependant dynamic, periodic problems 
 when heat capacity effects are concerned is only possible with an active 
TRANSIENT-Option of the program. 

 
 

 
Respective boundary conditions, periodically variable in time, can be modelled as series of values at specific time points or as 
series of mean values valid for several intervals of equal or variable lengths. Modelling periodic boundary conditions is not 
limited to air temperature but also possible for volumetric heat sources or sinks. The later will often be modelled as step 
(switch) functions while the other will result from some long term data measurements. The set of tools provided for 
modelling periodic data includes for example: values at equidistant points (regular points), mean values at equally or 
irregularly distributed time intervals (regular means, irregular means), values in steps (switching) on irregularly tiled intervals 
(irregular steps). Furthermore any periodic distribution given by complex coefficients of Fourier series can be employed too. 
 
Compared to HARMONIC option (this earlier option of AnTherm is available already for years) the TRANSIENT option adds 
higher precision of results, ability to evaluate higher harmonics of the main period requested (up to 1000 harmonics), 
evaluate timelines of temperatures at arbitrary probe points or visualize time dependant animations in 3D (by employing the 
already well known techniques of “standard” steady state AnTherm to chosen time series) and record them for movie 
reproduction. 
 
The strength of the HARMONIC tool relies on the fact, that harmonic thermal conductances (complex number, amplitude 
and the phase lag) can be calculated without the need to enter nor to know any boundary conditions.  
The TRANSIENT Option goes much further by adding the ability of modelling periodic boundary conditions (fully 
automated Fourier analysis) for the purpose of time dependant evaluations (either a 3D view at some point in time, then 
available to creating time series animation, or timelines of temperature changing in time at selected location of the 3D 
model). 
 

 
See also: Theoretical background, European standards on thermal bridges, EN ISO 13786, EN ISO 13370 
 
 

http://help.antherm.eu/Introduction/82_Harmonic.htm
http://help.antherm.eu/Introduction/82_Harmonic.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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Computational performance enhancement for multiprocessor systems 
 
 
Running solver on multiple CPUs enhances the calculation performance and thus (in most cases) reduces significantly the 
calculation time. Multi CPU (or Multicore) behaviour of the solver is controlled by respective application settings 
separately. 
 
Remark: This function requires a valid license feature MULTICORE. 
 

MULTICORE-option: Speeding up computationally intensive jobs by distributing them on 

multiple processors or processor cores for parallel execution is only possible with an active 

MULTICORE-Option of the program. 
 

 

Complex calculations (such of more then 1 million equations) can be critical in terms of time factor - the calculation can last 
few seconds only but (for so called "bad conditioned equations") tenths of minutes (on currently typical PC computer 
hardware). The CPU speed, CPU type but also die memory architecture of the system determine the effective 
computational power which is available to AnTherm. 
 
By employing the MULTICORE-Option the software can access multiple CPUs oder CPU kernels and by that significantly 
improve the efficiency. By increasing the number of used kernels will add to the computational power as expected. Knowing 
that it depends on the operating efficiency of many other components of the device it is advisable to determine the optimal 
number of cores by executing simple measurement. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Processing power of the Solver in AnTherm on a Core i7/920 computer in the function of 

employed CPU cores 
 
 

Above picture shows, that the theoretical multiplication of the computing power will not be reached by simply raising their 
number of cores! For the computer architecture used for the above example the saturation of computational power is 
reached already with four cores. This results from the technical structure of the Core i7/920 processor having only for 
memory paths (one for each pair of cores). In reality saturating the memory bandwidth raises the computing power limit in 
that case. 
 
The number of cores used by the solver shall be set in the application settings. 
 
 
See also: Solver window, Application settings 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
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Immersive 3D stereo (binocular) experience 
 
 
AnTherm utilizes stereo viewing capabilities for the three dimensional analysis of thermal bridges in building 
constructions. In addition to the real time 3D rendering of analyzed objects one can now easily receive immersive 
experience of real 3D by turning into stereo capable interactive imagery. 
 

 

STEREO3D-option: Stereoscopic, binocular display of three dimensional evaluations is is 

only possible with an active STERO3DVIEW-Option of the program. 

 

Stereo viewing is even possible with very cheap Read-Blue glasses. By utilizing more advanced equipment, such as Crystal-
Eyes or NVIDIA 3D Vision glasses, fully immersive stereoscopic 3D experience of colourful visualizations can be made 
available to nearly any user’s desktop PC. 
 
By a simple click of the mouse AnTherm automatically transforms your PC into full stereoscopic 3D thermal bridge 
evaluation tool. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 

Remark: Using binocular stereo modes requires a valid license feature STEREO3DVIEW 
 
See also: 3D Navigation within 3D windows 
 
 
 

http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
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Country specific localisation - important notice 
 
While using international features, Windows provides you with country specific setting for decimal comma. This shall allow 
you to use numeric pad of your keyboard for entering numbers correctly. Please note, that entering 0,8 (with comma 
instead of dot) might result in 08 if your setting of current operating system's locale (typically Regional Setting of the 
System's Control Panel) defines different character (for example a dot) for decimal comma. The opposite might also be 
valid (e.g. German systems use comma - the , character) for decimal comma. 
 
If the system is set up properly for your country, the numeric pad's comma will provide the right character to the input. 
 
Note: The AnTherm® provided application User interface language setting does not affect the operating system setting for 
the decimal comma or dot. 
 
See also: Application settings 
 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Starting the program 
 

Start the application from Windows Menu Start→Programs→AnTherm→AnTherm. 
 
It is also possible to start processing of a AnTherm project file directly from the Windows File Explorer. The double-click 
onto the project file (AnTherm project file has an extension .antherm) within the windows file explorer will start the 
program and open the chosen file. 
 
If the installation of the program has been successfully completed, you will be shown the Main application window 
together with further application windows embedded in it. The Tip of the Day shown immediately after application start 
provides useful hints on application usage. 
 
Pressing the F1 key or using the menu Help→Contents will show you the documentation - user guide, program 
reference, tutorials etc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

The windows of the program AnTherm will be shown on your screen at positions as they were shown on the last application 
use. On initial application start some preset windows are shown at their initially preset positions, depending on the installed 
and loaded template. All windows can be freely moved and most also freely sized. This allows you to setup the layout and 
content of the screen according to your needs. During the final shutdown of AnTherm positions of windows are saved 
together with all further application settings. 
 
Depending on application setting AnTherm will on its startup either initially load a template project file project.xml from the 
installation folder or it will load the recently open project automatically. 
 
Working with the program is controlled from the main menu and from various editing, dialog or evaluation windows and 
their context menus. 
 
Tip: If immediately after starting the program the message „The application failed to initialize properly (0x000135). Click 
OK to terminate the application“ is shown, please check if „MS.NET Runtime“ is installed on your computer – see also 
Installation of MS.NET Runtime or Installation of the Program . 
 
Tip: The program's User Interface is shown in the language chosen according to the preset setting of your operating 
system and language variant available in AnTherm (standard default language). You can change this! Please select the 
Menu Edit→Settings... (or Bearbeiten→Einstellungen...) and within the settings dialog set the User Interface Language 
(Sprache der Benutzeroberfläche) according to your needs from languages available in AnTherm. 
 

http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/TipOfTheDayForm/TipOfTheDayForm.htm
http://help.antherm.eu/Datei/Startup_LayoutPersistence_xml.htm
http://help.antherm.eu/Datei/Startup_LayoutPersistence_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Standard_projekt_xml.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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VAPOUR-option: Analysis of multidimensional vapour diffusion is only possible with an 

active VAPOUR-Option of the program.. 

 

 

 

Tip: You will receive a warning if there is one instance of the application running already. There is only one instance of 

AnTherm allowed to be actively executed. Simultaneous execution of more than one instance will be blocked. When 

attempting to start second instance, such instance will be terminated and you will be shown informational message. 

However such behaviour can be changed with the application setting "multiple app-instances allowed". This functionality is 

implemented by acquiring the mutex "{4927A7F0-BD15-499d-A82A-5EE422C6FF3F}" (arbitrary chosen GUID). 
 
See also: main menu, input windows, main window, MDI/SDI, application settings, standard project projekt.xml, 
Installation of the program, Tutorials und Cook-Books 
 
 
 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Install/Installation.htm
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Project types 
 

Following project types can be created and processed: 

 
 2D project  
 Layered 3D project  
 3D project 

 
Projects can be converted to different type too (e.g. using a 2D model as a template for more sophisticated 3D 
modelling). 



 

2D project 


Primary property of a 2D project is given by geometric modelling done in two dimensions only. Only one planar slice is 
entered and the resulting two dimensional construction calculated. There is no input regarding the third dimension - i.e. 
coordinates of the axis perpendicular to project plane. 
 
This project type is typically used to model a linear thermal heat bridge. 
 


















 
Final 2D Projekt contains ordered sequence of elements. The order of elements is relevant, because later entered 
elements will partly or fully overlap elements earlier in the order if covering common plane area. 
 
Note: Internally AnTherm represents the 2D model as a single layered 3D project with the thickness of exactly 1000 mm - i.e. 
1,0 m - in Z direction. 
 

















 
 

This dependency shall be considered if, e.g. for some result display, two dimensional contractions are modelled in three 
dimensions. 
 
Remark: To support graphical entry the underlay can be registered and shown within the plane of Elements2D window. 
 
Remark: The 2D Project Type will be often uses as a starting point for creating 3D models by various conversion 
capabilities (see below). 

http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
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Layered 3D project 
 
 

Primary property of a layered 3D project is given by its geometric modelling of planar slices consecutive to each other 
(slices itself are identical to a 2D project type). 
 
This project type is typically used to model a point thermal heat bridge. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Three dimensional model is given by assigning a thickness to each such planar slice.  
In Antherm each such slice with assigned thickness is called leyer. 
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Final "layered 3D project" contains ordered series of layers. The sequence can be controlled by the layers list. 
 

http://help.antherm.eu/Forms/LayerEditorForm/LayerEditorForm.htm
http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
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Note: A three dimensional model will result in exactly same results as its two dimensional counterpart only, and only if, the 
geometry and conductivities do not change along one dimension and the extent in this direction is exactly 1000 mm - i.e. 
1,0 m. 
 
Remark: To support graphical entry the underlay can be registered and shown within the plane of Elements2D window. 

 

 

3D project 

 

Primary property of a 3D project is given by entering all three coordinates in three dimensions directly. The resulting 
geometry of building construction is described by series of cubes. 
 
This project type is typically used to model a complex point thermal bridge. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

The order of element cubes in the sequence is relevant, because later entered elements will partly or fully overlap 

elements earlier in the order if covering common space area. 
 

http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
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Note: A three dimensional model will result in exactly same results as its two dimensional counterpart only, and only if, the 
geometry and conductivities do not change along one dimension and the extent in this direction is exactly 1000 mm - i.e. 
1,0 m. 
 
Remark: To support graphical entry three underlays can be registered and shown within respective planes of Elements23 
window quadrants. 

 

 

 

Converting between project types 
 

 A 2D project can be transformed (converted) to a layered 3D project.  
 A 2D project can be revolved (rotated) to produce 3D project based on a 2D template. 

Warning: Revolution to a 3D project is irreversible.  
 A layered 3D project can be converted to a 2D project only if it contains only one layer.  
 A layered 3D project (and a 2D project too) can be converted to a 3D project.  
 During the conversion AnTherm will assign each element to a additional group named  

„Layer#:LayerName/Thicknessmm“. This allows element selection by its original (prior to conversion) layer structure  
(context menu of element processing->Select->By Group). 

Warning: Converting to a 3D project is irreversible.  
 A 3D project can be converted to a 2D project only if thicknesses (e.g. Z coordinates) of all elements are equal. The 

resulting project will receive thickness of 1000mm (Z1=0, Z2=1000).  
 A 3D project can be converted to a layered 3D project. The conversion will create 3D Layers in the Z-directions for all Z-

coordinates existent in the project. Layer names will be derived from that Z-coordinate values. All elements are then 
added accordingly to respective layers.  
Warning: This conversion need not be reversible.  
Important: Element of Z-thickness equal 0mm will not be included in the conversion and ignored. 

 
 
 
See also: Create new project, Converting a project, Working with files, 3D-Layered model 
 
 

http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.eu/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.eu/Forms/RevolveTo3dParamsForm/RevolveTo3dParamsForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
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Coordinate system 
 

 
The tree dimensional construction is being modelled (input) within a Cartesian coordinate system. 
Axes X, Y, Z are set up to create a positive oriented, orthogonal coordinate system. 
 
Normally one places the footprint at the X-Y plane, thus coordinate values of the X axis grow to the right and those of the Y 
axis towards the back, hence the Z axis shows upwards along the structural levels. 
 
The view from right is then parallel to the Y-Z plane, and the front view is parallel with X-Z plane. 
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The user can of course freely choose to place the footprint at any other plane. He shall merely observe the orientation of 
the coordinate system to avoid in advance any mistake or confusion regarding the direction of axes. 
 
Note: Labelling of the axes titles can be modified in application settings . 
 
See also: Projec types, Element Editor, Elements 2D window, Elements 3D window, Elements 23 window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
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http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
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Results & Evaluation 
 

AnTherm provides variety of ways to show computational results and execute evaluations. It provides results as textual 
reports and graphical evaluations (visualization). 

 

Reports 
 

Reports provide computational results as textual, printable output. All reports can be 

 
 viewed on the screen,  
 saved as PDF, XLS, DOC or RTF file for further processing,  
 printed on the printer and 
 searched for specific words and phrases. 

 
Following reports are available and can be requested form the Main menu of the program: 
 

Report builder The report generator allows you to create completely custom reports. Microsoft Word is required. 

Data Entry  
Report 

detailed listing of entered data 

Modelling  
Report 

a summarizing report for the modelled construction, used materials, spaces, surface properties and 
power sources 

Coupling Coeff. 
Report 

Output of the calculated matrix of Thermal Coupling Coefficients (the conductance matrix) along with 
calculation precision indicators. 

Results Report 

Output of surface temperatures under defined boundary conditions at coldest surface points of each 
space, along with their location (coordinates) and respective temperature factors fRsi. 
The 2

nd
 part of this report outputs temperature values at given probe points under defined boundary 

conditions. 
If there is vapour solution also, values of vapour saturation pressure and partial pressure are 
also shown. 

 
Each output form contains the name and address of the user displayed at the top. Date and time of the output creation along 
with the program information are also shown. Please refer to license terms and conditions of use regarding these output 
contents. Just below the heading the file name (the project file) is shown followed by the user chosen short project 
description. Specific calculation and simulation results are displayed below this general information. 

 

 

Graphical Evaluations (Visualization) 
 

Graphical evaluations are used to visualize simulation results as two- and three-dimensional picture renderings. The 
choice of primary function provides following visualizations: 

 

  Representation of temperature distribution (colour mapped picture, iso-lines/isotherms, iso-surface, slices, profile-
diagram), 

  Representation of heat flux/heat stream flow (colour mapped, isolines, streamline(s), vector arrow(s), isosurface, 
slices, profile-diagram) und  

  Representation of dew point (colour mapped view, isolines),  
  Representation of interstitial (core) vapour pressure distribution (partial pressure, saturation pressure or 

pressure difference, relative core humidity) (colour mapped view, isolines/isobars, isourface, slices, profile-
diagram) 

  Representation of vapour diffusion flux/stream flow (colour mapped view, isolines, streamline(s), vector 
arrow(s), isosurface, slices, profile-diagram). 

 Visualizations can be easily adjusted to user's needs and according to specific requirements: 

  Changing the transparency/opacity of visible figures  
  Selection of value intervals and function specific adjustment  
  Choice of different slice planes or probing points  
  Selection of used colouring tables or by choosing single colouring  
  Switching to On/Off of specific elements of visualisations (surface, edges, axes, slice planes etc.)  
  Adjusting further display parameters. like light effects, position and size of the picture etc. 

 

http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/EingabeReportForm/EingabeReportForm.htm
http://help.antherm.eu/Forms/EingabeReportForm/EingabeReportForm.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.kornicki.com/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.kornicki.com/Forms/ReportBuilder/ReportBuilder.htm#Results#ProbePointsReport
http://help.antherm.kornicki.com/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.kornicki.com/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.kornicki.com/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Forms/DescriptionForm/DescriptionForm.htm
http://help.antherm.eu/Forms/DescriptionForm/DescriptionForm.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/FixedRange/FixedRange.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.kornicki.com/Introduction/81_Dampfdiffusion.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

71 
 

At any time the graphical display can be copied to the clipboard for further transfer to other applications (for example to 
create compound reports).  
Visualizations can also be saved (exported) to picture files (PNG, GIF, JPG, TIFF, ...) or to 3-D scene files (VRML, OOGL, 
IV, ...) for further processing. 
 
Following visualizations can be shown in Results 3D window : 

 

 

Temperature distribution: 
 
 

Surface 
temperatures  

Displaying the colour mapped distribution of temperature on the surface of the construction. The 
representation can be adjusted by choosing different colour table which assigns colour to intervals of 
the temperature values. 

Isotherms of  surface 
temperatures 

Displaying the distribution of temperature on the surface of the construction by isolines, i.e. lines of 
constant temperature. Isotherms can be coloured by applying the colour table which assigns colours to 
temperature values. The assignment of isolines to values of temperature can be controlled by user 
input. 

Temperature 
distribution on on a 
slice plane 

Displaying the colour mapped distribution of temperature on a slice plane cutting through the 
construction. The representation can be adjusted by choosing different colour table which assigns colour 
to intervals of the temperature values. The position of the slice plane - always parallel to axes planes - 
can be set by input of the coordinate at the intersection of the axis perpendicular to the slice plane. 

Isotherms on a slice 
plane 

Displaying the colour mapped distribution of temperature on a slice plane cutting through the 
construction by isotherms, i.e. lines of constant temperature. Isotherms can be coloured by applying the 
colour table which assigns colours to temperature values. The assignment of isolines to values of 
temperature can be controlled by user input. 

Isosurface for one 
value of 
temperature 

Displaying a surface of constant temperature (iso-surface) for one freely chosen value of temperature. 
The assignment of the colour of the surface to the represented temperature is applied by selecting 
colour table.  

Value of 
temperature at one 
chosen point. 

Displaying a numerical value of temperature at one freely chosen point of the constructions. The 
position of this probing point is set by positioning slice planes XY/YZ/ZX. The value shown corresponds to 
the point of intersection of those three planes. 

Diagram of 
temperature along a 
profile line. 

Displaying the X/Y-diagram of temperatures along the chosen profile line. The position of this profile line 
point is set by positioning slice planes XY/YZ/ZX. The diagram shown corresponds to values along the 
intersection of two of those three planes. 

 

Distribution of heat flux (heat stream and heat stream density): 
 
 

Heat stream density on 
construction's surface 

Distribution of heat flux (modulus of heat stream density) on the surfaces of the 
construction is shown as a coloured picture. The assignment of colours to heat stream 
density values depends on the chosen colour table.  

Isolines of heat stream density 
on the construction's surface 

Display the distribution of the heat stream density on the surfaces of the construction 
shown as isolines, i.e. lines of constant heat stream density values. The colour of the lines 
depends on the colour table chosen.  

Heat stream density on a slice 
plane 

Displaying the colour mapped distribution of heat flux on a slice plane cutting through the 
construction. The colouring of the slice plane depends on the colour table chosen. The 
position of the slice plane is given by one  coordinate. 

Isolines of heat flux on a slice 
plane 

Displaying isolines of heat stream density value on a slices plane cutting through the 
construction. Lines of constant stream density are coloured as set by the chosen colour 
table. 

Isosurface for one value of heat 
stream density 

Displaying a surface of constant value (iso-surface) for one freely chosen heat stream 
density. The colour of the surface depends on the colour table chosen.  

Streamline(s) tracing the heat 
flow through the construction 

Display of the heat flow streamline from/to any chosen point within the construction. The 
colour of the streamline depends on the colour table chosen.  

Vectors (HedgeHog, Arrows) 
tracing the heat flow through the 
construction 

Display of the heat flow at any chosen point or points within the construction by arrow 
glyphs. The size of vector symbols follows the heat stream density. The colour of glyph 
symbols depends on the colour table chosen.  
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Heat flux diagram along a profile 
line. 

Display of a X/Y-diagram of heat stream density along the chosen profile line. The position 
of this profile line point is set by positioning slice planes XY/YZ/ZX. The diagram shown 
corresponds to values along the intersection of two of those three planes. 

 

Dew point values at construction's surfaces 

 

Dew point values at 
construction's surfaces 

Displaying the colour mapped distribution of dew point values on the surface of the construction 
(calculated from the surface temperature and space air temperature). The representation can be 
adjusted by choosing different colour table which assigns colour to intervals of the dew point 
values.  

Isolines of dew point 
valuse on construction's 
surfaces 

Display of the distribution of dew point values on the surface of the construction shown as isolines 
(lines of constant dew point value). The assignment if the colours to dew point values depends on 
the chosen colour table.  

 

Distribution of vapour pressure difference, saturation and partial pressure, relative interstitial 
core humidity 

Pressure distribution on 
the construction's 
surface  

Display of pressure or pressure difference distribution on the surfaces of the construction is shown 
as a coloured picture. The assignment of colours to pressure values depends on the chosen colour 
table. 

Isolines of pressure 
distribution on the 
construction's surface  

Display of pressure or pressure difference distribution on the surfaces of the construction is shown 
as isolines, i.e.  lines of constant values. The colouring of isolines is applied according to the chosen 
colour table.  

Pressure- or pressure 
difference distribution 
on a slice plane 

Displaying the colour mapped distribution of pressure or pressure difference on a slice plane cutting 
through the construction. The representation can be adjusted by choosing different colour table 
which assigns colour to intervals of pressure values. The position of the slice plane - always parallel 
to axes planes - can be set by input of the coordinate at the intersection of the axis perpendicular to 
the slice plane. 

Isolines of vapour 
pressure on a slice plane 

Displaying isolines of vapour pressure or pressure difference on a slices plane cutting through the 
construction. Lines of constant pressure are coloured as set by the chosen colour table. 

Isosurface for one 
pressure or pressure 
difference value 

Displaying a surface of constant value (iso-surface) for one freely chosen vapour pressure or 
pressure difference. The colour of the surface depends on the colour table chosen. 

Output of pressure 
difference at one chosen 
point.  

Displaying a numerical value of pressure difference at one freely chosen point of the constructions. 
The position of this probing point is set by positioning slice planes XY/YZ/ZX. The value shown 
corresponds to the point of intersection of those three planes. 

Pressure difference 
diagram along a profile 
line. 

Display of a X/Y-diagram of pressure difference along the chosen profile line. The position of this 
profile line point is set by positioning slice planes XY/YZ/ZX. The diagram shown corresponds to 
values along the intersection of two of those three planes. 
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Distribution of the value of vapour stream density 

 

VAPOUR-Option: The analysis of multi-dimensional water vapor diffusion processes is only 
possible with the Vapour option of the program.  

Distribution of vapour 
stream density on 
construction's surface  

Display of vapour stream density distribution on the surfaces of the construction is shown as a 
coloured picture. The assignment of colours to density values depends on the chosen colour table. 

Isolines of vapour stream 
density on construction's 
surface  

Display of vapour stream density distribution on the surfaces of the construction is shown as 
isolines, i.e.  lines of constant values. The colouring of isolines is applied according to the chosen 
colour table. 

Vapour stream density 
on a slice plane 

Displaying the colour mapped distribution of vapour stream density on a slice plane cutting through 
the construction. The representation can be adjusted by choosing different colour table which 
assigns colour to intervals of density values. The position of the slice plane - always parallel to axes 
planes - can be set by input of the coordinate at the intersection of the axis perpendicular to the 
slice plane. 

Isolines of vapour stream 
density on a slice plane 

Displaying isolines of vapour stream density on a slices plane cutting through the construction. Lines 
of constant pressure are coloured as set by the chosen colour table. 

Isosurface for one 
vapour stream density 
value 

Displaying a surface of constant value (iso-surface) for one freely chosen vapour stream density. The 
colour of the surface depends on the colour table chosen. 

 

Streamline(s) tracing the 
vapour diffusion flow through 
the construction 

Display of the diffusion flow streamline from/to any chosen point within the construction. 
The colour of the streamline depends on the colour table chosen. 

Vectors (HedgeHog, Arrows) 
tracing vapour 
diffusion flow through the 
construction 

Display of the diffusion flow at any chosen point or points within the construction by arrow 
glyphs. The size of vector symbols follows the vapour stream density.  
The colour of glyph symbols depends on the colour table chosen.  

Vapour flux diagram along a 
profile line. 

Display of a X/Y-diagram of vapour stream density along the chosen profile line. The position 
of this profile line point is set by positioning slice planes XY/YZ/ZX. The diagram shown 
corresponds to values along the intersection of two of those three planes. 

 

See also: Evaluation windows, Results 3D window, Main menu, Main window, Secondary functions, Active function, 
Toolbar of Report windows 
 
 
 
 

http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
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Basics and Some Theory of AnTherm 
Primary Concepts 
 
 
 
The various terms and theoretical concepts, which form the basis for understanding the AnTherm 
application, are presented and defined briefly in the following sections. 
 
 
For a more thorough explanation of the theoretical background, please refer to the 

book "Wärmebrücken"Read more on theoretical concepts of AnTherm:  

 

 

See also: Theoretical background 
 
 
 
 
 

Basics and Some Theory of AnTherm 
 
Environmental Factors 
 
 
 

When analysing the thermal performance of building components, two different types of information are sought: thermal 
transmission and surface temperatures. 
 
The first type entails evaluating the heat transfer characteristics of a building assembly, i.e. the form and quantity of heat 
losses and gains, in order to ultimately obtain 

 

 a reliable estimation of heating and cooling loads (costs),  
 acceptable heat flow rates, 

 
             as well as 

 

 energy conserving design alternatives. 

 
Based on the heat transfer characteristics of a construction, the expected temperatures along interior surfaces must be 
evaluated in order to predict (and avoid) areas of potential moisture condensation. Beyond preventing damage to building 
materials caused by mould growth, adequate surface temperatures are also a relevant factor in the thermal comfort of an 
interior environment. 
 
See also: Thermal Transmission, Surface Temperatures

http://www.amazon.de/exec/obidos/ASIN/3211820248/tomaszkornickiwe
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/PrimaryConcepts/12_ThermalTransmission.htm
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Basics and Some Theory of AnTherm 
Thermal Transmission and Thermal Bridges 
 
 
 
 

Energy in the form of heat in building constructions is generally transmitted by a combination of conduction, convection, 
and radiation. When considering heat transfer within and through solid (homogeneous or non-homogeneous) building 
materials, heat conduction is the primary transmission factor; the effects of convection and radiation are typically 
negligible. 
 

heat 
conduction 

Conduction through homogeneous planar building components (i.e. composed of one or more layers of 
material with parallel surface planes) occurs in a single direction: normal to the component surface. This is 
referred to as one-dimensional heat flow, and is characterised by a constant surface temperature over the 
entire surface plane.  
Such idealised conditions can, of course, only be assumed in limited regions of an actual building structure. 
Geometries of non-planar components (construction joints, floor-wall connections, balconies, etc.) give rise to 
heat flow patterns of more than one direction, that is, to two- or three-dimensional heat flow. 
  

thermal 
bridge 
cold bridge 
heat bridge 

Regions or elements of a building construction characterised by multi-dimensional heat flow patterns are 
called thermal bridges. In contrast to regions of one-dimensional heat flow, thermal bridges are typically 
associated with local peaks of heat loss, which correspond to characteristic drops in the interior surface 
temperature. 
 
Thermal bridges, which in general occur at any junction between building components or where the building 
structure changes composition, have two consequences: 

a. a change in heat flow rate 
and 

b. a change in internal surface temperature 

compared with those of the unbridged structure.  
Although similar calculation procedures are used, the procedures are not identical for the calculation of heat 
flows and of surface temperatures. 

thermal 
bridge 
(defined in 
ISO 10211) 

Part of the building envelope where the otherwise uniform thermal resistance is significantly changed by:  

 full or partial penetration of the building envelope by materials with a different thermal conductivity 
and/or  

 a change in thickness of the fabric 
and/or  

 a difference between internal and external areas, such as occur at wall/floor/ceiling junctions  

linear thermal 
bridge 

Thermal bridge with a uniform cross-section along one of the three orthogonal axes (as defined by ISO 10211)  

point thermal 
bridge 

Localized thermal bridge whose influence can be represented by a point thermal transmittance (as defined by 
ISO 10211)  

 
See also: Thermal Heat Conductance, Methods of thermal heat bridge survey in international perspective 
 
 
 

http://help.antherm.eu/PrimaryConcepts/16_Transmittance.htm#point_thermal_transmittance
http://help.antherm.eu/PrimaryConcepts/14_Conductance.htm
http://help.antherm.eu/PrimaryConcepts/14_Conductance.htm
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Basics and Some Theory of AnTherm 
Conductance 
 

An exact description of the thermal behaviour of a building assembly would by nature be non-linear, and thus very 
complicated to evaluate. Fortunately, for most construction situations of interest, it is possible to drastically reduce the 
complexity of the physical model without sacrificing any appreciable accuracy. 
 
A linear description of thermal transmission involving an entire building can be introduced by 

 

 assuming that the temperature of each environment (space) associated with the building is unique, i.e. 
independent of position, and  

 forfeiting an exact treatment of radiation exchange within the spaces in favour of an approximation of this factor 
through adjusted surface transfer coefficients. 

 
 

thermal 
conductance, 
L

3D
  

 
[W/K] 

In light of this simplified physical model, it can be stated that the amount of heat which flows from one 
space to another, Q, is proportional to the temperature difference between the two environments under 
consideration (i and j). The factor of proportionality is a conductance , Lij, and linearly defined by 

                                         Q = Lij • ( Ti − Tj )  
  

conductance 
matrix 

The analogy of an electrical circuit can be extended to model a building structure more generally as a set of 
environments thermally connected through a resistance, i.e. the heat-conducting material elements. A 
complete description of the thermal relationships in a particular structure is given by a conductance matrix 
of values for all thermal connections, i • j, between the spaces of the model.  

The conductance matrix defines the heat transfer characteristics of a given model based solely on the 
geometry and materials (thermal properties) of the resistance, that is, independently of temperature 
conditions in adjacent spaces. This matrix is symmetrical. 
  

thermal 
transmittance, 
U-value, 
L

1D
 

[W/m
2
K] 

 

The area-related term "thermal transmittance" (U-value in Wm
-2

K
-1

) commonly used in standards to date 
essentially describes the same conductance as the reciprocal of the sum of resistances of a planar 
component, that is, resistances in "series":  

                           1/U = R = Rsi + ΣRj + 1/αse = 1/αsi + ΣRj + 1/αse 

whereby αsi and αse are the surface transfer coefficients of the interior and exterior environments, and ΣRj 
represents the sum of material resistances of j constituent component layers. The resistance of an 
individual homogeneous (isotropic) layer is directly proportional to layer thickness, d, and indirectly 
proportional to the material conductivity, λ: 

                                                  Rj = d/λ 

However, this simple formula applies only to the planar regions of a building assembly in which strictly one-
dimensional heat flow can be reasonably assumed. 
  

length-related 
conductance, 
L

2D
  

[W/mK] 
 

A further type of special situation is given where two-dimensional heat flow patterns are to be expected. 
Such a region is a stretch of the building assembly which can be evaluated with respect to a two-
dimensional section - under the assumption that no heat flow occurs normal to the section plane. In this 
case, a length-related conductance, L

2D
 [Wm

-1
K

-1
], must be calculated for the applicable region. 

The most general case, of course, is that of three-dimensional heat flow. For the regions of a construction 
in which no directional assumptions can be made about local heat flow patterns, only the evaluation of the 
(3D) conductance, L3D [WK-1], provides a reliable indicator of the thermal behaviour. 
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total 
conductance 

Due to the linearity of conductances, an entire building can be modelled as a sum of parts, with each part 
evaluated according to the applicable geometric conditions. Of course, the summation of conductances is 
only applicable if the temperature difference is the same through all model parts (e.g. one interior and one 
exterior temperature valid for the whole building). 

The model is sub-divided by introducing theoretical cut-off planes, which must be located such that any 
potential heat flow through these planes can be considered negligible. 

The total thermal conductance of a building thus modelled can be written as 

 

whereby lj is the length over which the two-dimensional conductance, L2D, is valid for part j, and Ak is the 
area of validity for Uk. 

This reliable and flexible approach to analysing the thermal performance of buildings is referred to in the 
Standards as the direct method. It requires the implementation of a suitable computer program for 
attaining two- and three-dimensional conductance results with the necessary precision 

The program AnTherm makes use of the linear nature of the heat conduction model by first determining a 
generally applicable calculation model: a characteristic set of temperature-independent base solutions (see 
also "Method of Analysis"). 

 

See also: Linear and Point Transmittance, The building envelope as thermal heat bridge, Theoretical background 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/PrimaryConcepts/50_MethodOfAnalysis.htm
http://help.antherm.eu/PrimaryConcepts/16_Transmittance.htm
http://help.antherm.eu/PrimaryConcepts/16_Transmittance.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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Basics and Some Theory of AnTherm 
Linear and Point Thermal Transmittance 
 

Often thermal bridges will be described in terms of linear and point thermal transmittances characteristic to building 
components analysed. 
 

linear thermal 
transmittance, Ψ 

[W/mK]  

Psi 

heat flow rate in the steady state divided by length and by the temperature difference between the 
environments on either side of a thermal bridge (definition in ISO 10211) 
NOTE The linear thermal transmittance is used as a correction term for the linear influence of a thermal 
bridge. 

The linear thermal transmittance is given by: 

 

where:  

Ψ   is the linear thermal transmittance Psi of the linear thermal bridge separating the two 
environments being considered; 

L2D   is the thermal coupling coefficient obtained from a 2-D calculation of the component separating 
the two environments being considered; 

Uj   is the thermal transmittance of the 1-D component j separating the two environments being 
considered; 

bj   is the length within the 2-D geometrical model over which the value Uj applies 
J   is the number of 1-D components. 

Note: When determining the linear thermal transmittance, it is necessary to state which dimensions 
(e.g. internal or external) are being used because for several types of thermal bridges the value of the 
linear thermal transmittance depends on this choice. 

  

point thermal 
transmittance, χ  

[W/K]  

chi 

heat flow rate in the steady state divided by the temperature difference between the environments on 
either side of a thermal bridge (definition in ISO 10211) 
NOTE The point thermal transmittance is used as a correction term for the influence of a point thermal 
bridge. 

The point thermal transmittance is given by: 

 

where:  

χ   is the point  thermal transmittance Chi of the point thermal bridge separating the two 
environments being considered; 

L
3D

   is the thermal coupling coefficient obtained from a 3-D calculation of the 3-D component 
separating the two environments being considered; 

Uj   is the thermal transmittance of the 1-D component j separating the two environments being 
considered; 

Aj   is the area over which the value Uj applies; 
Ψj   are respective linear thermal transmittances (see above); 
lj   is the length over which the value Ψj applies; 
J   is the number of 2-D components. 
I   is the number of 1-D components. 
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Note: When determining Ψ and χ values, it is necessary to state which dimensions (e.g. internal or 
external) are being used because for several types of thermal bridges the Ψ and χ values depend on this 
choice.. 

Rewriting the above equation by replacing the linear thermal transmittance by its definition, provides 
following alternative means of calculating the point thermal transmittance: 

 

  

An alternative expression for the total coupling coefficient Li,j which uses the linear and point thermal transmittances, Ψ and 
χ , is then given by 

 
 
 

 

where: 
 

Uk(i,j) is the thermal transmittance of part k of the room or building; 
Ak is the area over which the value Uk(i,j) applies; 
Ψm(i,j) is the linear thermal transmittance Psi of part m of the room or building; 
lm is the length over which the value Ψm(i,j) applies; 
χn(i,j) is the point thermal transmittance Chi of part n of the room or building;  
K is the number of thermal transmittances.  
M is the number of linear thermal transmittances;  
N is the number of point thermal transmittances; 

 
Note: In above formula ΣAk is equal to the total surface area of the envelope. 
 
Note: Li,j is equivalent to the heat transfer coefficient, H often used in other standards. 
 
See also: Conductance , On calculation of Ψ-values for building constructions in connection with ground, Theoretical 
background 
 
 
 
 
 

http://help.antherm.eu/PrimaryConcepts/14_Conductance.htm
http://help.antherm.eu/PrimaryConcepts/14_Conductance.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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Basics and Some Theory of AnTherm 
Surface Temperatures 
 

 

Once the base solutions describing a particular model have been established, temperature (boundary) conditions can be 
applied in the adjacent environments in order to predict a specific temperature distribution in the building component. 
 

condensing 
humidity / 
dew point 

Here the temperature along the component surface - where condensation is most likely to occur - is of 
particular interest. Humidity exceeding the saturation level of an environment, i.e. the condensing humidity 
or dew point) [%], leads to condensation. This value is directly linked to the temperature at any given 
location under. 
  

temperature 
extremes 

Therefore surface points at which a temperature minimum can be expected to occur must be localised in 
the model and explicitly evaluated with respect to specified conditions: 

  boundary conditions - air temperatures [°C]  

  position of coldest surface point (x, y, and z coordinates)  

  temperature of the surface at this point [°C]  

  associated condensing humidity (the dew point) [%] 

Note: Temperature maxima, i.e. warmest surface points, are primarily of interest when assessing the factor 
of thermal comfort in constructions which include heat sources. For example, situations in which electrical 
heating could be implemented (as floor heating, or as a measure against condensation) may be evaluated 
comparatively to determine if the power output needed could lead to uncomfortably high surface 
temperatures.  

Building elements which absorb and re-emanate solar gain can also be effectively approximated as heat 
sources and thus evaluated in order to assess constructions critically affected by solar radiation. 

Condensation 
Mould growth 
Corrosion/Rust 

Besides the avoidance of harmful water vapour condensation the mould growth or corrosion are also of 
importance. 
The mould growth can hold at 80% RH already. 
Corroding events can start even at 60% RH.  

 
 

Basics and Some Theory of AnTherm 
Weighting 
 
 
The air temperatures set in the spaces adjacent to a building component all contribute to the temperature distribution 
resulting within the component. Therefore, the specific temperature, T, at any given point in a model can also be 
described as the result of all the space temperatures, T0 through Tn, weighted for the specific position and summed:  

T = g0•T0 + g1•T1 + … gn•Tn 
 
g- The set of weighting factors, g0 through gn, must be determined for each point of the model to be considered more values 

closely. These so-called g-values are normalised such that their sum is equal to one. 
 

If all the interior spaces are set at the same temperature (Ti for T1 through Tn), and T0 is defined as the exterior 
temperature (Te), then the equation above can be simplified to  

T = g0•Te + (1 − g0)•Ti 
 

and re-written as 
 

T = Ti − g0• ( Ti − Te )  
In this case, g0 represents a generalised version of the f-value familiar from the evaluation of surface temperatures 

for one-dimensional heat flow (based on U-values). Contrary to a conventional f-value, which applies to the entire 

interior surface plane, the g-value above is only valid for a specific point of a thermal bridge. 
 
Once g-values have been characterised for the coldest points of all interior surfaces, however, the temperatures resulting at 
these points can be evaluated as simply as with the one-dimensional method Factors. 

 

http://help.antherm.eu/Theory/ZurGrenzfeuchtigkeit.htm
http://help.antherm.eu/Theory/ZurGrenzfeuchtigkeit.htm
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Results
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
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Basics and Some Theory of AnTherm 
Graphic Representation of Heat Flow 
 
 
Since the heat flow pattern of a thermal bridge is characteristically more complex than the single-direction flow through 
a planar component, graphic illustrations of bridge flow patterns can provide critical information at a glance. 
 
 

heat flow 
diagram 

One method of visualising two dimensional heat flow is to delineate the direction of flow (vector) through the 
building component with lines drawn at prescribed intervals. The area bounded by two lines in the diagram 
represents a heat quantity defined by the interval (e.g. given 10 intervals, the heat flow between two lines 
corresponds to 10% of the total heat flow in one direction through the surface of a given space). The denser the 
lines in a region of such a diagram, the more heat flows through this region. Thus local peaks of heat loss (and 
predictably cold surface points) are easily discernible.  

Due to the two-dimensionality of graphic illustrations, however, three-dimensional heat flow patterns cannot be 
meaningfully rendered with such a diagram. Therefore the three-dimensional rendering provides one streamline 
through the arbitrarily chosen point. 

isotherms The second common method of heat flow representation is to render the temperature distribution in a 
component with isotherms, i.e. by delineating lines of the same temperature at defined intervals. Isotherms lie 
normal to the direction of heat flow, thus providing an "inverted" rendering of the heat flow pattern (denser 
isotherms correspond to regions of increased heat flow).  

Since isotherms represent a two-dimensional section through a temperature distribution rather than vectors 
directly, the isotherm method is also suited for (partial) rendering of three-dimensional heat flow situations (on 
surfaces or slices). 

heat flux 
diagram 

Further method of heat flow representation is to render the heat flux distribution in a component - e.g. as 
colorized representation of values on on surfaces or slices or with isolines of the same heat flow density. Such 
rendering provides clear heat flow pattern and allows easy identification of regions of increased heat flow.  

isosurface For the three dimensional case the use of isosurface provides valuable alternative to isolines.  

As for isolines the isosurface is useful to emphasize a surface of same temperature and to assess the 
irregularities of temperature distribution within the components body in 3D. The isosurface of the temperature 
field lies normal to the direction of heat flow, thus providing an "inverted" rendering of the heat flow pattern. 

By utilizing the view onto the isosurface of equal values of heat flux one can visualize areas of increased heat 
flow rates and by that easily identify design, geometrical or material weak spots of the building component in 
three dimensional renderings. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm#2D%20Fall
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm#2D%20Fall
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm#MoveableProbePoint
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
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Basics and Some Theory of AnTherm 
Method of Analysis 
 
 

Heat flow in a building construction, as well as the subsequent temperature distribution, can be described mathematically 
by differential equations. Most importantly, these equations are linear and homogenous by nature. 
 
 

base 
solutions 

This means that one set of solutions, calculated for a specific set of conditions, can be "re-used" as the basis for 
solutions under differing conditions by superposition, i.e. by linear combination of selected base solutions. More 
specifically, base solutions are calculated under the assumption of a "basic" set of boundary conditions: with an air 
temperature of 1 in the selected space, and 0 in all others.  

Thus the temperature distribution, a function of the three spatial coordinates, can ultimately be written in the 
simple form of a sum of temperature values. The individual temperatures are the result of the actual boundary 
conditions (air temperatures in the given spaces from 0 to m) weighted by dimensionless base solutions: 

 

In other words, base solutions are effectively a generalised form of weighting factors (g-values) - a function of 
position for a given space, j: gj(x,y,z). 

The calculation approach in the program AnTherm uses this circumstance to minimise over-all evaluation time. 
One set of base solutions need be calculated only once to characterise a given model, which can subsequently be 
considered under varying boundary conditions without repeating the time-consuming computation necessary to 
solve the primary set of differential equations. 

Computation time is further reduced by utilising the weighting function character of base solutions (normalised 
such that their sum must equal 1). Hence, if n cases have been selected, only n-1 solutions need to actually be 
calculated. The n-th base solution is then very simply derived as a difference of the sum to 1, that is, by a separate 
stage of superposition. 

Basics and Some Theory of AnTherm 
Calculation Model 
 
 
Using the concept of a conductance, Lij (between the spaces i and j), the heat which flows out of space i is a sum 
depending on the temperatures of space i and of all other spaces, j: 
 
 

 

Since Lij can be proven to be symmetrical (= Lji), this equation corresponds formally to Kirchhoff's law of electrical networks. 
The analogy that this allows is quite significant: the spaces of a building construction (model) can be thought of as nodes in a 
heat conducting network. 
 

equation 
model 

Thus the heat conduction model, otherwise only describable with partial differential equations, can be 
mathematically defined as a relatively simple, linear system of equations with a given conductance matrix. 
Furthermore, only the thermal coupling between spaces which interchange heat directly through the building 
component ("neighbouring spaces") is of practical effect; coupling between indirectly connected spaces is 
generally negligible. 
  

boundary 
conditions 

As the equation above shows, in addition to the appropriate value in the conductance matrix, either air 
temperature or heating load must be defined for each space of the model (evaluation boundary conditions) in 
order to attain a complete description of a particular heat flow situation. 

http://help.antherm.eu/Datei/ArbeitenMitDateien.htm#Verzeichnis%20der%20Simulationsergebnisse
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
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Basics and Some Theory of AnTherm 
Numerical Solution 
 

The calculation method of finite differences used by AnTherm is based on the sub-division of the heat conducting continuum 
into an orthogonal cell structure. Each cell of this calculation geometry is treated as a node of the thermal network, and is 
typically connected with six other such nodes. The conductance of each connection depends on cell size and thermal 
conductivity of the material "filling" the individual cells. Therefore, the cell structure must be defined such that each cell can 
be assigned a single, homogeneous material. 
 
 

calculation 
geometry 

The calculation geometry is obtained by means of gridding the construction geometry of the model to be 
evaluated. A concrete grid is generated by dividing the model with a series of grid planes along material 
boundaries and at additional intervals (their number and distance depends on the precision of analysis 
required) parallel to the coordinate axes.  

Once the network data has been sufficiently defined for calculation, the program sets up an appropriate linear 
system of equations automatically. This equation system then needs to be solved numerically with an iterative 
method.  

relaxation 
factor 

The convergence process of the relaxation method used by AnTherm is entirely dependant on the value of the 
relaxation factor ω. Initially this factor is defined only within a given range: 
                                              1 ≤ ω < 2 

The "optimal" ω-value is defined as the constant value of ω which leads to the most expedient convergence of 
the calculation method. This value differs from case to case and is initially unknown. 

Once the system of equations describing the model has been determined, the first stage of calculation is 
therefore an analysis of this system, followed by an iterative calculation to approximate a preliminary 
"optimal" *-value, ω0. This stage can be influenced by two parameters defined in the solver-parameters form: 

  The termination condition for determining ω0 is satisfied when the absolute difference between last 
value of ω0 just calculated and the "old" value from the previous iterative step falls below a limit for 
which ω0 is considered solved. This limit is called OMEGAO_DELTA within the solver-parameter set. 

  A further termination condition is given by the maximum number of iterative steps which the 
program allows before stopping calculation and accepting the last value of ω0 as optimal for the next 
stage of calculation. This step number limit is defined by OMEGAO_STOP. 

A more precise approximation of ω0 (e.g. by setting a more stringent termination condition or increasing 
calculation time) is usually unnecessary, since ω0 just serves as an initial parameter for the relaxation factor 
ω, which is then modified with each iteration in the course of the second stage of calculation.   

relaxation 
factor 
variation 

The range of ω variation, 

                                               ωmin ≤ ω < ωmax 

depends on ω0 for the lower limit according to the following equation: 

                                             ωmin = ω0 - k • (ω0 - 1) • (ω0 -2), 

whereby k is a pre-defined parameter between -1 and 0.  

Since k is negative (ωmin < ω0), specifying a greater absolute value of k results in a larger difference between 
ωmin and ω0, and thus a larger range. This parameter is set as OMEGA_MIN.The upper limit of the range of ω 
variation, ωmax, is a set value between ω0 and 2. This is defined as OMEGA_MAX. 

In the second stage of calculation, the first step is performed with ω = ωmin. The relaxation factor is then 
increased incrementally with each iteration until either ωmax is reached or the process begins to diverge, 

http://help.antherm.eu/Introduction/50_Rasterung.htm
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whereupon ω is set back to ωmin and calculation continues. 

The increments of ω variation also vary: low values of ω in the beginning are run through rapidly, but the 
increment approaches 0 asymptotically as ω approaches the value of 2. The increments are calculated such 
that the approximated optimal value of ω0 is reached within a given number of iterations starting from ωmin. 
The standard number of assumed steps is relatively small number set as OMEGA_WEIGHT=-3. 

As already mentioned, ω is set back to ωmin as soon as the iterative results begin to recognisably diverge. The 
criterium for discerning whether the solution process is converging or diverging is the absolute value, Δmax, 
i.e. the deviation of the results from one iteration to the next. Hereby a mean value of Δmax is calculated from 
the last n steps and compared continually with the current Δmax. The number of steps included in the mean 
value for comparison, n, is also defined as a solver-parameter and called OMEGA_TESTNUM. 

The calculation process is considered divergent when Δmax equals or exceeds the comparative mean value. 
However, it would be impractical to set the relaxation factor back automatically every time this condition is 
satisfied before a certain minimum number of calculation steps has been performed. This quantity is a further 
criterium which must be met before an ω set-back occurs. The standard minimum number of iterations here is 
23, defined as OMEGA_VETO. 

An equation is ultimately considered solved when the deviation, Δmax, remains smaller than a defined limit 
for a continuous series of a prescribed number of iterations. This quantity is defined as TERM_NUM. 

Finally, in order to "smooth" the results of calculation, a post-run of iterations is performed with a constant 
relaxation factor, ω = 1 (defined as OMEGA_POSTRUN=1.0). An increase in this parameter should be avoided 
so as not to jeopardise the smoothing effect of post-calculation. The number of iterations of this stage is 
prescribed as POSTRUN=15. 
  

results 
precision 

In summary, three primary factors control the precision of calculation results:  

  fineness of the grid (calculation geometry).  

  stringency of the termination condition (calculation time).  

  precision of computation ("double precision").  

The first two of these factors can be manipulated by the user, though the standard parameters used by 
AnTherm are adequate for the evaluation of most models to be considered. 

 

 
 
 
 
 

http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm#Abbruchbedingung
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm#Abbruchbedingung
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Feinraster-Parameter
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Main application window 
 

The main window provides the primary working area for all control elements of the application. While working the 

application the control is performed by using the main menu and various editing, dialog or evaluation windows.   

File->Neu. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

On each application use its windows will be shown at their latest positions. On the absolutely first start of the application 
its windows will be shown at some tentative positions on the screen - as defined by a pre-installed template.  
Windows can be freely moved and sized. This allows adjusting the layout according to user's needs. During application 
shutdown current windows positions are saved along with other application settings. 
 
The main window's title bar displays the name of the currently open project file - if the file name has been assigned 
already - together with the indication of project's type (2D, 3DS, 3D). 
 
Depending on the project type of a new, opened, imported or converted project the application will automatically expose 
primary editing windows suitable for the project type and/or it will dispose (close) all windows which are not useful for that 
one project type and processing stage. 
 
 
 

 

Drag & Drop of a file onto the main window 
 

When a valid AnTherm project file is dropped onto the surface of the main window (after being dragged out from the 

windows file explorer) that file will be opened (equivalent to main Menu File->Open...). The name of the file will not be 

added to the Most Recently Used List unless the Shift- or Control-key is held depressed during the drop operation. 
 
Remark: Dropping of a Waebru component file is also supported. 
 
 
See also: Main menu, Editing and input windows, Evaluation windows, Dialog windows, Miscellaneous control elements 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Datei/Startup_LayoutPersistence_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Import/WAEBRU_Import.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Sonstige_Bedienelemente.htm
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Main menu 
 

Primary application functions are controlled and initiated from the main menu. The main menu is shown along the top 
edge of the main window. 
 

         
 

Where appropriate the main menu will be extended with further functions provided by an active window. For example the 

menu item File will contain the function Print if some report window is currently active. Likewise, when there is an active 

report window menu item File→Export will be extended with "→Export→Report..." and while there are active 3D windows 

(Elements3D, Results3D) the menu File will be extended with 3D-Navigation menu items, and accordingly, the menu 

File→Export with →Export→Image 3D... and →Export→Scene 3D... with menu Edit extended by →Copy Image 3D. 
 
During some processing steps are executing (e.g. longer operations like calculating the solution or preparing evaluation 
data) functions of the main menu will be turned off. This will be made visible by greying out the menu characters. While 
the menu is deactivated it is not possible to use it. 

 

 

Menu Project 

 

From AnTherm Version 9 on, there is the Menu Project. This menu allows the user to select project files from an existing 

project (such as "AnTherm-Examples") and open them. Moreover, the user can create new projects and add project files to 

them. In addition, there are functions such as copy or delete. This menu is supposed to make it easier for users to preserve an 

overview of all projects and project files. But the traditional way of accessing project files directly via the Menu File is still 

enabled. 

 

 

 

 

New Project 

 

Open Project 

 

Copy 

 

Delete 

 

Print 

 

Forward (works only if you have already opened a project) 

 

Settings 

 

About 

 

 

http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
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Once you open a project from the Project Selector Window (either by double-clicking the project button or clicking the button 
once and then clicking the "Open" button), the Project Details Window pops up: 

 

 

 

 

Add Existing File 

 

New File 

 

Open Reports Folder 

 

Save 

 

Back 
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Menu File 
 

Program functions put collectively into the menu File are used for file control.  
Occasionally there will be further menu items dynamically inserted to this menu, related to specific 

editing windows or result/evaluation windows (if such windows provide additional menu functions). 

 

New→ Creates a new project - see also project types. 
Important: prior to creating a new project it is recommended to 
save the current project's data! 

New→2D Project Create a new project for 2D dimensional input only (imput of the 
third dimension will be suppressed) 
Remark: A 2D project can also be thought as one layer of a "layered 
3D project" with the thickness of 1000mm. 
See also Project types. 

New→ Layered 3D 
Project 

Create a new project built from series of 2D layers. The input of the 
third dimesnion is provided by entering the thickness of each layer 
and ordering layers in the layers list . 
See also Project types. 

New→3D Project Create a new 3D project. Component's construction will be 
composed of series of cubes placed in the 3D space. 
See also Project types. 

Load... Loading an existent project file 

Load Recent→... A project file to open can be chosen from the list of recently edited 
project files. 
Remark: The number of file names shown (and remembered by the 
program) can be changed in application settings. 
Remark: The list of recently used project files will be saved to the 
application settings file between program executions. 
Remark: If the project file listed does not exist the message will be 
shown and the cleanup of the list offered. 

Save... A project file to open can be chosen from the list of recently edited 
project files. 
Remark: The number of file names shown (and remembered by the 
program) can be changed in application settings. 
Remark: The list of recently used project files will be saved to the 
application settings file between program executions. 
Remark: If the project file listed does not exist the message will be 
shown and the cleanup of the list offered. 

Save as... Will ask you to provide a file name before project data is saved. 

Import→ Files created with other applications can be imported into the 
application and the data will be transformed to a valid new project. 

Import→Waebru.?BT... Initiates an import from a WAEBRU component file (i.e. .2BT or 
.3BT file). 

Import→aCad DXF... Initiates an import from specially prepared DXF file. 

Import→Heat2 DAT... Initiates an import from a Heat2 text input file. 

Import→Heat3 DAT... Initiates an import from a Heat3 text input file. 

Import→Kobru 
86DAT… 

Initiates an import from a Heat3 text input file. 

Import→Image 
Underlay... 

Initiates an import and registration of an image underlay/overlay. 
Remark: This will register an image for XY-Plane only (typical for 2D- 
and 3D-Layered Projects). To register three underlay images for the 
3 planes of a 3D-Project (XY, YZ, ZX) use the context menu of 
respective quadrant within the Elements23 window. 

Export→ Project data (also including result reports for example) can be 
"exported" to various file formats for further processing in other 
applications. 

Export→Coupling Coeff. 
Matrix... 

Initiates an export of the matrix of coupling coefficients 
(Leitwertmatrix) to a CSV file which can be then otherwise 
processed. 
Remark: This menu function is only available if there are results 

http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#Schichten 3D Projekt
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#Schichten 3D Projekt
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/Datei/ArbeitenMitDateien.htm#Projektdateien
http://help.antherm.kornicki.com/Datei/ArbeitenMitDateien.htm#Projektdateien
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Anzahl gemerkten Projektnamen
http://help.antherm.kornicki.com/Datei/Settings_xml.htm
http://help.antherm.kornicki.com/Datei/ArbeitenMitDateien.htm#Projektdateien
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Anzahl gemerkten Projektnamen
http://help.antherm.kornicki.com/Datei/Settings_xml.htm
http://help.antherm.kornicki.com/Datei/Import/WAEBRU_Import.htm
http://help.antherm.kornicki.com/Datei/Import/DXF_Import.htm
http://help.antherm.kornicki.com/Datei/Import/Heat2_Import.htm
http://help.antherm.kornicki.com/Datei/Import/Heat3_Import.htm
http://help.antherm.kornicki.com/Datei/Import/Heat3_Import.htm
http://help.antherm.kornicki.com/Forms/RegisterUnderlayImage/RegisterUnderlayImage.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#2D Projekt
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#Schichten 3D Projekt
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#3D Projekt
http://help.antherm.kornicki.com/Forms/Elements2DForm/Elements2DForm.htm#Funktionen des Kontextmenüs
http://help.antherm.kornicki.com/Forms/Elements2DForm/Elements2DForm.htm#Funktionen des Kontextmenüs
http://help.antherm.kornicki.com/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.kornicki.com/Datei/Export/CSV_Export.htm
http://help.antherm.kornicki.com/Datei/Export/CSV_Export.htm
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#Menü Ergebnisse...
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(the solution) already created and available. 

Export→Report... Initiates an export of a result report to some external file which can 
then befurther processed. 
Remark: This menu function is only available if some report window 
is active. 

Export→Image 2D... 
Export→Image 3D... 

Allows saving of images to a picture file (PNG, TIF, JPG, BMP, GIF) 
and places the image onto the clipboard. 
Remark: This menu function is only available if some graphical 
window is active (e.g. Elements3D, Results3D, Elements2D, 
Elements23) 

Export→Scene 3D... Allows saving of a 3D scene to a 3D file (VRML, IV, OOGL, ...). 
Remark: This menu function is only available if thre is some 3D 
window (Elements3D, Results3D) active. 

Convert→ Project data can be "converted" to some other project type. 

Convert→Layered 3D 
Project 

Initiates the conversion of currently edited project data to a new 
layered 3D project. 
Remark: Not each project can be converted to that project type. 
See also Project types, conversion variants 

Convert→3D Project Initiates the conversion of currently edited project data to a new 
3D project (in a 3D project Z coordinates of elements can be 
entered directly). 
See also Project types, conversion variants 

Convert→2D Project Initiates the conversion of currently edited project data to a new 
2D project. 
Remark: Only projects homogenous in the third dimension (Z axis 
direction) can be converted to a 2D project (e.g. layered 3D project 
containing only one layer, or a 3D project of which all elements 
share same Z coordinates). 
See also Project types, conversion variants 

Convert→Revolve to 
3D... 

Initiates the conversion by revolution (rotation) of currently edited 
project data of a 2D project to 3D. 
See also Project types, conversion variants 

Print Report... Initiates printing of some report. 
Remark: This menu function is only available if some report window 
is active. 

Exit Initiates the shutdown of the application. 
Warning: please save project data prior to exiting the application! 

http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm#Exportieren des Berichts
http://help.antherm.kornicki.com/Auswertungen.htm#Berichte
http://help.antherm.kornicki.com/Datei/Export/Bild_Export.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.kornicki.com/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.kornicki.com/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.kornicki.com/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.kornicki.com/Datei/Export/Szene3D_Export.htm
http://help.antherm.kornicki.com/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#Konversionsmöglichkeiten
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#Konversionsmöglichkeiten
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#Schichten 3D Projekt
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#Konversionsmöglichkeiten
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#Konversionsmöglichkeiten
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#3D Projekt
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#Konversionsmöglichkeiten
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#Konversionsmöglichkeiten
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#2D Projekt
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#2D Projekt
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#Schichten 3D Projekt
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#3D Projekt
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#Konversionsmöglichkeiten
http://help.antherm.kornicki.com/Forms/RevolveTo3dParamsForm/RevolveTo3dParamsForm.htm
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#2D Projekt
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#3D Projekt
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#Konversionsmöglichkeiten
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm#Drucken eines Berichts
http://help.antherm.kornicki.com/Auswertungen.htm#Berichte
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#Speichern...
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Menu Edit 
 

Program functions placed collectively in the menu Edit are used for adjusting various 
processing parameters of the application. 
 
 

 

 
 
 

Occasionally there will be further menu items dynamically inserted to this menu, related to specific editing windows or 
result/evaluation windows (if such windows provide additional menu functions). 

 

 
 
 
 
 
 
 

Menu Results... (or the F5 function key) 
 

 

The menu Results... initiates calculation of results for the currently processed project. Occasionally you will be asked to 
save the project data to a project file and to set parameters for fine grid and for the solver engine. 
 
Before the calculation is actually started the application executes series of validation checks on the model construction 
entered. 
 
The calculation process can be observed in the Solver window. Which calculations are possible depends on actual model data 
and valid application license features. 
 
After the calculation has successfully completed the application will show the coupling coefficients report (Leitwerte) and will 

request the input of boundary conditions. Following the later further results reports and evaluations can be performed. 
 
See also: Solver window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fine-Grid Shows the dialog used to adjust fine grid generation settings of the 

params... current project. 
  

Solver Shows the dialog used to adjust settings of the solver engine in current 

params... project. 
  

Settings... Shows the application settings' dialog. 

  

http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Menu →Data Input & Entry  

      

The submenu Data Input & Entry groups functions  
used to open various editing and input windows of the 
application. In the normal case most of this windows can be 
opened in the processing context from other windows directly 
too. The menu Data Input & Entry provides in that sense an 
additional function only. 
 
 

Primary Edit 
Windows 

Opens primary input windows essential for the current 
Ptype of project (Description, Element selection, Layers, 
Elements 2D, Elements 3D, etc.) 
Remark: Which windows are considered essential can be 
set by user in the application settings for each different 
project type selectively. 

All Edit 
Windows 

Opens all input and edit windows of the application 

  

Description Opens the window "Descritpion" 

Edit Element Opens the window "Element Editor" 

Elements 
Browser 

Opens the window "Elements browser" 

Elements 2D Opens the window "Elements 2D" 

Elements 3D Opens the window "Elements 3D" 

Elements2/3D Opens the window "Elements 2/3D" 

Materials Opens the window "Materials" 

Surfaces Opens the window "Surfaces" 

Layers Browser 
Opens the window "Layers Browser"   
Remark:   Not offered for 3D project 

  

Translate 
Elements 

Opens the window "Translate" 

Stretch 
Elements 

Opens the window "Stretch" 

Rotate 
Elements 

Opens the window "Rotate" 

Mirror 
Elements 

Opens the window "Mirror" 

Status Report Opens the window showing the "Status report" 

  

Material 
Database 

Opens the window "Baustoffstammdaten" 

Isometries  
(of 3D views) 

The list of isometries is shown in the window Isometries. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/Forms/DescriptionForm/DescriptionForm.htm
http://help.antherm.kornicki.com/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.kornicki.com/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.kornicki.com/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.kornicki.com/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Erweiterte Benutzeroberflächeneinstellungen
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm
http://help.antherm.kornicki.com/Forms/DescriptionForm/DescriptionForm.htm
http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm
http://help.antherm.kornicki.com/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.kornicki.com/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.kornicki.com/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.kornicki.com/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.kornicki.com/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.kornicki.com/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.kornicki.com/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.kornicki.com/Forms/TranslateForm/TranslateForm.htm
http://help.antherm.kornicki.com/Forms/StretchForm/StretchForm.htm
http://help.antherm.kornicki.com/Forms/RotateForm/RotateForm.htm
http://help.antherm.kornicki.com/Forms/MirrorForm/MirrorForm.htm
http://help.antherm.kornicki.com/Forms/RaportForm/RaportForm.htm
http://help.antherm.kornicki.com/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
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Menu →Evaluation & Reports 
 

The submenu View→Evaluation & Reports groups together 
functions used to open various results- and evaluation 
windows of the application.  
 

 
Report builder 

 
Opens the window “Report builder” 

 
Boundary Conditions 

 
Opens the window "Boundary Conditions" 

Probe Points / 
Min/Max 

Opens the window "Probe Points /Extreme 
(min/max) Locations" 

  
 
Data-Entry Report 

 
Opens the window "Data-Entry Report" 

     
Modelling Report 

 
Opens the window "Modelling Report" 

  
Results Report Opens the window “Results Report 
Coupling Coeff. 
Report 

Coupling Coeff. Report Opens the window 
"Thermal Coupling Coefficients” Report 

  
Surface 
Temperatures 

Opens the window”Surface Temperatures” 

Results3D 
Visualisation 

Opens the window "Results 3D" 

Isometries (of 3D 
views) 

The list of isometries is shown in the window 
Isometries. 

Results 3D 
Parameter 

The choice list of evaluation parameters is shown 
in the window Results3D parameter 

  
 
 
 
 
 

Menu View→2D Navigation  

 

The Menu → View is only for an active window. Functions of this menu control the movement of the element display within 
the view. 
 

 

Zoom In Zoom Out The view can be „scaled“. 

Fit to window Adjust the position and scaling in such way, that the whole construction is visible within the 

window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/EingabeReportForm/EingabeReportForm.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
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Menu View→3D Navigation 
 

Menu items of 3D navigation are displayed as sub-items of the menu View 
if there is a 3D window active (Elements3D, Elements23, Results3D). 
Functions of this menu control the movement of the camera (observer) 
within the three dimensional scene. 
 

Side Turns the 3D view. The camera is moved to one of side view 
positions (Front, Bottom, Top etc.) 

Rotate The camera is moved on the surface of a sphere (the distance 
to the object's centre does not change). 
Turns are executed in 30° steps 

Spin The camera is moved on the surface of a sphere (the distance 
to the object's centre does not change). 
Turns are executed in 30° steps 

Pan The camera pans. 

Zoom 
In/Out 

The camera moves forwards or backwards. 
With the parallel projection it is equivalent to scaling the 
view. 

Fit The scaling and position of the view is adjusted to fit the 
whole building construction within the window's view. 

Revert Restore the original standard camera position.  
X/Y plane parallel to view plane. Z axis point towards the 
viewer. Y axis points upwards. Scaling adjusted to fit the view. 

Perspective Swithes the 3D display between perspective projection and 
parallel projection. 
The parallel projection is useful for 2D components or slice 
views (see also "Side Views" here above). 

Collect 
Isometry 

The current position of the 3D display (in Elements3D, 
Elements23 or Results3D) is added to the project specific list 
of isometries. 
The list of isometries can be edited in the window Isometries 
(each entry can be named for example) or one of listed 
isometries can be selected from the list and applied to 3D 
views. 

Show 
Isometries 

The list of isometries is shown in the window Isometries 

 
See also: 3-D Navigation (control panel), 3D Navigation in 3D windows, Track-Ball Rotation, Results3D window, Elements3D 
window, Elements23 window, Isometries window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#Perspektive
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#2D Projekt
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.kornicki.com/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.kornicki.com/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.eu/Forms/Elements23Form/Elements23Form.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

94 
 

Menu View→Results 3D 
 

Menu items of Results 3D are displayed as sub-items of the menu View (see above) if there is Results3D window active. 
Functions of this menu control settings (parameters) of the evaluation. 
 
 
Collect Isometry The current position of the 3D display is added to the project specific list of isometries. 
 The list of isometries can be edited in the window Isometries (each entry can be named for 
 example) or one of listed isometries can be selected from the list and applied to 3D views. 
   

Show Isometries The list of isometries is shown in the window Isometries. 
  

Collect Results3D Current settings (parameter) of a graphical evaluation in the Results3D window are saved and 

Parameter added to the project specific choice list of evaluation parameters. 
  

Show Results3D The choice list of evaluation parameters is shown in the window Results3D Parameter. 
Parameters  
  
 
See also: Results3D Parameter window, Isometries window, Results3D window, General (control panel), 3D Navigation 
(control panel) 

 

 
 

Menu Window 
 

 

The Window menu holds functions used for management of windows. In addition a list of 
open windows is pinned at the bottom of the menu and thus allows direct access to this 
windows (e.g. activation and bringing the window to front). 
 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Close all windows Closes all application window (except from main application window). 

  

 Window positions will be reset to its initial positions as of the very first 

Revert window application start-up. 

positions Remark: You must additionally confirm that request before it is 

 executed. 

 See also: Initial template of window positions 

 AnTherm.exe.LayoutPersistence.xml 
  

List of window List of all open windows. It is used to activate any of already open 

names windows. 

 Remark: The list is shown only in the MDI application mode. 
  

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Datei/Startup_LayoutPersistence_xml.htm
http://help.antherm.eu/Datei/Startup_LayoutPersistence_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Menu Tools 
 
The menu Tools collect various application tools. This additional function collectively shown in this menu have no direct 
impact on edited construction and are used as help for calculations. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Materials Database Opens the window "Materials Database" 

Materials Database(Custom) Opens the window "Materials Database" 
Custom 

Psi-Value  Calculator 
(manual). 

The manual tool to calculate a Psi-Value used for rapid 
calculation of the linear thermal transmittance of arbitrary 
thermal heat bridge. 

Psi-Value  Calculator 
(automatic) 

The automatic tool to calculate a Psi-Value used for rapid 
calculation of the linear thermal transmittance of arbitrary 
thermal heat bridge. 

Chi-Value Calculator The manual tool to calculate a Chi-Value 

U-Value Calculator A tiny tool to calculate a U-Value of a layered construction. 

Air Cavity Calculator A tiny tool to quickly calculate equivalent heat transfer 
coefficient of small air spaces and cavities based on 
dimensions of the cavity and heat stream direction. 

Condensing Hunidity 
Calculator 

A tiny tool to calculate condensing humidity (dew point) 
based on input of surface temperature and space (air) 
temperature. 

Periodic / Harmonic Data 
Editor 

Provides the means of creating, editing and managing 
periodic data required as boundary conditions to transient 
evaluation (requires TRANSIENT license feature) 

Inhomogenous Calculator The Inhomogenous Layer Calculator can be used to 
compute the features of a thermally equivalent 
homogenous layer. Possible applications include brick 
masonry and wooden walls. 

Expression Evaluator A tiny pocket calculator able to calculate simple expression 
(formulas) like 1/25 or Math.Sin(3.14). 

Solution Folder Cleaner A tool used to cleanup unneeded simulation folders. 

New AnTherm Instance The second (or next) new instance of AnTherm will start in 
parallel to the current.  
Remark: Neither current project data nor application 
settings are saved! The new instance loads with earlier 
settings. 
Remark: This function is available only if the setting 
"Multiple app-instances allowed" has been activated within 
application settings. 

New Instance Saved Project After requesting the user to save project data (equivalent to 
File->Save as...) the second (or next) new instance of 
AnTherm will start and load the project data just saved. 
Remark: Current application settings are not saved! The 
new instance loads with earlier settings. 
Remark: This function is available only if the setting 
"Multiple app-instances allowed" has been activated within 
application settings. 

Settings... Shows the application settings' dialog. 

http://help.antherm.kornicki.com/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.kornicki.com/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.kornicki.com/Forms/PsiValueSimpleCalculatorForm/PsiValueSimpleCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/PsiValueSimpleCalculatorForm/PsiValueSimpleCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/AirSpaceCalculatorForm/AirSpaceCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/AirSpaceCalculatorForm/AirSpaceCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/GrenzfeuchteCalculatorForm/GrenzfeuchteCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.kornicki.com/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.kornicki.com/Datei/Lizenzdatei.htm#Features
http://help.antherm.kornicki.com/Forms/ExpressionEvaluatorForm/ExpressionEvaluatorForm.htm
http://help.antherm.kornicki.com/Forms/SolutionFolderCleanerForm/SolutionFolderCleanerForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Mehrfache Programminstanzen zulassen
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Mehrfache Programminstanzen zulassen
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Mehrfache Programminstanzen zulassen
http://help.antherm.kornicki.com/Forms/MainForm/MainMenu.htm#Speichern unter...
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Mehrfache Programminstanzen zulassen
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Mehrfache Programminstanzen zulassen
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Mehrfache Programminstanzen zulassen
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Menu Help 
 

 

In the menu Help you will find links to various help and information functions of the application 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Remark: With the application setting "Help Window shown TopMost" the user can decide if the Help window will be 
shown topmost to all application windows and automatically minimize with the application (which is the windows default 
behaviour) or it can be set behind the application window via typical desktop window manager (default application 
setting). 
 
See also: The main application window, Editing windows (Input windows), Evaluation windows, Dialog windows 
 
 
 
 

Contents... Shows the help window and the table of contents of the application's help 

 system. 
  

Search... Shows the help window and a keyword search window of the application's 

 help system. 
  

Example Load... Using the same function as of File->Load a list of files in the examples 

 folder (created during installation) will be offered. This allows quick access 

 to example files deployed together with the application installation. 
  

Tutorial.... Shows first page of tutorials (cook book). 
  

Reference.... Shows first page of short reference. 
  

Tip of the Day.... Shows the dialog window "Top of the Day". 
  

Release Notes.... Shows first page of the change log (history of changes to applications). 
  

AnTherm@WWW... Shows the AnTherm's web page on internet (requires internet connection). 

 Currently the page at the URL http://www.antherm.kornicki.de/ is shown. 
  

Check for Checks if there are updates or new version of the application (requires 

Updates... internet connection). 

 Currently the page at the 
 URL http://www.antherm.kornicki.de/support/CheckForUpdates/ is 
 shown.. 
  

Help on Help... Shows the help window describing the usage of the help system. 
  

Info-„About“… Shows the About window of the application (application adn system 
 environment, license, etc.). 
  

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Inhalt.htm
http://help.antherm.eu/Tutorials/index.htm
http://help.antherm.eu/Kurzreferenz.htm
http://help.antherm.eu/Forms/TipOfTheDayForm/TipOfTheDayForm.htm
http://www.antherm.kornicki.de/
http://www.antherm.kornicki.de/support/CheckForUpdates/
http://help.antherm.eu/Forms/frmAbout/frmAbout.htm
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Editing windows (Input windows) 
 
Editing (or Input) windows are used for entry, modification or adjustment of data of one modelled constructions. 
 
Following editing windows are used in most cases: 

 
 Description  
 Element selection  
 Elements 2D  
 Elements 3D  
 Elements 2/3D  
 Element editor  
 3D-Layers 

 
and most of them share the common Context Menu of Element Editing Functions. 
 
During data entry further windows might be helpful: 

 
 Boundary conditions  
 Probe points  
 Materials and Material  
 Surfaces and Surface  
 Translate together with Rotate, Mirror, and Stretch (i.e. transforms)  
 Materials Database 

 
together with following tools: 

 
 Ψ-Value (Psi Value) Calculator (tool)  
 U-Value calculator (tool)  
 Air cavity calculator (tool)  
 Condensing Humidity (Dew point) calculator (tool)  
 Periodic / Harmonic Data Editor  
 Expression calculator (tool) 

 
In addition to the above editing/input windows there are further dialog windows used for more input. 



Undo (Ctrl-Z) and Redo (Ctrl-Y) of editing actions 


 
 

Editing windows provide the Undo action via the menu entry or a keyboard shortcut Ctrl-Z. 
 
The editing sequence up to 1000 editing actions can be easily undone to revert to the input state valid prior to the 
respective action. 
Actions Undone recently can be redone in the same order (Redo, Ctrl-Y). 
 
Executing an Undo or Redo action will expose the editing window the action originated from or primarily responsible for 
the action. 

  

 Undo  (Ctrl-Z) 

Undoes (reverts) the latest action(s) in the given context. 
Remark: Undo operations are available to element and material property editing 
actions. 

  Redo (Ctrl-Y)               
Redoes (reapplies) the action lately undone in the given context. 

 
 
Remark: The undo buffer ist kept within the context of the current project and will be emptied upon creation, loading, 
converting etc. actions applied to the project itself. 
 
See also: Dialog windows, Evaluation windows (Results windows), The main window, Context menu of element editing, 
 
 
 

http://help.antherm.eu/Forms/DescriptionForm/DescriptionForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialEditor/MaterialEditor.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/SurfaceEditor/SurfaceEditor.htm
http://help.antherm.eu/Forms/TranslateForm/TranslateForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
http://help.antherm.eu/Forms/JoinedTransformsForm/JoinedTransformsForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/PsiValueSimpleCalculatorForm/PsiValueSimpleCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/AirSpaceCalculatorForm/AirSpaceCalculatorForm.htm
http://help.antherm.eu/Forms/GrenzfeuchteCalculatorForm/GrenzfeuchteCalculatorForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/ExpressionEvaluatorForm/ExpressionEvaluatorForm.htm
http://help.antherm.eu/Forms/Dialogfenster.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/Dialogfenster.htm
http://help.antherm.eu/Forms/Dialogfenster.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
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Description - window 
 

 

In the window description you input a short description of the project - as one or multiple lines of text. 
 

 
 
 

                         
                                        
 
 

The project description is output in the heading of all project reports. 
 
Project description can be arbitrarily changed in this window. 

 

 
 
 
 

                                        
 
 
 
 
 
 

See also: Reports, Standard project template file projekt.xml 
 
 

http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
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Element selection (browser) - window 
 

Element selection (element browser) window shows the list of all input elements of the construction (or elements of the 
active layer) in specific order of overlapping. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

From that window you can select elements for editing, insert new elements, reorder elements in their overlapping order 
(promote or relegate) and also delete elements. 
 

 
            Element list List of all elements entered (or elements of the active layer) in specific order of overlapping. 

        New Inserts a new element (of type "Empty") to the end of the list. 

        Duplicate 
Inserts a copy of currently selected element(s) into the element list.  
Further details on duplicate function are provided in the description of the context menu of 
elementediting functions. 

        Delete 
Deletes selected element(s) from the list. 
After deleting one selected element the selection move to the one before the deleted. 
When first element has been deleted the one becoming first after deletion is selected. 
If more then one element are selected actual deletion is executed if additionally confirmed by the 
user. 
See also: Cut elements to clipboard 

      Undo(Ctrl-Z) 
Undoes (reverts) the latest action(s) in the given editing context. 

       Redo(Ctrl-Y) 
Redoes (reapplies) the action lately undone in the given editing context. 

      First element 
Selects the first element in the element list. 

      Previous 
Selects an element which is previous to the currently selected in the element list. 

      Next 
Selects an element which is next to the currently selected in the element list. 

     Last element 
Selects the last element in the element list. 

 

    Relegate to 
          Backmost 
            

Reorders selected element(s) in the list to the "backmost" position. The element is then located at 
the beginning of the list thus now being potentially overlapped by all other elements. 
If more elements are selected then each one is relegated by the same distance as the backmost 
selected one. This action is inhibited if the chosen element does already occupy the first 
(backmost) location in the list. 

 

      Relegate 

Reorders selected element(s) in the list one position "backwards". The element is then located 
earlier in the list thus now being potentially overlapped by another element which have thus been 
promoted to the location of the element relegated. 
If more elements are selected then each one is relegated by one position in the list order. 
This action is inhibited if the chosen element does already occupy the first (backmost) location in 
the list. 

 

       Promote 

Reorders selected element(s) in the list one position "towards front". The element is then located 
later in the list thus now potentially overlapping another element which have thus been relegated 
to the location of the element promoted. 
If more elements are selected then each one is promoted by one position in the list order. 
This action is inhibited if the chosen element does already occupy the last (front most) location in 
the list. 

  

http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
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     Promote to 
            Frontmost 

Reorders selected element(s) in the list to the "frontmost" position. The element is then located 
at the end of the list thus now potentially overlapping all other elements. 
If more elements are selected then each one is promoted by the same distance as the frontmost 
selected one.  
This action is inhibited if the chosen element does already occupy the last (front most) location in 
the list. 

Click right mouse         
button 

Exposes the context menu of element editing functions 

Click left mouse 
button 

Selection of an element in the element list. 

Double-click left 
mouse button 

Selection of an element in the element list and exposing the Element editor window for that 
selected element. 

Click CTRL+left 
mouse button 

Extend the selection with the one element clicked or removes the element clicked from the 
current selection. 

Click SHIFT+left 
mouse button 

Extends the selection with all elements between the one clicked and the one selected earlier. 

Drag left mouse 
button 

Selecting of one or more elements touched with the mouse pointer during the drag operation. 

 
 
 
 

Elements list 
 

Each line of the elements list represents one input element. The line shows the type of the element (Space, Material, Power 
source, Empty), its position given by entered coordinates (x1,y1,z1)-(x2,y2,z2), name of the material used or of the surface, 
space or power source together with its physical properties such as heat conductivity of the material or surface heat transfer 
coefficient. 
 
When the mouse pointer hovers over one element the properties of the element under the pointer are shown in a tooltip 

(small informational popup window). The tooltip text disappears after 5 seconds or on any mouse movement or click. 
 
Columns Number# and Type are rendered by approximating the colour of an element (the text is rendered in the contrast 
colour depending on the value of the element colour). 

 

 
 

 Element editing 
 

 
A double click over a element's line in the elements list will 
open the Element editor window or expose it if it is already 
open. 
Clicking the right mouse button over the elements list will 
reveal (possibly very complex) context menu of element 
editing allowing choice of element processing functions. This 
context menu and its commands are common to all element 
editing windows and is described separately. 

 

 

. 
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Element selection 
 

Clicking with left mouse button with the mouse pointer placed over a line within the elements list will select the element 
clicked Keyboard's arrow keys can also be used for such single element selection. 
 

      Element selection buttons can be used to select single elements: the first in the order, previous to 

the currently selected, next to the current or the last one in the element list. 

 

 

Selection of multiple elements 
 

While holding the control-key (CTRL) one can click on one line of the element list to add that element to the selection or to 
remove it from the current selection. 
 
While holding the shift-key (SHIFT) one can click on one line of the element list to select all elements between the line 
clicked and the element selected just beforehand. 
 
The selection can also be extended by dragging with the pointer over elements while holding the left mouse button 
pressed. 
 

 

Reordering (promoting/demoting) of elements 
 

The order of elements shown in the element list is significant for resulting overlapping effect of elements intersecting one 

another. Changing the order of elements in the element list leads to change in the overlapping effect. By overlapping 

elements in the order of input one receives automatically dynamic intersection of elements positioned earlier in the order. 
 

 Command buttons "Promote" or "Relegate" are used to move selected elements in the list and thus they 
change the order of overlapping intersections. 

 
Promoting and relegating is also possible of several elements are selected. Each selected element is shifted by one position 
until the block of selected elements reaches the start or the end of the list. If the first or last selected element has already 
reached beginning (or end) of element list no further reordering action in this direction can be performed any more - this 
limitation provides the ability to revert the operation in the opposite direction to eventually restore to the original situation 
(order). 
 
 
See also: Element Editor, Order of overlapping, context menu of element editing, Types of elements, Layers window 

http://help.antherm.eu/Forms/EditForm/EditForm.htm
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Elements 2D - window 

 

The Elements 2D window, together with element list and the element editor provide 
the central front end of the application used for data input of a modelled building 
construction component. Pressing the right mouse button exposes the context menu 
offering all element editing functions. 
 
The Element 2D window shows graphically the list of all input elements (or 
elements of the active 3D-layer) in the specific order of overlapping. 
 
Remark: This window has its primary use for 2D- and 3D-layered models only. For 
pure 3D models it will only show the Z-view onto the model - thus it is advised to use 
the Elements 23 window to process pure 3D models. 
 
On one hand the window provides an instant graphical view onto the component 

under construction. On the other it is used as an input device together 

with the mouse as a tool to edit current construction. Graphical sizing of elements is supported with the snapping grid. 
From this window one can select elements for processing, add new elements, change the overlapping order (promote or 
relegate) of elements or delete them.  
The 2D view can be copied onto the clipboard to be pasted later into another application (e.g. Word) from the clipboard - for 

example for the purpose of integrating this view into some user's report. The image can be saved to a picture file also. 
 
Remark: Functions offered in this window are by far comparable to those offered by Element selection (browser) window, 

because both windows show the same list of elements, but in two different representations - graphical and textual. 

 

 
 

Element graph Graphical representation of all elements input (or elements of the active layer) in the 

 specific order of overlapping. 
  

         New 
Inserts a new element (of type "Empty") to the end of the element list. 
 

  

        Duplicate 
Inserts a copy of currently selected element(s) into the element list. 

Further details on duplicate function are provided in the description of the context menu  

 of element editing functions. 
  

  Delete 
Deletes selected element(s) from the list. 

After deleting one selected element the selection move to the one before the deleted.  

 When first element has been deleted the one becoming first after deletion is selected. 

 If more then one element are selected actual deletion is executed if additionally 

 confirmed by the user. 

 See also: Cut elements to clipboard 
  

  Undo(Ctrl-Z) 
Undoes (reverts) the latest action(s) in the given editing context. 
 

  
  

  Redo(Ctrl-Y) 
Redoes (reapplies) the action lately undone in the given editing context. 
 

  
  

 Selects an element which is first, previous to the currently selected, next to it or last in 

 the element list. 

 
 

 Relegate to Backmost Reorders selected element(s) in the element list to the "backmost" position. The 

 element is then located at the beginning of the list thus now being potentially 

 overlapped by all other elements. 

 If more elements are selected then each one is relegated by the same distance as the 

 backmost selected one. 

 This action is inhibited if the chosen element does already occupy the first (backmost) 

 location in the list. 

 
 

Relegate Reorders selected element(s) in the element list one position "backwards". The 

 element is then located earlier in the list thus now being potentially overlapped by 

 another element which have thus been promoted to the location of the element 

 relegated. 

 If more elements are selected then each one is relegated by one position in the list 

 order. 
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http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
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http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
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 This action is inhibited if the chosen element does already occupy the first (backmost) 

 location in the list. 

 
 

 Reorders selected element(s) in the element list one position "towards front". The 

          Promote element is then located later in the list thus now potentially overlapping another 

 element which have thus been relegated to the location of the element promoted. 

 If more elements are selected then each one is promoted by one position in the list 

 order. 

 This action is inhibited if the chosen element does already occupy the last (front most) 

 location in the list. 
  

  Reorders selected element(s) in the element list to the "frontmost" position. The 

          Promote to Frontmost element is then located at the end of the list thus now potentially overlapping all other 
        elements. 
 If more elements are selected then each one is promoted by the same distance as the 
 frontmost selected one. 
 This action is inhibited if the chosen element does already occupy the last (front most) 
 location in the list. 
  

Click right mouse button Exposes the context menu of element editing functions 
  

Click left mouse button Selection of an element in the element list for further processing. 
  

Turning the mouse wheel The view will be "scaled" - displayed area will be zoomed. 

 Remark: The scaling operation focuses around the mouse pointer. This allows zooming 

 of the area of interest directly followed by ability to pan the view with the mouse. 

 Remark: If one of the scrollbars has focus, then turning the mouse wheel will result in 

 scrolling (instead of zoom). 

 Remark: During drag operations of the editing mark the function of scaling by the wheel 

 mouse turns is suspended 
  

 Fit 
The position (scroll) and scaling (zoom) of the view will be adjusted to display the 
whole component in the window. 

 

 Remark: If there is an underlay registered and visible its bound will be taken into 

 account also. 
  

Drag with left mouse button The view will be „scrolled“ - displayed area is panned following the mouse. 
depressed (not on the edit Remark: You can use scroll bars to pan the view also. 

marker)  
  

Drag with left mouse button Translates the element or changes the position of element's side or its corner. 

depressed (on the edit marker) Remark: If snapping grid is active, translations are adjusted to valid snapping grid line 

 positions also. 
  

Double-click left mouse button Selection of an element in the element list and exposing the Element editor window for 

 that selected element. 
  

Click CTRL+left mouse button Extend the selection with the one element clicked or removes the element clicked from 
 the current selection 
  

Drag SHIFT+left mouse button Selection of element(s) with a lasso 
  

Drag SHIFT+CTRL+left mouse Extending the selection of element(s) with a lasso 

button  
  

CTRL+C, CTRL+X, CTRL+V Copy or Cut selected elements to the clipboard or Paste elements from the clipboard. 
  

Copy Image 
Allows saving of the image to a picture file (PNG, TIF, JPG, BMP, GIF) and places the 

image onto the clipboard. 
 

 See also: application setting "clipboard image Save-To-File option" 
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The graphical display 
 

The window displays a 2-dimensional slice through the building component. Elements are drawn in 
the order of their appearance in the element list. This results possibly (and as desired) in the effect of 
overlapping of elements being immediately visible on the screen  
 
 
When the mouse pointer hovers over one element the properties of the element under the 
pointer are shown in a tooltip (small informational popup window). The information shown 
applies to the visible (i.e. not overlapped) element. The tooltip text disappears after 5 
seconds or on any mouse movement or click. 
 
Each element is displayed differently depending on its element type and defined colouring: 

 
 material elements are shown filled in their defined colour  
 empty elements are shown as edge line surrounding the „empty area“ and with two 

diagonal lines 
 space elements are filled with waved lines  
 power source elements are filled with a fine net of lines and coloured in red. 

 
 
 
 

Due to the overlapping effect (which is also desired) one or more elements might be fully obscured 
and thus not visible at all. Such (fully obscured) elements are emphasized with a selection marker only 
if they are selected in the element list. 
 
Selected elements are emphasized with selection markers. When only one element is selected a 
editing marker is shown instead and can be used to size or move that one element. 
 
Remark: Line representation used to show elements with zero extent might be too thin at smaller 
view scaling and not visible. Such elements are visible only when selected. 
 
The display can be adjusted according to users needs as required: 

 
 Scrollbars allow panning of the view (which is also possibly by simply dragging the view with the 

mouse).  
 Turning the mouse wheel will scale the view around the point below the mouse pointer (enlarged or shrunken).  
 The fitting function adjusts the position and scaling in such way, that the whole construction is visible within the 

window.  
 The colour of the background (which is by default set to black) can be changed within the application setting 

"Background 2D-colour".  
 A registered image can be displayed as an underlay or as partly transparent overlay for better orientation during 

creation of the model. 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
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Element selection 
 

One or more elements in the element list can be selected. Selection can also be performed within the graphic view in this 
window: 

 
 by using the lasso function one can select many elements for further processing  
 a mouse click while the mouse pointer rests over one element will select that element which then will be 

emphasized with an editing marker.  
 Remark: If there are more elements stacked below the mouse pointer, each next mouse click will select the one 

behind the one currently selected (i.e. in the opposite order to the overlapping sequence).  
 a mouse click while the control key (CTRL) is depressed will add the element below the mouse pointer to the list of 

selected elements. 

 by element selection buttons to select single elements from the element list. 

 

 
 
 
 

Lasso 

The lasso provides the function for selecting elements for further processing. 
 
The lasso function will be activated when the shift-key (SHIFT) is held depressed together 
with left mouse button typically followed by dragging the mouse. 
 
All elements fully inside of the lasso will be selected when the mouse button is returned to its 
resting position. 
 
When the control key (CTRL) is also held depressed (SHIFT+CTRL+left mouse button) the 
selection will then be extended with elements matched with lasso. 
 

 

To cancel the lasso selection process (i.e. to keep the last selection active) simply 
free the SHIFT key while the mouse button is still kept depressed. 

 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
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Element processing 
 

A double click with the mouse over an element will open the processing window designed for elements - the element 
editor. 
 
When the right mouse button is depressed in the graphical window, the context menu of element processing is exposed 
offering extensive list of element processing functions for choice. 
 
Elements can be selected with a single mouse click or with the lasso function. 
 
If there is only one element selected its position can be changed by dragging the editing marker with the mouse. 

 

Functions of the context menu 
 

Zoom In The view can be „scaled“. 

Zoom Out This is an alternative to using the mouse wheel. 
 

 

Fit to window Adjust the position and scaling in such way, that the whole 
 construction is visible within the window. 
 

 

Snap to Grid The function of the snapping grid will be turned on or off. 
 The "check mark" shows the active setting of this function. 

 See also: Snapping grind parameters 
  

Snap to Points This is a snapping function, which snaps to already existing 

 coordinate points and can be turned on or off here. 

 The "check mark" shows the active setting of this function. 

 See also: Snapping grid parameters 
  

Snap-To-Grid Shows the dialog used to adjust current snapping grid settings. 

params...  
  

Underlay/Overlay→ Functions respective to underlay/overlay. 

 Remark: The planar underlay is registered at the plane shown 

 within the window. Within the context of Elements23 window (i.e. a 

 3D-Project) up to three underlays can be registered within 

 respective quadrants. 
  

Underlay/Overlay→ Offers the dialog "Register Underlay Image" to import an image file 

Image Register . 
  

Underlay/Overlay→ If there is an underlay image registered and shown it will be 

Image Hide hidden. 
  

Underlay/Overlay→ If there is an underlay image registered its registration data will 

Image Drop removed from the current project. 
  

Underlay/Overlay→ If there is an underlay image registered it will be shown as 
Image Underlay underlay (being occluded by elements entered). 
  

Underlay/Overlay→ If there is an underlay image registered it will be shown as overlay 

Image Overlay 100% (occluding elements entered) either opaque (100%) or with 50% or 

Image Overlay 50% 20% of transparency value. 

Image Overlay 20% The currently selected transparency value is marked with a 

 checkmark left to the menu item. 

 See also: Dialog "Register Underlay Image" to import an image file 
  

 
Many further functions of this context menu are common to all element processing windows and are described 
separately. 
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Editing marker 
 
 
 
 
 
 
 
 
 
 

 

 
 

The editing marker is used for adjusting the position of one element. It is displayed as rectangle emphasized with a thick 
coloured edges. 
 
Dragging an edge with the mouse will translate (move) the complete edit marker (and thus the element will also move). If 
however edge centres or corners are dragged (these are emphasized with small rectangles) only the particular edge or 
corner will change its position.  
By pressing the ESC-key the change initiated by dragging the mouse can be reset to its original state at any moment. 
 
Remark: If snapping to grid is active, changes to the position are restricted to current snapping grid lines. 
 
Remark: When mouse pointer hovers over edges lines of the editing marker the properties of the element edited are 
shown in a tool-tip. The information shown applies to the edited element. The tool-tip text disappears after 5 seconds or 
on any mouse movement or click. 
 
A double-click over the edge of the marker will expose the Element editor window. 

 

 
 

Snapping grid 
 

The snapping grid, if active, restricts coordinate values which can be reached by moving the editing marker. 
 
The snapping grid can be set up in such a way that only integral coordinates are allowed (each 1 mm) or only coordinates in 
integral multiplies of ten (each 10 mm) - etc. The setting of snapping grid can be adjusted from main menu via Edit→Snap to 
Grid params... . Activation and deactivation of snapping grid is also possible in the context menu. 
 
When the function of snapping grid is turned off movements of editing marker will result in coordinate values calculated by 
the inverse transform of pixel coordinates at the mouse position. This transformation can result in numbers with large 
number of decimal places which, in most cases, will not correspond to desired element coordinates. 
 
See also: Element Editor, Element selection (browser) window, Editing (input) windows), Context menu of element 
processing, Snapping grind parameters, Coordinate system, Export Image 2D, Copy Image 2D 
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Element Editor 
 

The Element Editor window provides a central input function of 
construction input. Depending on the type of input or edited element 
different input fields are activated or shown. 
 
Note: You shall switch between input fields by using the TAB-key. Using 
that key confirms the data entry. On the other hand it provides a good 
alternative compared to permanent mouse use. 
 
The Element Editor window displays data of a element currently selected 
for editing in the element list. The selection can be taken within element 
selection window and/or in Elements 2D window. 
 
The input of coordinate positions x1,x2,y1,y2,z1,z2 of element's box is 
common to all element types. Coordinate input is done in millimetres. The 
input can also be given by the entry of the first coordinate and of the related 
thickness interval dX, dY, or dZ - the other (second) coordinate will by 
recalculated accordingly when the input field is being left (e.g.. by pressing 
the TAB-key). 
 
Also, regardless of element's type, each element can be assigned to one or 
more groups for simplifying selections. 
 
By assigning names to space boxes (or Power Source boxes) you will 
define boundary conditions for the calculation model. 
 
During the input material boxes and space boxes it is advised to use a an earlier prepared materials list and surface list. 
These windows "cooperate" with Element Editor when used in context of assigning material- or surface properties to the box 
- a double-click onto a material's line of materials list (or surface line of surfaces list) or a drag-drop of one line onto Element 
Editor window results in an assignment of chosen properties thus eliminating further need of (possibly repetitive) input of 
those. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Both windows (the materials list or surfaces list) can be opened by clicking the "..." button placed to the right of material's 
(or surface's) name field.  
Remark: A drag-drop of a material or surface (from a materials list or surface list) onto the Element-Editor is only allowed if 
there are elements of corresponding type (material box or surface box) selected. 
 
Remark: Assigning material properties can be done from the materials database window too (by a drag-drop or by a 
double-click). 
 
Pressing a right mouse button over Element Editor window exposes (possibly comprehensive) context menu of element 
processing which provides further editing functions. This context menu and functions provided by is it are common to all 
element editing windows and described separately. 
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Input fields Are used to input detailed data of one element - see below. 

  
New Inserts a new Element (of the Type "Empty") at the end of the element list (or creates a duplicate 

Duplicate of the element currently selected). 
 Remark: When this button is shown focused one can use the ENTER key to activate it instead of 
 the mouse. 
 Remark: Holding SHIFT-key while that button is depressed will additionally swap coordinates of the 
 duplicate. 
  

 Undo(Ctrl-Z) 
Undoes (reverts) the latest action(s) in the given editing context. 
 

  
  

 Redo(Ctrl-Y) 
Redoes (reapplies) the action lately undone in the given editing context. 
 

  
  

 First element 
Selects the first element in the element list. 
 

  

 Previous 
Selects an element which is previous to the currently selected in the element list. 
 

  

 Next 
Selects an element which is next to the currently selected in the element list. 
 

  

 Last element 
Selects the last element in the element list. 
 

  

Click right mouse Exposes the context menu of element processing functions or group editing functions. 
button  

  

Button "..." 
Clicking onto the button "..." adjacent to material (or surface) name field exposed the window of 

surfaces or materials.  

  
Double-click onto A double-click over the coordinate field label (left to the input field) will swap the coordinates 

field label (value of the first coordinate will be moved to the second field and the one of the second to the first) 

 - eventually useful in context of the Duplicate function. 

 A double-click onto a label of a material or surface property fields (left to the input field) exposes the 
 surfaces window or materials window . 
  

Drag-drop of a A drag-drop of a material or surface (from a materials list or surface list) onto the Element-Editor 

material / surface results in an assignment of chosen properties thus eliminating further need of (possibly repetitive) 

line input of those. 
  

 

Input fields 
 

Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 

 
Position x1, x2, 
y1, y2, z1, z2 
Extent dX, dY,dZ 

The input of coordinate positions x1,x2,y1,y2,z1,z2 of element's box is common to all element types. 
Coordinate input is done in millimetres. The input can also be given by the entry of the first 
coordinate and of the related extent dX, dY, or dZ - the other (second) coordinate will by recalculated 
accordingly when the input field is being left (e.g.. by pressing the TAB-key). 
Remark: A double-click over the field label (left to the input field) will swap the coordinates (value of 
the first coordinate will be moved to the second field and the one of the second to the first) - 
eventually useful in context of the Duplicate function. 
Remark: Within a 3D layered model coordinate values of result from the layer's thickness and the 

sequence of layers. Values of z1 and z2 are automatically calculated and cannot be modified within 
the Element Editor window. 
Remark: z1 and z2 have no meaning for 2D model. This values are preset to 0 and 1000 respectively 
and cannot be modified within the Element Editor window. 
Remark: If there is some overlapping of element boxes then the ordering of elements in the elements 
list is significant. 

Type Defines the Type of an element: 

 Empty (EmptyBox, empty element, adiabatic element, deleting/erasing box) 

 Material (MaterialBox, material element) 
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 Space (SpaceBox, space element, space air) 
 Power Source (PowerBox, energy source or sink region) 

 
The meaning of various kinds of elements is described further below here. 
 
Remark: While this input field is shown focused one can use arrow keys or type the first letter of type 
on the keyboard (E, M, S, P) to select the type from the list. 

Group(s) Enables an assignment of an element to one or more groups. 
Remark: Pressing the right mouse button when the pointer if over this field will expose the context 
menu of group editing functions. 

Specific to material elements: 
Material name Name of material. It is used for documentation purpose. 

Important: Leading and trailing spaces are significant only during data entry. That white space will be 
dropped and ignored during the creation of the calculation model. Names differing only by the 
number of leading or trailing spaces are significant and considered as different materials only during 
data entry(e.g. Materials list, Data Entry report) but not within Modelling Report nor calculation 
model. 

λ (lambda) Defines the Thermal Conductivity of the material. 
Remark: Each change to this input field results in automatic colouring of the element (simple 
inserting of a space character at the end of lambda value followed by pressing TAB key will result in 
calculation of new colour). 

μ (my) Defines the Water vapour diffusion resistance of the material. 
Remark: A double-click over the field label (left to the input field) will expose materials window. 

ρ (rho) Defines the mass density of the material. 
Remark: A double-click over the field label (left to the input field) will expose materials window. 

c (ce) Defines the heat capacity of the material. 
Remark: A double-click over the field label (left to the input field) will expose materials window. 

Colour and 
AutoColour 
 

 

Provides the ability to assign a distinctive colour to the element identifying it in graphical views and 

evaluations. 
To select the colour click onto the coloured rectangle labelled "Colour" - it will expose colour 
selection 
 dialog. 
Remark: By default the colour is automatically assigned when change to lambda value is applied, 
based on predefined colour table. 
Removing the checkmark will turn the "auto-colour by lambda" application setting off thus assigned 
colour will be retained during changes to the value of lambda. 

Specific to surface elements: 
 Surface name Name of the surface property. It is used for documentation purpose. 

Remark: A double-click over the field label (left to the input field) will expose surfaces window. 
Important: Leading and trailing spaces are significant only during data entry. That white space will be 
dropped and ignored during the creation of the calculation model. Names differing only by the 
number of leading or trailing spaces are significant and considered as different surfaces only during 
data entry (e.g.) 
Surface list, Data Entry report) but not within Modelling Report nor calculation model. 

RS Defines the Thermal Transfer Resistance of the surface. This is an alternative input to α . 
Remark: A double-click over the field label (left to the input field) will expose surfaces window. 

α (alpha) Defines the Thermal Transfer Coefficient of the surface. This is an alternative input to RS. 
Remark: A double-click over the field label (left to the input field) will expose surfaces window. 
See also: Application setting "Alpha (surface transmittance) hidden" 

Space name Name of the space. It represents distinct boundary condition. 
Remark: The name can be selected from a list of already known space names. While this input field is 
shown focused the known name can be chosen by using arrow keys or by entering the keyboard key 
of the first letter in the space name. 
Important: It is mandatory to assign a distinct name. An empty entry will be automatically replaced 
by the space named "NONE". 
Important: Leading and trailing spaces are significant only during data entry. That white space will be 
dropped and ignored during the creation of the calculation model. Names differing only by the 
number of leading or trailing spaces are significant and considered as different space names only 
during data entry(e.g. Data Entry report) but not within Modelling Report ,calculation model nor 
within thermalconductance report, results report etc. 
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Specific to power source elements: 
Power source 
name 

Name of a power source to be assigned to material extent covered by this element. It represents 
distinct boundary condition. 
Remark: The name can be selected from a list of already known power source names. While this input 
field is shown focused the known name can be chosen by using arrow keys or by entering the 
keyboard key of the first letter in the power source name. 
Important: It is mandatory to assign a distinct name. An empty entry will be automatically replaced 
by the power source named "NONE". 
Important: Leading and trailing spaces are significant only during data entry. That white space will be 
dropped and ignored during the creation of the calculation model. Names differing only by the 
number of leading or trailing spaces are significant and considered as different power source names 
only during data entry (e.g. Data Entry report) but not within Modelling Report ,calculation model nor 
within thermalconductance report, results report etc. 

 
 
 
 

Element type (kind/type of a element) 
The Material Box (material element) 
 

A material box is a extent of a volume filled with some specific material. Heat transport within material is described by 
thermal conductivity of material assigned to the box. Vapour transport by diffusion within material is described by its 
vapour diffusion resistance number. The dynamic, transient behaviour of the material regarding its ability to store heat is 
given by its mass density and heat capacity. 
 
Remark: The equivalent heat conductivity of small air cavities and air gaps can be calculated with the air cavity calculator 
tool. 

 

The Space Box (space element, space air) 
 

A space box represents an air filled room of some defined temperature. The heat transport occurs only at surfaces of 
material boxes connected to the space. 
 
All space boxes assigned same space name are merged together as one space. Each such space will later be assigned to one 
temperature (the boundary condition) during the simulation and evaluation. By consequently choosing respective space 
names – e.g. exterior, room, kitchen, bath – or – e.g.. Room 0, Room 1, … - one creates a list of boundary conditions for 
simulations. 
 
Important: It is mandatory to assign a distinct name. An empty name will be automatically replaced by the space 
named "NONE". 

 

 
 
 

The Power Source (PowerBox, power element, energy source or sink region/area) 
 

A power source generates no new volume box. Contrary to material boxes it only defines an area (cube) of power source or 
power sink. All material boxes covered by this are (or their parts) will be assigned to that power source and will receive heat 
energy from this source. 
 
All power source boxes assigned same name are grouped together as one power source. Each such source will later be 
assigned to one power density (the boundary condition) during the simulation and evaluation. By consequently choosing 
respective power source names – e.g. heating interlayer, wall heating, power stick – or – e.g.. PS 0, PS 1, … - one creates a 
list of boundary conditions for simulations. 
 
Important: It is mandatory to assign a distinct name. An empty name will be automatically replaced by the power 
source named "NONE". 
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The Empty box (EmptyBox, empty element, adiabatic element, deleting/erasing/adiabatic box) 

 

Empty boxes are primarily used to excavate or cut areas of the construction creating adiabatic boundaries. A metaphor to 
„Vacuum“, without any kind of heat transport, can be helpful. 

 

 

 

Group(s) of Elements 
 

Each one element can be assigned to one or more group names. Elements can then be quickly selected by the group name - see 
element list and the context menu of element processing functions. 
 
The assignment of an element to some group is done by entering the group name into the group name input filed. Names of groups 
the element is already assigned to can be listed by clicking onto the arrow symbol adjacent to the input field. While this input field is 
shown focused one can use arrow keys to browse  
through the list. 
 
The click with the right mouse button of the input filed Group(s) exposes the 
context menu of group editing functions. 
 

 
 

Remove from Group   The Element will be removed from the group actually displayed in the input field 

 

 

 

 

Boundary conditions 
 

All space boxes merge by their name together to spaces. Every space is assigned one temperature (the boundary condition) 
during the simulation. By consequently choosing respective space names – e.g. exterior, room, kitchen, bath – or – e.g.. 
Room 0, Room 1, … - one creates a list of boundary conditions for simulations.. Same applies to power sources. 
 
All spaces (their temperatures) and all power sources (their power densities) provide boundary conditions for results 
calculated by the program collectively. The name of a space or a power source uniquely identifies such boundary 
condition which is then further processed and used during Evaluation. 
 
If the particular space- or power source name is already known one can click onto the arrow adjacent to the name input 
field and select it directly from the list exposed. While the name input field is shown focused one can use arrow keys to 
select the name or type the first letter of the name in the list. 
 
Important: It is mandatory to assign distinct names for spaces and power sources. An empty name will be 
automatically replaced by the power source named "NONE". 
 
Important: The component prepared for the calculation must contain two boundary conditions at least - see: Solver 
window - data integrity and messages. 
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See also: Element selection window, Elements 2D, Elements 3D, Materials window, Surfaces window, Element kinds/types, 
Context menu of element processing, Colour settings file LambdaToColor.ColorList, Coordinate system, Air Cavity Calculator 
(Tool) 
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Context menu of element editing 
 

The context menu of element editing can be exposed from various editing windows 
when the right mouse button is depressed. 
 
The set of functions supplied within this context menu depends on the actual number 
of elements selected from the element list. 
 

Edit Element. (Ctrl- E) Exposes the Element Editor window. 

  

  
Materials&Surfaces Exposes the Materials and/or Surfaces window. 

(Ctrl-M)  
  

Copy (CTRL-C) Creates a copy of currently selected element(s) and places it 
 onto the clipboard. Element(s) can then be pasted from it 
 See also: Paste 
  

Cut (Strg-X) Currently selected elements are deleted from the element list, 
 but their copies are placed onto the clipboard. Element(s) can 
 then be pasted from it. 
 See also: Paste, Delete 
  

Paste (Strg-V) Element(s) currently on the clipboard are insert just beyond the 

 one currently selected in the element list (or appended to the 

 end of element list if none or several elements are selected). 

 After being inserted all these elements are marked selected 

 thus being ready for further processing (Translate, Rotate, 

 Mirror etc.). 

 See also: Duplicate 
  

 

 
 
 
 
 

Add→Append Appends a new element (of type "Empty") to the end of element list 
  

Add→Before Inserts a new element (of type "Empty") just before the one currently selected into the  element list. 

Selected  
  

Add→After Inserts a new element (of type "Empty") just after the one currently selected into the  element list. 

Selected  
  

Duplicate Inserts a copy of currently selected elements into the element list. 

 Remark: Holding SHIFT-key while that menu is activated will additionally swap coordinates of the 

 duplicate. 

 If several elements are selected their copies are appended to the end of element list retaining their 

 order. 
 After being inserted all these element copies are marked selected thus being ready for further 
 processing (Translate, Rotate, Mirror etc.). 
 See also: Copy & Paste also Translate window 
  

 

 
 

Move 
(Order)→Relegate 
to Backmost 

Reorders selected element(s) in the element list to the "backmost" position. The element is then 
located at the beginning of the list thus now being potentially overlapped by all other elements. 
If more elements are selected then each one is relegated by the same distance as the backmost 
selected one. 
This action is inhibited if the chosen element does already occupy the first (backmost) location in the 
list. 

Move 
(Order)→Relegate 

Reorders selected element(s) in the element list one position "backwards". The element is then 
located earlier in the list thus now being potentially overlapped by another element which have thus 
been promoted to the location of the element relegated. 
If more elements are selected then each one is relegated by one position in the list order. 
This action is inhibited if the chosen element does already occupy the first (backmost) location in the 
list. 
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Move 
(Order)→Promote 

Reorders selected element(s) in the element list one position "towards front". The element is then 
located later in the list thus now potentially overlapping another element which have thus been 
relegated to the location of the element promoted. 
If more elements are selected then each one is promoted by one position in the list order. 
This action is inhibited if the chosen element does already occupy the last (front most) location in the 
list. 

Move 
(Order)→Promote 
to Frontmost 

Reorders selected element(s) in the element list to the "frontmost" position. The element is then 
located at the end of the list thus now potentially overlapping all other elements. 
If more elements are selected then each one is promoted by the same distance as the frontmost 
selected one. 
This action is inhibited if the chosen element does already occupy the last (front most) location in the 
list. 

Delete (DEL key) 

Deletes (irrevocably) currently selected element(s) from the element list. 
After deletion of single element is executed the selection moves to a foregoing element. When first 
element is deleted the selection move to the element advanced to first positon. 
Deletion request of one or more elements is executed after being additionally confirmed in a dialog 
window shown. 
See also: Cut 

 
 
 

 
Translate 

Provides a translation of one or many elements by a distance (dX,dY,dZ) entered in the window 
Translate . 
Remark: Translation itself is invoked from the Translation window. 

 
Stretch 

Provides stretching of one or many elements by a specified distance in specified coordinate direction. 
Extension (or shrinking) of elements is given by specific plane coordinate selection an shift interval 
within the Stretch window. 

 
Rotate 

Provides rotation of one or more elements around an axis parallel to one of coordinate axes. The 
position of the rotation axis is given by the choice of one rotation plane and two coordinates within 
the window Rotate. 

 
Mirror 

Provides mirroring of one or more elements to a plane parallel to one of coordinate planes. The 
position of mirroring plane is given by the choice of mirroring direction and its coordinate position in 
the window Mirror. 

 
 
 

Select→By 
Group→... 

Selects all elements assign to one specific Group (the group name). 
Remark: The menu offers a list of all available groups to chose from. If there are no groups used yet 
this menu has no function. 
Remark: For 3D-Layered models the selection operation is applies only to currently active layer. 

Select→By 
Type→... 

Selects all element of one specific type (Empty, Material, Space, etc.) 
Remark: For 3D-Layered models the selection operation is applies only to currently active layer. 

Select→By 
Name→... 

Selects all elements having one specific name. 
Remark: The menu offers a list of all names - names of spaces, power sources, surfaces and materials) 
to chose from.  
Remark: For 3D-Layered models the selection operation is applies only to currently active layer. 

Select→All (CTRL-
A) 

Select all elements. 
Remark: For 3D-Layered models the selection operation is applies only to currently active layer. 
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Assign→Material→... 

Assign a material to all selected material boxes. All materials used in the project so far are offered 
for choice. 
Remark: If within current selection there are elements of type incompatible with the assignment 
to be performed, the action is executed on compatible elements only after additional user 
confirmation dialog. 
If several elements are selected user's confirmation is also requested by a dialog. 
Error message is shown if neither element matches the expected type. 

Assign→Surface→... 

Assign a surface to all selected space boxes. All surfaces used in the project so far are offered for 
choice. 
Remark: If within current selection there are elements of type incompatible with the assignment 
to be performed, the action is executed on compatible elements only after additional user 
confirmation dialog. 
If several elements are selected user's confirmation is also requested by a dialog. 
Error message is shown if neither element matches the expected type. 

Assign→Space 
name→... 

Assign a space name to all selected space boxes. All space names used in the project so far are 
offered for choice. 
Remark: If within current selection there are elements of type incompatible with the assignment 
to be performed, the action is executed on compatible elements only after additional user 
confirmation dialog. 
If several elements are selected user's confirmation is also requested by a dialog. 
Error message is shown if neither element matches the expected type. 

Assign→Power 
name→... 

Assign a power source name to all selected power source boxes. All power source names used in 
the project so far are offered for choice. 
Remark: If within current selection there are elements of type incompatible with the assignment 
to be performed, the action is executed on compatible elements only after additional user 
confirmation dialog. 
If several elements are selected user's confirmation is also requested by a dialog. 
Error message is shown if neither element matches the expected type. 

Assign→Colour... 
Assign a colour to all selected element (standard colour dialog is shown) 
See also: Element Editor 

Assign→To Group→... 

All selected elements are assigned to the group name chosen (in addition to group assignments 
already in place). 
Remark: The menu offers a list of all groups used in the project so far to chose from. If there are 
no groups used yet this menu has no function. 

Assign→To New 
Group... 

A dialog will be offered to enter the group name. All selected elements are assigned to the group 
name entered (in addition to group assignments already in place). 

Assign→To Type→... 

The type of currently selected element(s) will be changed to the one of 
 Matrial box(es),  

 Power box(es),  

 Space box(es) or  

 Empty box(es)  
When the assignment is done for multiple elements a confirmation will be required. 

Remove from Group 
Assignment to one specific group name is deleted from all selected elements. 
Remark: The menu offers a list of all groups applicable to selected elements to chose from. If no 
one of selected elements is assigned to any group this menu has no function. 

Undo (Ctrl-Z) Undoes (reverts) the latest action(s) in the given editing context. 

Redo(Ctrl-Y) Redoes (reapplies) the action lately undone in the given context 

 
 
Important: Shortcuts shown above CTRL-A, CTRL-C, CTRL-X, CTRL-V, DEL of this context menu are not available with Element-
Editor window. These key combinations have further specific functions respective to input fields of Element-Editor window. 
 
 
See also: Element Editor, Element selection window, Elements 2D window, Elements 23 window, Editing windows (Input 
windows 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm
http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm#Gruppe(n) der Elemente
http://help.antherm.kornicki.com/Forms/AssignToGroupDialog/AssignToGroupDialog.htm
http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm#Gruppe(n) der Elemente
http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm#Gruppe(n) der Elemente
http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm#Gruppe(n) der Elemente
http://help.antherm.kornicki.com/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.kornicki.com/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm
http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm
http://help.antherm.kornicki.com/Forms/EditForm/EditForm.htm
http://help.antherm.kornicki.com/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.kornicki.com/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.kornicki.com/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.kornicki.com/Forms/Bearbeitungsfenster.htm
http://help.antherm.kornicki.com/Forms/Bearbeitungsfenster.htm
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3D-Layer selection window 
 

Layer selection window displays a list of all 3D layers of a 
construction entered as a 3D Layered project.  
Important: The order of layers in the list is significant for the 
resulting 3D construction. 
 
From this window one layer can be selected for editing, new 
layers can be inserted, the order of layers can be changed 
(moved towards front or back) or layers can be deleted from 
the project. 
 
The layer currently processed is shown as selected. Data of 
the selected 3D-layer is shown and can be modified within 
editing part of the window  
Remark: Only one layer can be selected for processing.  
Remark: The windows Element selection (browser) and Elements 2D always display elements of the currently selected 
layer. 
 
 

Layer list  List of all input layers in the specific order along the Z direction of coordinate system 
  

Layer Name  Name of the layer. It is used for documentation purpose. 

  
Depth  Define the thickness of the layer in the direction of Z axis. 

  

 New 
 Appends a new layer (with uniform thickness of 1000mm) onto the end of layer list 
 

  

 Duplicate 
 Creates an exact copy of selected layer (including copies of elements contained in this layer) 

 and inserts the new layer into the layer list just beyond the selected one.  
  

 Delete 
 Deletes the currently selected layer from the list. 

 Warning: all elements which belong to this layer are inadvertently deleted also.  

  Remark: You will be asked for confirmation. 
  

  

 Undo(Ctrl-Z) 
 Undoes (reverts) the latest action(s) in the given editing context. 
 

  
  

 Redo(Ctrl-Y) 
 Redoes (reapplies) the action lately undone in the given editing context. 
 

  
  

  

  Selects First, Previous, Next or Last layer. 
  

  

Relegate to  Reorders the currently selected layer to the backmost position in the list. The layer is then 

Backmost  shown as first in the list. 
  

Relegate  Reorders the currently selected layer one position "towards back" in the list. The layer is then 

  shown earlier in the list. 
  

Promote  Reorders the currently selected layer one position "towards front" in the list. The layer is then 

  shown later in the list. 
  

Promote to  Reorders the currently selected layer to the frontmost position in the list. The layer is then 

Frontmost  shown as last in the list. 
  

   
Click right mouse  Exposes the context menu of layer editing functions 

button 
 
Click left mouse button  Selection of a layer from the layer list 
 
Double click left mouse  Selection of a layer from the list and exposure of Element selection (browser) and Elements 2D 

button windows. 
 

http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/LayerEditorForm/LayerEditorForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
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Layer list 
 

Each line in the list represent one layer in the model input. Adjacent to layer's name its thickness is displayed. The 
windows Element selection (browser) and Elements 2D always display elements of the currently selected layer. The 
construction resulting from current modelling can be observed within the Elements 3D window. 
 
The order of layers in the list corresponds to the sequence of layers as they are stacked together along Z coordinate 
direction. See the description of the project type "3D layered project". 
 
Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 
 

 

Layer editing 
 
 

Data of a selected layer is displayed within layer 

editing part of the window for thickness adjustments. 
 
A double click onto the layer's line exposes the 
windows Element selection (browser) and Elements 
2D which display elements of the currently selected 
layer for further processing. 
 
When the right mouse button is presses over layer 
list a context menu of layer editing is shown and 
offers further layer processing functions. 

 

Layer selection 
 

A click onto layer's line in the layer list selects 

corresponding layer for further processing. 
 

 
 

Selection can be done by arrow keys or by clicking the buttons Next/Prev. also. 

 

 

Reordering layers 
 

 

 

The order in which layers are shown in the list is significant for the stacking order of 
these layers in Z coordinate direction. Reordering of layers results in different 
stacking order. 
 

Buttons "Relegate" and "Promote" are used to move selected 

layer within the list and thus change the stacking order of layers.  

See the description of the project type "3D layered project". 

 

 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/LayerEditorForm/LayerEditorForm.htm
http://help.antherm.eu/Forms/LayerEditorForm/LayerEditorForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
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Functions of the context menu 
 
 

Add→Append Appends a new layer (with uniform thickness of 1000mm) onto the end of layer list. 
  

Add→Before Selected Inserts a new layer (with uniform thickness of 1000mm) just before the one selected in the 

 list. 
  

Add→After Selected Inserts a new layer (with uniform thickness of 1000mm) just below the one selected in the 

 list. 
  

Duplicate Creates an exact copy of selected layer (including copies of elements contained in this 

 layer) and inserts the new layer into the layer list just beyond the selected one. 
  

Move (Order)→Relegate to Reorders the currently selected layer to the backmost position in the list. The layer is then 

Backmost shown as first in the list. 
  

Move (Order)→Relegate Reorders the currently selected layer one position "towards back" in the list. The layer is 

 then shown earlier in the list. 
  

Move (Order)→Promote Reorders the currently selected layer one position "towards front" in the list. The layer is 
 then shown later in the list. 
  

   
 

Move (Order)→Promote to Reorders the currently selected layer to the frontmost position in the list. The layer is then 

Frontmost shown as last in the list. 
  

Move (Order)→Reverse Reorders elements of the list to the opposite direction. The earlier frontmost layers displays 

Order as backmost then. 
  

Delete Deletes the currently selected layer from the list. 
 Warning: all elements which belong to this layer are inadvertently deleted also. 
  

  
Select All Elements (Ctrl-A) Selects all elements of the current layer for further processing. 
 Remark: Use it to emphasize layer within transparent Elements3D view or as preparation 
 for translation/rotation etc. 
  

Select All Elements in All Selects all elements in all layers for further processing. 

Layers  
  

  
Show Elements Browser Exposes the Element selection (browser) - window showing elements of currently selected 

 3D-layer. 

 
 

Show Elements 2D View Exposes the Elements 2D - window showing elements of currently selected 3D-layer. 

 
 

Show Elements 3D View Exposes the Elements 3D window. 
  

 

Remark: Layer list is only meaningful for 3D Layered Project. Within a 2D-Model editing of layer list is inhibited (2D 
model corresponds to only one layer with fixed 1 meter thickness). Within 3D projects this window cannot be used 
because a 3D project contains only one ordered list of elements and not layers. 
 
See also: Element selection window, Elements 2D window, Elements 3D window, Project types, The component 

 

 

 

 

 

 

 

 

 

 

 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
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Layer Editor window 
 

Layer Editor window is used to edit properties of one layer within a 
3D layered project. 
 
This window is shown within 3D-layer selection window. 
 
 
 

Layer Name Name of the layer. It is used for documentation purpose. 

Depth Define the thickness of the layer in the direction of Z axis. 
 
 
 
 
 

Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 
 
Remark: Layer is only meaningful for 3D Layered Project. Within a 2D-Model editing of layer is inhibited (2D model 
corresponds to only one layer with fixed 1 meter thickness). Within 3D projects this window cannot be used because a 3D 
project contains only one ordered list of elements and not layers. 
 
 
See also: Layer selection window, Coordinate system 
 
 
 
 

Now it is possible to change the selected material in all layers the layer modeling.  
 

Select a material you want to change in the window "Material&Surface" , then click with the left mouse button on 
the new button (right). 
The material master data will open.  
Double-click to adopt a new material.Right mouse button - selected material - exchange all elements. 

http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
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Materials & Surfaces window 

 
 
 
                                 

 
 

 
lists of Materials & Surfaces window is used to maintain project 
specific material and surface properties. It is used as an entry point 
to following editing windows: 
 Materials window  
 Surfaces window  
 Material Database window  
 Standard Surfaces window 

The primary use of this window is to prepare lists of materials and 
surfaces which, in cooperation with other windows, allow significant 
simplification and acceleration during the input of element 
properties for material and space boxes. 
 
To expose this window select it from the menu View->Data Input &  
Entry or double click onto the respective material or surface property input field or its label in Element 
Editor (conductivity, diffusion resistance, transfer coefficient or transfer resistance). 
 
Remark: Insertion of materials can be performed via Drag & Drop from Materials Database window. The Material 
Database can be opened by activating the Tab "Mataril DB". 
 
Remark: The Tab "Std.Surfaces" offers standardized, non editable, surface properties (normative values). 
 
See also: Materials window, Surfaces window, Material Database window, Element Editor, Elements 2D, Element list, 
Material Editor, Surface Editor 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
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Materials window 
 

 

 

 
 
 
The Materials window is used to create and maintain the list of 
project specific material properties.  
The list of materials offered in this window can be synchronised 
with materials directly entered and used in the model, thus all 
materials constituting the component are displayed here also. 
Materials can be merged from other projects and combined in this 
list. 
 
The primary use of this window is to prepare lists of materials 
which, in cooperation with other windows, allow significant 
simplification and acceleration during the input of element 
properties for material boxes. Materials already prepared within 
another project can be merged to the list also. 
 
Upper part of the window lists materials. The bottom part -  
Material Editor - allows definition of material properties. 
 
Important: Changes to material properties in the project specific 
materials list do not automatically propagate to properties of 
construction elements. Applying new material properties to 
selected elements must be done explicitly - either by a double-
click onto a list item, via a drag-drop operation from the material 
list or by the bulk replacement of properties. 
 
Remark: Additional materials can be also selected from Material Database window by drag-drop from database (Material 
Database can be opened from the Tab "Material DB"). Dropping some material identical to the one in the list will be 
inhibited. 
 

http://help.antherm.eu/Forms/MaterialEditor/MaterialEditor.htm
http://help.antherm.eu/Forms/MaterialEditor/MaterialEditor.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
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Material list 
 

A double-click onto a line representing material in this window results in an assignment of material properties of selected 
material to currently selected material elements (selected from elements list). 
 
Also, by drag-drop operation (by dragging with the mouse), a material line can be dragged onto element editor window 
resulting in assignment of material properties to the element currently shown there. 
 
Materials window can be opened either from main menu View→Data Input & Entry→Materials or from element editor by a 
double-click onto material name, conductivity and other material property input fields. 
 
 

Double-click left mouse Transfer of material properties of selected material onto currently selected element(s) in the 

button element list. 

  
Dragging with left mouse Transfer of material properties of dragged material to material element currently edited in 

button element editor, 

 or: 
 Transfer of material properties of dragged material to currently selected material element(s) 
 in the element list. 
  

Click right mouse button Exposes the context menu of material editing functions. 
  

Click left mouse button Selection of material from material list. Properties of selected material are displayed in 

 Material Editor for further processing. 
  
 
 

Remark: If there are several elements selected (from element list) then a double-click onto the material line (or drag-drop of 
material line) result in the assignment of material properties to all selected elements. Such bulk element assignment has to 
be confirmed by the user. If within selected elements there are some of incompatible type (non material) further user 
confirmation is requested. Error message is shown if neither element matches the expected type. 
 
 

 New 
Appends a new material onto the end of the material list 
 

  

 Delete 
Deletes the currently selected material from the list. 

Remark: The material is deleted from the material list only.  
  

  

 Undo(Ctrl-Z) 
Undoes (reverts) the latest action(s) in the given editing context. 
 

  
  

 Redo(Ctrl-Y) 
Redoes (reapplies) the action lately undone in the editing context. 
 

        
  

  

 Selects First, Previous, Next or Last material. 
  

 

 
Material selection 

 

 

 

A click onto material's line in the material list selects corresponding material for further processing. 

  

Selection can be done by arrow keys or by clicking the buttons Next/Prev. also. 

 
 
 
 
 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
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http://help.antherm.eu/Forms/MaterialEditor/MaterialEditor.htm
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Funktion of context menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Add Material 
INS-Key A new material is appended at the end of the list. 

Delete Material 
DEL-Key 

Deletes selected material from the list. 

Apply Material 
Transfer material properties of a selected material onto currently selected element(s) in the element 
list. 
Remark: Visible when exactly one surface is selected. 

Select Elements by 
Material 

Selects all elements in the element list having one specific material assigend. 
Remark: Visible when exactly one surface is selected. 
Remark: For 3D-Layered models the selection operation applies only to currently active layer. 

Synch. from 
Elements 

Executes immediate synchronisation of material list from properties of all elements currently in the 
modelled component 

Autosynch. from 
Elements 

The synchronisation of material list from properties of all elements in the modelled component  will 
be executed automatically (checkmark is visible) and can be turned on or off here. 

Sort Materials Materials will be sorted by name, λ, μ, ρ and c. 

Purge all Materials Removes all materials from the list 

Pick from Project... 
Materials saved within another project will be read and appended to the list. 
Remark: After importing the data from another project the (optional) bulk replacement of material 
properties on all elements with those just imported will be offered. 

Replace Materials 
on All Elements 

The material properties of all elements will be replaced by name with those from the current material 
list (bulk replacement). 
Remark: Shall duplicate name appear in the list only the first instance in the order will be applied. 
Remark: For 3D-Layered models the operation applies only to currently active layer. 
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Synchronisation of material list 
 

The list of materials offered in this window can be synchronized (extended) with materials currently in use in the modelled 
component, thus all materials used in the model are also displayed. This provides the ability to transfer properties directly 
entered in element editor to the list and have them at hand as additional entries. 
 
Synchronisation can be explicitly requested from the context menu of the material list ("Synch. from Elements") or will 
automatically be executed on each element selection change when the application setting "Autosynch. from Elements" is 
active. 
 
Synchronisation executes by following steps: 

 

 All elements of modelled component are analysed.  
 Material properties of each material element are extracted.  
 If no such material (name, lambda, my) can be found in material list it is appended to it.  
 Materials appended during this synchronisation run and appended at the end of the list are sorted alphabetically. 

 
This procedure assures, that entries are retained in the list and only "missing" materials will extend it. 
 
Remark: Automatic synchronisation of list contents, if active, occurs on each element selection change. Changes to 
element properties (in Element Editor) alone do not result in automatic synchronisation yet. Immediate synchronisation 
can be explicitly requested from the context menu of the material list ("Synch. from Elements"). 
 
Tip: To have the list showing only materials actually used in the modelled component delete all materials from the list 
(this can be quickly done with DEL-key) and then request immediate synchronisation from component's elements. 
Unused materials are not removed automatically from the list! 
 
Remark: Even if values of ρ (density) and c (heat capacity) are transferred from material database, these values cannot be 
modified unless the licence feature HARMONIC or TRANSIENT is available (these data is not used during nor required for 
the steady state simulation). 
 
See also: Element Editor, Elements 2D, Element list, Material Editor 

 

 

Material Editor window 
 

Material Editor is used to maintain properties of material. This window 
is displayed as part of materials window. 
 
 
 

Material Name Name of material. It is used for documentation 
purpose. 

λ (lambda) Thermal Conductivity of the material.  

μ (mue) Water vapour diffusion resistance of the material. 

ρ (rho) Mass density of the material. 

c (ce) Heat capacity of the material. 

Colour and 
AutoColour 
 

Provides the ability to assign any distinctive colour to 
the element identifying it in graphical views and 
evaluations. 
To select the colour click onto the coloured rectangle 
labelled "Colour" - it will expose colour selection 
dialog. 
Remark: By default the colour is automatically 
assigned when change to lambda value is applied, 
based on predefined colour table. 
Removing the checkmark will turn the "auto-colour by 
lambda" application setting off thus assigned colour 
will be retained during changes to the value of lambda 

New Adds a new entry to the material list and selects it for 
editing. 

Delete Deletes the currently selected material from material 

http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
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Important: Changes to material properties in the project specific material list do not automatically propagate to properties of 
construction elements. Applying new material properties to selected elements must be done explicitly - either by a double-
click onto a material list item or via a drag-drop operation from material list . 
 
Remark: The equivalent heat conductivity of small air cavities and air gaps can be calculated with the air cavity calculator 
tool. 
 
Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 
 
See also: Materials window, Air Cavity Calculator (Tool) 
 
 
 
 
Surfaces window 

 
The Surfaces window is used to create and maintain the list of 
project specific surface properties.  
The list of surfaces offered in this window can be synchronised with 
surfaces directly entered and used in the model, thus all surfaces 
constituting the component are displayed here also.  
Surfaces can be merged from other projects and combined in this 
list. 
 
The primary use of this window is to prepare lists of surfaces 
which, in cooperation with other windows, allow significant 
simplification and acceleration during the input of element 
properties for space boxes. 
 
Upper part of the window lists surfaces. The bottom part - Surface 
Editor - allows definition of surface properties. 
 
 
Important: Changes to surface properties in the project specific  
surface list do not automatically propagate to properties of construction elements. Applying new surface properties to 
selected elements must be done explicitly - either by a double-click onto a list item, via a drag-drop operation from the 
surface list or by the bulk replacement of properties. 
 
Remark: The tab "Std.Surfaces" provides a list of (read only) normative surface properties. 
 
 

 
 
 

 

list. 

Prev. Selects previous material in the material list for 
editing. 

Next Selects next material in the material list for editing 

http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/AirSpaceCalculatorForm/AirSpaceCalculatorForm.htm
http://help.antherm.eu/Forms/AirSpaceCalculatorForm/AirSpaceCalculatorForm.htm
http://help.antherm.eu/Forms/AirSpaceCalculatorForm/AirSpaceCalculatorForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/SurfaceEditor/SurfaceEditor.htm
http://help.antherm.eu/Forms/SurfaceEditor/SurfaceEditor.htm
http://help.antherm.kornicki.com/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.kornicki.com/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.kornicki.com/Forms/MaterialForm/MaterialForm.htm
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Surface list 
 
 

A double-click onto a line representing surface in this window results in an assignment of surface properties of selected 
surface to currently selected space elements (selected from elements list). 
 
Also, by drag-drop operation (by dragging with the mouse), a surface line can be dragged onto element editor window 
resulting in assignment of surface properties to the element currently shown there. 
 
Surfaces window can be opened either from main menu View→Data Input & Entry→Surfaces or from element editor by a 
double-click onto surface name, transfer coefficient or resistance input fields. 
 
 

Surface list List of all surface properties entered 
  

Double-click left mouse Transfer of surface properties of selected material onto currently selected elemen(s) in the 

button element list. 
  

Dragging with left mouse Transfer of surface properties of dragged surface to space element currently edited in 

button element editor, 

 or: 
 Transfer of surface properties of dragged surface to currently selected space elemen(s) in 
 the element list. 
  

Click right mouse button Exposes the context menu of surface editing functions. 

 
 

Click left mouse button Selection of surface from surface list. Properties of selected surface are displayed in Surface 
 Editor for further processing. 
  

 
 

Remark: If there are several elements selected (from element list) then a double-click onto the surface line (or drag-drop of 
surface line) result in the assignment of surface properties to all selected elements. Such bulk element assignment has to be 
confirmed by the user. If within selected elements there are some of incompatible type (non space) further user 
confirmation is requested. Error message is shown if neither element matches the expected type. 
 
 

 
 

 New 
 Appends a new surface onto the end of the surface list 
 

  

 Delete 
 Deletes the currently selected surface from the list. 

 Remark: The surface is deleted from the surface list only.  
  

  

 Undo(Ctrl-Z) 
 Undoes (reverts) the latest action(s) in the given editing context. 
 

  
  

 Redo(Ctrl-Y) 
 Redoes (reapplies) the action undone in the given editing context. 
 

  
  

  

  Selects First, Previous, Next or Last surface. 
  

 

 

Surface selection 
 

 A click onto surface's line in the surface list selects corresponding surface for further processing.  

 

Selection can be done by arrow keys or by clicking the buttons Next/Prev. also. 

 
 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/SurfaceEditor/SurfaceEditor.htm
http://help.antherm.eu/Forms/SurfaceEditor/SurfaceEditor.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
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Functions of the context menu 

 

 A new surface is appended at the end of the list. 

 
 
  
Add Surface INS-Key  

  

Delete Surface Deletes selected surface from the list. 

DEL-Key  
  

Apply Surface Transfer surface properties of a selected surface onto currently selected 
 element(s) in the element list. 

 Remark: Visible when exactly one surface is selected. 
  

Select Elements by Surface Selects all elements in the element list having one specific surface 

 assigned. 

 Remark: Visible when exactly one surface is selected. 

 Remark: For 3D-Layered models the selection operation applies only to 

 currently active layer. 
  

Synch. from Elements Executes immediate synchronisation of surface list from properties of all 

 elements currently in the modelled component 
  

Autosynch. from Elements The synchronisation of surface list from properties of all elements in the 

 modelled component  will be executed automatically (checkmark is 

 visible) and can be turned on or off here. 
  

Sort Surfaces Surfaces will be sorted by name and alpha. 
  

Purge all Surfaces Removes all surfaces from the list 
  

Pick from Project... Surfaces saved within another project will be read and appended to the 

 list. 

 Remark: After importing the data from another project the (optional) bulk 

 replacement of surface properties on all elements with those just imported 

 will be offered. 
  

Replace Surfaces on All Elements The surface properties of all elements will be replaced by name with 
 those from the current surface list (bulk replacement). 

 Remark: Shall duplicate name appear in the list only the first instance in 

 the order will be applied. 

 Remark: For 3D-Layered models the operation applies only to currently 

 active layer. 
  

  

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Synchronisation of surface list 
 

The list of surfaces offered in this window can be synchronized (extended) with surfaces currently in use in the modelled 
component, thus all surfaces used in the model are also displayed. This provides the ability to transfer properties directly 
entered in element editor to the list and have them at hand as additional entries. 
 
Synchronisation can be explicitly requested from the context menu of the material list ("Synch. from Elements") or will 
automatically be executed on each element selection change when the application setting "Autosynch. from Elements" is 
active. 
 
Synchronisation executes by following steps: 

 

 All elements of modelled component are analysed. 

 Surface properties of each space element are extracted. 

 If no such surface (name, α, Rs) can be found in surface list it is appended to it. 

 Surfaces appended during this synchronisation run and appended at the end of the list are sorted alphabetically. 

 
This procedure assures, that entries are retained in the list and only "missing" surfaces will extend it. 
 
Remark: Automatic synchronisation of list contents, if active, occurs on each element selection change. Changes to 
element properties (in Element Editor) alone do not result in automatic synchronisation yet. Immediate synchronisation 
can be explicitly requested from the context menu of the surface list ("Synch. from Elements"). 
 
Tip: To have the list showing only surfaces actually used in the modelled component delete all surfaces from the list (this can 
be quickly done with DEL-key) and then request immediate synchronisation from component's elements. Unused surfaces 
are not removed automatically from the list! 

 

 

 

Standardised surface heat transfer coefficients 
 

The tab "Std.Surfaces" provides a list of (read only) normative surface properties (standard values of Rsi and Rse). You 
can find these reference values within the description of U-Value calculator. 
 
Important: While assessing heat loss different values must be used within the component model as those for the mould and 
condensation assessment! That means you will have to adjust respective Rsi and Rse values depending on the assessment 
type. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

See also: Element Editor, Elements 2D, Element list, Surface Editor window 
 
 

 

 

 

http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
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Surface Editor window 
 

 

                                   
 
 

Surface Editor is used to maintain properties of surface. This window is 
displayed as part of Surfaces window. 
 
 
 
 

Surface name Name of surface. It is used for documentation purpose. 

RS (W) (T) Defines the thermal transfer resistance of the surface. RS= 1 / α 
 

 
 
 

Important: Changes to surface properties in the project specific surface list do not automatically propagate to properties of 
construction elements. Applying new surface properties to selected elements must be done explicitly - either by a 
double-click onto a list item or via a drag-drop operation from the surface list. 
 
Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
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Materials Database window 
 
 

Material Database contains materials from DIN, ÖNORM, ETU, IBO, BPHDB.COM, Baubook/öbox, ArchiPHYSIK and 
ECOTECH. This window will be opened from the menu Tools →Material Database and from the menu Tools→Materials 
Database.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

By selecting required filter criteria (Source, Major type, Type and Name filter) one can reduce amount of shown materials to 
those currently searched for. The filter setting is retained between application executions (will be saved together with 
application settings).  
 
 

The context menu provides a command to reset the filter criteria 
(Source, Major type, Type and Name filter) thus showing all available 
data without any filtering. 

 

A double-click onto a data selector (left to data fields) will assign material properties to currently selected material 

element(s) of the model. Such assignment can be executed by a drag-drop with the right mouse button also - see below.  
 

Source Provides the selection of shown materials by their data source. If empty entry is 
selected data from all sources is shown. 

Filter 
Name-Filter 

Provides the selection of shown materials by a substring contained in their 
name(e.g. Brick). 

Major Type Provides the selection of shown materials by their major type. If empty entry is 
selected data of all major types is shown. 
Remark: List of available major types is source specific. 

Type Provides the selection of shown materials by their type. If empty entry is 
selected data of all types is shown. 
Remark: List of available types is source specific. 

Material list Displays a list of materials in the database, possibly filtered according to 
selection criteria specified by Source, Name-Filter, Major type and Type. 

Double-click left mouse button 
out of data record mark 

Transfer material properties of the selected material onto currently selected 
element(s) within element list 

Dragging with left mouse button 
out of data record mark 

Transfer material properties of the material dragged with the mouse onto the 
element being currently edited in element editor 
or: 
Transfer material properties of the material dragged with the mouse onto the 
element(s) currently selected within element list 
or: 
Insert the material dragged with the mouse into the project own material list 

lick left mouse button Selection of a material 
 

http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_ON_V_31.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_APH_ArchiPHYSIK.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_ecotech_BuildDesk.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
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Remark: If there are several elements selected (from element list) then a double-click onto the material line (or drag-drop of 
material line) result in the assignment of material properties to all selected elements. Such bulk element assignment has to 
be confirmed by the user. If within selected elements there are some of incompatible type (non material) further user 
confirmation is requested. 
 
Functional details summarized: 

 
 Drag-Drop of material into material window: Drag-Drop with right mouse button from record mark (left to data fields).  
 Drag-Drop of material into element editor: Drag-Drop with right mouse button from record mark (left to data fields). 

Remark: A Drag-Drop of a material onto element editor is only possible if edited element is of sufficient type 
(material box).  

 Drag-Drop of material onto element list or Elemente2D window: Drag-Drop with right mouse button from record 
mark (left to data fields). 

 Double-click onto a data record mark (left to data fields) 

 
Remark: Drag-Drop is being initiated with right mouse botton out of data record mark (left to data fields). 
 
Remark: For technical reasons there are some columns hidden from the user. While tabbing between the fields the text 
cursor might hide also - simply press the TAB key again to reveal the focus. 
 
Remark: Materials database data is stored within the file "Baustoffe.xml" within installation folder of the application and is 
loaded during this window is opened. You can modify this file within Excel or text editor if required. 
 
Remark: If Baubook/öbox-Data or BPHDB.COM-data is available within the Download-Folder it will be loaded during this 
window is opened (the load operation might lead to slight delay before the window is displayed). 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_OeBox.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Materials -Database menu 

 

While the Materials Database window is focused the main menu of 
the application is extended with the window specific menu "Materials 
DB": 
 
Reset Filter Reset the filter criteria (Source, Major type, 
 Type and Name filter) thus showing all available 
 data without any filtering. 

  

  

Baubook(ÖBOX) The menu specific for management of 

Data baubook(öbox) material data 
  

Check for A test for updated data against the 

Updates... Baubook/öbox server is initiated via internet 
 connection 
  

Download A test for updated data against the 

Updates... Baubook/öbox server and a download (if new 

 data is available) is initiated via internet 

 connection 
  

Include Include baubook(öbox)-data (if available) within 

Baubook(ÖBOX) material database window. This, if turned off, 

Data allows you to exclude baubook(öbox)-data from 

 the view even if the baubook(öbox) data file is 

 available. 

 See also: Application setting "Baubook(öbox) 
 data included" 
  

BPHDB Data The menu specific for management of 

 BPHDB.COM data 
  

Check for A test for updated data against the 

Updates... BPHDB.COM server is initiated via internet 

 connection 
  

Download A test for updated data against the 

Updates... BPHDB.COM server and a download (if new 
 data is available) is initiated via internet 

 connection 
  

Include BPHDB Include BPHDB.COM-data (if available) within 

Data material database window. This, if turned off, 

 allows you to exclude BPHDB.COM-data from 

 the view even if the BPHDB data file is 

 available. 

 See also: Application setting "BPHDB.COM data 
 included" 
  
 

Remark: To execute an update check or the download of Baubook/öbox or BPHDB.COM data an internet connection is 
required. 
 
Remark: Downloaded data will be saved to the Download-Folder specified within application settings. 
 
See also: Element Editor, Materials window, Baustoffkatalog ON V 31, Material Database Baubook/ÖBOX, Material 
Database BPHDB.COM, Material Database ArchiPHYSIK (APH), Material Database ECOTECH 
 

http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_OeBox.htm
http://www.baubook.at/vlbg/
http://www.baubook.at/vlbg/
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_OeBox.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_OeBox.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://www.bphdb.com/
http://www.bphdb.com/
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
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http://www.baubook.at/vlbg/
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Materials window 
 
The Materials window is used to create and maintain the list of 
project specific material properties.  
The list of materials offered in this window can be synchronised 
with materials directly entered and used in the model, thus all 
materials constituting the component are displayed here also. 
Materials can be merged from other projects and combined in this 
list. 
 
The primary use of this window is to prepare lists of materials 
which, in cooperation with other windows, allow significant 
simplification and acceleration during the input of element 
properties for material boxes. Materials already prepared within 
another project can be merged to the list also. 
 
Upper part of the window lists materials. The bottom part – 
Material Editor - allows definition of material properties. 
  
Important: Changes to material properties in the project specific 
materials list do not automatically propagate to properties of 
construction elements. Applying new material properties to 
selected elements must be done explicitly - either by a double-
click onto a list item, via a drag-drop operation from the material 
list or by the bulk replacement of properties. 
 
Remark: Additional materials can be also selected from Material Database window by drag-drop from database (Material 
Database can be opened from the Tab "Material DB"). Dropping some material identical to the one in the list will be 
inhibited. 

 

 

Material list 
 

A double-click onto a line representing material in this window results in an assignment of material properties of selected 
material to currently selected material elements (selected from elements list). 
 
Also, by drag-drop operation (by dragging with the mouse), a material line can be dragged onto element editor window 
resulting in assignment of material properties to the element currently shown there. 
 
Materials window can be opened either from main menu View→Data Input & Entry→Materials or from element editor by a 
double-click onto material name, conductivity and other material property input fields. 
 
 

Double-click left mouse Transfer of material properties of selected material onto currently selected element(s) in the 

button element list. 
  

Dragging with left mouse Transfer of material properties of dragged material to material element currently edited in 

button element editor, 

 or: 
 Transfer of material properties of dragged material to currently selected material element(s) 
 in the element list. 
  

Click right mouse button Exposes the context menu of material editing functions. 
  

Click left mouse button Selection of material from material list. Properties of selected material are displayed in 

 Material Editor for further processing. 
  
 
Remark:  If there are several elements selected (from element list) then a double-click onto the material line (or drag-    drop 
of material line) result in the assignment of material properties to all selected elements. Such bulk element assignment has 
to be confirmed by the user. If within selected elements there are some of incompatible type (non material) further user 
confirmation is requested. Error message is shown if neither element matches the expected type. 
 

http://help.antherm.eu/Forms/MaterialEditor/MaterialEditor.htm
http://help.antherm.eu/Forms/MaterialEditor/MaterialEditor.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
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http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
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     New Appends a new material onto the end of thematerial list 

     Delete Deletes thecurrently selected material from the list. 
Remark: The material is deleted from the material list only. 

 

 Undo(Ctrl-Z) 
 Undoes (reverts) the latest action(s) in the given editing context. 
 

         
  

 Redo(Ctrl-Y) 
 Redoes (reapplies) the action undone in the given editing context. 
 

        
  

  
  Selects First, Previous, Next or Last material. 
  

 

Material selection 

 

A click onto material's line in the material list selects corresponding material for further processing. 

  

Selection can be done by arrow keys or by clicking the buttons Next/Prev. also. 

 

Functions of the context menu 

 

 

 
 

Add Material INS-Key A new material is appended at the end of the list. 

Delete Material DEL-Key Deletes selected material from the list. 

Apply Material Transfer material properties of a selected material onto currently 
selected element(s) in the element list. Remark: Visible when 
exactly one surface is selected. 

Select Elements by Material Selects all elements in the element list having one specific material 
assigned. 
Remark: Visible when exactly one surface is selected. 
Remark: For 3D-Layered models the selection operation applies 
only to currently active layer. 

Synch. from Elements Executes immediate synchronisation of material list from 
properties of all elements currently in the modelled component 

Autosynch. from Elements The synchronisation of material list from properties of all elements 
in modelled component  will be executed automatically 
(checkmark is visible) and can be turned on or off here. 

Sort Materials Materials will be sorted by name, λ, μ, ρ and c. 

Purge all Materials Removes all materials from the list 

Pick from Project... Materials saved within another project will be read and appended 
to the list. 

http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
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Remark: After importing the data from another project the 
(optional) bulk replacement of material properties on all elements 
with those just imported will be offered. 

Replace Materials on All Elements The material properties of all elements will be replaced by name 
with those from the current material list (bulk replacement). 
Remark: Shall duplicate name appear in the list only the first 
instance in the order will be applied. 
Remark: For 3D-Layered models the operation applies only to 
currently active layer. 

 
 
 
 
 
 

                              
 
 
 

Synchronisation of material list 
 
 
The list of materials offered in this window can be synchronized (extended) with materials currently in use in the modelled 
component, thus all materials used in the model are also displayed. This provides the ability to transfer properties directly 
entered in element editor to the list and have them at hand as additional entries. 
 
Synchronisation can be explicitly requested from the context menu of the material list ("Synch. from Elements") or will 
automatically be executed on each element selection change when the application setting "Autosynch. from Elements" is 
active. 
 
Synchronisation executes by following steps: 

 

 All elements of modelled component are analysed. 

 Material properties of each material element are extracted. 

 If no such material (name, lambda, my) can be found in material list it is appended to it. 

 Materials appended during this synchronisation run and appended at the end of the list are sorted alphabetically. 

 
This procedure assures, that entries are retained in the list and only "missing" materials will extend it. 
 
Remark: Automatic synchronisation of list contents, if active, occurs on each element selection change. Changes to 
element properties (in Element Editor) alone do not result in automatic synchronisation yet. Immediate synchronisation 
can be explicitly requested from the context menu of the material list ("Synch. from Elements"). 
 
Tip: To have the list showing only materials actually used in the modelled component delete all materials from the list 
(this can be quickly done with DEL-key) and then request immediate synchronisation from component's elements. 
Unused materials are not removed automatically from the list! 
 
Remark: Even if values of ρ (density) and c (heat capacity) are transferred from material database, these values cannot be 
modified unless the licence feature HARMONIC or TRANSIENT is available (these data is not used during nor required for 
the steady state simulation). 
 
See also: Element Editor, Elements 2D, Element list, Material Editor 
 

 

http://help.antherm.kornicki.com/Forms/JoinedMaterialsSurfacesForm/JoinedMaterialsSurfacesForm.htm#BaustoffeAllerElementeAustauschen
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
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Material Editor window 

 

Material Editor is used to maintain properties of material. This window 
is displayed as part of materials window. 
 
 
 
 
 

 

 

 

 

 

Material Name Name of material. It is used for documentation purpose. 
  

λ (lambda) Thermal Conductivity of the material. 
  

μ (mue) Water vapour diffusion resistance of the material. 
  

ρ (rho) Mass density of the material. 
  

c (ce) Heat capacity of the material. 
  

Colour and 
AutoColour Provides the ability to assign any distinctive colour to the element identifying it in graphical views and 
 evaluations. 
 To select the colour click onto the coloured rectangle labelled "Colour" - it will expose colour 

 selection dialog. 

 Remark: By default the colour is automatically assigned when change to lambda value is applied, 
 based on predefined colour table. 
 Removing the checkmark will turn the "auto-colour by lambda" application setting off thus assigned 
 colour will be retained during changes to the value of lambda. 

 
 

New Adds a new entry to the material list and selects it for editing. 

 
 

Delete Deletes the currently selected material from material list. 

 
 

Prev. Selects previous material in the material list for editing. 

 
 

Next Selects next material in the material list for editing. 
  

 

 
 

Important: Changes to material properties in the project specific material list do not automatically propagate to properties 
of construction elements. Applying new material properties to selected elements must be done explicitly - either by a 
double-click onto a material list item or via a drag-drop operation from material list . 
 
Remark: The equivalent heat conductivity of small air cavities and air gaps can be calculated with the air cavity calculator 
tool. 
 
Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 
 
See also: Materials window, Air Cavity Calculator (Tool) 
 
 
 
 
 

http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Datei/LambdaToColor_ColorList.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/AirSpaceCalculatorForm/AirSpaceCalculatorForm.htm
http://help.antherm.eu/Forms/AirSpaceCalculatorForm/AirSpaceCalculatorForm.htm
http://help.antherm.eu/Forms/AirSpaceCalculatorForm/AirSpaceCalculatorForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
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Materials Database window 
 

Material Database contains materials from DIN, ÖNORM, ETU, IBO, BPHDB.COM, Baubook/öbox, ArchiPHYSIK and 
ECOTECH. This window will be opened from the menu Tools→Material Database and from the menu Tools→Materials 
Database. The main application's menu is extended with "Materials-Database" menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

By selecting required filter criteria (Source, Major type, Type and Name filter) one can reduce amount of shown materials to 
those currently searched for. The filter setting is retained between application executions (will be saved together with 
application settings). 
 
The context menu provides a command to reset the filter criteria 
(Source, Major type, Type and Name filter) thus showing all available 
data without any filtering. 

 

A double-click onto a data selector (left to data fields) will assign material properties to currently selected material 

element(s) of the model. Such assignment can be executed by a drag-drop with the right mouse button also - see 

below. 

 

Source Provides the selection of shown materials by their data source. 

 If empty entry is selected data from all sources is shown. 
  

Filter Provides the selection of shown materials by a substring contained in their name 

Name-Filter (e.g. Brick). 
  

Major Type Provides the selection of shown materials by their major type. 

 If empty entry is selected data of all major types is shown. 

 Remark: List of available major types is source specific. 
  

Type Provides the selection of shown materials by their type. 

 If empty entry is selected data of all types is shown. 

 Remark: List of available types is source specific. 
  

Material list Displays a list of materials in the database, possibly filtered according to selection 

 criteria specified by Source, Name-Filter, Major type and Type. 
  

Double-click left mouse button Transfers material properties of the selected material onto currently selected 

onto data record mark element(s) within element list 

  
Dragging with left mouse button Transfer material properties of the material dragged with the mouse onto the 

out of data record mark element being currently edited in element editor 

 or: 

 Transfer material properties of the material dragged with the mouse onto the 
 element(s) currently selected within element list 
  

 

 

http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_ON_V_31.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_APH_ArchiPHYSIK.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_ecotech_BuildDesk.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
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 or: 

 Insert the material dragged with the mouse into the project own material list 
  

lick left mouse button Selection of a material 
  

 

Remark: If there are several elements selected (from element list) then a double-click onto the material line (or drag-drop 
of material line) result in the assignment of material properties to all selected elements. Such bulk element assignment has 
to be confirmed by the user. If within selected elements there are some of incompatible type (non material) further user 
confirmation is requested. 
 
Functional details summarized: 

 
 Drag-Drop of material into material window: Drag-Drop with right mouse button from record mark (left to data fields).  
 Drag-Drop of material into element editor: Drag-Drop with right mouse button from record mark (left to data fields). 

Remark: A Drag-Drop of a material onto element editor is only possible if edited element is of sufficient type 
(material box).  

 Drag-Drop of material onto element list or Elemente2D window: Drag-Drop with right mouse button from record 
mark (left to data fields).  

 Double-click onto a data record mark (left to data fields) 

 
Remark: Drag-Drop is being initiated with right mouse botton out of data record mark (left to data fields). 
 
Remark: For technical reasons there are some columns hidden from the user. While tabbing between the fields the text 
cursor might hide also - simply press the TAB key again to reveal the focus. 
 
Remark: Materials database data is stored within the file "Baustoffe.xml" within installation folder of the application and is 
loaded during this window is opened. You can modify this file within Excel or text editor if required. 
 
Remark: If Baubook/öbox-Data or BPHDB.COM-data is available within the Download-Folder it will be loaded during this 
window is opened (the load operation might lead to slight delay before the window is displayed). 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_OeBox.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

140 
 

 
 
 

Materials- Database menu 
 

 
 
 

 
 
 

Menu Tools→Materials Database. The main application's menu is extended with "Materials-Database" (Custom)menu. 
 
 

While the Materials Database window is focused the main menu of the application is extended with the window specific 
menu "Materials DB": 
 
 
 

Reset Filter Reset the filter criteria (Source, Major type, Type and Name filter) thus showing all 
available data without any filtering. 

  

Baubook(ÖBOX)Data The menu specific for management of baubook(öbox) material data 

Check for Updates... A test for updated data against the Baubook/öbox server is initiated via internet 
connection. 

Download Updates... A test for updated data against the Baubook/öbox server and a download (if new data is 
available) is initiated via internet connection. 

Include Baubook(ÖBOX)Data
  

Include baubook(öbox)-data (if available) within material database window. This, if 
turned off, allows you to exclude baubook(öbox)-data from the view even if the 
baubook(öbox) data file is available. 
See also: Application setting "Baubook(öbox) data included" 

  

BPHDB Data The menu specific for management of BPHDB.COM data. 

Check for Updates.. A test for updated data against the BPHDB.COM server is initiated via internet 
connection. 

Download Updates... A test for updated data against the BPHDB.COM server and a download (if new data is 
available) is initiated via internet connection. 

Include BPHDB Data Include BPHDB.COM-data (if available) within material database window. This, if turned 
off, allows you to exclude BPHDB.COM-data from the view even if the BPHDB data file is 
available. 
See also: Application setting "BPHDB.COM data ncluded". 

 
 
 
Remark: To execute an update check or the download of Baubook/öbox or BPHDB.COM data an internet connection is   
required. 
Remark: Downloaded data will be saved to the Download-Folder specified within application settings. 

 

 
See also: Element Editor, Materials window, Baustoffkatalog ON V 31, Material Database Baubook/ÖBOX, Material 
Database BPHDB.COM, Material Database ArchiPHYSIK (APH), Material Database ECOTECH 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_OeBox.htm
http://www.baubook.at/vlbg/
http://www.baubook.at/vlbg/
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_OeBox.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_OeBox.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://www.bphdb.com/
http://www.bphdb.com/
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://www.baubook.at/vlbg/
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_ON_V_31.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_ON_V_31.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_BPHDB_com.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/Baustoffkatalog_ecotech_BuildDesk.htm
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Baustoffkatalog ON V 31 

 
In der Anlehnung an Abschnitt 1 vom "Katalog für wärmeschutztechnische Rechenwerte von Baustoffen und Bauteilen", 
ON V 31 1. Auflage, Ausgabe 1. Dezember 2001, des Österreichischen Normungsinstitutes, Serie "Bauwesen" haben wir die 
typischen Baustoffe zusammengestellt. 
 
Der Kataloginhalt soll im gesamten Bundesgebiet eine einheitliche Beurteilung von wärmeschutztechnischen Maßnahmen 

ermöglichen, wie sie laufend bei Planungen, bei den Durchführungen von Neubauten und in verstärktem Maße zukünftig 

auch bei Umbauten bzw. Adaptierungsmaßnahmen sowie im Betrieb auftreten; außerdem soll er als Grundlage für einfache 

Überprüfungen von an die Baustellen angelieferten Materialien dienen, um eine weitestgehende Übereinstimmung 

zwischen dem geplanten und dem zur Ausführung gelangenden Wärmeschutz zu gewährleisten. 

...  
Der ... Katalog stellt eine Weiterentwicklung der vom Bundesministerium für Bauten und Technik im Jahre 1979 für den 

staatlichen Hochbau herausgegebenen Richtlinien für maßgebliche Wärmeschutzrechenwerte dar. In der Neuauflage sind 

nun auch die europäischen Entwicklungen unter Bedachtnahme auf eine optimale Erfüllung der Umsetzung der Richtlinie des 

Rates vom 21. Dezember 1988 zur Angleichung der Rechts- und Verwaltungsvorschriften der Mitgliedsstaaten über 

Bauprodukte, Anhang I, Pkt. 6 – ENERGIEEINSPARUNG UND WÄRMESCHUTZ – bei der Planung und Errichtung aller Gebäude 

oder Räume zur Sicherstellung von deren Gebrauchstauglichkeit über einen jeweils aus wirtschaftlicher Sicht festzulegenden 

Zeitraum sowie die daraus abgeleiteten Normungsgrundlagen innerhalb von CEN/TC 89 ”Wärmeschutz von Gebäuden und 

Bauteilen” sowie die ÖNORMEN-Serie B 8110 ”Wärmeschutz im 

Hochbau” des österreichischen Spiegelgremiums – Fachnormenausschuss (FNA) 175 – berücksichtigt. 
...  
Die verschiedenen normativen Berechnungsverfahren für den Nachweis der Erfüllung der wärmeschutztechnischen 
Anforderungen und Kennwerte setzen die Verwendung zutreffender Rechenwerte für Baustoffe, Bauteilschichten, 
Hohlräume oder Bauteile voraus. Diese Werte können – sofern sie nicht in ÖNORMEN enthalten sind – dem nun 
vorliegendem ”Katalog für empfohlene Wärmeschutz-Rechenwerte von Baustoffen und Baukonstruktionen” entnommen 
oder auch aus zertifizierten Produktkennwerten abgeleitet werden. 
...  
Der nun vorliegende völlig neu überarbeitete Katalog für empfohlene Wärmeschutzrechenwerte für Baustoffe und 
Baukonstruktionen ist ein grundlegendes Werk für dieses Fachgebiet und stellt für Architekten und Ingenieurkonsulenten, 
Zivilingenieure, Bauunternehmen, Baubehörden, Bausachverständige und Interessensvertretungen ein unverzichtbares 
Planungshilfsmittel dar.  
... 
 
Der Abschnitt 1 über die Wärmeleitfähigkeit von Bau- und Dämmstoffen enthält die Angaben über den zutreffenden Bereich 
der Rechenwerte (obere und untere Grenze) der Wärmeleitfähigkeit. Soferne die erreichbaren Grundlagendaten eine 
Bereichsangabe nicht zulassen, wird nur ein Wert für die Wärmeleitfähigkeit angeführt. Die Werte für die spezifische 
Wärmekapazität sind ebenfalls unter Berücksichtigung des baupraktischen Feuchtegehalts der Baustoffe angegeben.   
... 
 
Empfohlene Wärmeschutz-Rechenwerte für Baustoffe 
 
Der Abschnitt 1 über die Wärmeleitfähigkeit von Baustoffen, einschließlich Dämmstoffen gibt für jedes in den Katalog 
aufgenommene Material die Dichte (DICHTE), die Wärmeleitfähigkeit (WÄRMELEITFÄHIGKEIT) für mittlere Bauverhältnisse 
(U23/80) und die spezifische Wärme (SPEZ.W.) an. Die Rechenwerte der Wärmeleitfähigkeit in W/(m·K) werden als obere 
Grenzwerte (90%-Fraktile) und so weit dies möglich auch als Mittelwerte (50%-Fraktile) angegeben, die von 90% bzw. 50% der 
gemessenen oder überwachten Bauprodukte des betreffenden Materialtyps unterschritten werden. 
 
Die oberen Grenzwerte sind zur Berechnung der U-Werte und der thermischen Leitwerte von Bauteilen heranzuziehen. Die 
Differenz zwischen dem oberen Grenzwert und dem Mittelwert gibt Aufschluss über die Breite der Verteilung der Messwerte 
(der Wärmeleitfähigkeit eines Baustoffes im betreffenden Dichtebereich) und ermöglicht die Abschätzung des unteren 
Grenzwertes der Wärmeleitfähigkeit. 
 
Die unteren Grenzwerte sind zur Berechnung von Oberflächentemperaturen in Bauteilen heranzuziehen, sofern dies die 
gegebenen Randbedingungen oder das Auftreten von Wärmequellen im Bauteil erfordern. 
 
Diese Form der Angabe der Wärmeleitfähigkeit als oberen Grenzwert und Mittelwert entspricht den inzwischen gefassten 
Beschlüssen in den europäischen Normungsgremien. Sie setzt allerdings voraus, dass für jeden der angegebenen Baustoffe 
oder Bauprodukte genügend Messwerte über deren Wärmeleitfähigkeit zur Verfügung stehen, um eine statistische 
Auswertung zu rechtfertigen. Diese Voraussetzung ist für die Wärmedämmstoffe in der Regel erfüllt, für andere 
konventionelle Baustoffe nur teilweise erfüllbar, für die Gruppe der Metalle und sonstiger Werkstoffe aber noch nicht 
gegeben. 
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Die statistische Auswertung stützt sich, analog dem Verfahren in CEN, ausschließlich auf Originalmesswerte, die im Rahmen 
von Zertifizierungsverfahren oder Güteüberwachungen (third party control) ermittelt wurden. Dabei werden nach der 
Berechnung der bestpassenden mittleren Regressionskurve die unteren und oberen Grenzwerte für die dichteabhängige 
Wärmeleitfähigkeit der betrachteten Baustoffart bestimmt, die von mindestens 90% der erfassten Daten erfüllt werden. 
Diese statistisch abgesicherten λ-Werte sind im Katalog daran erkennbar, daß dafür obere Grenzwerte und Mittelwerte für 
die dichteabhängigen Rechenwerte angegeben werden. 
 
Für Baustoffe, für welche die erforderlichen Messwerte zur vollständigen statistischen Auswertung (noch) nicht zugänglich 
sind, werden nur die oberen Grenzwerte (90%-Fraktile) angeführt. Für Baustoffe, für die keine aktuellen Messwerte (oder nur 
Einzelwerte) der Wärmeleitfähigkeit existieren, werden in den Tabellen die bisherigen Rechenwerte beibehalten. Diese Werte 
sind in die Spalte für obere Grenzwerte eingetragen. 
 
Für Werkstoffe oder Materialien, für die bisher keine Rechenwerte angegeben waren und für die bereits CENWerte 
existieren, wurden entsprechende Ergänzungen vorgenommen. Diese Ergänzungen betreffen insbesondere 
Stoffgruppen wie Metalle, Natursteine, Bodenmaterial und Kunststoffe. 
 
Bei den angegebenen Dichtewerten ist im gegebenen Fall zwischen der Stoffrohdichte (z.B. Scherbenrohdichte eines 
Ziegelsteines) und der Komponentenrohdichte (z.B. eines Hochlochmauersteines oder eines Mauerwerks) zu 
unterscheiden. Die λ-Rechenwerte für das Vollziegelmauerwerk werden beispielsweise aus praktischen Gründen in 
Abhängigkeit von der Scherbenrohdichte des Ziegelsteines angegeben. 
 
Für Baustoffe oder Baukomponenten, für die eine Interpolation der λ-Rechenwerte zwischen den einzelnen Dichtestufen 
zulässig ist, wird dies durch je ein Sternchen * vor und nach der Spaltenbezeichnung DICHTE angemerkt. 
 
Die Rechenwerte für die spezifische Wärme sind zur Berechnung nicht stationärer Wärmeleitungsvorgänge in Bauteilen 
oder im Boden und zur Abschätzung des Wärmespeichervermögens von Bauteilen erforderlich. 
 
Diese angegebenen Rechenwerte stammen aus dem Katalog für empfohlene Wärmeschutz-Rechenwerte 1979, sofern sie 
nicht durch Rechenwerte aus der ÖNORM EN ISO 10456 ersetzt wurden. Eine bessere Absicherung dieser Rechenwerte 
durch neuere Messungen ist derzeit nicht möglich. 
 
Die spezifische Wärme von Baustoffen wird in den CEN-Dokumenten für den Trockenzustand und für 10 °C in J/(kg·K) 
angegeben. Für die nationalen Tabellenwerte, die für baupraktische Feuchtezustände zutreffen, wurde daher die 
erforderliche Umrechnung vorgenommen. ... 
 
Für die gegenständliche Zusammenstellung der Rechenwerte wird die bisher verwendete Dimension kJ/(kg·K) 
beibehalten. Für Berechnungen von Wärmeströmen durch den Boden wird in CEN-Dokumenten auch die Dimension 
J/(m

3
·K) verwendet.  

Im Katalog werden der Baustoff- oder der Materialbezeichnung (Materialtypen) in der Regel Ordnungsnummern 
vorgesetzt. Jeder Datenzeile (Baustoff oder Material bestimmter Dichte) ist eine Katalog-Nummer vorangestellt. 
 
Overview about the building material- and material types. 

 
1 MAURERWORK 
1.102 ZIEGELMATERIAL (gem. ÖNORM B 3200; Reinders)  
1.104 VOLLZIEGELMAUERWERK 
1.106 HOCHLOCHZIEGELMAUERWERK (Altbestand)  
1.108 HOCHLOCHZIEGELMAUERWERK (Neubau) 
1.110 LANGLOCHZIEGELMAUERWERK  
1.112 BETONHOHLSTEINMAUERWERK 
1.114 PORENBETON  
1.116 GIPSWANDBAUPLATTEN 
1.118 ZWISCHENWANDZIEGEL 
 
2 MASONRY AND PLASTER MORTAR 
2.202 NORMALMAUERMÖRTEL 
2.204 MAUERMÖRTEL MIT SONSTIGEN ZUSCHLÄGEN  
2.206 MAUERMÖRTEL MIT BLÄHTON-ZUSCHLAG 
2.208 MAUERMÖRTEL MIT PERLITE-ZUSCHLAG  
2.210 PUTZMÖRTEL – AUSSENPUTZE 
2.212 PUTZMÖRTEL – INNENPUTZE  
2.214 PUTZMÖRTEL MIT SONSTIGEM LEICHTZUSCHLAG 
2.216 PUTZMÖRTEL MIT PERLITE-ZUSCHLAG  
2.218 PUTZMÖRTEL MIT EPS-ZUSCHLAG 
2.220 SANIERPUTZMÖRTEL 
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3 CONCRETES AND SCREEDS 
3.302 BETON MIT ZUSCHLÄGEN AUS NATÜRLICHEM GESTEIN  
3.304 STAHLBETON 
3.306 BETON MIT BLÄHTON-ZUSCHLAG  
3.308 BETON MIT BLÄHSCHIEFER-ZUSCHLAG 
3.310 BIMSBETON OHNE NATURSAND  
3.312 HÜTTENBIMSBETON OHNE NATURSAND 
3.314 BETON MIT LEICHTSPLITT-ZUSCHLAG  
3.316 BETON MIT ZIEGELSPLITT-ZUSCHLAG 
3.318 PORENBETON  
3.320 BETON MIT EPS-ZUSCHLAG 
3.322 HOLZSPANBETON  
3.324 NICHTZEMENTGEBUNDENE ESTRICHBAUSTOFFE 
3.326 ZEMENTGEBUNDENE ESTRICHBAUSTOFFE  
3.328 KALKSANDSTEINMATERIAL 
 
4 STANDARDIZED INSULATION MATERIALS 
4.402 HOLZWOLLE-DÄMMPLATTEN (OHNE PORENVERSCHLUSS) W  
4.404 HOLZWOLLE-DÄMMPLATTEN (MIT PORENVERSCHLUSS) WW-PV 4.406 
HOLZWOLLE-MEHRSCHICHT-DÄMMPLATTEN (gem. ÖNORM B 6021) 4.408 
HOLZSPAN-DÄMMPLATTEN WS 
4.410 DÄMMKORK (reinexpandiert; gem. ÖNORM B 6031)  
4.412 DÄMMKORK (gepresst)  
4.414 GEBUNDENE MINERALWOLLE (Glaswolle; gem. ÖNORM B 6035; Wärmestrom senkrecht zur Faser) 4.416 
GEBUNDENE MINERALWOLLE (Glaswolle; gem. ÖNORM B 6035; Wärmestrom parallel zur Faser) 4.418 
GEBUNDENE MINERALWOLLE (Glaswolle; gem. ÖNORM B 6035; gekrept)  
4.420 GEBUNDENE MINERALWOLLE (Steinwolle; gem. ÖNORM B 6035; Wärmestrom senkrecht zur Faser) 4.422 
GEBUNDENE MINERALWOLLE (Steinwolle; gem. ÖNORM B 6035; Wärmestrom parallel zur Faser) 4.424 
GEBUNDENE MINERALWOLLE (Steinwolle; gem. ÖNORM B 6035; gekrept)  
4.426 EXPANDIERTER POLYSTYROL PARTIKELSCHAUMSTOFF 

(gem.ÖNORM B 6050; GPH-Nennwerte) 

4.428 POLYSTYROL-EXTRUDERSCHAUMSTOFF XPS (Altbestand; gem. ÖNORM B 6053; Zellgas FCKW) 4.430 
POLYSTYROL-EXTRUDERSCHAUMSTOFF XPS (gem. ÖNORM B 6053; Zellgas HFCKW)  
4.432 POLYSTYROL-EXTRUDERSCHAUMSTOFF XPS (gem. ÖNORM B 6053; Zellgas HFKW) 4.434 
POLYSTYROL-EXTRUDERSCHAUMSTOFF XPS (gem. ÖNORM B 6053; Zellglas Luft) 4.436 
POLYURETHAN-HARTSCHAUMSTOFF PUR (CFC-extrudiert, überwacht) 
4.438 POLYURETHAN-HARTSCHAUMSTOFF PUR (CFC-extrudiert, nicht überwacht)  
4.440 POLYURETHAN-HARTSCHAUMSTOFF PUR (Pentan-extrudiert, zw. diffusionsdichten Schichten) 4.442 
POLYURETHAN-HARTSCHAUMSTOFF PUR (Pentan-extrudiert, diffusionsoffen)  
4.444 SCHAUMGLAS 
4.446 HOLZFASERDÄMMPLATTEN (Nassverfahren)  
4.448 HOLZWOLLE (gebunden mit Wasserglas) 
 
5 WOOD AND WOOD-BASED MATERIALS 
5.502 HOLZ UND SPERRHOLZ  
5.504 HOLZSPANPLATTEN 
5.506 HOLZSPANPLATTEN (ZEMENTGEBUNDEN)  
5.508 HOLZSPANPLATTEN (GIPSGEBUNDEN) 
5.510 OSB-PLATTEN  
5.512 HOLZFASERPLATTEN (Nassverfahren) 
5.514 MDF-PLATTEN (Trockenverfahren) 
 
6 FILLS 
6.602 SCHÜTTUNGEN AUS BLÄHGLIMMER (LOSE) 
6.604 SCHÜTTUNGEN AUS KORKSCHROT (EXPANDIERT)  
6.606 SCHÜTTUNGEN AUS SONSTIGEN PORIGEN STOFFEN 
6.608 SCHÜTTUNGEN AUS SAND, KIES, SPLITT 
 
7 FLOOR COVERINGS OF PLASTIC, RUBBER AND SIMILAR 
7.702 LINOLEUM UND KORK  
7.704 KUNSTSTOFF- UND GUMMIBELÄGE 
7.706 TEXTILE BELÄGE  
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7.708 UNTERLAGE UND RÜCKENBESCHICHTUNG VON BODENBELÄGEN 
 
8 INDIVIDUAL BUILDING MATERIALS  
8.802 METALLE 
8.804 GLAS, FLIESEN, KERAMIKVERKLEIDUNGEN  
8.806 PLATTEN 
8.808 THERMAX-PLATTEN (AUS VERMICULIT; GEBUNDEN)  
8.810 PLATTEN AUS PERLITE UND FASERMATERIAL MIT ASPHALTEMULSION 
8.812 PLATTEN AUS PERLITE, BLÄHTON UND ÄHNLICHEM MIT KUNSTHARZBINDUNG  
8.814 PLATTEN AUS PERLITE 
8.816 ABDICHTSTOFFE  
8.818 KUNSTSTOFFMATERIAL 
8.820 KAUTSCHUK  
8.822 NATURSTEINE 
8.824 BODENMATERIAL  
8.826 DACHZIEGEL, DACHSTEINE 
8.828 GASE  
8.830 WASSER 
8.832 DÄMMSTOFFE IN KONTAKT MIT DEM BODEN (FROSTSCHUTZ)  
8.834 DICHTSTOFFE, DICHTBÄNDER UND WÄRMEBRÜCKENUNTERBRECHER 
 
9 OTHER INSULATING MATERIALS 
9.902 PIR  
9.904 PHENOLHARZSCHAUM 
9.906 HARNSTOFFSCHAUM  
9.908 POLYESTERFASER 
9.910 KORKSTEINPLATTEN  
9.912 DÄMMKORK (PECHIMPRÄGNIERT) 
9.914 KOKOSFASERMATTEN  
9.916 BAUMWOLLE-DÄMMATTEN 
9.918 SCHAFWOLLE  
9.920 SCHILFBAUPLATTEN  
9.922 ZELLULOSE (LOSE) 
9.924 FLACHS  
9.926 GLUED EPS-BOARDS 
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Material Database Baubook (Reference Data) 
 
The "baubook" (earlier "öbox") (www.baubook.info/zentrale/) provides characteristic values of popular materials. The 
baubook data contains set of characteristic physical and ecological indicators. The dataset has be created in cooperation 
with "Österreichisches Institut für Baubiologie und -ökologie (IBO)". Data can be freely downloaded and used in calculations. 
 
Registered users of baubook-plattform are automatically alerted by e-Mail-Newsletter if changes or extensions apply. 
 
If you miss data for specific materials please contact Baubook, Energieinstitut Vorarlberg . 
 
The reference and product indicators are based on Austrian standards and regulations and are provided for calculation of 
energy and ecology indicators created to fulfil formal requirements (energy pass). In general this data can be used in other 
countries also. 
 
These data is only partially applicable to expertise opinions - especially regarding vapour diffusion calculations. 
 
Die baubook GmbH übernimmt keinerlei Haftung für die bereitgestellten Richt- und Produktkennwerte. Es handelt sich um 
eine Aufzählung erhaltener und gesammelter Informationen. Die Datenbank erhebt daher keinen Anspruch auf 
Vollständigkeit und Richtigkeit. Die baubook GmbH haftet auch nicht für den Fall, dass eine Förderung aufgrund falscher 
Herstellerangaben nicht erteilt oder widerrufen wird. 

 

Importing updated data. 
 

Thanks to an agreement between vendors the data of the baubook-catalogue shall be used within AnTherm. While the 
materials database window is active you will find a main menu item specific to baubook-functions allowing you to initiate 
the check and download of updates from the baubook Server via internet. 
 
Remark: To execute an update check and/or the download of  baubook data an internet connection is required. 
 
Remark: The data set of baubook data is stored within a user specific folder (as defined within application settings) 
 

 

Material Database BPHDB.COM (Building Physics Database) 
 

The Building Physics Database (www.bphdb.com) provides a place to declare and maintain data for building physics 
software. 
 
The BPHDB.COM is Copyright (c) Kurt Battisti, Eichendorffstr. 1, 8010 Graz, Österreich. 

 

Importing updated data. 
 

Thanks to an agreement between vendors the data of the BPHDB.COM-catalogue shall be used within AnTherm. While the 
materials database window is active you will find a main menu item specific to BPHDB.COM-functions allowing you to initiate 
the check and download of updates from the BPHDB.COM Server via internet. 
 
Remark: To execute an update check and/or the download of  BPHDB.COM data an internet connection is required. 
 
 

Material Database APH (ArchiPHYSIK Database) 
 
The ArchiPHYSIK Database is Copyright (c) A-NULL Bauphysik GmbH, Österreich. 
 
Thanks to an agreement between vendors the data of the ArchiPHYSIK-catalogue shall be used within AnTherm. 
 
Remark: The data set "APH9_052011" reflects the state as it was friendly provided for AnTherm on 9

th
 May 2011 by A-

NULL Bauphysik GmbH, Kurt Battisti, and cannot be changed by the user. 
Remark: The data set is stored within a user specific folder (as defined within application settings)

http://www.baubook.info/zentrale/
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://www.bphdb.com/
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://www.bphdb.com/
http://www.bphdb.com/
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Material Database Ecotech (ECOTECH-Catalogue) 
 
The ECOTECH Database is Copyright (c) BuildDesk Österreich GmbH, Linz. 
 
Thanks to an agreement between vendors the data of the ECOTECH-catalogue shall be used within AnTherm. 
 
Remark: The data set "ecotech_062011" reflects the state as it was friendly provided for AnTherm on 15

th
 June 2011 by 

BuildDesk Österreich GmbH, Mag. Hermann Jahrmann, and cannot be changed by the user. 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The ECOTECH Material Catalogue window uses the data of the ECOTECH Building Calculator and provides this data 
within AnTherm. 
 
Remark: The ECOTECH Material Catalogue requires the "ECOTECH Building Calculator" to be installed already. If this 
installation is omitted, the functions are hidden (out of the Main-menu too). 
 
On the left there is ECOTECH Material Catalogue Data displayed.  
Respective materials are grouped together (e.g. standards, manufacturer) and further subdivided into subgroups.  
The nodes of such a tree can be expanded by a click onto a triangle symbol or by a double click onto the name; further 
double click (or click onto the triangle symbol) closes that node. 
 
The right part displays physical material properties (thermal conductivity λ, density ρ, heat capacity c, ...) and (optionally) 
images with further information (e.g. links to manufacturer information). 
 
To use materials out of the catalogue do the following: 

 
 Double-Click onto the material assigns that material to the currently selected element(s).  
 A Drag&Drop of a material onto Element Editor, Elements 2D, Elements 23 or Element Browser assigns that 

material to the currently selected element(s); when dropped onto Materials window appends it to the list. 
 
Compare to: Materials Database window 

http://help.antherm.eu/Forms/EcoTechBaustoffeForm/EcoTechBaustoffeForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
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Searching and filtering of materials 
 

Materials can be filtered by name by entering some test into the field at the top of the window. There is no wildcard support! 
Whitespace separated filter segments will be filter like the continuous sequence. Entering "open" for example will show only 
materials of which names contain the word "open". 
 
In addition to "name filter" one can filter materials by their auxiliary properties (e.g. "insulation", "brick"). This properties 

are defined by the manufacturer of the catalogue. Click onto (^) to show the list of selectable auxiliary filter properties. 
 
Click onto "filter delete" symbol resets the filter and all material are shown again. 
 
See also: Element Editor, Materials window, Materials Database window, Material Database ECOTECH 
 
 
 
 
 
Surfaces window 
 

The Surfaces window is used to create and maintain the list of 
project specific surface properties.  
The list of surfaces offered in this window can be synchronised with 
surfaces directly entered and used in the model, thus all surfaces 
constituting the component are displayed here also.  
Surfaces can be merged from other projects and combined in this 
list. 
 
The primary use of this window is to prepare lists of surfaces 
which, in cooperation with other windows, allow significant 
simplification and acceleration during the input of element 
properties for space boxes. 
 
Upper part of the window lists surfaces. The bottom part - Surface 
Editor - allows definition of surface properties. 
 
Important: Changes to surface properties in the project specific  
surface list do not automatically propagate to properties of construction elements. Applying new surface properties to 
selected elements must be done explicitly - either by a double-click onto a list item, via a drag-drop operation from the 
surface list or by the bulk replacement of properties. 
 
Remark: The tab "Std.Surfaces" provides a list of (read only) normative surface properties.  
 

 

 
 

 

In AnTherm Version 10 you can change RS values for several room cells. Therefor, select the corresponding room cells in the 

"Element selection". Click the right mouse button, where you will find the function "change Rs values". Click again; it opens 

another window where you can change the RS values. 

 

http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/SurfaceEditor/SurfaceEditor.htm
http://help.antherm.eu/Forms/SurfaceEditor/SurfaceEditor.htm
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Surface list 

 

A double-click onto a line representing surface in this window results in an assignment of surface properties of selected 
surface to currently selected space elements (selected from elements list). 
 
Also, by drag-drop operation (by dragging with the mouse), a surface line can be dragged onto element editor window 
resulting in assignment of surface properties to the element currently shown there. 
 
Surfaces window can be opened either from main menu View→Data Input & Entry→Surfaces or from element editor by a 
double-click onto surface name, transfer coefficient or resistance input fields. 
 
 

Surface list List of all surface properties entered 
  

Double-click left mouse Transfer of surface properties of selected material onto currently selected elemen(s) in the 

button element list. 
  

Dragging with left mouse Transfer of surface properties of dragged surface to space element currently edited in 

button element editor, 

 or: 
 Transfer of surface properties of dragged surface to currently selected space elemen(s) in 
 the element list. 
  

Click right mouse button Exposes the context menu of surface editing functions. 
  

Click left mouse button Selection of surface from surface list. Properties of selected surface are displayed in Surface 

 Editor for further processing. 
  

 
 

Remark: If there are several elements selected (from element list) then a double-click onto the surface line (or drag-drop of 
surface line) result in the assignment of surface properties to all selected elements. Such bulk element assignment has to be 
confirmed by the user. If within selected elements there are some of incompatible type (non space) further user 
confirmation is requested. Error message is shown if neither element matches the expected type. 
 

  New 
Appends a new surface onto the end of the surface list 

 Delete 
Deletes the currently selected surface from the list. 
Remark: The surface is deleted from the surface list only. 

    

  Undo(Ctrl-Z) 
       

Undoes (reverts) the latest action(s) in the given editing context. 

  Redo(Ctrl-Y) 
       

Redoes (reapplies) the action lately undone in the given editing context. 

  

 

Selects First, Previous, Next or Last surface. 

 

 

Surface selection 
 

A click onto surface's line in the surface list selects corresponding surface for further processing. 

  

Selection can be done by arrow keys or by clicking the buttons Next/Prev. also. 

 

 

 

 

 
 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/SurfaceEditor/SurfaceEditor.htm
http://help.antherm.eu/Forms/SurfaceEditor/SurfaceEditor.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
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Functions of the context menu 
 

 

  

  
 
 
 
 Add Surface  A new surface is appended at the end of the list. 

 INS-Key  
  

 Delete Surface DEL-Key  Deletes selected surface from the list. 

   
  

Apply Surface  Transfer surface properties of a selected surface onto currently selected 

  element(s) in the element list. 

  Remark: Visible when exactly one surface is selected. 
  

  Selects all elements in the element list having one specific surface 

 Select Elements by Surface  assigned. 

  Remark: Visible when exactly one surface is selected. 

  Remark: For 3D-Layered models the selection operation applies only to 

  currently active layer. 
  

Synch. from Elements  Executes immediate synchronisation of surface list from properties of all 

 elements currently in the modelled component 
  

   The synchronisation of surface list from properties of all elements in the 

 Autosynch. from Elements  modelled component  will be executed automatically (checkmark is 

  visible) and can be turned on or off here. 
  

 Sort Surfaces  Surfaces will be sorted by name and alpha. 
  

 Purge all Surfaces  Removes all surfaces from the list 
  

   Surfaces saved within another project will be read and appended to the 

 Pick from Project...  ist. 

  Remark: After importing the data from another project the (optional) bulk 

 
 replacement of surface properties on all elements with those just    
imported 

  will be offered. 
  

Replace Surfaces on All Elements 

The surface properties of all elements will be replaced by name with 
those from the current surface list (bulk replacement). 
Remark: Shall duplicate name appear in the list only the first instance in 
the order will be applied. 
Remark: For 3D-Layered models the operation applies only to currently 
active layer. 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

150 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Synchronisation of surface list 
 

The list of surfaces offered in this window can be synchronized (extended) with surfaces currently in use in the modelled 
component, thus all surfaces used in the model are also displayed. This provides the ability to transfer properties directly 
entered in element editor to the list and have them at hand as additional entries. 
 
Synchronisation can be explicitly requested from the context menu of the material list ("Synch. from Elements") or will 
automatically be executed on each element selection change when the application setting "Autosynch. from Elements" is 
active. 
 
Synchronisation executes by following steps: 

 

 All elements of modelled component are analysed. 

 Surface properties of each space element are extracted. 

 If no such surface (name, α, Rs) can be found in surface list it is appended to it. 

 Surfaces appended during this synchronisation run and appended at the end of the list are sorted alphabetically. 

 
This procedure assures, that entries are retained in the list and only "missing" surfaces will extend it. 
 
Remark: Automatic synchronisation of list contents, if active, occurs on each element selection change. Changes to 
element properties (in Element Editor) alone do not result in automatic synchronisation yet. Immediate synchronisation 
can be explicitly requested from the context menu of the surface list ("Synch. from Elements"). 
 
Tip: To have the list showing only surfaces actually used in the modelled component delete all surfaces from the list (this 
can be quickly done with DEL-key) and then request immediate synchronisation from component's elements. Unused 
surfaces are not removed automatically from the list! 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
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Standardised surface heat transfer coefficients 
 

The tab "Std.Surfaces" provides a list of (read only) normative surface properties (standard values of Rsi and Rse). You 
can find these reference values within the description of U-Value calculator. 
 
Important: While assessing heat loss different values must be used within the component model as those for the mould 
and condensation assessment! That means you will have to adjust respective Rsi and Rse values depending on the 
assessment type. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

See also: Element Editor, Elements 2D, Element list, Surface Editor window 

 

 
 

Surface Editor Window 
 

Surface Editor is used to maintain properties of surface. This window is 
displayed as part of Surfaces window. 
 

                                            
 

Surface name Name of surface. It is used for documentation purpose. 

RS  (H)  

RS  (T) 
Defines the thermal transfer resistance of the surface. RS= 1 / α 

 
Important: Changes to surface properties in the project specific surface list do not automatically propagate to properties of 
construction elements. Applying new surface properties to selected elements must be done explicitly - either by a double-
click onto a list item or via a drag-drop operation from the surface list. 
Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 
 See also: Surfaces window, Alpha (surface transmittance) hidden (application setting) 
 

http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
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Transforms (Rotate, Mirror, Translate, Stretch, ...) window 

The window Transforms combines operations of Rotation, Mirroring, Translation and Stretching applied to elements, 

 Translate window 

 Rotate window 

 Mirror window 

 Stretch window 

The input of X, Y, Z coordinates of the point defining the transformation is common to both functions. 

 

 
Undo (Strg-Z) 
Redo (Strg-Y) 

 Undoes (reverts) the latest action(s) in the given editing context 
 or 
 Redoes (reapplies) the action lately undone in the given context. 

See also: Element Editor, Context menu of element processing, Element selection window 

 

Translate window 

The Translate window allows translation of one or many elements (selected the element list) 
by specific distance (dX,dY,dZ). 

The window Translate can be called from the context menu of element processing (a sub 
menu Translate). 

 + Translate Translates one or many elements (selected the element list) by specific 
vector (dX,dY,dZ) 

 − Translate Translates one or many elements (selected the element list) by specific 
vector (−dX,−dY,−dZ) 

 Duplicate Inserts a copy of currently selected element(s) into the element list. 
Remark: Holding SHIFT-key while that button is depressed will 
additionally swap coordinates of the duplicate. 

If several elements are selected their copies are appended to the end of 
element list retaining their order. 
After being inserted all these element copies are marked selected thus 
being ready for further processing. 
Remark: This function is identical to "Duplicate" in the context menu of 

http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/MirrorForm/MirrorForm.htm
http://help.antherm.eu/Forms/TranslateForm/TranslateForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
http://help.antherm.eu/Forms/TranslateForm/TranslateForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/MirrorForm/MirrorForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm#Duplizieren
http://help.antherm.eu/Forms/TranslateForm/TranslateForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/MirrorForm/MirrorForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
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element processing. 

Duplicate and then 
Translate 

If this checkbox is marked, "Duplicate" is executed prior to each 
"Translate". The translation is then applied to the copies (duplicates) of 
elements selected earlier. 
Remark: The functionality of "Duplicate and then Translate" provides a 
basis for the entry of complex components, especially those representing 
sloped constructions. 

 
Undo (Strg-Z) 
Redo (Strg-Y) 

Undoes (reverts) the latest action(s) in the given editing context 
or 
Redoes (reapplies) the action lately undone in the given context. 

The translation is applied equally to all elements selected from the element list. Is no elements are currently selected both 
buttons "+ Translate" and "− Translate" are inactive. 

Remark: Repetitive combinations of "+ Translate" and "− Translate"  can be used to revert translations. 

Remark: Z-coordinates of elements in 2D or Layered 3D projects are calculated from layer's thickness. Therefore the input 
field dZ is inactive in such projects. 

See also: Element Editor, Context menu of element processing, Element selection window, Stretch window, Rotate window, 
Mirror window 

Rotate window 

The window Rotate allows rotations of one or more element(s) selected from element list.  
The window is opened from the context menu of element processing (submenu Rotate). 

Rot. Z Selects the rotation in the Z plane. The centre of rotation is defined by the input 
of  X und Y coordinate values 

Rot. Y Selects the rotation in the Y plane. The centre of rotation is defined by the input 
of  X und Z coordinate values 

Rot. X Selects the rotation in the X plane. The centre of rotation is defined by the input 
of  Y und Z coordinate values 

X, Y, Z Coordinates of the rotation centre point 

- 90° clockwise All element(s) selected from element list are rotated around the rotation's 
centre. 

+ 90° counter 
cw. 

All element(s) selected from element list are rotated around the rotation's 
centre. 

180° rotation All element(s) selected from element list are rotated around the rotation's 
centre. 

 Rotate Selection of the rotation function of this window 

 
Undo (Strg-Z) 
Redo (Strg-Y) 

Undoes (reverts) the latest action(s) in the given editing context 
or 
Redoes (reapplies) the action lately undone in the given context. 

 

  

The rotation is applied equally to all elements currently selected in the element list. If there are no elements selected all 
Rotation buttons are set inactive. 

Remark: Rotation in Y or X plane is available only in 3D projects. 

Remark: Element rotation are done only in 90 degrees steps to keep the orthogonal structure of the input model. 

Remark. To rotate elements of belonging together it is advised to assign them to a group. This allows for later selection from 
context menu of element processing by group name easily. 

http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm#Duplizieren
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/MirrorForm/MirrorForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

154 
 

See also: Element Editor, Context menu of element processing, Element selection window, Translate window, Stretch 
window 

 

Mirror window 
 

 

The window Mirror allows mirroring of one or more element(s) selected from element list. The 
window is opened from the context menu of element processing (submenu Rotate or Mirror). 

Mirror X Selects the X plane as mirroring plane. The position of mirroring plane is 
defined by the input of  X coordinate value 

Mirror Y Selects the Y plane as mirroring plane. The position of mirroring plane is 
defined by the input of Y coordinate value 

Mirror Z Selects the Z plane as mirroring plane. The position of mirroring plane is 
defined by the input of  Z coordinate value 

X, Y, Z Coordinates of mirroring plane 

Mirror All element(s) selected from element list are mirrored by the mirror plane. 

 
Undo (Strg-Z) 
Redo (Strg-Y) 

Undoes (reverts) the latest action(s) in the given editing context 
or 
Redoes (reapplies) the action lately undone in the given context. 

 

  

The mirroring is applied equally to all elements currently selected in the element list. If there are no elements selected all 
Mirror button is set inactive. 

Remark: Mirroring by Z plane is available only in 3D projects. 

Remark. To rotate elements of belonging together it is advised to assign them to a group. This allows for later selection from 
context menu of element processing by group name easily. 
  

See also: Element Editor, Context menu of element processing, Element selection window, Translate window, Stretch 
window, Rotate window 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/TranslateForm/TranslateForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/TranslateForm/TranslateForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
http://help.antherm.eu/Forms/StretchForm/StretchForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
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Stretch window 

 

The Stretch window allows stretching (extending, lengthening) of one or many elements 
(selected the element list) located on one side of specified coordinate by specific distance. By 
entering negative distance the effect of "shrinking" (shortening) elements can be reached. 

The window Stretch can be called from the context menu of element processing (a sub menu 
Stretch). 

By X Selects stretching operation in X direction. 

By Y Selects stretching operation in Y direction. 

By Z Selects stretching operation in Z direction. 
Remark: Not available for 2D and 3D-Layered projects. 

Stretch−> Translates points of one or many elements (selected the element list) which 
coordinate values are larger then (are located right to) the From-Entry by 
specific interval by 

<−Stretch Translates points of one or many elements (selected the element list) which 
coordinate values are smaller then (are located left to) the From-Entry by 
specific interval by 

Shrink<− Translates points of one or many elements (selected the element list) which 
coordinate values are larger then (are located right to) the From-Entry by 
specific interval −by 

−>Shrink Translates points of one or many elements (selected the element list) which 
coordinate values are smaller then (are located left to) the From-Entry by 
specific interval −by 

 
Undo (Strg-Z) 
Redo (Strg-Y) 

Undoes (reverts) the latest action(s) in the given editing context 
or 
Redoes (reapplies) the action lately undone in the given context. 

The shift is applied equally to all elements selected from the element list, but only restricted to coordinates located on one 
side of the From-Input value. If no elements are currently selected buttons are inactive. 

Remark: Repetitive combinations of "+ Interval" and "− Interval" (in that order) can be used to revert the operation. 

Important: Using negative "by" value will in most cases result in irreversible result! 

Remark: Z-coordinates of elements in 2D or Layered 3D projects are calculated from layer's thickness. Therefore stretching in 
Z direction is inactive in such projects. 

See also: Element Editor, Context menu of element processing, Element selection window, Translate window, Rotate 
window, Mirror window 

 
 
 
 

http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm#UndoRedoActions
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/TranslateForm/TranslateForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/RotateForm/RotateForm.htm
http://help.antherm.eu/Forms/MirrorForm/MirrorForm.htm
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Slopes and Roundings 
 

Elements are defined in AnTherm by their coordinates – X1, X2, Y1, Y2 and, in 3D, additionally Z1 and Z2. In previous versions 
this allowed only for rectangular elements. The finite differences method requires rectangles. Still it is now also possible to 
enter slopes and roundings which are subsequently approximated by rectangular steps. The number of steps can be defined 
by the user to achieve a good balance between the necessary precision and the computation speed. 

To modify the method of input as little as possible we have decided to insert an additional button into the element editor 
which allows to convert the current element to a slope or roundness. This method considers the coordinates of the two 
points as the ending points of the slope or roundness. The slope is modelled as a triangle, the roundness as a sector of an 
ellipsis. By combining several rectangular elements and converting them to triangles or sectors of ellipses you can, for 
instance, represent roofs or camins. 

Moreover, it is now possible to input elements rotated by an angle between 0 and 90° (clockwise or counter-clockwise). 
These elements can be rectangular or triangular and will eventually also be converted to several rectangular elements. 

New Elements 

The new function „Slopes and Roundings“ permits input of three additional types of elements by first specifying the 
coordinates of two corner points and then clicking the button “Convert to Slope or Roundness”. This makes AnTherm 
interpret the new element not as a rectangle but as another type of element. The type of element can be chosen in the 
window that appears after the click on the button. In the most basic case, there are the following options: 

 Slope: Oblique elements have the shape of a triangle. 
 Roundness: Roundings have the shape of a sector of an ellipse.  

 Roundness Complement: These elements correspond to the difference between a sector of an ellipse and a 
complete rectangle.  

 In the most basic case the chosen shape is drawn with its oblique or round edge ending with the specified corner 
points. 

Moreover, it is possible to draw geometric shapes which are composed of up to four oblique or round elements.  

Quadrants 
 
Upon conversion into a slope or roundness the element can be divided into up to four quadrants. This has the effect that up 
to four elements of the chosen shape are drawn which in turn are approximated by rectangular elements. What is important 
is that the element is always drawn in such a way that the corner in the respective quadrant remains empty. So if you draw a 
slope in the top left quadrant, it goes from the bottom left to the top right corner point of the rectangle and the bottom right 
corner point of the rectangle is the third corner point of the triangle. The top left corner point of the rectangle remains 
empty. 
The following sketch demonstrates this principle by means of an example: A square has been divided into four quadrants and 
in each of these quadrants a slope has been drawn. 
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Input 

To input a slope or roundness first you have to create a new element: 

 

Next, you click „Convert to Slope/Roundness“. The following window appears: 

 

The individual components of this window are rather easy to explain:  

 Shape: Slope, Roundess or Roundness Complement 

 Layer: Only relevant to the three-dimensional case. Here the user specified whether the slope or roundness should 
appear in the X/Y layer, the X/Z layer or the Y/Z layer. If the user chooses the X/Y layer, the coordinates Z1 and Z2 
remain the same for all of the elements into which the slope or roundness is subdivided. In case of a slope this 
results in a solid figure with the form of a prism, the base of which is located on the X/Y layer. 

 Steps: Number of rectangular elements into which the slope or roundness is effectively subdivided. This number 
refers to a single quadrant. If you draw a shape composed of the two left quadrants, this shape will be effectively 
subdivided into the twofold number of steps. Choosing the two upper quadrant also results in a twofold number of 
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rectangles. However, the number of steps effectively corresponds to the number entered as the staircase-shaped 
elements are vertically aligned. 
 

 Quadrants: Here the user can choose the quadrants to be drawn. In the section „Quadrants“ the effect of this has 
been explained. If no quadrant is specified, the signs of dX, dY and dZ decide how the shape or roundness is drawn. 

If we want to convert the square which we initially created to a circle in a high resolution, we have to make the following 
inputs:   

 

The square is thus subdivided into four quadrants in each of which a sector of an ellipse is drawn. Since the basic element is a 
square, which means that its width and height are identical, the resulting shape will be a circle. Choosing 200 steps results in 
a very high resolution (maybe even higher than necessary).  

We get to see the result as soon as we click the button „OK“:  

 

                                           It is also easily possible to create composed shapes such as this one:  
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In order to create this shape we start with a square-shaped material box. We duplicate this box and convert one of the two 
copies to a roundness where we specify the top left and bottom right quadrants to be drawn. We then convert the other 
copy to the complement of a roundness and choose the top right and bttom left quadrants. Done!  
 
 
Undo 

It is possible to undo the entering of a slope or roundness by pressing CTRL+Z or clicking the respective button in the element 
window immediately after entering the slope or roundness.  

Later on it is possible to remove a slope or roundness by checking the elements belonging to it in the element list (several 
elements can be chosen at once by pressing the SHIFT key and clicking at the same time or pressing the CTRL key and clicking 
at the same time) and deleting the elements by pressing the DEL key.  

Rotations 

Rectangular and triangular elements can also be rotated by an angle between 0 and 90 degrees (clockwise or counter-
clockwise). As an example a triangle rotated by 60 degrees is shown here.  
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Remarks 

With increasing number of steps, the precision of the calculation increases. It is recommended to use a high number of steps 
for optimal precision.  

Long, thin elements such as heat sources or thin films require a very high number of steps. We recommend to model these 
elements as the last ones.  

If you want to rotate several elements at once by an arbitrary angle between 0 and 90 degrees, with the rotation point being 
the same for all elements, it is recommended to follow these steps:  

1. Choose all elements you want to rotate. Click the first element, then keep the CTRL key pressed while clicking the 
next element and so on. 

2. Click an element with the right mouse button and select "Convert to Slope/Roundness" in the context menu. 
3. Choose "Rotated Rectangle", enter the rotation point and either keep the number of steps suggested by AnTherm or 

choose a larger number, but not less than suggested. 
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Elements 3D window 

The Elements 3D window shows a 3D view of the component entered. This view is used for continuous verification of the 
input and of the resulting construction model. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

The 3D view can be arbitrarily moved within virtual 3D space with the mouse (rotated, translated or zoomed). The 3D view 
can be copied onto the clipboard to be pasted later into another application (e.g. Word) from the clipboard - for example 
for the purpose of integrating this 3D view into some user's report.  
 

More 
Light  

If checked is turns additional "light sources" on to add more contrast or brightness to the view.  
Remark: Adding more light might result in perception of some shift of how the view coloured - this might be 
sometimes confusing the the viewer with "overexposure". 
See also: More Light (setting) 

Back 
Colour 
  

Allow for the choice of the background colour used in the 3D view. 
See also: Background colour (setting) 

Opaque,  
Opacity 

Defines the transparency of model surfaces. AN opaque object is obscure. It obscures fully all objects located 
behind it. It the opaque checkmark is removed, the opacity can be set to define the degree of transparency of the 
object. 
See also: Opaque and Opacity (setting) 

Solid  Changing this setting allows for the choice if objects are shown as solid models or as wire frame (lines) only. 
See also: Solid or wireframe (setting) 

Optimize Coinciding ashlars of the model resulting from overlapping elements (minimum grid) are analysed for equal 
properties and joined into one object if possible. 
Remark: Turning this setting on is especially useful to eliminate most of partly transparent planes nested within 
space areas which might be distracting for the observer.  

Spaces Displaying of space elements (space boxes, shown partly transparent) can be turned on or off. 
  

Fit The Position and scaling of the view will be adjusted to show the whole component within the window. 
  

Copy 
Image  

The image of the 3D view is copied onto the clipboard.  
The 3D view can be copied onto the clipboard to be pasted later into another application (e.g. Word) from the 
clipboard - for example for the purpose of integrating this 3D view into some user's report.  

http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
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The View 
 

The view shows the model resulting from the overlapping of all elements entered within the component (this is the 
starting point of so called "minimum grid"). 
 
How each element is shown depends on element's type and colour assigned to is, whereas: 

 

 Empty boxes are only visible if selected. 
 Space boxes are shown partly transparent. 

 
Element(s) currently selected in the element list are shown emphasized by their edge lines. 
 
Remark: When this window is focused following functions specific to this window are available from the main menu: 

 

 View→3D Navigation functions (side views, rotations, perspective etc.) 

 Edit→Copy to place the Image on to the clipboard 

 File→Export→Image... to save the image to picture file 

 File→Export→Scene... to save the 3D scene to 3D scene file. 

 
Remark: Labels on axes can be adjusted within application settings. 
 
Remark: The size and proportions of the picture placed onto the clipboard are preset within application settings. 
 
Remark: Current position of the 3D view (the isometry given by the current view vector) will be retained when the window is 
closed and saved when the application exits. The next time the window is opened the view isometry will be restored if such 
behaviour is set within application settings. 
 
See also: Elements 2D window, Element Editor, Element selection window, Further control elements, 3D Navigation in 3D 
windows, TrackBall rotation, The main menu, Coordinate system, Application settings 
 
 
 

http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Export/Szene3D_Export.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.eu/CoordinateSystem/CoordinateSystem.htm
http://help.antherm.eu/CoordinateSystem/CoordinateSystem.htm
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Elements 23 window 
 

The Elements 23 window is used to input 3D models. It combines three Elements 2D windows and Elements 3D window (for 
example) in one coordinated input form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Within four quadrants the 3D view is shown at top-right quadrant (by default setting) and three parallel projections, 
identical to those of Elements 2D window, are shown in the other three: 

 

 at left-bottom: the X/Y plane 

 at left-top: the X/Z plane 

 at right-bottom: the Z/Y plane 

 
This provides consistent consistent axe's alignment of neighbouring quadrants connected to the X/Y quadrant (left-
bottom). 
 
Each of the three 2D views displays elements in their overlapping order (input order as set within the element list, without 
any Z-buffer) ! 
 
Editing and selection functions are identical to those of Elements 2D window. 
 
The 3D view is identical with Elements 3D window. 
 
Which view is shown in each quadrant can be defined within extended user interface settings . 
 
The views can be copied onto the clipboard to be pasted later into another application (e.g. Word) from the clipboard - for 
example for the purpose of integrating this view into some user's report. Views can be saved to a picture or scene file also 
 
See also: Elements 2D window, Elements 3D window, Coordinate system, Extended user interface settings, Export 
Image 2D, Copy Image 2D, Context menu of element editing 
 
 
 

http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/CoordinateSystem/CoordinateSystem.htm
http://help.antherm.eu/CoordinateSystem/CoordinateSystem.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
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Status Report window 
 

The window "Status of input" provides an active and detailed view onto data of the modelled component. 

This window can be accessed form the main menu via View→Data Input & Entry→Status-Report. 

 

 

                 
          
 
 
 
Contents of this window are permanently updated on each change to input data. Therefore it resembles detailed view on 
current state of input model. 
 
Under certain circumstances such recurrent updates of this display might lead to significant performance loss of the 
application (lengthening its response times). Therefore it is advised to open this window for verification purpose and 
close it when done. 
 
See also: Reports 
 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Auswertungen.htm
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Boundary Conditions window 
 

The window Boundary Conditions enlists all spaces of which the 
user sets temperatures and all power sources of which power 
density can be entered (the boundary conditions). For dynamic, 
transient problem solution the window mutates to allow input of 
time dependant quantities. 
 
Temperatures of spaces are initially preset to standard values: 

 

 first space in the list (sorted alphabetically) is set to 
airspace temperature of -10°C 

 all other spaces are set to the temperature of +20°C. 

 
Remark: These standard values can be changed within application settings. 
 
Spaces are enlisted alphabetically. Knowing this, by consequently naming spaces you can target proper automatic 
assignment of preset values.: 

 Exterior precedes Interior 

 Space 00 precedes Space 03 and Space 10 

 Space 11 precedes Space 1. 

 
If the component contains power sources (heat sources or sinks) also, their names will be offered here for the input of 
their respective power density [W/m

3
]. Initially power sources are set to have no power (equal 0 W/m

3
). 

 
Remark: If there is solution of vapour calculation available too, the input of relative humidity of air space, required 
for vapour evaluations of partial pressure, is also offered in additional dedicated column: 
 
 
 
 

 

Relative humidity of air spaces is initially preset as follows: 

 

 first space is assigned the relative air humidity of 80% 

 all further spaces are assigned relative air humidity of 53%. 

 
Remark: These standard values can be changed within application settings.     

 

Name Name of the space or power source (not editable) 

Value 
The value of the boundary condition of specific space (temperature °C) or power source (power 
density W/m

3
). 

Unit Unit of the value of that specific boundary condition (not editable)           

Rel. Humidity Relative air humidity in percent 

Part. Pressure 
Partial pressure of vapour (in hPa) resulting from the temperature and relative humidity values 
entered (not editable 

Expose graphical 
evaluation too 

If checked here, the graphical evaluation (Results 3D window) will be started after boundary 
conditions are applied. If this setting is turned off the graphical evaluation (if not open yet) will 
not be executed automatically.  
See also Application settings. 

Evaluate secondary 
functions 

If checked here, secondary functions (like heat flux, relative surface humidity, etc.) will be 
calculated for graphical evaluation. If turned off (unchecked) only temperature field will be 
calculated for Results 3D evaluations. This saves significantly time needed for calculation and 
reduces memory demand during evaluation. 
See also Application settings 

Apply 
Confirms data entered in this window end initiates the superposition followed by various 
evaluations. 

 
You confirm the data entered by pressing the button Apply. Boundary conditions will be applied onto basic solutions (g-
values). If calculation of basic solutions is also required it will be automatically initiated also. 

 

     

 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Graphische Auswertung immer anzeigen
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen Auswerten
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Remark: The button "Apply" will blink if there is new solution set available from the solver, but the data entered in this 
window has not been applied yet to the new solution set.  
Remark: The button "Apply" is shown disabled if one or more basic solutions have not been calculated (solved) yet, i.e. 
they are missing. 
 
The temperature distribution with the construction results from the superposition of respective basic solutions each 
multiplied by its boundary condition. Results are presented as text reports ready for printing or to be saved as Adobe 
PDF, MS.Word or MS-Excel files.  
The distribution of temperature and further secondary functions is further used in various graphical evaluations. 
 
Templates of Boundary conditions are saved to the project file when the project is saved. 
 
Remark: All BCs will be merged by their Names into the projects BC-Template upon apply. This will retain BCs even when 
spaces or power source are renamed or removed from the project. By that the BCs of other projects can be merged and 
saved - even such with names which are not yet (or no more) available if the current project. 
 
Important: To retain the values of boundary conditions between program executions the project must be explicitly saved 
(project data is not saved automatically when boundary conditions are applied!). 
 
Remark: You will need the value of power density W/m

3
 to properly enter the boundary condition specific to power 

sources. For verification purposes you will find the total volume of each power source within Modelling Report. Within 
Results Report, in addition to the value of respective power densities, you will also find the overall power of each power 
source. 

 

VAPOUR-option: Analysis of multidimensional vapour diffusion is only possible   
with an active VAPOUR-Option of the program.. 

 

 
 

Transient Boundary Conditions (periodic, harmonic) 
 
 
For the purpose of dynamic, transient problem (subject to the TRANSIENT-Option) the boundary conditions window 
mutates to input of time dependant quantities. 
        

           
 

TRANSIENT-option: Solving and evaluating time dependant dynamic, periodic problems 
when heat capacity effects are concerned is only possible with an active TRANSIENT-Option 
of the program.  

 
 

The transient boundary conditions are provided as sets of harmonic Fourier coefficients created for respective periodic 
data (these are managed in Periodic / Harmonic Data Editor) for each and any Main Period of the transient problem (as 
selected in Solver parameter form). 
 
Boundary conditions are kept distinct of each solution period and also saved to the project file when the project is saved. 
Important: To retain the values of boundary conditions lately applied the project must be explicitly saved (project data is 
not saved automatically when boundary conditions are applied!). 
 
Remark: All BCs will be merged for each Period (including MainPeriod=0 - steady state) by their Names into the projects BC-
Template upon apply. This will retain BCs even when spaces or power source are renamed or removed from the project. By 
that the BCs of other projects can be merged and saved - even such with periods and names which are not yet (or no more) 
available if the current project. 

 

 

http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.kornicki.com/Introduction/83_Transient.htm
http://help.antherm.kornicki.com/Introduction/81_Dampfdiffusion.htm
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Main Period The Boundary Conditions window title bar displays the Maine Period of the currently evaluation transient, 

(title-bar) periodic problem (as selected in Solver parameter form). 
  

Time Point to Some evaluation time point T within the Main Period of the solution. 

evaluate If checked the change to the time point is immediately applied together with boundary conditions and 
 reflected in evaluation windows (Results report, Results 3D window) once these are open. 
  

#H Number of harmonics solved (harmonic solutions) for the selected Period and available to further 
 Evaluation 
  

#Hc Number of continuous harmonics solved for the selected Period and available to further evaluation 
  

Periodic Data Periodic boundary conditions data managed in Periodic / Harmonic Data Editor 
 By default the Constant Value Periodic data will be initially set respectively to the steady state boundary 
 condition. 
  

#Hbc Number of harmonics available from Fourier Analysis out of periodic boundary conditions data (managed 

 in Periodic / Harmonic Data Editor) available to further synthesis and evaluation 

 
 

#Hsynth Number of harmonics chosen for use in harmonic Fourier Synthesis out of those available from periodic 

 boundary conditions data (#Hbc) 

 The highest number of harmonics used during synthesis (#Hsynth) results from the smallest count of 
 harmonics within the base solution and out of the respective boundary condition and can be further 
 reduced (-1 - all available). 

 Remark: Evaluating in TRANSIENT mode with only 0-th harmonic or only Constant Boundary Conditions 

 is identical to Steady State results (regardless of HARMONIC or TRANSIENT license feature). 

  

#Heff Effective number of harmonics used in harmonic Fourier Synthesis out of those available from periodic 

 boundary conditions data (#Hbc) and those available from the solution set (#H). 

 
 

Value Synthetic boundary condition value at the evaluation time point T 

 
 

  

Timelines Opens Timelines window displaying synthetic temporal, time dependant results at selected Probe Points 

 together with timelines of synthetic boundary conditions applied. 

 
 

Animate Displays the Animate Time Dialog used to define temporal animation of transient evaluation by 

 automating changes to the evaluation time point T. 
  

 

Time Point to Evaluate: provided existence of periodic boundary conditions on can set the evaluation time point (within 
the main period) 
 
Remark: During graphical evaluation the time point information will be displayed in the title of the colour bar. 
 
For the evaluation the harmonic base solutions are combined with the respective harmonic coefficients of the boundary 
condition the belong to (complex linear combination). The resulting distribution harmonic coefficients it then passed for 
Fourier synthesis for specific evaluation time point T. 
 
Remark: Provided that the periodic boundary conditions did not change, only synthesis for new time point must be 
executed. 
Remark: Evaluating in TRANSIENT mode with only 0-th harmonic or only Constant Boundary Conditions is identical to 
Steady State results (regardless of HARMONIC or TRANSIENT license feature). 
 

 

MULTICORE-option: Speeding up computationally intensive jobs by distributing them on 

multiple processors or processor cores for parallel execution is only possible with an active 

MULTICORE-Option of the program. 
 

 

Remark: The input of relative air humidity (when vapour diffusion problem has been solved too) are sill constant (steady 
state) and independent of air temperatures. Only the partial pressure will be recalculated for respective, evaluation time 
point dependant, air temperature. 

 
See also: Element Editor, Element types, Evaluations and Results, Standard Boundary Conditions, Periodic / Harmonic Data 
Editor, Animate Time Dialog, Timelines Window 

http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/TimelinesForm/TimelinesForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
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Periodic / Harmonic Data Editor 

 
 
The Periodic / Harmonic Data Editor window provides the means of creating, editing and managing periodic climate data 
required as boundary conditions to transient evaluation. 
 
TRANSIENT-option: Solving and evaluating time dependant dynamic, periodic problems when 

heat capacity effects are concerned is only possible with an active TRANSIENT-Option of the 

program. 
 

The Periodic / Harmonic Data Editor will be used out of the Boundary Conditions window when transient problem is to be 
evaluated and time dependant boundary conditions are needed for that purpose. For convenient managing periodic data 
sets it us available from a Tools Menu also. 
 
There are following types of data which could by managed within Periodic / Harmonic Data Editor: 
 

 Constant 

 Regular Points 

 Regular Means 

 Irregular Means 

 Irregular Steps 

 Harmonic Coefficients. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
          

       The window contains three parts: 

 File & Examples Menu 

 Info 

 Graph 

 Data Grid 
 
 

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
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File Menu:  New - create new data set of the specific part. A dialog is shown to provide the      
information required for specific type (see "Info Part"). 

     Open/Save/Save As... - provides the file access to the data  
     Convert To... - allows simple synthetic conversions between selected periodic data 

types. 
Info Part: The Info part displays the characteristic information for the dataset being processed. 

Depending on the type of data different information is displayed and eventually 
available to in put. 
The initial specific values are supplied during the creation of the data set (File-
>New...) and a limited set of them, depending on the data type processed, can be 
changed later. 

  Description identifying the data 

  Period Length 

  Number of Interval 

Graph Chart Part: The graph chart represents and displays the input data along with its synthetic variant 
resulting from harmonic Fourier analysis and synthesis. 
Zoom with lasso... 
The legend provides the identification of patterns shown. A double click on to the legend 
will change its position relative to the chart area (right, left, top, bottom). 
Data points can be selected. 
Data points (or bars) can be dragged changing the value (press ESC to abort the 
unintentional drag operation an revert to the previous value). 

Context menu of the 
Graph Chart: 

 Reset Zoom                                 

 Zoom enabled 

 Zoom X only enabled 

 Appearance 

 Page Setup... 

 Preview... 

 Print... 

 Copy 

 Export Image... 

 Show synthetic data 

 Window Function (Gibbs Effect) 
Selection of the windowing filter function to reduce the Gibbs effect (e.g. while 
working with switch functions "IrregularIntervalSteps" or dense data with high 
value changes). 

 Fejer window 
 Hann window 
 Hamming window 
 None 

 Cut-Off Harmonic 
Limits the number of harmonics for the Fourier syntheis. 

Data Grid Part: The data is input into the Value column. 
The native Copy & Paste of the selected cell(s) is provided. 
Capability to paste data from/to the Value column streamlines the input procedure (also 
available via Context Menu).All numbers contained in the paste buffer (regardless if 
column(s) or row(s)) will be parsed as double entities (entries in error and not parse able as 
such in be ignored) and transferred in the order to the value column. 
 

 
 

Buttons: With the button "Harmonics" the user can open a window where the individual 
components of the harmonic Fourier series are displayed in their temporal progression. The 
harmonic value at a given point of time is (approximately) the sum of the individual 
components. The user can choose which of up to twelve components should be displayed. 
It is also possible to assign various colours to the components. 
With the camera button it is possible to create a screenshot which can later be used in the 
report builder. In the Harmonics window there is this possibility as well. 
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Probe Points / Extreme (min/max) Locations window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 

The window Probe Points is used to input any number of arbitrary points for which the Probe Points report shall be 
generated (second part of Results report). The list of probe points can be extended from the Result 3D window (Probe) 
also (by "Collect point"). 
 
The Min/Max tab of the window lists interesting locations with extreme values (e.g. points lowest and highest temperatures 
at surfaces of all spaces and within the interior of all power sources) thus providing the ability to select them for further 
evaluation. This read only listing is automatically provided and updated as soon as any boundary conditions have been 
applied to the solution. 
 
 
 
 
 
 
 
 

 

 

 

X, Y, Z Coordinates of the point in millimetres 
  

Comment An (optional) description of the point entered (used for documentation only) 
  

Delete/New Deletes the current data line or append a new one 
  

Pick from Project... Probe points saved within another project will be read and appended to the list. 
  

Report Confirms the data entry and initiates the creation of probe points in the Results report. 

  

Double click onto Initiates translation of the current probe point shown in the Result3D window to the position shown 

data record mark in the line clicked - it translates Slices X/Y/Z accordingly. Within a 2D-project the Z-slice is set to 

 500 mm. 

Go To 
Remark: It is data shown in the currently marked line transferred - this means, that a double click  

 onto column or new row will also result in setting the current probe point to values shown selected 
 by data mark arrow. 
  

 

 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
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The input is confirmed by pressing the button Apply. 
The second part of Results report will show evaluation of temperatures for all points (x, y, z coordinates) entered in this 
window. If some point does not belong to the interior of the construction no temperature values will be shown in the 
corresponding line of the report. 
Probe points entered are saved to the project file. 
 
Remark: Similar evaluation of one probe point is available within graphical results of the application. 
Remark: The active tab will be saved upon the window is closed together with the application settings 

(LastSelectedProbePointsFormTabPageName) and restored when this window is opened again. 
 
Remark: While "Collect Point" (e.g. out of "Results 3D window") is requested the window will switch to the "User" tab 
where the new probe point will be appended. 

 

See also: Results report, Boundary Conditions window, Evaluation windows, Probe (control panel), Coordinate system, 
Slice X, Y, Z (control panel), Timelines window 
 
 
 
 
 
 
 
 
MULTICORE-option: Speeding up computationally intensive jobs by distributing them on multiple  
processors or processor cores for parallel execution is only possible with an active  
MULTICORE-Option of the program 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/CoordinateSystem/CoordinateSystem.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
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Interface AnTherm/SolRad  
 
 

Interface AnTherm/SolRad 

For customers of AnTherm/SolRad there is now the possibility to evaluate the influence of solar radiation and the long-
wavelength radiation to and from the external surfaces of a building construction with regard to thermal transmission and 
temperature distribution. 
 
Since the influences of the radiations are dependent on their orientations, there can be several„exterior spaces“. An exterior 
space could, for instance, be subdivided into the spaces „south wall vertical“, „west wall vertical“ and „oblique roof“. In the 
course of the evaluation, three diurnal variations of the radiation air temperature and the related thermal transmission 
resistances are assigned to these three spaces. 
 
The radiation air temperature is a fictional temperature which is influenced both by the solar radiation and the long-
wavelength radiation exchange. If an AnTherm user specifies the radiation air temperature instead of the exterior air 
temperature, this means that not only the diurnal solar radiation is considered but also the long-wavelength radiation 
exchange between the exterior surfaces of the exterior building components on the one hand and the sky and the terrestrial 
environment on the other. The use of the radiation air temperature implies that the absorption and reflection processes 
occur at the exterior building component surfaces. The used method is capable of exactly reproducing these processes. 
Until now, the user specified outside air temperatures in AnTherm as exterior boundary conditions. In the stationary case, 
this is a single value. In the instationary, periodic case this is the 24 values of a diurnal cycle. 
 
SolRad Version 4.1 or higher and AnTherm Version 9.136.2 or higher are now connected via an interface. 
The diurnal variations of the radiations computed by SolRad (global radiations in Wm

-2
) at the project site can be exported 

from SolRad for a chosen date and orientation by clicking the „Export“ button. 
These exported result files can then be imported in AnTherm in order to compute radiation air temperatures and thermal 
transmission resistances. 
 

Short Instructions Guide:  

 

1. Program SolRad 

 
1.1 In SolRad, open the project from which you would like to export the data and click the button „Export“.  

1.2 Choose date and orientation. The orientation corresponds to an exterior surface of an exerior component 

appearing in an AnTherm model. 

1.3 Enter the filename as which the data to be exported should be saved. Mind that you might have to export 

radiations on differently orientated exterior building components. 

       1.4    Confirm the export by clicking „OK“. 
 
The data are now exported and are then available for being imported to AnTherm. 
Repeat the steps 1.2 to 1.4 until the radiations on all exterior building component orientations that appear in the AnTherm 
model have been exported. 
 

2. Program package AnTherm 

The computation of the radiation air temperatures from the outside air temperatures and the solar radiations imported    
from SolRad can be done for the stationary and for the instationary periodic case. To ensure compatibility with SolRad, it is 
only possible to calculate with period length being one day in the instationary case. 
 

Important! 

The computation of the radiation air temperaturs not only leads to a temperature value (in stationary case) or a diurnal cycle 
of the temperatures (in the periodic case) but also a thermal transmission resistance which has to be assigned to the 
considered exterior space. 
Since the thermal transmission resistances have been entered in AnTherm when the geometric modelling happens but the 
assignment of the boundary conditions only happens in the course of the evaluation (the actual computation), it is necessary 
to compute the radiation air 
temperatures before the geometric modeling, either by using the tool „Radiation Temperatures Calculator“or the 
„Periodic/Harmonic Data Editor“ in the menu „Tools“. The thermal transmission resistances assigned to the radiation air 
temperatures have to be linked by the user to the exterior spaces in the course of the geometry input. 
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     2.1      Stationary Computation 

2.1.1 Choose the „Radiation Air Temperatures Calculator“ in the menu „Tools“. 

2.1.2 Into the field „Outside Air Temperature“, enter the diurnal average of the exterior air temperature for the day 

for which SolRad computed the radiations. Usually this value matches the long-year monthly average at the 

project site. 

2.1.3 Into the field „Enviroment Air Temperature“, enter the diurnal average of the surface temperature of the 

terrestrial environment. In almost all cases this value matchs the diurnal average of the outside air temperature. 

The exceptions are cases with heavy snow or bodies of water. 

2.1.4 Into the field „Global Radiation“, enter the diurnal average of the area-related global radiation to the exterior 

surface of the considered exterior building component in Wm
-2

. This value can be either manually derived from 

the program SolRad or automatically imported from the result file by clicking the button „Import“. 

2.1.4 In the field „Absorption of Sun Radiation“ the color of the exterior surface of the considered exterior building 

component is classified. The absorption number specifies the percentage of the solar radiation hitting the 

surface that is absorbed; the remainder is  

 

2.2 Periodic Computation 

 
2.2.1 Choose the „Periodic/Harmonic Data Editor“ in the menu „Tools“. 

2.2.2 After clicking „File“ you can either enter the outside air temperature again („New Periodic Data“) or read the 

already entered and stored diurnal cycle („Open …“). If you enter the data anew, you have to choose „Regular 

Points“. The period length has to be a day (86400 sec) and the number of intervals („#intervals“) 24. With these 

settings the input of the hourly values of the outside air temperature is settled. 

2.2.3 The import of global radiations calculated by SolRad in advance is done by selecting „File“ and then „Import“ and 

„SolRad“ once again. 

2.2.4 The assignment of the color occurs in the next window. Regarding the significance of the input the things said for 

2.1.4 apply here in an analogous fashion. By clicking „Import“, the diurnal cycle of the radiation air temperatures 

is calculated. 

2.2.5 The thermal transmission resistance assigned to the diurnal variation of the radiation air temperature has to be 

written down and, in the course of entering the geometry, assigned to the exerior space. 

2.2.6 By choosing „File – Save as“ the computed diurnal cycle of the radiation air temperature is saved along with the 

diurnal cycle of the outside air temperature. Thus it can be used for evaluation after the modelling of the 

geometry and the computation. 

2.2.7 In the course of the evaluation the column „Periodic Data“ ist to be chosen in the window „Boundary 

Coniditions“. Via „File – Open“ the diurnal cycles of outside air temperature and radiation air temperature are 

imported upon choosing the filename determined in 2.2.6. 

2.2.8 As a boundary condition for the chosen exterior space, the entered diurnal variation of the air temperature 
(„Apply“) or the computed diurnal variation of the radiation air temperature („Apply StraLu“) can be chosen. If the latter has 
been chosen, AnTherm will check whether the thermal transmission resistance entered for the exterior space match the 
computed value. If that is not the case, a warning message is displayed. 
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                                               Radiation Air Temperatures Calculator 
 
 

                                                 

 

                              
 

Periodic/Harmonic Data Editor“ 
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Psi-Value Calculator (Tool) 

 
 
The Psi-Value Calculator is used for rapid calculation of the linear thermal transmittance of the thermal heat 
bridge (correction factors Psi (Ψ, LΨ, ) resulting from the input of U-values and lengths specific to the building 
component concerned and its thermal coupling coefficient L2D as calculated within a steady state, two dimensional 
thermal heat bridge simulation.  
Calculating U-values needed is supported by the U-value Calculator integrated within this application. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

U-Value 

The U-Value specific the the components part concerned (as calculated with a U-Value 
Calculator, for example). 
Remark: If specific U-Value is provided by a layered construct entered within a U-Value 
calculator, the checkmark left to the button "Layered Construct" is marked checked and this 
field is marked read-only. To override the value manually uncheck the checkmark left to the 
button "Layered Construct". 

Length The length to be used for the respective U-Value above 

Coupling  
Coefficient L

2D
 

The thermal coupling coefficient specific to the component under consideration (as 
calculated and reported within the Coupling Coefficients report, for example). 

U * l The result of the multiplication of respective values of U and l. 

Total U * l The sum of respective U * l multiplications. 

Psi-Value (Ψ) The resulting Psi-Value (Ψ, LΨ, ); the linear thermal transmittance 

 

Up to two U-Value and Length pairs can be entered. The formulas used for this calculation are defined in the EN ISO 
10211. 
 
Remark: Obtaining the thermal coupling coefficient L2D can be accomplished with an appropriate two dimensional, 
steady state, thermal bridge heat transfer simulation software. AnTherm provides class A precision method for such 
calculation. 

 

Calculating U-Values with U-Value Calculator 
 

To calculate respective U-Value with an integrated U-Value Calculator, press the button 

"Layered Construct", build or load the layered construct within the U-Value Calculator which 

is shown thereafter and confirm the calculated result by pressing the Ok-button therein. The 

calculated U-Value of a layered construct is shown in the U-Value field which is then  
marked read-only. The checkmark left to the button "Layered Construct" confirms, that the value shown is based on 
respective layered construct. 
 
The actual data of a layered construct can be changed at any time by pressing the button "Layered Construct" again and 
editing the data within the U-Value Calculator shown thereafter. 
 
Remark: The actual data of a layered construct is retained until the form is closed. To save the data of each respective 
layered construct use the "Save" function within the U-Value Calculator. 
  
Remark: You can drag & drop any layered construct (as it is available from a U-Value Calculator if it is run separately) 
onto the one of U-Value / Length blocks in this window also. 
  

http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/ReportBuilder/ReportBuilder.htm#Coupling
http://help.antherm.eu/Introduction/05_Normen.htm
http://help.antherm.eu/Introduction/05_Normen.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
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Remark: To override the value manually uncheck the checkmark left to the button "Layered Construct".  
Remark: If no data of a layered construct has been applied yet, the checkmark left to the button "Layered Construct" is 
shown greyed. 
 
 
 

Entering the Thermal Coupling Coefficient L2D obtained from AnTherm 
 
AnTherm's "Coupling Coefficients Report" provides the matrix of thermal coupling coefficients resulting from steady state 
simulation of respective modelled construction. As AnTherm displays both, the interior and exterior calculated values for 
precision validation purposes, you can either use any one of the two or apply the mean value of both for example, provided 
that precision criteria is satisfied. 
 
Important: U-Values and lengths used for the Psi-Value calculation must correspond to the thermal coupling coefficient of 
the modelled component in the manner defined within EN ISO 10211 and EN ISO 13789. 
 
As soon as simulation results of a two dimensional calculation are available or created in AnTherm you can pick the value of 
thermal coupling coefficient from the coupling coefficients report manually.  
Remark: The model is interpreted as two dimensional if it is homogenous in the Z direction (the grid contains only one 
layer in Z). You shall transfer a median value of the two corresponding matrix elements divided by the thickness in Z 
(within a 2D project it is 1 meter) and rounded according to the close-up error. 
 
Remark: The project specific Psi Value Determination Form will pick values automatically as soon as calculation results are 
available. 

 

Entering U-Values obtained from AnTherm 
 

AnTherm's "Modelling Report" shows U-Values for all layered constructs at adiabatic cut-off planes of the modelled 
component. 
 
Important: U-Values and lengths used for the Psi-Value calculation must correspond to the thermal coupling coefficient of 
the modelled component in the manner defined within EN ISO 10211 and EN ISO 13789. 
 
Remark: The project specific Psi Value Determination Form will pick values automatically as soon as calculation results are 
available. 

 

 

Additional remarks 
 

 The standalone version of the tool can be invoked with an argument of "en" or "de" to work in the language 
different from the operating system default. 

 
 
See also: U-Value Calculator (Tool), Coupling Coefficients and Precision report, Project types, Psi-Value Determination, 
Modelling report 
 
 

http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
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U-Value Calculator (Tool) 
 

The window of U-Value Calculator is used for rapid calculation of U-Values for layered constructs (the R-Value is calculated 
too). 
 
Data of the layered structure can be saved into a layered construct file (<name>.LayeredConstruct). Data can 
also be loaded from material layers file (<name>.MaterialLayers) or layered construct file 
(<name>.LayeredConstruct). 
 
This tool can be started from the menu Tools. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A layered construct contains a list of material layers surrounded by two surface (exterior and interior) boundaries. 
 
For the two surface boundaries one can enter its surface heat transfer coefficient or transfer resistance. The Menu 
Edit→Surface transfer coeffs provides a choice of normative standard values. Both name fields of exterior and interior 
surfaces also provide same choices of standard normative values: 
 
 
 
 
 
 
 
 

 

Remark: It is also possible to drag-drop values from the project specific surface list. 
 
Material layers are input by the entry of their heat conductance and layer's thickness. Based on this values the program 
calculates heat resistance for each material layer. 
 
Remark: It is also possible to drag-drop values from the project specific material list or from the material database. 
 
The sum of resistances of all material layers and both surface transfers is displayed in the R-Value field. 
 
The reciprocal value of the sum of resistances of all material layers and both surface transfers is displayed in the U-Value field. 
 
Actually selected data line is marked by an arrow symbol at its left (data record mark). Multiple selection is also possible 
(e.g. for deletion of line which can be initiated with DEL key). 
 
The complete layered construct can be placed onto the clipboard by the menu function Edit→Copy to be pasted later. 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
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Remark: Changing the construct might be disabled if the U-Value Calculator is shown in read-only mode (e.g. when 
called from the Psi-Value Determination window. 
 

 

Tool specific control elements 
 

Insert Inserts a new layer at the top of material layers list 
  

Insert Before Inserts a new layer before the one currently selected 
  

Insert After Inserts a new layer after the one currently selected 
  

Append Appends a new layer at the bottom of material layers list 
  

Move Up Moves the selected data line one position towards top of material layers list 
  

Move Down Moves the selected data line one position towards bottom of material layers list 
  

Delete Deletes the currently selected data line from material layers list 
 Tip: To delete data line selected press the DEL key 
 Remark: Pressing DEL key will delete all selected lines 
  

Copy to A copy of current layered construct (all layers and the result) are placed onto the clipboard. 
Clipboard Data placed onto the clipboard are are available there in different formats: 

   complete layered construct, which can be pasted back into U-value calculator, 

   tabulated text data of layered construct available for insertion into another application (z.B. MS 
 Excel). 

 See also: Menu Edit→Paste, Edit→Copy 
  
 
Even if the order of layers and the inside/outside orientation do not matter for the calculation of the U-Value one can reorder 
layers within this tool as needed. 

 

 

Tool specific menus 

 

Menus specific to this tool are combined into the main menu of the application: 
 
 
 

File→Layered 
Construct→New 

Creates a new, empty, structure of a layered construct. 
Warning: Save data prior to requesting this function! 
Remark: Changing the construct might be disabled if the U-Value Calculator is shown in read-
only mode (e.g. when called from the Psi-Value Determination window. 

File→Layered 
Construct→Load... 

Allows loading data of material layers (<name>.MaterialLayers) or layered construct 
(<name>.LayeredConstruct) from a file. 
Warning: Save data prior to requesting this function! 
Remark: Loading the construct might be disabled if the U-Value Calculator is shown in read-only 
mode (e.g. when called from the Psi-Value Determination window. 

File→Layered 
Construct→Save As. 

Allows storing the data of a layered construct into separate file (<name>.LayeredConstruct). 

Edit→Copy 

A copy of current layered construct (all layers and the result) are placed onto the clipboard. 
Data placed onto the clipboard are are available there in different formats: 

 complete layered construct, which can be pasted back into U-value calculator, 

 tabulated text data of layered construct available for insertion into another application (z.B. 
MS Excel). 

 Tip: To copy the resulting U-Value to the clipboard alone use the context menu f the 

respective result field (you reach this menu by pressing the right mouse button over the 
field). 

Edit→Paste The construct currently on the clipboard can be pasted (inserted) into the current one. 

Edit→ 
Surface transfer 
coeffs→... 

Provides a choice of normative standard values of surface transfer coefficients designed for 
interior and exterior surfaces. 
The list offers standard value pairs from EN ISO 6946:1996, EN ISO 10077:2003 and EN ISO 
13788:2001. 

 

 

http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.kornicki.com/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.kornicki.com/Forms/UValueCalculatorForm/UValueCalculatorForm.htm#StandardisierteWaermeUebergangsKoeffizienten
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Standardised surface heat transfer coefficients  

 

Depending on the assessment criteria respective surface resistance values shall be used or replaced if calculation target has 
changed.  
The standards EN ISO 6946, 13788 and 10077 provide set of such standardized values. 

 

 Description RSi 

[m²K/W] 

RSe 

[m²K/W 

Calculating heat losses due to transmission (by component and heat flow direction):   

EN ISO 6946:1996 Exterior wall (not ventilated) 0.13 0.04 

EN ISO 6946:1996 Exterior wall, ventilated 0.13 0.13 

EN ISO 6946:1996 Partition wall 0.13 0.13 

EN ISO 6946:1996 Wall to unconditioned (cellar) 0.13 0.13 

EN ISO 6946:1996 Wall to uncond. garret 0.13 0.13 

EN ISO 6946:1996 Wall connected to ground 0.13 0.00 

EN ISO 6946:1996 Roof (not ventilated) - HS up 0.10 0.04 

EN ISO 6946:1996 Floor to exterior (not ventilated) - HS down (passage; projecting component) 0.13 0.13 

EN ISO 6946:1996 Roof, ventilated - HS up 0.10 0.10 

EN ISO 6946:1996 Floor to exterior, ventilated - HS down (passage; projecting component) 0.17 0.17 

EN ISO 6946:1996 Intermediate ceiling (betw. cond. spaces) 0.13 0.13 

EN ISO 6946:1996 Floor to unconditioned (cellar) - HS down 0.17 0.17 

EN ISO 6946:1996 Ceiling to uncond. garret - HS up 0.10 0.10 

EN ISO 6946:1996 Slab at ground 0.17 0.00 
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Calculating heat losses due to transmission through transparent components 

(windows): 

  

EN ISO 10077:2003 Window vertical ±30° (planar surface)- HS hor. ±30° 0.13 0.04 

EN ISO 10077:2003 Window horizontal 0°-60° (planar surface)- HS vert. ±60° 0.10 0.04 

EN ISO 10077:2003 Window red. radiation/conv. (corners and butt joints) - HS hor. 0.20 0.04 

Assessing the Mould and Condensation Risk (by component type):   

EN ISO 13788:2001 Walls and slabs etc. (assessing mould and condensation risk) 0.25 0.04 

EN ISO 13788:2001 Window panes and frames (assessing mould and condensation risk) 0.13 0.04 

 
 
 
Additional remarks 

 
 The standalone version of the tool can be invoked with an argument of "en" or "de" to work in the language 

different from the operating system default. 
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Psi-value (window integration)" tool 

Integration of the window area into the exterior wall always plays an important role in mathematical evaluation of thermal 

bridges in buildings envelope. Therefore almost always distinction has to be made between lintels, reveals and sills. 

Of course with "Psi-Value Determination (Automatic)" in menu „Tools", there is already a function available that may be 

suitable to calculate the psi values for window bindings. However, since the offered automatic calculation of U-values in the 

area of sectional planes is unsuitable for the window, in case of window bindings and/or the consideration of roller shutter 

boxes, it is recommended to apply the tool, which was specially developed for this purpose. This will not only draw attention 

to the importance of thermal bridges in the area of window insertions, but also reduce the risk of modeling errors. 

Remark: The automatically calculated U-value for the area of the window will be the U-value of glass and not the window U-

value UW for the Psi-value calculation. A confusion between glass U-value and window U-value, e.g. caused by unquestioned 

application of the automatic U-value calculation, can lead to grossly erroneous results. 

The tool "Psi-Value Determination (Window Integration)" differs from "Psi-Value Determination (Automatic)" in that the user 

is required to enter the window U-value. If this U-value "U FE" is not entered, no report can be created and a corresponding 

error message is displayed. 

For standard calculation, the area of architectural width/ recess has to be used as the window area. Of course, the U-value of 

the window is used to calculate the coupling coefficient for this area. This approach is used in the calculation of the psi value 

by setting the "reference point". Also this parameter must be explicitly specified by the user and will be used by AnTherm 

automatically to calculate the lengths of the two-dimensional model. 

Of course both, U-values and associated lengths, must be assigned "correctly". AnTherm suggests an assignment based on 

entered U-values. This is possible because in the majority of cases, the window U-value will be far greater than the U-value of 

the exterior wall. If the automatically assignment made by AnTherm is not correct, it is possible to swap the lengths assigned 

by AnTherm. 

The call of the tool which is described here is only permitted if the input area is "cut" in at least on two opposite sides. Of 

course, it will occur that there will be more/other sectional planes - see the following example of window integration in the 

lintel area. 

                                                                                                                    Sectional plane „top " outer wall   
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                                                               Sectional plane "bottom" window     

As a special feature, in case of window integration in the lintel area, the model also includes the intermediate ceiling. This 
means for the interpretation of the Psi-value, that not only the influence of the window connection but also the influence of 
the ceiling integration into the outer wall is taken into account. 
 
For the case shown above, the window "Psi-Value Determination (Window Integration)" has the following appearance. 

 
 

                                         
 

The reference point in this example is the edge between the outer surface of the plastered exterior wall (X=540 mm) and the 

bottom of the (plastered) lintel (Y=380 mm) and is thus compatible with the definition of architectural width/ recess. 

U-value of the window was explicitly inserted by the user with 0.95 W/m2K and corresponds to product declaration. 

Remark: The automatic determination of the U-value at the lower boundary of the model (section plane "bottom") with the 

tool "Psi-value determination (automatic)" leads to 0.70 W/m2K and is the U-value of the present triple thermal insulation 

glass. 

Sizes in "Psi-Value Determination (Window Integration)" 

Space as Outdoor space Select the name that has been assigned to the outdoor space 

 Thermal Coupling Coefficients 2D The length-related coupling coefficient of the considered construction is calculated 

and output data by AnTherm (see also „coupling coefficient report“).The value of the 

length-related coupling coefficient L2D is predefined as a calculation result and cannot 

be changed by the user. 

U-values For recalculation to Psi value, the following two U values must always be known: 
The U value of the window U FE: 
this U-value must always be entered explicitly by the user and was either determined 
in a separate calculation or taken from the product declaration. If U-value is not 
entered, the calculation result makes no sense. In this case, access to the printout of 
the report remains blocked. 
The U-value of the exterior wall U AW: 
This U-value can either be determined automatically from the layered structure along 
the section line or entered explicitly by the user. In the case of explicit entry, the tick 
must be removed from "Layered structure" first. 
Remark: The automatic determination of the U-value of the exterior wall is only useful 
with a homogeneous layered construction. If there is an inhomogeneous structure - 
such as a wall made of vertically perforated bricks - the automatically calculated U-
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value changes with the position of the section plane. In this case, the average U-value 
of the wall must either be determined in advance by a separate calculation or this 

 value must be taken from the product data sheet and entered explicitly.

Lengths The lengths shown are automatically calculated by AnTherm from the given reference 
point and cannot be changed by the user. 
If the automatically assigned lengths by AnTherm are not plausible, it is possible to 

change them by selecting the arrow to shift. 

 

Reference point The choice of the reference point, which is to be determined by the user, serves the 
automatically recalculate of the lengths required for the Psi-value calculation. 
In general, the reference point must be set in such a way that it correctly represents 
the fictitious dividing line between the outer wall and the window used in the one-
dimensional model in the course of area calculation. 
If the coordinates of the reference point are not specified, the calculation result 
becomes nonsensical and the tool for documenting result is blocked. 

Psi value (Ψ) According to the standard, the Psi value is a length-related correction factor intended 
to compensate the error of the one-dimensional calculation model. This value is the 
calculation result and cannot be changed by the user. 
Multiplication of the Psi value with a length leads directly to conductance surcharge in 
W/K. It is important to know that this length is always measured vertical to the 
calculation plane of the two-dimensional calculation. 
Remark: In case of the example, this is the width of the lintel. For this particular 

example, it should be noted that the calculated Ψ-value not only influences the 

window connection to the wall, but also of the ceiling integration into the exterior 

wall. 

 

If entries required by the user (U-values, reference point) have been completed, the production of documentation can be 
ordered by pressing the "Create report" button. 
The report has the following appearance as shown here on an example:                                                      
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Psi-Value Calculation for Three Rooms 
 
 

AnTherm Version 9.136 has Psi-Value Calculation for Three Rooms (unheated buffer room) as a new tool. It starts with 
a 2D calculation of a model that thermatically connects these rooms with each other. The temperatures can be either 
entered separately or a temperature factor can be specified. It is important to enter the rooms in the correct order.  
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Model - Reference points 
 

      
 

   Sketch of the calculation process 
 
    Assumptions 
 
    Space „above“  (top left)  Θi =   20.0 °C (heated) 
     Space „below“ (bottom left)  Θp =    5.0 ° C  (basement unheated) 
     Space  „outside“ (right)  Θe =  -10.0 °C  (outside) 
 
 
 
     Conductance Values 
 
      Conductance “upward-outward”     Li,e  = 0.218881 Wm

-1
K

-1
 

      Conductance “up down”                 Li,p  = 0.421231 Wm
-1

K
-1

 
 
 
 
      Heat transfer coefficients 
     
       EW above       Ui,e    = 0.1004 Wm

-2
K

-1
 (from AnTherm layers report) 

       Cellar ceiling   Ui,p    = 0.1025 Wm
-2

K
-1

 (from AnTherm layers report) 
 

 
 
 
 

 
 
 
 
 



Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

186 
 

 

Roller Shutter Box Usb Calculator    
 
 
The tool Shutter Usb Calculator allows for simple and user-friendly modeling of a shutter box geometry in a 2D-model. The 
goal is to calculate the Usb-value by means of a user interface prompting the user to pass all relevant input parameters. The 
calculation is in accordance with the EU standard EN ISO 10077. 
The input/output of all relevant parameters and results is divided into 3 steps: Geometry, Physics, Calculation. 
 
 

 
 
In order to create a shutter box, one has to click Tools -> Shutter Usb Calculator. Clicking the button Apply, all set parameters 
in that tab are accepted and saved. Click Close if you wish to exit the input prompt of the Shutter Usb Calculator. 
Afterwards, the shutter can be edited by clicking on the outermost cell of the shutter box (all contours and cells of the shutter 
box are represented by dashed lines) and click Edit in the Elements window.  
 
 
 

                                      
 
 
 
The following sections provide a detailed explanation of each input parameter: 
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Geometry:  
 
 

First, we introduce the concept of the Basic box. The Basic box is a simple, rectangular standard geometry, which is generated 
by means of the tool Shutter Usb Calculator. The Basic box features an opening for the shutter at it’s exterior, bottom edge. 
Starting from the Basic box, a real shutter box can be created by manually adding cells using the conventional tools of 
AnTherm. Hence, features can be added, such as notches, profiles, end profiles, additional cells, etc… to model a real shutter 
box. The benefits of this approach as compared to an entirely manual modeling of a shutter box are: 
 
•    Quick and simple approach 
•    Input parameters for the opening of the shutter in accordance with the terminology of the EU standard 
•    Automated classification of the ventilation state inside the shutter box 
•    No explicit modeling of the boundary conditions or adiabatic boundaries needed 
•    Quick enabling of boundary conditions according to the EU standard 
•    Quick calculation of the heat flux and the Usb-value 
 
However, the Shutter Usb Calculator is subject to the below restrictions: 
 
•    Applicable for simple, rectangular geometries with one cavity, , and in vertical orientation (as displayed in below image). 
•    Only applicable for 2D-models 
•    Only one shutter box allowed per file 
•    A file must not contain cells that do not belong to the shutter box, otherwise the resulting Usb-value might be wrong 
•    The shutter opening is always part of the construction which we refer to as the Basic box 
•    The shutter opening is only defined on the exterior bottom edge/face of the shutter box 
•    The shutter opening settings (defined by the parameters e1, e2, e3) can only be edited in the Shutter Usb Calculator tool 
exclusively (not in the Element  window), in order to assure correct treatment of the ventilation condition in the cavity 
•    The shutter opening is always located on the exterior, which is always on the left of the shutter box 
•    The default thermal insulation provided by the tool Shutter Usb Calculator is designed for covering the top, bottom and 
the interior edge of the shutter box cavity with a layer of thermal insulation, having a circular recess in the center…, if 
required otherwise, needs to be edited manually 
•    Boundary conditions, such as temperatures and adiabatic boundaries, must not be included manually, they are included in 
the calculation of the Usb-value by default (the placement of the bottom adiabatic boundary is controlled by the control 
parameter Offset) 
•    The model must not contain any heat sources or drains 
•    The model must not contain any internal boundaries 
•    Except for the cavity, the model can only contain two more room cells, that is an inner room and an outer room, hence 
only two temperatures are allowed as boundary conditions (both rooms are created automatically, and must not be created 
manually by the user) 
•    The model can only contain two adiabatic boundaries, one being at the top edge of the shutter box all along its entire 
width, the other being at the lower edge along a width of 60mm starting from the location defined by Offset (both adiabatic 
boundary conditions are created automatically, and must not be created manually by the user) 
The below schematic serves as a guide for an easy understanding of the input parameters listed below. 
•    Input parameters geometry: parameters that allow for defining a standard geometry (Basic box) for a rectangular shutter 
box, featuring an opening for the shutter on the exterior bottom edge/face 
•    e1: partial width of the shutter opening (outermost) 
Remark: Only edit in the Shutter Usb Calculator 
•    e2: partial width of the shutter opening (shutter itself) 
Remark: Only edit in the Shutter Usb Calculator 
•    e3: partial width of the shutter opening (innermost) 
Remark: only edit in the Shutter Usb Calculator 
Remark: if there is no information on the shutter thickness itself (width e2), but only the total width of the shutter opening 
e1+e2+e3, then the user is free to arbitrarily distribute the total width to each partial width…, however please mind the 
ventilation condition inside the cavity 
•    Height: height of the shutter box in x-direction 
•    Width: width of the shutter box in x-direction 
•    Wall thickness at top Wo, outer Wa, inner Wi, bottom Wu: Wall thickness at each face of the shutter box 
•    Offset: Desired distance between the exterior edge of the Basic box and the bottom adiabatic boundary (see image 
below). 
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The parameters that define the default geometry of the thermal insulation inside of the shutter box are supposed to cover the 
faces of the cavity (only partially, if desired). Around the center of the cavity we have a recess defined by a circular-shaped 
cell. In case it is desired to model a customized insulation geometry, the user can manually edit the geometry (add cells) using 
conventional tools provided by AnTherm. Many industrial products are designed such that the housing itself is manufactured 
from thermally insulating materials, whereas no internal insulation is included on the inside of the shutter box. In such a case, 
this component is to be considered as the housing, and in the field Thermal insulation, one needs to select No insulation. In 
general, that part of the shutter box that defines/contains the shutter opening, is considered as the Basic box. 
•    Thermal insulation (default insulation): provides the option to either create a default insulation implemented in AnTherm 
as described above, or alternatively to leave the shutter box without any default insulation 
•    Width at the top bo: width of the top layer of insulation in x-direction, whereas the edge towards the exterior side is 
variable 
•    Width at the bottom bu: width of the bottom layer of insulation in x-direction, whereas the edge towards the exterior side 
is variable 
•    Thickness at top do, bottom du, interior side ds: thickness of the insulation layer at the respective edge inside the shutter 
box cavity 
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Physics: 
 
The tab Physics allows for setting/controlling all parameters that are relevant for the calculation of the Usb-value. 
The field Box provides the option to select the material for the housing of the shutter box. In fact, this defines the outermost 
cell of the Basic box, which can be assigned any material from the database. 
The field Thermal insulation can only be edited if the user decides to include an (Default) insulation in the Geometry tab in the 
first place. In that case, the tab Physics provides the option to choose an insulation material for the Default insulation. 
Manually added cells can only be edited in their respective Element window. 
 
By clicking OK in the field Environment EU-standard conditions can be enabled. This action assigns boundary conditions 
(temperatures and thermal transfer resistance of the interior and exterior) according to the EU-standard and the ventilation 
condition inside the cavity. This extends to the adiabatic boundaries, being in accordance with the EU-standard. 
• Material name: defines the material for the housing of the shutter box 
• e1+e3 (output only): partial width of the shutter opening, that only includes the two airgaps and does not include the 
shutter thickness 
• e1+e2+e3 (output only): total width of the shutter opening, including both airgaps and the shutter thickness 
• The shutter box is (output only): displays the ventilation state of the shutter box cavity, depending on the dimensions 
of the shutter opening 
• Apply EU-standard boundary conditions?: Enables boundary conditions in accordance with the EU-standard 
• Interior Rs(W): interior heat transfer resistance 
• Temperature: interior temperature 
• Exterior Rs(W): exterior heat transfer resistance 
• Temperature: exterior temperature 
• Cavity Rs(W): heat transfer resistance inside the shutter box  
• Temperature: temperature inside the shutter box (please set equal to exterior temperature, if non-EU-standard 
conditions desired) 
• Equivalent Lambda: defines an equivalent Lambda-value for the cavity in case of an unventilated shutter box (to be 
set by the user). 
 

Calculation: 
 
In the last step, the calculation of the Usb-value can be triggered. Additionally, a list of thermal conductance values is 
displayed that contribute to the heat flux, which is relevant for the Usb-value. 
• Start: triggers the calculation of the heat flux and the Usb-value 
• List of thermal conductance values in contact with the interior (output only): a list of all components of the thermal 
conductance matrix listed in the interior-column 
• Report: creates a report that lists all relevant input parameters used fort he calculation oft he heat flux and the Usb-
value 
• Total heat flux (output only): displays the total heat flux from the interior through the shutter box 
• Usb-value (output only): displays the Usb-value of the shutter box geometry at hand.  
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Chi-Wert Calculator 
 
 

 

The Chi value can be calculated manually or using the tools already contained in previous versions of AnTherm. 

 

We have included a Chi Calculator in AnTherm.  
The Chi value is the point heat transfer coefficient. 
You can enter all data manually or make use of the existing tools in AnTherm. 

 Leitwert 3D: is automatically computed by AnTherm if the model is a 3D model. Either enter the value manually or 
do the computations first before opening the Chi Calculator, then AnTherm will take the value from the Thermal 
Coupling Coefficient report. 

 

 

 

 U value: The U value calculator of AnTherm can be used by clicking the button „Layered construct“. 
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 Area: This must be manually specified by the user. 

 Now you get the product U * A. 
 For the Psi calculation you can use the manual Psi calculator which is included in AnTherm.  

 

 

(If you also have 2D-cuts of the model that show the corners, it is possible to use the automatic Psi calculator to 
obtain the U values and lengths.)  
 
     To run the Psi calculator, click the related button.  
     For the Psi calculation in the manual Psi calculator you also need the Leitwert 2D. 
     For each Psi value a separate calculation has to be performed. By clicking “OK” you copy the result of the    
computation into the Chi calculator. 
 

 
 
 
 
 
 



Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

192 
 

 
 
 
 
  
 

 
 
            You can save these calculations and create a screenshot using the camera icon. 
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Inhomogenous Layer Calculator (Tool) 

The Inhomogenous Layer Calculator can be used to compute the features of a thermally equivalent homogenous layer. 
Possible applications include brick masonry and wooden walls.On opening the Inhomogenous Layer Calculator first the Solver 
is called in case the Thermal Coupling Coefficients have not been calculated yet. As soon as that has been done, the width, 
thickness and (in 3D models) height of the largest element of the model are automatically inserted in the form. If due to the 
modelling this element does not have the measures relevant for the computation, the user can also insert these values 
manually. With manual input, the report does not contain annotations to the graphic as otherwise they might not fit to the 
model. 

After clicking the button "Calculate" the report can be generated by clicking the button "Report". 

 

The following inputs are relevant: 

 Width, Thickness and Height of the input model 

 Mass Density of the input model (only relevant for the computation of the equivalent thermal capacity) 
The following material attributes are calculated and displayed: 

 Equivalent Thermal Conductance of the homogenous replacement model 

 Equivalent Thermal Capacity of the homogenous replacement model (requires to enter the density and the 
availability of the Harmonic or Transient option) 

 Equivalent Vapour Diffusion Resistance of the homogenous replacement model (requires Vapour option) 
Furthermore, the following thermal parameters are computed and displayed: 

 Transmission Resistance 

 Areal heat capacity 

 Areal storage-effective mass 
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Air Cavity Calculator (Tool) 
 

The Air Cavity Calculator window is used as a 
tool for rapid calculation of equivalent heat 
conductivity of small air cavities and air gaps 
based on the input of their dimensions and heat 
stream direction. 
 
To calculate equivalent heat conductivity 
(lambda) the application uses formulas defining 
calculation of heat transfer resistance of air 
spaces described in EN ISO 6946:2005 Appendix 
B - please be aware of limitations related to its 
application (e.g. small, closed air cavities).  
Calculation regulation are geared to European 

norms EN ISO 6946 and EN ISO 10077-2 and 

cover two dimensional calculations. 
 
This tool can be started from the menu Tools. 
 

Heat Stream direction Definition of heat stream direction: 

  Horizontal (default) 
  Upwards 
  Downwards 

  
Size in stream The size of the cavity measured in the heat stream direction (thickness). 
direction Remark: Thickness and width can be swapped via a context menu. 

  

perpendicular to str. The size of the cavity perpendicular to the stream direction (width) 
dir. Remark: Thickness and width can be swapped via a context menu. 

  

Temperature The difference of temperature between cavity boundaries in the heat stream direction. 
difference dT Remark: According to normative regulations one shall set the temperature difference, if exact 
 value is not known, accordingly. 
 Buttons "5K (EN 6946)" and "10K (EN 10077) set this value to one of magnitudes required in 
 these respective regulations. 
  

Equiv. Resistance Equivalent heat transfer resistance of particular air cavity 
  

Equiv. Lambda Equivalent heat conductivity of particular air cavity 
  

Result Calculation result is replaced by the actual value. 
 A double click on this button results in an assignment of the calculation result to currently 
 selected elements of element list. 
 Remark: The button is also used a a source of a drag-drop operation of material property of a 
 equivalent material. 
   

 
Remark: An air cavity will consist of only one element rarely; usually an air cavity is described by a group of several 
elements. 
 
For the very usual case of non rectangular air 
cavities normative regulations define following 
procedure to account for: 
 
An equivalent conductivity is to be calculated for 
a fictive rectangular cavity. Such fictive cavity 
shall be constructed as follows: 

 

 create a rectangle surrounding the cavity 
of interest.  

 the area of a fictive cavity rectangle shall 
be equal to the area original (non 
rectangular) cavity. 

 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
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 the ratio of width to the height of the fictive rectangle cavity shall be the same as of the rectangle surrounding 
the original. 

 

The conductivity calculated for such fictive rectangular cavity is the used instead for the (non rectangular) original 
air cavity. 
 

Heat Stream direction Definition of heat stream direction: 

  Horizontal (default) 

  Upwards 

  Downwards 

  
Thickness (stream The thickness of the rectangle surrounding the cavity measured in the heat stream direction. 

dir.) Remark: Thickness and width can be swapped via a context menu. 
  

Width The width of the rectangle surrounding the cavity (perpendicular to the thickness) 
 Remark: Thickness and width can be swapped via a context menu. 
  

Area The actual are of the real (non rectangular) air cavity 
  

Temperature The difference of temperature between cavity boundaries in the heat stream direction. 

difference dT   
  

Equiv. Lambda Equivalent heat conductivity of particular air cavity 
  

Result Calculation result is replaced by the actual value. 
 A double click on this button results in an assignment of the calculation result to currently 
 selected elements of element list. 
 Remark: The button is also used a a source of a drag-drop operation of material property of a 
 equivalent material. 
   

 
Remark: For this procedure the most sophisticated it is to calculate the real are of the non rectangular cavity itself. 

 

 

Air cavity dimension picked from element selection 
 

This air cavity calculator provides a feature allowing automatic acquisition of area and dimension values from current 
element selection. Already selected temperature difference and stream direction are not affected. Only dimensions of the 
rectangle surrounding selected element(s) and the sum of its/their respective area(s) are automatically calculated and 
transferred into calculator.  
Possibly one will have to swap the thickness and width manually (via the context menu or respective button) to adjust to 
the fact, that the thickness must be specified parallel to the assumed stream direction! 

 

 

Applying the result onto selected elements 
 

A double click onto the button "Result" will apply the calculated result of equivalent conductance onto all material 
elements currently selected within the element list.  
For the material's name a text "Cavity dir t=..w=..(A=...) dT=..." is used. 
 
Remark: The result (equivalent lambda) can be drag-dropped from the button "Result" directly onto am element within 
element editor or onto elements (Element list, Elements 2D) or event into material list. 
 
As an alternative, to assign the result (an equivalent lambda), on can use the clipboard also: Click onto the result field 

"Equiv. Lambda" with the right mouse button and select "Copy". Then you are able to paste the resulting value into the 

lambda input field of the element editor or material editor within the material list (by pasting it from the clipboard there). 

 

Remark: The exact direction of stream flow is known in advance within multi dimensional calculations. This means, that the 
requirement to decide the correct choice of the "width" and "thickness" for the cavity cannot be fulfilled easily. It is user's 
decision to estimate the right heat stream direction by some heuristics based on his experience („along the x- or y-axis“). 
 
Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 
 
 
 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
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Condensing Humidity (dew point) Calculator (Tool) 
 

The Condensing Humidity Calculator (Dew Point Calculator) is used for 
rapid calculation of the surface dew point (i.e. relative humidity above 
which there is condensation probability on the surface) resulting from the 
input of surface and space air temperatures. 
 
This tool can be started form the menu Tools. 
 

Space Temperature The temperature of the space air. 

  
Surface The temperature of the surface under consideration 

Temperature  
  

  
Condensing The resulting dew point (maximum safe relative air 

Humidity humidity) 
  

Mould Growth The resulting maximum safe relative air humidity to 

Humidity avoid mould growth 
  

Corroding Humidity The resulting maximum safe relative air humidity to 
 avoid corrosion 
  

 

 

The formulas used for this dew point calculation are defined in the by formulas of partial pressure as shown in the EN 
ISO 13788:2002. 
 

 
Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 

 

Additional remarks 

 

 The standalone version of the tool can be invoked with an argument of "en" or "de" to work in the language 
different from the operating system default. 

 
 
 
See also: Result report, Boundary conditions window, Remarks to dew point 
 
See also: Element Editor, Materials window, Element selection window, Elements 2D window 

http://help.antherm.eu/Theory/ZurGrenzfeuchtigkeit.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Theory/ZurGrenzfeuchtigkeit.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
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Expression Evaluator (Tool) 

 

This expression calculator is used as a tool for rapid evaluation of simple 
expressions, like 1/25 or Math.Sin(3.14). It can be helpful for calculating 
values required as input of boundary conditions or input of material- or 
surface properties. 
 
This tool can be started from the menu Tools. 
 

Syntax For more complex expression one can select the syntax defined 
 by programming languages like C# (C-Sharp) or VB (Visual 
 Basic) from the .NET Family. 
  

Input Input field for the entry of an expression to be evaluated. 

field  
  

Result Displays the result of evaluated expression. 

field  
  

Evaluate Requests the evaluation of the expression shown in the input 
 field. 
  

Copy Copies the contents of the result field into the clipboard making 
 it available for the paste operation within other windows and its 
 input fields. 
  

 
Expression entered into the input field must conform to the syntax of the programming language chosen. To receive the 
result R of an expression E (R = E) one shell enter the expression term E into the input field. 
 
All functions available in the respective programming language can be used also - especially mathematical functions like 
Math.Sin or Math.Log etc.  
Further (non numerical) expressions can be used here also, but describing it is beyond the scope of this application. 

 

Examples 

 

Expression (C#) Result Comment 
   

1/15 0 The result is 0 because integral types only are used in the expression 
   

1.0/15 0,0666666666666667 The result in double precision 
   

1./15 #Error! Error, because floating point numbers are to be entered with at least one 
  digit after the decimal point (C#) 
   

1f/15 0,06666667 The result is single precision, dure to the use of the suffix "f". 
   

Math.Sin(3.14) 0,00159265291648683 Using the Math library 
   

Math.Sin(Math.PI) 1,22460635382238E- Using constants from the Math library 
 16  
   

Math.Log10(10) 1  
   

Math.Log(Math.E) 1  
   

33.3*(Math.Log(7)+1) 98,0988079635419 Using expressions in braces 
   

 
Remark: If the expression entered leads to an error there will be a pop-up window revealed explaining the cause. 
 
Remark: Please be aware of the fact, that numeric constants must conform to the syntax of the programming language, 

thus the decimal comma (for example) might differ from the current localisation of the system as shown here above. 
 
Remark: Detailed syntax descriptions for expressions: 

 
 C# Language Specification, Expressions  
 Visual Basic Language Specification, Operator Expressions 

 
Note: You shall switch between input fields by using the TAB-key. Using that key confirms the data entry. On the other 
hand it provides a good alternative compared to permanent mouse use. 

 
See also: Boundary conditions window, Element Editor 
 

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Lokalisierung.htm
http://msdn2.microsoft.com/en-us/library/aa691304(VS.71).aspx
http://msdn2.microsoft.com/en-us/library/aa711613(VS.71).aspx
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
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Evaluation windows (Results windows) 
 

Documentation of input data is offered as reports within following windows: 

 
 Data-Entry report  
 Modelling report 

 
Application results are offered in following windows: 

 
 Solver  
 Coupling Coefficients (Leitwert) report  
 Psi-Value Determination (in 2D projects)  
 Results report  
 Results 3D (the visualization of thermal or vapour diffusion, temporal animations too)  
 Timelines (charting of temporal results und time dependant boundary conditions) 

 
Evaluation parameters required for the calculation of specific results are input within following windows: 

 
 Boundary conditions (and Periodic / Harmonic Data Editor for transient case)  
 Probe points  
 Isometries  
 Results3D parameter 

 
If some (additional) computation is required for respective results to be shown in a requested evaluation window, it will be 
initiated automatically. 
 
See also: Editing windows (Input windows), Dialog windows, Main menu, Results and Evaluations, Main window, Toolbar of 
report windows 
 
 
 

http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/EingabeReportForm/EingabeReportForm.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
http://help.antherm.eu/Forms/TimelinesForm/TimelinesForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm_copy4auswertungen.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm_copy4auswertungen.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
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Data-Entry report 
    

 
The Data-Entry report is used for detailed documentation of all data entered while modelling a building component. 

The window can opened from the Main menu via →Evaluation & Reports Report builder or Modelling Report→ and 

via Data Input & Entry→Status Report 

   

 

        
 

 

 

 
Remark: Data of vapour diffusion resistance μ will be also reported if entered. 
A report can be: 

 viewed on the screen 

 saved as PDF, XLS, DOC or RTF file 

 printed onto a printer 
 

 
See Toolbar of a Report window 
 
Remark: The content of this report will be updated after any change to input data immediately. This might result in slight 
delays during processing of the input. Therefore it is advisable to keep that report window closed during the input. 
 
See also: Evaluation windows, Evaluation and Results, Toolbar of a Report window 

 
 

 

 

 

 

 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
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Modelling report 
 

The Modelling report is used for summarizing documentation of a building components data relevant for the simulation. 

The window can be reached from the Main menu via →Evaluation & Reports→Modelling report and via  

Evaluation & Reports→Report builder 
 
 

            
 
 

Compared to the Data-Entry report only data relevant for the calculation is reported. 
 
Resulting from the overlapping elements some materials might have no impact within calculation (being fully overlapped 
and thus discarded). Thus this report shall be used to document and to verify the input of spaces and power sources 
(boundary conditions), their names and transfer coefficients. 
 
Remark: If there are power sources included in the model (after all overlapping of elements have been resolved) their 
resulting (active) volumes will be calculated and output also. This values might be helpful during the entry of boundary 
conditions. 
 
Remark: Data of vapour diffusion resistance μ will be also reported if entered. 
 
The second part of the report lists U-Values of characteristic layered constructs at adiabatic boundaries of the model. These 
intermediary results are required for the calculation of thermal bridge correction factor Psi or Chi. 
 
Remark: The listing does only show U-Values of layered constructs between two spaces; Incomplete layered constructs will 
not be output. The algorithm searches at all six sides of the model bounding box for adiabatic cut-off planes (from outside 
towards model's interior, the first one adiabatic plane in each such direction). If a space surface is found at first in one of 
that directions, then there will be no adiabatic boundary reported in that direction. Adiabatic planes found by that process 
are then intersected in pairs at twelve edges. At these intersection lines U-Value profiles are generated - each such profile 
results in none, one or even many layered constructs space-to-space.  
Remark: For U-Value profiles passing multiple layered constructs (e.g. multiple ceilings) there will be multiple U-Values 
reported for respective space pairs. 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/EingabeReportForm/EingabeReportForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
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Solver window 
 

The window Solver allows observing the progress of the 
simulation process. 
 
The animation displayed at the top edge of the window signals 
that the application is currently calculating the solution. Further 
detailed messages reported by the computation will be shown 
within text window. 
 
The simulation is executed in background completely 
(rasterizing, system of equations, optimal omega, calculation of 
base solutions, calculation of thermal coupling coefficients) 
without any further interaction. 
 
If necessary the solution of vapour diffusion equations will be 
created also. 
 
If solving transient, harmonic, periodic problem has been  
requested also, then respective system of harmonic equations will be set up for all chosen period lengths and solved too. 
 
If there are simulation results already available, current input data will be compared to the one already saved. If there is no 
difference to the model calculated earlier the simulation step will be skipped. Calculation will start wherever: 

 
 Simulation results are not available or are incomplete (partially solved)  
 The model data (geometry, materials etc.) has been changed  
 Different resulting discretization (changes to fine grid parameters)  
 More stringent solver parameters chosen (smaller termination condition, more iterations below termination 

condition, more final iterations). 

 
Remark: The animation symbolically showing the progress of the computation (displayed at the to edge of the window) 
can be hidden via the context menu of that element (right mouse button). See also the application setting "Animate 
Progress on Solver Form". 

 

Data integrity and messages 
 

Relevant information about the progress or errors of the simulation process are shown within this window. Messages 
shown will not always report the reason for an error, albeit they shall be used as starting point for problem analysis and 
for further search for input error (e.g. Lambda = 0, no heat transport at the surface, only one space named, all spaces 
unnamed etc.) 
 
Before actual computation is started the application examines the validity of input data. Following integrity checks are 
executed: 

 
 the input must result in a 3D structure (even a 2D project will produce a 3D structure , a homogenous one in the Z 

axis -direction), 
 heat conductance of all materials must not be zero,  
 vapour diffusion resistance of all materials must not be zero (only relevant with active VAPOUR-Option)  
 volumetric heat capacities of all materials (product of mass density and heat capacity) must not be zero (only 

relevant with active HARMONIC/TRANSIENT option)  
 transfer coefficients of all surfaces must not be zero,  
 there must be at least two independent boundary conditions (different space- and/or power source names)  
 there is at least one boundary condition of constant temperature (a space of defined air temperature - i.e. defined 

space name) 
 names of power sources must differ from space names  
 the resulting system of equations must contain at least two equations (i.e. at least two cells to calculate)  
 availability of sufficient license features 

 

If the resulting fine grind consists of 1.000.000 or more cells you will be shown a warning message (as set with the 

application setting "Warn on excessive Equation Size"). This provides the ability to stop the computation just before the 

equation system data, very large in such case, is being created and written to files (even the rasterizer tries to avoid 



http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Introduction/81_Dampfdiffusion.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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holes of the construction, which have no influence onto resulting equations, the size of the equation might be still above 
the number of cells reported). 
 

If there is sufficient data provided for execution of vapour diffusion calculation, but the Solver setting of vapour     
calculation is turned off, the application will ask (when the VAPOUR license option if available) if this setting of the 
solver shall be turned on (see also: Compute Vapour Transfer Solution inquiry).  
If there is sufficient data provided for execution of transient, harmonic, periodic calculation, but the Solver setting of 
harmonic calculation is turned off, the application will ask (when the HARMONIC/TRANSIENT license option if available) if 
this setting of the solver shall be turned on (see also: Compute Transient Solution inquiry). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Stopping the calculation 
 

Pressing the button Stop will initiate the abortion procedure of the solver. Terminating the solver will typically last 10 to 30 
seconds. 
 

 

Message: Solver aborted / Solver status 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

If the computation cannot be started or executed successfully the application will show a dialog window next to solver 

window providing further details and problem descriptions - prior to closing this window please analyse contents of solver 

window in the context of the message shown also. 
 

http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Running Solver on multiple CPUs 
 

Running solver on multiple CPUs enhances the calculation performance and thus (in most cases) reduces significantly the 
calculation time. Multi CPU (or Multicore) behaviour of the solver is controlled by respective application settings 
separately. 
 
Important: Actual reduction of calculation time by execution of the solver on multiple processors results from various 
properties of employed hardware architecture (number of processors and processor cores, number and size of processor 
cache memories, cache speed, bandwidth to and from the RAM, Memory speed, bus speed and bus waiting rates, etc.). 
Some multicore systems might even show performance degradation if multiple cores simultaneously access shared 
resources.  
It is advisable to compare the number of iterations executed per time unit (as displayed within the solver window). 
 
Remark: This function requires a valid license feature MULTICORE. 
 
Remark: If the number of equations (independent variables) to solve is less or equal the number of processors than each 
variable will be scheduled to one processor. Due to synchronization required on every iteration poor performance may 
result for such small equations. 
 
MULTICORE-option: Speeding up computationally intensive jobs by distributing them on 

multiple processors or processor cores for parallel execution is only possible with an 

active MULTICORE-Option of the program. 
 

 

See also: Evaluation windows, Solver parameter, Fine Grind parameter, Rasterizing, Application settings 
 
 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Coupling Coefficients and Precision report 

 
 

 
 
 The Coupling Coefficients and Precision report displays the matrix Li,j of thermal coupling coefficients  
 (L

2D
 or L

3D
 , also called heat transfer coefficients H in some standards or Leitwert matrix, thermal conductance 

matrix) and respective precision information  of the simulation. For a two dimensional model the matrix shows  
length related  transmittance L

2D
 [Wm

−1
K

−1
] ; for three dimensional construction the  matrix displays thermal 

coupling coefficients L
3D

 per se [WK
−1

]. Depending on which problems have been chosen for the Solver and on 
the number and type of boundary conditions following results are shown: 

 Number of evaluated cells(size of the system of equations)  
             for the steady state (stationary) heat transport   problem: 

 Matrix of stationary, steady state thermal coupling coefficients for all space pairs 

 Heat distribution factors for all power sources and spaces 

 Precision information the steady state heat transfer problem 
            for the steady state vapour diffusion problem: 
                       Precision information for the steady state vapour diffusion problem 
            for the dynamic,transient,harmonic,periodic heat transport problem,for any period length (and eventually higher 
           harmonics): 

 the matrix of harmonic coupling coefficients for all space pairs, 

 the harmonic heat distribution factors of each source to all spaces 
  given as complex numbers and as amplitude/phase pairs. 
            If the number of matrix columns output shall overrun the page width then the output of overrunning matrix 
  columns is continued in groups one below the other.            
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Steady state (stationary) thermal coupling coefficients 


The report displays the matrix of thermal coupling coefficients for any pair of spaces (with 6 decimal places). 
 
If N spaces are attached to the considered construction the NxN matrix will be displayed (without diagonal elements). 
 
Theoretically the matrix shall be symmetrical (i.e. Lij=Lji), thus the output allows precision consideration of results. 
 
These values are used, for example, to calculate thermal bridge correction factors - for a 3D case the "point thermal 
transmittance" Χ (Chi) and for a 2D case the "linear thermal transmittance" Ψ (Psi). 
 
See also: Psi-Value Determination (Calculate Ψ-Value) 
 
Remark: By multiplying the (steady state) thermal coupling coefficient Lij by the difference of temperatures of respective 
space pairs Θi−Θj one will receive the heat stream (or the length related heat stream in 2D case) between the two spaces 
transmitted through the modelled component. 
 

Heat source Distribution Factors (steady state) 
 

In the event heat sources are available also, the heat distribution factors of each source to all spaces are shown too. 
 
 
 
 
 
 
If N spaces are attached to the considered construction then there will be N numbers shown for every heat source in the 
distribution table. The i-th (i = 1,N) column value of the distribution table shows the percentage of the heat provided by the 
particular heat source passing to the i-th space. The values of the distribution table are therefore from the range 0 to 1. 
 
Because the steady state calculation does not cover the heat capacity storage, the sum of all distribution values must 
theoretically result in 1 (apart from minor rounding errors) allowing further precision consideration of results. 
 
Remark: By multiplying the distribution factor Fkj by its respective power density Φk of the heat source k and its volume Vk 
one will receive the heat stream (or the length related heat stream in 2D case) from the heat source k to the space j. (The 
volume of every heat source will be shown within Modelling report or Results report). 

 

Transient (instationary, dynamic), harmonic, periodic thermal coupling coefficients 
 

Provided the solution of a dynamic, transient, harmonic, periodic problem has been computed also, the matrix of periodic 
harmonic coupling coefficients will be output (with output of up to 4 decimal places). 
 
The output is provided for each requested period (period length, in decreasing order; longest first) once as matrix of 
complex numbers and additionally as matrix of norm (amplitude) and argument (phase shift, time lag) values. 
From that output the exterior harmonic coupling coefficient (between exterior and interior) can be identified for example. 
 
Diagonal elements (contrary to the steady state case these are significant and output here) can be used for the 
calculation of effective heat capacities. 
 
Theoretically, as for the steady state case, the matrix shall be symmetrical, thus the output allows precision 
considerations of results also.  
 

          
 
 

http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
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In the event heat sources are available also, the harmonic heat distribution factors of each source to all spaces are 
shown too. 

 

 

Vapour diffusion, hygric coupling coefficients 
 
The report will also show hygric coupling coefficients (mg/Pa*h) ("Matrix of hygric coupling") if there are results 
of vapour diffusion calculation available too. 

 
 

                                   
 
 
 
Precision information 
 

An immediate indicator of the precision of the solutions is the matrix of thermal coupling coefficients itself - if it is not 
reasonably symmetrical, then further calculation might be necessary. Along with the output of coupling coefficients the 
necessary information about the precision of these results is output. 
 
A theoretically exact method of calculation would necessarily satisfy the condition, that the sum of heat entering a 
component exactly equals the sum leaving the same - for any set of basic solutions. The inherent nature of a numeric 
method, however, will always result in a marginal difference in the evaluated energy balance. This is referred to here as 
the close-up error of base solution. Dividing the close-up error by the sum of the coefficients associated with the respective 
base solution (space) provides a measure of the precision of calculation. 
 
 

                            
The relative close-up error shall never exceed 10

−4
 considering precise solution (see EN ISO 10211:2008). 

 
The value of the Relative Close-Up Error limit (default 10

−4
) can be adjusted within application settings: 

 

http://help.antherm.eu/Introduction/05_Normen.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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 If the relative close-up error exceeds the half of that limit the line will be marked with (*) - i.e. "just at 
minimum precision". 

 If the relative close-up error exceeds that limit (**) are shown. 
A warning message "(*) Warning: The precision criterion concerning the magnitude of relative close-up errors is not fulfilled" 
will be shown below the precision data listing if the precision criterion is not satisfied by any of base solution (the display of 
this message can be turned off by the application setting "Relative Close-Up Error - Warn if above"). 
 
Note: If the relative close-up error exceeds 10

−
 
4
 (or the limit otherwise set) a continuation of calculation based on more 

stringent parameters for more precise solution should be considered before proceeding with further evaluation. 
Eventually modified (finer or coarser) raster discretisation (gridding) might be required also. 
 

 
If the solution of vapour diffusion has been also computed, the associated precision information is also displayed 
following the results of thermal heat calculation. 
 
 
 
 
 
 
 

                                    
 
 
 

Precision indicators, i.e. (*), (**) and a warning message, are shown for the vapour base solutions - based on same 
precision criteria (see above). 
 
A report can be: 

 

 viewed on the screen 

 saved as PDF, XLS, DOC or RTF file 

 printed onto a printe 

 searched by keywords 

 
See Toolbar of a Report window 
 
See also: Evaluation windows, Evaluation and Results, Toolbar of a Report window, Results 3D window, Boundary 
Conditions window, Please Wait window, Psi-Value Determination (Calculate Ψ-Value), Linear and Point Transmittance, EN 
ISO 10211 
 
 
 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm_copy4auswertungen.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm_copy4auswertungen.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm_copy4auswertungen.htm
http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
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Psi-Value Determination (Ψ-Value Calculation) 
 

The Psi-Value Determination Form is used for automatic calculation of the linear thermal transmittance Psi of the 
(linear) thermal heat bridge (correction factors Psi (Ψ, LΨ, ) for the currently analysed two dimensional (2D) building 
component according to the EN ISO 10211 (or EN ISO 10077). 
 
Note: The Psi value is a computational value that corrects the error of the one-dimensional computation. The Psi value 
must not be assigned a physical significance. 
  
Most typical 2D cases will be calculated without any additional user intervention. The automation is supported by: 

 
 calculation of the thermal coupling coefficient L2D (as calculated within by the steady state, two dimensional thermal 

heat bridge simulation),  
 automatic identification of characteristic U-Values at adiabatic boundaries of the model (also shown within the 

Modelling Report) and  
 determination of respective lengths (exterior- or interior based) resulting from the Reference Point which are 

determined automatically if possible. 
 
Some limitations of that automation depend on the particular geometry and can be controlled by the user.  
Remark: Psi-Value Determination Form will show disabled if neither automatic nor partly automatic determination is 
feasible for the particular model. The message related to such situation will be displayed also. Manual arbitrary 
calculation of Psi-Value is then supported by the Psi-Value Calculator tool only.  
Remark: The model is interpreted as two dimensional if it is homogenous in the Z direction (the grid contains only one 
layer in Z). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Space to assume Select the space name which is to be assumed exterior at first. The choice of the value of the thermal 

-Exterior coupling coefficient L
2D

, the automatic determination of the Reference Point and the selection of 
-Interior characteristic U-Value Profiles at adiabatic boundaries all depend on that input. 

 By default AnTherm will pick the name of the first space (as sorted in alphabetic order) which in 
 particular is assigned the lowest temperature during later evaluations. 
  

Coupling The thermal coupling coefficient specific to the component under consideration (as calculated and 

Coefficient L
2D

 reported within the Coupling Coefficients report, for example). 

 As soon as simulation results of a two dimension calculation are available or created within AnTherm 
 the Psi-Value Determination Form will pick the value of the coupling coefficient between the two 
 spaces (exterior and interior) automatically. The value transferred is the median of the two 
 corresponding matrix elements divided by the thickness in Z (in 2D it is 1 meter) and rounded 
 according to the close-up error. 
  

http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/PsiValueSimpleCalculatorForm/PsiValueSimpleCalculatorForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
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U-Value Profiles  

 

Turn that switch on to request AnTherm to pick the profiles automatically at adiabatic boundaries.  

 

   

 at adiabatic cut-  Available U-Value Profiles are then shown in the two choice boxes displayed just below the switch for  

 off planes  further selection. If turned off you will have to provide U-Values manually (either by the value input or  

   as calculated with a U-Value Calculator)  

   By default AnTherm attempts to automatically find appropriate profiles.  
   Remark: If profiles cannot be found this control element will be shown inactive (greyed).  

     

 U-Value Profile  Characteristic profiles at adiabatic cut-off planes found automatically are available for selection.  

 selection  Remark: AnTherm will offer only profiles connected to the exterior or interior spaces.  

   The layered construct at the profile chosen is automatically created and passed to the respective U-  
   Value Calculator in the fields shown below, thus replacing the earlier entries therein.  

   By default AnTherm will automatically pick the first two orthogonal profiles from the list available.  
     

 Layered construct  The button provides the means of viewing (or entering) a layered construct for the calculation of its  

   characteristic U-Value.  

   Remark: The layered construct editor (the U-Value Calculator) will block changes (editing buttons  
   and menues will be grayed) if the construct is provided from the profiles identified by AnTherm. If you  

   wish to override the construct by changing it you must uncheck the "U-Value Profiles at adiabatic cut-  

   off planes" switch above.  

   Remark: If specific U-Value is calculated from a layered construct entered within a U-Value calculator  
   (or from the characteristic profile selected), the checkmark left to the button "Layered Construct" is  

   marked checked. To override the U-Value manually uncheck the checkmark left to the button  

   "Layered Construct".  

     

 U-Value  The U-Value specific the the components part concerned (as calculated with a U-Value Calculator,  

   for example).  

   Remark: If specific U-Value is provided by a layered construct entered within a U-Value calculator,  
   the checkmark left to the button "Layered Construct" is marked checked and this field is marked  

   read-only. To override the value manually uncheck the checkmark left to the button "Layered  

   Construct".  

     

 Length  The length to be used for the respective U-Value above.  

   Remark: If respective lengths are determined automatically from the Reference Point, the respective  
   fields are shown read-only.  

     

 Determine  Lengths shall be determined from the specific Reference Point found automatically for exterior or  

 Lengths by  interior dimensions or given by manual entry.  

 Reference Point  
Remark: If respective lengths cannot be determined from any Reference Point that choice box and 

 
    

   controls below it are shown disabled..  
     

 Reference Point  The Reference Point shall be found automatically at exterior or interior dimensions or specified by  

 at  manual entry.  

 -exterior  
Remark: If the respective reference point cannot be determined at some specific automation,  that 

 
 
-interior 

  

  choices are shown disabled. 
 

 

-manual 

  

  
See the explanation graphics below. 

 

    
     

 U * l  The result of the multiplication of respective values of U and l.  
     

 Total U * l  The sum of respective U * l multiplications.  

   
 

 

 Psi-Value (Ψ)  The resulting Psi-Value (Ψ, LΨ, ); the linear thermal transmittance  
 

http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
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Calculating U-Values with U-Value Calculator 
 
 

 

To calculate respective U-Value with an integrated U-Value Calculator, press the button 

"Layered Construct", build or load the layered construct within the U-Value Calculator which is 

shown thereafter and confirm the calculated result by pressing the Ok-button therein. The 

calculated U-Value of a layered construct is shown in the U-Value field which is then  
marked read-only. The checkmark left to the button "Layered Construct" confirms, that the value shown is based on 
respective layered construct. 
 
The actual data of a layered construct can be changed at any time by pressing the button "Layered Construct" again and 
editing the data within the U-Value Calculator shown thereafter. 
 
Remark: The actual data of a layered construct is retained until the form is closed. To save the data of each respective 
layered construct use the "Save" function within the U-Value Calculator.  
Remark: You can drag & drop any layered construct (as it is available from a U-Value Calculator if it is run separately) 
onto the one of U-Value / Length blocks in this window also. 
Remark: To override the value manually uncheck the checkmark left to the button "Layered Construct".  
Remark: If no data of a layered construct has been applied yet, the checkmark left to the button "Layered Construct" is 
shown greyed. 

 

 

 

 

 

 

 

 

 

 

http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
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Thermal Coupling Coefficient L2D obtained from AnTherm 
 
AnTherm's "Coupling Coefficients Report" provides the matrix of thermal coupling coefficients resulting from steady state 
simulation of respective modelled construction. As AnTherm displays both, the interior and exterior calculated values for 
precision validation purposes, the mean value of both is used. 
 
Important: U-Values and lengths used for the Psi-Value calculation must correspond to the thermal coupling coefficient of 
the modelled component in the manner defined within EN ISO 10211 and EN ISO 13789. 
 
As soon as simulation results of a two dimension calculation are available or created in AnTherm the Psi-Value Calculator 
will pick the value of the thermal coupling coefficient between the two selected spaces automatically. Remark: The model is 
interpreted as two dimensional if it is homogenous in the Z direction (the grid contains only one layer in Z).  
Remark: The value transferred is calculated as the mean value of the two matrix elements which apply and divided y the 
thickness in the Z direction (in 2D it is 1 Meter) and then rounded according to the current close-up error. 
  
 

U-Values obtained automatically by AnTherm 
 

AnTherm's "Modelling Report" shows U-Values for all layered constructs at adiabatic cut-off planes of the modelled 
component. 
 
Important: U-Values and lengths used for the Psi-Value calculation must correspond to the therml coupling coefficient of 
the modelled component in the manner defined within EN ISO 10211 and EN ISO 13789. 

 
See also: Coupling Coefficients and Precision report, Modelling report, Psi-Value Calculator (Tool), U-Value Calculator (Tool), 
Project types, Linear and Point Transmittance, On calculation of Ψ-values for building constructions in connection with 
ground, EN ISO 14683, EN ISO 13789 
 
 
 
 

http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/PsiValueSimpleCalculatorForm/PsiValueSimpleCalculatorForm.htm
http://help.antherm.eu/Forms/PsiValueSimpleCalculatorForm/PsiValueSimpleCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/Forms/UValueCalculatorForm/UValueCalculatorForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Theory/psi_Boden.htm
http://help.antherm.eu/Theory/psi_Boden.htm
http://help.antherm.eu/Theory/psi_Boden.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

213 
 

 
 
Boundary Conditions window 
 

The window Boundary Conditions enlists all spaces of which the 
user sets temperatures and all power sources of which power 
density can be entered (the boundary conditions). For dynamic, 
transient problem solution the window mutates to allow input of 
time dependant quantities. 
 
Temperatures of spaces are initially preset to standard values: 

 
 first space in the list (sorted alphabetically) is set to 

airspace temperature of -10°C 
 all other spaces are set to the temperature of +20°C. 

 
Remark: These standard values can be changed within9,5 
 
Spaces are enlisted alphabetically. Knowing this, by consequently naming spaces you can target proper automatic 
assignment of preset values.: 

 

 Exterior precedes Interior 

 Space 00 precedes Space 03 and Space 10 

 Space 11 precedes Space 1. 

 
If the component contains power sources (heat sources or sinks) also, their names will be offered here for the input of 
their respective power density [W/m

3
]. Initially power sources are set to have no power (equal 0 W/m

3
). 

 
Remark: If there is solution of vapour calculation available too, the input of relative humidity of air space, required 
for vapour evaluations of partial pressure, is also offered in additional dedicated column: 
 
 
 
 

 

Relative humidity of air spaces is initially preset as follows: 

 

 first space is assigned the relative air humidity of 80% 

 all further spaces are assigned relative air humidity of 53%. 

 
Remark: These standard values can be changed within application settings. 
 

Name Name of the space or power source (not editable) 

Value 
The value of the boundary condition of specific space (temperature °C) or power source (power 
density W/m

3
). 

Unit Unit of the value of that specific boundary condition (not editable) 

Rel. Humidity Relative air humidity in percent 

Part. Pressure 
Partial pressure of vapour (in hPa) resulting from the temperature and relative humidity values 
entered (not editable) 

Expose graphical 
evaluation too 

If checked here, the graphical evaluation (Results 3D window) will be started after boundary 
conditions are applied. If this setting is turned off the graphical evaluation (if not open yet) will 
not be executed automatically.  
See also Application settings. 

Evaluate secondary 
functions 

If checked here, secondary functions (like heat flux, relative surface humidity, etc.) will be 
calculated for graphical evaluation. If turned off (unchecked) only temperature field will be 
calculated for Results 3D evaluations. This saves significantly time needed for calculation and 
reduces memory demand during evaluation. 
See also Application settings 

Apply 
Confirms data entered in this window end initiates the superposition followed by various 
evaluations. 

 
You confirm the data entered by pressing the button Apply. Boundary conditions will be applied onto basic solutions 
(g-values). If calculation of basic solutions is also required it will be automatically initiated also. 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Graphische Auswertung immer anzeigen
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen Auswerten
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MULTICORE-option: Speeding up computationally intensive jobs by distributing them on 

multiple processors or processor cores for parallel execution is only possible with an 

active MULTICORE-Option of the program. 
 

Remark: The button "Apply" will blink if there is new solution set available from the solver, but the data entered in this 
window has not been applied yet to the new solution set.  
Remark: The button "Apply" is shown disabled if one or more basic solutions have not been calculated (solved) yet, i.e. 
they are missing. 
 
The temperature distribution with the construction results from the superposition of respective basic solutions each 
multiplied by its boundary condition. Results are presented as text reports ready for printing or to be saved as Adobe 
PDF, MS.Word or MS-Excel files.  
The distribution of temperature and further secondary functions is further used in various graphical evaluations. 
 
Templates of Boundary conditions are saved to the project file when the project is saved. 
 
Remark: All BCs will be merged by their Names into the projects BC-Template upon apply. This will retain BCs even when 
spaces or power source are renamed or removed from the project. By that the BCs of other projects can be merged and 
saved - even such with names which are not yet (or no more) available if the current project. 
 
Important: To retain the values of boundary conditions between program executions the project must be explicitly saved 
(project data is not saved automatically when boundary conditions are applied!). 
 
Remark: You will need the value of power density W/m

3
 to properly enter the boundary condition specific to power 

sources. For verification purposes you will find the total volume of each power source within Modelling Report. Within 
Results Report, in addition to the value of respective power densities, you will also find the overall power of each power 
source. 

 

VAPOUR-option: Analysis of multidimensional vapour diffusion is only possible with an active 

VAPOUR-Option of the program. 
 

 

 

Transient Boundary Conditions (periodic, harmonic) 
 
 
For the purpose of dynamic, transient problem (subject to the TRANSIENT-Option) the boundary conditions window 
mutates to input of time dependant quantities. 
 

                  
 

TRANSIENT-option: Solving and evaluating time dependant dynamic, periodic problems 
when heat capacity effects are concerned is only possible with an active TRANSIENT-
Option of the program.  

 

The transient boundary conditions are provided as sets of harmonic Fourier coefficients created for respective periodic 
data (these are managed in Periodic / Harmonic Data Editor) for each and any Main Period of the transient problem (as 
selected in Solver parameter form). 
Boundary conditions are kept distinct of each solution period and also saved to the project file when the project is saved. 
Important: To retain the values of boundary conditions lately applied the project must be explicitly saved (project data is 
not saved automatically when boundary conditions are applied!). 

http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
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Remark: All BCs will be merged for each Period (including MainPeriod=0 - steady state) by their Names into the projects BC-
Template upon apply. This will retain BCs even when spaces or power source are renamed or removed from the project. By 
that the BCs of other projects can be merged and saved - even such with periods and names which are not yet (or no more) 
available if the current project. 
 

Main Period The Boundary Conditions window title bar displays the Maine Period of the currently evaluation transient, 

(title-bar) periodic problem (as selected in Solver parameter form). 

 
 

Time Point to Some evaluation time point T within the Main Period of the solution. 

evaluate If checked the change to the time point is immediately applied together with boundary conditions and 

 reflected in evaluation windows (Results report, Results 3D window) once these are open. 

 
 

#H Number of harmonics solved (harmonic solutions) for the selected Period and available to further 

 evaluation 

 
 

#Hc Number of continuous harmonics solved for the selected Period and available to further evaluation 

 
 

Periodic Data Periodic boundary conditions data managed in Periodic / Harmonic Data Editor 

 By default the Constant Value Periodic data will be initially set respectively to the steady state boundary 

 condition. 

 
 

#Hbc Number of harmonics available from Fourier Analysis out of periodic boundary conditions data (managed 

 in Periodic / Harmonic Data Editor) available to further synthesis and evaluation 

 
 

#Hsynth Number of harmonics chosen for use in harmonic Fourier Synthesis out of those available from periodic 

 boundary conditions data (#Hbc) 

 The highest number of harmonics used during synthesis (#Hsynth) results from the smallest count of 
 harmonics within the base solution and out of the respective boundary condition and can be further 
 reduced (-1 - all available). 

 Remark: Evaluating in TRANSIENT mode with only 0-th harmonic or only Constant Boundary Conditions 

 is identical to Steady State results (regardless of HARMONIC or TRANSIENT license feature). 

  

#Heff Effective number of harmonics used in harmonic Fourier Synthesis out of those available from periodic 

 boundary conditions data (#Hbc) and those available from the solution set (#H). 

 
 

Value Synthetic boundary condition value at the evaluation time point T 

 
 

  

Timelines Opens Timelines window displaying synthetic temporal, time dependant results at selected Probe Points 

 together with timelines of synthetic boundary conditions applied. 

 
 

Animate Displays the Animate Time Dialog used to define temporal animation of transient evaluation by 

 automating changes to the evaluation time point T. 
  

 
Time Point to Evaluate: provided existence of periodic boundary conditions on can set the evaluation time point (within 
the main period) 
 
Remark: During graphical evaluation the time point information will be displayed in the title of the colour bar. 
For the evaluation the harmonic base solutions are combined with the respective harmonic coefficients of the boundary 
condition the belong to (complex linear combination). The resulting distribution harmonic coefficients it then passed for 
Fourier synthesis for specific evaluation time point T. 
Remark: Provided that the periodic boundary conditions did not change, only synthesis for new time point must be 
executed. 
Remark: Evaluating in TRANSIENT mode with only 0-th harmonic or only Constant Boundary Conditions is identical to 
Steady State results (regardless of HARMONIC or TRANSIENT license feature). 
Remark: The input of relative air humidity (when vapour diffusion problem has been solved too) are sill constant (steady 
state) and independent of air temperatures. Only the partial pressure will be recalculated for respective, evaluation time 
point dependant, air temperature. 
See also: Element Editor, Element types, Evaluations and Results, Standard Boundary Conditions, Periodic / Harmonic Data 
Editor, Animate Time Dialog, Timelines Window

http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/TimelinesForm/TimelinesForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
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Periodic / Harmonic Data Editor 
 
 
The Periodic / Harmonic Data Editor window provides the means of creating, editing and managing periodic climate 
data required as boundary conditions to transient evaluation. 
 
TRANSIENT-option: Solving and evaluating time dependant dynamic, periodic problems 

when heat capacity effects are concerned is only possible with an active TRANSIENT-Option 

of the program. 
 

The Periodic / Harmonic Data Editor will be used out of the Boundary Conditions window when transient problem is to be 
evaluated and time dependant boundary conditions are needed for that purpose. For convenient managing periodic data 
sets it us available from a Tools Menu also. 
 
There are following types of data which could by managed within Periodic / Harmonic Data Editor: 

 

 Constant 

 Regular Points 

 Regular Means 

 Irregular Means 

 Irregular Steps 

 Harmonic Coefficients.
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
The window contains three parts: 

 

 File & Examples Menu 

 Info 

 Graph 

 Data Grid 

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
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File Menu: 

 

 New - create new data set of the specific part. A dialog is shown to provide the information required for specific 
type (see "Info Part"). 

 Open/Save/Save As... - provides the file access to the data 
 Convert To... - allows simple synthetic conversions between selected periodic data types. 

 
Info Part: 
 
The Info part displays the characteristic information for the dataset being processed. Depending on the type of data 
different information is displayed and eventually available to input.  
The initial specific values are supplied during the creation of the data set (File->New...) and a limited set of them, 
depending on the data type processed, can be changed later. 

 

 Description identifying the data 

 Period Length 

 Number of Intervals 
 

 
Graph Chart Part: 
 
The graph chart represents and displays the input data along with its synthetic variant resulting from harmonic Fourier 
analysis and synthesis. 
 
Zoom with lasso... 
 
The legend provides the identification of patterns shown. A double click on to the legend will change its position relative to 
the chart area (right, left, top, bottom). 
 
Data points can be selected. 
 
Data points (or bars) can be dragged changing the value (press ESC to abort the unintentional drag operation an revert to 
the previous value). 
 
MULTICORE-option: Speeding up computationally intensive jobs by distributing them on 

multiple processors or processor cores for parallel execution is only possible with an 

active MULTICORE-Option of the program. 
 
 

Context menu of the Graph Chart: 

 Reset Zoom 

 Zoom enabled 

 Zoom X only enabled 

 Appearance 

 Page Setup... 

 Preview... 

 Print... 

 Copy 

 Export Image... 

 Show synthetic data 

 Window Function 

 Cut-Off Harmonic 
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Window Function 
(Gibbs Effect) 

 
Selection of the windowing filter function to reduce the Gibbs effect (e.g. while working 
with switch functions "IrregularIntervalSteps" or dense data with high value changes). 

 Fejer window 

 Hann window 

 Hamming window 

 None 

Cut-Off Harmonic Limits the number of harmonics for the Fourier syntheis. 

 
 
 
Data Grid Part: 
 
The data is input into the Value column.  
The native Copy & Paste of the selected cell(s) is provided. 
 
Capability to paste data from/to the Value column streamlines the input procedure (also available via Context Menu). All 
numbers contained in the paste buffer (regardless if column(s) or row(s)) will be parsed as double entities (entries in error 
and not parse able as such in be ignored) and transferred in the order to the value column. 
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Timelines 
 
 
The Timelines window displays synthetic temporal, time dependant results at selected Probe Points together with 

timelines of synthetic boundary conditions applied. The window is opened from the Boundary Conditions window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
TRANSIENT-option: Solving and evaluating time dependant dynamic, periodic problems 

when heat capacity effects are concerned is only possible with an active TRANSIENT-Option 

of the program. 
 
 

The creation of resulting chart involves of following work items which, depending on the complexity of the model, might 
be time consuming (during the calculation a progress bar shows at the bottom edge of the window): 

 
 Timelines of boundary conditions are created by harmonic Fourier synthesis based on effective number of 

harmonics specified in the Boundary Conditions window.  
For power sources a second vertical axis on the right side of the chart is displayed; this axis and curves showing the 
boundary conditions of power sources are display as dashed lines,  

 Timelines of resulting values (temperatures) at selected Probe Points are generated by first computing synthetic 
distribution of results at specific time point for the whole model and then extracting the values at specified by spatial 
information. 

 
 
Remark: Values are (re)computed for each time value corresponding to respective pixel or pixel pair position along the 
time axis. When the window is resized by increasing its width significantly (more then doubled) then the calculation is 
restarted. 
 

MULTICORE-option: Speeding up computationally intensive jobs by distributing them 
on multiple processors or processor cores for parallel execution is only possible with an 
active MULTICORE-Option of the program.  

 
The legend provides the identification of patterns shown. A double click on to the legend will change its position relative to 
the chart area (right, left, top, bottom). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.kornicki.com/Introduction/86_Multicore.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

220 
 

 
 
Animate Time Dialog 
 

The Animate Time Dialog window is used to define temporal animation of transient evaluation by automating changes to 
the evaluation time point T of  Boundary Conditions window. 

TRANSIENT-option: Solving and evaluating time dependant dynamic, periodic problems when heat 
capacity effects are concerned is only possible with an active TRANSIENT-Option of the program. 

 

The temporal animation will be executed in specified time intervals continuously updating evaluation windows (Results 
report, Results 3D window) once these are open an boundary condition applied. Results 3D window rendering can be 
optionally recorded to an AVI file. 

                         

 

Time Point to Start The start value of iterating the evaluation time point 

Time Point to End The end value of iterating the evaluation time point 

Time Step length The step to increment evaluation time point on each iteration 

Number of animation steps Number of animation frames resulting from above inputs 

 

Remark: The AnimateTimeSettings for each MainPeriod of the latest animation started are retained within application 
settings (Start, End, Step, currently set in AnimationTimeDialog) 

The Recording to AVI part of the window will be active if there is an active Results 3D window rendering only, otherwise it is 
shown disabled. 

 

       

 

 

 

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm#TimePointToEvaluate
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Results
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Results
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm#TimePointToEvaluate
http://help.antherm.kornicki.com/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm#TimePointToEvaluate
http://help.antherm.kornicki.com/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm#TimePointToEvaluate
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Introduction/83_Transient.htm
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Record animation to AVI 
File 

If checked the image frame created for each time step will be recorded to a file. 
Prior to start of recording a dialog will ask you to specify the file name to record to. 
If the checkbox is cleared the animations started is reflected visually in the results shown only. 

Recorded frame rate Specify the frame rate for later playback. 

frame duration The reciprocal value of frame rate. Each time step frame will get the specified duration (for 
later playback) 

effective video duration Overall duration of later playback of the created file (number of frames * frame duration). 

Prompt for Compressor 
options 

If checked the operating system provided compressor options will queried prior the recording 
to a file will be started. 

 

  

Remark: This VideoRecordingSettings (FrameRate, PromptCompressorOptions; currently set in AnimationTimeDialog) are 
saved within application settings (of the latest recording started successfully).  

Start Will start iterating the evaluation time point within the specified interval 

Stop Will stop the iteration. 

Cancel Will close the window (and stop the iteration too) 

 See also: Results 3D window, Results report, Boundary Conditions window, Timelines Window 

 

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm#TimePointToEvaluate
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Results
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/TimelinesForm/TimelinesForm.htm
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Surface Temperatures Window 
 
In "View -> Evaluation & Reports -> Surface Temperatures" you can now, after applying the boundary conditions, access a 
graphical representation of the temperature gradients at the surfaces of the rooms the project contains.  
 
You can also access this view by marking the option in the window "Boundary Conditions" and clicking "Apply Boundary 
Conditions".  

 

In the top left corner of the window "Surface Temperatures" you can choose the room for which you want to display the 
surface temperature gradient.  
Click "Draw" to activate the graphical representation of the surface temperature gradient.  
With "Direction" you can change the direction of the unrolling.  
With "Corners" you can toggle the displaying of the corners.   

 

Click the camera icon to create a Word document which you can process using Microsoft Word. In the window that is now opened 
you can mark the images which you want to transfer to the report builder.  
Note: If you created more than four images buttons for scrolling will be displayed. A click always scrolls forward by four images.  
Then you can select the images which should be printed out with the report in the report builder after clicking "Graphical 
Evaluation".  
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Results report 
 

 
 
 
 
 

 

 
 

 

The Results report provides the output related to 
boundary conditions applied and shows results for 
coldest surface points of each respective space and 
includes their temperatures, coordinates and 
temperature weighting factors also. 
 
Calculation of evaluation results dependant on 
boundary conditions is requested by applying these 
values from the Boundary Conditions window. 
 
The results offered by this report are used for the 
assessment of fulfilling (or failing) the condensation and 
mould growth avoidance criteria (see EN ISO 13788). 
 

For each space the application automatically locates points of lowest surface temperature and outputs its coordinates. 
Also g-values (the weighting factors) are calculated and output. 
 
Along temperatures of coldest surface points the application outputs respective dew point values (maximum non-
condensing air humidity) also [1]. Respective values are calculated according to formulas of partial pressure as defined in EN 
ISO 13788:2002. 
 
The evaluation is executed on top of base solutions solved and superposed with respective boundary conditions 
(reported by the number of equations or cells solved) then further refined to the super fine solution (reported by the 
number of nodes evaluated). 
 

Boundary conditions and critical results 
 

For each space connected to the model following results information is offered: 

 
 name of the space  
 air temperature (the boundary condition of that space as entered within the Boundary Conditions window and 

applied)  
 the lowest surface temperature θ

*
Rsi at the surface of that space (at the coldest surface point) 

 the highest surface temperature at the surface of that space (at the hottest surface point)  
 highest allowed relative air humidity with respect to the coldest surface point of that space to avoid surface 

condensation (condensing humidity, Condens. RH) 
 the temperature factor f

*
Rsi with respect to the coldest surface point θ

*
Rsi (see remarks below).  

 

    
 

The temperature factor f*Rsi will be evaluated against the space with the lowest temperature Θe (i.e. that space will be 
assumed to be "exterior") and calculated according to standard by the definition f

*
Rsi = (θ

*
Rsi − θe)/(θi − θe) .  

Remark: In a two space case temperature factors f*Rsi will be output in addition to temperature weighting factors g - 
calculated for points of lowest temperatures of surface of each space. The temperature factor f

*
Rsi can be used as 

construction characteristic indicator only when two boundary conditions are applied. When three or more boundary 
conditions (spaces, power sources) are involved then the standard requires using of temperature weighting factors g 
because f

*
Rsi is not suitable in such cases! 

 

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Introduction/05_Normen.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Theory/SuperFineGrid.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Theory/Temperaturfaktor_fRsi.htm
http://help.antherm.eu/Theory/Temperaturfaktor_fRsi.htm
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Remark: The output of temperature factors f*Rsi will be suppressed if the application setting "fRsi - Two-Space only 
evaluation" is turned on and there are more than exactly two temperature boundary conditions involved in the model. 
If there are more then exactly two temperature boundary conditions and the application setting "fRsi - Two-Space only 
evaluation" is kept turned off, then the appropriate warning message is displayed within the report: "Warning: fRsi 
evaluation with more then two temperature boundary conditions!". 
 
 
If heat sources are also modelled: 

 
 the overall power of the heat source (calculated from the boundary condition entered and its volume)  
 the power density (the boundary condition of that heat source as entered within the Boundary Conditions window 

and applied)  
 the effective volume of that heat source 

 
Remark: The assessment of further extreme values (e.g. temperatures) at all surfaces and within interiors of all power 
sources is provided within the 2nd part of this report too. 
 

 

 

Weighting Factors (g-values) of coldest space points 
 

The weighting factors (g-values) will be output as a matrix for the coldest point of every space. Every column of the 
matrix displays g-values for the coldest point of the space surface named in the column heading. 
 
 

                                          
 

Weighting factors g are characteristic for respective points of the construction and their value is independent from any 
boundary conditions. The summation of g-values of a point multiplied by the respective boundary condition results in the 
temperature of that point. Under the assumption that the location of extreme poles will not change under different 
boundary conditions one can easily calculate the resulting temperature at these varied boundary conditions. 
 
Remark: The sum over all g-values belonging to temperature boundary conditions at specific point (sum of values in one 
column without those belonging to heat sources) is always 1. 
 
Remark: If the number of matrix columns output shall overrun the page width then the output of overrunning matrix 
columns is continued in groups one below the other. 

 

Coordinates of coldest surface points 
 

The listing of points of lowest space surface temperatures for each space shows point coordinates, the respective surface 
temperature, the dew point and the temperature factor f

*
Rsi also.  

 

 
 
 
 
 
 
 

http://help.antherm.eu/Theory/Temperaturfaktor_fRsi.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
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Condensation and Mould Growth Assessment Criteria 
 
 
 
If requested by the application setting "fRsi,min design factors - Warn if undercut" (on by default) AnTherm will 
automatically evaluate the assessment of the f

*
Rsi values by comparing actual values of f

*
Rsi to their design values for 

condensation free 
and mould-growth free constructions (also set within application settings). 
 
 shall the actual value of f

*
Rsi undercut the design value for mould-growth free construction, the indicator (*) is shown  

 shall the actual value of f
*

Rsi undercut the design value for condensation free construction (and eventually mould-
growth criteria too), the indicator (**) is shown. 

 
In addition, if either of the design values are undercut at any space surface there will be warning message displayed at the 
end of this report: 
 
 (*) Warning: f

*
Rsi < XXXX - Mould growth assessment criterion not fulfilled.  

 (**) Warning: f
*

Rsi < XXXX - Condensation assessment criterion not fulfilled. 
 
If the criteria is fulfilled on the other hand following confirmation will be printed: 

 
 f

*
Rsi - Mould growth- and Condensation assessment criteria are fulfilled. 

 
Remark: The output of temperature factors f*Rsi will be suppressed if the application setting "fRsi - Two-Space only 
evaluation" is turned on and there are more than exactly two temperature boundary conditions involved in the model. 
If there are more then exactly two temperature boundary conditions and the application setting "fRsi - Two-Space only 
evaluation" is kept turned off, then the appropriate warning message is displayed within the report: "Warning: fRsi 
evaluation with more then two temperature boundary conditions!". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Theory/Temperaturfaktor_fRsi.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Probe Points report 
 
The Probe Points report us used for the output of temperatures at chosen probe points at currently applied boundary 
conditions . 
 

 
                           

The report outputs temperatures at points (coordinates x,y,z) defined in the window "Probe Points". 
 
For each point given the application outputs coordinates (values of x,y,z) and the value of calculated temperature. If 
required a tri-linear interpolation is used to calculate temperature exactly at any point of the model from node values 
available at the super fine grid. 
 
If the chosen point is located at some space surface the respective dew point (maximum non-condensing air humidity) is 
calculated and output in %. 
 
If the chosen point is located outside of the boundaries of the construction only its coordinates are output. 
 
Remark: The report includes points of lowest and highest surface temperature for each space surface automatically – 
space name, space temperature, dew point and f

*
Rsi value (if applicable) are output – same as in Results report. 

http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Theory/SuperFineGrid.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
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Remark: The output of temperature factors f*Rsi will be suppressed if the application setting "fRsi - Two-Space only 

evaluation" is turned on and there are more than exactly two temperature boundary conditions involved in the model. 
 
Remark: If there are power sources contained within the model this report also includes points of lowest and highest 
temperature within each power source (to assess overheating for example). 
 
If there is solution of vapour diffusion available also, values of saturation and partial pressure are also output at each 
point: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

If the current value of partial pressure is higher then saturation pressure, a star (*) is shown adjacent to the partial 
pressure value - this shall alert on possible condensation risk at this respective point. 

 

VAPOUR-option: Analysis of multidimensional vapour diffusion is only possible with an active 

VAPOUR-Option of the program. 

 

 

Remark: Point evaluated are defined in the window Probe Points. The list of probe points can be extended directly from 
Results 3D window (Probe) also. 
 
 
Remark: Shall partial solution be only available to the report (e.g. some base solution yet not calculated finally, spaces 
without thermal connection with the model, etc.) the respective result fields will be left empty. Please consider checking 
the input data or rerunning the solver and checking the output shown within the solver window in such situation. 
 

http://help.antherm.eu/Theory/Temperaturfaktor_fRsi.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
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Results 3D window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

The Results 3D window displays graphical 3D evaluations according to control parameters set in the control panel of this 
window. Changes to control parameters are immediately applied and result in new graphical image displayed. The 3D view 
can be arbitrarily manoeuvred with the mouse in a 3D virtual space (rotations, scaling or translations). 
 
 

 The image of the resulting 3D view can be rendered to the operating system's clipboard and then used in further 
applications (e.g. Word) to integrate it in personalised reports for example. It can be saved to an image file or exported as a 
3D scene file too. 
 
The window is divided into two areas: 

 the 3D view 

 the control panel 

  
The 3D view shows the visualization of the 3D evaluation. Typically the actual view is overlaid with the current colour bar 
and with results of probing evaluation (shown at bottom left). The orientation marker (shown at bottom right) provides 
feedback of current orientation of axes within the 3D space. Additional output of program version (bottom right) and 
license information (top left) will display in the colour being contrast to current background colour. 
  

 Actually the 3D evaluation displays a composition of possible graphical evaluations which are controlled selectively 

from the control panel. The arbitrary composition of these parameters can be collected for later reuse. 
 
Remark: The position of the control panel can be set in application settings to left instead of right side of the window. 
 
Remark: Within application settings you can decide if the recently used combination of evaluation settings will be restored 
on initial display of this window. 
 
 
TRANSIENT-option: Solving and evaluating time dependant dynamic, periodic problems 

when heat capacity effects are concerned is only possible with an active TRANSIENT-Option 

of the program. 
 
 

Evaluation of time dependant results of transient problem is controlled either by the evaluation time point T input in the 
Boundary Conditions window or automated with the Animate Time Dialog. 

 

http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
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The Control Panel 

The control panel is used for selective parameterisation of any of 3D evaluations and for combining 
them in to visualizations within the 3D area. The graphical display resembles changes to various 
parameters immediately. 

The final visualization depends on settings of all active evaluations, the opacity of their visual parts 
and choice of solid or wireframe views. 

Which values if temperature, heat flux, humidity and others are evaluated depends on the choice 
of the active function in the General panel. 

Names of respective control panels correspond to the evaluation controlled therein: 

General  General control parameters like selection of the active function evaluated, of 
light, of background colour. 

Model  
  

Control parameters of the visualization of construction's model (similar to 
Elements 3D window) 

Surface  
  

Controls parameters of  evaluations specific to component's surface. 

Slice X  

Slice Y  

Slice Z  

Control parameters 3D slices (parallel to axes planes) through the building 
construction 

Isolines  
(Isotherms) 

Control parameters of isolines (isotherms, lines of equal heat stream density or 
surface humidity) 

Streamlines  Control parameters for evaluation of (heat-)streamlines within the construction 
over the vector field of (heat) stream density 

Vectors  
HedgeHog 
Arrows 

Control parameters for evaluation of (heat-)stream vector arrows within the 
construction over the vector field of (heat) stream density 

Isosurface  
  

Control parameters of a isosurface connecting points of equal values 

Colorbar  

  

Selection of parameters controlling the colourizing of evaluations by the colour 
table chosen. 

Axes  
  

Control parameters of the display of coordinate axes 

Probe  
Probe Cross  

Control of the view of results of point probing. Particular probe can be selected 
from the list of probe points 

Profile  
  

Control a X/Y diagram display of values along a profile line 

Labels  
  

Control properties and density of labels and annotations of isolines and the 
colour bar 

Outline  
  

Control parameters of the display showing the volume's outline. 

3-D  
  

3-D navigation within the three dimensional virtual view space (e.g. rotations, 
plan views etc.) 

 
Buttons always accessible: 

Collect/Show 
Parameters  

Complete combinations of evaluation parameters set and selected can be 
collected in the list of Results3D parameters and makes them available for later, 
single step, restoration. 
Remark: Clicking on this button while holding the Shift- or Ctrl-Key will simply 
expose the  list of Results3D parameters without collecting current evaluation 
settings (adding the new entry). 

Collect/Show 
Probepoint(s)  

Current coordinates of the probe point (actual positon of X, Y, Z slices) are 
collected to the list of probe points. 
Remark: Clicking on this button while holding the Shift- or Ctrl-Key will simply 
expose the list of probe points without collecting the current point (adding a new 

http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#Sekundärfunktionen
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#Sekundärfunktionen
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Beschriftungen.htm
http://help.antherm.eu/Forms/Result3DForm/Beschriftungen.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Umriss.htm
http://help.antherm.eu/Forms/Result3DForm/Umriss.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

230 
 

entry). 
See also: Probe (control panel) 

Collect/Show 
Isometry 

Current isometry (the 3-D transformation) is collected to the liste of isometries. 
The list of isometries can be edited in the isometries window or a chosen 
isometry can be selected and applied to the view. 
Remark: Clicking on this button while holding the Shift- or Ctrl-Key will simply 
expose the list of isometries without collecting the current camera position 
(adding a new entry). 
See also: 3-D navigation (control panel) 

Fit The position and scaling of the view will be adjusted to ensure that the whole 
component is visible in the window. 

Copy Image  The 3D view will be rendered to the clipboard of the operating system.  
The image can be pasted from the clipboard to another application (e.g. Word) 
for further processing (e.g. integration in a personalized report.  
The image can be exported (saved) into an image file . 
Remark: The size of the image rendered is different from the view on screen and 
is defined within application settings. 

Record Video What happens inside the Results 3D window is recorded and saved as a video file 
in the AVI format. To stop recording click this button another time. 

[>>>], [<<<] Hides- and exposes the control panel itself 

The width of the control panel can be adjusted by dragging its border. Place the mouse pointer over the splitter edge of the 

control panel (left edge) until the mouse pointer changes to . Then hold the mouse button and drag the edge of the 
control panel adjusting its width upon to your needs. 
Remark: The chosen width will be saved when the window is closed and restored on the next display provided the the value is 
within the allowed range (116 to 600 display points). 

   

Placing of the tabs of the control panel and their labels can be set to right or left. Adjust the setting "Left-align vertical 
tabcontrol tabs" within application settings accordingly. 

The tabs can be shown labelled with text titles and/or displayed with icon symbols (controlled with context menu of vertical 
tabs). The setting "with Icons" only ("text labels" disabled) provides a very compact display of the tabs with only graphical 
symbols. All tabs show their respective tooltip also (which might contain further information). By that, even without text 
labels, the navigation in the control panels of Results3D is comfortably possible (and does not require any searching in several 
columns possible) 
 
The control panel can be hidden or exposed by clicking onto the button [>>>] or [<<<] respectively. 
 
Following control settings are common: 
 Active  
 Opaque and Opacity  
 Colorize  
 Fixed Range  
 Solid or wireframe model  
 Background colour 

 
Remark: Actual creation of 3D evaluations result in relatively high memory demands. Systems equipped with less then 
512MB RAM will experience significant delays in execution due to extensive paging. The number of secondary functions 
chosen for evaluation significantly controls these demands.  
Important: In the case memory demands cannot be satisfied by the system error message will be displayed. If the 

application is still responsive after such an error message please save your data immediately and restart the application. 
 
Remark: Current position of the 3D view (the isometry given by the current view vector) will be retained when the window is 
closed and saved when the application exits. The next time the window is opened the view isometry will be restored if such 

http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Bildspeichern immer erfragen
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Bilddimension f.d. Zwischenablage
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#VertikaleReiterLinksAusrichten
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#VertikaleReiterLinksAusrichten
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
http://help.antherm.eu/Forms/Result3DForm/FixedRange/FixedRange.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
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behaviour is set within application settings. 
 
Remark: During the time the system is busy with rendering the new evaluation view (possibly very complex calculations) the 
mouse pointer will change to clock symbol (when placed over the control panel). 
 

Remark: When this window is focused following additional, window specific, functions are available from the main menu: 

 
 View→3D navigation functions (plan views, rotations, perspective etc.)  
 Edit→Copy Image 3D to render the image onto the clipboard  
 File→Export→Image 3D... to save the rendered image to a image file  
 File→Export→Scene 3D... to save the rendered 3D scene into a 3D scene  file. 

 
Remark: The size and proportions of the image rendered to the clipboard can be set within application settings. 

 
 

Saving and Restoring parameter combinations 
 

Complete combinations of evaluation parameters set and selected can be collected in the list of Results3D parameters and 
makes them available for later, single step, restoration with a double click. This provides the valuable ability to quickly 
restore parameter combinations earlier saved, thus allowing reproducible visualizations. Nearly all parameters set within 
control panels are retained there as list entries. Parameters specific to evaluation function are handled otherwise  

 
 

Function specific evaluation parameters 
 

Evaluation settings which are specific to the evaluated function (i.e. to different active function, for example the temperature, 

heat flux, pressure, ...) will be collected internally for each chosen evaluation function. When the selection of the active 

function is changed the settings specific the the one chosen will be restored respectively - for optimal and comparable 

visualization of results for different projects. 
 
By that it can be ensured that settings dependant on values of specific function (e.g. colours of the colour table, applicable 
assignment of colours to value domain, step of isolines, labels' parameter, etc.) will be kept invariant, as far as possible, for 
all projects. 
Active Function specific evaluation parameters: 
 

 

Color Bar 

Fixed Range (TotalRangeEditable),  
Range-Min/Max (TotalMinimum/MaximumValue),  
Min/Max (RangeMinimum/MaximumValue),  
Clamp range (Clamp),  
Colour table (ColorTable) and Label parameter (see below) 

 

Isolines 

Fixed Range (TotalRangeEditable),  
Range-Min/Max (TotalMinimum/MaximumValue), 
Min/Max (RangeMinimum/MaximumValue),  
Clamp range (ClampRange), 
#interv. (NoOfIntervals/Enabled),  
Step (Step/Enabled),  
Start At (StartAt/Enabled),  
Bold n-th (HighlightEachNth/Enabled) and Label parameter (see below) 

Labels 

Color Bar: # Intervals (ColorBarLabelsIntervals), 
Color Bar: Decimal digits (ColorBarLabelsDigits), 
Isolines: Font size [pts] (IsolinesLabelsFontSize), 
Isolines: Decimal digits (IsolinesLabelsDigits) 

Isosurface Value (IsosuraceValue) 

 
This function specific parameters, when set in the control panels, will be collected continuously for each evaluation 
function selected and saved within application settings when Result3D window closes. 
 
Important: The function specific parameters do not run into the collection of "Results3D Parameter" (neither Project nor 
Standard). The function specific evaluation parameter are application setting. 
 

 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Export/Bild_Export.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Export/Szene3D_Export.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Farbskala.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Farbskala.htm#FixedRange
http://help.antherm.kornicki.com/Forms/Result3DForm/Farbskala.htm#RangeMinMax
http://help.antherm.kornicki.com/Forms/Result3DForm/Farbskala.htm#MinMax
http://help.antherm.kornicki.com/Forms/Result3DForm/Farbskala.htm#ClampRange
http://help.antherm.kornicki.com/Forms/Result3DForm/Farbskala.htm#ColorTable
http://help.antherm.kornicki.com/Forms/Result3DForm/Isolinien.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Isolinien.htm#FixedRange
http://help.antherm.kornicki.com/Forms/Result3DForm/Isolinien.htm#RangeMinMax
http://help.antherm.kornicki.com/Forms/Result3DForm/Isolinien.htm#MinMax
http://help.antherm.kornicki.com/Forms/Result3DForm/Isolinien.htm#ClampRange
http://help.antherm.kornicki.com/Forms/Result3DForm/Isolinien.htm#NumberOfIntervals
http://help.antherm.kornicki.com/Forms/Result3DForm/Isolinien.htm#Step
http://help.antherm.kornicki.com/Forms/Result3DForm/Isolinien.htm#StartAt
http://help.antherm.kornicki.com/Forms/Result3DForm/Isolinien.htm#FettJeN
http://help.antherm.kornicki.com/Forms/Result3DForm/Beschriftungen.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Beschriftungen.htm#ColorBarLabelsIntervals
http://help.antherm.kornicki.com/Forms/Result3DForm/Beschriftungen.htm#ColorBarLabelsDigits
http://help.antherm.kornicki.com/Forms/Result3DForm/Beschriftungen.htm#IsolinesLabelsFontSize
http://help.antherm.kornicki.com/Forms/Result3DForm/Beschriftungen.htm#IsolinesLabelsDigits
http://help.antherm.kornicki.com/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Isoflaeche.htm#Value
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
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General (control panel) 
 

 

The control panel General is used to set and adjust general parameters of the visualization. 

More Light 
Used to turn addition "light sources" on making the the resulting 
view brighter and displaying more contrast. 

Back Color Defines the colour of the background used within graphical window 

Perspective 

Switches the 3D view between perspective projection and parallel 
projection. 
The parallel projection is especially useful during visualization of 3D 
models or slice views (see also Plan Views). 

Function 
selected 

By selecting an active function you define which data will be 
visualized. When additional secondary functions are calculated also 
(this is set with the switch „Secondary functions") one of following 
functions can be selected for the 3D visualization: 

 Temperature °C  

 Heat stream density W/m²   

 Relative condensing surface humidity % (only at the 
surface of the construction) according to EN ISO 
13788:2002, respectively: 

 Condensation 

 Mould growth 

 Corrosion 

 Saturation pressure of vapour hPa 

 Partial pressure of vapour hPa 

 Vapour pressure difference hPa (saturation pressure - 
partial pressure) 

 Relative Core Humidity % (relative interstitial humidity; 
interstitial vapour saturation ratio = partial 
pressure/saturation pressure * 100) 

 Vapour diffusion stream density mg/m²h 
Which of these secondary function is actually calculated can be 
selectively defined within application settings by a parameter 
"Evaluate which secondary functions?".  
If no secondary functions (beyond temperature) are available the 
field is shown disabled. 

Secondary 
functions 

When the setting "secondary functions" is tuned off, only 
temperature distribution within the model is calculated and offered 
for evaluation. 
Turning this setting on requests calculation of additional scalar and 
vector functions.  
Which of these secondary function is actually calculated can be 
selectively defined within application settings by a parameter 
"Evaluate which secondary functions?". 
Within application settings: Evaluate secondary functions 

Vector 
selected 

By selecting an active vector field you define which data will be 
visualized (e.g. during generation of streamlines or vectors 
(hedgehog, arrows). When additional secondary functions are 
calculated also (this is set with the switch „Secondary functions") 
one of following vector fields can be selected for the 3D 
visualization: 

 Vector field of heat stream W/m² 

 Vector field of the vapour diffusion stream density 
mg/m²h 

Which of these secondary vector field is actually calculated can be 
selectively defined within application settings by a parameter 
"Evaluate which secondary functions?".  
If there are no vector fields available the field is shown disabled. 
 

Collect 
Params 

The current combination of numerous parameters set in all control 
panels will be saved to the list of Results3D parameters as new 

http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/ThreeDee.htm#Seitensichten
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#Sekundärfunktionen
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#Sekundärfunktionen
http://help.antherm.kornicki.com/Theory/ZurGrenzfeuchtigkeit.htm
http://help.antherm.kornicki.com/Introduction/81_Dampfdiffusion.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen: welche
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen: welche
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen: welche
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen: welche
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Solver-Parameter
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen Auswerten
http://help.antherm.kornicki.com/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#Sekundärfunktionen
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#Sekundärfunktionen
http://help.antherm.kornicki.com/Introduction/81_Dampfdiffusion.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen: welche
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen: welche
http://help.antherm.kornicki.com/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.kornicki.com/Introduction/81_Dampfdiffusion.htm
http://help.antherm.kornicki.com/Introduction/81_Dampfdiffusion.htm
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The choice of evaluation function selected and the vector selected retained within application settings and restored 
respectively.  
If the earlier selection is not available within the current data set (i.e. respective secondary function was not calculated) 
the selection will be reset to default. See also: Selected Function specific evaluation parameters and the application 
setting "Restore last Result3D Parameters". 
 
Remark: As primary function selected we call the set of values used for current visualization. One can select the 
temperature, heat stream density, relative surface humidity etc. To reduce the time required for calculation, one can 
suppress the calculation of secondary functions with the switch "Secondary functions" (creation of data of each separate 
secondary function requires approximately same time as the creation of the temperature distribution alone when new 
boundary conditions are applied).  
Calculating secondary functions can be significantly improved on multiprocessor systems (MULTICORE-Option). 
 
 
MULTICORE-option: Speeding up computationally intensive jobs by distributing them on 

multiple processors or processor cores for parallel execution is only possible with an 

active MULTICORE-Option of the program. 
 

 

Remark: The relative surface humidity is defined only at the component's surface. At adiabatic boundaries (wonder foils) 
and at surface points hotter then the air space temperature the value of 100% is applied currently. 
 
Following images display visualizations of different primary functions (Temperature °C , heat Stream Density W/m², 
Relative Surface Humidity % ): 
 
 
 
 
 

                                                          
 
 
 

entry.  
The list of parameters can be edited within Results3D parameters 
window (e.g. it can be named arbitrarily) or the required parameter 
combination can be selected from the list and applied to the current 
Results3D view. This provides the ability to quickly restore earlier 
saved combination of parameters allowing  
 
reproducible visualizations. 
The list of parameters is saved within project file. 
The Results3D Parameter window will be shown also. 

Show 
Collection 

The Results3D Parameter window will be shown. 

Restore 

Changes the application settings deciding if the recently used 
combination of evaluation settings will be restored on initial display 
of the Results 3D window.  
For more details see: Application setting "Restore last Result3D 
Parameters" 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.kornicki.com/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.kornicki.com/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.kornicki.com/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.kornicki.com/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RestoreLast3dResult3DParam
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RestoreLast3dResult3DParam
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RestoreLast3dResult3DParam
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RestoreLast3dResult3DParam
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RestoreLast3dResult3DParam
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Remark: Producing a visualization of (heat) streamlines requires the calculation of the corresponding vector field of heat (or 
vapour) stream. Therefore you must turn the calculation of such required secondary vector field on to receive stream line 
visualizations (i.e. of secondary functions). 
 

 

VAPOUR-option: Analysis of multidimensional vapour diffusion is only possible with an active 

VAPOUR-Option of the program. 
 
 
 

See also: Results3D window, Active (setting), Opaque and Opacity (setting), Colorize (setting), More Light (setting), 
Background Colour (setting), Main menu, Application settings 
 
 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Results3D Parameter window 

 

The window Results3D Parameter shows the list of collected 3D evaluation and 
visualization settings parameters. Nearly all parameters set within control panels are 
retained here as list entries. Parameters specific to evaluation function are not influenced 
from this window. 
 

Collecting new Results3D parameters is initiated from the Results3D window with 
the button Collect Params (in the control panel General) or from the View menu. 

 
The set of parameters shown as an item in the list can be easily restored and applied to 
the evaluation view. 
 
The list of evaluation settings specific to the project is shown in the tab Project. The tab  
Standard shows the list of application wide evaluation settings. 
 

Label 

An arbitrary, editable, label of respective item in the list of 
parameters (used for documentation and better, easier identification 
only) 

Double-Click 
onto  record-mark 

Initiates the process of applying the combination of settings selected 
(marked line) to the 3D visualization. 
Remark.: Settings applied are taken from the current row – i.e. even if 
the click occurred within text of another line, the data applied is taken 
from the line marked with the record mark (an arrow symbol). 

Apply 
Initiates the process of applying the combination of settings selected 
(marked line) to the 3D visualization. 

Delete Deletes the currently selected (marked) item form the list. 
Move Up The position of the item currently selected can be moved in the list. 

Move Down The position of the item currently selected can be moved in the list. 

To Standard 

Settings combination associated with the selected entry within the 
project specific list will be copied (as additional entry) to the 
application wide list (Standard). 

To Project 

Settings combination associated with the selected entry within the 
project specific list will be copied (as additional entry) to the 
application wide list (Standard). 

Project Exposes the list of project specific evaluation settings 

Standard Exposes the list of application wide (standard) evaluation settings 
 

 

Functions of the context menu 
 

The display of the list has a context menu attached (exposed when right mouse button is 

pressed): 

 
 

 

 

Apply Initiates the process of applying the combination of settings selected (marked 

 line) to the 3D visualization. 

   
 

Edit Details... Setting combination of the currently selected item can be edited in detail and 

 adjusted according to specific needs. 

 Remark: This is an advanced function. Naming chosen for distinctive 

 parameters shall be self explanatory. 

 
 

Pick from The list of project specific evaluation settings saved within some another 

Project... project will be imported (appended) to the current project's list. 

 
 

Move Up The position of the item currently selected can be moved in the list. 

 
 

Move Down The position of the item currently selected can be moved in the list. 
  

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/SettingsForm/SettingsForm.htm
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Delete Deletes the currently selected (marked) item form the list.  

 
 

 

To Standard Settings combination associated with the selected entry within the project  

 specific list will be copied (as additional entry) to the application wide list  

 (Standard).  

 
 

 

To Project Settings combination associated with the selected entry within the application  

 wide (Standard) list will be copied (as additional entry) to the project own list.  
   

 

 
 

Please note: Various settings listed in this window can be set within other control 
elements also. The position of slices X/Y/Z can be set from Probe points window 
(see also control panel Probe). 
 
The camera position (isometry) of 3D view can be set from Isometries window (see 
also control panel 3D). 
 
 
 
 
 
 
 
Remark: To retain the list and the evaluation settings of the project between 
application executions you must save the project! 
 
Remark: The application wide list of evaluation settings (Standard) will be saved 
with application settings (at application's exit). 
 
See also: Results3D window, General (control panel), application settings file 
AnTherm.exe.Settings.xml, Function specific evaluation parameters, Settings - 
various (dialog) 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/SettingsForm/SettingsForm.htm
http://help.antherm.eu/Forms/SettingsForm/SettingsForm.htm
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Model (control panel) 

 
The control panel Model is used to adjust the parameters relevant for the visualisation of modelled 
building construction - in addition or in combination with other evaluations. 
 
Following combination of evaluations might be of special interest: 

 
 View of the model shown as solid body with isolines (e.g.. isotherms) on component's surface,  
 View of slices through the model (solid body) with isolines on slice planes,  
 View of the model as lines (boundaries of materials) overlay-ed with other evaluations. 

 
The model representation shown corresponds to the one used in Elements 3D window within input 
part. The resulting image shows the modelled construction resulting from the overlapping of input 
elements (the entry point for the so called "minimum grid"). 
 
Surfaces of the model (and eventually edges) are shown colorized. Colorizing corresponds to the 
input of element properties. 
 
The Slice planes X/Y/Z can be also shown as model slices. Resulting representation can be shown as 
solid (colorized by material colour) or edge-lines (i.e. material edges). 
 

Active, Decide about the visibility, colorizing and transparency of model surfaces (and its 

Opaque, edges if applicable) 

Colorize  

  

Shrink Elements will be "shrunken" towards their centre (the value of 1.0 means no 

 shrinking). Shrunken view is very helpful when examining the modelled construction 

 in its interior also. 
  

Solid Allows the wireframe view of edges of the model input. 
  
 
 
By default the construction model is shown as lines (wireframe) resulting from the input of elements. 
 
The view onto edges of slice planes (these are located at the surface of the model) can be turned on or off within the 
control panel „Surface“. This is important ion the context of wireframe view of the modelled construction to either show 
lines coloured by material or by selected evaluation function. 
 
By default the view of model slices is turned off or set to wireframe. This is required to avoid overlapping of that 
representation with slices of selected function and to avoid confusing results and interpretation difficulties when too many 
lines are simultaneously shown during initial display. 
 
Remark: Planes representing construction surface and model surface overlap. These can lead to visually "confusing" effect 
of "shadows" shown on the surfaces. Therefore it is advised to select wireframe representation for one of the two surface 
evaluations.  
Important: Some (external) material edges overlap with surface edges and slice edges. If all these are turned on the 
overlapping might result in visually "confusing" effects.  
Important: Model slice plane and function slice plane overlap. When both are turned on this overlapping will lead to 
sometimes confusing effect of "shadows". To make model slices visible at their own make slices itself fully transparent 
(i.e. turn their opacity = 0). If you wish to view slices through function values, it is advised to show model slices as lines 
(wireframe, solid off) to show edges of materials only.  
Important: To properly show lines at material edges elements of the modelled construction are shrunk by a very small 
factor – otherwise the edges of neighbouring elements could not be shown properly (visually confusing result, possibly 
some lines even not visible). The shrinking factor used has a value of 0.99999, i.e. an element of 10 meters length is 
shrunken by less then 1 mm (only in the picture, which is absolutely invisible). 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
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See also: Results 3D window, Active (setting), Opaque and Opacity (setting), Colorize (setting), Solid or Wireframe (setting), 
General (control panel), Isolines / Isotherms (control panel), Elements 3D window 
 
 
 
 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
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Surface (control panel) 

 

The control panel Surface is used to adjust parameters of the surface visualization and thus has also 
impact onto results of evaluations related to the components surface: Colorizing and Isolines 
(Isotherms). The surface, if rendered opaque, will obscure all other evaluations specific to the objects 
interior (Isosurface, Streamlines, Slices etc.) 

 
The surface (and eventually its edges) are rendered colorized. Actual colorizing follows values of 
currently active function (temperature, heat stream density, surface humidity etc. - selected within 
General control panel) and currently selected Colour table. 

 

Active, Opaque, Decide about the visibility, colorizing and transparency of the surface (and its edges 

Colorize if applicable) 
  

Solid When turned off allows the wireframe view onto the fine grid at which temperature 

 distribution and  secondary functions are calculated. 
  

Edges Allows emphasizing of component's edges, i.e. lines at intersections of surface 

 plane elements. 

 Rendering of surface edges can be requested independently of the surface - made 
 visible or transparent. 
  

Slice Edges Allows emphasizing of slice edges (rendered only if any slices are active). 

 Rendering of slice edges can be requested independently of the surface - made 
 visible or transparent. 
  

 
Remark: The surface displays components hull coloured by the primary function (including adiabatic 
cut-off planes – so called "wonders", adiabatic planes). The surface is rendered partly transparent 
(according to the setting of the opacity value). To receive an opaque (non transparent) rendering use 
the switch Opaque. The surface can be rendered as a wire frame (lines) – turn the switch Solid off – to 
display the grid used for evaluation of results.  
Remark: Construction edges show the position of all edges of the component. This rendering is useful 

while the surface itself is not shown (inactive or transparent). Displaying construction edges might be also very helpful 
when verifying the correctness of model input.  
Remark: Graphical objects used to render the surface are oriented outside of components interior. This also ensures 
proper colouring of the wireframe view of the fine grid (the „back side“ of the wire frame is black). 
 
 
 
 
 

                       

http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
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See also: Results 3D window, Active (setting), Opaque and Opacity (setting), Colorize (setting), Solid or Wireframe 
(setting), General (control panel), Active function, Isosurface (control panel), Streamlines (control panel), Vectors 
(HedgeHog, Arrows) (control panel), Isolines / Isotherms (control panel) 
 
 
Slice X, Y, Z (control panels) 
 

Control panels Slice X, Slice Y, Slice Z are used to adjust parameters of slice planes parallel to 
coordinate axes planes cutting through the construction. These settings have impact onto result of 
evaluations focused onto slice planes also: Colorizing and Isolines (Isotherms). The inputs are also 
used to control the Probe evaluation, Profile evaluation, Streamlines evaluation and Vectors 
(HedgeHog, Arrows) evaluation. 

 
Slice planes are shown colorized. Actual colorizing follows the values of active function (temperature, 
heat flux (stream density), etc. - selected within General control panel) and currently selected Colour 
table. 
Crossing lines of the three slice planes (these lines are parallel to the axes) can be also shown 
(controlled via Probe panel). That other panel provides additional control of interactive moving the 
cross point. 

 

Active, Opaque, Decide about the visibility, colorizing and transparency of the slice 

Colorize  
  

Value The slice position is defined by an input of plane coordinate (x for slice-X, y for 
 slice-Y or z for slice-Z). 

 The input can be performed either by 

  entry of numeric value in the input field or 
  moving the slider between the extent values of respective coordinate axis 
 or 
  selecting a value from the context menu 

  

Context menu/ The context menu of this control panel offers the list of all 

Coordinate list surface coordinates within the modelled construction (in the 

 direction of respective axis). 

 By choosing one of the values the position of the slice plane 

 will be set accordingly. 
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Remark: Because slice plane intersects with model's interior only it is advisable to either turn the view of the surface 
completely off or show it partially transparent (i.e. not opaque) or show it as wireframe only.  
The tooltip of the tab will show up if the surface obscures objects rendered within the interior of the model. 
 
Remark: The slice planes (SliceX, SliceY, SliceZ, orthogonal to respective coordinate axis) show plane intersections with 
construction colorized by values of selected function. If required values are interpolated (linear interpolation). Slices are 
shown partially transparent (according to current opacity value). To receive opaque representation (non transparent) use 
the switch Opaque. 
 
Remark: Slice edges (these are placed at construction's surface) are shown to emphasize the position of the slice plane even 
if the slice itslf is transparent and not visible. The exposure of slice edges can be controlled from the control panel Surface. 
 
Remark: The position of SliceX/Y/Z will be retained within application settings and restored respectively.  
If the old slice position is outside of the model bounds (with model spatially changed or different model loaded) the 
respective slice position will be reset to the centre of the model. See also Application setting "Restore last Result3D 
Parameters". 
 
Remark: A double click onto the data record mark of a line corresponding to a probe point within the probe points window 

will initiate the transition of the position of the probe point currently shown within Results3D window to coordinates shown 

in the respective line – slice planes X/Y/Z are moved accordingly. Within a 2D project slice plane Z is moved to 500 mm. 
 
 
See also: Results 3D window, Active (setting), Opaque and Opacity (setting), Colorize (setting), Solid or Wireframe 
(setting), General (control panel), Active Function, Isolines (Isotherms), Probe (control panel) 
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Isolinies / Isotherms (control panel) 
 

The control panel Isolines is used to adjust parameters of isoline evaluations (isotherms, in the 
case of temperature is chosen for the active evaluation function). 

 
Isolines are shown colorized. Actual colorizing follows values of currently active function 
(temperature, heat flux, surface humidity etc. - selected within General control panel) and currently 
selected Colour table. 

 
The isolines (or isotherms) are drawn on component's surface or on slice planes, and are 
therefore only visible if these evaluations are active also. Settings chosen within control panels 
Slice X, Slice Y, Slice Z and Surface have thereafter an impact onto evaluation of isolines. 

 
Which isolines are shown can be selectively chosen by setting the number of intervals (#Interv.) or by 
choosing the step value. Isolines will be created only for values within the interval Min and Max 
according to the input therein.  
At initial view of isotherms the interval of 1°C, starting at 0°C is set and isolines shown. 

 
Isolines can be labelled accordingly also and/or emphasized bolded (as a tube). 

 
 
               

Active, Opaque, 
Colorize 

Decide about the visibility, colorizing and transparency of the lines shown 

Fixed range 
If turned on the value range for isolines' creation can be set arbitrarily, 
independent of the current value range of the evaluated function. 

Range-Min/Max 

The values of Maximum and Minimum, shown at the top and bottom of the 
panel, display the current extent of selected evaluation function. 
When "Fixed range" is chosen both values can be set arbitrarily, 
independent of the current value range of the evaluated function. 

Min/Max 

The interval can be reduced by the input in the respective fields. 
The input can be performed either by the entry of numeric values into the 
respective input field or by moving the sliders between the extent values.  

#interv 
Number of equidistant intervals dividing the extent between the input Min 
and Max values. The step will be calculated from these values. 

Step The value interval at which isolines shall be drawn. 

Start at 
The start value fro which (in both directions, towards Min and towards 
Max) the values of isolines to be drawn shall be calculated. 

Bold n-th 

Selected isolines (each N-th) will be shown emphasized (Bold n-th) - as a 
thick tube instead of a thin line. 
Isoline labels are shown only on bolded lines if the option "Bold n-th" is 
chosen. 
Remark: The tube itself if always partially transparent to allow proper 
display of isoline labels (visibility test) 

Tube Radius 

Emphasized isolines (switched on by "Bold n-th") are shown as a tube to 
better emphasize respective isolines (compared to single pixel thick line). 
The radius is entered in units of the coordinate system - i.e. millimetres. 
Setting the tube radius = 0 will show it as simple line. 
The initial value of tube radius is computed based on median extent of 
component (1/200 of it). 
Remark: The number of sides rendered for the tube can be adjusted within 
application settings. 

Clamp range 

Limits the isolines created to the values within the Min/Max interval 
specified. 
If switched off (default) the isolines are created for the whole value range 
available in the data set. 

 
 

Remark: It is advisable to adjust the surface "holding" the isolines (i.e. Surface or Slices) by showing it transparent or  
opaque. 
Alternatively adjust colorizing of isolines or the surface "holding" them to dark or bright to receive the required contrast of 
the image. 
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Remark: Because slice planes, holding isolines, intersect with model's interior only it is advisable to either turn the view of 
the surface completely off or show it partially transparent (i.e. not opaque) or show it as wireframe only. 
The tooltip of the tab will show up if the surface obscures objects rendered within the interior of the model. 
 
 
 
 
Remark: Isolines are lines shown and colorized by the constant value of the primary function chosen (Isotherms, lines of 
equal heat flux, lines of equal surface humidity, and so on). Isolines are displayed on construction's surface (Surface) and on 
slice planes (SliceX,Y,Z) (only if these are active). To show isolines only, without the surface "holding" them, turn that surface 
completely transparent (set opacity = 0). The selection of values at which isolines are shown is givien by the definition of a 
start value (Start at) and of a interval length (Step) (or number of intervals). 
 
 
Remark: The visibility of isolines is directly dependant on the visibility of the surface object holding it:  
→ Isolines on the component's surface are only visible if the Surface is also active. To get better view onto isolines turn 
the surface transparent – Surface→Opacity=0.0;  
→ Isolines on slices (X/Y/Z) are only shown if the respective slice is also active. To get better view onto isolines turn the 
respective slice transparent – SliceX/Y/Z→Opacity=0.0 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

Hint: Fix the Range to receive comparable results by decoupling it from the actually evaluated domain. This function 
specific setting takes care for keeping the range constant regardless of changes to boundary conditions, evaluation time 
point, animation or for different projects. 
 
 
See also: Results 3D window, Active (setting), Opaque and Opacity (setting), Colorize (setting), Solid or Wireframe 
(setting), General (control panel), Active Function, Isosurface (control panel), Labels (control panel), Fixed Range 
(setting) 
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Labels (control panel) 
 

The control panel Labels contains settings for labelling of  Isolines and of the Colorbar 

 

Labels on Isolines 
 

Labels of Isolines are placed over Isolines shown over the slice planes X/Y/Z or over component's 
surface. 
 

Show labels Turns labelling of isolines on or off 

  
Distance along The distance between labelling points along each isoline (staring at the middle 

line of each polyline of each isoline) 

 The initial value of the distance value is calculated based on the median extent 
 of the component modelled (1/3 of it). 
  

Proximity The minimum distance between any two labelling points. 

  
Font size [pts] Size of letters used for labels. 
 The actual size scales with the height of the 3d view. 
  

Decimal digits Number of decimal digits after decimal comma to show on isoline labels. 
  

 
Remark: In general it is advisable to keep the distance along line at 1/3 of the component's extent. 
The proximity is commonly changed together with the font size. Generally the Proximity is always 
smaller then Distance along line. 
 
Remark: Visibility of each separate label is checked against all opaque surfaces and objects within the view. Transparent 
surfaces and do not obscure labels. 
 
Remark: Labels of isolines shown with active isoline option "Bold n-th" are shown on emphasized isolines only. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The tricky algorithm positioning the labels can be described as follows: 
 

1. Each isoline is represented by a polyline - under certain circumstances there will be many polylines for the same 
isoline value generated (sections of isolines). 

2. The initial labelling point is set at the middle of such polyline (very short polylines are skipped).  
3. Starting from that initial point, in both directions of the polyline, further points will be placed - repeatedly at each 

distance along line.  
4. After all points are set for all polylines the distance of each pair of points is tested against proximity - one of the 

points is removed if the distance is less then the set proximity value. This avoids overlapping of labels placed too 
nearly (below the value of proximity) to each other.  

5. All labelling points are tested for their visibility - this highly depends on the orientation of the 3d view. Points 

obscured by opaque surfaces are removed. 
6. All points still on the list are used to place labels in requested font size. The size and orientation of labels is 

independent of the current 3d transformation. 
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Labelling the Colorbar 
 

Value labels of the colorbar are placed at one side of the coloured bar. 
 
 

Show labels Turns labelling of colorbar on or off 

  
# Intervals Defines the number of intervals at which the colorbar shall be labelled. 
 

 

Decimal digits Number of decimal digits after decimal comma to show on colorbar labels.. 
  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Remark: When Results3D is showing a periodic evaluation at some time point, the title of the colour bar will display that 
value. 
 
See also: Isolines / Isotherms (control panel), Slice X,Y,Z (control panel), Results 3D window, Colorbar (control panel) 
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Isosurface (control panel) 

 

The control panel Isosurface is used to adjust parameters of a isosurface - a surface joining points of 
equal values. The isosurface shows a colorized surface of constant value of current primary function 
(temperature, heat flux etc.). 

 
The isosurface is shown colorized. Actual colorizing follows the values of currently active function 
(temperature, heat flux, etc. - selected within General control panel) and currently selected Colour 
table. 

 

Active, Opaque,   Decide about the visibility, colorizing and transparency of the surface shown. 

Colorize 
 

Value The value at which the isosurface shall be generated. 
 

The input can be performed either by entry of numeric value in the input field or  
by moving the slider between the extreme values of respective function. 

 

Remark: Because the isosurface exists within model's interior only it is advisable to either turn the 
view of the component's surface completely off or show it partially transparent (i.e. not opaque) or 
show it as wireframe only.  
The tooltip of the tab will show up if the surface obscures objects rendered within the interior of the 
model. 

 
Remark: Extreme values of temperatures include space temperatures also. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
            
 
 
 
 
 
 
 
 
     

 

   

 

 
 

Hint: To identify and locate the are of thermal bridges there is very valuable evaluation offered by visualizing the 
isosurface of a high value within the field of heat stream densities. 
 
See also: Results 3D window, Active (setting), Opaque and Opacity (setting), Colorize (setting), Solid or Wireframe 
(setting), General (control panel), Active Function, Isolines (Isotherms) 
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Streamlines (control panel) 

 

The control panel Streamlines is used to adjust parameters of the stream line evaluation. 
 

A streamline shows a trace of a heat flow through any point within the construction. For 2D project 
traces are produced through several points placed at the surface of selected space. 

 
If there is vapour solution available the flow of vapour diffusion can be visualized with this 
evaluation alternatively. 

 
The evaluation is performed over the calculated field of heat flux vectors (or vapour diffusion flux 
vectors) at all nodes of the simulation grid – these fields are available only if evaluation of secondary 
functions has been chosen (in General the secondary functions is active!). If there is no vector field 
data available to render the tab will show a tooltip stating that. 

 
The streamline will be calculated over the active vector field by executing the Runge-Kutta 
method. The streamline (independently from the active function always follows the active vector 
field) is shown colorized. Only the colorizing of the streamline corresponds to the active function 
(temperature, heat flux etc.) as set in the General control panel and depends on the colour table 
selected. 

 

Streamline through one probe point (Slice X/Y/Z) 

 

The position of the starting point to trace the stream is defined by the intersection of the three slice 
planes Slice-X / Slice-Y / Slice-Z. Impressive visualizations can be obtained also by interactively moving 
or picking the starting point. 

 
Therefore the slices X,Y,Z provide crucial part of parameters required for this evaluation (but need 
not be visible nor active). 

 

Streamlines at equidistant intervals of heat stream from space boundary in 
2D case 

 

For 2-dimensional models the streamlines can be automatically drawn out of space boundaries at equal 
intervals of heat stream (of that space). This functionality is available for 2D projects only. 
 
Important: Streamlines are drawn in the plane of slice Z which must be active (even if fully transparent)!   

After the option "Start at ... Space Boundary" is selected, the name of the space the streamlines shall be drawn from can be chosen 
together with the number of intervals the stream of that space boundary shall be divided into. The application calculates the heat 
(or vapour) stream from/to the space, subdivides it into the given number of equal intervals and draws streamlines at each such 
calculated start value of the stream function. 
 
This evaluation can be executed for 2D projects or for other project types, but only if the construction is absolutely homogenous in 
the Z-direction and there are no space connections in this direction also. If this variant of evaluation is actually available can be 
verified within the streamlines control panel - if the choice option "Start at: Space Boundaries" is inactive (shown greyed) then that 
type of evaluation is not available in the context of actual simulation results ergo of the actual model. 

Actve, Opaque, Colorize Decide about the visibility, colorizing and transparency of the streamline 

Integration Step length 

The factor used to determine the minimal step length of the Runge-Kutta method.  
Small values lead to high number of iteration steps within each fine grid cell executed 
by Runge-Kutta method. More such steps (i.e. at small values of integration step) result 
in smother, more precise, stream lines. Small number of steps (i.e. large integration 
steps) result in coarse steam flow representation. 
The value also determines the minimum distance of how close the streamline can 
approach the surface boundaries of construction. 
Default: 0.1 mm 

Max. propagation length 

This number affects the number of integration steps of the Runge-Kutta method 
performed from the starting point until iterations, and thus tracking the stream field, 
are aborted. 

This number is important by defining the highest allowed total length of each separate 
streamline in millimetres.  

High values of maximum propagation length will obviously increase the computational 
time required to create the streamline. 
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Terminal stream density 

This number defines the magnitude of stream density (modulus of flux vector) below 
which the tracking of the stream field by Runge-Kutta method shall be aborted. 

Default: 0 

Tube Radius 

The streamline is shown as a tube to better emphasize the stream (compared to single 
pixel thick line). The radius is entered in units of the coordinate system - i.e. 
millimetres. 

Setting the tube radius = 0 will show it as simple line. 

Default: The initial value of tube radius is computed based on median extent of 
component (1/200 of it). 

Remark: The number of sides rendered for the tube can be adjusted within application 
settings. 

 

     

 

 

 

 

 

 

 

 

 

 

 

 

Start at: 

 ProbeX/Y/Z 

 Space Boundary 

 

The position of staring point is defined by the intersection of the three slice planes Slice-X / 
Slice-Y / Slice-Z  
or,  
for 2 dimensional models, one can chose to automatically generate starting points on 
space boundaries at equidistant intervals of heat stream.  
Remark: The "Start at Space Boundary" option is available for 2D projects only. 

Space Boundary The name of the space from which the streamlines shall be drawn 

# intervals 
Number if intervals the stream function calculated at the space boundary shall be divided 
into thus determining the starting points for streamline generation. 
Remark: High number of streamlines generated will result in high graphical memory 
demand. It is advised to set the tube radius to 0. 
Remark: If the stream flows to the space and (at other section of the space boundary) from 
the space, the highest amount is taken and divided into intervals. To visualize the dividing 
line between the areas of stream loss and stream win select division at 1 interval only. 

 

Remark: Because streamline (the flow) exists in model's interior only it is advisable to either turn the view of the surface 
completely off or show it partially transparent (i.e. not opaque) or show it as wireframe only. The same applies to the 
visibility of slice planes X, Y, Z (starting point of stream tracing) which shall be made partly transparent or even completely 
invisible (Opacity = 0). 
The tooltip of the tab will show up if the surface obscures objects rendered within the interior of the model. 
Remark: When surface humidity is selected as active function (panel General), the streamline is coloured grey only, because 
the function of surface humidity is defined at component's surface only. 
Remark: Current implementation of the solution of the initial boundary problem posed here uses Runge-Kutta method of 

http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#TubeNumberOfSides
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#2D Projekt
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#2D Projekt
http://help.antherm.kornicki.com/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
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fourth order with adaptive step control. The boundary condition of step control is set to the small, still numerically stable, 
error value of epsilon = 10

-17
 and cannot be changed by the user.  

The initial-, minimal- and maximal integration steps are determined by the user (Integration Step length). The minimal step 
corresponds to the value entered (default  0.1 mm). The initial step length is 100 times the minimal value. The maximal step 
length is 10000 times the minimal value.  
The maximal propagation length corresponds to the total length of the resulting streamline in millimetres.  
 
Remark: Not to overwhelm the capacity of today's hardware equipment when combined with tube visualization following 
restrictions apply and are automatically checked and set: 
 
 Showing the streamline as Tube will be suspended (and all streamlines shown only as simple lines) when for all 

streamlines taken together the overall number of vertices needed for the tube representation would exceed 1.6 
millions (i.e. number of segments < 1.6Mio/NumberOfTubeSides). 

 
 Rendering as tube will be suspended for all streamlines also also if any part of any streamline themselves would 

contain more than 100.000 segments - such too long streamline, then shown by simple lines, will show broken 
early. This applies to both parts (the forward and backward) of each separate streamline independently. 
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Remark: Start at – Probe X/Y/Z: The position of staring point of a streamline is defined by the intersection of the three 
slice planes Slice-X / Slice-Y / Slice-Z. The intersection of the three planes must be within model's interior.  
If the intersection of the slices X/Y/Z (we call it the probe point) is located very close to components surface it might 

happen that no stream line can be started from there. Shall this (rare) situation arise you will have to shift the starting 

point by at least the half of the smallest size of the fine grid cells (i.e. the start thickness of the fine grid parameters, 

typically 0.5mm or 1mm). 
 
Remark: Start at – Space Boundary: Produces many streamlines started at selected space boundary. The application 
calculates the sum of stream flowing to the space and the sum of stream leaving the space through the boundary (for 
exterior space, case with two spaces without powers sources one of this values is always 0). The sum with the largest 
modulus is divided into the number of intervals entered (maximum 200 intervals, i.e. at 0.5% of the heat stream). Along the 
space boundary the application repeats the calculation of the stream function and places start points for the streamline at 
interval boundary values calculated earlier (interpolated). To ensure, that every streamline will start each starting point is 

http://help.antherm.kornicki.com/Forms/Result3DForm/Stromlinien.htm#Integrationsschrittfaktor
http://help.antherm.kornicki.com/Forms/Result3DForm/Stromlinien.htm#Maximale Propagationslänge
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
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shifted towards the interior of the model by about the half thickness of the surface fine grind cell (typically 0.5mm or 1mm). 
See also: Results 3D window, Active (settings), Opaque and Opacity (setting), Colorize (setting), Solid or Wireframe 
(setting), General (control panel), Active Function, Isolines (Isotherms), Slice X,Y,Z (control panel), Surface (control 
panel), Vectors (HedgeHog, Arrows) (control panel) 
 
 
Vectors (HedgeHog, Arrows) (control panel) 
 

The control panel Vectors (HedgeHog) is used to adjust parameters of the vector field evaluation 
with arrow symbols. 

 
Arrow symbols shows the direction of heat flow through within the construction at any arbitrary point 
or points on 1,2 or 3-dimensional regular mesh. 

 
If there is vapour solution available the flow of vapour diffusion can be visualized with this 
evaluation alternatively. 

 
The evaluation is performed over the calculated field of heat flux vectors (or vapour diffusion flux 
vectors) at all nodes of the simulation grid – these fields are available only if evaluation of secondary 
functions has been chosen (in General the secondary functions is active!). If there is no vector field 
data available to render the tab will show a tooltip stating that. 

 
Vector glyphs will be calculated over the active vector field. Vectors (which direction and eventually 
size independently from the active function always follow the active vector field) are shown colorized. 
Only the colorizing of vector glyphs corresponds to the active function (temperature, heat flux etc.) as 
set in the General control panel and depends on the colour table selected. 

 
The length (and thickness too) of arrow glyphs follow the magnitude (vector norm) the active vector 
field (Scale) or are shown at fix constant size. 

 
Alternatively to showing arrow glyphs cone symbols or lines can be chosen. 

 

Arrows at one probe point (Slice X/Y/Z) or Mesh Points 
 

The position of the point to display the arrow glyph is defined by the intersection of the three slice planes 
Slice-X / Slice-Y / Slice-Z. 

 
Therefore the slices X,Y,Z provide crucial part of parameters required for this evaluation (but need not be 
active nor visible). 

 
Starting from that probe point a regular mesh of points can be created (at given step, distance) and that 
either along the Line X,Y or Z, the slice plane X,Y or Z or throughout the whole volume. 
 

Active, Opaque, 
Colorize 

Decide about the visibility, colorizing and transparency of glyphs 

Style The representation of an glyph:  

 Arrow,  

 Smooth-Arrow,  

 Cone,  

 Smooth-Cone or  

 Line. 
Remark: Rendering details of cone glyphs are set within application settings. 
Remark: Rendering details of arrow glyphs are set within application settings. 

Scale The size (length) of the glyph shall scale by magnitude (vector norm) the active 
vector field . The normalized magnitude is then scaled by the factor given. 
Remark: Scaling the normalized magnitude means, that the maximum value 
within the vector magnitude field is 1.0. 

Fixed length 
The size (length) of the glyph shall be exactly the value given (in millimetres). 

Mesh points at: 

 Probe 
Point 

 Probe 
Lines 
(LineX,Y,Z) 

 Slice 
Planes 

The position of vector glyphs is defined either by theintersection of the three slice 
planes Slice-X / Slice-Y / Slice-Z or at a regular mesh of points along the LineX,Y or 
Z, the slice plane X,Y or Z or throughout the whole volume.  
Remark: The setting "Volume" in combination with too dense mesh mightresult in 
display of too much information to be interpreted. 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
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(SliceX,Y,) 

 Volume 

Mesh Distance The name of the space from which the streamlines shall be drawn 
Remark: The resulting number of mesh points is limited by following criteria: 500 
intervals at each axis direction; total maximum100000points 

 
 

Remark: When surface humidity is selected as active function (panel General), glyphs are coloured grey only, because the 
function of surface humidity is defined at component's surface only. 
 
Remark: Because starting points for the glyphs exist within model's interior only it is advisable to either turn the view of 
the component's surface completely off or show it partially transparent (i.e. not opaque) or show it as wireframe only. The 
tooltip of the tab will show up if the surface obscures objects rendered within the interior of the model. 
 
Remark: Glyphs will not be placed within regions of stagnation (flux <10e-17). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                

 
 
 
 
 

See also: Results 3D window, Active (settings), Opaque and Opacity (setting), Colorize (setting), Solid or Wireframe 
(setting), General (control panel), Active Function, Isolines (Isotherms), Slice X,Y,Z (control panel), Surface (control 
panel), Streamlines (control panel) 
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Colorbar (control panel) 

 

The control panel Colorbar defines transformation settings of the colour table used for false colour 
assignments in all colorized evaluations (the transformation from function value to a colour). The 
display of the colour scale can be adjusted here also. 

 
The colour table "affects" the active function (temperature, heat flux, surface humidity, etc.) - 
selected within the General control panel. 

 
Remark: By changing the setting Colorize of each respective evaluation the function of colorizing by 
a colour table can be turned off selectively - objects are then homogenously coloured by dark or 
bright colour instead of being colorized by value. 

 
Active, Decide about the visibility and transparency of the colour scale and its labels. 

Opaque 
Remark: Even if the colour scale itself is inactive (not visible) chosen parameters are  

 applied to evaluations!! 
  

Moveable If turned off all mouse events will be directed to the 3D evaluation - the colour bar 
 cannot be sized nor moved anymore. 

 
Fixed range If turned on the value range for adjusting the colour bar can be set arbitrarily,  

independent of the current value range of the evaluated function. 
 

Range- The values of Maximum and Minimum, shown at the top and bottom of the panel, 

Min/Max display the current extent of selected evaluation function. 

 When "Fixed range" is chosen both values can be set arbitrarily, independent of the 

 current value range of the evaluated function. 
  

Min/Max The mapping interval of the colour bar displayed can be reduced by the input in the 

 respective fields. 

 The input can be performed either by the entry of numeric values into the respective 
 input field or by moving the sliders between the extent values. This allows better 
 emphasizing of selective value interval. 
  

Clamp Allows for clamping of evaluation areas outside of selected value interval. 

range 
Remark: Current implementation provides very simple but extremely fast clamping  

 function. 
 

Colour table Preset with the standard value "(Default)" the colour table of red through green to blue 

is used. 

The application provides many various colour tables which can be selected here. 
 
 

Labelling of the colour bar can be adjusted within the control panel Labels. 
 
The position at which the colour bar is displayed can be arbitrarily changed within the 3D view by moving and sizing it 
with the mouse. 
 
Remark: Even if the colour scale itself is inactive (not visible) chosen colorizing parameters are applied to evaluations! 
 
Remark: Extreme values of temperatures include space temperatures also. 
 
 
 
 
 
 
 
 
 
 
 

 

 

Hint: Fix the Range of the Color Bar to receive comparable results by decoupling it from the actually evaluated domain. 
This function specific setting takes care for keeping the range constant regardless of changes to boundary conditions, 
evaluation time point, animation or for different projects. 

 

http://help.antherm.eu/Forms/Result3DForm/Farbskala_Farbtabellen/Farbskala_Farbtabellen.htm
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
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http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
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Position and size of the colour bar display 
 

The position at which the colour bar is displayed can be arbitrarily changed within the 3D view by moving and sizing it 
with the mouse if the "Moveable" setting is turned on. 
 
You interactively manipulate the position, size, and orientation of a colour bar. It reacts to to left mouse events and 
mouse movement. The shape of the cursor will change based on its location. If the cursor is over an edge of the colour bar 
the cursor shape will change to a resize edge shape.  
If the position of a colour bar is moved to be close to the centre of one of the four edges of the 3D view, then the colour bar 
will change its orientation to align with that edge. This orientation is sticky in that it will stay at that orientation until the 
position is moved close to the centre of another edge. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Actual position of the colour bar is saved automatically within application settings file and restored the next time the 
Results3D window is opened. 
 
Remark: If the case the colour bar has been accidentally moved outside of the visible area of the window, it can not be 
picked with the mouse pointer anymore for any further movement. To restore the position to some position where it can be 
picked and moved again you must close the 3D window and reopen it - the colour bar will be automatically restored at some 
visible position nearby the image edge. 

 

Remark: When Results3D is showing a periodic evaluation at some evaluation time point, the title of the colour bar will 
display that value (lacking other annotations the title of the colour bar has been chosen for now as appropriate). 
<Function name><Unit> (<Time Point>) 
For vertically displayed colour bar the time information will be placed onto the second line of the title. 
 
 
TRANSIENT-option: Solving and evaluating time dependant dynamic, periodic problems 

when heat capacity effects are concerned is only possible with an active TRANSIENT-Option 

of the program. 
 

 

See also: Colorize (setting), Results 3D window, Isolines / Isotherms (control panel), Surface (control panel), Slice X,Y,Z (control 
panel), Streamlines (control panel), Vectors (HedgeHog, Arrows) (control panel), Isosurface (control panel), General (control 
panel), Labels (control panel), Fixed Range (setting) 
 
 
 

http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
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http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
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Colour scale / Colour tables 
 

The application provides various colour scales (colour tables) used to assign colours to numerical results within graphical 
evaluations. Particular selection of a colour scale depends on visualisation needs of the user. 
 
In addition to the obligatory RGB and RGB_INV tables, following 
colour tables are available: 
 
The grey scale provides the most simple palette of colours. 
Temperature values are transformed to brightness values, similarly 
as it is done by camera. This palette is useful for exceptionally 
neutral evaluations. 
 
Especially for temperature images it is natural to use the colour 
scale of glowing body: Cold objects display dark and reddish, hot 
show in bright in yellow or even white. The contrast is moderate, 
but higher then of the neutral grey scale. 
 
The contrast of a thermogram can be enhanced by adding the 
colour of violet between red and the black (= cold) end. 
 
Alternatively a thermogram can be enhanced also by using  
the contrast of a scale of hot stars as it is used by astronomy. 
 
To carry the contrast to extreme by adding as many colours to the 

scale as possible. One can use psychological perception people see 

as "cold" and "warm" colours, and assign them accordingly to 

temperatures. None of colours used is repeated to avoid any 

ambiguity. It is worth to observe, that even small value  
errors will be visible now. 
 
Cartography uses an alternative kind of colouring allowing 
perception of even very small value differences. Psychologically 
"colder" colours are assigned to smaller values and "warmer" 
colours apply to higher values. 
 
There are some use cases making conventional colorizing not 
suitable - for example when the picture of a thermogram shall allow 
derivation of energy balance. For such situations a symmetrical 
colouring is more reasonable and the centre jump point could be set 
to zero. 
 
Remark: The current number of colour intervals used within the colour table is 2048 (more colours „cannot be seen 
simultaneously by human eye“). 
 
See also: 3D evaluations 
 
 
 
 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
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Probe (control panel) 

 
The control panel Probe is used to control the view of data measurement at some probe point, 
graphical display of its location and control of additional interactive positioning methods. 

 
The position of the probing point is defined by the intersection of the three slice planes Slice-X / Slice-
Y / Slice-Z. Here it can be interactively moved by dragging the 3D cursor with the mouse or by picking 
points with the mouse at any displayed surface. 

 

 Probe  

   

 Active Decides about the visibility of the probe data for its textual readout. 
   

 Probe Cross  

   

 Active, Decide about the visibility, colorizing and transparency of the probe cross 

 Opaque,  

 Colorize  

   

   

 Moveable When active allows interactive moving of the 3D cursor (by dragging it with the 

  mouse) and thus arbitrary placement of the probe point position X,Y,Z. 
   

 Pickable When active allows picking the probe point position at any surface object displayed 

  by clicking (or double clicking) on it. 
   

   

 Collect Point Coordinates X,Y,Z of the current probe point are added to the list of probe points 

  (this list will be edited within the Probe Points window and evaluated within Probe 

  Points part of Results report). 

  The window Probe Points will be exposed also. 
   

 Probe points The window Probe Points will be exposed. 
   

 

  
Readout of the probe point data  

 

The result of this probing evaluation is shown at the bottom left corner of the view. The colour for that display is chosen 
automatically and set to some high contrast colour against current background colour. 
 
At the evaluated point its coordinates are output (the values of X,Y and Z) along with the calculated value of temperature. If 
required tri-linear interpolation is used to calculate exact resultant value at any point of modelled construction from values 
calculated by the simulation at nodes of the super fine grid. 
 
The probe provides the way to read out a value (e.g. temperature in °C) at any point of the construction.  
If the probing point is placed at space boundary the value of non condensing (maximum) air humidity (%) is evaluated 
and output also.  
If there is solution of vapour diffusion available also, probing shows the pressure difference of partial and 
saturation pressures (hPa) too. 
If the point is positioned at the exterior of modelled construction no results are output beyond coordinate data. 
 
Remark: The Probe Points part of Results report provides an alternative textual method of evaluating temperature values at 
multiple probe points . 

 

Visualizing the probe point location 

 

At the intersection lines of slice planes X,Y,Z a colorized probe cross can be displayed. Actual colorizing follows the 
values of active function (temperature, heat flux (stream density), etc. - selected within General control panel) and 
currently selected Colour table. 
 
Remark: Because this evaluation provides reasonable results for points located in model's interior only it is advisable to  
either turn the view of the surface completely off or show it partially transparent (i.e. not opaque) or show it as wireframe 
only.  
The tooltip of the tab will show up if the surface obscures objects rendered within the interior of the model. 

 

http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Theory/SuperFineGrid.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
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Moving the probe point interactively (3D cursor moveable) 
 

The setting Moveable controls the 3D cursor. The setting can have one of the three distinct states: 
 
 

Checked Immediate 
3D cursor is active. While the 3D cursor is being dragged with the mouse its 
position will be immediately applied to the values of Slice X,Y,Z thus resulting in 
frequent (interactive) updates of the rendering. 

Partly 
checked 

Deferred 

3D cursor is active. The new position of the 3D cursor will be passed to Slice 
X,Y,Z coordinates at the end of the move (i.e. when the mouse button is 
depressed). This ensures that the eventually complex visualisation pipeline is 
executed at final position once only. 

Unchecked Off Using the 3D cursor is disabled. 

 
 

Interaction with the 3D cursor will start as soon as the mouse is positioned in the neighbourhood of the probe cross or 
rectangle lines surrounding the slice planes (so called X/Y/Z shadows) an the left mouse button is depressed. Elements of 
the 3D cursor will display in light green during the active interaction. 
 
If the shift key is held depressed during the initial move of the 3D cursor, than that initial move direction constrains the 
further interaction to one axis direction only. 
 
Remarks: The widget itself is shown nearly transparent not to overlap with other elements (opacity = 0.1). The outline 

shadow (the box) is not shown by design. When selected default colour used (light-green). Scaling/Zooming/Translation of 

the 3D cursor outline is not allowed by design. Movements are always constrained to the bounding box of the model. 
 
Remark: During export operations the 3D cursor widget will be hidden temporarily and not rendered to the resulting 
export view. 

 

Picking the probe point at surfaces shown (picakble) 

 

The setting Pickable controls the picking behaviour of the mouse. The setting can have one of the three 

distinct states: 

 

Checked Double Click Picking a point on some visible surface is initiated with a double click. 

Partly checked Single Click Picking a point on some visible surface is initiated with one single click. 

Unchecked Off Picking is disabled. 

 

 

Upon the click (or double click) the application will attempt to pick the point on the next visible surface below the 

current cursor position. 
 
The picking of the point is available at visible (i.e. active, opaque or partly transparent) surface objects and provided in 
that order: 

 

 Surface - locating probe output at interesting places of the analyzed scalar function.  
 Isosurface - usable to pick a starting point of streamline on the isosurface of high heat flux (identifying thermal 

bridges).  
 Slices X,Y,Z - usable to re-position two slice planes at some location at the third plane 

 
Remark: if neither surface object is visible (inactive or totally transparent) picking will have no effect. 
 
 
Remark: The position of SliceX/Y/Z will be retained within application settings and restored respectively.  
If the old slice position is outside of the model bounds (with model spatially changed or different model loaded) the 
respective slice position will be reset to the centre of the model. See also Application setting "Restore last Result3D 
Parameters". 
 
Remark: From the Probe points window you can double click onto a data mark record of some point listed there to 
transfer its coordinates to the 3D evaluation (position of slices X/Y/Z) .

http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm#Wert
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm#Wert
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm#Wert
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
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See also: Results 3D window, Active (setting), General (control panel), Active Function, Slice X,Y,Z (control panel), 
Surface (control panel), Profile (control panel), Probe Points window 
 
 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
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Profile (control panel) 
 

 
The control panel Profile defines parameters for the visualization of values of the active function 
along specified line or edge showing within X/Y-diagram. 
 

 

Labels of the horizontal axis display coordinate values along the chosen edge line. The axis title report 
the exact position and direction of the profile line. 

 

The position at which the diagram is displayed can be arbitrarily changed within the 3D view by moving and sizing it with 
the mouse. 
 
Remark: Adjustments of axis labels can be done within panel Axes. 
 
The colour of the function line, axes lines and annotations is chosen automatically and set to some high contrast colour 
against current background colour. 
 
Remark: Settings "Probe Line" and "Space Boundary" are yet inactive within current implementation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Position and size of the diagram display 

 

The position at which the diagram is displayed can be arbitrarily changed within the 3D view by moving and sizing it with 
the mouse if the "Moveable" setting is turned on. 
 
You interactively manipulate the position, size, and orientation of the diagram. It reacts to to left mouse events and mouse 
movement. The shape of the cursor will change based on its location. If the cursor is over an edge of the diagram the cursor 
shape will change to a resize edge shape.  
If the position of diagram is moved to be close to the centre of one of the four edges of the 3D view, then the diagram will 
change its orientation to align with that edge. This orientation is sticky in that it will stay at that orientation until the position 
is moved close to the centre of another edge. 
 
Actual position of the diagram is saved automatically within application settings file and restored the next time the 
Results3D window is opened. 
 
Remark: If the case the diagram has been accidentally moved outside of the visible area of the window, it can not be 
picked with the mouse pointer anymore for any further movement. To restore the position to some position where it can 
be picked and moved again you must close the 3D window and reopen it - the diagram will be automatically restored at 
some visible position nearby the image edge. 
 
See also: Results 3D window, Slice X, Y, Z (control panels), Axes (control panel) 
 
 

Active Decide about the visibility of the function diagram. 

Moveable 
If turned off all mouse events will be directed to the 3D evaluation - the 
diagram cannot be sized nor moved anymore. 

Profile at: 
X:SliceY/Z 
Y:SliceX/Z 
Z:SliceX/Y 

Selects the line used to profile the values of the active function. 
The location of the line is set by values controlled within panels Slice X, Y and 
Z. 

http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Profil.htm#PositionUndGröße
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm#Die Schnittlinie der drei Schnittflächen
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm#Die Schnittlinie der drei Schnittflächen
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Axes (control panel) 

 

 

The control panel Axes is used to adjust setting of the axes representation shown around the three 
dimension view of evaluation combination. 

 

Active, 
Opaque Decide about the visibility and transparency of the axes lines and their annotations. 

  

Placement At Outer Edges - axes will be placed at  outer edges of the volume 
 or 
 At Closest Triad - axes will be placed at the corner which is closest to the viewer. 
  

Titles Decide about the visibility of titles on all three axes (e.g.. X, Y, Z) 
  

Font Size [pts] Defines the size of the font used to show axes titles. 

  
Labels Decide about the visibility of numerical labels on axes. 

  

Font Größe Defines the size of the font used to show numerical labels on axes. 

  
# intervals Defines the number of intervals of numerical labels on all three axes. 

  

  
X Aktiv Decide about the visibility of X axis and its annotations. 

  

X Titel Decide about the visibility of an axis tile on X axis. 
  

Titel Defines the title of X axis 
  

X Labels Decides about the visibility of numerical labels on X axis. 
  

  
Y Aktiv Decide about the visibility of Y axis and its annotations. 

  

Y Titel Decide about the visibility of an axis tile on Y axis. 
  

Titel Defines the title of Y axis 
  

Y Labels Decides about the visibility of numerical labels on Y axis. 
  

  
Z Aktiv Decide about the visibility of Z axis and its annotations. 

  

Z Titel Decide about the visibility of an axis tile on Z axis. 
  

Titel Defines the title of Z axis 
  

Z Labels Decides about the visibility of numerical labels on Z axis. 
  

 
 

 
By default axes are shown with numerical labels and titles. The colour of axes lines and annotations is chosen automatically 
and set to some high contrast colour against current background colour. 
 
Axes lines are settled a bit out of the volume shown allowing sufficient space for numerical labels. The position of each 
axis is adjusted according to the placement chosen (so called "Fly-Mode" method) - for each axis there are 4 different 
placement alternatives at 4 sides of the Outline of the volume). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/Result3DForm/Umriss.htm
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Remark: During 2D evaluations and with views parallel to axes planes (side views) it is advised not to select "At Outer 
Edges" - otherwise axes will jump between left/right and bottom/top edges because the term "outer" is ambiguous 
(and numerically unstable thereafter) 
 
Remark: Naming of axes titles can be adjusted in application settings also. 
 
See also: Results 3D window, Active (setting), Background colour (setting), 3-D Navigation Orientation Marker 
(control panel), Application settings 
 

 
 

 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

261 
 

Outline (control panel)  
 
 

                                             
The control panel Outline is used to control the display of the bounding box of the visualized 
object. 
 

 
 
 
 
 
 

                                       
 
 
 
 
 
 
 
 
 
 
 
 
 
See also: Results3D window, Active (setting), Opaque and Opacity (setting), Surface Edges (control panel), Axes 
(control panel), 3-D Navigation Orientation Marker (control panel) 
 
 
 
 

Outline 

Allows the display of a bounding-box: i.e. of a ashlar surrounding the 
whole modelled construction. Only edges of the ashlar are displayed. 
The outline can be helpful during positioning the graphical view within 
virtual 3D space, similarly as axes will do also. 
The Active setting turns the visibility of an outline on or off. 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Achsen.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Aktiv/Aktiv.htm
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3-D Navigation (control panel)  
 

 
The control panel 3-D Navigation is used to adjust the position of resulting 3-D view. The controls of 
this panel guide the movements of camera (the viewer) of the three dimensional scene. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Further possibilities and details of 3D-Navigation with mouse or the keyboard are described in "3D Navigation within 3D 
windows". 
Remark: Type of 3D projection (parallel or perspective) can be also set within General control panel or from the View menu 
within Main menu. 
Remark: From the Isometries window you can restore saved isometry by a double click onto the requested one. 

Remark: You can interactively manipulate the position and the size of the orientation marker. It reacts  
to to left mouse events and mouse movement when set to be moveable. The shape of the cursor will  
change based on its location. If the cursor is over the orientation mark the cursor shape will change to a  
resize or move shape. 

                           Orientation mark settings are saved automatically within application settings file. 

                              

 
 

 Reset 

Reset the camera position to its standard placement.  
 X/Y plane parallel to the view plane.  
 Z axis points towards the viewer.  
 Y axis points vertically upwards (zenith).  
 X axis points horizontally to the right. 

The scaling of the image is adjusted automatically to fit the view. 

 Fit 
The position and scaling of the view will be adjusted in such a way, that the 
whole building construction is visible within the view window. 

+/- 
The camera is moved forwards or backwards. 
While in parallel projection it is equivalent to scaling the view. 

Side views 

The camera is moved to one of side view positions (back, front, bottom, top, left, 
right) 
Remark: Hold one of the modifier keys (Alt, Ctrl or Shift) depressed while pressing 
the button to view animated transformation of the position. The duration of the 
animation is set via the advanced application setting "DesiredFlyToSeconds". 

Rotations 
The camera is moved at the surface of a sphere (the distance to the object is 
constant) or the camera is tilted. 
Rotations are executed at steps of 30° (angle degrees). 

Panning 
The camera is panned horizontally or vertically in the view plane. 
Panning is executed at steps of 10 pixels. 

Perspective 
Switches the 3-D view between perspective projection and parallel projection . 
The parallel projection is useful for 2D models or slice views (see also side views 
here above). 

Psi Toggles the graphical representation of the Psi value evaulation on or off. 

Stereo 

Provides switching between monocular view (standard) and several stereo viewing 
(binocular) modes. 
Remark: Eventually additional hardware and license extensions might be required. 
Remark: That control element is shown disabled if there are no stereo modes 
available. 

Collect 
Isometry 

The current isometry (the 3-D transformation) will be added (collected) to the list 
of isometries.  
The list of isometries can be edited within the window isometries (named with an 
arbitrary name) or required isometry can be selected from there. 
The list is saved within the project file. 
The Isometries window will be exposed also. 

Show 
Isometries 

The Isometries window will be exposed. 

Restore 
Adjusts the application setting to restore to the recent Camera position on next 
initial display of a 3D window. 
For more details see: Application setting "Restore last Camera Position" 

 Orientation marker 

Active style Turns on or of the display of the orientation marker 

Moveable 
If turned off all mouse events will be directed to the 3D evaluation - the orientation 
marker cannot be sized nor moved anymore. 

http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Allgemein.htm#Perspektive
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#DesiredFlyToSeconds
http://help.antherm.kornicki.com/ProjectTypes/ProjectTypes.htm#2D Projekt
http://help.antherm.kornicki.com/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/ThreeDee.htm#Seitensichten
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#stereo
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#stereo
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#stereo
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#stereo
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.kornicki.com/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RestoreLast3dCameraViewInfo
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RestoreLast3dCameraViewInfo
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RestoreLast3dCameraViewInfo
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RestoreLast3dCameraViewInfo
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Isometries window 

 

 

The window Isometries shows the list of collected 3D transformations of the 3D view. 
 

 Collecting new isometries is initiated from the Results3D window with the button Collect 
  Isometries (in the control panel 3-D) or from the View menu. 

 
The isometry shown as an item in the list can be easily restored and applied to the 3D view. 
 
The list of isometries specific to the project is shown in the tab Project. The tab Standard shows 
the list of application wide isometry settings. 
 
 
 

Label An arbitrary, editable, label of respective item in the list of isometries (used for 
 documentation and better, easier identification only) 
  

Double click Initiates repositioning the current view to the position (3D transformation) 

onto record clicked within the list. 

mark Remark.: Transformation applied is taken from the current row – i.e. even if the 
 click occurred within text of another line, the data applied is taken from the line 
 marked with the record mark (an arrow symbol). 
  

Apply Initiates repositioning the current view to the position (3D transformation) 
 currently marked within the list. 
  

Delete Deletes the currently selected (marked) item form the list. 
  

Move Up    The position of the item currently selected can be moved in the list. 
  

Move Down The position of the item currently selected can be moved in the list. 
  

To Standard The isometry (3D transformation) associated with the selected entry within the 

 project specific list will be copied (as additional entry) to the application wide 

 list (Standard). 
  

To Project The isometry (3D transformation) associated with the selected entry within the 

 application wide (Standard) list will be copied (as additional entry) to the 

 project own list. 
  

Projekt Exposes the list of project specific isometries 
  

Standard Exposes the list of application wide (standard) isometries 
  

 

 

 
Remark: Hold one of the modifier keys (Alt, Ctrl or Shift) depressed while pressing "Apply" or double-clicking the choice to 
view animated transformation of the position. The duration of the animation is set via the advanced application setting 
"DesiredFlyToSeconds". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Functions of the context menu 

 

The display of the list has a context menu attached (exposed when right mouse button 
is pressed): 
 
 

 

            
 

 

The selected isometry is applied to all 3D windows: Elements 3D window, Elements 23 window, Results 3D window 
 
 
Remark: To retain the list of isometries of the project between application executions you must save the project! 
 
Remark: The application wide list of isometries (Standard) will be saved with application settings (at application's exit). 
 
See also: Results 3D window, Elements 23 window, Results 3D window, 3-D Navigation (control panel), Settings file 
AnTherm.exe.Settings.xml, Settings - various (dialog) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Apply 
Initiates repositioning the current view to the position (3D transformation) 
currently marked within the list. 

Edit Details... 

Transformation data of the currently selected item can be edited in detail 
and adjusted according to specific needs. 
Remark: This is an advanced function. Naming chosen for distinctive 
parameters shall be self explanatory. 

Pick from 
Project... 

The list of project specific isometries saved within some another project 
will be imported (appended) to the current project's list. 
Remark: This function is available in the "Project tab" only. 

Move Up The position of the item currently selected can be moved in the list. 

Move Down The position of the item currently selected can be moved in the list. 

Delete Deletes the currently selected (marked) item form the list. 

To Standard 

The isometry (3D transformation) associated with the selected entry 
within the project specific list will be copied (as additional entry) to the 
application wide list (Standard). 

To Project 

The isometry (3D transformation) associated with the selected entry 
within the application wide (Standard) list will be copied (as additional 
entry) to the project own list. 

http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
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Active (setting) 

 

With the switch Active you define if the particular part of evaluation is created and eventually visible. 
 

The setting is available for following evaluations : 

 

 Outline  
 Model and Model Slices  
 Surface and Surface Edges and Surface Slice Edges  
 Slice X, Slice Y and Slice Z  
 Isolines (Isotherms)  
 Isosurface  
 Streamlines  
 Vectors (HedgeHog, Arrows)  
 Colorbar  
 Probe  
 Profile  
 Axes (also Axis X, Axis Y and Axis Z)



Remark: Some combinations of evaluations are only possible if some other parts of evaluation are simultaneously 
active. Such prerequisite dependency examples are:



 Isotherms on top of a slice plane X are only visible, if both evaluations, Isolines and Slice X, are active.  
 Isolines on top of component's surface - both must be active to receive the visual result.  
 etc.



See also: Results 3D window, Opaque (setting), Solid (setting), Colorize (setting) 
 
 
Opaque and Opacity (setting) 

 

The setting Opaque and the Opacity define the level of translucency of graphical objects shown. 
 

An opaque Object is not translucent. It fully obscures objects located behind it. 
 

When the switch Opaque is turned off, one can set the partial opacity / transparency of the respective 
object. The value of opacity is in the range of 0 to 1: 

 

 0 - no opacity, the object is fully transparent (and thus "invisible" also!) 

 1 - full opacity, the object is opaque, obscures and hides all objects "behind" it. 

 
When the value within an interval is chosen (e.g. 0.3) the particular object ist still visible, but thanks to its transparency 
(translucency) does not obscure nor hide object behind it allowing them to be visible also. 
 
The setting is available for following evaluations:    

 

 Outline  
 Model and Model Slices  
 Surface and Surface Edges and Surface Slice Edges  
 Slice X, Slice Y and Slice Z  
 Isolines (Isotherms)  
 Isosurface  
 Streamlines  
 Vectors (HedgeHog, Arrows)  
 Colorbar  
 Axes 



Remark: The opacity will be automatically set to 0.1 when the user unchecks 
the Opaque-switch while the original opacity value was left at 1.0 - this provides 
transparent visualization immediately after the user requests transparency 
(but has left the opacity value at 1.0). 

See also: Evaluations, Results 3D window, Active (setting), Solid (setting), More Light 
 
 

http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Result3DForm/Umriss.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Profil.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Result3DForm/Umriss.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

               257 

 
 

Colorize (setting) 

 
 
 
 

The setting Colorize define the colorizing of a particular graphical object.  

The setting can have one of the three distinct states: 

Checked 
Colour 
table 

Colorizing follows the currently selected Colour 
table (or element's properties in model view) 

Partly 
checked 

Dark 
The object is coloured with some dark (nearly black) 
colour 

Unchecked Bright 
The object is coloured with some bright (nearly 
white) colour 

The setting is available to following evaluations : 

 Outline 

 Model and Model Slices 

 Surface and Surface Edges and Surface Slice Edges 

 Slice X, Slice Y and Slice Z 

 Isolines (Isotherms) 

 Isosurface 

 Streamlines 

 Vectors (HedgeHog, Arrows) 

Example: An interesting ability exists when willing to show white isolines over colorized (by value) component's surface, 
while emphasizing component's edges in black. 

See also: Evaluations, Results 3D window, Active (setting), Solid (setting), More Light, Colorbar (control panel), Colour scale / 
Colour tables, Fixed Range (setting) 

 
 
 
 
 

http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Result3DForm/Umriss.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm#Schnitt Kanten
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala_Farbtabellen/Farbskala_Farbtabellen.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala_Farbtabellen/Farbskala_Farbtabellen.htm
http://help.antherm.eu/Forms/Result3DForm/FixedRange/FixedRange.htm
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Fixed Range (setting) 

 

Activating the switch "Fixed Range" (here referenced in the context ColorBar by example) allows to override (fix) the 
current value range of the active evaluation function. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

 
If "Fixed Range" is turned OFF (default) the overall value range, calculated out of the domain of current values set of the 
active evaluation function, is displayed at the top and bottom of the panel and is customizable. This domain is subject to 
automatic adjustment whenever the different active function is chosen, boundary conditions or time point of evaluation 
are changed or the project itself has been modified.  
Because the "Min/Max" interval boundaries must always stay within this domain, they might be modified automatically too 
(e.g. if the currently set minimum underflows new data of the active function after some change to the boundary 
conditions). 
 
When the "Fixed Range" is ON the domain range is entered manually (overridden) and remains invariant, independent of 
currently evaluated data set or the project.  
Important: The domain can supplied separately for any active function and will be retained as function specific setting. By 
thy the "Min/Max" interval boundaries will not be varied too. 
 
Remark: With any new boundary conditions the "Min/Max" interval boundaries will not change (the domain range will 
eventually be extended but never it will shrunk). 
 
For example this can keep the setting of colour bar used for evaluation of temperature field independent of the project or 
boundary conditions always in -10/20°C and for the purpose of pressure difference in -5/5hPa. In the combination with 
function specific choice of colour table this leads to optimal and comparable visualization of results, even for different 
projects. 
 
 
See also: Colorbar (control panel), Isolines / Isotherms (control panel), General (control panel) 
 
 

http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
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Probe Points / Extreme (min/max) Locations window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

The window Probe Points is used to input any number of arbitrary points for which the Probe Points report shall be 
generated (second part of Results report). The list of probe points can be extended from the Result 3D window (Probe) 
also (by "Collect point"). 
 
The Min/Max tab of the window lists interesting locations with extreme values (e.g. points lowest and highest temperatures 
at surfaces of all spaces and within the interior of all power sources) thus providing the ability to select them for further 
evaluation. This read only listing is automatically provided and updated as soon as any boundary conditions have been 
applied to the solution. 
 
 
 
 
 
 
 
 
 

 

 

X, Y, Z Coordinates of the point in millimetres 
  

Comment An (optional) description of the point entered (used for documentation only) 
  

Delete/New Deletes the current data line or append a new one 
  

Pick from Project... Probe points saved within another project will be read and appended to the list. 
  

Report Confirms the data entry and initiates the creation of probe points in the Results report. 

  
Double click onto Initiates translation of the current probe point shown in the Result3D window to the position shown 

data record mark in the line clicked - it translates Slices X/Y/Z accordingly. Within a 2D-project the Z-slice is set to 

 500 mm. 

Go To 
Remark: It is data shown in the currently marked line transferred - this means, that a double click  

 onto column or new row will also result in setting the current probe point to values shown selected 
 by data mark arrow. 
  

 

The input is confirmed by pressing the button Apply. The second part of Results report  
will show evaluation of temperatures for all points (x, y, z coordinates) entered in this window. 
If some point does not belong to the interior of the construction no temperature values will be 
shown in the corresponding line of the report. 
Probe points entered are saved to the project file. 
Remark: Similar evaluation of one probe point is available within graphical results of the application. 

Remark: The active tab will be saved upon the window is closed together with the application settings 

(LastSelectedProbePointsFormTabPageName) and restored when this window is opened again. 
 
Remark: While "Collect Point" (e.g. out of "Results 3D window") is requested the window will switch to the "User" tab 
where the new probe point will be appended. 

 

See also: Results report, Boundary Conditions window, Evaluation windows, Probe (control panel), Coordinate system, 
Slice X, Y, Z (control panel), Timelines window 
 

http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/CoordinateSystem/CoordinateSystem.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

269 
 

 
 
Results3D Parameter window 
 
The window Results3D Parameter shows the list of collected 3D evaluation and 
visualization settings parameters. Nearly all parameters set within control panels are 
retained here as list entries. Parameters specific to evaluation function are not influenced 
from this window. 
 

Collecting new Results3D parameters is initiated from the Results3D window with 
the button Collect Params (in the control panel General) or from the View menu. 

 
The set of parameters shown as an item in the list can be easily restored and applied to 
the evaluation view. 
 
The list of evaluation settings specific to the project is shown in the tab Project. The tab 
Standard shows the list of application wide evaluation settings. 
 

Label An arbitrary, editable, label of respective item in the list of parameters 

 (used for documentation and better, easier identification only) 

  
Double-Click Initiates the process of applying the combination of settings selected 
onto record-mark (marked line) to the 3D visualization. 

 Remark.: Settings applied are taken from the current row – i.e. even 

 if the click occurred within text of another line, the data applied is 

 taken from the line marked with the record mark (an arrow symbol). 
  

Apply Initiates the process of applying the combination of settings selected 
 (marked line) to the 3D visualization. 
  

Delete Deletes the currently selected (marked) item form the list. 
  

Move Up       The position of the item currently selected can be moved in the list. 
 

  

Move Down  The position of the item currently selected can be moved in the list. 
 

  

To Standard Settings combination associated with the selected entry within the 

 project specific list will be copied (as additional entry) to the 

 application wide list (Standard). 
  

To Project Settings combination associated with the selected entry within the 
 application wide (Standard) list will be copied (as additional entry) to 

 the project own list. 
  

Project Exposes the list of project specific evaluation settings 
  

Standard Exposes the list of application wide (standard) evaluation settings 
  

 

Functions of the context menu 

 

The display of the list has a context menu attached (exposed when right mouse button 

is pressed): 

 

Apply Initiates the process of applying the combination of settings selected (marked 

 line) to the 3D visualization. 
  

Edit Details... Setting combination of the currently selected item can be edited in detail and 

 adjusted according to specific needs. 

 Remark: This is an advanced function. Naming chosen for distinctive 

 parameters shall be self explanatory. 
  

Pick from The list of project specific evaluation settings saved within some another 

Project... project will be imported (appended) to the current project's list. 
  

Move Up The position of the item currently selected can be moved in the list. 
  

Move Down The position of the item currently selected can be moved in the list. 
  

Delete Deletes the currently selected (marked) item form the list. 
  

 
 
 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/SettingsForm/SettingsForm.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

270 
 

 

To 
Standard 

Settings combination associated with the selected entry within the project 
specific list will be copied (as additional entry) to the application wide list 
(Standard). 

To 
Project 

Settings combination associated with the selected entry within the 
application wide (Standard) list will be copied (as additional entry) to the 
project own list. 

 
 
 
 
 
 
 
 
 

Please note: Various settings listed in this window can be set within other control 
elements also. 
The position of slices X/Y/Z can be set from Probe points window (see also control 
panel Probe). 
The camera position (isometry) of 3D view can be set from Isometries window (see also 
control panel 3D). 
 
 
 
 
 
 
 
 
 
 
 
 
 

Remark: To retain the list and the evaluation settings of the project between application executions you must save the 
project! 
 
Remark: The application wide list of evaluation settings (Standard) will be saved with application settings (at application's 
exit). 
 
 
See also: Results3D window, General (control panel), application settings file AnTherm.exe.Settings.xml, Function 
specific evaluation parameters, Settings - various (dialog) 
 
 

http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
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Isometries window 
 

The window Isometries shows the list of collected 3D transformations of the 3D view. 
 

Collecting new isometries is initiated from the Results3D window with the button Collect  
Isometries (in the control panel 3-D) or from the View menu. 

 
The isometry shown as an item in the list can be easily restored and applied to the 3D view. 
 
The list of isometries specific to the project is shown in the tab Project. The tab Standard shows 
the list of application wide isometry settings. 
 

Label An arbitrary, editable, label of respective item in the list of isometries (used for 
 documentation and better, easier identification only) 
  

Double click Initiates repositioning the current view to the position (3D transformation) 

onto record clicked within the list. 

mark Remark.: Transformation applied is taken from the current row – i.e. even if the 
 click occurred within text of another line, the data applied is taken from the line 
 marked with the record mark (an arrow symbol). 
  

Apply Initiates repositioning the current view to the position (3D transformation) 
 currently marked within the list. 
  

Delete Deletes the currently selected (marked) item form the list. 
  

Move Up The position of the item currently selected can be moved in the list. 
  

Move Down The position of the item currently selected can be moved in the list. 
  

To Standard The isometry (3D transformation) associated with the selected entry within the 

 project specific list will be copied (as additional entry) to the application wide 

 list (Standard). 
  

To Project The isometry (3D transformation) associated with the selected entry within the 

 application wide (Standard) list will be copied (as additional entry) to the 

 project own list. 
  

Projekt Exposes the list of project specific isometries 
  

Standard Exposes the list of application wide (standard) isometries 
  

 

 

Remark: Hold one of the modifier keys (Alt, Ctrl or Shift) depressed while pressing "Apply" or double-clicking the choice to 
view animated transformation of the position. The duration of the animation is set via the advanced application setting 
"DesiredFlyToSeconds". 
 

Functions of the context menu 

 

The display of the list has a context menu attached (exposed when right mouse button is 
pressed): 
 

Apply Initiates repositioning the current view to the position (3D transformation) 

 currently marked within the list. 
  

Edit Transformation data of the currently selected item can be edited in detail and 
Details... adjusted according to specific needs. 

 Remark: This is an advanced function. Naming chosen for distinctive 

 parameters shall be self explanatory. 
  

Pick from The list of project specific isometries saved within some another project will 
Project... be imported (appended) to the current project's list. 

 Remark: This function is available in the "Project tab" only. 
  

Move Up The position of the item currently selected can be moved in the list. 
  

Move Down The position of the item currently selected can be moved in the list. 
  

Delete Deletes the currently selected (marked) item form the list. 
  

To Standard The isometry (3D transformation) associated with the selected entry within 
 the project specific list will be copied (as additional entry) to the application 
  

 

To Project 
The isometry (3D transformation) associated with the selected entry within the 
application wide (Standard) list will be copied (as additional entry) to the project 
own list 

http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
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Please note: Various settings listed in this window can be set within other control 
elements also. 
 
The position of slices X/Y/Z can be set from Probe points window (see also control 
panel Probe). 
The camera position (isometry) of 3D view can be set from Isometries window (see 
also control panel 3D). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Remark: To retain the list and the evaluation settings of the project between application executions you must save 
the project! 
 
Remark: The application wide list of evaluation settings (Standard) will be saved with application settings (at application's 
exit). 
 
See also: Results3D window, General (control panel), application settings file AnTherm.exe.Settings.xml, 
Function specific evaluation parameters, Settings - various (dialog) 
 
 
 
 
 
 
 
 
 
Dialog windows 

 

Within various dialog windows the user is requested for immediate input or response. Usually the execution of the 

application is interrupted until the user provides and confirm the requested input or cancels the operation explicitly. 
 
Following dialog windows are shown within this application: 

 

 Save/Open a file  
 Print  
 Fine Grind parameter  
 Settings  
 Snap-To-Grid parameter  
 Solver parameter  
 Simulation folder cleaner  
 Colour  
 About info  
 Revolve to 3D parameters  
 Import of Image file (Image Underlay) 

 
See also: Editing & Input windows, Evaluation windows, Main Menu, The Main window 
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Snap-To-Grid parameter 

 

The alignment grid, if active, restricts values of coordinates which can be reached my moving element boundaries 
(element's editing markers) with the mouse in Elements 2D window. 
 
An alignment grid can be set in such a way, that, for example, it only provides integral coordinates (each 1 mm) or, for 
example, at every 10 mm, etc.  
Alternatively (or simultaneously) an alignment to already existing coordinates of the construction (within some snapping 
distance) can be requested also. 
 
With alignment (snapping grid) turned off movements of editing marker will result in coordinate values calculated by the 
inverse transform of pixel coordinates at the mouse position. This transformation can result in numbers with large number 
of decimal places which, in most cases, will not correspond to desired element coordinates. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Turn Snapping  Activates/deactivates the snap and align to grid function. 

On  It overrides the setting of specific alignment options below 

 

Alignment Grid 
 
Snap to Grid Activates/deactivates the snapping function on alignment grid. 
 

Positions of slignment grid lines can be calculated as follows:  
Grid_coordinate_N = Offset + Step • N 

where N is of integral type. 
 
Step X/Y/Z Defines the step of an alignment grid in millimetres. Must not be 0 (> 1.0e-20) 
 
Offset X/Y/Z Defines the starting point of an alignment grid in millimetres. 

 

Point alignment  

Snap to Activates/deactivates the snapping function onto coordinates of points already existing in the 

existing points construction. 
  

Distance Define the distance between the mouse position and neighbouring point coordinate below which 

 snapping to the point coordinate will occur. Above this distance no snapping is applied and any arbitrary 

 coordinate can be reached. 
  

 
 

Alignement functions be activated and deactivated from the context menu within Elements 2D window also. 
 
Settings of the alignment grid are saved together with application settings. 
 
See also: Elements 2D window, Application settings 
 
 
 
 
 

http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
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Assign To Group (Dialog) 

 

 

The dialog window "Assign To Group" offers input of any (eventually new) group name to which all selected alements 

shall be assigned. You can reach this dialog from the context menu of element editing "Assign→To New Group...". 

 
 
 
 
 
 
 
 

 

 
Remark: Group assignment is offered (for single elements) directly within Element Editor also. 
 
 
Group Name The name of a group to which all selected elements shall be assigned. 

 

 
Zuweisen The name entered will be assigned to all selected elements yet not in that group. The dialog window will 
ENTER- close. 

Taste  

 

 
Abbrechen Closes the dialog window without executing any assignment. 

ESC-Taste  
  

 
 

Remark: By entering the name of an already existing group only elements yet not in that group will be assigned. 
 
See also: Element Editor, Context menu of element editing 
 
 
 

http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
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Fine-Grid parameter (dialog) 

 

The fine-grid subdivides the model into small cells which are then used to solve the 
thermal equations during simulation. Creation of the fine-grid is controlled via fine-
grid parameters. Values offered by default have been preset in such manner, that 
for most usual cases none of them needs to be adjusted. 
 
Settings of the fine-grid process directly influence the size of the equitation system 
to be solved - the more detailed fine grid will create larger, eventually more 
complex, system of equations with higher number of cells to be balanced - that 
number is shown within the headings of evaluation reports. 
 
Important: Very fine and detailed gridding (discretization) does not automatically 
ensure higher precision of results. Too detailed discretization might lead to 
unnecessary and inefficiently long calculations or even to results with less 
precision. 
 
The most important setting of Start Step shall typically correspond to the 
thickness of thinnest thermally significant structure of the construction. As such 
higher subdivision of metal slabs is not advisable.  
The Maximum Step shall be significantly raised when models of large 
dimensions of homogenous structures are considered. 
 
The setting of Target Model Size is mostly used while benchmarking the precision of results, typically as last step during 
expertise process: 

1. coupling coefficients and the number of cells of a calculation shall be identified within its Coupling Coefficients 
report,  

2. for the purpose of additional calculation of results the Target Model Size will be requested at the half or at the 
double of the cell count reported earlier and the new calculation is executed,  

3. Coupling coefficients resulting from that second calculation (with half or double number of cells) are compared to 
the values received with the first calculation and respective precision criteria is validated then. 

 
This final process of validation the precision of results conforms to the requirements set by the Standard EN ISO 10211. 
Important: This validation is independent from the check of results precision provided within the respective section of the 
Coupling Coefficients report (the relative Close-Up Error). 

 

Start Fine Grid at: These are parameters defining starting criteria of the rasterizing process (creation of the fine 

 grid) 

 

 

Space Surfaces Rasterizing will be initiated with its start step at each space surface and continue towards 

 interior of the construction. 

 

 

Adiabatic Cut-Off Rasterizing will be initiated with its start step at each adiabatic cut-off plane (adiabatic 

Planes boundary) and continue towards interior of the construction. 

 (in earlier application versions also called "Cut-Off/Wonder" foil) 

 

 

Power Source Rasterizing will be initiated with its start step at each boundary line of any power source. 

Boundaries  

 

 

Material Changes Rasterizing will be initiated with its start step at boundary lines of different materials. An 

 additional start criteria is defined the quotient of conductivity values (lambda quotient). 

 

 

when λ, μ, ρ·c ratio Rasterizing will start with its start step at boundary lines of different materials (material change) 

above if the ratio of conductivity values (λ, μ, ρ·c values) of these materials is larger than the 

 magnitude entered here. 

 If the change of λ, μ and ρ·c is not significant (quotient is smaller the the value entered here) 

 rasterizing will continue with its normal coarsening process. 

 Remark: To force the rasterizing to start at each material change boundary set this parameter 

 <=1 

 Remark: The ratio (quotient) of conductivities of two materials is always calculated as the 

 division of the larger value by the smaller one, thus it always results in ratios values >= 1. 
  

  

http://help.antherm.eu/Forms/Auswertefenster.htm
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Step by:  
Start Step Rasterizing will start with this distance when starting criteria is matched at specific position. 
 Remark: This is not the smallest step within the resulting fine grid - smaller structures can result 
 relative position of elements and element dimensions also! 
  

Max Step The process of coarsening the fine grid away from start positions does not go beyond this 
 value. If applicable rasterizing will continue with this maximum value 
 Remark: This value can be estimated automatically if target model size (number of fine grid 

 cells) is chosen. 
  

Step Growth Factor At each further rasterizing step away from the position where the starting criteria has been 
 matched the step of fine grid (distance) is enlarged by that factor. 
 Remark: ≥ 1.0 
  

  
Suppress fine grid in Suppresses the process of fine grid generation in that specific axis direction. Resulting fine grid 
direction of X/Y/Z axis is then identical to minimal model grid. 
 Remark: The application automatically detects homogenous dimension of the model (in that 
 direction there will be no heat flow nor temperature gradients). If such direction is identified 
 already within minimum grid, fine grid generation in this direction is automatically suppressed 
 (regardless of the setting of the respective parameter here). 
  

Target Model Size:  
  

Target for Model Size When checked, one can request the target number of equations (cells). Rasterizer will then vary 
 the maximum step to match the size at its best 
  

# Cells Rasterizer will vary the maximum step by an iterative search until it reaches the number fine 
 grid cells within +/- 10% estimation range. 

 Remark: If the target number cannot be reached sufficiently (i.e. maximum step could not be 

 found satisfying other criteria), try to change the coarsening factor (step growth factor). 

 Remark: „Max Step“ will be varied between „Start Step“ and full model extent. If there is no 

 solution sufficiently matching the targeted criteria the most coarse fine grid (in the case the 

 target number was too small) or the finest fine grid (if the target was too large) will be created. 
  

  
Restore Default  Reset all rasterizer settings to values provided in the application settings 

  
Set As Default  Current project setting will replace values provided in the application settings. 

  
Pick from Project...  Fine Grid settings will be loaded from another project. 

 

Always show this  If checked the application will automatically reveal this dialog on each rasterizer run (in 

dialog automatically  preparation of each calculation).  
when required 
 

 
Fine Grid parameters are saved to the project file. 
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Detailed description of gridding procedure 
 

At first the application creates a "minimal grid" resulting from the overlapping of all elements. Overlapping of elements 
might result in removal of some elements if those are completely overlapped. The resulting model can be observed within 
the Elements3D window. The Modelling-Report will list all spaces, surfaces, power sources and materials actually used within 
final model. 
 
 
 
 
 
 
 
 
 

    

 
 

Then, the application "visits" all boundaries of the minimal grid (which represents elements entered) and identifies if they 
are one of: 

 Space surface (space boundary) 

 change of material 

 power source boundary 

 adiabatic boundary 
 
 
 
 
 
 
 

 

 
 

Having fine-grid parameters set, the application will start adding additional grid planes in both directions away 
from these boundaries: 

 initially with starting step  
 every next one in the distance enlarged by the step growth factor compared to the previous 

 until the maximum step size has been reached, which will be used to subdivide the rest of the model. 
 
 
 
 
 

 

 
 

This process is executed in all three Cartesian dimensions if not suppressed. 
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Solver parameter (dialog) 
 

 

The Solver Parameter Dialog provides ability to adjust control parameters 
controlling directly the process of solving the equation system. Values offered by 
default have been preset in such manner, that for most usual cases none of them 
needs to be adjusted. 
 
Provided the VAPOUR-Option and/or HARMONIC / TRANSIENT-Option are 
available the decision will be made here if solving Vapour Transfer and/or 
Transient problems shall be executed. 
 
The most important setting is given by the Termination Condition which defines 
the targeted precision of the solution. This parameter is directly connected to the 
resulting relative close-up error describing the quality and precision of results. 
Eventually making the Maximum Number of Iterations larger might be needed to 
obtain the solution at requested precision in one solution run. Further parameters 
are used to optimize the efficiency (computational time) of the calculation process. 
 
Within the Advanced -tab you can edit details of solver parameters or, for a very 
special case, adjust further advanced parameters. 
 
Remark: The decision if the solver shall run in parallel on multiple processors has to be done within application settings.  
 
 

                      

Control parameters of solution iterations (Iteration control) 
 

                                    

Termination 
condition (Delta) 

If the largest change of temperature (normalized onto value interval 0.0 - 1.0) is continuously below the 
value entered here then the iterations are assumed as being precise. 

Reducing this value leads to more precise results at cost of longer computational time. 

Within the application settings: Delta 
Value range: [5.0*10-14 , 1.0] 

Maximum number 
of iterations 

If the current number of iterations reaches the value entered here the solution process will be aborted 
without creating the solution. 

Remark: At each new run counting of iterations starts at 0. 

Since AnTherm Version 8 this value is fixed to 1 billion and cannot be changed by the user. 

Minimum number 
of iterations below 
Delta 

Defines the number of iterations at which the termination condition (delta) must be continuously 
satisfied prior to the assumption of precise solution and its final generation. 

Within the application settings: MinItNoBelowDelta 
Value range: [1 , 10000] 

Relaxation factor 
for initial 

Defines the value of the relaxation factor ω which is used during initial "StartItNo" of iterations. 

http://help.antherm.eu/Introduction/81_Dampfdiffusion.htm
http://help.antherm.eu/Introduction/82_Harmonic.htm
http://help.antherm.eu/Introduction/83_Transient.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
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iterations 
Within the application settings: StartOmega 
Value range: [1.0 , 2.0] 

Number of initial 
iterations 

Defines the number of initial iterations with constant relaxation factor "StartOmega" (executed prior to 
further iterations with varying relaxation factor). 

Within the application settings: StartItNo 
Value range: [0 , 1000000] 

Relaxation factor 
for final iterations 

Defines the value of the relaxation factor ω which is used during final "FinalItNo" of iterations. 

Within the application settings: FinalOmega 
Value range: [1.0 , 2.0] 

Number of final 
iterations 

Defines the number of final iterations with constant relaxation factor "FinalOmega" (executed after 
"MinItNoBelowDelta" iterations with varying relaxation factor continuously satisfied the termination 
criteria - i.e. result variation was continuously below termination delta). 
This smoothes the final temperature distribution in the solution. 

Within the application settings: FinalItNo 
Value range: [0 , 1000000] 

Number of 
Iterations for 
tracing the Delta 

Number of latest iteration steps to monitor the delta value changes. 

Within the application settings: DeltaTraceItNo 
Value range: [2 , 99], currently shall not be changed (read only) = 10. 

 

 

Control parameter of the dynamic adjustment of the relaxation factor (ω) (Releaxtion factor 
control) 
 

                             

Factor 
determining the 
largest relaxation 
factor ωmax 

Weighting factor used for calculation of largest relaxation factor ωmax which is larger than the optimal 
relaxation factor ωopt .  
ωmax =  ωopt - l * (ωopt - 1) * (ωopt - 2) 
Within the application settings: OmegaMaxFactor 
Value range: ≥ 0.0 

Factor 
determining the 
smallest 
relaxation factor 
ωmin 

Weighting factor used for calculation of smallest relaxation factor ωmin which is smaller than the optimal 
relaxation factor ωopt .  
ωmin =  ωopt + k * (ωopt - 1) * (ωopt - 2) 
Within the application settings: OmegaMinFaktor 
Value range: ≥ 0.0 

Number of 
iterations between 
ωmin and ωopt 

Defines the speed at which the relaxation factor is increased between iterations. 
Within the application settings: OmegaMinOptItNo 
Value range: [2 , 1000] 

Delta Trace ItNo Number of latest iteration steps to monitor the delta value changes. 
Within the application settings: DeltaTraceItNo 
Value range: [2 , 99] 

Number of 
iterations prior to 

Even if the over-relaxation starts to be divergent (instead of converting to stable solution) the relaxation 
factor ω will be reset to its minimum value ωmin after at least that defined number of iterations between 

http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Solver-Parameter
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reset (ω Veto) consecutive resets. 
Within the application settings: OmegaVetoItNo 
Value range: [2 , 1000] 

 
 

 
Control parameters for estimation of the optimal relaxation faktor (ωopt) 
 

Termination 
condition (Delta) 

If the largest change to elements of the eigenvector of the equation matrix is continuously below this 
value the estimation of the optimal relaxation factor  ωopt is assumed to be precise and used for further 
calculation. 
Within the application settings: OmegaDelta 
Value range: [5.0*10-14 , 1.0] 

Maximum number 
of  eigenvector 
iterations 

If the current number of iterations reaches the value entered here the estimation of the optimal 
relaxation factors ωopt is terminated and the result estimated so far (even if not precise enough) is used 
in further calculation. 
Within the application settings: OmegaMaxNoOfIterations 
Wertebereich: [0 , 1000000] 

 

 
Control parameters of vapour transfer calculation 
 

Compute Vapour 
Transfer Solution 

If checked the application will create the solution of vapour transfer problem also (if applicable). Usually 
used to suppress vapour calculation even if all data required for such is available but that specific solution 
is not required. 
Within the application settings: "Compute vapour transfer solution" 

Remark: This setting requires a valid license feature DAMPF2DIM or DAMPF3DIM. 

 

 
Control parameters of transient, periodic, harmonic calculation 
 

Compute 
Transient, 
Periodic Solution 

If checked the application will create the solution of the transient, periodic, harmonic problem also (if 
applicable). Usually used to suppress transient calculation even if all data required for such is available 
but that specific solution is not required. 
Within  the application settings: "Compute Transient Solution" 
Remark: This setting requires a valid license feature HARMONIC and/or TRANSIENT 

Year (365 days) 
Day (24 hours) 
Custom (seconds) 

Defines for which period length (year, day, custom) there will be harmonic computation executed. 
For the custom period enter the period length in seconds (1..99999999). 
Within  the application settings: "PeriodYearActive", "PeriodDayActive", "PeriodCustomActive" 
Remark: This setting requires a valid license feature HARMONIC or TRANSIENT. 
Remark: Additional period lengths can be entered, if required, within advanced solver parameters (in 
seconds). 

# harmonics 
Year/Day/Custom 

Defines how many harmonics for the respective period length shall be calculated for the harmonic, 
transient solution. 
Year: max of 365 harmonics, 
Day: max of 24 harmonics, 
Custom: max of 1000 harmonics. 
With HARMONIC option alone (without TRANSIENT option) only the maximum of first 6 harmonics will 
be calculated. 
Within  the application settings: "PeriodYearHarmonics", "PeriodDayHarmonics", 
"PeriodCustomHarmonics" 
Remark: This setting requires a valid license feature HARMONIC or TRANSIENT. 
Remark: Current implementation enforces same number of harmonics for every boundary conditions to 
be calculated regardless if that number of harmonics will be used during evaluation. 

                               

Force 
Recalculation of 
Solution 

The existing solution (if available for loading) will be marked as "not solved" and calculation will be 
started. The calculation will restart with already available results. 
This setting will not be saved and is reset on each run. 
Remark: Usually the calculation step is skipped if valid results are already available. This setting provides 

http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Solver-Parameter
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Solver-Parameter
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Solver-Parameter
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Solver-Parameter
http://help.antherm.kornicki.com/Datei/Lizenzdatei.htm#Features
http://help.antherm.kornicki.com/Introduction/82_Harmonic.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Solver-Parameter
http://help.antherm.kornicki.com/Datei/Lizenzdatei.htm#Features
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Solver-Parameter
http://help.antherm.kornicki.com/Datei/Lizenzdatei.htm#Features
http://help.antherm.kornicki.com/Forms/SolverParamsForm/SolverParamsForm.htm#ErweiterteSolverParameter
http://help.antherm.kornicki.com/Introduction/82_Harmonic.htm
http://help.antherm.kornicki.com/Introduction/83_Transient.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Solver-Parameter
http://help.antherm.kornicki.com/Datei/Lizenzdatei.htm#Features
http://help.antherm.kornicki.com/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.kornicki.com/Introduction/81_Dampfdiffusion.htm
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the means to force calculation to start at any case to, for example, repeat the final "smoothing" 
iterations. 

Restore Default Resets all solver parameters to the values define within application settings 

Set As Default Current solver settings are set as default and stored as application settings 

Pick from 
Project... 

Solver parameters are loaded from another project file. 

Always show this 
dialog 
automatically 
when required 

Solver parameters are loaded from another project file. 

 
 
  
Solver parameters are saved to the project file. 
 
Remark: Proper estimation of the optimal relaxation factor ωopt becomes very important for large and possibly converging 
slowly calculations. It is advised to adjust parameters used for controlling the estimation of optimal omega in such a way, 
that better estimation ωopt of is provided - reduce the termination condition of omega estimation (e.g. 10

-7
) and enlarge the 

maximum number of iterations used in this process (e.g. 5000). The preset value of only 250 iterations provides vary coarse 
estimation. Especially calculations of large cases with many spaces shall be run with well estimated omega because the 
process of solving by over-relaxation is executed repeatedly for each separate space! By using optimal relaxation factor the 
convergence behaviour of the solver will be sped up significantly! 
 

 

VAPOUR-option: Analysis of multidimensional vapour diffusion is only possible with an active 

VAPOUR-Option of the program.. 
 

 

 

 

Running Solver on multiple CPUs 

 

Running the solver on multiple CPUs enhances the calculation performance and thus (in most cases) reduces significantly 
the calculation time. Multi CPU (or Multicore) behaviour of the solver is controlled by respective application settings 
separately. 
 
 
MULTICORE-option: Speeding up computationally intensive jobs by distributing them on 

multiple processors or processor cores for parallel execution is only possible with an active 

MULTICORE-Option of the program. 
 
 

http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Feinraster-Parameter
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Standard Feinraster-Parameter
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Introduction/65_Overrelaxation.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Advanced Solver parameters 
 
Within the tab Advanced you can edit 
details of solver parameters. 
 
Parameter settings composed of several 
parameters are shown pre-pended with a 
small plus sign. A click onto the plus sign 
will expand the detailed list of these 
parameters and offer them for editing. 
 
The bottom part of the window shows 
explanations related to the parameter 
currently marked for editing. You can 
change the height of this description area 
by dragging the separator line shown 
above it. 
 
Important: Transient (harmonic) solver 
parameters are grouped together within the 
section "Transient Problem Solver". 
Parameters offered by default shall not be 
changed. Ability to modify these settings is 
provided for testing and diagnostics 
purposes only. 
 
 
 

  Control parameter of the transient, harmonic Solver 
  
PeriodDayActive Request harmonic calculation for the period of one day. 

 Default: False 
  

PeriodYearActive Request harmonic calculation for the period of one year. 
 Default: False 
  

PeriodsAdditionalString Request harmonic calculation for additional periods in seconds (separated by spaces). 
 Default: "" 
  

PeriodsCount Displays count of requested periods. 
  

PeriodString Displays the list of requested period lengths. 
  

iomegpars Currently no meaning. 
 Default: "/i0" 

 Important: Do not change. 
  

isorpars Iteration control of the transient, harmonic solver. 
 Default: "/O0 /o(1.20:-0.05) /d.0000001 /i300000 /I10" 

 Important: Do not change. 
  

isorpost Iteration control for final iteration of the transient, harmonic solver. 
 Default: "/O0 /o1 /d.0000001 /i300000 /I15" 

 Important: Do not change. 
  

Parameters displayed slanted will be passed verbose to the solver. Do not change. 
 

Remarks: 

 The highest number of periods the solver can process is limited to 2000. 

 Period lengths (also of the higher harmonics) are kept as integers (seconds, 1..99999999). 

 The "Periods" Array will contain more then only the fist 6 harmonics exclusively if TRANSIENT option is in place. 
Additional periods will be appended only if TRANSIENT is available. 

 
 
 
See also: Application settings, Fine Grid parameter, The over-relaxation, Solver window 
 
 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Introduction/65_Overrelaxation.htm
http://help.antherm.eu/Introduction/65_Overrelaxation.htm
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Revolve to 3D Params - dialog 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
      

 

   
 

 

The conversion by revolution of a 2D project to 3D model is defined by the parameters provided in this dialogue window. 
 
A 3D model is constructed by revolving the 2D object by 90° around vertical or horizontal rotation axis placed in the plane of 
the 2D model. The position of the axis relative to the 2D model defines the resulting 3D constructions. The option of clipping 
the 2D model to one side of the axis is also provided. 
 
Important: Remember to save the originating 2D model prior to executing the revolution. The operation is not reversible 
and cannot be undone. 
 
 

Revolution Axis Defines the orientation of the rotation axis the revolution shall be performed around. 

Direction Choose either X (horizontal) or Y (vertical) axis direction. 
  

Revolution Axis Sets the position of the axis in absolute coordinates. Typically it will be some adiabatic boundary at 

Position some model extent or any arbitrary position for specialized purposes. 
  

Revolved Axis Elements of the 2D model revolved are clipped to either side of the axis. If only one side is chosen for 

Side revolution elements clipped for the other side are not revolved. 
  

Z Offset The resulting 3D model is constructed in such a way, that the Z position of the revolution axis will be 

 kept equal with the axis position specified at first. Z Offset adds a post processing option to shift all 

 resulting Z coordinates in the 3D model by the offset specified. 
  

Revolve to 3D Executes the revolution using the current set of parameters 
  

Cancel Aborts the operation 
  

 

 

Examples 
 
Example 1: Following 2D model is once converted by revolution around the X axis at Y=2000mm (which is coincident 
with the adiabatic boundary at the top of the 2D model) 
 

http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
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The model below results from the same 2D model revolved around the Y axis at X=-1000 mm. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Example 2: The 2D model of a wall & floor junction (shown below) is revolved around the Y axis at X=1000 mm 
producing a 3D corner component available for further detailed modelling and thermal assessment. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Example 3: Component in connection with ground was prepared in 2D at first and then revolved to 3D (rotated around Y 
axis at X=4475 mm). 
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See also: Convert projects, Project types 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
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About dialog window 

 

The About dialog window displays current information related to the system environment, the application version, the 
license and copyright data. You reach the About window from the main menu, Help→About... . 
 
Remark: If the application executes within a demonstrational mode (if there is demonstrational license only available to 
the application), this window is exposed periodically in short time intervals. Purchasing a permanent or time limited 
license will turn this behaviour off. 
 
The window is divided in three parts, each of which can be sized arbitrarily. 

1. The first part, located at the top of the window, provides detailed information concerning the application license and 
validity of the license. This data is related to the terms and conditions of use of this application.  
In the case the application shows information about missing license or tells, that the license is not valid you might 
be using an illegal version of the application.  
Please immediately contact the vendor or copyright holder of the application in the case you see error 
messages in this part of the window.  
Within this information block you will also find listing of all hardware identifiers available for licensing corresponding 

to the physical equipment installed in your computer (network adapters, processors, disks, license dongles, etc.). 

2. The second part, located in the centre of the window shows valid vendor and copyright massages. 
3. The third part, located at the bottom of the window, displays data about the version of the application and current 

operating environment. This data might be helpful during problem analysis or to clarify technical questions. 

                                                   
Text shown (or parts thereof) can be selected with the mouse and copied to the clipboard (via the context menu) for 
further processing. 
Pressing the button "Copy Text to Clipboard" will copy text contents of all window parts onto the clipboard for further 
processing (e.g. to paste them into an e-Mail application). 
The button "Copy Text to E-Mail" will start default e-Mail application setup on your computer (if possible) and pre-fill fields 
"To:" and "Subject:" with preset values furthermore inserting the e-Mail body with contents of all text modules from all 
parts of the about window.  
The departure of the e-Mail itself must still be confirmed by the user within the e-Mail application explicitly and 
intentionally - AnTherm does not initiate e-Mail transfer by itself under no circumstances.  
Remark: The addressee of the e-Mail preset in your version of the application might be antiquated or even not valid any 
more. Please verify the "To:" field prior to dispatching the e-Mail to make sure that the departure of the message will 
work. 
Remark: Text contents will be determined within a background job. During that calculation period the copy buttons 
(clipboard, e-Mail) are shown disabled. 
Remark: Contents of all parts might scroll automatically line by line at the interval of about 1 second. To stop the scrolling 
click with the mouse within the text part of interest or onto the scrollbar of that part. 
 
See also: System requirements, License file AnTherm.HID, License terms and conditions 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Legal/Lizenzbedingungen.htm
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Simulation folder cleaner 
 

The simulation folder cleaner assists you by removal of folders 
storing intermediate simulation results created by AnTherm. 
During every calculation large amounts of tentative data is written 
to simulation results folder created for each project to speed up 
future repeated evaluations.  
You shall remove these intermediary data from your disc 
regularly to save space. The data can be recreated in full from 
the data stored within respective project file at cost of some 
additional calculation time. 
 
Using that cleanup tool consists of three steps: 

 
1. Identify directories (potentially) containing simulation 

results folders to search for.  
2. Select and mark for removal particular simulation results 

folders.  
3. Actually delete folders marked for removal. 

 
This tool can be requested from the menu Tools. 
 
Remark: This tool is used to manage the list of folders known to AnTherm as containers of simulation results folders 
updated on each calculation run.  
Important: During initial display of the window folders known to AnTherm are not searched automatically - the Refresh 
button will blink in short intervals. Please press the Refresh button to initiate the search - the application will block and 
show wait cursor during this period. Actually, the search process cannot be interrupted indeed. 
 
Remark: If the number of days passed since the last invocation of this tool is above the number set by the application 

setting "Simulation Folder Cleanup (Reminder)", then on the next application start-up a reminder message will be shown. 

 

 

Identifying folders potentially containing simulation results folders (search folder names) 
 

Top part of the window shows the list of directories to be later searched for simulation results folders. Initially the list 
shows folders known to AnTherm as containers of such simulation results folders which is stored within the application 
settings file and updated on each calculation run. 
 
 
 

Search 
folders 

Displays the list of directories expected to contain simulation results folders . 
Click onto an item to select it for eventual removal. Multiple selections are supported (use Ctrl- 
or Shift- key combination). 
Remark: Inaccessible directories are highlighted in red - you shall eventually consider removing 
them manually from the list. 

Add... 
Will expose the directory browser helping you in selecting an existing folder to add to the 
search list 

Remove 
Will remove selected items from the search list. 
Remark: Removing an item from the list will not delete that directory. 

Clear 
Will remove all items from the search list. 
Remark: Removing an item from the list will not delete that directory. 

 
 
 

Important: The search list resembles the application setting "Known simulation folder containers" which is currently 
edited in this tool. 
 
 
 
 
 
 
 

http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
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Searching for simulation results folders 

 

The central part of the window displays the list of folders found during the search and provides the means for marking 
them for removal also. 
 
On every change to the search list the application will search for simulation results folders in directories specified 
(actually only folders added to the search list will be searched to improve performance). 
Remark: Searching directories might last for several minutes - the application will block and show wait cursor during this 
period.  
Remark: The search cannot be interrupted. 
 
 

Refresh... 

 
Will execute full search within all search paths. 
 
Remark: On each change to the search list the search is executed automatically. 
 

Recursive search 

 
If marked, the search will include folders specified in the search list and all subdirectories of 
these folders. 
 
Remark: If the search list contains paths which are contained within the other some items 
found will be shown duplicate - this has no general impact on function of the tool currently. 

List of simulation folders 

 
Displays the list of simulation results folders found during the search in search folders 
together with its modification time (time of last calculation) and the time the project file 
was last written (also time of latest evaluation). 
 
Click onto an item to select it. Multiple selections are supported (use Ctrl- or Shift- key 
combination). 
Click on column title to update the sorting direction (initially items are shown not sorted). 
Check the Checkmark left to the folder name to mark it for removal. 
 
Remark: Orphaned simulation results folders (i.e. those lacking their associated project file) 
are highlighted in red and are automatically marked for removal. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
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Selecting and marking simulation results folders for removal 
 
 

The bottom part of the window provides the means for selecting and marking items for removal and deleting them finally. 
 
 

Selection buttons 
Remark: Selection does not mark items for deletion, its supports it only. 

Select orphaned Will select orphaned simulation results folders only (i.e. those lacking their associated project file). 

Select older than Will select simulation results folders by either their simulation time or the project time. 
days Number of days. Only folders older than number of days will be selected. 

by project time 
Selection of old folders is done by comparing the time the project file was last written (also time of 
latest evaluation) by default. If not marked (unchecked) the last simulation time will be used. 

Select all Will select all items 
Clear selection Will remove the selection from all items. 
Inverse selection Will reverse the selection on every item (those selected will become unselected and vice-versa). 
 
Marking for removal buttons 
Remark: Marking items for deletion does not remove items yet. 

 
Check 
selected 

Will mark selected items for removal. 

Uncheck 
selected 

Will remove the deletion mark from selected items. 

Check all Will mark all items for removal. 

Uncheck all Will remove the deletion mark from all items. 

Final Removal 

Delete 
checked 
items... 

Will start the process of irrevocable removal of items checked. You will be asked to confirm the request. 

If errors occurred during the actual removal process a dialog massage will show the error report after 
the process has been finished for all items marked for removal. Items deleted successfully will be 
removed from the list also. Items in error will stay marked in the list. 
Remark: Actual removal of simulation results folders might last for several minutes - the application will 
block and show wait cursor during this period. 

Warning: The removal process cannot be interrupted nor it is reversible.  
Remark: Removing simulation results folders does not influence the search list. Eventually you shall 
remove specific directory names from the search list manually if you do not expect them to contain 
simulation folders in the future.  

 
 
 
 
 
 

KnownSimulationFolderContainters (application setting) 
 
On each evaluation execution (and any potential calculation) AnTherm will add the parent directory of the project file (and 
thus the parent directory of the simulation results folder too) to the application setting 
"KnownSimulationFolderContainters". This provides the notion of folders being potential containers of simulation results 
folders and is retained between program executions (stored within the application settings file). 
 
The setting "KnownSimulationFolderContainters" is not managed within application setting window but within this 
"Solution Folder Cleaner" here. Folder names are shown as "Search folders" within this tool. 
 
Important: When the window of this tool is closed the application setting will receive contents of the list as entered and 
shown. This tool provides the only means to remove directories from that list (or add items to it) manually. 
 
 
 
 
 
 
 

http://help.antherm.kornicki.com/Datei/ArbeitenMitDateien.htm#Verzeichnis der Simulationsergebnisse
http://help.antherm.kornicki.com/Datei/ArbeitenMitDateien.htm#Projektdateien
http://help.antherm.kornicki.com/Datei/ArbeitenMitDateien.htm#Verzeichnis der Simulationsergebnisse
http://help.antherm.kornicki.com/Datei/ArbeitenMitDateien.htm#Verzeichnis der Simulationsergebnisse
http://help.antherm.kornicki.com/Datei/ArbeitenMitDateien.htm#Verzeichnis der Simulationsergebnisse
http://help.antherm.kornicki.com/Forms/SolutionFolderCleanerForm/SolutionFolderCleanerForm.htm#SearchFolderNames
http://help.antherm.kornicki.com/Forms/SolutionFolderCleanerForm/SolutionFolderCleanerForm.htm#SearchFolderNames
http://help.antherm.kornicki.com/Datei/ArbeitenMitDateien.htm#Verzeichnis der Simulationsergebnisse
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Heuristics used to identify simulation results folder 
 

The application uses following heuristics to identify a folder as an AnTherm's simulation results folder: 

 

 The name of the folder ends with „.dir“. 

 Following files exist within that folder at least:  
C.dat, dim.dat, I_.dat, J.dat, K_.dat, L.dat, L_.tmp, LS.tmp, N.dat, ROOMS.dat, S.dat, S_.dat, xyz.dat 

 
 
See also: Working with files, Settings file AnTherm.exe.Settings.xml 
 
 
 
Please Wait window 

 

 

This window is shown during long lasting jobs. 

 
 
 
 
 
 
 
 
 
 

 

 

 

The number in braces shows the count of background jobs which have to be waited for. At the bottom of the window 
short information about executed jobs might display optionally. 
 
While this window is shown no further interaction with the program is possible by intent. Please wait... 
 
Note: Under certain circumstances the application will start several evaluations executing simultaneously and 
asynchronously. When run on weaker computer systems this might lead to over utilisation of resources or even program 
lock up. To turn off such asynchronous execution of evaluations and let the program execute them synchronously, one after 
another, please change the application setting "Asynchronous Evaluation Builds". 
 
See also: Results 3D window, Results report, Coupling Coefficients report 
 
 
 

http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
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Tip of the day (Dialog) 
 

The Tip of the Day displays some useful information within a dialog window. This hints are mostly helpful to new users of 
AnTherm, but even experienced users shall revisit this window from time to time to receive new short informations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

The dialog window is shown automatically on each application start (this can be turned off) or from the Help Menu "Tipp 
Of The Day...". 
 
 

Show Tips Having this checkmark set the dialog window will show at each application start.  
on Startup Remark: This switch can be be turned off only after all tips have been shown several times. This shall  

emphasize the importance of those tips for new users. (All tips have been watched at least 2 times for at  
least 10 seconds in average; or the user clicks 10 times through all tips. Data is stored within  
ApplicationSettings/UsageStatistics). 

 
Next Tip Show the next tip.  
ENTER-key  Remark: After showing all text components installed with the program first tip will be shown again. 
 
Schließen Closes the dialog window.  
ESC-Taste 
 
 
 

Remark: Additional information linked from the displayed content are often located on the internet. To display these 
additional content internet connection is needed. 
 
See also: Help Menu, Tutorials and Cookbooks 
 
 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
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Settings - various (dialog) 

 

 

Detailed editing of parameter, settings and options for which there is no specific data entry window will be done by this 
window. 

 
 detailed editing of Results3D Parameters of the graphical evaluation,  
 detailed editing of Isometries window of the graphical evaluation,. 

 
Remark: The Application Settings are separately available within the Application Settings Dialog. 
 
Parameters which are composed of a set of detailed settings are shown with a plus symbol to the left of the parameter 
name. A click onto the plus symbol will expand the list of detailed setting offering them for editing. 
 
The bottom part of the window displays the description of the parameter currently selected. The height of this part of the 
window can be adjusted by dragging the splitter bar. 
 
Settings shown and adjusted in this window are applied immediately to the application. Changes may also propagate to 
further settings. Changes to some parameters require an application restart (e.g. User interface language) - if so it is 
emphasized in the description specific parameter. 
 
Hint: To restore the value of any respective parameter to its default use its context menu (right mouse button) and select 
"Reset". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

See also: Results3D Parameter window, Isometries window, Application Settings (dialog) 
 
 
 
 
 
  

http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
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Leitwert Lambda Equivalent Calculator (Lambda-EQ Tool ) 
 
 
Objective  
 
 

The Lambda Equivalent Calculator (Lambda-EQ tool) is used to calculate the thermal conductivity of a component consisting 

of a building material with a simplified replacement model of thermal separation (equivalent Lambda of the simplified 

model), in such a way that the thermal conductance of the simplified model must be equal to the conductance of the detail 

model. 

If necessary, the detail model is available as a 3D construction, the simplified model as 2D only. In such a case L
3D

/dZ = L
2D

 

must be used. 

 

By variation of the building material property, the lambda-eq of a building material is to be calculated iteratively for an 

inputable or calculated thermal coupling coefficient (target value) in the two-room case. 

 
Detail model (“Isokorb” K50CV35h200) Equivalent model (Insulating block) 

 
 
 
 
 

 

==> 
 
 
 
 
 
 
 

 

==> 
 
 
 

 

L
3D

 detail  = L
3D

 simple ( λeq ) 

 

 

The target conductivity value can be set as follows: 

 

 Calculation from the current project (ProjectDetailName empty) 

 Calculation from the specified project ProjectDetailName 

 Numeric input (ProjectDetailName empty) 

 

The thermal conductivity SimplifiedLambda of a building material SimplifiedMaterialNameToVaryLambda of a simplified 

model is to be calculated. 

The resulting conductance SimplifiedLeitwert of the simplified model shall differ only slightly from the target conductance. 

The specification is made with the relative deviation SimplifiedConductanceIterationMaxRelativeDelta related to the 

magnitude of the conductance. 

The simplified model can be specified as follows: 

 Construction from the current project (ProjectDetailName empty, ProjectSimplifiedName empty) in which elements 

from the DetailGroupToRemove group are removed (the elements SimplifiedMaterialNameToVaryLambda are retained, 

however) 

 Construction from the specified project ProjectSimplifiedName in which elements are removed from the 

DetailGroupToRemove group (the SimplifiedMaterialNameToVaryLambda elements are retained) 
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The iterative process ends when: 

 The desired accuracy (precision) SimplifiedLeitwertIterationMaxRelativeDelta is reached (success) 

 
•       The specified maximum number of iterations SimplifiedLeitwertIterationsMaxCount is reached (no result) 
 
 
 
                                 

                            
 
 

When calling the Lambda-EQ tool from the menu, the current project must first be saved. 

 

When exiting the tool, the project is restored (read in from the file). The settings and results made in the tool are 

automatically saved in the project (automatic saving again). 

 

Reset Resetting the control parameters to their default values 

Undo Resetting the control parameters to the values when the dialog is opened 

Cancel Abort the function 

Start Starting the calculation 

Done/Save Save settings and results in the current project 
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The Settings 
 
 
 
 
Target Data: 
 

ProjectDetailName 

(optional) Name of the project of the detail model for the calculation of 
the Conductivity DetailLeitwert. 
If empty, then the project currently being processed is used. 
Default: empty 

DetailLeitwert 

(optional) The thermal coupling coefficient of a detail model (and the 
target variable which is to be approximated by the conductance 
SimplifiedLeitwert of the simplified model 
If empty or 0, it is used for the detail model (ProjectDetailName or current 
project). 
If not empty, it is calculated with the conductance of the detail model 
(ProjectDetailName or current project). 
Default: 0 

ProjectSimplifiedName 

(optional) Name of the project of the comparison model (simplified 
model) for which the variation of the thermal conductivity 
SimplifiedLambda of a building material 
SimplifiedMaterialNameToVaryLambda results in one (approximately) 
identical thermal conductance SimplifiedLeitwert like the DetailLeitwert.  
If empty, the simplified model is created by removing the 
elements belonging to the group DetailGroupToRemove (but the elements 
SimplifiedMaterialNameToVaryLambda are not 
maintained) 
Default: empty 

DetailGroupToRemove 

(optional) The elements belonging to the group DetailGroupToRemove are 
to be removed from the simplified model (the 
Elements SimplifiedMaterialNameToVaryLambda are however 
maintained) 
Default: empty 

SimplifiedMaterialNameToVaryLambda 

(Mandatory field) Name of the building material from which the value of 
the Thermal conductivity SimplifiedLambda is to be adjusted (varied) until 
the thermal conductance SimplifiedConductance of the simplified model 
matches the conductance DetailLeitwert of the detail model except for a 
relative deviation SimplifiedLeitwertIterationMaxRelativeDelta. 
Default: empty 

 
Results Data: 
 

SimplifiedLambda 

 
(optional) The thermal conductivity of the building material 
SimplifiedMaterialNameToVaryLambda of the simplified model is 
assigned. In the course of the calculation, the value of the 
thermal conductivity SimplifiedLambda is adapted (varies) until the 
thermal conductance SimplifiedLeitwert of the simplified model matches 
the conductance DetailLeitwert of the detail model except for a relative 
deviation SimplifiedLeitwertIterationMaxRelativeDelta. 
If empty or 0 it is calculated. 
If not empty, it is inserted and checks whether it matches the desired 
accuracy criteria, and if not, recalculated. 
0 as result: the calculation failed. 

SimplifiedLeitwert 
The thermal conductance of the simplified model ... 
0 as result: the calculation failed. 

SimplifiedLeitwertAbsoluteDelta 
Amount of the difference between thermal conductance DetailLeitwert of 
the detail model and the SimplifiedLeitwert of the simplified model. 
0 as result: the calculation failed. 

SimplifiedLeitwertRelativeDelta 

Conductance deviation related to the amount of thermal conductance 
DetailLeitwert. 
In the course of the calculation this is compared with the accuracy 
criterion SimplifiedLeitwertIterationMaxRelativeDelta. 
0 as result: the calculation failed. 

 
 
Auxiliary Data: 

SimplifiedLambdaRangeMin 

In the course of the calculation, the value of the thermal conductivity 
SimplifiedLambda varies in the interval SimplifiedLambdaRangeMin to 
SimplifiedLambdaRangeMax. 
Default: 0.001 W/mK 
Should be < SimplifiedLambdaRangeMax 



Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

296 
 

SimplifiedLambdaRangeMax 

 
In the course of the calculation, the value of the thermal conductivity 
SimplifiedLambda varies in the interval SimplifiedLambdaRangeMin to 
SimplifiedLambdaRangeMax. 
Default: 1000 W/mK 
Should be > SimplifiedLambdaRangeMin 

 
 
SimplifiedLeitwertIterationsMaxCount 

The maximum number of iteration steps 
SimplifiedLeitwertIterationsCount in the course of the SimplifiedLambda 
search. 
Default: 50 

SimplifiedLeitwertIterationsCount 
The current number of iteration steps SimplifiedLeitwertIterationsCount in 
the course of the SimplifiedLambda search. 

SimplifiedLeitwertIterationMaxRelativeDelta 

The accuracy criterion and termination condition. The search for 
SimplifiedLambda is considered successful if the relative difference 
between the conductance DetailLeitwert of the detail model and the 
SimplifiedLeitwert of the simplified model (which is calculated from the 
thermal conductivity SimplifiedLambda) is below this limit. Default: 0.0001 
(also corresponds to ISO 10211) 

 
 
 
Further control elements 

 

Following control elements or settings are common to several parts of the application and collectively listed: 

 

 3D Navigation within 3D windows  
 Background colour (setting)  
 More Light (setting)  
 Solid or Wireframe (setting)  
 Copy image to clipboard (command)



See also: Results 3D window, Elements 3D window 

 
 
 
Toolbar of a Report window 

 

Report windows expose common toolbar containing following symbols: 
 
 
 
 

 Export report  
 Print report  
 Go to first page  
 Go one page back  
 Go one page forward  
 Go to last page  
 Go to page number entered  
 Search  
 Zoom (scale) the view 



 
Exporting the report



Reports can be exported (saved) into following document formats: 
 

 Adobe Acrobat PDF (.pdf) 

 Character Separated Values (.csv) 

 Microsoft Excel (97-2003) (.xls) 

 Microsoft Excel (97-2003) Data-Only (.xls) 

 Microsoft Excel Workbook Data-Only (.xlsx) 

 Microsoft Word (97-2003) (.doc) 

 Microsoft Word (97-2003) - Editable (.rtf) 

 Rich Text Format (RTF) (.rtf) 

 XML (.xml) 

http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
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

By pressing the symbol Export, (within the Toolbar), you can convert and save the report currently displayed into one of 
supported formats. 
 
While the report window is shown you can use the main menu's submenu File→Export→Report... to initiate export of 
report data. 

 

 

Printing the report 

 

The printing function is available via the button Print, within the Toolbar. 
 
While the report window is shown you can use the main menu's submenu File→Print... to initiate printing of current 
report. 

 

See also: Input report, Results report, Coupling Coefficients report, Modelling report, Evaluation windows, Evaluations 
and Results 
 
 
3D Navigation within 3D windows 
 
The imagery displayed in three dimensional rendering views can be controlled in various ways: 

 

 With the mouse  
 By keyboard shortcuts  
 With 3D control panel (within Results3D window)



In addition immersive stereo display rendering in various technologies can be requested. 
 
 
3D Navigation with the mouse
 

Graphics shown within 3D windows (Elements 3D, Results 3D) can be manoeuvred in virtual 3D space (rotation, translation or 
scaling) with the mouse easily. The level of display detail will be reduced during the motion if required. 
 
Remark: When the mouse pointer is located above some special objects within the view these objects can be specifically 
controlled directly in different manner then described here (e.g. position of the movable colour bar, moveable probe point 
X,Y,Z, moveable orientation marker). 
 

Place the mouse pointer over graphics view of the window: 
 

Left mouse key, drag: 
Press and hold the left 
mouse button, move the 
mouse pointer. 

 

A dragging action (holding down the left mouse button, then moving the mouse) rotates 
the view in 3D space.  
The view behaves as if it were attached to a virtual trackball whose centre is at the centre 
of the view window. The mouse cursor is attached to the part of the trackball that 
protrudes above the surface of the window. Similarly the view follows a virtual joystick 
held with the mouse while joystick behaviour is activated instead. 
You can switch between trackball- and joystick behaviour with keyboard controls. 
 

Ctrl + mouse wheel turn 
Hold the Ctrl key and turn 
the mouse wheel 
or: 
Ctrl + left mouse button, 
drag: 
Hold the Ctrl key and press 
and hold the left mouse 
button, move the mouse 
pointer. 

The 3D view is rotated around the axis in the geometrical centre of the view and 
perpendicular to the screen surface (rotation around the block axis, also called "Rolling"). 
You will need this function to flip the view "upside down" for example. 
 

Shift + left mouse button, 
drag: 
Hold the Shift key and press 

The view is translated in the plane of the window following the mouse pointer (translation, 
scrolling, panning in the view plane). 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/EingabeReportForm/EingabeReportForm.htm
http://help.antherm.eu/Forms/EingabeReportForm/EingabeReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm#LevelOfDetail
http://help.antherm.kornicki.com/Forms/Result3DForm/Farbskala.htm#Position und Größe der Darstellung der Farbskala
http://help.antherm.kornicki.com/Forms/Result3DForm/Probe.htm#MoveableProbePoint
http://help.antherm.kornicki.com/Forms/Result3DForm/Probe.htm#MoveableProbePoint
http://help.antherm.kornicki.com/Forms/Result3DForm/ThreeDee.htm#OrientationMarkerMoveable
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#Joystick Interaktor
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#Joystick Interaktor
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#Trackball Interaktor
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#Joystick Interaktor
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#Tastatur
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and hold the left mouse 
button, move the mouse 
pointer. 
 

Mouse wheel turn 
or: 
Shift + Ctrl + left mouse 
button, drag: 
Hold the Shift and the Ctrl 
keys and press and hold the 
left mouse button, move the 
mouse pointer. 
or: 
Right mouse button, drag: 
Press and hold the right 
mouse button, move the 
mouse pointer. 

The view is scaled (zoom-in and zoom-out).  
Scaling operation is executed relative to the geometrical centre of the 3d view in virtual 
space 
 

        Press the Fit button    

 

The position and scaling of the view will be adjusted in such a way, that the whole building 
component fits into the view. 
 

       Press the Reset button       

 

Resets the camera (viewer) position to its default state:  

 X/Y plane parallel to the view (window) plane.  

 Z axis points towards the viewer (perpendicular to window plane).  

 Y axis is oriented vertical and upwards.  

 X axis points to the right. 
Scaling of the view is adjusted accordingly to fit the whole component into the view. 
 

 
 
 
 
 
3D Navigation with the keyboard 

Graphics shown within 3D windows (Elements 3D, Results 3D) can be manoeuvred in virtual 3D space (rotation, translation or 
scaling) with the keyboard. Further settings of the displayed graphics can also be controlled and adjusted with the keyboard. 

Click once with the mouse onto the graphics part of the window to move the keyboard focus to it. 

Keyboard key             Function 

T  Trackball Interactor of the mouse - dragging the mouse controls the moves of the 3d view 

J  Joystick Interactor of the mouse - the position of the mouse in the view controls the direction and the speed of 
continuous movements 

P Perspective On/Off 

L More Light On/Off 

F Fit (also "NumPad 5") 

+ (Plus) Scale (Zoom) +10% (also "Numpad +") 

− (Minus) Scale (Un-Zoom) -10% (also "Numpad −") 

    

Ins Side view from the left 

Del Side view from the right 

Home Side view from the front 

End Side view from the back 

Page-Up Side view from the top (also "Enter") 

Page-Down Side view from the bottom 

Enter Side view from the top (also "Page-Up") 

  Remark: Hold one of the modifier keys (Alt, Ctrl or Shift) depressed while pressing the button to view animated 
transformation of the position. The duration of the animation is set via the advanced application setting 
"DesiredFlyToSeconds". 

    

http://help.antherm.kornicki.com/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#DesiredFlyToSeconds


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

299 
 

Numpad 5 Fit (also "F") 

Numpad + Scale (Zoom) +10% (also +, Plus) 

Numpad − Scale (Un-Zoom) -10% (also −, Minus) 

    

Numpad 6 Rotate to the right around the vertical axis, Azimuth -10° (also Right-Arrow) 

Numpad 4 Rotate to the left around the vertical axis, Azimuth +10° (also Left-Arrow) 

Numpad 8 Rotate upwards around the horizontal axis, Elevation -10° (also Up-Arrow) 

Numpad 2 Rotate downwards around the horizontal axis, Elevation +10° (also Down-Arrow) 

Numpad 9 Rotate to the right/upwards around a diagonal axis, Azimuth/Elevation, 7,07°/7,07° 

Numpad 7 Rotate to the left/upwards around a diagonal axis, Azimuth/Elevation, 7,07°/7,07° 

Numpad 1 Rotate to the left/downwards around a diagonal axis, Azimuth/Elevation, 7,07°/7,07° 

Numpad 3 Rotate to the right/downwards around a diagonal axis, Azimuth/Elevation, 7,07°/7,07° 

    

Ctrl + 
Numpad 6 

Roll to the right around the view (block) axis, -10° (also Ctrl + Right-Arrow) 

Ctrl + 
Numpad 4 

Roll to the left around the view (block) axis, +10° (also Ctrl + Left-Arrow) 

Ctrl + 
Numpad 8 

Roll to the right around the view (block) axis, -10° (also Ctrl + Up-Arrow) 

Ctrl + 
Numpad 2 

Roll to the left around the view (block) axis, +10° (also Ctrl + Down-Arrow) 

Shift + 
Numpad 6 

Translate (scroll, pan) to the right, -10 pixels (also Shift + Right-Arrow) 

Shift + 
Numpad 4 

Translate (scroll, pan) to the left, +10 pixels (also Shift + Left-Arrow) 

Shift + 
Numpad 8 

Translate (scroll, pan) upwards, -10 pixels (also Shift + Up-Arrow) 

Shift + 
Numpad 2 

Translate (scroll, pan) down, +10 pixels (also Shift + Down-Arrow) 

Shift + 
Numpad 9 

Translate (scroll, pan) diagonal to the right and upwards by 10 pixels 

Shift + 
Numpad 7 

Translate (scroll, pan) diagonal to the left and upwards by 10 pixels 

Shift + 
Numpad 1 

Translate (scroll, pan) diagonal to the left and down by 10 pixels 

Shift + 
Numpad 3 

Translate (scroll, pan) diagonal to the right and down by 10 pixels 

    

Right-Arrow Rotate to the right around the vertical axis, Azimuth -10° (also Numpad-6) 

Left-Arrow Rotate to the left around the vertical axis, Azimuth +10° (also Numpad-4) 

Up-Arrow Rotate upwards around the horizontal axis, Azimuth -10° (also Numpad-8) 

Down-Arrow Rotate downwards around the horizontal axis, Azimuth +10° (also Numpad-2) 

    

Ctrl + Right-
Arrow 

Roll to the right around the view (block) axis, -10° (also Ctrl + Numpad-6) 

Ctrl + Left-
Arrow 

Roll to the left around the view (block) axis, +10° (also Ctrl + Numpad-4) 

Ctrl + Up-
Arrow 

Roll to the right around the view (block) axis, -10° (also Ctrl + Numpad-8) 

Ctrl + Down-
Arrow 

Roll to the left around the view (block) axis, +10° (also Ctrl + Numpad-2) 

    

Shift + Right-
Arrow 

Translate (scroll, pan) to the right, -10 pixels (also Shift + Numpad-6) 

Shift + Left-
Arrow 

Translate (scroll, pan) to the left, +10 pixels (also Shift + Numpad-4) 

Shift + Up-
Arrow 

Translate (scroll, pan) upwards, -10 pixels (also Shift + Numpad-8) 

Shift + Down- Translate (scroll, pan) down, +10 pixels (also Shift + Numpad-2) 
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Arrow 
    

Shift + Home Translate (scroll, pan) to the left by 2/3 of the full window width 

Shift + End Translate (scroll, pan) to the right by 2/3 of the full window width 

Shift + Page-
Up 

Translate (scroll, pan) upwards by 2/3 of the full window height 

Shift + Page-
Down 

Translate (scroll, pan) down by 2/3 of the full window height 

    

S Provides switching between monocular view (standard) and several stereo viewing (binocular) modes. The 
setting change will be confirmed with a dialog message displayed. 
Remark: Eventually additional hardware and license extensions might be required. 
Remark: This setting requires a valid license feature STEREO3DVIEW 
Remark: This function will have no effect if there are no stereo modes available. 

 
 
Immersive stereo display rendering techniques 

 

By default 3D renderings are provided for monocular view onto 3D objects projected onto the display (monitor) plane either 
with or without perspective transformations. 
 
Binocular viewing is accomplished by providing different images to the left and right eye thus allowing for immersive depth 
perception. Some of the techniques require only very simple additional equipment. Others have more sophisticated technical 
prerequisites which must be fulfilled to use them. 

 
 
Implementation provided monocular and binocular rendering modes  
 mono (no Monocular view (standard). True Color  No additional equipment 
 stereo)    required 
    

 Anaglyph By using simple Red/Cyan Glasses the effect of true depth can Some Color Red/Cyan glasses 
 (Red/Cyan) be accounted.   required 
 Remark: By adjusting the anaglyph color mask different color   

 filter glasses can be used. The anaglyph color saturation can be   

 adjusted too.   
    

 Red/Blue By using simple Red/Blue Glasses the effect of true depth can be Monochrom Red/Blue glasses 
 accounted at the cost of colour quality (the image will be seen in   required 
 levels of gray).   
    

 Dresden For output to a Dresden-style display. True Color  Dresden type interlaced 
    display required 
    

 VRex For output to a VRex stereo projector. All of the odd horizontal True Color  Interlaced VRex type 
  (Interlaced) lines are from the left eye, and the even lines are from the right   projector required 
 eye. The user has to make the render window aligned with the   

 VRex projector, or the eye will be swapped.   
    

 Checkerboard For output to a checkerboard style display. True Color  Checkerboard type 
    interlaced display 
    required 
    

 Crystal Eyes Active stereo-mode display. True Color  Crystal Eyes type display 
    and active 3D shutter 
    glasses required 
    

 Left Eye Images shown in mono which shall be directed to the left and True Color  No additional equipment 
 (mono) right eye respectively can be used to create binocular views   required 
 Right Eye based on those two images but in some other stereo viewing   
 (mono) application.   
    

 

 

STEREO3D-option: Stereoscopic, binocular display of three dimensional evaluations is is only 

possible with an active STERO3DVIEW-Option of the program. 

 

Remark: Activating any binocular stereo modes will have no effect if there are no stereo modes available. 

 

http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#stereo
http://help.antherm.eu/Datei/Lizenzdatei.htm#Features
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Remark: Only passive stereo view types can be copied into the clipboard or image file. Disabling of stereo mode is only 
required for hardware dependant stereo types. 
 
Remark (technical): The anaglyph color saturation factor ranges from 0.0 to 1.0: 0.0 means that no color from the original 
object is maintained, 1.0 means all of the color is maintained. The default value is 0.65 and can be changed within 
application settings. Too much saturation can produce uncomfortable 3D viewing because anaglyphs also use color to 
encode 3D. 
 
Remark (technical): The anaglyph color mask values are two numbers which are bits mask that control which color channels 
of the original stereo images are used to produce the final anaglyph image. The first value is the color mask for the left view, 
the second the mask for the right view. If a bit in the mask is on for a particular color for a view, that color is passed on to the 
final view; if it is not set, that channel for that view is ignored. The bits are arranged as r, g, and b, so r = 4, g = 2, and b = 1. 
By default, the first value (the left view) is set to 4, and the second value is set to 3. That means that the red output channel 
comes from the left view, and the green and blue values come from the right view. This can be changed within application 
settings. 
 

 
See also: Elements 3D, Results 3D, Evaluations and Results, 3-D Navigation (control panel), TrackBall Rotation 
 
 
 
 

http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
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Trackball and Joystick Rotation 
 

 

You can adjust the position of the 3D view according to your 
needs. 
 
A dragging action (holding down the left mouse button, then 
moving the mouse) rotates the view in 3D space. 
 
The view behaves as if it were attached to a "virtual trackball" 
whose centre is at the centre of the view window. The mouse 
cursor is attached to the part of the trackball that protrudes 
above the surface of the window. 
 
While the trackball interaction mode is active, the view 
movements follow movements of the mouse. 
 
While the joystick interaction mode is active, the distance of 
the mouse pointer from the centre of the view controls the  
directions and the speed of continuous movements of the view (occurring while the mouse button is held down, without 
the need of mouse movement itself). 
 
Remark: You can switch between the two interaction modes (trackball or joystick) with keyboard controls of 3D view. 

 

 

 

Level Of Detail (LOD) and rendering performance (fps) 
 

While the 3D view is interactively moved with the mouse the application will reduce the level of detail of the displayed 
entities if required. The desired view update rate (number of frames per second) will be managed as far as possible. As 
soon as the view stops moving (not being driven with the mouse anymore) the highest rendering quality will be applied 
again. 
 
The desired view update rate can be set within application settings. 
 
Remark: While considering very complex visualization switching to so called "Immediate-Mode" application setting will 
favour memory efficiency instead of speed. 
 
Following objects will be rendered in various levels of detail: 

 
 Isosurface,  
 Model,  
 Model slices (all three X,Y,Z),  
 Slices (all three X,Y,Z),  
 Streamline(s),  
 Vectors (HedgeHog, Arrows)  
 Surface 

 
There are three levels of detail: 

 

 The top level is just the normal data at highest quality 

 The middle level of detail is a point cloud of a fixed number of points that have been randomly sampled from 
objects 

 The lowest level of detail is a simple bounding box outline of the object 

 
Remark: Currently a very simple method of TotalTime/NumberOfObjects is used. 
 
Remark: On some graphics systems the point cloud rendering can result in points so small that they can hardly be seen. 
These hardware dependant behaviour cannot be controlled currently. 
 
See also: Elements 3D window, Results 3D window, 3D Navigation within 3D window 
 
 
 

http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

303 
 

 
 
Solid or Wireframe model (setting) 
 

 
By changing the setting "Solid" you can decide if graphical representation is displayed as solid model or as 
a wireframe (lines) model. 

 
While this setting is turned on, all volumes and surfaces are shown as 
such. 
 
 

If this setting if turned off, all 

volumes will be represented 

only by their edge lines and 

surfaces will be shown as a 

network of lines on top of 

which surfaces are spanned. 
 
This setting has no impact on 
how linear or point objects 
(like component edges, 
bounding box, axes) and other 
special object (e.g. colour bar, 
probe text) are displayed (and 
is meaningless for such kinds 
of objects). 
 
This setting can be applied to the following evaluations:  

 
 Surface  
 Slice X  
 Slice Y  
 Slice Z  
 Streamline  
 Vectors (HedgeHog, Arrows)  
 Isosurface 

 
See also: Elements 3D, Results 3D, Active, Opaque, Colorize, More Light 
 
 

http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
http://help.antherm.eu/Forms/Result3DForm/Colorize/Colorize.htm
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Background colour (setting) 
 

 
 
By this setting you control the background colour used in graphical output. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
To change the colour of the background click onto the coloured button. Then select the colour from the colour dialog window 
- a standard operating system specific component.  
Select the colour of your choice an confirm your choice with Ok button. 
The background colour can be preset within application settings also. 
Remark: This setting has no impact onto background colour of images saved via the function "Copy Image...". Images placed 
onto the clipboard with the function "Copy Image..." are always recreated with white background colour. 
 
 
 
 
See also: Elements 3D,  Active (setting), Solid or Wireframe (setting), More Light (setting), Application settings 
 
 
 
 
 
More Light (setting) 
 
 

he setting "More Light" is used to turn additional "light sources" on making the resulting graphical 

representation look brighter or providing more contrast. Please observe, that by adding more light that  
way, some areas of the picture might be coloured in much brighter colours. This will be perceived as some kind of colour 
shift, which, under certain circumstances, leads to an over exposed image. 
 
Below you can compare two images created with the setting turned off and on: 
 
    
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.kornicki.com/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.kornicki.com/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.kornicki.com/Forms/SonstigeBedienelemente/MoreLight/MoreLight.htm
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Copy image to clipboard (command) 
 

 

Graphical views can be easily copied to the clipboard and transferred for further processing (e.g. for integrating 
images in reports) to any other application (pasted from the clipboard). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Pictures copied to the clipboard are always shown on top of white background ensuring correct printing quality. 
 
The size and proportions (aspect ratio of width to height) of the specially generated image can be defined within 
application settings. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

During the process of image creation the mouse cursor changes to a sand clock. 
 
Detailed description of clipboard usage is described within operating system help. See Exporting an image for further 
description of exporting images from this application. 
 
If the application setting "clipboard image Save-To-File option" is set to active (true) then you will be offered an option to 
save (export) the image into an image file (PNG, TIF, BMP, GIF, JPG) - a file-save-as-dialog will be presented. 
 
Remark: The option to save images placed onto the clipboard to a file can be set within application settings (Clipboard 
image Save-To-File option, AlwaysAskToSaveGrabbedImage). 
 
Remark: The meaning of the setting "Clipboard image Save-To-File option" can be reversed while the SHIFT-key is held 
depressed during a click onto the "Photo button". This means, that if the Save-To-File option is active saving the image to 
the file will not be offered if the Photo-button is depressed during the SHIFT-Key is held depressed. Opposite is also valid: 
During the Save-To-File option is not active (set to False) and the Photo-button is clicked while holding the SHIFT-key, the 
dialog offering saving of the image to a file will be presented in contrast. 
 
Remark: The 3D cursor widget and the orientation marker will be hidden temporarily and not rendered to the resulting 
export view. 
 
Remark: Saving images while in stereo mode might be eventually restricted (see "stereo display rendering"). 
 
See also: Elements 3D, Results 3D, Application settings, Exporting an image, Keep view aspect ratio 
 

http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Export/Bild_Export.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Export/Bild_Export.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Export/Bild_Export.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Working with files 
 

The software saves data entered by the user as well as calculated intermediary results into different, project specific, 
files and folders. 

 

 

Project files 
 

Data of each project is stored in so called "project files". For all project files the software expects and uses the file name 
extension ".antherm". It is under users' control choosing some different extension for certain purposes instead of the 
extension (".antherm") suggested by the program. 
 
The name of the project file must be unique within the folder it is saved into. Of course it is allowed to have project files 
with equal names saved to different folders. 
 
For the purpose of Data backup it is absolutely sufficient to make secure copies of project file. All data and settings required 
to reproduce any calculation results (even if requiring complete recalculation) and all project specific parameters are kept in 
the project file. 
 
Project file stores following data - provided this data has been entered: 

 
 description of the project,  
 materials,  
 surfaces,  
 elements or layers and its elements,  
 registration parameter of an image underlay (optional)  
 fine grid parameters,  
 solver parameters,  
 boundary conditions (including periodic data for each main period of transient calculation)  
 probe points,  
 isometries,  
 results3D parameters. 

 
The file name extension ".antherm" is signalling to the operating system, that it is the input file for AnTherm. A double 
click onto an AnTherm project file starts the application and loads the chosen file.  
Remark: Also dropping (drag & drop) a project file over the main application window will open that file. 
 
Opening or saving of project files is executed from the menu "File". All project data is also saved automatically at the 
beginning of each new calculation run or new evaluation. At any time project data can be saved by choosing the menu 
File→Save... . This is especially useful during evaluation to save current boundary condition for example too.. 
 
The software will offer the option to save data prior to any potentially destructive operation. This "safety" behaviour can 
be turned off in application setting by changing the value of the option "always ask to save project". 
It is recommended to save project data before executing following actions: 

 
 New project (2D, 3D, Schichten 3D),  
 Load, Load resent,  
 Import (waebru 2/3bt, acad/DXF, Heat2, Heat3, Kobru86)  
 Convert (to 2D, 3D, layered 3D)  
 Exit / closing the main window 

 
Remark: During the initial save operation the application will create the standard project folder and offer this in respective 
dialog as central storage point for project files. The name of this folder is defined by the application setting "Default project 
directory". 
 
Important: The overall path length of a project file (i.e. including drive and folder  
names L:\folderpath...\projectfile.antherm) is constrained by operating system limits. When the current limitation of 
Windows is taken into account together with path lengths required for the folder of simulation results and its contents the 
maximum path length of a project file must not exceed 220 characters. Simulation results will not be created if the path 
name is longer then 220 characters - the project has to be saved under different name or into different folder (with overall 
path length not exceeding 220 characters) to be able to obtain simulation results also.

http://help.antherm.eu/Forms/DescriptionForm/DescriptionForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/LayerBrowserForm/LayerBrowserForm.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/RegisterUnderlayImage/RegisterUnderlayImage.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/PeriodicDataEditorForm/PeriodicDataEditorForm.htm
http://help.antherm.eu/Forms/ProbePointsForm/ProbePointsForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Starten.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Folder of simulation results 
 

For each project AnTherm keeps tentative calculation results (simulation results) of calculations stored in a subfolder  
"<projectfile>.dir".  
This means, that for a project file named <name>.antherm there will be a subfolder <name>.antherm.dir storing 
simulation results. The project file and the related subfolder of simulation results accompany each other and therefore 
they share the name. 
 
The absence of a simulation folder signals, that there has been no simulation run yet. If the folder <name>.antherm.dir has 
been deleted by the user then, on the next request to show results of the project <name>.antherm, complete calculation 
run will be executed. Deleting the simulation folder can therefore be used to force full recalculation. Since all data required 
for reproduction of simulation results along with all project specific settings are kept in the project file, the loss of 
simulation folder does only mean, that additional time is required to repeat all the required computations. 
 
Contents of the simulation folder "<projektdatei>.dir" are fully managed by AnTherm - without any intervention required 
from user. The simulation results folder has special, application specific, structure and thus it is not designed to be accessed 
by the user directly. AnTherm creates this folder and, under certain circumstances, will purge its contents also without 
warning. For that reason no user specific files or data shall be placed into the folder "<projektdatei>.dir" ! Manipulating 
contents of the simulation folder might also break its data integrity leading to serious software malfunction - therefore it is 
forbidden!  
To avoid accidental manipulation AnTherm applies hidden attribute to each simulation results folder. This makes this 
folders invisible and unavailable for browsing within windows file explorer by default. Only if the user changes the setting 
"show hidden files and folders" within windows file explorer, simulation results folder will be shown therein. This specific 
setting of windows file explorer does also apply to results shown in the dialogs "Open project..." and "Save 
project". 
 
Note: Simulation results of a vapour diffusion computation also stored as a subfolder DAMPF within the 
simulations results folder "<projektdatei>.dir". 
 
For the purpose of Data backup it is under users control to save simulation results folder also - in addition to project file. If 
the project file <name>.antherm and its accompanying simulation results folder <name>.antherm.dir are together restored, 
the application has no further need for full computation of simulation results. 
 
The Simulation folder cleaner tool supports you in removing (physically deleting) unneeded simulation results folders to 
save disc space. 
 
Important: Calculation of a project with its name given by a UNC name (e.g. /server\path...\project.antherm) is not allowed. 
If the given UNC path name cannot be coupled with a temporary network drive the application will show explaining 
message accordingly. In general the calculation of a project on a network drive (connected by a drive letter) is possible but 
(due to significant performance penalties) not advisable. 

 

Variant calculation, renaming and copying of project file 
 

Under certain usage scenarios there might be the need to execute calculation of variants which differ only slightly by few 
parameters. In such a case it is the easiest to simply save the project with new name. However this results in the need of 
complete simulation calculation because the simulation folder does not exist yet for the new project name. 
 
Remark: The need for performing complete new simulation calculation results when significant input data or parameters of 
s project have changed: e.g. geometry of the construction, material and/or surface properties, names (tags) of spaces, 
power sources, materials or surfaces, fine grid parameters etc. This concludes that only under very rare occasions there will 
be no need for complete new simulation calculation to be executed. 
 
Still to avoid repeating simulation calculation when performing variant modifications one can copy the project file and its 
accompanying simulation results folder with simple tools of the operating system (e.g. windows file explorer, command 
line etc.): 

 

Variant scenario A: 

 

Use subfolders to store variants: copy the project file <name>.antherm and its accompanying simulation 
folder<name>.antherm.dir into a new folder. That way you receive a subfolder "Variant B" containing equally named copy of 
already calculated project and its simulation results from folder "Variant A". 

 

 

 

http://help.antherm.eu/Forms/SolutionFolderCleanerForm/SolutionFolderCleanerForm.htm
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Variant scenario B: 
 

Make a copy of the project file <nameA>.antherm and name it <nameB>.antherm. Make a copy of the simulation folder  
<nameA>.antherm.dir also and name it <nameB>.antherm.dir. That way you have an exact copy of project "nameA" and its 
simulation results folder, now both named "nameB". 

 

 

 

 

Miscellaneous files 

 

Beyond project files the application stores further information in additional, application specific, files: 

 
 Standard project template file projekt.xml  
 Initial template of window positions AnTherm.exe.LayoutPersistence.xml  
 Settings file AnTherm.exe.Settings.xml  
 Colour setting file LambdaToColor.ColorList  
 Material data base file Baustoffe.xml  
 License file AnTherm.HID 

 
This application is aware of importing files created with other applications: 

 
 Import of Image file (Image Underlay)  
 Import of DXF file  
 Import of WAEBRU component file  
 Import of Heat2 input file  
 Import of Heat3 text input file  
 Import of Kobru86 file 

 
There are some example project files included with the application's installation which can be used to execute tutorials and 
learn the program's use. These example project files can be found in the subfolder "Beispiele" (means "examples" in 
german) of the installation folder (typically C:\Programm\tkornicki\AnTherm\Beispiele) or can be directly loaded into 
AnTherm via the menu Help->Example Load... . 
 
Results created with the application can be exported for further processing: 

 
 The matrix of thermal coupling coefficients (conductance matrix, Leitwertmatrix) can be exported to a CSV file,  
 All reports can be saved as PDF, XLS, DOC or RTF file,  
 Graphical representations can be saved as picture file (PNG, TIF, JPG, BMP, GIF),  
 Graphical representations can also be transferred as pictures via clipboard to other applications,  
 Graphical representations can be exported 3D scene file (VRML, IV, OOGL, ...).  
 Animations can be recorded as video files (AVI). 

 
See also: The main menu, Tutorials and cookbooks, Simulation folder cleaner 
 
 
 

http://help.antherm.eu/Datei/Standard_projekt_xml.htm
http://help.antherm.eu/Datei/Startup_LayoutPersistence_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/LambdaToColor_ColorList.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Forms/RegisterUnderlayImage/RegisterUnderlayImage.htm
http://help.antherm.eu/Datei/Import/DXF_Import.htm
http://help.antherm.eu/Datei/Import/WAEBRU_Import.htm
http://help.antherm.eu/Datei/Import/Heat2_Import.htm
http://help.antherm.eu/Datei/Import/Heat3_Import.htm
http://help.antherm.eu/Datei/Import/Kobru86_Import.htm
http://help.antherm.eu/Tutorials/index.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Export/CSV_Export.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Export/Bild_Export.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Datei/Export/Szene3D_Export.htm
http://help.antherm.eu/Forms/AnimateTimeDialog/AnimateTimeDialog.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/SolutionFolderCleanerForm/SolutionFolderCleanerForm.htm
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User specific Logo CustomColorBitmap.bmp 
 

 
A user specific logo picture can be set in the application settings. The preset value uses an example file 
CustomLogoBitmap.bmp from the installation folder by default. 
 
The logo image is displayed in the heading of reports, as middle item of the heading, placed left to the Copyright-Info, 
6cm wide and 1.5cm high. 
 
 
 
 
 
 

 

 
 
Any picture file can be used (format BMP, GIF, JPG,...). 
 
To avoid distortion of the picture keep the width to height ration of 4:1 (for example 800x200 pixels). 
 

6,0 cm 
 
 

 

1,5 cm 
 
 
 
 

 

If one wishes that no logo picture is displaed on reports, simply leave the setting empty. 
 
Important: Under certain circumstanses the logo picture will be overlapped by the licensing information placed left to the 
logo. The example file "CustomLogoBitmap.bmp" shows the solution containing the logo itself placed on the right edge of the 
bitmap and allowing the left side of the image, which has been left in the background colour of white, to be overlapped by 
the license information by intent. 
 
See also: Application settings, Evaluation reports 
 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Standard project template file projekt.xml 
 

If the installation folder contains the file named projekt.xml and application settings chosen are not set to automatically 
reopen the latest project, this template project file will be automatically loaded on applications start. 
 
One can use this file to create your own "template project" containing some preset materials or text input to have them at 
your hand for new projects. 
 
This behaviour can be changed via menu function application settings directing AnTherm to automatically reopen the 
latest project instead of this template file. 
 
Remark: The preinstalled template file projekt.xml contains some example project and shall be modified by the user. 
 
See also: Application settings, Working with files 
 
 
 
 
 
 
Initial template of window positions AnTherm.exe.LayoutPersistence.xml 
 
On the absolutely first start of the application its windows will be shown at some tentative positions on the screen. These 
initial positions are defined by the pre-installed template file "AnTherm.exe.LayoutPersistence.xml" which can be found in 
the installation folder. The tentative layout provided assumes screen resolution of 1024x786 pixels. 
 
AnTherm will only read the file „AnTherm.exe.LayoutPersistence.xml“ is the application settings file  
AnTherm.exe.Settings.xml does not exist yet. During the application shutdown AnTherm saves window positions to the 
user specific settings „AnTherm.exe.Settings.xml“ and on subsequent executions only this file is being used!. 
 
Resetting the window positions to its initial, tentative, setting can be accomplished with the menu function 
Windows→Reset window positons. 
 
The format of this template file conforms to the section "LayoutPersistence" of the application settings file 
"Antherm.exe.settings.xml". 
 
See also: Application settings, File Antherm.exe.settings.xml 
 
 
 
 
 
 
 
Colour setting file LambdaToColor.ColorList 
 

The setting used for automatic colouring of material cells based on its thermal conductivity is kept in the file  
LambdaToColor.ColorList. 
 
The file can be found in the installation folder and is being automatically loaded at application start up. 
 
This text file starts with a header line (predefined content) followed by list of colours (ARGB Bytes) in sorted intervals of 
conductivity values (Double). 
 
 
The colouring according to the defined intervals of thermal conductivity (lambda) can be redefined by editing this file..  

See also: Application settings, Working with files, Element Editor 

 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
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Import of WAEBRU component file 
 

A component file created with the application package WAEBRU V6.0 can be imported into AnTherm and automatically 
converted into AnTherm project file nearly without any changes. 
 
Please observe following remarks: 

 
 A .2BT file (a two dimensional WAEBRU model) will be converted to AnTherm's 2D project .  
 A .3BT file (a three dimensional WAEBRU model) will be converted to AnTherm's layered 3D project .  
 If there is a raster-file corresponding to the imported WAEBRU component available within the same folder 

(name.2RA or name.3RA), rasterising parameters used to create this file (and stored within it) will be imported also 
and converted to fine grid parameters of the AnTherm's project.  

 Each "power source" element of a WAEBRU model is converted into two respective elements of AnTherm. The first 
one as a material element and the second element as power source extent of same dimensions - overlapping the 
corresponding material element.  

 Names of component groups and components assigned to elements within the WAEBRU file are converted to 
group assignments of each element.  

 Element coordinates stored within WAEBRU file are always read rounded at third decimal position.  
 Project description is transferred unchanged from WAEBRU file.  
 Reinforcing bars (neither diagonal nor parallel to axes) will not be imported in current version!  
 During the import of a WAEBRU file <name>.?BT AnTherm will also attempt importing a corresponding 

vapour model from a subfolder DAMPF (created with MueInp - an internal DAMPFBRU tool) thus loading 
the vapour transfer coefficients (µ) also.  

 If the imported WAEBRU file originated from an instationary (transient, harmonic) application variant of WAEBRU 
(iwaebru), AnTherm will import heat capacity and mass density (ρ and c) properties of materials 

 
Remark: Some imported WAEBRU component files can contain coordinate values saved with rounding errors due to (that 
time common) number representation. To compensate for such rounding errors AnTherm will always round coordinates 
read from the WAEBRU file at third desimal position (WAEBRU allows entry of only to decimal places, but it writes four 
decimal places to the file saved). Following arguments of the WAEBRU file are concerned: Ex1, Ex2, Ey1, Ey2, Edis, BGDicke. 
 
Remark: If the import from a WAEBRU file is not successful an error message will be shown. The resulting AnTherm 
project will be empty. 
 
Remark: A WAEBRU file can be dragged from windows file explorer and dropped over the main application window as a 
shortcut for quick import. 
 
See also: Working with files 
 



http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
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Import of Heat2 input file 

 

Components available as stored within HEAT2 input file can be easily imported as used as starting point for further 
modelling and simulation. 
 
Only material elements and empty boxes are imported from a Heat2 input file. 
 
Remark: An import of a Heat2 input file always creates a 2D project. 
Remark: The volumetric heat capacity will be imported into the Rho value. Ce will be set to 1.0. 

 

 

Post processing of imported data 

 

Because only geometry and conductivities of material elements are read from a Heat2 input file, but no boundary 
conditions (spaces, power sources), the project created by importing a Heat2 input file must be edited further prior to 
simulation. 

 

 

Post processing steps: 

 

 Enter project description. 

 Creation of spaces. Location of spaces connected to the model must be defined manually.  
Hint: The quickest possibility to add spaces is by inserting space elements at the top of element list, thus letting all  
other (imported) elements to overlap them accordingly. 

 
See also: Working with files, Editing windows (input windows), Element selection window 
 
 
 
Import of Heat3 text input file 

 

Components available as stored within HEAT3 text input file can be easily imported as used as starting point for further 
modelling and simulation. 
 
Only material elements and empty boxes are imported from a Heat3 text input file. 
 
Remark: An import of a Heat3 text input file always creates a 3D project. 
Remark: The volumetric heat capacity will be imported into the Rho value. Ce will be set to 1.0. 

 

 

Post processing of imported data 

 

Because only geometry and conductivities of material elements are read from a Heat3 text input file, but no boundary 
conditions (spaces, power sources), the project created by importing a Heat3 text input file must be edited further prior to 
simulation. 

 

 

Post processing steps: 

 

 Enter project description. 

 Creation of spaces. Location of spaces connected to the model must be defined manually.  
Hint: The quickest possibility to add spaces is by inserting space elements at the top of element list, thus letting all  
other (imported) elements to overlap them accordingly. 

 
See also: Working with files, Editing windows (input windows), Element selection window 
 
 
 
 

http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
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Import of Kobru86 file 

 

Components available within Kobru86 file (e.g. from the KOPRACTICE data set) can be easily imported as used as 
starting point for further modelling and simulation. 
 
Only material cells will be imported from a Kobru86 file. Position of imported space boundaries must be verified manually 
after import. 
 
Remark: The importing procedure uses text and material files (if contained within the directory structure) also. Two files, 
KOBRSTRI.TXT and MADB.TXT are looked for at each import within the directory at which the Kobru86 file is located. If 
either of this files cannot be found within this directory the search for these file continues in the parent directory. 
 
Remark: An import of a Kobru86 file always creates a 2D project. 
 
Remark: If the text file KOBRSTRI.TXT (space names), corresponding to the thermal heat bridge imported, cannot be 
found, AnTherm will set space names to "KOBRSTRITXT_LN=lineNo". 
 
Remark: If the text file MADB.TXT (properties of materials), corresponding to the thermal heat bridge imported, cannot be 
found, AnTherm will set material names to "MADBTXT_RN=refNo". 

 

 

Post processing of imported data 

 

Because importing of boundary conditions (spaces) from Kobru86 file is not fully automated, the project created by 
importing a Kobru86 file must be edited further prior to simulation. 

 

 

Post processing steps: 

 

 Enter project description. 

 Creation of spaces. Location of spaces connected to the model must be verified and eventually adjusted manually. 
Hint: The quickest possibility to add spaces is by inserting space elements at the top of element list, thus letting all  
other (imported) elements to overlap them accordingly. 

 
See also: Working with files, Editing windows (input windows), Element selection window 
 
 
 

http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

315 
 

Import of DXF file 

 

If there is a construction available as a DXF file (e.g. created with AutoCAD® or other CAD application), it can be easily 
imported and used as a template for creation of a two dimensional component model. 
 
Only specifically prepared DXF files can be imported. Only if a DXF file conforms to specific criteria it can be imported into 
AnTherm. 
 
To start the DXF file import, select the  
men File→Import→Acad-DXF. 
 
The file browser shown provides the ability to search 
for DXF files. Select the DXF file to import and press "Open"  
or double click onto the file requested. 
The DXF file is read in and all polylines are processed. 
Prior to actual conversion you will be shown an import settings dialog. 
The import settings dialog is used to control how the contents  

of the DXF file imported are interpreted by AnTherm. 

You shall define by which attribute materials or conductives 

shall be identified: either by layer name, the colour or  

the line respective polyline. If no specific material grouping defined 

during creation of the DXF file, select type of each has been "ignore". 

 

The dialog displays the count of polylines adequate for import 
(after the refine-step) and corresponding layer-, line- and  
colour names which shall be used for either material name 
assignment or grouping (if there are no line types or layer names 
defined within the DXF file "NoLineType" or "NoLayerName" is used). 
 
If the DXF file has been created with component grouping in mind 
also, then you can select this criteria within the block "group by". 
 
The setting "optimize number of elements" shall be left checked 
in most cases. The number of elements resulting from the 
conversion and transferred to AnTherm will be  
kept as small as possible by merging resulting elements if 
applicable. 
 
Check the field „Group polygons too“ only, and only then, if 
component areas surrounded by polylines within the DXF file shall  
be interpreted as component groups also. 
 
Select the lowest number of decimal places sufficient to precisely  
read and interpret the geometry saved within the DXF file. 
 
Press "Ok" to initiate the import of polylines and convert them to  
elements. 
 
Concluding the import of geometry data you will be asked if material 

properties of materials currently stored in the material's list shall be 

applied (replaced) by name on all elements of the imported model. 
 
 
 
Remark: One shall also include spaces, power sources etc. within the file to be imported and change the type of resulting 
elements later. 
 
 
AB Version 10 you have the possibility to import several 2D-DXF files into an existing project. Therefor position the imported 

elements by using "Transform / Move“, „Rotate / Window“. 

http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Datei/Import/DXF_Import_Voraussetzungen.htm
http://help.antherm.eu/Datei/Import/DXF_Import_Voraussetzungen.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
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DXF-Converting Setting 
File-Import 
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Post processing of imported data 
 

Because the imported DXF file provides only geometry data and naming of materials and groups, the data of the 
imported model must be post processed prior to further computations. 

 

 

Post processing steps: 
 

 Enter the text of project description. 

 Define spaces (boundary conditions).  
Typical CAD drawings contain only the component but lack location of attached spaces. Location of spaces 
connected to the model must be defined manually.  
Hint: The quickest possibility to add spaces is by inserting space elements at the top of element list, thus letting all  
other (imported) elements to overlap them accordingly. 

 Entry of heat conductance for materials.  
During import only material names are provided by the DXF file. 
See also: Replace Materials on All Elements (within the Materials window) 

 
Remark: The order in which polylines are stored in (and thus also imported from) DXF file does not follow the order they 
have been input within CAD application.  
Due to the fact, that elements imported will follow the order of polylines as they are stored within the DXF file, we advise 
you not to use element (nor polyline) overlapping! If necessary you will make the use of reordering functions (promote or 
relegate) of elements to reach needed overlapping effects. 
 
Remark: If the import from a DXF file is not successful an error message will be shown. The resulting AnTherm project will 
be empty. 
 
See also: Requirements related to DXF file, Element selection window, Materials window, Editing windows (Input 
windows) 
 
 
 

http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Datei/Import/DXF_Import_Voraussetzungen.htm
http://help.antherm.eu/Datei/Import/DXF_Import_Voraussetzungen.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
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Import of DXF file - Requirements 
 

If there is a construction available as a DXF file (e.g. created with AutoCAD® or other CAD application), it can be easily 
imported and used as a template for creation of a two dimensional component model. Only specifically prepared DXF files 
can be imported. Only if a DXF file conforms to specific criteria it can be imported into AnTherm. 
 
Below you will find all requirements to follow when creating DXF file which shall be imported to AnTherm. 

 

AnTherm 8.132 

 
In the new version the DXF import function was enhanced. Now slopes and roundings are 
imported too.  
Regarding the preparation of 2D projects: 

 Polylines no longer have to be axis-parallel. 
 Simple lines will also be used if they can be combined to polylines. 
 It is also possible to use circles, ellipses and arcs. 
 Polylines whose layer name starts with "Space" or "Raum" are automatically interpreted 

as space elements. 
The other requirements are like in previous versions (read on). Note: We do not support hatches! 

 

 

Requirements related to contents of DXF  

 

The application converts contents of a DXF file into a building component. The substantial characteristics of a building model is 
described in terms of unique assignment of heat conductivity to specific areas of the construction. This information is usually 
not entered within CAD input. Therefore the DXF file prepared for the import must rigorously follow some stringent rules. 
 
With regards to the contents of a DXF file following applies: 
 

      Only polylines are read. Any different content of DXF file (lines, points, labels, blocks, hatches etc.) will be skipped  
during reading. 

      Only closed polylines with segments parallel to axes 
are processed. Any polyline containing sloped 
segments, as well as polylines not declared as 
closed, will be dropped. (Exception: If the first and 
last point of an open polyline coincide exactly by 
their coordinates, the application will implicitly close 
the polyline and consider for further processing.) 
Hint: Polylines within DXF file shall not self 
intersect! Evaluation of self intersecting polylines 
will result in unexpected results. 

       Assignments to layers, line types and colours of 
polylines will interpreted specifically by the 
application. 
Polylines assigned same layer number will be interpreted as belonging together in such a way, that areas 
surrounded by them are filled with same material (hence have same thermal conductivity). The layer name will be 
used as name of material. 
Analogically same applies to polylines of equal line type or equal colour. Such grouping by material can be selected 
either layer number or line type or colour however. Mixing of the grouping criteria is not allowed!  
Hint: Applying some naming scheme which follows a specially prepared material list consequently, gives you the 
ability to automatically amend physical properties of materials - see Replace Materials on All Elements (within the 
Materials window) 
Selective use of layers, line types or line colours provides additional ability to generate assignments to component 

groups. Polylines with equal layer number, equal line type or equal colour can be assigned collectively to one 

component group. The name of a layer, line type or colour will be used as the name for the group. 

 

Of course it is important to carefully use layer numbers, line types and line colours to create meaningful and 
helpful groupings. It is advised to use the layer information for the purpose of assignment of polylines to materials 
and - if required and applicable - use line type as groping vehicle to generate group assignments. 

       While creating the DXF file keep in mind, that CAD drawing units will be interpreted as millimetres by the 

application. 
      Coordinates stored within DXF file will be read as double precision. This provides the maximum precision of 13 to 

15 decimal digits for coordinates read.  

http://help.antherm.eu/Datei/Import/DXF_Import.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
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Therefore it is advisable to save coordinates to a DXF file by specifying the smallest number of digits required to 
represent precise coordinates (typically 7 to 10). 

 
Important: We strongly recommend to avoid writing the maximum of 16 digits as offered by default by 
some programs! 

 

 

Creating a DXF file suitable for the import 
 

Resulting from the above considerations following guidelines result for the creation of new or processing of existing DXF 
files : 

 

Creation of a new DXF file 

 

 Exclusive use of closed polylines with 
segments parallel to coordinate axes. 

 Slopes and curves must be modelled by 
(replayed with) stairs (with line 
segments parallel to coordinate axes) 

 Grouping of polylines by materials 
(thermal conductances) either by equal 
layer number or by equal line type or by 
equal line colour. (if some materials list 
shall be applied, stick to the naming 
convention chosen) 

 Grouping of polylines to generate 
component groups (if required) either 
by equal layer number or by equal line 
type or by equal line colour. 

 Cleanup the drawing unused elements 
(e.g. apply "_purge" command in Acad). 

 During saving to DXF file request scaling 
in millimetres. 

 During saving to DXF file request the 
smallest number of decimal digits 
sufficient to represent coordinates 
precisely. 

 

Editing of existing DXF file 
 

 Draw over the CAD picture with polylines. 

 Slopes and curves must be modelled by (replayed with) stairs (with line segments parallel to coordinate axes) 

 Group polylines by materials. 

 Group polylines to create component groups also (optional). 

 
Remark: The order in which polylines are stored in (and thus also imported from) DXF file does not follow the order they 
have been input within CAD application. Due to the fact, that elements imported will follow the order of polylines as they 
are stored within the DXF file, we advise you not to use element (nor polyline) overlapping! If necessary you will make the 
use of reordering functions (promote or relegate) of elements to reach needed overlapping effects. 
 
Remark: Different line ending conventions shall be tolerated within import: Windows (CR LF) - Macintosh (CR) - Unix 
(LF). 
 
See also: Import of DXF file 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Datei/Import/DXF_Import.htm
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Import of 3D DXF / IFC file  
 
 
AnTherm 8.133 or higher is able to import 3D models in DXF or IFC format that have been created using programs such as 
AutoCAD, ArchiCAD, Revit,...  
 

Voraussetzung, um diese Funktion benutzen zu können, ist die Lizenzoption IMPORT3D.  

                                      
 
 
 
 
In order to import a 3D DXF file to AnTherm, the same procedure as for 2D DXF files is to be applied, that is the command File 
→ Import → aCad DXF. For IFC files the command File → Import → Revit IFC is to be used.  
 
The DXF / IFC files need to meet several requirements:  
 

- DXF files must not use the 3DSOLID command. It is possible to force AutoCAD to avoid this command by choosing an 
old variant of the DXF format (as old as possible) when saving the file.  

- 3D objects should be modelled as closed polylines or polyfaces in DXF files so that they can be imported with 
AnTherm.  

 
In IFC files, AnTherm searches for the command IFCRELCONTAINEDINSPATIALSTRUCTURE. There AnTherm retrieves the list of 
objects to be displayed. AnTherm is capable of processing several types of objects, for instance  
 

- IFCBUILDINGELEMENTPROXY,  
- IFCBUILDINGSTOREY,  
- IFCWALL,  
- IFCSLAB,  
- IFCCOLUMN,  
- IFCBEAM  

 
and many more. These objects can be defined using commands such as  
 

- IFCEXTRUDEDAREASOLID,  
- IFCFACETEDBREP,  
- IFCFACEBASEDSURFACEMODEL,  
- IFCBOOLEANRESULT,  
- IFCPOLYGONALBOUNDEDHALFSPACE  

 
utilizing the auxiliary commands  
 

- IFCRECTANGLEPROFILEDEF,  
- IFCARBITRARYCLOSEDPROFILEDEF,  
- IFCPOLYLINE,  
- IFCCIRCLE  

 
 
 
 
and others. If the objects have been assigned materials, AnTherm automatically imports the material names.   
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Register Image underlay/overlay (Dialog) 
 

Any arbitrary image file can be loaded within that image registration dialog (button "Load Image") and located properly 
within the model coordinate system: exact location of two points of the picture will be specified within workspace 
coordinate system. The image registered by such can be displayed within Elements 2D window (either as an underlay or as 
partly transparent overlay) and used for better orientation during the entry of elements during the model creation. Remark: 
The planar underlay is registered at the plane shown within the window. Within the context of Elements23 window (i.e. a 
3D-Project) up to three underlays can be registered within respective quadrants. 
 
This dialog can be reached via the Main Menu-Import or from the context menu of the Element 2D window. Remark: If 
there is an image defined already (registered) then the image registration data can be adjusted within this dialog. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The left part of the window display the loaded image within its pixel coordinate system. Entry of pixel coordinates of two 
points of the image defines the initial part of the transformation to the workspace coordinate system. Input can be done 
either by numerical entry or by dragging the selection rectangle with the mouse - the selection rectangle will automatically 
align (snap) to whole pixel coordinate values or to pixel boundary values. 
Graphical user interface elements and their behaviour are identical to Elements 2D window. 
 
Within the right part of the window the position of the two chosen image points within the workspace coordinate system 
has to be defined (in millimetres). Input can be done either by numerical entry or by dragging the selection rectangle with 
the mouse. 
 
Important: Please observe, that coordinate values of pixel coordinate system (left image) are ordered from top toward 
bottom! 
 
The location of chosen points is emphasized in both image views by red cross marks. 
 
In addition to position registration some optimization of the display of the image in Elements 2D window can be reached 
by adjusting the transparency colour or colour value range (that colour range will be not rendered and result in 
transparency effect). 
 
To make the image display brighter the Gamma-Value can be adjusted. For an overly display the transparency of the 
image can be set with its Alpha-Value.  
One can decide if the image will show as an underlay (i.e. below elements and occluded by them) or as overlay (on top of 
elements). For the latter case it advisable to choose partly transparent rendering (Alpha < 1.0).  
Remark: These detailed settings can be easily adjusted directly from be context menu of the Element 2D window also. 
 
Important: Data enered here, including the absolute path to the image file, will be saved to the project file. Provided that 
several project can reference same image file as an underlay or overlay - moving the project file to different folder does not 
change the image file path. On the other hand, moving or renaming the image file itself will lead to the situation, that it 
cannot be loaded again and must be re-registered. 
 
Important: The data of the image itself is kept within the image file. Only the path name to the image file is stored 
within the project file. 
 
Following image file formats can be loaded: JPG, BMP, GIF, TIF, PNG 
 
See also: Main menu, Coordinate system, Context menu of the Elements 2D window, Project file 

http://help.antherm.eu/CoordinateSystem/CoordinateSystem.htm
http://help.antherm.eu/CoordinateSystem/CoordinateSystem.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.eu/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/Forms/Elements23Form/Elements23Form.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/CoordinateSystem/CoordinateSystem.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

324 
 

Export to CSV file 
 

The matrix of thermal coupling coefficients (conductance matrix) and of power source distribution keys can be saved as a 
CSV file. 
 
The CSV file can be read by other application (e.g. Excel) for further processing. 
 
Typically the conductance matrix of coupling coefficients (space to space) is exported. If there are power sources within 
the construction then distribution table (power source to space) is exported also. 
 
Remark: The export operation is executed in current localization of the operating system (the list separator and decimal 
comma follow the setting of the operating system). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

See also: Menu File→Export→Coupling Coeff. Matrix 
 
 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
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Export image to file 
 

Graphical images can be saved to image files (PNG, TIF, JPG, BMP, GIF). 
 
The button „Copy Image“ and the menu „File→Export→Image“ (or „Edit→Copy Image“) provide the transfer function of 
the picture prepared within a 2D or 3D view to the clipboard and/or to image file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Important: The 3D image will be always recreated in specific, defined size and on top of white background thus being 
better suitable for printing. 
 
Remark: This function is available if there is 3D graphical window active (Elements3D, Results3D). 
Export of 2D views is offered if there is a 2D window active (e.g. Elements2D). 
 
Remark: Graphical views can be transferred to other applications as images via the clipboard also. 
 
If the application setting "clipboard image Save-To-File option" is set to active (true) then you will be offered an option to 
save (export) the image into an image file (PNG, TIF, BMP, GIF, JPG) - a file-save-as-dialog will be presented.  
Lately chosen export format will be initially offered. 
 
When save operation is repeatedly used the index file name will be offered. If the name recently used ends with digits, then 
the numeric pattern of same length will be created (Name_0001, _0002 a.s.o.). If the recent name does not end with digits, 
then a three digits long index will be offered.  
Important: The new free index will be used, i.e. if recently Name_0005 has been saved, but yet Name_0001 does not 
exist, this Name_0001 will be proposed followed by _0002,_0003,_0004 and later _0006, .... 
 
Remark: The option to save images placed onto the clipboard to a file can be set within application settings (Clipboard 
image Save-To-File option, AlwaysAskToSaveGrabbedImage). 
 
Remark: The meaning of the setting "Clipboard image Save-To-File option" can be reversed while the SHIFT-key is held 
depressed during a click onto the "Photo button". This means, that if the Save-To-File option is active saving the image to 
the file will not be offered if the Photo-button is depressed during the SHIFT-Key is held depressed. Opposite is also valid: 
During the Save-To-File option is not active (set to False) and the Photo-button is clicked while holding the SHIFT-key, the 
dialog offering saving of the image to a file will be presented in contrast. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/BackgroundColor/BackgroundColor.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Export/Bild_Export.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Dimensions of the image created for 3D views 
 

Important! Dimensions of the image of a 3D view transferred are not equal to the size of the image visible on the screen! 
 
According to the application wide dimension setting the image will be created at defined size (within "virtual“ window) and 
transferred thereafter. The size and proportion (aspect ratio) of the image specially created for the file storage can be set 
within application settings. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

      The input describes the resulting image dimensions in pixels(image points). 

 

 

 

 

 

 

Keep View Aspect Ration - application setting 
 

If proportions of the image visible in the window on screen differ from proportions at which the image shall be transferred 

(i.e. different ratio of width and height) the resulting image transferred will display differently then that on the screen!. 
 
This results from the binding of scaling of the displayed 3D view to the window height: 

 

 try changing the height of the window – 3D object shown will scale accordingly also. 

 changing the width of the window does not influence the scaling of 3D objects shown! 

 
This automatic scaling behaviour of the image can be suspended for the image being transferred by the setting „Keep View 
Aspect Ratio“ – transferred image will be created at one dimensions actually smaller as set in parameter to show at same 
aspect ration as the view on the screen. 
 
See also: Elements 3D, Results 3D, Application settings, Menu File→Export→Image, Menu Edit→Copy Image, Copy 
image to the clipboard, Keep View Aspect Ratio (setting) 
 
 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
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Export 3D scene to file 
 

Graphical 3D views can be saved to saved to 3D scene files (VRML, IV, OOGL, ...). 
 
In contrast to two dimensional images which can be saved to image files or transferred via clipboard, the three 

dimensional scene file is ideal to be transferred to other three dimensional application for further processing. 
 
A 3D scene consists exclusively of 3D object which can be combined with available building constructions in other 
applications and rendered therein also (rotated, lighted, over sampled etc.) 
 
A 3D scene file can be offered within a 3D viewer (integrated in modern internet browsers) and being presented on the 
internet for virtual viewing. 
 
Remark: This function is only available if there is a 3D window  (Elements3D, Results3D) active. 
 
A 3D scene can be saved to the file in one of following formats: 

 

 X3D (.x3d) 

 X3D-Binary (.x3d) – default 

 POV-Ray (.pov) 

 VRML 2.0 (.vml) 

 Geomview (.oogl) 

 OpenInventor 2.0 (.iv) 

 Wavefront ASCII (.obj and .mat) 

 Renderman (.rib) 

 
Lately chosen export format will be initially offerred.  
A confirmation (or an error) message is displayed upon export completion. 
 
When save operation is repeatedly used the index file name will be offered. If the name recently used ends with digits, then 
the numeric pattern of same length will be created (Name_0001, _0002 a.s.o.). If the recent name does not end with digits, 
then a three digits long index will be offered.  
Important: The new free index will be used, i.e. if recently Name_0005 has been saved, but yet Name_0001 does not 
exist, this Name_0001 will be proposed followed by _0002,_0003,_0004 and later _0006, .... 
 
Remark: An export to a Wavefront OBJ file <name.obj> will create the MAT file (contains material properties) 
<name.mat> also. 
 
Remark: An export to a Renderman RIB file creates on the .rib file only. TIF image is not created. To render the file 
RenderMan or a RenderMan-Emulator (e.g. Blue Moon Ray Tracer BMRT) is required. This export converts against 
following Renderman shaders:a) Normal property, no texture map - plastic.sl, b) Normal property with texture map - 
txtplastic.sl; Both shaders must be compiled into the rendering package used to process the file. 
 
Important: The RIB and OBJ exporter create (also) a rendering based on the size constraints for Image Exporter 
(Width/Height). 
 
 
See also: Export image to file, Menu File→Export→Scene 3D... 
 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Export/Bild_Export.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Datei/Export/Bild_Export.htm
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Application settings (dialog) 
 

The (extensive) set of application settings can be accessed vie the Menu Edit→Settings from the main menu and 
adjusted within the dialog window. 
Amongst other following settings are available: 

 

 language of the user interface (currently 
English or German) 

 loading the recently edited project,  
 automatic calculation of secondary 

functions (heat flux, relative humidity on 
surface etc.),  

 standard directory to save project to,  
 user defined logo for report headings  
 etc. 

Settings shown and adjusted in this window are 

applied to the application and are independent 

from project specific parameters (compared to 

current fine grid parameters of the project, for 

example, saved with the project). 
 
Changes to some parameters require an 
application restart (e.g. User interface language) - 
if so it is emphasized in the description specific 
parameter. 

Parameters which are composed of a set of detailed settings are shown with a plus symbol to the left of the parameter 
name. A click onto the plus symbol will expand the list of detailed setting offering them for editing. 
 
The bottom part of the window displays the description of the parameter currently selected. The height of this part of the 
window can be adjusted by dragging the splitter bar. 
 
Every change to the settings are applied immediately (eventually requires application restart too). 
The button "Close" or ESC-Key close this window. 
 

 Evaluation 

Relative Close-Up 
Error limit 

Relative Close-Up Error maximum criteria for coupling coefficient determination. The value set here 
is used to show precision missed marks (*) and (**) within the coupling coefficient precision 

information. 
Remark: Further precision analysis of the calculation shall be considered if current error values are 
above this limit. 
 Default: 0.0001 (defined by EN ISO 10211:2008); Range: 10

-10
 to 1.0 

Relative Close-Up 
Error - Warn if above 

Display a warning message if precision criteria (limit for the relative close-up error of all boundary 
conditions) is not fulfilled. 
Default: On 

Standard Boundary 
Conditions 

Default values of boundary conditions (temperature and relative air humidity) for the evaluation. These 
values are used only during the first evaluation of a project. 
Following defaults are defined: 

 Temperature of the first space (default: -10°C) 

 Relative humidity of the first space (default: 80 %) 

 Temperature for all other spaces (default: +20°C) 

 Relative humidity for all other spaces (default: 53 %) 
Spaces are sorted alphabetically by their name. All but first space will receive these values by default. 
First space will be assigned its specific values. 
Remark: Relative humidity values apply only to evaluations of vapour diffusion. These default values can 
be set only if DAMPF2/3DIM license option is available. 
Remark: If the project template "projekt.xml" contains boundary conditions already, that will have the 
priority over the values specified here. 

fRsi,min design factor  
for condensation 
assessment 

Minimum value fRsi,min of the temperature factor of interior surfaces for the condensation-free 
assessment (within results report). Undercutting this value should mean that condensation free 
assessment criterion of interior surfaces is not fulfilled. 
Important: The value fRsi,min is dependent on interior climate (temperature, air humidity) and can be 
referred within local regulations. 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Coupling#Genauigkeitsangaben
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Coupling#Genauigkeitsangaben
http://help.antherm.eu/Introduction/05_Normen.htm
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Coupling#LeitwertbezogenerSchließfehler
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#RelativeCloseUpErrorLimit
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm#Features
http://help.antherm.eu/Datei/Standard_projekt_xml.htm
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Results
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Default: 0.69, Range: 0.0-1.0 

fRsi,min design  
factor for mould-free 
assessment 

Minimum value fRsi,min of the temperature factor of interior surfaces for the mould-growth-free 
assessment (within results report). Undercutting this value should mean that mould growth free 
assessment criterion of interior surfaces is not fulfilled. 
Important: The value fRsi,min is dependent on interior climate (temperature, air humidity) and can be 
referred within local regulations. 
Default: 0.71, Range: 0.0-1.0 

fRsi,min design factors - 
Warn if undercut 

Display a warning message within results report if mould- or condensation-free criteria is not fulfilled 
(fRsi,min design factors are undercut). 
Default: On 

fRsi - Two-Space only 
evaluation 

Evaluate fRsi temperature factors (within results report) only if exactly 2 spaces (temperatures) and no 
further boundary conditions exist in the model. 
Default: Off (temperature factor are always calculated) 

Always Expose 
Graphical Evaluation 

The graphical evaluation window (Results 3D window) will be opened automatically each time boundary 
conditions are applied. 
If this setting is turned off (False) the graphical evaluation, if not opened yet, will be not initiated - 
computationally very intensive and memory consuming evaluation is not requested. Only the results 
report will be created and exposed. 
Default: On 

Evaluate secondary 
functions 

Secondary functions (like heat flux, relative surface humidity, etc.) will be calculated for graphical 
evaluation. 
If this setting is turned off (False) only temperature field will be calculated for Results 3D evaluations. This 
saves significantly time needed for calculation and reduces memory demand during evaluation. 
Default: On 

Evaluate which 
secondary functions 

Allows selective selection of secondary function to be calculated for graphical evaluation.  
This provides the ability to evaluate only needed functions by simultaneously reducing the memory 
demand and calculation time otherwise spent for functions the user is not interested in (surface 
humidity, heat flux, heat stream vector field, saturation pressure etc.). 

 Temperature °C  

 Heat flux W/m² (magnitude of the vector)  

 Vector field of heat stream W/m² 

 Relative condensing surface humidity % (only at component's surface), respectively: 

 Condensation: "Condens. RH %" - air humidity limit leading to surface condensation [0-
100%] 

 Mould growth: "Mould RH %" - air humidity limit leading to mould growth on surfaces 
(i.e. 0.8*Condens.RH) [0-80%] 

 Corrosion: "Corrosion RH %" - air humidity limit leading to corrosion of metals on 
surfaces (i.e. 0.6*Condens.RH) [0-60%] 

 Further secondary function are available with the active VAPOUR-Option: 

 saturation pressure hPa 

 partial pressure hPa 

 vapour pressure difference hPa (= saturation - partial pressure) 

 relative core humidity % (relative interstitial humidity; interstitial vapour saturation ratio = 
partial pressure/saturation pressure * 100) 

 vapour diffusion flux mg/m²h 

 vector field of vapour diffusion stream mg/m²h 
 

Remark: Application settings specific to the VAPOUR-Option (partial pressure, pressure difference, 
interstitial core humidity, vapour flux and vector) can only be changed if the DAMPF2/3DIM license 
option is available (otherwise are shown as Read-Only). 
Remark: This setting is only meaningful if the setting "Evaluate secondary functions" is turned on.  
See also: Parameter setting "Evaluate secondary functions", General (control panel) 
Default: By default all secondary functions are evaluated. It is advised to turn off evaluation of not used 
secondary functions to reduce the computational time and memory demands. 

Restore last  
Result3D Parameters 

Defines how (and if) to restore the Results3D Parameters on first display of the Results3D window (the 
combination of evaluation parameters is saved when the Results3D window is closed).  

 No - parameters will not be restored; predefined default combination of parameters will be 
used.  

 Restore - exact combination of parameters will be restored; some restored numerical values 
might not be suitable for the model currently evaluated.  

 RestoreAdapt - combination of parameters will be restored and some numerical parameters 
will be adjusted to reflect currently evaluated model (e.g. Tube Radius etc). 

Default: RestoreAdapt (earlier versions, up to 4.80: No) 

 

http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Results
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Results
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Results
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
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http://help.antherm.eu/Theory/ZurGrenzfeuchtigkeit.htm
http://help.antherm.eu/Introduction/81_Dampfdiffusion.htm
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User Interface 

Autosynchronize 
materials & surfaces 

Defines if the project specific material list and surface list are automatically synchronised (on each 
element selection change). This can be also change on the context menu of both lists ("Autosynch. from 
Elements") 
See also: Material window, Surfaces window  
Default: On 

Colorize material by 
Lambda automatically 

Defines if the material colour is automatically calculated and changed then the value of Lambda changes 
(by LambdaToColor-Table). When off the colour assigned to the material will be retained during changes 
to the value of Lambda. 
See also: Material Editor window, Element Editor, Colour setting file LambdaToColor.ColorList 
Default: On 

Clipboard image 
settings 
/ 
Clipboard image size 

Dimensions (in pixels) of images shot from 3D views and placed onto the clipboard (via Copy Image). 
Please keep proportions (width/height) of the image targeted for the clipboard same to proportions of 
the view on the screen. If proportions differ the resulting image placed on to the clipboard will probably 
differ (in its scaling) from the view seen on the screen. 
See also: Keep View Aspect Ratio, Copy image to clipboard, Export image to file 
Default: 2000x2000 (Range:  2-8192 or less after Bitmap-Test) 

Clipboard image 
settings 
/ 
Keep View Aspect 
Ratio 

If turned on proportions of the image placed on the clipboard reflect these of the image shown on 
screen. Preset dimensions (see above) of the image will be treated as maximum values for the resulting 
image (the resulting image will fit into the rectangle given by the dimensions specified). 
See also: Clipboard image size, Copy image to clipboard, Export image to file 
Default: On  

Clipboard image Save-
To-File option 

Defines if after copying the image onto the clipboard an option to save the image to the file (Save Image 
dialog) shall be offered also. 
Default: Off 

Remember window 
positions 

Positions of windows on the screen shall be saved and windows shall reopen at positions saved lately. 
Default: On 

Background 2D colour 
Background colour of 2D views ( Elements 2D, Elements 2/3D, ...) 
Default: Black 

Background 3D colour 
Background colour of 3D views ( Elements 3D, Results 3D, ...) 
Default: WhiteSmoke 

User Interface 
Language 

By default the user interface of the application reflects the language of the operating system 
(standard/default language). The user can change this setting!  
If the language setting is not supported by the application (current distribution provides only English and 
German), the application will fall back to English. 
Be aware of: Country specific localisation 
Default: Language of the operating system (if available, otherwise default will be English) 

Standard 3D-View 
Axes 

Defines titles displayed along axes within 3D view (used in Elements 3D and Results 3D window) 
Default axes titles: X, Y, Z 

Default snapping grid 

Defines settings of Snap-To-Grid functions (used in 2D Element Editor) 
See also: Snap-To-Grid parameter 
Default: All snapping On, X(0,100) Y(0,100) Z(0,100), Distance=10 

Vertical tabcontrol 
tabs Left-Alligned 

Tabs of the control panel within Results3D window will show at the left edge of the window (instead of 
the default at right side). 
This setting allows to change the placement of tabs to the left side of the window which might be 
common to architects and engineers. This reflects familiar tilt of the head to the left to read tab labels. 
Default: Off 

Vertical tabcontrol 
tabs with Labels 

Tabs of the control panel within Results3D window will show labelled with Text 
Default: On 

Vertical tabcontrol 
tabs with Icons 

Tabs of the control panel within Results3D window will show graphical symbols also. 
Default: On 

 
Project Files 

MRU Project Count 

The Number of recently processed project names (paths) the application shall remember. (value range 0-
200, -35 with menu shortcuts) 
Default: 8 
See also: Main menu 

 
Reopen last project 

The last project saved or opened prior to application exit will be reopened automatically on next 
application start. 
Default: On 

Overwrite project 
without asking 

The project file will be overwritten without any warning or approval (only if the name for the project file 
is already set). 
If the name of the project file is already set (either saved or loaded) saving the project is executed 
without any additional warnings. This simplifies the step „Results…“ – when combined with 

http://help.antherm.eu/Forms/MaterialForm/MaterialForm.htm#Synchronisation der Baustoffliste
http://help.antherm.eu/Forms/SurfaceForm/SurfaceForm.htm#Synchronisation der Oberflächenliste
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http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
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AlwaysAskForFineGridParams=FALSE and AlwaysAskForSolverParams=FALSE the application shows 
results directly.  
Default: On 

Always Ask To Save 
Project 

You will be reminded to save current project prior to any destructive operations (this the default 
behaviour). 
Prior to disposing data of current project (New, Load, Convert etc.) the user will be asked to save the 
project.  
Answering "No" will continue with the operation requested without saving the project (which potentially 
result in losing current project data). Answering "Abort" will immediately cancel the requested operation. 
Default: On 

 
Projects 

Create Directory For 
Reports 

When creating a new project, create a directory where the reports and related images are stored. 
Default: Off 

 
Grid 

  

Always ask for fine 
grid parameters 

User will be asked to adjust and confirm fine grid parameters (the dialog Fine-Grid parameter will be 
shown) on each computation. 
Default: On 

Default fine grid 
parameters 

Default values of parameters used by fine grid generator applied to new projects 
See also: Fine-Grid parameter 

 
Solver 

Automatically close 
Solver Form 

The Solver window will close automatically when the computation is finished.  
If this setting is turned off (False) the application will wait until the user manually closes this window (by 
pressing the button "Close"). Keeping the window visible can be helpful when further detailed analysis of 
messages produced by the solver is required (e.g. at some error conditions). 
Default: On 

Animate Progress on 
Solver Form 

Show the progress animation on Solver window.  
If this setting is turned off (False) the animation will not show thus saving CPU time. 
Default: On 

Always ask for Solver 
parameter 

User will be asked to adjust and confirm Solver parameters on each computation (the dialog Solver 
parameter will be shown). 
Default: On 

 
Default Solver 
parameters 

Default values of parameters used by the simulation engine applied to new projects. 
See also: Solver-Parameter 

Run Solver On 
Multiple Processors 

Run the Solver utilizing multiple processors or processor kernels.  
The maximum number of processors utilized is set with the parameter "Max Number Of Solver 
Processors". 
Remark: This setting can be changed only if there are multiple processors (or processor cores) available in 
the system used. 
Remark: This setting requires a valid license feature MULTICORE.  
See also: application setting "Option MULTICORE active".  
Default: On (subject to license feature MULTICORE and the OS reported number of processor above 2).  
The user shall adjust the Number Of Solver Processors to achieve optimum performance. 

Max Number Of Solver 
Processors 

The Maximum Number Of Processors utilized by Solver (if it shall run on multiple processors). The 
number entered is limited to the actual number of processors (or processor cores) currently installed and 
available in the system. The user shall adjust this number to achieve optimum performance. 
0 (default) - utilize all available processors/cores. 
Remark: This setting can be changed only if there are multiple processors (or processor cores) available in 
the system used. 
Remark: This setting requires a valid license feature MULTICORE. 
See also: application setting "Option MULTICORE active".  

Warn on excessive 
Equation Size 

Display a warning message in the Solver if the equation size is above the value specified (0 - disable 
warning). 
Default: 1000000 

 
Directories & Files 

Material Database 
Path to the Material database 
Default: <installation folder of the program>\Baustoffe.xml 

Simulation Folder 
Cleanup (Reminder) 

Set the number of days after the latest invocation of the Simulation Folder Cleaner Tool to 
remind you about the cleanup of intermediary simulation results eventually needed. If you ignore 
the reminder when shown, the setting is raised by 1 automatically. 
 Default: 30 (days)    0 - no reminder. 
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User specific Logo 

Path to the User specific logo file.  
The logo image is displayed in the heading of reports, as middle item of the heading, placed left to the 
Copyright-Info, 6cm wide and 1.5cm high. To avoid distortion of the picture keep the width to height 
ration of 4:1 (for example 800x200 pixels). 
If no logo image shall be shown on reports leaving this field empty is allowed. 
Default: <installation folder of the program>\CustomLogoBitmap.bmp 

Default project 
directory 

The Path to the folder to which project files shall be saved. This setting is only used for dialogs of 
save/load menus if the project currently processed has not been saved to file ever yet (this is valid for 
new projects). 
Default: "My Documents\AnTherm" 

 
 
öbox data download 
folder 

Path to the store of öbox-data which then are shown within material database window. 
Default: <LocalApplicationData>\OeBOX_Downloaded,  
typical: C:\Documents and Settings\<USER>\Local Settings\Application Data\OeBOX_Downloaded 

baubook(öbox) data 
included 

Include baubook(öbox)-data (if available) within material database window. This, if turned off, allows you 
to exclude baubook(öbox)-data from the view even if the baubook(öbox) data file is available.  
You will have to close and reopen the material database window to fully apply change in setting of this 
switch. 
Default: On 

BPHDB.COM data 
included 

Include BPHDB.COM data (if available) within material database window. This, if turned off, allows you to 
exclude BPHDB.COM data from the view even if the BPHDB.COM data file is available.  
You will have to close and reopen the material database window to fully apply change in setting of this 
switch. 
Default: On 
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Special (Advanced) settings 
 

Settings collectively grouped here are used to adjust behaviours and techniques used by the program. Such special 
adjustments must be accounted also to reflect various differences in hardware used, which cannot be automatically 
analysed and might lead to undesirable behaviour of the application. 
 

  Advanced UI Settings 

 Alpha (surface transmittance)  
hidden 

Hide the Alpha field (surface transmittance Alpha=1/Rs) within space surface property 
input. 
When turned off both reciprocal inputs of surface resistance Rs and transmittance α are 
offered (compatible with versions prior to 6.102) on Element Editor and Surface Editor 
forms and reported on Modelling Report.  
Default: On 

 Elements23Form Panel Contents 

Contents shown within quadrants of Elements23 window can be adjusted and contain 
choices of parallel projections XY, XZ, YX, YZ, ZX, ZY, the 3D view and element selection list. 
One can also do without showing anything within quadrant (in most cases the 3D view 
might be obsolete). 
Default:  

 Left-Bottom: XY 

 Left-Top: XZ 

 Right-Bottom: ZY 

 Right-Top: 3D 

 Primary Edit Windows 
 2D-Project 

Defines which Editing windows will automatically open for 2D project. 
Default: Description, Element Editor, Element selection, Elements 2D 

 Primary Edit Windows 
 3D-Project 

Defines which Editing windows will automatically open for 3D project. 
Default: Description, Element Editor, Element selection, Elements 23 

 Primary Edit Windows 
 3D-Layered-Project 

Defines which Editing windows will automatically open for layered 3D project. 
Default: Description, Element Editor, Element selection, Elements 2D, 3D-Layers, 
Elements 3D 

 Restore last Camera Position 

Restore to the recent Camera position on initial display of a 3D window (applies to 
Elements3D, Elements23, Results3D).  

 No - position will not be restored, only Fit (center, scale); predefined default 
position will be used.  

 Restore - exact position of the camera will be restored; might not be suitable for 
the model currently evaluated.  

 RestoreAndFit - position of the camera will be restored followed by a Fit (center, 
scale) 

Default: RestoreAndFit 

 Show using Visual Styles 

When enabled Buttons and other controls will render with (new) visual style, e.g. rounded.  
Default: On  
You will have to end and restart the application to consistently apply the change of this 
setting. 
Remark: For Windows XP the default is "Off" to overcome some compatibility issues 
resulting from implementation error on that systems when showing text on vertical tabs 
of the tab control which are not rendered properly if visual styles are enabled. The user 
can still enable that setting manually. 

 Help Window shown TopMost 

Help window will be shown topmost to application windows and automatically minimize 
with the application (this is the windows default behaviour). When turned off (the default) 
the help window can be set behind the application window via typical desktop window 
manager.  
Remark: It applies only to Help.ShowHelp but not the HelpProvider (invoked via F1 key) 
thus the effective behaviour depends on how the help window was opened. If 
HelpProvider opens the Help window (user pressed F1 key) then the default (TopMost) 
behaviour will be always retained. If Help.ShowHelp opens the Help window (via Help-
Contents, Tutorials, etc.) then the behaviour set here will be retained also for subsequent 
F1 requests.  
Default: Off 

 

 Advanced Settings 

 Alternative License File  
AnTherm.HID 

Alternative path to the store of the license file AnTherm.HID.  
Important: This setting, if not empty, takes precedence over the "Alternative list of license 
files AnTherm.HID". 
If left empty (default) the license file AnTherm.HID is looked for within the installation 
folder, and, if not found there, within the subfolder DemoLicense of the installation folder.  
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Important: A valid license file MUST be named AnTherm.HID.  
AnTherm will create a temporary local copy of the file provided to also allow network 
stores without additional performance penalties. 
ZIP Archive: specifying a ZIP archive storing the license file AnTherm.HID in its top level 
directory is also supported.  
If the file specified does not exist, this setting is simply ignored. 
Default: empty 
Important: You will have to end and restart the application to consistently apply the 
change of this setting. 

 Alternative List of license files  
AnTherm.HID 

The list of alternative paths to multiple stores of license files AnTherm.HID of which the 
first valid or first marked expired will be employed.  
Important: The setting "Alternative license file AnTherm.HID", if not empty, takes 
precedence over this one (which then will be ignored).  
If left empty (default) the license file AnTherm.HID is looked for within the installation 
folder, and, if not found there, within the subfolder DemoLicense of the installation folder.  
Important: A valid license file MUST be named AnTherm.HID. 
The name of a ZIP archive storing the file AnTherm.HID can be set alternatively too.  
AnTherm will create a temporary local copy of the file provided to also allow network 
stores without additional performance penalties.  
If the file specified does not exist, this setting is simply ignored.  
Default: empty  
Important: You will have to end and restart the application to consistently apply the 
change of this setting.  
Remark: The purpose of this setting is, in the case you have multiple license files bound to 
different hardware identifiers (e.g. dongles), eventually with varying functional scope. 
Switching the dongle the first license file matching it will be validated. 

 Asynchronous Evaluation Builds 

Turn this setting off to force the application to execute all its parts sequentially (otherwise 
executing in parallel and possibly utilizing multiple CPUs if available) on weaker computer 
or for testing purposes. 
Default: On 

 Windows mode MDI 

Show windows in MDI mode (you will have to restart the application to aplly this setting). 
MDI: All application windows will be shown as sub-windows within the main application 
window.. MDI mode is especially useful with lower screen resolutions (<1600x1200). The 
MDI main window is scrollable. The main MDI window cannot be sized below 600x400 
pixels (such small windows size is much too small for wfficent application use, but might 
be convenient for the first application start). 
 
SDI: While in non-MDI mode (WindowModeMDI=false, also called "SDI mode") the height 
the main form will be reduced to lowest possible size to show the main application menu 
only. The main window will be declared as "Top-Most" ensuring its visibility on top of all 
other application windows to avoid hiding of the main application menu. 
Default: On 

 Fade Info-Dialog Gradually 

The About dialog shall appear by decreasing its opacity in small steps. On some (older) 
machines this might result in undesirable flickering effect, thus this setting can be turned 
off if such behaviour is observed. 
Default: On 

 Multiple app-instances allowed 

Simultaneous execution of multiple instance of this application can be allowed by turning 
this setting to on. 
This might be useful when components or their parts shall be quickly transferred between 
projects via clipboard (copy/paste) without the need to close the active project and open 
another one in between. 
Default: On (was "Off" till V.5.88). 
Warning: Simultaneous execution of multiple instance of this application might result in 
race conditions between instances and lead to severely erroneous results. You shall never 
edit same project originating from/in the same directory simultaneously or otherwise the 
application will behave unexpectedly. 

 Option VAPOUR active 

The VAPOUR option can be switched off by the user: 
Within the MainForm the application setting ComputeVaporTransferSolution will 
be reset 
The EditControl of ElementEditor will not show the Mu value 
The MaterialEditorControl of the MaterialsList will not show the Mu value 
Within the SolutionFactory the setting ComputeVaporTransferSolution will be reset 
The SolverParamsControl will disable the setting of ComputeVaporTransferSolution 
Remark: This setting requires a valid license feature DAMPF2/3DIM. 
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 Option HARMONIC active 

The HARMONIC option can be turned off by the user.  

 Within the MainForm the application setting ComputeTransientSolution will be 
reset 

 The EditControl of ElementEditor will not show the Rho and Ce values 

 The MaterialEditorControl of the MaterialsList will not show the Rho and Ce 
values 

 Within the SolutionFactory the setting ComputeTransientSolution will be reset 

 The SolverParamsControl will disable the setting of ComputeTransientSolution 
Remark: This setting requires a valid license feature HARMONIC. 
Remark: Suspending HARMONIC option turns off the TRANSIENT option too. 

 Option TRANSIENT (incl.   
HARMONIC) active 

The TRANSIENT option can be turned off by the user - when time dependant evaluations 
are not needed (i.e. no entry of Periodic Boundary Conditions, Evaluation Time Point and 
no Timeline- nor Animate-Evaluations)  

 The SolverParamsControl will limit the number of harmonics to 6. 

 The MainForm wii suppress time dependant evaluations 
Remark: This setting requires a valid license feature HARMONIC/TRANSIENT. 
Remark: Turning the TRANSIENT option ON turns on the HARMONIC option too. 

 Option MULTICORE active 

The MULTICORE option can be switched off by the user. 
When deactivated the optimized execution of calculation (Solver) and many further 
evaluation components of the application will be suppressed.  

 Solving the equation system(s) - the Solver 

 Loading the solution from files in solution folder 

 Combining solution vectors at specific boundary conditions 

 Fourier analysis and synthesis of periodic boundary conditions 

 Fourier synthesis of time dependant solutions 

 Creation of results data for 3D visualization (primary and secondary functions), 
timelines and animation 

Remark: This setting requires a valid license feature MULTICORE 
See also: application settings "Run Solver On Multiple Processors", "Max Number Of Solver 
Processors". 

 Option STEREO3DVIEW active 

The STEREO3DVIEW option can be switched off by the user. 
When deactivated stereo rendering capability of 3D windows will not be available. 
You will have to close and reopen all 3D windows to fully apply change in setting of this 
switch.  
Remark: This setting requires a valid license feature STEREO3DVIEW 

 Lately used Settings File 
The path to the settings file loaded lately (read only, for information only). 
  

 
 OpenGL Settings 

Control parameter for the OpenGL system library 
Remark: Changes to settings in this group require all 3D-windows to be reopened or the 
application to be restarted to apply them. 

 ResolveCoincidentToplogy 
 ToPolygonOffset 

This setting ensures enhanced visualization of lines drawn along surfaces. When 
turned off lines (e.g. isolines, edges etc.) will be drawn coplanar to surfaces, possibly 
leading to undesired visual effects (e.g. lines only partly visible, partly obscured). 
On some weaker graphics systems (e.g. DELL Lattitude D505 with Intel Extreme Graphics 
855GM) this setting might be turned off or otherwise rendering of surfaces is not correct. 
Default: On 

 UseBackingStore 

Turn on/off using backing store. This may cause the re-rendering time to be slightly slower 
when the view changes. But it is much faster when the image has not changed, such as 
during an expose event. 
Default: On 
Remark: On some systems it undesirable to turn this option on - areas of covered partly by 
other windows might not be redrawn correctly during normal rendering. 

 UseImmediateMode 
 Rendering 

Turn on/off flag to control whether data is rendered using immediate mode or not.  
Immediate mode rendering tends to be slower but it can handle larger datasets. 
 If you are having problems rendering a large dataset you might want to consider using 
immediate mode rendering. 
Default: Off (i.e. RetainedMode-Rendering) 

 ExplicitBackfaceProperty 

Will assign BackfaceProperty=FrontFace for modelSliceX, modelSliceY, modelSliceZ, model, 
sliceZ, sliceY, sliceX, isosurface, surface; It is used to resolve rendering issues on (very few) 
systems rendering only one side of surfaces. (See workaround in FAQ too). 
Default: Off (i.e. default behaviour) 

 DesiredFlyToSeconds 
Define the time used for animating to the particular isometry applied.  
Default: 2 seconds (Range: 0 - 100). 
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Remark: Actual number of frames shown during the animation results automatically from 
current rendering time. Rendering time depends highly on the object complexity and its 
current transform and varies during the animation - faster 3D graphics systems will show 
more animated frames thus the resulting move will look natural. 

 Interactor 
 DesiredUpdateRate 

Desired number of frames per second while the 3D view is rotated or zoomed with the 
mouse interactor. 
Default: 2 fps (Range: 0.0001-10000). It shall always be larger then the StillUpdateRate 
Remark: Setting InteractorDesiredUpdateRate to 0.0001 will practically turn the LOD 
functionality off (full detailed image on each rendering). 

 Interactor 
 StillUpdateRate 

Number of frames per second while the 3D view has became still after being rotated or 
zoomed with the mouse interactor. 
Default: 0.0001 fps (Range: 0.0001-10000). It shall always be smaller then the 
DesiredUpdateRate. 

 TubeNumberOfSides 

Number of sides of the Tube representation (Streamlines, Isolines).  
Default: 4 (Range: 3-16) 
Remark: After changing this setting you will eventually have to restart the visualization. 

 ConeResolution 

Number of facets used to represent the cone (as used by Vectors/HedgeHog).  
=0: a line; =1: a single triangle; =2, two crossed triangles; >2, a 3D cone (with resolution 
number of sides). 
Default: 4 (Range: 1-16) 
Remark: After changing this setting you will eventually have to restart the visualization. 

 ConeRadiusToLengthRatio 

The radius of the cone base as ratio of its length (as used by Vectors/HedgeHog).  
0.15 ~three times long as wide; 0.25 twice longer as wide.  
Default: 0.15 (Range: 0.001-0.5) 
Remark: After changing this setting you will eventually have to restart the visualization. 

 ArrowResolution 

Number of facets used to represent the arrow shaft and its tip (as used by 
Vectors/HedgeHog).  
=1: a single triangle and single rectangle; =2: two crossed triangles and single 
rectangle; >2: a 3D tip cone and 3D shaft (with resolution number of sides). 
Default: 4 (Range: 1-16) 
Remark: After changing this setting you will eventually have to restart the visualization. 

 ArrowTipRadiusToLengthRatio 

The radius of the arrow's tip cone base as ratio of arrow length (as used by 
Vectors/HedgeHog). 
Default: 0.15 (Range: 0.001-0.5) 
Remark: After changing this setting you will eventually have to restart the visualization. 

 ArrowShaftRadiusToLengthRatio 

The radius of the arrow's shaft as ratio of arrow length (as used by Vectors/HedgeHog). 
Default: 0.05 (Range: 0.001-0.5) 
Remark: After changing this setting you will eventually have to restart the visualization. 

 ArrowTipLengthToLengthRatio 

The length of the arrow's tip cone as ratio of arrow length (as used by Vectors/HedgeHog). 
Default: 0.4 (Range: 0.001-0.999) 
Remark: After changing this setting you will eventually have to restart the visualization. 

 StereoAnaglyphColorSaturation 

The anaglyph color saturation factor (as used by anaglyph stereo rendering mode). 
0.0 means that no color from the original object is maintained, 1.0 means all of the color is 
maintained.  
The default value is 0.65. Too much saturation can produce uncomfortable 3D viewing 
because anaglyphs also use color to encode 3D.  
Default: 0.65 (Range: 0.0-1.0).  

 StereoAnaglyphColorMask 

The anaglyph color mask values are two numbers which are bits mask that control which 
color channels of the original stereo images are used to produce the final anaglyph image 
(as used by anaglyph stereo rendering mode). The first value is the color mask for the left 
view, the second the mask for the right view. If a bit in the mask is on for a particular color 
for a view, that color is passed on to the final view; if it is not set, that channel for that 
view is ignored. The bits are arranged as r, g, and b, so r = 4, g = 2, and b = 1.  
By default, the first value (the left view) is set to 4, and the second value is set to 3. That 
means that the red output channel comes from the left view, and the green and blue 
values come from the right view.  
Default: Red_Cyan = R_GB  
Range: R_GB=Red_Cyan; GB_R=Cyan_Red; G_RB=Geen_Magenta; RB_G=Magenta_Green; 
B_RG=Blue_Yellow; RG_B=Yellow_Blue 

    

 Display 
 ErrorAndWarning 
 Window 

Warning and error messages of visualization components will be displayed (a 
dedicated window will be exposed). 
Default: Off 

 

http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm#LevelOfDetail
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm#LevelOfDetail
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm#TubeRadius
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm#TubeRadius
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm#Style
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm#Style
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm#Style
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm#Style
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm#Style
http://help.antherm.eu/Forms/Result3DForm/HedgeHog.htm#Style
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#stereo
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/Navigation_3d.htm#stereo
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 Advanced Solver Settings 

 Compute Vapour Transfer    
Solution inquiry 

Always ask if Solver shall create the solution for the vapour transfer problem provided the 
sufficient data is available but this Computation has not been requested yet.  
This setting is subject to additional licence restrictions if such apply.  
Default: On 

 Compute Transient Solution   
inquiry 

Always ask if Solver shall create the solution for the transient periodic, harmonic, 
instationary problem provided the sufficient data is available but this Computation has not 
been requested yet.  
This setting is subject to additional licence restrictions if such apply.  
Default: On 

 

Hint: To restore the value of any respective parameter to its default use its context menu (right mouse button) and select 
"Reset". 
 
Remark: Application wide settings are stored to the file AnTherm.exe.Settings.xml which is kept within local settings 
folder of any user. 
 
The lately active tab of the settings window will be save with the application settings and later restored 
(LastSelectedApplicationSettingsFormTabPageName). 
 
See also: Settings file AnTherm.exe.Settings.xml, Fine Grid parameter, Solver parameter, Snap-To-Grid parameter 
 
 
 
 
 
                                   

                             
 
 
 
 
 

 
 
                                             

http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
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Settings file AnTherm.exe.Settings.xml 
 

Global application settings are saved to the file AnTherm.exe.Settings.xml located in the user specific settings folder. 
 
During application shutdown current window positions will also be saved to this file. On next application use these windows 
will be shown at their last position. If this stored setting is not sufficient anymore and you wish to reset the layout of all 
application windows, please use the menu function Windows→Reset windows positions. On next application start following 
this reset all windows will be shown at positions defined in the initial template AnTherm.exe.LayoutPersistence.xml. 
 
Actual filter settings defined in the Material database window are also persisted. 
 
The settings file also stores latest arrangement of 3D views (the actual isometrics of 3D representation). Given by the 
view vector and perspective it will be restored when a 3D window is opened again. 
 
Furthermore, this settings file keeps track of all global (standard) evaluation settings lists, isometry lists a.s.o. (these are 
managed from the "standard" panel of the isometries window and results 3D parameters window). 
 
The list of all folders which appear used by AnTherm as containers for AnTherm projects and simulation results folders is 
stored in that file also. 
 
 
Note: The folder used for local settings is located, for example in Windows XP Professional, under following path name: 
 

C:\Documents and Settings\<User>\Local Settings\Application  
Data\tkornicki\AnTherm\ 

 
 
Actual location of this folder depends on the settings of operating system, its version and language choice. The exact 
path can be found in the About window (menu Help→About...) by looking for the value of the entry: 
 

LocalUserAppDataPath: 
 
See also: Application settings 

 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Datei/Startup_LayoutPersistence_xml.htm
http://help.antherm.eu/Forms/BaustoffStammdatenForm/BaustoffStammdatenForm.htm
http://help.antherm.eu/Forms/CameraViewInfosForm/CameraViewInfosForm.htm
http://help.antherm.eu/Forms/Result3DParamsForm/Result3DParamsForm.htm
http://help.antherm.eu/Forms/SolutionFolderCleanerForm/SolutionFolderCleanerForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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Theoretical background 
 

The calculation of temperature field and heat streams is founded on top of the general concept of base solutions and 
thermal coupling coefficients. 
The theoretical foundation for these concepts for steady state (stationary) calculations can be found within the book 
„Wärmebrücken (Thermal heat Bridges)“ from W. Heindl, et al. [1] and for the dynamic (transient harmonic, periodic) 
calculation within writings of K. Kreč [2] . 
Main feature of theoretical concepts used here has been directly adopted within the "Thermal Bridges Standard“ EN ISO  
10211-1 [3], hence the stringent standard's conformance of the program AnTherm is easily provided. 
It is noteworthy to reference the distinctive method of direct and exact determination of temperature factors fRsi which 
applies to multidimensional (three dimensional) cases also. 
The numerical methods used in this program build on top of standard mathematics bibliography [4]. 
The special subjects and methods of optimal over-relaxation are further described in [5] . 
 
See also: Introduction, Why multidimensional calculation?, European standards on thermal bridges, The over relaxation, 
Primary Concepts 

 

Articles and essays 
 

 On condensing humidity (dew point) 
 
 Calculating equivalent thermal transfer coefficient of air cavities 

 
 On calculation of Ψ-values (Psi) for a 3 space case: Special consideration: Unheated spaces 

 
 On calculation of Ψ-values for building constructions in connection with ground 

 
 The air temperature in the unheated basement, a case study 

 
 Heat losses from large buildings through the ground 

 
 Methods of thermal heat bridge survey in international perspective 

 
 On three dimensional simulation of thermal behaviour of buildings 

 
 The building envelope as thermal heat bridge 

 
 On the Storage of Heat in Building Components 

 
 Transient, multidimensional calculations by an example of components in contact with soil 

 
 Heat Transfer in Building Constructions in consideration of Heat Sources 

 
 A practical method for the assessment of heat bridges with a view to surface condensation 

 

 Multidimensional vapour diffusion processes   
 
 On visualization of heat and vapour diffusion stream in three dimensional models 

 
 Temperature factor fRsi 

 
 Appropriate responses to the complex problem of finding the cause for mould growth? [NEW] 

 
 Das Leitwert-Konzept [NEW] 

 
 Anmerkungen zur EN ISO 13786 [NEW] 

 
 Berechnung der spezifischen Wärmekapazität der Ersatzkonstruktion [NEW] 

 
 Die wirksame Wärmespeicherkapazität [NEW] 

 
 Wärmeleitung und Wärmespeicherung in plattenförmigen Bauteilen [NEW] 

 
 Zur Definition der wirksamen Wärmespeicherkapazität [NEW] 

http://help.antherm.eu/Theory/Waermebruecken_Heindl.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Theory/Temperaturfaktor_fRsi.htm
http://help.antherm.eu/Introduction/Einfuehrung.htm
http://help.antherm.eu/Introduction/Einfuehrung.htm
http://help.antherm.eu/Introduction/05_Normen.htm
http://help.antherm.eu/Introduction/05_Normen.htm
http://help.antherm.eu/PrimaryConcepts/BasicsAndSomeTheory.htm
http://help.antherm.eu/Theory/ZurGrenzfeuchtigkeit.htm
http://help.antherm.eu/Theory/Lambda_equ.htm
http://help.antherm.eu/Theory/Puffer_allgemein.htm
http://help.antherm.eu/Theory/psi_Boden.htm
http://help.antherm.eu/Theory/WKSB_94_34.htm
http://help.antherm.eu/Theory/BUD_95G.htm
http://help.antherm.eu/Theory/BERLIN_1997.htm
http://help.antherm.eu/Theory/GI_2000.htm
http://help.antherm.eu/Theory/Hamburg_2003.htm
http://help.antherm.eu/Theory/GI_1993_H1.htm
http://help.antherm.eu/Theory/Merkblatt_instationaer.htm
http://help.antherm.eu/Theory/GI_1993_H6.htm
http://help.antherm.eu/Theory/BPH_1989_H5.htm
http://help.antherm.eu/Theory/Notiz_Diffusion.htm
http://help.antherm.eu/Theory/Bauphysik_3_06.htm
http://help.antherm.eu/Theory/Temperaturfaktor_fRsi.htm
http://help.antherm.eu/Theory/Sonderdruck_Oswald_2011_zu_4018_8.htm
http://help.antherm.eu/Theory/2007_Das_Leitwert_Konzept.htm
http://help.antherm.eu/Theory/2007_Anmerkungen_zur_EN_ISO_13786_2000.htm
http://help.antherm.eu/Theory/2007_Berechnung_der_spezifischen_Waermekapazitaet_der_Ersatzkonstruktion.htm
http://help.antherm.eu/Theory/2007_Die_wirksame_Waermespeicherkapazitaet.htm
http://help.antherm.eu/Theory/2007_Waermeleitung_und_Waermespeicherung_in_plattenfoermigen_Bauteilen.htm
http://help.antherm.eu/Theory/2007_Zur_Definition_der_wirksamen_Waermespeicherkapazitaet.htm
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EN ISO 13788: fRsi and Vapour Diffusion 
 

EN ISO 13789: references to Psi and Chi coefficients (inner/outer lengths)  
EN ISO 14683: Thermal Coupling Coefficient L

nD
 sometimes shown as HD - direct heat transmission coefficient, 

references to Psi and Chi coefficients 
 

EN ISO 14683 Annex A: Thermal Bridges reference 
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http://www.amazon.de/exec/obidos/ASIN/0387545654/tomaszkornickiwe
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The book "Thermal Heat Bridges" by W.Heindl, K.Krec, E.Panzhauser, A.Sigmund 
 

This publication is available in German only. 

 

 

Das Buch "Wärmebrücken" von W.Heindl, K.Krec, E.Panzhauser, A.Sigmund 

 

Das Buch präsentiert neue einfache Methoden für den Hochbauingenieur zur Berücksichtigung der 
Auswirkungen von Wärmebrücken. Im Vordergrund steht dabei die für die Planung von Hochbauten 
wichtige Frage, ob, wo und unter welchen Bedingungen Oberflächenkondensation zu erwarten ist. Auch 
die nicht minder wichtige Frage nach den durch Wärmebrücken verursachten Wärmeverlusten wird 
beantwortet. Dabei wird besonderen Wert darauf gelegt, dass die durch die EDV-Berechnungen 
ermittelten Wärmebrücken-Kennwerte anschaulich fassbar sind und als Grundlage einfacher 
Auswertungen ohne weiteren Einsatz der EDV dienen können; bei diesen Auswertungen können 
Wärmeverluste, Oberflächentemperaturen und kritische relative Luftfeuchtigkeiten für beliebige Außen-
und Innenlufttemperaturen mittels einfacher Formeln berechnet bzw. aus einer Tabelle abgelesen werden. 
 
Das Buch bietet eine praxisorientierte Einführung in die für die Beurteilung von Wärmebrücken wichtigsten Begriffe, 
Formeln und Rechenmethoden. Im Hochbau häufig auftretende Wärmebrückeneffekte werden anhand von Beispielen 
erläutert. Ein umfangreicher Baudetailkatalog wird dem Planer das Gefühl für wärmetechnisch zweckmäßige Lösungen 
vermitteln, so dass er besser entscheiden kann, in welchen Fällen eine genaue Berechnung der Kennwerte seiner 
Konstruktion mittels EDV unentbehrlich ist. 
 
Die theoretischen Grundlagen der angewandten Methoden und ein Exkurs über die experimentelle Entwicklung der 
Kennwerte von Wärmebrücken runden das Werk ab. Damit wird das Buch Architekten und Bauphysikern nicht nur als 
direkte Hilfe bei der Planung von Nutzen sein, sondern auch den an der Theorie Interessierten Einblick in die 
grundlegenden Zusammenhänge gewähren. 
 
 
This book can be ordered (for example) at amazon.de : W. Heindl, K. Kreč, E. Panzhauser & A. Sigmund, 
"Wärmebrücken", Springer-Verlag (1987) ISBN:3211820248, ISBN:0387820248 
 
See also: Theoretical background 
 
 

 
 
 
 
 
 

http://www.amazon.de/exec/obidos/ASIN/3211820248/tomaszkornickiwe
http://www.amazon.de/exec/obidos/ASIN/3211820248/tomaszkornickiwe
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On condensing humidity (dew point) 
 

 
A practical measurement indicator for the amount of vapour contained within the wet air of some specific temperature is 
given by the relative humidity. It can be measured directly and very precisely with simple instruments - e.g. the hair 
hygrometer. When wet air wipes some surface of which the temperature is lower then that of the air, then it will show the 
vapour condensation on that surface when its temperature falls below the dew point temperature of the air. The dew point 
temperature is set by the value of temperature at which wet air of some specific vapour content will be saturated (by holding 
other parameters constant), i.e. the relative humidity is 100%. 
 
The dew point temperature is simultaneously the degree of air moisture. Unfortunately it is not easy to measure (e.g. with a 
dew point thermometer) and by that it has not been adopted in practical use. De facto the dew point provides an ideal 
indicator to assess condensation risk at building component surfaces. If the dew point temperature is below the actual 
surface temperature there will be no condensation. To reliably preclude condensation the temperature at any place of the 
interior surface must be higher than the current dew point temperature of the air. 
 
In practice, however, one will rarely have an idea about the dew point, rather then, on the other hand, about the 
temperature and relative air humidity. For that reason the term of "condensing humidity" is introduced when assessing 
surface temperatures in the context of condensation risk. 
 
The "condensing humidity" is the value of relative air humidity at which, when it is exceeded, the vapour condensation will 
occur on the surface having some specific temperature. It can be calculated by a quotient of saturated vapour pressure at 
surface temperature and the pressure of saturation at specific air temperature. 
 
The introduction of condensing humidity provides direct normative assessment of the temperature field calculated for some 
construction. The ÖNorm B8110-2:2003 defines the standard interior climate for residential spaces as follows: 20 °C air 
temperature and 65% relative air humidity when exterior temperature is 0° C. For negative temperatures of exterior air the 
maximum allowed humidity for the interior space air has to be reduced by 1% by each degree of exterior air temperature 
decrease. The condensation risk must be concluded only when the "condensing humidity" calculated for the temperature of 
the coldest point at the surface goes below the one set within the standard. 
 
Example: When the standardized temperature of exterior air is set for the calculation to -12°C, then the relative humidity 

of the interior air (at 20°C temperature) shell never go above 65 – 12 = 53%.  
If the "condensing humidity" calculated for the coldest surface point is above 53%, then, concluding the 

ÖNorm B8110-2:2003, there is no condensation risk.  
If this is not the case, the construction assessed must be considered non conformant with standards. The 

areas affected by the condensation risk can be easily made visible by drawing the isolinie of 53% of  
condensing humidity at that surface. 

 

http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
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See also: Condensing Humidity Calculator (Tool), Results report, Selected evaluation function 
 
 
 
 

http://help.antherm.eu/Forms/GrenzfeuchteCalculatorForm/GrenzfeuchteCalculatorForm.htm
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Notes on calculating equivalent thermal transfer coefficient of air cavities 
 

This essay is available in German only. 

 

Notiz zur Berechnung äquivalenter Wärmeleitfähigkeiten für Hohlräume 
 

Modul zur Berechnung äquivalenter Wärmeleitfähigkeiten für Hohlräume  
Im Menü „Werkzeuge“ wird ein Programm zur Berechnung von äquivalenten Wärmeleitfähigkeiten für geschlossene 
Hohlräume angeboten werden.  
Ein Hohlraum wird nur in Ausnahmefällen aus einem einzigen Element bestehen; im Normalfall wird ein Hohlraum durch 
eine Gruppe von Elementen beschrieben werden.  
Die im Folgenden angeführten Berechnungsvorschriften orientieren sich an den Euronormen EN ISO 6946 und EN ISO 
10077-2 und sind für zweidimensionale Berechnungen ausgelegt. 
 

Ao. Univ. Prof. Dipl.-Ing. Dr. techn. Klaus Kreč, Büro für Bauphysik, Schönberg am Kamp, Österreich 
 
Lesen Sie hier weiter: 
 

 Notiz zur Berechnung äquivalenter Wärmeleitfähigkeiten für Hohlräume (pdf)  
 
 

 
The above essay has been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
See also: Theoretical background 
 
 
 
 

http://help.antherm.eu/Theory/Lambda_equ.pdf
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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On calculation of Ψ-values (Psi) for a 3 space case: Special consideration: Unheated spaces 
 

This essay is available in German only. 

 

Notiz zur Berechnung von Ψ-Werten (Psi) im 3-Raum-Fall; Spezialfall: unbeheizte Pufferräume 
 

Eine Notiz zur psi-Wert Berechnung im 3-Raum-Fall. 
 
Die Problematik wird im Zusammenhang mit den bodenberührten Bauteilen behandelt (unbeheizter Kellerraum) und das 
Thema ist nun ganz allgemein abgearbeitet. Aus mehreren Anfragen zeigt sich, dass die Problematik schnell zur Konfusion 
und zur (unsinnigen) physikalischen Interpretation von psi-Werten (ver)führt. 
 

 
Continue reading here: 
 

 ψ-Werte im 3-Raum-Fall; Spezialfall: unbeheizte Pufferräume  
 

 
The above essay has been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria 
 
See also: Linear and Point Transmittance, Theoretical background 
 
 
 
 
 

http://help.antherm.eu/Theory/Puffer_allgemein.pdf
http://help.antherm.eu/PrimaryConcepts/16_Transmittance.htm
http://help.antherm.eu/PrimaryConcepts/16_Transmittance.htm
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On calculation of Ψ-values (Psi) for building constructions in connection with ground 
 

This essay is available in German only. 

 

Zur Berechnung von Ψ-Werten (Psi) für Baukonstruktionen im Bereich bodenberührter 
Bauteile 
 

Die „indirekte Methode“ zur Berechnung des thermischen Leitwerts der Gebäudehülle nach EN ISO 10211 basiert auf 
einem eindimensionalen Berechnungsansatz, der im Nachhinein durch Aufsummierung sog. „Leitwertzuschläge“ korrigiert 
wird. Die Leitwertzuschläge werden jeweils durch Bildung des Produkts aus dem „Ψ-Wert“ (Psi Wert) und der zugehörigen 
Länge errechnet. 
 
Da die „indirekte Methode“ mehrdeutig und nicht für jeden Spezialfall normativ geregelt ist, führt sie immer wieder zu   
Verunsicherung und in der Folge auch zu – durchaus auch schwerwiegenden – Fehlern. Im Fall bodenberührter Bauteile, für 

den ja eine eindimensionale Modellierung von vornherein fragwürdig erscheint, ist die Verunsicherung besonders ausgeprägt. 

Daher soll hier ein Versuch der Klärung anstehender Fragen unternommen werden. Hierbei werden allgemein gültige, 

wesentliche Grundsätze untersucht und dargelegt. Die oft gewünschte kochbuchartige Beschreibung einer einzuhaltenden 

Vorgangsweise könnte lediglich Spezialfälle abdecken und wird hier bewusst vermieden. 
 
Von grundsätzlicher Bedeutung ist die Einsicht, dass die „indirekte Methode“ eine reine Rechenvorschrift zur Korrektur des 
Fehlers der eindimensionalen Modellierung ist. Daher ist es in der überwiegenden Zahl der Fälle auch unzulässig und 
irreführend, den mittels zweidimensionalen Wärmebrückenberechnungen ermittelten „Ψ-Werten“ irgendeine physikalische 
Bedeutung beizumessen. Zu betonen ist allerdings, dass die „indirekte Methode“ bei richtiger Anwendung zum gleichen 
Resultat – dem thermischen Leitwert der Gebäudehülle – führt wie die „direkte Methode“ der EN ISO 10211 oder eine 
dreidimensionale Modellierung des gesamten Gebäudes. 
 
Die Mehrdeutigkeit der „indirekten Methode“ wird durch den Umstand hervorgerufen, dass das verwendete 
eindimensionale Berechnungsmodell zur Beantwortung der Problemstellung (Berechnung des Leitwerts der Gebäudehülle, 
Heizwärme- und Heizenergiebedarfsberechnung, Sommertauglichkeitsberechnung, …) grundsätzlich nicht geeignet ist und 
auf verschiedenste Weise konstruiert werden kann. Der Fehler der eindimensionalen Berechnung ist somit eng mit der Art 
des gewählten eindimensionalen Modells verbunden. Die Korrektur dieses Fehlers mittels Leitwert-Zu- oder Abschlägen wird 
dann und nur dann richtige Resultate liefern, wenn die Berechnung der Ψ-Werte und der Längen unter Zugrundelegung des 
exakt gleichen eindimensionalen Modells erfolgt wie die Berechnung des Gesamtleitwerts. 
 
Die nachfolgende Untersuchung des Spezialfalls bodenberührter Bauteile fußt auf den normativen Vorgaben der EN ISO 
10211, der EN ISO 13370 und der ÖNorm B8110-6. 
 
Continue reading here: 
 

 Zur Berechnung von Ψ-Werten für Baukonstruktionen im Bereich bodenberührter Bauteile (pdf)  
 

 
The above essay has been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria 
 
See also: Linear and Point Transmittance, Theoretical background 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://help.antherm.eu/Theory/psi_Boden.pdf
http://help.antherm.eu/PrimaryConcepts/16_Transmittance.htm
http://help.antherm.eu/PrimaryConcepts/16_Transmittance.htm
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Temperature factor fRsi (f*
Rsi) 

Thermal bridges cause additional heat losses on one hand and on the other they cause low interior surface temperatures. 
Accordingly, to characterize the effect of thermal bridges, two different, independent parameters are needed - f

*
Rsi and 

thermal coupling coefficient (Leitwert, thermal conductance). For the case of many spaces connected via the thermal bridge 
these are the weighting factors g0 , ... , gn and the thermal conductance matrix of thermal coupling coefficients L ij . 

To estimate the risk of a possible condensation or mould growth, the surface temperature of the interior space must be 
known. It is not reasonable to declare this temperature in degrees of Celsius, as this would only be valid for some defined 
boundary conditions mix, i.e. some specific temperature set for indoor air space and exterior air. Instead the temperature 
factor  f

*
Rsi , as defined in EN ISO 10211, shall be used (in the bibliography is is also known as temperature difference quotient 

Θ ). 

It is a constant, construction specific value, that is independent of any temperature difference between indoor and outdoor 
climate. This factor can be calculated only with two- and three dimensional heat transport simulation software. 

Thanks to the super-refinement AnTherm evaluates temperature factors f
*

Rsi directly out of base solutions (the weighting 
factors) and independently of the dimensionality of thermal bridge (2D or 3D).  

The temperature factor f
*

Rsi is calculated and output in the results report for the coldest point of any respective space - in 
addition to the weighting factors. For the case of only two space it is nothing else but 1 − gSe (i.e. within results report the row 
of weighting factors for the exterior space shall be subtracted from 1). 

Important: The temperature factor f
*

Rsi is defines for only two spaces connected to the thermal bridge. When three or more 
spaces are considered the temperature factors g0 , ... , gn must be used for the evaluation! 

Definition 

The temperature factor f
*

Rsi (fRsi) : the difference between the interior surface temperature θsi of a component and exterior 
air temperature θe, related to (defided by) the difference of temperatures between interior air θi and exterior air θe. The 
surface temperature is to be determined with some well defined surface resistance Rsi :  

Θ = f
*

Rsi = (θsi - θe) / (θi - θe)  

where 

θsi [°C] interior surface temperature 
θe [°C] exterior air temperature 
θi [°C] interior air temperature 

The calculation of the interior surface temperature °C can be then derived from following equation: 

θsi = f
*

Rsi • (θi − θe) + θe 

When one dimensional case is considered, e.g. to asses regular layer structure of external wall, the f
*

Rsi might be calculated 
from 

f
*

Rsi = 1 − U / αsi  

or  

f
*

Rsi = 1 − U * Rsi  

where 

U [W/(m·K)] thermal conductance of the wall 
αsi [W/(m2·K)] thermal surface conductance of the interior surface 
Rsi [m2·K/W] thermal resistance of the interior surface. 

Taking the definition formula of f
*

Rsi and replacing the terms with the formula used within AnTherm θsi = θi*gSi + θe*gSe (valid 
for the two space case only!), one shell obtain as intermediate result: 

f
*

Rsi = ((θi*gSi+ θe*gSe) - θe) / (θi - θe)  

Considering simultaneously, that for the two space case also gSi + gSe = 1 is valid, thus gSe = 1 - gSi holds too, one receives short 
equation: 

f
*

Rsi = 1 - gSi  

or 

f
*

Rsi = gSe  

http://help.antherm.kornicki.com/Theory/TheoretischeGrundlagen.htm#Literatur
http://help.antherm.kornicki.com/Theory/TheoretischeGrundlagen.htm#Literatur
http://help.antherm.kornicki.com/Introduction/50_Rasterung.htm#SuperFineGrid
http://help.antherm.kornicki.com/Forms/ReportBuilder/ReportBuilder.htm#Results
http://help.antherm.kornicki.com/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#fRsiEvaluateTwoSpaceOnly
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Thanks to the super-refinement AnTherm evaluates temperature factors f
*

Rsi directly and precisely out of base solutions 
(the weighting factors) and independently of the dimensionality of thermal bridge (2D or 3D).  

 

 

Space corners in three dimensions 
 

At corners of spaces there are three two dimensional thermal bridges crossing over which consequently results in three 
dimensional distribution of temperatures. At such corners lower interior temperatures result when compared to those of 
two dimensional thermal bridges (edges). Therefore significantly higher risk of mould growth or vapour condensation is 
located here. 
 
Thanks to the super-refinement AnTherm evaluates temperature factors f

3D
Rsi directly and precisely out of base solutions 

(the weighting factors) and independently of the dimensionality of thermal bridge (2D or 3D). 
 

 

Minimum requirements (design factors) 
 

To reduce the mould growth risk by applying design measures several requirements shall be fulfilled. 
 
For example, for all structural, geometrical and material thermal bridges deviating from DIN 4108 Beiblatt 2, the 
temperature factor f

*
Rsi at the worst location must suffice the requirement of f

*
Rsi ≥ 0,70 . 

 
The respective design factors are specified in local regulations of the assessment of condensation or mould growth risk 
and vary strongly from country to country. 
 
 
See also: Results report, Bibliography, EN ISO 13788 
 
 

http://help.antherm.kornicki.com/Introduction/50_Rasterung.htm#SuperFineGrid
http://help.antherm.eu/Theory/SuperFineGrid.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
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Notes on calculation methods used in AnTherm to describe multidimensional 
vapour diffusion process 

 

This essay is available in German only. 
 
Update: The equation (14) of the EN ISO 13788 defines a factor ("water vapour diffusion conductance coefficient") equal to 
2*10

-10
 kg/Pa*m*s. If converted to the units used in AnTherm it leads to a factor 1,3888 (instead of 1,5 following earlier 

standards). To stay conformant with currents standards the factor 1,5 was changed to 1,3888 - or better to 10/7,2. One shall 
expect only marginal changes to the results! 

 

 

 

Notiz zu den von AnTherm verwendeten Berechnungsgrundlagen zur 
Beschreibung mehrdimensional ablaufender Wasserdampf-Diffusionsvorgänge 
 

Da das hier skizzierte physikalische Modell streng analog zum in AnTherm umgesetzten Modell zur Beschreibung 
mehrdimensionaler Wärmeströme ist, kann AnTherm unmittelbar auch zur Beschreibung von mehrdimensional 
ablaufenden Diffusionsvorgängen von Wasserdampf eingesetzt werden. Es ist lediglich die ... 
 

Ao. Univ. Prof. Dipl.-Ing. Dr. techn. Klaus Kreč, Büro für Bauphysik, Schönberg am Kamp, Österreich 
 
 
Update: In der EN ISO 13788 ist in Gleichung (14) ein Faktor ("Wasserdampfdiffusionsleitkoeffizient") definiert (2*10

-10
 

kg/Pa*m*s), der umgerechnet auf das im AnTherm verwendete Einheitensystem auf den Faktor 1,3888 (anstelle von 1,5 
nach früheren Normen) führt. Um konform mit den aktuellen Normen zu sein Faktor 1,5 auf 1,3888 - bzw. besser auf 10/7,2 
- gesetzt. Durch diese Änderung sind keine großen Veränderungen im Ergebnis zu erwarten! 
 

 
Lesen Sie hier weiter: 
 
 Notiz zu den von AnTherm verwendeten Berechnungsgrundlagen zur Beschreibung mehrdimensional 

ablaufender Wasserdampf-Diffusionsvorgänge (pdf)  

 

The above essay have been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
See also: Theoretical background 
 






http://help.antherm.eu/Introduction/81_Dampfdiffusion.htm
http://help.antherm.eu/Theory/Notiz_Diffusion.pdf
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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The air temperature in the unheated basement, a case study 
 

This essay is available in German only. 

 

Die Lufttemperatur im unbeheizten Kellergeschoß; eine Fallstudie 
 

Der Jahresverlauf der sich in einem unbeheizten Kellergeschoß einstellenden Lufttemperatur wird für verschiedenste 
Dämm-Varianten unter Zugrundelegung eines dreidimensionalen, zeitlich periodisch eingeschwungenen thermischen 
Modelles berechnet. Die Untersuchung der Wirksamkeit von Dämm-Maßnahmen im Bereich der Kellerdecke führt zum 
Ergebnis, dass die Reduktion der Wärmeverluste an den unbeheizten Kellerraum aufgrund von Zusatzdämmung wesentlich 
kleiner ausfällt als es bei Verwendung der üblicherweise angewandten eindimensionalen rechnerischen Abschätzungen zu 
erwarten wäre. 
 
Die Kenntnis des Jahresverlaufes der Raumlufttemperatur eines nicht beheizten Kellergeschoßes ist im allgemeinen aus 
mehreren Gründen von Bedeutung. Zum einen bestimmt die Temperaturdifferenz zwischen dem über dem Keller gelegenen, 
beheizten Geschoß und dem Kellergeschoß den Transmissionswärmeverlust durch die Kellerdecke und hat damit auch Einfluss 
auf den Heizenergiebedarf für das beheizte Gebäudevolumen. Zum anderen ist die Temperatur im Kellergeschoß 
entscheidend für die Möglichkeiten, dieses zu nutzen. So ist es interessant zu wissen, inwieweit der Keller zur Lagerung 
verderblicher Güter - z. B. von Lebensmitteln - geeignet ist. Insbesondere kommt auch der Frostsicherheit im Winter große 
Bedeutung zu. 
 
Zudem kann es gerade in unbeheizten Kellerräumen zu Oberflächenkondensation und in der Folge zu Schimmelbildung 
kommen, wenn die Oberflächentemperaturen der bodenberührten Bauteile über längere Zeit stark unter die 
Raumlufttemperatur absinken. Aus den genannten Gründen ist es erstrebenswert, den im langjährigen Schnitt zu 
erwartenden Jahresverlauf der Lufttemperatur in einem unbeheizten Kellergeschoß und die Temperaturen der dem 
Kellergeschoß zugewandten Bauteiloberflächen berechnen zu können. 
 
Die hier vorliegende Arbeit befasst sich ausschließlich mit der erstgenannten Problemstellung. Die Schilderung der auf die 
Ergebnisse der vorliegenden Untersuchung aufbauenden Berechnung der Oberflächentemperaturen soll einer späteren 
Publikation vorbehalten bleiben. 
 
...Die Berechnung des Jahresverlaufes der Lufttemperatur innerhalb eines unbeheizten Kellergeschoßes läuft auf die 
instationäre, zeitlich periodisch eingeschwungene Simulation des thermischen Verhaltens eines Raumes unter 
Berücksichtigung dreidimensional ablaufender Wärmeleitungs- und Wärmespeicherungsvorgänge hinaus. Das hier 
vorgestellte Simulationsmodell ist insofern vereinfacht, als etwaige Innenwärmen im Kellergeschoß vernachlässigt werden. 
Die Berücksichtigung von Innenwärmen bereitet - wie in [7] gezeigt - keine grundsätzlichen Schwierigkeiten, sodass auch 
die Entwicklung eines dreidimensional, periodisch eingeschwungen arbeitenden Rechenprogrammes zur Beschreibung des 
thermischen Verhaltens ganzer Gebäude prinzipiell realisierbar erscheint. 
 
Continue reading here: 
 
 Die Lufttemperatur im unbeheizten Kellergeschoß; eine Fallstudie (pdf) 

 

 
The above essay has been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
 
[7] K. Kreč, "Wärmeleitung in Baukonstruktionen unter Berücksichtigung von Wärmequellen", Gesundheitsingenieur 114, 
Heft 6, 313-318, 1993 
 
 
See also: Theoretical background 
 
 
 
 

http://help.antherm.eu/Theory/WKSB_94_34_korr.pdf
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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Heat losses from large buildings through the ground 
 

The heating demand of a building is strongly influenced by transmission heat losses through the ground, if the total thermal 

conductance of the building constructions in contact with the ground is in the same order as the thermal conductance of the 

building envelope in contact with the air. This will be the case in particular for such buildings, where the building 

constructions in contact with the ground take up a considerable part of the total area of the building envelope. On the one 

hand this situation is given for small buildings provided with a basement. On the other hand transmission heat losses through 

the ground are important for buildings with big floor areas in direct contact to the ground, e.g. for big halls. 
 
Transmission heat losses from a basement of a residential building were investigated in [1] and [2]. This paper deals with 
heat losses through various slab on ground constructions normally used for big industrial halls. 
 
Calculations of the heat flow through building constructions in contact with the ground are special cases on principle in that 
they cannot be done using the ordinary constant, one-dimensional (1D) thermal model. On the one side the heat flow through 
the ground can be described only using two or three spatial coordinates. From this heat losses through the ground are to be 
calculated using two- and three-dimensional (2D and 3D) thermal models. On the other side in most cases of interest the very 
big heat storage capacity of the ground involved in such heat flow calculations cannot be ignored, so that a non-steady 
calculation method is required. 
 
For most slab shaped building constructions in contact with the air the thermal quality of the construction with regard to 
heat losses can be characterized by an U-value in good approximation. Contrary to this the declaration of a U-value alone 
makes no sense for slab on ground constructions. The well known fact that the heat loss through a slab-shaped building 
construction can be calculated in good approximation by multiplying the U-value of the slab with it's area and with the 
difference of the air temperatures between internal and external environment is no longer true for slab on ground 
constructions. The heat flow through slabs on ground is not only influences by the U-value and the area of the slab but also 
by the geometry of the building construction in contact with the ground and by the thermal characteristics of the surrounding 
soil. For that reason quantitative statements concerning the heat through the ground are only true for the specific building 
under consideration. 
 
In this paper a case study concerning different insulation levels of a slab on ground construction is performed for an 
industrial hall with largely fixed geometry. From this study qualitative conclusions concerning the effectiveness of slab 
insulation is drawn. 
 
... The limitation of the heating demand of industrial halls often requires a reduction of the transmission heat losses 
through the ground. Generally calculations of heat losses through the ground require a three-dimensional, non-steady 
treatment. ... 
 
Continue reading here: 
 
 Heat losses from large buildings through the ground (pdf) 

 

 
The above essay have been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
 
[1] K. Kreč, "Wärmeverluste über erdbodenberührte Bauteile Fallstudie beheizter Kellerraum", WKSB 33,32-35 (1993)  
[2] K. Kreč, "Lufttemperatur im unbeheizten Kellergeschoß; eine Fallstudie", WKSB 34,42-47 (1994) 
 
See also: Theoretical background 
 
 
 
 

http://help.antherm.eu/Theory/WKSB_94_34.htm
http://help.antherm.eu/Theory/BUD_95G.pdf
http://help.antherm.eu/Theory/WKSB_94_34.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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Methods of thermal heat bridge survey in international perspective 
 

This essay is available in German only. Translation of the abstract: 
 
The recording of the effect of thermal bridges on the thermal behaviour of building constructions, rooms, room groups and 
buildings is becoming increasingly important in the course of the continuously increasing demand for thermal quality. The 
reason for this is the fact that the one-dimensional calculation of temperature distributions and heat flows in building 
constructions with well insulated construction methods, as they are state of the art today, delivers too inaccurate results. The 
effects of such oversimplified calculation methods can be misjudgments regarding the heating design and the expected 
heating energy demand, but also the overlooking of existing condensation risks. A metrological recording of the behaviour of 
building constructions with thermal bridges fails in particular with larger components or whole building parts because of the 
necessary effort. 
 
The importance of a sufficiently precise recording of thermal bridges, i.e. areas in which thermal conduction and storage 
effects can only be calculated using a 2- or 3-dimensional thermal model, has been taken into account since the beginning of 
the 1980s insofar as a large number of proposals have been discussed with regard to the introduction of correction factors for 
the recording of thermal bridges, programs for the simulation of 2- and 3-dimensional thermal processes have been created 
and offered and, finally, several working groups (TC 89: WG1, WG4 and WG5) have also addressed this problem in the course 
of European standardisation. 
 
In the following, a physically founded theoretical model for recording the thermal behaviour of building structures with 
thermal bridges will be presented and the implementation of this theoretical basis in practical use and the relevant provisions 
of European standardization (TC 89) will be discussed. 

 

 

Methoden der Erfassung von Wärmebrücken im internationalen Vergleich 
 

Der Erfassung der Auswirkung von Wärmebrücken auf das thermische Verhalten von Baukonstruktionen, Räumen, 
Raumgruppen und Gebäuden kommt im Zuge der laufend größer werdenden Anforderung an die thermische Qualität stark 
steigende Bedeutung zu. Grund hierfür ist der Umstand, dass die bisher eingebürgerte eindimensionale Berechnung von 
Temperaturverteilungen und Wärmeströmen in Baukonstruktionen bei gut gedämmten Bauweisen, wie sie heute Stand der 
Technik sind, zu ungenaue Ergebnisse liefert. Die Auswirkungen solch' übersimplifizierter Berechnungsmethoden können 
Fehleinschätzungen bezüglich der Heizungsauslegung und des zu erwartenden Heizenergiebedarfes aber auch das Übersehen 
bestehender Kondensationsrisiken sein. Eine messtechnische Erfassung des Verhaltens von Baukonstruktionen mit 
Wärmebrücken scheitert insbesondere bei größeren Bauteilen oder ganzen Gebäudeteilen am hierfür notwendigen Aufwand.  
 
Der Bedeutung einer genügend genauen Erfassung von Wärmebrücken, also Bereichen in denen Wärmeleitungs- und 
Wärmespeicherungseffekte nur unter Verwendung eines 2- oder 3-dimensionalen thermischen Modells berechnet werden 
können, wurde insofern seit Anfang der 80er Jahre Rechnung getragen, als eine Vielzahl von Vorschlägen bezüglich der 
Einführung von Korrekturfaktoren zur Erfassung von Wärmebrücken diskutiert wurde, Programme zur Simulation von 2- 
und 3-dimensional ablaufenden thermischen Vorgängen geschaffen und angeboten wurden und sich schließlich auch im 
Zuge der europäischen Normung etliche Arbeitsgruppen (TC 89: WG1, WG4 und WG5) dieser Problematik annahmen. 
 
Im Folgenden wird ein physikalisch fundiertes theoretisches Modell zur Erfassung des thermischen Verhaltens von 
Baukonstruktionen mit Wärmebrücken vorgestellt und auf die Umsetzung dieser theoretischen Grundlage im 
Praxiseinsatz sowie auf die diesbezüglich im Rahmen der europäischen Normung (TC 89) gesetzten Festlegungen 
eingegangen. 
 
Lesen Sie hier weiter: 
 
 Methoden der Erfassung von Wärmebrücken im internationalen Vergleich (pdf) 

 
 
The above essay have been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
See also: Theoretical background 

http://help.antherm.eu/Theory/BERLIN_1997.pdf
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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On three dimensional simulation of thermal behaviour of buildings 
 

This essay is available in German only. Translation of the abstract: 
 
The concept of harmonic thermal coupling coefficients is used to describe the multidimensional heat conduction processes 
taking place in the components of a building, taking heat storage into account. The design of a thermal network leads to an 
easily comprehensible concept for multidimensional programs for the simulation of the thermal behaviour of buildings. The 
possibilities and limits of such a simulation program are shown using the example of a residential building with a highly 
glazed south façade that is lowered into the ground. 
 
The simulation of the thermal behaviour of buildings requires, among other things, the computational recording of heat 
conduction and heat storage processes in the building components. In the last three decades, various calculation algorithms 
have been developed for this purpose - see e.g. Gertis & Hauser [1] or Feist [2]. However, the multitude of methods and 
programs for recording the thermal behaviour of buildings has one thing in common. The heat conduction equation is applied 
and solved in one-dimensional approximation. At best, multidimensional heat conduction processes are taken into account by 
introducing stationary correction factors. 
 
The necessity of considering areas of multi-dimensional heat conduction - usually referred to as "thermal bridges" - is not 
disputed for buildings that are thermally insulated according to today's building codes or thermal insulation regulations. Thus, 
in national (see e.g. ÖNorm B8110-1 [3]) as well as international standards [4], the consideration of thermal bridges in the 
calculation of the heating demand of buildings is mandatory. The calculation approaches specified in these standards are 
limited to stationary, i.e. time-independent, processes. Heat storage processes that influence the multidimensional heat 
conduction processes are not taken into account. 
 
This unsatisfactory situation was countered with the development of a theoretical concept that allows transient 
multidimensional heat conduction processes to be recorded taking into account heat storage [5, 6]. In the meantime, the 
concept of thermal coupling coefficients developed by Heindl et al. [7] has been anchored in the European standard on the 
mathematical treatment of thermal bridges [8]. The generalization of this concept to transient processes leads according to 
[5] to complex thermal coupling coefficients. The generalized conductance concept was at least taken over from the general 
approach in the international standard EN ISO 13786 [9]. The "generalized conductance" introduced in [5] is referred to in EN 
ISO 13786 as the "harmonic thermal conductance" - a term that is also to be used here. 
 
In the present work, a calculation model for a multi-dimensional simulation program for recording the thermal behaviour of 
buildings is presented and discussed with access to the theoretical principles developed in [7], [5] and [6]. 
 
... Programs which are based on the described physical model allow the multidimensional simulation of the thermal behaviour 
of buildings and are characterized by extremely short computation times and immediately interpretable results. The handling 
of the simulation module can be designed extremely simply for the user, since the three-dimensional modelling of the 
building, which is necessary for the computation of the conductance matrix and the heating power distribution key, takes 
place under access to a transient "thermal bridge program" in an advance computation. The results of the simulation - time 
curves of the indoor air temperatures and/or time curves of heating or cooling capacities - can be used to calculate the time 
curve of the temperature field within the building components by transferring them to the "thermal bridge program" used in 
the first step. Of course, it is also possible to call up the time course of the surface temperatures, which occurs taking into 
account the multidimensional heat conduction and heat storage processes. 
 
The heat storage effects occurring in the components of a building influence the heat flow that occurs. In multidimensional 
thermal models, these heat storage effects are not taken into account in building simulation programs commonly used today. 
With the calculation model discussed here, it will be possible to quantify the magnitude of the error caused by such neglect. In 
particular for summer suitability calculations, the planning reliability can be increased by now possible examination of the 
usually used simplified approaches. In addition, it is now also possible - as shown in the example - to check and optimise those 
design strategies that are used for heat storage systems. 
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Zur dreidimensionalen Simulation des thermischen Verhaltens von Gebäuden 
 

Das Konzept der harmonischen thermischen Leitwerte wird verwendet, um die in den Bauteilen eines Gebäudes 
mehrdimensional ablaufenden Wärmeleitungsvorgänge unter Berücksichtigung der Wärmespeicherung zu beschreiben. Der 
Entwurf eines thermischen Netzwerkes führt auf ein leicht überschaubares Konzept für mehrdimensional arbeitende 
Programme zur Simulation des thermischen Verhaltens von Gebäuden. Die Möglichkeiten und Grenzen eines derartigen 
Simulationsprogramms werden am Beispiel eines in den Erdboden abgesenkten Wohnhauses mit hochverglaster Südfassade 
aufgezeigt. 
 
Die Simulation des thermischen Verhaltens von Gebäuden erfordert unter anderem die rechnerische Erfassung von 
Wärmeleitungs- und Wärmespeicherungsvorgängen in den Bauteilen des Gebäudes. In den letzten drei Jahrzehnten 
wurden hierfür verschiedenste Berechnungsalgorithmen entwickelt – siehe z. B. Gertis & Hauser [1] oder Feist [2]. Der 
Vielzahl an Methoden und Programmen zur Erfassung des thermischen Verhaltens von Gebäuden haftet jedoch eine 
Gemeinsamkeit an. Die Wärmeleitungsgleichung wird in eindimensionaler Näherung angesetzt und – meist 
näherungsweise – gelöst. Mehrdimensional ablaufende Wärmeleitungsvorgänge werden bestenfalls mittels Einführung 
von stationären Korrekturfaktoren berücksichtigt. 
 
Die Notwendigkeit der Berücksichtigung von Bereichen mehrdimensionaler Wärmeleitung – schlagwortartig meist als 
“Wärmebrücken” bezeichnet – steht für Gebäude, die nach heutigen Bauordnungen oder Wärmeschutzverordnungen 
wärmegedämmt sind, außer Streit. So ist in nationalen (siehe z. B. ÖNorm B8110-1 [3]) wie auch internationalen 
Normenwerken [4] die Berücksichtigung von Wärmebrücken bei der Berechnung des Heizwärmebedarfes von Gebäuden 
zwingend vorgeschrieben. Die in diesen Normen angegebenen Berechnungsansätze bleiben auf stationäre, d. h. 
zeitunabhängige Vorgänge beschränkt. Wärmespeicherungsvorgänge, die die mehrdimensional ablaufenden 
Wärmeleitungsvorgänge beeinflussen, bleiben unberücksichtigt. 
 
Dieser unbefriedigenden Situation wurde mit der Entwicklung eines theoretischen Konzeptes, das instationär 
mehrdimensional ablaufende Wärmeleitungsvorgänge unter Berücksichtigung der Wärmespeicherung zu erfassen gestattet, 
begegnet [5, 6]. Mittlerweile ist das durch Heindl et al. [7] entwickelte Konzept der thermischen Leitwerte in der Europanorm 
über die rechnerische Behandlung von Wärmebrücken [8] verankert. Die Verallgemeinerung dieses Konzeptes auf 
instationäre Vorgänge führt gemäß [5] auf komplexwertige thermische Leitwerte. Das verallgemeinerte Leitwert-Konzept 
wurde zumindest vom allgemeinen Ansatz her in die internationale Norm EN ISO 13786 [9] übernommen. Der in [5] 
eingeführte “verallgemeinerte Leitwert” wird in der EN ISO 13786 als “harmonischer thermischer Leitwert” bezeichnet – ein 
Begriff, der auch hier verwendet werden soll. 
 
In der vorliegenden Arbeit wird unter Zugriff auf die in [7], [5] und [6] entwickelten theoretischen Grundlagen ein 
Berechnungsmodell für ein mehrdimensional arbeitendes Simulationsprogramm zur Erfassung des thermischen 
Verhaltens von Gebäuden vorgestellt und diskutiert. 
 
... Programme, die auf dem geschilderten physikalischen Modell aufbauen, erlauben die mehrdimensionale Simulation des 
thermischen Verhaltens von Gebäuden und zeichnen sich durch extrem kurze Rechenzeiten und unmittelbar interpretierbare 
Ergebnisse aus. Die Handhabung des Simulationsmoduls kann für den Benutzer äußerst einfach gestaltet werden, da die 
dreidimensionale Modellierung des Gebäudes, die zur Berechnung der Leitwert-Matrix und der 
Heizleistungsverteilungsschlüssel erforderlich ist, unter Zugriff auf ein instationäres "Wärmebrückenprogramm" in einer 
Vorwegberechnung erfolgt. Die Ergebnisse der Simulation - Zeitverläufe der Innenlufttemperaturen und/oder Zeitverläufe 
von Heiz- oder Kühlleistungen - können mittels Übergabe an das im ersten Schritt verwendete "Wärmebrückenprogramm" 
dazu verwendet werden, den zeitlichen Verlauf des Temperaturfeldes innerhalb der Bauteile des Gebäudes zu berechnen. 
Natürlich kann hierbei auch der Zeitverlauf der Oberflächentemperaturen, der sich unter Berücksichtigung der 
mehrdimensional ablaufenden Wärmeleitungs- und Wärmespeicherungsvorgänge einstellt, abgerufen werden. 
 
Die in den Bauteilen eines Gebäudes ablaufenden Wärmespeicherungseffekte beeinflussen den sich einstellenden 
Wärmestrom. In mehrdimensionalen thermischen Modellen bleiben diese Wärmespeicherungseffekte bei heute 
gebräuchlichen Gebäudesimulationsprogrammen unberücksichtigt. Mit dem hier diskutierten Berechnungsmodell wird es 
möglich sein, die Größenordnung des Fehlers, der durch solch' eine Vernachlässigung entsteht, zu quantifizieren. 
Insbesondere für Sommertauglichkeitsberechnungen kann durch die nun mögliche Überprüfung der üblicherweise 
verwendeten vereinfachten Ansätze die Planungssicherheit erhöht werden. Zudem ist es nunmehr - wie im Beispiel gezeigt - 
möglich, auch jene Entwurfsstrategien zu überprüfen und zu optimieren, die Wärmespeicherfähigkeitseffekte auszunutzen 
versuchen. 
 
Continue reading here:  
 

 Zur dreidimensionalen Simulation des thermischen Verhaltens von Gebäuden (pdf)      

http://help.antherm.eu/Theory/GI_1993_H1.htm
http://help.antherm.eu/Theory/GI_1993_H1.htm
http://help.antherm.eu/Theory/Waermebruecken_Heindl.htm
http://help.antherm.eu/Theory/GI_1993_H1.htm
http://help.antherm.eu/Theory/GI_1993_H1.htm
http://help.antherm.eu/Theory/GI_1993_H1.htm
http://help.antherm.eu/Theory/Waermebruecken_Heindl.htm
http://help.antherm.eu/Theory/Waermebruecken_Heindl.htm
http://help.antherm.eu/Theory/GI_1993_H6.htm
http://help.antherm.eu/Theory/GI_2000.pdf
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The above essay has been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
[1] Gertis, K. und Hauser, G.: Instationäre Berechnungsverfahren für den sommerlichen Wärmeschutz im Hochbau. 
Verlag Ernst & Sohn, Berlin, Berichte aus der Bauforschung, Heft 103, (1976)  
[2] Feist, W.: Thermische Gebäudesimulation. C. F. Müller Verlag Heidelberg 1994 
[3] ÖNorm B8110-1, Wärmeschutz im Hochbau – Anforderungen an den Wärmeschutz und Nachweisverfahren. (2000)  
[4] EN 832, Wärmetechnisches Verhalten von Gebäuden – Berechnung des Heizenergiebedarfs – Wohngebäude (1998)  
[5] Kreč, K.: On the Storage of Heat in Building Components (Zur Wärmespeicherung in Baukonstruktionen). 
Gesundheits-Ingenieur 114 (1993), H. 1, S. 11-18.  
[6] Kreč, K.: Wärmeleitung in Baukonstruktionen unter Berücksichtigung von Wärmequellen. Gesundheits-Ingenieur 114 
(1993), H. 6, S. 313-318.  
[7] Heindl, W., Kreč K., Panzhauser E. und Sigmund A.: Wärmebrücken. Springer-Verlag Wien-New York 1987.  
[8] EN ISO 10211-1: Wärmebrücken im Hochbau – Wärmeströme und Oberflächentemperaturen – Teil 1: Allgemeine 
Berechnungsverfahren. (1996)  
[9] EN ISO 13786: Wärmetechnisches Verhalten von Bauteilen – Dynamisch-thermische Kenngrößen – 
Berechnungsverfahren (1999) 
 
See also: Theoretical background 
 
 
 
 

http://help.antherm.eu/Theory/GI_1993_H1.htm
http://help.antherm.eu/Theory/GI_1993_H1.htm
http://help.antherm.eu/Theory/GI_1993_H6.htm
http://help.antherm.eu/Theory/GI_1993_H6.htm
http://help.antherm.eu/Theory/Waermebruecken_Heindl.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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On visualization of heat and vapour diffusion stream in three dimensional models 
 

The difficulties in the depiction of the flow of heat and vapour through three-dimensionally modelled building constructions 
are taken up. A method well suited for practical use in finding regions which are critical with regard to heat and water vapour 
transport is presented. The pseudo colour image of the absolute values of the flow densities of heat and/or diffusion of water 
vapour immediately shows the regions of increased heat or vapour diffusion flow. Furthermore the plot of single flow lines 
clearly shows the three-dimensional path of the heat or water vapour through the building construction. The expressiveness of 
this method is demonstrated by an example representing a building construction which was analyzed by a three-dimensional 
calculation using the new thermal bridge program AnTherm. 
 
This article is available in German only. 
 
See also: Theoretical background, http://dx.doi.org/10.1002/bapi.200690030 

 

 

Zur Visualisierung von Wärme- und Wasserdampfdiffusionsstrom bei dreidimensionaler 
Modellierung 

 

Klaus Kreč & Tomasz Kornicki  
1. Einleitung 
 
Bei der Berechnung des Wärmedurchgangs durch Baukonstruktionen hat sich im Fall zweidimensionaler Wärmeströmung 
seit langem die Darstellung des Wärmestroms mit Hilfe von Wärmestromlinien als wertvolles Hilfsmittel für den Bauplaner 
in der Baupraxis etabliert. Da ein Zusammenrücken der Wärmestromlinien Bereiche höherer Wärmestromdichte 
signalisiert, gibt ein Bild der Wärmestromlinien als eines der Ergebnisse einer Wärmebrückenberechnung auf einen Blick 
Aufschluss über die thermischen Schwachstellen der untersuchten Baukonstruktion. Das Bild der Wärmestromlinien 
ermöglicht es dem Bauplaner, rasch und effektiv sowohl Bauteilanschlüsse in Hinblick auf deren thermische Qualität zu 
optimieren als auch die richtigen Ansatzpunkte bei Sanierungsprojekten zu finden. 
 
Bei dreidimensionaler Modellierung besteht das Problem, dass die Stromfunktion zwar nach wie vor berechenbar ist, die 
Visualisierung der nun räumlich verlaufenden Kurvenschar aber nicht zu einer einfach lesbaren Ergebnisdarstellung führt. 
Diese Problematik wurde bei der Neuentwicklung des Wärmebrückenprogramms AnTherm [1] aufgegriffen und unter Zugriff 
auf die heute verfügbaren Mittel der Darstellung dreidimensional modellierter Objekte einer praxistauglichen Lösung 
zugeführt. 
 
2. Berechnung und Visualisierung der Wärmestromdichten 
 
Wie die meisten Wärmebrückenprogramme verwendet auch AnTherm die Methode der finiten Differenzen zur 
Beschreibung dreidimensional ablaufender Wärmeleitungsprozesse. Der Bauteil wird somit vor der eigentlichen 
Berechnung automatisch in Quader zerlegt. Die Zahl der Quader steigt im Allgemeinen rasch mit der Größe des 
modellierten Bereichs und/oder der Feinheit der Modellierung an. Im Gegensatz zu zweidimensionalen 
Berechnungsfällen erreicht die Anzahl der zu bilanzierenden Zellen bei dreidimensionalen Berechnungsfällen schnell 
Werte von einer oder mehreren Millionen. Bei den heute bereits auf Standard-PC’s verfügbaren Rechnerleistungen 
bereitet dieser Umstand jedoch keine Probleme mehr.  
Nach der Berechnung steht mit den Temperaturen in den Quadermitten, sowie den Seiten- und Kantenmitten und den 

Ecken der Quader eine Beschreibung des dreidimensionalen Temperaturfelds in einem üblicherweise sehr feinen Netz zur 

Verfügung. Somit kann auch für jeden Punkt des Netzes der Vektor der Wärmestromdichte errechnet werden. 
 
Um in einem ersten Schritt die Verteilung der Wärmestromdichte mit AnTherm anschaulich darzustellen, wird jedem 
Quader durch Mittelung ein Vektor der Wärmestromdichte zugeordnet und der Betrag dieses Vektors gebildet. Das Feld 
der Beträge der Wärmestromdichten kann nun in Form einer Falschfarbendarstellung anschaulich dargestellt werden. 
Ähnlich wie beim zweidimensionalen Fall besteht nun die Möglichkeit, Orte erhöhter Wärmestromdichte und somit 
thermische Schwachstellen der Baukonstruktion unmittelbar zu lokalisieren. 
 
In einem zweiten Schritt kann der Benutzer einen Punkt an der Oberfläche oder innerhalb der Baukonstruktion definieren 

und das Auszeichnen der Wärmestromlinie durch diesen Punkt verlangen. AnTherm ermöglicht es, die Oberflächen 

transparent oder durchscheinend zu gestalten. Es ist somit möglich, in die dreidimensional modellierte Baukonstruktion 

„hinein zu schauen“ und den Weg der Wärme durch den Bauteil in leicht verständlicher und prägnanter Darstellung zu 

verfolgen. 
 
 

 

http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm
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3. Ein Beispiel 
 
Die beschriebenen Möglichkeiten der Visualisierung dreidimensional verlaufender Wärmeströme soll im Folgenden an 
einem einfachen Beispiel demonstriert werden. 
 

 
Der modellierte Fall greift die Problematik des Wärme- und Dampftransports in Dach und Wänden eines Hallenbads auf, das 
einerseits an eine Wohnung und andererseits an die Außenluft grenzt. Die modellierte Baukonstruktion wurde von einem in 
[2] beschriebenen zweidimensionalen Fall abgeleitet. 
 
Die folgende, mit AnTherm generierte Skizze zeigt den untersuchten Ausschnitt aus der Gebäudehülle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Abb. 1: Dreidimensionale Darstellung des modellierten Ausschnitts 
 
 

Für das im unteren Bereich befindliche Hallenbad wurde bei den durchgeführten Berechnungen eine Lufttemperatur von 
30 °C und eine relative Luftfeuchtigkeit von 80% angenommen. Auf der rechten Seite grenzt ein Wohnraum mit 20 °C und 
53% r. F. direkt an das Hallenbad. Die thermische Verbindung nach außen ist im Hallenbad durch die rückseitig gelegene 
Außenwand (Betonwand mit außen liegender, 10 cm dicker Dämmschicht und Vorsatzschale aus Backstein) und das 
Flachdach gegeben. Der Wohnraum grenzt mit der rückseitig gelegenen Außenwand aber auch der über das Flachdach 
hinaus ragenden Außenwand nach außen. Diese Außenwand ist als zweischaliges Mauerwerk aus Backstein mit 5 cm 
Steinwolle als Kerndämmung ausgebildet. In der Berechnung wurde für die Außenluft eine Temperatur -12 °C und für die 
relative Luftfeuchtigkeit 80% angesetzt. 
 
Die folgende Abbildung zeigt als Ergebnisdarstellung die Verteilung der Wärmestromdichte im modellierten Ausschnitt in 
Form eines Falschfarbenbilds. 
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Abb. 2: Falschfarbenbild der Wärmestromdichte 
 
 
 
 
Wie nicht anders zu erwarten, treten die größten Werte der im Falschfarbenbild ausgewiesenen Beträge der 
Wärmestromdichten in den Kanten und Ecken der raumbegrenzenden Bauteile des Hallenbads auf. Da die Grafik in 
AnTherm beliebig im Raum gedreht und somit von allen Seiten betrachtet werden kann, sind die thermischen 
Schwachstellen der untersuchten Baukonstruktion rasch lokalisiert. 
 
Um geeignete Maßnahmen für eine Verbesserung der thermischen Qualität zu finden, ist es nun sehr wertvoll, den Weg 
der Wärme von einem als kritisch erkannten Punkt der inneren Oberfläche durch die Baukonstruktion zu kennen. Im 
Beispiel des Hallenbads soll der Weg der Wärme von der einspringenden Ecke nach außen visualisiert werden. Hierzu ist es 
zum einen notwendig, den Punkt, von dem aus eine Wärmestromlinie gezeichnet werden soll, festzulegen. Zum anderen 
muss die Oberfläche transparent gemacht werden, um in die Baukonstruktion hinein schauen zu können.  
Das mit Antherm generierte Ergebnis zeigt folgende Abbildung. 
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Abb. 3: Wärmestromlinie von der einspringenden Ecke nach außen 
 
 
Es zeigt sich, dass die Wärme nicht den geometrisch kürzesten Weg nimmt, sondern in der Stahlbetondecke schräg 
nach oben fließt, der Dämmschicht des Flachdachs ausweicht und schließlich durch die Außenwand nach außen 
abfließt. 
 
Als Planungsempfehlung ergibt sich nun unmittelbar, dass für eine Erhöhung der Temperatur in der einspringenden Ecke die 
Dämmung der Außenwand – und nicht jene des Flachdachs – verbessert werden muss. 

 

4. Berechnung und Visualisierung der Diffusionsstromdichten 
 
Bekanntlich kann der Transport von Wasserdampf durch eine Baukonstruktion mittels Diffusion mit einer formal der 

Wärmeleitungsgleichung entsprechenden Differentialgleichung beschrieben werden, sofern die Gültigkeit des 1. 

Fick’schen Gesetzes vorausgesetzt wird. Es ist daher nahe liegend, ein Wärmebrückenprogramm auch zur Beschreibung 
mehrdimensionaler ablaufender Wasserdampfdiffusionsprozesse heranzuziehen. 
 
In AnTherm wurde diese Möglichkeit genutzt, sodass nach einer mehrdimensionalen Berechnung nicht nur das 
Temperaturfeld sondern auch das Feld des Wasserdampfpartialdrucks verfügbar ist.  
Ein Vergleich der Verteilung des Wasserdampfpartialdrucks innerhalb der Baukonstruktion mit der aus den Temperaturen 
rückrechenbaren Verteilung des Sättigungsdampfdrucks zeigt unmittelbar, ob innerhalb des Bauteils mit Kondensatbildung 
gerechnet werden muss oder nicht. 
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Natürlich muss bei der Interpretation des Ergebnisses berücksichtigt werden, dass der Wasserdampftransport in 
Baukonstruktionen nicht allein durch Diffusion bewirkt wird und das Berechnungsergebnis somit nur als grobe Näherung für 
die in der Realität ablaufenden Vorgänge angesehen werden darf.  
Dennoch zeigt sich, dass die zwei- oder dreidimensionale Beschreibung der Wasserdampfdiffusion in Baukonstruktionen 

sehr gut geeignet ist, klare Hinweise auf feuchtigkeitstechnische Schwachstellen der Konstruktion zu liefern und/oder 

wertvolle Hilfestellung bei der Suche nach der Ursache von Bauschäden aufgrund von Durchfeuchtung zu geben. 
 
Dies soll im Folgenden am Beispiel des bereits behandelten, in Abb. 1 dargestellten Bauteilausschnitts demonstriert werden. 

Zur Visualisierung des Diffusionsstroms werden die gleichen, von AnTherm angebotenen Methoden verwendet, wie für den 

Wärmestrom. Die folgende Abbildung zeigt ein Falschfarbenbild, mit dem die Verteilung der Beträge der Vektoren des 

Wasserdampfdiffusionsstroms an den Oberflächen und innerhalb der Schnittfläche dargestellt wird. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Abb. 4: Falschfarbenbild der Wasserdampfstromdichte 

 
 

Der in Hinblick auf die Wasserdampfdiffusion kritische Bereich ist auf den ersten Blick erkennbar. Die mit Abstand höchste 
Dampfstromdichte stellt sich in der Kerndämmung der Wand zwischen Hallenbad und Wohnraum in Höhe des Flachdachs 
ein. Bedeutsam ist in diesem Zusammenhang, dass als Material der Kerndämmung Mineralfaserplatten, also ein Material mit 
extrem kleinem Diffusionswiderstand, verwendet wurde. Bautechnisch richtig wurde an der dem Wohnraum zugewandten 
Seite der Mineralfaserplatten eine PVC-Folie als Dampfbremse angebracht. 
 
Der Weg des Dampfstroms durch die Konstruktion kann ähnlich wie beim Wärmestrom mittels Auszeichnen einer 

Stromlinie dreidimensional gezeigt werden. Es ist nahe liegend, sich durch Auswahl von Punkten innerhalb der  
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als kritisch erkannten Zone der Kerndämmung ein Bild über den Weg des Wasserdampfs durch die Konstruktion zu machen. 
Die folgende Abbildung zeigt als Beispiel eines der von AnTherm erzeugten Stromlinienbilder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Abb. 5: Wasserdampfstromlinie von der inneren Oberfläche des Hallenbads nach außen 
 
 

Es zeigt sich, dass der Wasserdampf vom Hallenbad den direktesten Weg in die Kerndämmung nimmt, dort aufgrund des 
kleinen Diffusionswiderstands weit nach oben steigt und schließlich durch die äußere Backstein-Schale nach außen abfließt. 
Da der berechnete Wasserdampfpartialdruck im Bereich dieser vorgemauerten Backsteinschale erheblich höher ist als der 
Sättigungsdampfdruck, muss davon ausgegangen werden, dass es dort zu massiver Kondensatbildung kommen wird. 
 
Das gezeigte Beispiel erweist sich insofern als bedeutsam als in [2] berichtet wird, dass der dort zweidimensional 
betrachtete Fall einem gebauten Beispiel (Hallenbad in Poschavio in der Schweiz) entspricht, bei dem es zu starker 
Durchfeuchtung im Bereich der über dem Dach liegenden Außenwand der Wohnung gekommen ist. 
 
Besonders interessant ist dabei, dass der normgemäß in eindimensionaler Näherung nach Glaser für die zweischalige Wand 
durchgeführten Nachweis (siehe z. B. ÖNorm B8110-2 [3]) auf keine Kondensatbildung führt, die Konstruktion also als 
vollkommen unkritisch einstuft. Dies zeigt, dass mit mehrdimensionalen Berechnungen nicht nur im Fall der 
Temperaturverteilung sondern auch im Fall der Verteilung des Wasserdampfpartialdrucks eine erhebliche Steigerung der 
Planungssicherheit erreicht werden kann. 
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5. Zusammenfassung 

 
Die in Programmpaket Antherm [1] umgesetzte Vorgangsweise zur Visualisierung der Verteilung von Wärme- und 
Wasserdampfdiffusionsströmen hat sich bereits als praxistaugliche Methode für das rasche Auffinden von thermischen 
und hygrischen Schwachstellen in Baukonstruktionen etabliert.  
Das Visualisieren des Felds der Beträge der Wärme- und Diffusionsstromdichten mittels Falschfarbendarstellung zeigt auf 
einen Blick die kritischen Bereiche.  
Die Möglichkeit, den Weg der Wärme und/oder des Wasserdampfdiffusionsstroms dreidimensional mittels Auszeichnen 
einer einzelnen Stromlinie zu verfolgen, gibt zudem wertvolle Hinweise in Hinblick auf Planungsempfehlungen zur 
Verbesserung der thermisch-hygrischen Qualität einer Baukonstruktion. 
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Abstract 
 
Visualization of heat and water vapour diffusion flows in the case of tree-dimensional modelling; Klaus Kreč & Tomasz 
Kornicki 
 
The difficulties in the depiction of the flow of heat and vapour through three-dimensionally modelled building constructions 
are taken up. A method well suited for practical use in finding regions which are critical with regard to heat and water vapour 
transport is presented. The pseudo colour image of the absolute values of the flow densities of heat and/or diffusion of water 
vapour immediately shows the regions of increased heat or vapour diffusion flow. Furthermore the plot of single flow lines 
clearly shows the three-dimensional path of the heat or water vapour through the building construction. The expressiveness of 
this method is demonstrated by an example representing a building construction which was analyzed by a three-dimensional 
calculation using the new thermal bridge program AnTherm. 
 
 
 
 

Fig. 1: three dimensional view of the building construction (model) 
 
 
 
 
 

 

Fig. 2: pseudo colour image of the heat flow densities (heat flux) 
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Fig. 3: heat flow line depicting the path of heat through the building construction (heat stream line) 
 
 
 
 
 

 

Fig. 4: pseudo colour image of the water vapour diffusion flow densities (vapour flux) 
 
 
 
 
 
 

Fig. 5: heat flow line depicting the path of water vapour through the building construction (vapour 

stream line) 
 
 

 

 

 

Kurzfassung 
 
Die Problematik der Darstellung des Wärme- und/oder Dampfdiffusionsstroms durch dreidimensional modellierte 
Baukonstruktionen wird aufgegriffen und eine praxistaugliche Methode zur raschen Erkennung von thermischen und/oder 
hygrischen Schwachstellen vorgestellt. Das Falschfarbenbild der sich an den Oberflächen des untersuchten Bauteils 
einstellenden Beträge der Wärme- und/oder Dampfdiffusionsstromdichten zeigt unmittelbar Bereiche erhöhten Wärme-oder 
Diffusionsstroms auf. Das Auszeichnen einzelner Stromlinien gibt zudem Einblick in den Weg des Wärme- oder 
Diffusionsstroms durch die Baukonstruktion. Die Aussagekraft des vorgestellten Verfahrens wird anhand eines mit dem neuen 
Wärmebrückenprogramm AnTherm dreidimensional durchgerechneten Beispiels demonstriert.  
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The building envelope as thermal heat bridge 
 

This essay is available in German only. 

 

Die Gebäudehülle als Wärmebrücke 
 

Die Transmissionswärmeverluste der Gebäudehülle beeinflussen die im Inneren des Gebäudes zur Einhaltung einer Soll-
Temperatur erforderliche Heizleistung nachhaltig. Die Planung von Gebäuden mit niedrigem Heizwärmebedarf ist immer mit 
der Forderung einer Optimierung der Gebäudehülle in Hinblick auf die Reduktion der zu erwartenden  
Transmissionswärmeverluste verknüpft. Dies gilt auch für „sonnengestützte Häuser“, also für Gebäudeentwürfe, deren 
primäres Planungsziel eine möglichst gute Ausnutzung der Energie der auf das Gebäude einfallenden Sonnenstrahlung 
zwecks Reduzierung der erforderlichen Heizenergie ist. 
 
Um die thermischen Eigenschaften der Gebäudehülle erfolgreich optimieren zu können, bedarf es planungsbegleitender 
Berechnungen. Die hierzu verwendeten Hilfsmittel sind Computerprogramme, die es gestatten sowohl das thermische 
Verhalten einzelner Teile der Gebäudehülle als auch das thermische Verhalten des gesamten Gebäudes in Abhängigkeit von 
der Planungsvariante vorher zu sagen. Für die Entwickler solcher Programme sind die Anforderungen insofern besonders 
hoch, als einerseits die physikalische Modellierung detailliert genug sein muss, um Ergebnisse in solch’ einem  
Grad an Genauigkeit zu erhalten, dass sie dem Anspruch an eine hohe Planungssicherheit gerecht werden können. 

Andererseits muss bedacht werden, daß Überlegungen in Hinblick auf die Optimierung der thermischen Qualität des 

Gebäudes in frühen Planungsphasen besonders effektiv sind. Zielgruppe für Programme zur Beurteilung der thermischen 

Qualität von Baukonstruktionen und Gebäuden sollte aus diesem Grunde in erster Linie die Gruppe der PlanerInnen selbst sein 

und erst in zweiter Linie jene der Spezialfachleute wie z. B. BauphysikerInnen oder HaustechnikerInnen. 
 
Die Beschreibung des Transmissionswärmeverlustes eines Bauteils ist nur bei Verwendung eines thermisch eindimensionalen 
Modells der Handrechnung zugänglich. Die Erfahrung mit diesen einfachen Berechnungsmethoden zeigte bei nicht oder nur 
wenig wärmegedämmten Gebäuden eine erstaunlich gute Übereinstimmung zwischen berechnetem „Bedarfs-Wert“ und 
gemessenen „Verbrauchs-Werten“, sofern bei der Flächenermittlung auf Außenmaße zurückgegriffen wurde. Mit steigendem 
Anspruch an die thermische Qualität des Gebäudes wird jedoch das Rechnen mit eindimensionalen Modellen zunehmend 
ungenauer. Grund für diesen Trend sind mehrdimensional ablaufende Wärmetransportvorgänge, deren Auswirkung auf die 
Transmissionswärmeverluste der gesamten Gebäudehülle mit besser werdender Wärmedämmung stark ansteigt. Bei 
Gebäuden, deren Wärmedämmung den heute gültigen Bauordnungen und Verordnungen entspricht, ist die eindimensionale 
Rechnung bereits so ungenau, daß die erforderliche Planungssicherheit nicht mehr gegeben ist. Bei Passivhäusern mit ihren 
extrem hohen Ansprüchen an die Planungssicherheit ist das Erfassen von mehrdimensional ablaufenden 
Wärmeleitungsvorgängen – eine Thematik, die gerne unter dem Schlagwort „Wärmebrücken“ zusammengefasst wird – zu 
einem zentralen Punkt der Bauplanung geworden. 
 
Das Erfassen des thermischen Verhaltens von Wärmebrücken ist bei allen für die Baupraxis relevanten Fragestellungen nur 

mit dem Einsatz numerischer Methoden unter Zugriff auf so genannten „Wärmebrücken-Programme“ möglich. 

Obzwar mittlerweile eine Vielzahl solcher Programme existiert und am Markt angeboten wird, besteht die Problematik, daß 
die Handhabung der meisten dieser Programme für den Planer zu aufwendig ist. Aus diesem Grund werden 
Wärmebrückenberechnungen nach wie vor von Spezialfachleuten oder aber überhaupt nicht durchgeführt. Auch auf dem 
Gebiet der Planung von Passivhäusern findet eine planungsbegleitend durchgeführte rechnerische Optimierung der 
thermischen Eigenschaften von Bauteilanschlüssen nicht generell statt. Die Praxis, auf „passivhaustaugliche“  
Komponenten zuzugreifen, bringt zwar die erforderliche Planungssicherheit mit sich. Die wünschenswerte Förderung 
innovativer Planungslösungen wird auf diese Weise jedoch nicht unterstützt. 
 
Im Folgenden wird zunächst der wissenschaftliche Hintergrund und die normative Lage in Hinblick auf die Erfassung 
mehrdimensionaler Wärmeleitungsvorgänge kurz dargelegt und der derzeitige Stand der Technik bezüglich der angebotenen 
Wärmebrückenprogramme analysiert. Schließlich wird die Richtung einer gleichermaßen wünschenswerten wie auch 
notwendigen Weiterentwicklung auf dem Gebiet der thermischen Modellierung skizziert. 
 
Lesen Sie hier weiter: 
 

 Die Gebäudehülle als Wärmebrücke     
 

 
The above essay has been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
See also: Theoretical background 
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On the Storage of Heat in Building Components 
 

Examining heat storage in building construction materials and assemblies - often referred to as thermal storage - by 
means of a periodically oscillating model of thermal conduction leads to a generalized conductance concept (complex 
conductance matrices). This concept can serve as the basis for three- dimensional, non-steady-state (transient) 
calculations of the thermal performance of buildings. Relationships to the concept of effective thermal capacity 
(previously introduced in other publications) are established in context.  
... 
 
A correct treatment of heat storage processes in building structures is only possible by means of a thorough examination of 
relevant time-dependant heat flows. The concept presented here is only seemingly restricted to periodically fluctuating 
processes since a generalization which incorporates aperiodic functions as well is principally possible with the use of Laplace 
transforms. 
 
The segment of this discourse most relevant to the practical application of evaluating a building's thermal performance is the 
generalization of the already familiar conduction value concept for steady-state conditions to include periodically time-
dependant conditions as well. This provides the basis for calculating the thermal performance of entire buildings in which 
two- and three-dimensional heat conduction is considered - without a serious increase in complications as compared to one-
dimensional, time-dependant calculations. 
 
Continue reading here: 
 

 On the Storage of Heat in Building Components (pdf)     
 

 
The above essay has been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 

 
See also: Theoretical background 
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http://help.antherm.eu/Theory/TheoretischeGrundlagen.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

368 
 

 
 
 

Transient, multidimensional calculations by an example of components in contact with soil 
 

This essay is available in German only. 

 

Instationäre, mehrdimensionale Berechnungen am Beispiel erdbodenberührter Bauteile 
 

Die Instationär-Version von AnTherm bietet die Möglichkeit, im Zuge mehrdimensionaler Berechnungen auch die Einflüsse 

der Wärmespeicherfähigkeit zu berücksichtigen. Nun mag man vielleicht meinen, dass die Wärmespeicherfähigkeit nur im 

Sommer eine Rolle spielt und ihr in Zusammenhang mit Wärmebrückenberechnungen bestenfalls eine akademische 

Bedeutung zukommt. Diese Meinung mag in Zusammenhang mit luftberührten Bauteilanschlüssen durchaus berechtigt 

sein, sofern nur der Wärmedurchgang interessiert. Schon bei der Frage nach Oberflächentemperaturen oder Temperaturen 

im Bauteil wird die instationäre Berechnung bei massiver Bauweise zu deutlich anderen Planungsempfehlungen und 

Bewertungen führen als eine stationäre oder quasistationäre Rechnung. 
 
Bei einem wichtigen Sonderfall spielt die Wärmespeicherfähigkeit allerdings eine derart dominante Rolle, dass die 
Sinnhaftigkeit einer stationären oder quasistationären Betrachtungsweise von vornherein in Frage gestellt werden muss. Im 
Fall erdbodenberührter Bauteile sind weite Bereiche des ein Gebäude umgebenden Erdreichs in den Wärmetransport vom 
Gebäudeinneren nach außen einbezogen, sodass allein aufgrund der extrem großen Masse des vom Wärmedurchgang 
betroffenen Erdreichs Wärmespeichereffekte keinesfalls vernachlässigt werden können. 
 
Die Auswirkung der Vernachlässigung des Wärmespeichervermögens kann mit einem Blick auf das sommerliche 

Raumverhalten rasch plausibel gemacht werden: je größer das Wärmespeichervermögen der Bauteile ist, desto kleiner wird 

die Tagesschwankung der Innenlufttemperatur und in der Folge auch die Schwankung der Wärmeströme. Bei bodenberührten 

Bauteilen wirkt sich die Tagesschwankung der Außenlufttemperatur auf das Temperaturfeld im Erdboden kaum aus; aufgrund 

der extrem hohen Wärmespeicherfähigkeit spielt hier nur die Jahresschwankung der Außenlufttemperatur eine Rolle. Aber 

auch hier gilt: je größer die Wärmespeicherfähigkeit, desto kleiner ist die Jahresschwankung der Wärmeverluste. Wird nun 

der Einfluss der Wärmespeicherfähigkeit ignoriert, wie das bei allen stationären und quasistationären Berechnungsansätzen 

der Fall ist, erhält man eine viel zu große Jahresschwankung der Wärmeverluste. Das viel zu hohe Maximum der 

Wärmeverluste liegt dabei im Tiefwinter, also genau in jener Zeit, in dem eine möglichst genaue Erfassung der Wärmeverluste 

besonders wichtig ist. Bezogen auf die Normverfahren bedeutet dies, dass die quasistationäre, monatliche Berechnung mit 

Temperaturkorrekturfaktoren („f-Werten“), wie sie z. B. in der ÖNorm B8110-6 [1] oder in der Energieausweis-Berechnung 

verankert ist, tendenziell auf viel zu hohe Wärmeverluste führt. 
 
Zwar liegen diese quasistationären Ansätze auf „der sicheren Seite“, doch liegt die Größenordnung dieser Sicherheit in  
Bereichen, wo deren Sinnhaftigkeit angezweifelt werden muss [2]. Insbesondere bei der Planung von 
Niedrigenergiegebäuden, Passivhäusern und Plusenergiehäusern kann der Fehler einer nur überschlägigen (, doch sehr wohl 
normgemäßen) Berechnung der Wärmeverluste über die erdbodenberührten Bauteile in der gleichen Größenordnung liegen, 
wie die Summe der Wärmebrückenzuschläge für alle Bauteilanschlüsse des Gebäudes. Bei Gebäuden mir großflächigen 
bodenberührten Bauteilen, wie z. B. bei Werks- oder Lagerhallen, ist der Wärmeabflusses über den Erdboden nach außen und 
zum Grundwasser zumeist der bestimmende Faktor für das thermische Gebäudeverhalten. Bei einer zu ungenauen Erfassung 
dieser Wärmeverluste liegt die Gefahr von Fehleinschätzungen und Fehlplanungen sehr nahe. 
 
Auf dem Gebiet der Wärmeverluste über erdbodenberührte Bauteile besteht offenbar dringender Bedarf nach 
verfeinerten Berechnungsmethoden. Diese sollen helfen, die Planungssicherheit zu erhöhen und die Bewertung der 
thermisch-energetischen Qualität von Gebäuden realitätsnäher zu gestalten. Dies war ein Grund für die Entwicklung 
eines Anwenderbezogenen Simulationsprogramms, mit dem die Jahresverläufe der Wärmeverluste über 
erdbodenberührte Bauteile mit bisher nicht gekannter Genauigkeit berechnet werden können. 
 
Es war insofern nicht weiter schwierig, AnTherm und THESIM miteinander zu verknüpfen, als beiden Programmen der gleiche 
theoretische Ansatz zugrunde liegt. In der auf instationäre, periodisch eingeschwungene Vorgänge verallgemeinerten 
Leitwert-Theorie kann für jede Harmonische (d. h. für jeden rein sinusförmigen Zeitverlauf) die Wärmeleitungsgleichung exakt 
gelöst werden [3]. Da der aus den langjährigen Monatsmittelwerten gebildete, geglättete Jahresgang der 
Außenlufttemperatur sehr gut mit einer reinen Sinuskurve approximiert werden kann, bringt bereits die Rechnung mit nur 
einer Harmonischen eine brauchbare Näherung; durch Hinzunahme mehrerer Harmonischer kann eine Abweichung vom rein 
sinusförmigen Verlauf beliebig gut modelliert und die Genauigkeit des Berechnungsergebnisses nach Belieben gesteigert 
werden. 
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Die instationäre Leitwert-Theorie [3] kann als Grundlage eines Gebäudesimulationsprogramms, das die Mehrdimensionalität 
von Wärmedurchgang und Wärmespeicherung zu erfassen gestattet, verwendet werden. Programmpaket THESIM wurde 
nach den in [4] beschriebenen, auf die Leitwert-Theorie aufbauenden Simulationsalgorithmen entwickelt. Für den hier 
interessierenden Spezialfall des Wärmedurchgangs durch den Erdboden wurde das Simulationsprogramm THESIM mit einer 
Benutzeroberfläche kombiniert, die zwar die vielfältigen 

 

Möglichkeiten des Simulationsprogramms nur eingeschränkt nutzt, die Handhabung für den Benutzer damit jedoch sehr 
einfach werden lässt. Auf diese Weise wird erreicht, dass selbst dreidimensionale, instationäre Simulationen ohne großen 
Aufwand und ohne weitreichendes Spezialwissen möglich werden. 
 
 

Als pdf lesen: Instationäre, mehrdimensionale Berechnungen am Beispiel erdbodenberührter Bauteile       
 

 
Die obigen Artikel wurden mit der freundlichen Einwilligung von Klaus Kreč, Büro für Bauphysik, A-3562 Schönberg am 
Kamp, Veltlinerstr. 9, Österreich übernommen. 
 
 
[1] ÖNorm B8110-6, Wärmeschutz im Hochbau – Teil 6: Grundlagen und Nachweisverfahren – Heizwärmebedarf und 
Kühlbedarf, Ausgabe 2011-03-01  
[2] J. N. Nackler, Wärmeverluste erdbodenberührter Bauteile im Passivhausstandard – Vergleich verschiedener 
Berechnungsverfahren, Masterarbeit, Fakultät für Architektur und Raumplanung der TU Wien, 2010 (als Download unter 
www.thesim.at verfügbar)  
[3] K. Kreč, Zur Wärmespeicherung in Baukonstruktionen, Gesundheits-Ingenieur 114, Heft 1, 11-18, 1993 (als Download 
unter www.thesim.at verfügbar)  
[4] K. Kreč, Zur dreidimensionalen Simulation des thermischen Verhaltens von Gebäuden, Gesundheits-Ingenieur 121, Heft 
6, 293-344, 2000 (als Download unter www.thesim.at verfügbar) 
 
Siehe auch: Theoretische Grundlagen 
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Heat Transfer in Building Constructions in consideration of Heat Sources 
 

This essay is available in German only. 

 

Wärmeleitung in Baukonstruktionen unter Berücksichtigung von Wärmequellen 
 

Zum Thema der Wärmeleitern in Baukonstruktionen existiert eine umfangreiche Literatur. In der Mehrzahl der Fälle wird 
dabei nur der eindimensionale Fall der stationären Wärmeleitung abgehandelt. Der in der Realität vorliegende Fall der 
dreidimensionalen instationären Wärmeleitung wurde der praktischen Berechnung erst in letzter Zeit unter Zuhilfenahme 
der elektronischen Datenverarbeitung zuganglich. Ein derartiges Konzept, das zumindest zum Teil schon in anwendbare 
EDV-Programme umgesetzt ist, wird z. B. in [1] (stationärer Fall) und [2] (instationärer Fall) geschildert. 
 
Bedenkt man, dass die thermischen Vorgänge in einem Bauwerk nicht nur durch die Außenlufttemperatur und die 
Lufttemperaturen in seinen Innenräumen bestimmt werden, sondern ebenso durch die Wärmequellen, die infolge von 
Sonneneinstrahlung, langwelliger Wärmestrahlung und natürlich auch beim Betrieb von Heizkörpern auftreten, so wird 
einem klar, dass jedes Konzept, das diese Wärmequellen nicht berücksichtigt, unvollständig und wirklichkeitsfremd 
bleiben muss. 
... 
 
Wie solche Wärmequellen berücksichtigt werden können, wurde schon 1975 unter Beschränkung auf eindimensionale 
Wärmeleitung und flächenhafte Wärmequellen in [4] für den periodisch eingeschwungenen Fall besprochen. Hier soll der 
dreidimensionale Fall und der Zusammenhang mit dem in [2] geschilderten Leitwert-Konzept behandelt werden. 
... 
 
Die Berücksichtigung von Wärmequellen innerhalb oder an den Oberflächen einer Baukonstruktion ist im Rahmen des in [2] 
vorgestellten Leitwert-Konzeptes sowohl im stationären als auch im periodisch eingeschwungenen Fall ohne weiteres 
möglich. Die Auswirkung von Wärmequellen auf die thermischen Vorgange im Bauwerk lassen sich unabhängig von den 
jeweiligen Randbedingungen und unabhängig vom Wert der den Wärmequellen zugeordneten Heizleistungen beschreiben. 
Als kennzeichnende Größen zur Charakterisierung einer Wärmequelle dienen im Rahmen des hier vorgesteilten Konzeptes 
die Verteilungsschlüssel und die Heizleistungsamplituden. 
 
Die Berechnung von Heizleistungs-Verteilungsschlüsseln und von Leitwert-Matrizen (siehe [2]) ermöglicht es, das thermische 
Verhalten von Baukonstruktionen unter Berücksichtigung zwei- und dreidimensionaler Wärmeleitungsvorgänge instationär 
zu erfassen. Insbesondere liefert sie die grundlegenden Daten für dreidimensional rechnende Programme zur Simulation des 
thermischen Verhaltens ganzer Gebäude unter periodisch eingeschwungenen Verhältnissen. 
 
Lesen Sie hier weiter: 
 

Wärmeleitung in Baukonstruktionen unter Berücksichtigung von Wärmequellen (pdf)  
 

 
The above essay has been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 

 
[1] Heindl, W., Kreč K., Panzhauser E. und Sigmund A.: Wärmebrücken. Springer-Verlag Wien-New York 1987.  
[2] Kreč, K.: On the Storage of Heat in Building Components (Zur Wärmespeicherung in Baukonstruktionen). 
Gesundheits-Ingenieur 114 (1993), H. 1, S. 11-18.  
[3] Koch, H. A. und Pechinger, U.: Möglichkeiten zur Berücksichtigung von Sonnen- und Wärmestrahlungseinflüssen auf 
Gebäudeoberflächen. Gesundheits-Ingenieur 98(1977), H. 10, S. 265—280.  
[4] Haferland, Fr., Heindl, W und Fuchs, H.: Ein Verfahren zur Ermittlung des wärmetechnischen Verhaltens ganzer Gebäude 

unter periodisch wechselnder Wärmeeinwirkung und rechnerische Untersuchungen zur Ermittlung der Größenordnung 

bestimter Einflüsse von Bauweise und Konstruktion sowie sonstiger Parameter auf die Temperaturstabilität in Räumen. 

Berichte aus der Bauforschung H. 99, Verlag Wilhelm Ernst & Sohn Berlin — München 

— Düsseldorf 1975.  
[5] Frank. P. und Mises, R.: Die Differential- und Integralgleichungen. Band 2. Friedr. Vieweg & Sohn, Braunschweig 
1961. 

 

See also: Theoretical background 
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A practical method for the assessment of heat bridges with a view to surface condensation 
 

A practical method is presented to be used for assessing the steady-state thermal behaviour of heat bridges. This method 
bases of the fact, that the temperature at each point along the heat bridge can be represented as linear combination of the 
adjacent air temperatures. A single computer calculation of basic solutions allows to determine the standardized weights of 
these air temperatures for the construction concerned. Such calculations can be performed on personal computers without 
any difficulties by means of a specialized programme package. Both, this fact and the simple possibility of the subsequent 
determination of surface temperatures under arbitrary boundary conditions support the hope that heat bridges will no longer 
frighten us in future. 
 
This essay is available in German only. 

 

Ein praktisches Verfahren zur Beurteilung von Wärmebrücken im Hinblick 
auf Oberflächenkondensation 
 

Ein praktisches Verfahren zur Beurteilung des stationären thermischen Verhaltens von Wärmebrücken wird vorgesteilt. Es 

beruht auf der Tatsache, dass sich die Temperatur an jeder Stelle der Wärmebrücke als Linearkombination der 

angrenzenden Lufttemperaturen darstellen lässt. Die normierten Gewichte dieser Lufttemperaturen können durch eine 

einmalige EDV-Berechnung von Basislosungen für die jeweils vorliegende Konstruktion ermittelt werden. Solche 

Berechnungen sind mittels eines eigens entwickelten Programmpaketes auf Personal-Computern problemlos durchführbar. 

Dies und die einfache Möglichkeit der anschließenden Ermittlung von Oberflächentemperaturen unter beliebigen 

Randbedingungen geben zur Hoffnung Anlass, dass Wärmebrücken in Zukunft ihren Schrecken verlieren. 

... 
 
Die Autoren haben in Zusammenarbeit mit W. Heindl [4] Verfahren ... entwickelt, die — einmal angewendet — die 

thermische Beurteilung von Wärmebrücken im stationären Fall unter den verschiedensten Randbedingungen auf ähnlich 

einfache Weise ermöglichen, wie bei ,,eindimensional” erfassbaren Bauteilen. Das Verfahren beruht auf der Tatsache, dass 

die Fouriersche Wärmeleitungsgleichung bei Abwesenheit von Wärmequellen linear und homogen ist, jede Superposition von 

Lösungen daher wieder Lösung der Differentialgleichung ist. Es bedarf daher nur geschickt gewählter, linear 

unabhängiger ,,Basislösungen’, um die zu bestimmten Randbedingungen gehörige spezielle Losung durch 

Superposition — also ohne weitere aufwendige Berechnung — zu erhalten. 
 
In diesem Aufsatz wollen wir uns auf das Problem der Bestimmung der Oberflächentemperaturen im 
Wärmebrückenbereich beschränken. Das Problem der Bestimmung der Wärmeströme zwischen den durch eine 
Wärmebrücke thermisch verbundenen Räumen sei einer späteren Veröffentlichung vorbehalten. 
 
... 
 
Das bestehende Programpaket zur Berechnung der ,,Gewichte” an kritischen Stellen von Wärmebrücken und die  
Einfachheit der Verwendung dieser — einmal zu berechnenden — Gewichte zur Bestimmung der Oberflächentemperaturen 
sollten uns ermutigen, die nötigen Untersuchungen von Wärmebrücken nicht erst bei bereits ins Auge springenden 
Bauschäden zu beginnen.  
Hat man sich einmal vor Augen geführt, dass die Temperatur an jeder Stelle einer Wärmebrücke sich als Linearkombination 

der Lufttemperaturen der angrenzenden Räume ergibt, so ist nichts naheliegender, als die Gewichte (g-Werte) an den 

interessierenden Stellen des Wärmebrückenbereiches zu ermitteln; dies erfordert zwar einen einmaligen nennenswerten 

Aufwand, ermöglicht aber anschließend problemlose Berechnungen der Temperaturen an diesen Stellen, wobei nun der 

Aufwand kaum größer ist als bei Temperaturberechnungen im eindimensionalen Fall. 
 
Allen Betroffenen — vom Planer bis zum Benutzer des Gebäudes — wäre gedient, wenn aufgrund entsprechender normativer 
Festlegungen der Nachweis zu erbringen wäre, dass die verwendete Wärmebrückenkonstruktion bestimmten thermischen 
Anforderungen genügt. Bei ebenen Wänden werden derartige Nachweise schon lange verlangt (Mindestwärmeschutz); bei 
Wärmebrücken wären sie ebenfalls ohne weiteres möglich.  
Solche Normen sollten vom Planer verlangen, die Gewichte an kritischen Stellen der Konstruktion auszuweisen. Auf dieser 
Basis lassen sich für beliebige Lufttemperaturen der angrenzenden Räume die zugehörigen Oberflächentemperaturen leicht 
berechnen; damit können bereits quantitative Aussagen über die Gefahr der Bildung von Oberflächenkondensat gemacht 
werden. 
 
Die rasche Verbreitung leistungsfähiger Personal-Computer lässt erwarten, dass Rechenprogramme für stationäre 
mehrdimensionale Wärmeleitungsprobleme bald allgemein zuganglich und routinemäßig angewendet werden können. 
Alle Versuche, Wärmebrücken zu typisieren und deren thermisches Verhalten durch eine Vielzahl empirischer Formeln zu 
charakterisieren, erübrigen sich damit. 
 
 
 

http://help.antherm.eu/Theory/Waermebruecken_Heindl.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

372 
 

 
 

Lesen Sie hier weiter: 

 

 Ein praktisches Verfahren zur Beurteilung von Wärmebrücken im Hinblick auf Oberflächenkondensation (pdf) 
 
 

 
The above essay has been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
[1] Mainka, G.-W., Paschen, H.: Wärmebrückenkatalog. B.G. Teubner, Stuttgart 1986.  
[2] Erhorn, H., Tammes, E.: Eine einfache Methode zum Abschätzen balkenförmiger Wärmebrücken in Bauteilen mit 
planparallelen Oberflächen. Bauphysik (1985), H. 1, S. 7—11. 
[3] Berber, J.: Außenwinkel als Wärmebrücken. Bauphysik 6 (1984), H. 4, S. 142—144.  
[4] Heindl, W., Kreč K., Panzhauser E. und Sigmund A.: Wärmebrücken. Springer-Verlag Wien-New York 1987. 
 
See also: Theoretical background 
 
 
 
 
 
 
The "super" - refinement 
 

The gridding (discretization) algorithm of AnTherm subdivides the component model under consideration into cells which 
will be thermally balanced thereafter. The calculation algorithm creates for each such cell the heat balance equation and 
then solves the system of such equations. The solution results describe temperature field with values in the middles of cells. 
 
During the evaluation AnTherm will provide further refinement of this results. Here, by using heat balance and 
interpolation algorithms, AnTherm uses temperatures at cell centres to calculate temperatures at centres of cell edges, 
centres of cell surfaces and at each cell corner. 
 
As the nice result of such refinement the provisioning of much higher number of node values is available for the 
evaluation, hence the evaluation can be much more precise thereafter - for  
the two dimensional case the number of temperature nodes is fourfold the 
original cell count and in three dimensional case it is eightfold! 
 
For example, the calculation with 1.000.000 (one million) balanced cells 

provides results of thermal balance equations at more than 8.000.000 

(eight million) points! - and the operation is accomplished in surprisingly 

short computation time. In most cases in less then one minute! 
 
The most beneficial effect of this refinement can bee seen in that the 
temperatures at any material boundary can be provisioned that way! 
Material boundaries of special interest exist at the junction of different 
materials and, more importantly, at all surfaces of the component 
considered for analysis. 
 
Evaluating temperatures at component surfaces is essential to the 
evaluation and analysis of thermal bridges. Therefore the super refinement 
shall be seen as substantial calculation step. 
 
 
 
 
 
 

http://help.antherm.eu/Theory/BPH_1989_H5.pdf
http://help.antherm.eu/Theory/Waermebruecken_Heindl.htm
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Appropriate responses to the complex problem of finding the cause for mould growth? 
 

This essay is available in German only. 

 

Angemessene Antworten auf das komplexe Problem der Schimmelursachen? 
 

Die DIN 1946-6 spricht von der "Lüftung zum Feuchteschutz ohne Nutzerunterstützung" - genauere Analyse der 

unvermeidbaren Feuchtelast - zur Vermeidung von Schimmel an den wärmeschutztechnisch ungünstigsten Stellen der 

nutzerunabhängige Grundluftwechsel nur durch bauliche Maßnahmen (mindestens passiv) sichergestellt werden kann.  

 
Im September 2010 ist der DIN - Fachbericht 4108-8 mit dem Titel:“Wärmeschutz und Energieeinsparung in Gebäuden, Teil 

8: Vermeidung von Schimmelwachstum in Wohngebäuden” erschienen.  
Im Gegensatz zu Normfassungen wurde der Fachbericht nicht als Entwurfsfassung vorgelegt, so dass die breitere 

Fachöffentlichkeit keine Möglichkeit zur Mitwirkungs- und Einspruchsmöglichkeit hatte.  
Viele Inhalte des Fachberichts sind zu begrüßen, andere sind kritikwürdig oder sogar unzutreffend.  

 
Prof. Dr.-Ing. R. Oswald hat dazu eine Stellungnahme verfasst, in der auf eine schnelle Korrektur des Fachberichts 

gedrängt wird.  
Die Stellungnahme ist in der Zeitschrift „Der Bausachverständige“, Ausgabe 1/2011, erschienen. 
 
 
Lesen Sie hier weiter: 
 
 "Angemessene Antworten auf das komplexe Problem der Schimmelursachen?"  

Ein Sonderdruck und Stellungnahme Stellungnahme zum DIN-Fachbericht 4108-8 Vermeidung von 

Schimmelwachstum in Wohngebäuden (pdf)  
 
 
Siehe auch: Theoretische Grundlagen 
 
 
 

http://www.aibau.de/pdf_documents/Sonderdruck%20Oswald.pdf
http://www.aibau.de/pdf_documents/Sonderdruck%20Oswald.pdf
http://www.aibau.de/pdf_documents/Sonderdruck%20Oswald.pdf
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The concept of thermal conductance 
 

This essay is available in German only. 

 

Das Leitwert-Konzept 
 

Eine wichtige Grundlage für die Beschreibung des thermischen Verhaltens eines Körpers stellt der Fourier’sche  
Wärmestromansatz ... 
 
Lesen Sie hier weiter: 
 
 Das Leitwert-Konzept (pdf ) 

 

 
The above essay have been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 

 
[1] Kreč K.: Bewertung der Sommertauglichkeit von Gebäuden, Forschungsbericht im Auftrag der Initiative Ziegel im 
Fachverband der Stein- und keramischen Industrie, 31. März 2006  
[2] Stockinger, J., Kreč , K. & Seidl, J.: Thermisch optimierter Einsatz von Ziegel in Passivhäusern, Tagungsbericht der 8.  
Europäischen Passivhaustagung 2004, 205-219, Krems (2004)  
[3] Stockinger, J.: Thermisch optimierter Einsatz von Ziegel im Passivhaus, Master-Thesis, Donau-Universität Krems 
(2004) 
[4] Bruckmayer, F.: Der praktische Wärme- und Schallschutz im Hochbau, Deuticke-Verlag Wien (1949)  
[5] Koch H. A. & Pechinger, U.: Möglichkeiten zur Berücksichtigung von Sonnen- und Wärmestrahlungseinflüssen auf 
Gebäudeoberflächen. Gesundheits-Ingenieur 98, H. 10, S. 265-280, (1977)  
[6] Heindl W., Kreč K., Panzhauser, E. & Sigmund, A.: Wärmebrücken. Springer-Verlag Wien-New York (1987) 
[7] ÖNorm B8110-1, Wärmeschutz im Hochbau – Anforderungen an den Wärmeschutz und Nachweisverfahren. (2000)  
[8] EN ISO 10211-1: Wärmebrücken im Hochbau – Wärmeströme und Oberflächentemperaturen – Teil 1: Allgemeine 
Berechnungsverfahren. (1996)  
[9] Kreč, K.: Zur Wärmespeicherung in Baukonstruktionen. Gesundheits-Ingenieur 114, H. 1, S. 11-18, (1993)  
[10] ÖNorm EN ISO 13786: Wärmetechnisches Verhalten von Bauteilen – Dynamisch-thermische Kenngrößen – 
Berechnungsverfahren, Ausgabe: 2000-08-01 (2000)  
[11] Kreč, K.: Zur dreidimensionalen Simulation des thermischen Verhaltens von Gebäuden“, Gesundheits-Ingenieur 121, 
Heft 6, 293-344 (2000)  
[12] ÖNorm B8110-3, Wärmeschutz im Hochbau – Wärmespeicherung und Sonneneinflüsse, Ausgabe: 1999-12-01 
(1999)  
[13] EN 832, Wärmetechnisches Verhalten von Gebäuden – Berechnung des Heizenergiebedarfs – Wohngebäude 
(1998)  
[14] ÖNorm EN ISO 13791, Wärmetechnisches Verhalten von Gebäuden - Sommerliche Raumtemperaturen bei 
Gebäuden ohne Anlagentechnik - Allgemeine Kriterien und Validierungsverfahren (2004)  
[15] ÖNorm EN ISO 6946, Bauteile – Wärmedurchlasswiderstand und Wärmedurchgangskoeffizient – 
Berechnungsverfahren (2005)  
[16] Minke, G.: Lehmbau - Handbuch, Ökobuch, Staufen bei Freiburg (1999)  
[17] AnTherm V3.51, Programmpaket zur Analyse des Thermischen Verhaltens von Bauteilen mit Wärmebrücken, © 
2004 – 2007 T. Kornicki (2007)  
[18] GEBA V7.0, Programmpaket zur Simulation des thermischen Verhaltens von Räumen, Raumgruppen und 
Gebäuden, © 1996 – 2007 K. Kreč (2007)  
[19] THESIM V2.0, Programm zur mehrdimensionalen Thermischen Simulation eines Raums, © 1996 – 2007 K. Kreč 
(2007) 
 
 
See also: Theoretical background 
 
 
 
 

http://help.antherm.eu/Theory/2007_Das_Leitwert_Konzept.pdf
http://help.antherm.eu/Theory/Waermebruecken_Heindl.htm
http://help.antherm.eu/Theory/GI_1993_H1.htm
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Remarks to EN ISO 13786 (2000) 
 

This essay is available in German only. 

 

Anmerkungen zur EN ISO 13786 (2000) 
 

In diesem Anhang werden Inhalte der Norm ÖNorm EN ISO 13786 [1] analysiert und diskutiert. Hier bei wird generell auf die 
derzeit gültige Ausgabe vom 1. 8. 2000 Bezug genommen. Eine Besonderheit dieser Ausgabe ist, dass die Formeln zur 
Definition und zur Berechnung der wirksamen Wärmespeicherkapazitäten in der österreichischen Fassung dieser Norm durch 
ein nationales Vorwort umformuliert werden. Auf die Untersuchung der Hintergründe und Notwendigkeiten für diese 
Maßnahme wird hier besonderes Gewicht gelegt... 
 

 
Lesen Sie hier weiter: 
 
 Anmerkungen zur EN ISO 13786 (pdf) 

 
 
The above essay have been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 

 
[1] ÖNorm EN ISO 13786: Wärmetechnisches Verhalten von Bauteilen – Dynamisch-thermische Kenngrößen – 
Berechnungsverfahren, Ausgabe: 2000-08-01 (2000)  
[2] ON V 31: Katalog für wärmeschutztechnische Rechenwerte von Baustoffen und Bauteilen, Ausgabe: 1. 12. 2001 
(2001) 
 

 
See also: Theoretical background 
 
 
 

http://help.antherm.eu/Theory/2007_Anmerkungen_zur_EN_ISO_13786_2000.pdf
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Calculating the specific heat capacity of an equivalent component 
 

This essay is available in German only. 

 

Berechnung der spezifischen Wärmekapazität der Ersatzkonstruktion 
 

Der im Folgenden dargelegte Algorithmus erlaubt es, die spezifische Wärmekapazität der als Ersatzkonstruktion dienenden 
fiktiven, homogenen Schicht derart zu berechnen, dass die flächenbezogene wirksame Wärmekapazität dieser homogenen 
Schicht genau der flächenbezogenen wirksamen Wärmekapazität des mehrdimensional berechneten Ausschnitts der 
untersuchten Ziegelwand entspricht. 
 
Die flächenbezogene wirksame Wärmekapazität: Als Definition für die wirksame Wärmekapazität wird der Ansatz des  
nationalen Vorworts der ÖNorm EN ISO 13786 [1] in der Form ... 
 
 
Lesen Sie hier weiter: 
 
 Berechnung der spezifischen Wärmekapazität der Ersatzkonstruktion (pdf) 

 
 
The above essay have been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
 
[1] ÖNorm EN ISO 13786: Wärmetechnisches Verhalten von Bauteilen – Dynamisch-thermische Kenngrößen – 
Berechnungsverfahren, Ausgabe: 2000-08-01 (2000)  
[2] Bartsch, H.J.: Taschenbuch mathematischer Formeln, Verlag Harri Deutsch Thun, Frankfurt am Main (1982) 
 
 
See also: Theoretical background 
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The effective thermal heat capacity 
 

This essay is available in German only. 

 

Die wirksame Wärmespeicherkapazität 
 

Als zentraler Begriff für die Beschreibung der Wärmespeicherfähigkeit von Baukonstruktion-en wird die sog. „wirksame 
Wärmespeicherkapazität“ in verschiedenen Normenwerken verwendet. Aus diesem Grund ist es notwendig, sich mit dieser 
Kenngröße kritisch zu befassen und deren Aussagekraft zu analysieren ... 
 
Lesen Sie hier weiter: 
 
 Die wirksame Wärmespeicherkapazität (pdf) 

 

 

The above essay have been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
 
[1] Kreč K.: Bewertung der Sommertauglichkeit von Gebäuden, Forschungsbericht im Auftrag der Initiative Ziegel im 
Fachverband der Stein- und keramischen Industrie, 31. März 2006  
[2] Stockinger, J., Kreč , K. & Seidl, J.: Thermisch optimierter Einsatz von Ziegel in Passivhäusern, Tagungsbericht der 8. 
Europäischen Passivhaustagung 2004, 205-219, Krems (2004)  
[3] Stockinger, J.: Thermisch optimierter Einsatz von Ziegel im Passivhaus, Master-Thesis, Donau-Universität Krems 
(2004)  
[4] Bruckmayer, F.: Der praktische Wärme- und Schallschutz im Hochbau, Deuticke-Verlag Wien (1949)  
[5] Koch H. A. & Pechinger, U.: Möglichkeiten zur Berücksichtigung von Sonnen- und Wärmestrahlungseinflüssen auf 
Gebäudeoberflächen. Gesundheits-Ingenieur 98, H. 10, S. 265-280, (1977) 
[6] Heindl W., Kreč K., Panzhauser, E. & Sigmund, A.: Wärmebrücken. Springer-Verlag Wien-New York (1987)  
[7] ÖNorm B8110-1, Wärmeschutz im Hochbau – Anforderungen an den Wärmeschutz und Nachweisverfahren. (2000)  
[8] EN ISO 10211-1: Wärmebrücken im Hochbau – Wärmeströme und Oberflächentemperaturen – Teil 1: Allgemeine 
Berechnungsverfahren. (1996)  
[9] Kreč, K.: Zur Wärmespeicherung in Baukonstruktionen. Gesundheits-Ingenieur 114, H. 1, S. 11-18, (1993) 
[10] ÖNorm EN ISO 13786: Wärmetechnisches Verhalten von Bauteilen – Dynamisch-thermische Kenngrößen –  
Berechnungsverfahren, Ausgabe: 2000-08-01 (2000)  
[11] Kreč, K.: Zur dreidimensionalen Simulation des thermischen Verhaltens von Gebäuden“, Gesundheits-Ingenieur 121, 
Heft 6, 293-344 (2000)  
[12] ÖNorm B8110-3, Wärmeschutz im Hochbau – Wärmespeicherung und Sonneneinflüsse, Ausgabe: 1999-12-01 
(1999)  
[13] EN 832, Wärmetechnisches Verhalten von Gebäuden – Berechnung des Heizenergiebedarfs – Wohngebäude 
(1998) 
[14] ÖNorm EN ISO 13791, Wärmetechnisches Verhalten von Gebäuden - Sommerliche Raumtemperaturen bei  
Gebäuden ohne Anlagentechnik - Allgemeine Kriterien und Validierungsverfahren (2004)  
[15] ÖNorm EN ISO 6946, Bauteile – Wärmedurchlasswiderstand und Wärmedurchgangskoeffizient – 
Berechnungsverfahren (2005) 
[16] Minke, G.: Lehmbau - Handbuch, Ökobuch, Staufen bei Freiburg (1999)  
[17] AnTherm V3.51, Programmpaket zur Analyse des Thermischen Verhaltens von Bauteilen mit Wärmebrücken, © 
2004 – 2007 T. Kornicki (2007)  
[18] GEBA V7.0, Programmpaket zur Simulation des thermischen Verhaltens von Räumen, Raumgruppen und 
Gebäuden, © 1996 – 2007 K. Kreč (2007)  
[19] THESIM V2.0, Programm zur mehrdimensionalen Thermischen Simulation eines Raums, © 1996 – 2007 K. Kreč 
(2007) 
 
 
See also: Theoretical background 
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Thermal conductivity and heat storage within planar components (slabs) 
 

This essay is available in German only. 

 

Wärmeleitung und Wärmespeicherung in plattenförmigen Bauteilen 
 

Instationäre Wärmeleitungsprobleme, die natürlich auch die Berücksichtigung der Wärmespeicherung beinhalten, wurden in 
[1] in relativ allgemeiner Weise behandelt. Die dort geschilderten Methoden erlauben eine praktische Anwendung nur unter 
Einsatz entsprechender Computer-Programme, wenn man von besonders einfachen Fällen absieht. Diese einfachen Fälle sind 
jene, in denen eindimensionale Wärmeleitung vorliegt, also Wärmeleitung durch plattenförmige Bauteile bzw. durch Kugel- 
oder Zylinderschalen. 
 
Da plattenförmige Bauteile im Hochbau die Regel darstellen, scheint es der Mühe wert, für diese ein einfacheres 
Rechenverfahren anzugeben und zu diskutieren. Für stationäre Wärmeleitung sind diese Verfahren seit langem bekannt, für 
instationäre Wärmeleitung auch schon seit einigen Jahrzehnten - siehe z. B. [2, 3, 4, 5]. Diese Verfahren sollen nun in den 
größeren Zusammenhang der in [1] dargelegten Methoden gestellt werden... 
 
Lesen Sie hier weiter: 
 
 Wärmeleitung und Wärmespeicherung in plattenförmigen Bauteilen (pdf) 

 

 
The above essay have been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 
 
[1] Kreč, K.: Zur Wärmespeicherung in Baukonstruktionen. Gesundheits-Ingenieur 114, Heft 1, S. 11-18 (1993) 
[2] Carslaw, H.S. & Jaeger, J. C.: Conduction of heat in solids. Second edition, Oxford University Press (1959)  
[3] Heindl, W.: Neue Methoden zur Beurteilung des Wärmeschutzes im Hochbau. Die Ziegelindustrie, Hefte 4, 5, 6 (1967)  
[4] Masuch, J.: Untersuchung des thermischen Verhaltens klimatisierter Räume bei variabler innerer Temperatur. 
Dissertation; Berlin (1971)  
[5] Masuch, J.: Analytische Untersuchungen zum regeldynamischen Temperaturverhalten von Räumen. VDI-
Forschungsbericht 557 (1973)  
[6] ÖNorm EN ISO 13786, Wärmetechnisches Verhalten von Bauteilen – Dynamisch-thermische Kenngrössen – 
Berechnungsverfahren, Ausgabe 2000-08-01 (2000)  
[7] Eichler, F.: Praktische Wärmelehre im Hochbau. 4. Auflage, VEB-Verlag für Bauwesen, Berlin (1964) 
[8] Berber, J.: Bauphysik – Wärmetransport-Feuchtigkeit-Schall, Verlag Handwerk und Technik (1973)  
[9] Tschegg, E., Heindl, W. & Sigmund, A.: Grundzüge der Bauphysik, Springer-Verlag Wien New York (1984) 
 
 
See also: Theoretical background 
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On the definition of the effective thermal heat capacity 
 

This essay is available in German only. 

 

Zur Definition der wirksamen Wärmespeicherkapazität 
 

In diesem Anhang wird jener Ansatz für die wirksame Wärmespeicherkapazität hergeleitet, der im Vorwort der ÖNorm  
EN ISO 13786 [1] festgehalten ist... 
 

 
Lesen Sie hier weiter: 
 
 Zur Definition der wirksamen Wärmespeicherkapazität (pdf) 

 
 
The above essay have been incorporated with friendly permission from Klaus Kreč, Büro für Bauphysik, A-3562 
Schönberg am Kamp, Veltlinerstr. 9, Österreich/Austria . 
 

 
[1] ÖNorm EN ISO 13786: Wärmetechnisches Verhalten von Bauteilen – Dynamisch-thermische Kenngrößen – 
Berechnungsverfahren, Ausgabe: 2000-08-01 (2000)  
[2] ÖNorm B8110-3, Wärmeschutz im Hochbau – Wärmespeicherung und Sonneneinflüsse, Ausgabe: 1999-12-01 (1999) 
 
 
See also: Theoretical background 
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Tutorials and Cookbooks 
 

Tutorials shall help you to learn the AnTherm application quickly and efficiently. 
 
Examples and guides collected below shall explain the usage of the application. They shall allow the user to quickly learn the 
operation of the application and contain useful tips regarding input strategies also. 
 
Following tutorials are available: 
 
• Modelling and Evaluation Tutorial  
• VAPOUR - Tutorial  
• Usage Hints Introductory Tutorial  
• Transiente Simulation - Tutorial  
• Example images  
• Example: Results repot (edited)  
• Example: Coupling Coefficients report (edited)  

 

Hint: The application help window will always display on top (in front of) all other application windows when invoked 

directly from the application (via F1 key or the Help menu) and eventually overlap them. To have help window be freely 

switchable via desktop manager (which will allow you to bring the application windows to front) you shall start the 

application help from the windows start menu instead (Start-All Programs-AnTherm-Help) and browse the contents 

manually to the chapter of your choice.  
With the application setting "Help Window shown TopMost" the user can decide if the Help window will be shown 

topmost to all application windows and automatically minimize with the application (which is the windows default 

behaviour) or it can be set behind the application window via typical desktop window manager (default application 

setting). 

Example project files 

There are several example projects included within the application's installation to give you a quick start. You will find these 
examples in the subfolder "Beispiele" (means "examples" in german) of the installation folder (typically its is C:\Program 
Files\tkornicki\AnTherm\Beispiele ). After opening one of these example projects (via menu Help->Example Load...) please 
save a working copy of it to your private folder (menu File->Save as...). 
Below the listing of some: 

BEISPIEL_1    3-dimensional modelling of an building corner with balcony. This example is identical to the 3rd validation example 
of EN ISO 10211. 

BEISPIEL_2    3-dimensional modelling detail of a glass roof over indoor swimming pool. To avoid condensation one of the joists 
is heated by filament (heating power can be entered).  

BEISPIEL_3    3-dimensional modelling detail of exterior wall of vertically perforated bricks.  
The calculation of heat transport is executed to obtain medium U-Value for unrendered wall.  

DEMO1_3D Wall corner made of homogenous material, plastered on both sides with concrete ceiling with plaster. Three-
dimensional calculation. 

DEMO3_3D Masonry wall corner plastered on both sides with concrete ceiling with plaster. Three-dimensional calculation. 

Hallenbad_2D VAPOUR - Tutorial: Example of two dimensional heat and vapour transport (diffusion) and interstitial condensation 
risk assessment.  
Junction detail of flat roof of an indoor pool. Dividing wall between living room and indoor swimming pool: double 
skin brick wall with 5 cm core insulation. Calculation of the heat and vapour transport. 

Hallenbad_3D VAPOUR - Tutorial: Example of three dimensional heat and vapour transport (diffusion) and interstitial 
condensation risk assessment.  
Junction details of the flat roof over an indoor pool. Dividing wall between living room and indoor swimming pool: 
double skin brick wall with 5 cm core insulation. Exterior wall of the swimming pool: 25 cm concrete, 15 cm core 
insulation, 12.5 cm brick sheathing. Calculation of the heat and vapour transport   

overlap Example showing effect of overlapping principles of data entry. Flipping the order of elements results in different 
overlapping product. Try reordering (promote/demote) of a selected element. 

TUTOR2_orig TUTORIAL - 2-dimensional: Reinforced concrete slab with masonry bearing wall on girder over carport (+ exterior 
insulation and electric heating cable assembly embedded in concrete floor topping).  

TUTOR3_orig TUTORIAL - 3-dimensional: Corner construction over carport. Masonry bearing wall on girder over carport and 
bonded with concrete floor slab (+ ext. insul, perimeter insul., elect. heating assembly in floor topping).  

http://help.antherm.eu/Tutorials/tutor02en/index.htm
http://help.antherm.eu/Tutorials/dampf01/index.htm
http://help.antherm.eu/Tutorials/tutor01/index.htm
http://help.antherm.eu/Tutorials/TransientSimulation_Nackler/TransientSimulation.htm
http://help.antherm.eu/Tutorials/Bilder/Bilder.htm
http://help.antherm.eu/Tutorials/ErgebnisBericht_example01/index.htm
http://help.antherm.eu/Tutorials/LeitwertBericht_example02/index.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm#Projektdateien
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Hilfe
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Speichern unter...
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Tutorials/dampf01/index.htm
http://help.antherm.eu/Tutorials/dampf01/index.htm
http://help.antherm.eu/Tutorials/tutor01/50_Elementueberlagerung.htm
http://help.antherm.eu/Tutorials/tutor02en/index.htm
http://help.antherm.eu/Tutorials/tutor02en/3d/3d_00_ThreeDimensionalAnalysis.htm


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

381 
 

EN ISO 10077 All conformance validation examples of EN ISO 10077 (Frames). 

EN ISO 10211 All conformance validation examples of EN ISO 10211 (Thermal bridges). 

EN ISO 13786 All validation examples of EN ISO 13786 (Dynamic thermal indicators). 

Remark: To quickly reach examples installed within the example folder use the  Menu Help->Example Load... . 

Remark: Further tutorials, references, examples, videos and imagery of AnTherm can be available at the AnTherm's website 
or Blog also. Please visit them frequently. You will find the link to AnTherm's web within the Help menu. 

  

See also: Introduction, Data Entry & Input windows, Evaluations and Results 

 
 
 
 
 
 
 
Modelling and Evaluation Tutorial 
 

The program operations shall be illustrated here with step-by-step instructions for analysing a demonstration object. The 
procedures of input and evaluation can be followed as described to generate and evaluate two- and three-dimensional input 
models equivalent to the examples contained in the distribution. These completely calculated model files, which can be 
perused before working with this program directly, also serve as an object of comparison and aid towards successful 
completion of the model as described in the following. 
 
Note: To quickly reach examples contained in the distribution you shall use menu Help->Example Load... . 
 
> Start reading with "Object of Analysis"... 
 
 
 
 
 

 

Hint: The application help window will always display on top (in front of) all other application windows when invoked 

directly from the application (via F1 key or the Help menu) and eventually overlap them. To have help window be freely 

switchable via desktop manager (which will allow you to bring the application windows to front) you shall start the 

application help from the windows start menu instead (Start-All Programs-AnTherm-Help) and browse the contents 

manually to the chapter of your choice.  
With the application setting "Help Window shown TopMost" the user can decide if the Help window will be shown topmost 

to all application windows and automatically minimize with the application (which is the windows default behaviour) or it 

can be set behind the application window via typical desktop window manager (default application setting). 
 

 
 
 

See also: Usage Hints Introductory Tutorial 
 
 
 
 
 
 

http://help.antherm.eu/Validierung/Validierung_EN_ISO_10077.htm
http://help.antherm.eu/Validierung/Validierung_EN_ISO_10211.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Hilfe
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Hilfe
http://help.antherm.eu/Introduction/Einfuehrung.htm
http://help.antherm.eu/Forms/Bearbeitungsfenster.htm
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Tutorials/tutor02en/00_ObjectOfAnalysis.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Tutorials/tutor01/index.htm
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Object of Analysis 
 

The demonstration object to be modelled and evaluated encompasses the corner region of a masonry and concrete 
construction over an exterior space (e.g. carport). As illustrated in the axiometric (axonometric) rendering below, the 
masonry bearing wall is bonded with the concrete floor slab along the side which flanks the exterior space underneath, 
and supported by a girder spanning an opening in the other direction. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
 
 

The standard masonry wall construction is a total of 35.5 cm thick, composed of (from the exterior): 

2.5 cm    stucco  

30.0 cm    masonry  

2.0 cm    interior plaster 

In the region flanking the floor slab, the masonry wall is substituted by: 

2.5 cm     stucco  

6.0 cm     perimeter brick  

4.0 cm     perimeter insulation  
(floor slab) 

The reinforced concrete girder supporting the other side of masonry is encased in 7.0 cm of standard insulation.  

The floor construction over the exterior space is built up to a total thickness of 41.5 cm with: 

0.5 cm     exterior plaster 

12.0 cm     insulation 

0.5 cm     adhesive mortar 
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17.5 cm     reinforced concrete 

2.0 cm     sand cushion 

3.0 cm     isolating underlayment* 

1.0 cm     embedded heating assembly (concrete)* 

5.0 cm     concrete topping* 

    *- expansion strip along outer perimeter (0.4 cm ) 

Despite extensive exterior insulation, such a prominent corner situation could prove to be a critical thermal bridge. A 
potential heat source has also been included to simulate an electrical floor heating assembly in the concrete topping. The 
efficiency of such a heating alternative in this exposed location can thus be assessed as well. 

> Continue reading with "Stages of Analysis"... 

 
 
 
 
 
 
Stages of Analysis 
 

The most critical cross-section of the object under consideration is through the wall/floor connection at the girder. This 
section shall be modelled and evaluated first in the two-dimensional mode of the program. The results obtained here 
would be valid for the region of the thermal bridge in which heat flow can be expected to occur strictly parallel to the 
section plane, i.e. at least approximately 1 m from the corner. Instructions for this application are provided in the next 
chapter to this tutorial, Two-dimensional Analysis. 
 
In order to obtain a picture of the temperature distribution in the apparent thermal bridge at the outer corner of the 
construction, a three-dimensional model of the situation must be generated for evaluation. The procedures of this stage 
are treated in the chapter on Three-dimensional Analysis.  
To facilitate input in three-dimensional mode, the previously generated two-dimensional model can serve as the first layer 
(component group) and reference basis for further component group input. The transformation of an object from two to 
three dimensions by means of the input branch of the program is outlined in the section on Generating the Model - Input / 
Transforming an Existing 2-Dimensional Model. 
 
> Continue reading with "Two-dimensional Analysis"... 
 
 

 
 
  

http://help.antherm.kornicki.com/Tutorials/tutor02en/10_StagesOfAnalysis.htm
http://help.antherm.eu/Tutorials/tutor02en/3d/3d_00_ThreeDimensionalAnalysis.htm
http://help.antherm.eu/Tutorials/tutor02en/3d/3d_10_GeneratingThe3dModel.htm
http://help.antherm.eu/Tutorials/tutor02en/3d/3d_10_GeneratingThe3dModel.htm
http://help.antherm.eu/Tutorials/tutor02en/2d/2d_00_TwoDimensionalAnalysis.htm
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Two-dimensional Analysis 
Modelling the Object 
 
 

Before actually working with the program, a sketch of the object should be prepared in which relevant data is summarised 
for model input. Such a sketch of the two-dimensional demonstration object would include the information shown below: 
dimensions, reference coordinates, and material properties. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

Since negative coordinate values are allowed, the positioning of the graph origin (x=0, y=0) is generally arbitrary. The 
reference coordinates shown here, however, are the ones consistent with the geometric input data as related in the next 
section. 

Continue reading with "Generating the Model - Input" ... 

 
 

  material   λ [Wm
-1

K
-1

] 

0  stucco  0.800 

1  masonry  0.164 

2  interior plaster  0.700 

3  exterior plaster  0.800 

      

4  insulation  0.041 

5  adhesive mortar  0.271 

6  reinf. concrete  2.200 

      

7  sand  1.000 

8  expansion strip  0.150 

9  isol. underlayment  0.040 

10  concrete topping  1.200 

      

  space   α [Wm
-2

K
-1

] 

0  exterior  25 

1  interior  6 

http://help.antherm.eu/Tutorials/tutor02en/2d/2d_10_GeneratingThe2dModel.htm
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Generating the Model - Input 
 

The program is called up with the Start-Menu Start→Programs→AnTherm→AnTherm, whereupon the default screen 
configuration appears. 
From the main menu select File→New→2D Project. In the Description window enter some text information identifying the 
current project, e.g. 
 
TUTORIAL - 2-dimensional:  
Reinforced concrete slab with masonry bearing wall on girder over 

carport (+ exterior insulation and electric heating cable assembly 

embedded in concrete floor topping). 
 
 

Note: Whatever text is typed here will be included at the head of program printouts (model documentation and numeric 

results). This screen can be accessed from the main window at any time by selecting View→Windows→Description. 
 
Make sure Element input windows are open. There shall be at least Elements2D and ElementsBrowser widows already 
open now. If not, go into View-Menu and select View→Primary Edit Windows. 
 
You can close the Elements 3D and Layer Browser window if displayed, by clicking on X at its top-right corner, since 
those windows are not being referenced in this tutorial. 
 
The first element to be entered is the exterior space. On the ElementsBrowser window click New button. The element 
Edit window ( a Box Editor) shall reveal and a new, empty element shall list in the elements' list. 
 
The boundaries of element 1 shall demarcate the full extent of the model with 
 

X_1: -100 X_2: 1525 

Y_1: 0 Y_2: 2200 

 

 Start entering the coordinates by entering -100 for x1 first. 

 Then press TAB-key to move the input focus to x2. 

 Enter 1525 for x2 and TAB to next field, which is y1. 

 Enter 0 for y1 and TAB to y2. 

 Enter 2200 for y2 and confirm again with TAB. 

 
Having now the focus in the "Box Type" field press arrow-down key to select "Space Box" as the type of this element (or 
either use the mouse to select the requested type). 
 
Now TAB twice (skipping the Group entry for now) to move the input focus into "Surface Name" field. Enter "exterior 
surface" and TAB to its alpha value. Enter 25 and confirm the entry with the TAB again. 
 
Name the room with "exterior" which will be later used to setup the temperature for this boundary. Confirm with TAB. 
 
Once these entries are confirmed, element 1 is complete and the program is ready for input of the next element. 
 
Now it would be worthwhile to re-scale the control graph for a better view of the component during input of successive 
elements: press Fit on the Element2D window and let the application redraw the graph. 
 
Note to earlier WAEBRU users: As opposite to Waebru, AnTherm's Element 2D View does always show all elements of the 
one (and within the 2D model the only) layer. There is no such option to select the object display level to aggregate. Naming 
of groups and grouping is done directly to each element. 
 
Before setting out to build up the material component, some thought should be given to the sequence of element input so 
as to best utilise the advantages of element overlapping. To illustrate this principle, the demonstration example described 
here has been organised into construction parts of predominantly parallel material layers. This simplifies coordinate input 
substantially. 
The first part of the model to be entered is the wall structure. An "onion skin" sequence begins at the outermost layer 
(stucco) with the second element: 
 

X_1: 0 

X_2: 1525  
Y_1: 1175 

Y_2: 2200 
 
 
On the ElementsBrowser window click New button again. The element Edit window (the Box Editor) shall reveal and a 
new, empty element shall list in the elements' list next to the one entered before. 
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Enter the coordinates and confirm each entry with a TAB key as before. Using arrow keys while the focus is at the Box 
Type select "Material Box". 
TAB to Material Name and enter stucco. 
TAB to Lambda field and enter 0.8. 
 
Note: While using international features windows provides you with country specific setting for decimal comma. This shall 
allow you to use numeric pad of your keyboard for entering number correctly. Please observe, that entering 0,8 (with 
comma instead of dot) might result in 08 if your setting of current operating system locale (typically Regional Setting of the 
System's Control Panel) defines different character (for example a dot) for decimal comma. The opposite might also be valid 
(e.g. german system use comma - the , character) for decimal comma. If the system is set up properly for your country, the 
numeric pad's comma will provide the right character to the input. 
 
The control graph should now look like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

To insert next new element use the context menu available to the Box Editor. Over the Box Editor click the right mouse 
button to reveal the Edit context menu. Select Add→Append. 
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The next element is the masonry wall, which overlaps - and thereby displaces - all but a thin strip of stucco (25 mm to the 
left and bottom): 
 

X_1: 25 

X_2: 1525  
Y_1: 1200  
Y_2: 2200 

Box type: Material Box 

Material name: Masonry wall 

Lambda: 0.164 
 
 

TAB to x1 and proceed with entering the data as before. 
 
The interior plaster, the fourth element, delineates the right side of the masonry. 
 
Instead of using New on ElementsBrowser or the context menue's Add→Append sequence to add that next element to the 
list use "Duplicate" on the Box Editor window. Since you have just TABbed to it and it is visible marked as focused, simply 
press ENTER to execute the Duplicate operation. 
 
Here, only one coordinate of the set still visible from element 3 needs to be adjusted to leave 200 mm of masonry 
thickness: 
 

X_1: 325 

X_2: 1525 

Y_1: 1200 

Y_2: 2200 

Box type: Material Box  
Material name: Interior plaster 

Lambda: 0.7 
 
 

TAB to x1 and proceed with entering the data as before. 
 
When you confirm the entry and TAB to "Duplicate" press ENTER receiving again a copy of the lately active (selected) 
element. This simplifies the input to just the need of changing the things which are different for the new element and also 
leaves your hand off the mouse. 
 
The next new element is the "kernel" of this part of the aggregate: the interior space overlapping all but the total wall 
thickness (with extended strip of stucco) of the material entered thus far: 
 

X_1: 345 

X_2: 1525 

Y_1: 1200  
Y_2: 2200 

Box type: Space Box 

Surface name: interior surface 

Alpha: 6 

Room name: interior 
 
 

Create new element, TAB to x1 (if needed) and proceed with entering the data as before. 
 
The last element edited is shown selected in the ElementsBrowser window. Holding the control-key click over the line 
with that selected element to deselect it. The selection mark shall disappear. 
 
The control graph should now display the following figure of the standard masonry construction: 
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Note: The illustration above shows only the silhouette of the component in its current state. 
 
The second part of the construction to be entered is the insulated girder, followed by the concrete floor slab with its 
exterior insulation. The final part of input covers the interior floor construction over the slab. These sequences are 
covered in the section on Completing the Component further on in this tutorial. 
 
Continue reading with "Completing the Tables" ... 
 
 
 

http://help.antherm.eu/Tutorials/tutor02en/2d/2d_20_CompletingTheTables.htm
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Completing the Tables 

 

With the over-all sequence of input in mind, the table of building materials can be completed in one uninterrupted input 
series. Once complete, the list of available material properties can be accessed from Materials window to facilitate 
material identification and input. 
 
Any of the elements of type Material Box can than be subsequently assigned using the material table. 
 
Select View→Windows→Material Window to reveal the list of Materials. If the list is empty we will have to re-enter 
materials used so far: 
 
Right-click on the Material window and select Add Material from the context menu shown. An template of a material is 
added to the list. Right-click at that new line in the list - the Material Editor shall appear 
 
Click at Material Editor and TAB to Material Name field. 
 
Enter "stucco" and TAB to Lambda field. 
 
Enter "0.8" and TAB to confirm the entry. 
 
Right-click on the Material window and select Add Material from the context menu shown. You can add as many 
templates as you expect to need. In this tutorial we will use 11 different materials, thus add further templates (repeat 
Right-click on the Material window and select Add Material) to the list. 
 
Finally, having now further 10 material templates, move the list to make "stucco" visible (using scroll bar if required) and 
right-click on it to get Material Editor show it again. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Click "Next" on Material Editor. The first template is selected and shown. 
 
TAB to Material Name and enter "masonry wall". TAB to Lambda and enter "0.164". TAB to "Next" confirming the entry 
and press ENTER (which does the same as clicking Next). 
On the third line now selected, TAB to Material Name and continue with entry of: 
 

Material name  Lambda 

Interior plaster  0,7 

exterior plaster  0.8 

insulation  0.041 

Adhesive mortar  0.271 

Reinf. convrete  2.2 

Sand cushion  1.0 

Expansion strip 

 

0.15  

Isol. underlayment  0.040 

Concrete topping  1.2 
   



Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 10.137 
 

 
 

390 
 

 
 

To have a printout of the complete tables at hand as a reference during input, use Data-Entry Report from the 
View→Window menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

The data associated with a particular material can be edited by selecting it in the Material list. Individual entries can be 

deleted from the table screen directly (mark line and right-click, then selecting Delete Material from the context menu). 
 
Note: Material list just simply provide a container holding materials for reference. Material properties of elements are 
currently stored by elements themselves, thus either changes apply only to the related object (element) and does not 
influence the other (or another element). 
 
Note: The method described above for completing the materials table can also be used to generate the other type of 
tables - surfaces - for later selection. 
 
Continue reading with "Completing the Component" ... 
 
 

http://help.antherm.eu/Tutorials/tutor02en/2d/2d_30_CompletingTheComponent.htm
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Completing the Component 
 

To move on to input of the remaining elements, click New on Elements Browser or Box Editor window. The screen should 
then appears ready for input of element 6, now empty or a copy of the last element. 
 
The next sequence of four overlapping elements describes the girder part of the aggregate: 
 
elem. 6, ext. plaster: 
 

X_1: 45 

X_2: 405  
Y_1: 695 

Y_2: 1200  
elem. type :Material 

material: exterior plaster 
 
 

After having x1,x2,x3,x4 entered and selecting the type of "Material Box", instead of entering material data, simply double 
click the "interior plaster" in the "Materials" window. The material data is being copied into the fields. 
 
By double-clicking a material in Materials window while a material box is selected, you assign the material data to the 
currently selected material element. 
 
Note: you can also drag a material from Materials window onto the Box Editor to achieve the same result. 
 
Note: If the Materials window is hidden or not shown you can reveal it by double-clicking the label "Material Name" or 
"Lambda" or the accompanying data entry fields (shown when element type is "Material Box"). 
 
Continue with the data entry and assignment of material properties as follows: 
 
 
elem. 7, ext. insulation: 
 

X_1: 50 

X_2: 400 

Y_1: 700  
Y_2: 1200  
elem. type :Material 

material: insulation 
 
elem. 8, adh. mortar: 
 

X_1: 120 

X_2: 330 

Y_1: 770 

Y_2: 1200  
elem. type :Material 

material: adhesive mortar 
 
elem. 9, reinf. concrete: 
 

X_1: 125 

X_2: 325 

Y_1: 775 

Y_2: 1200  
elem. type :Material 

material: reinf. concrete 
 
Elements 10 through 13 describe the same sequence of materials for the insulated concrete floor slab construction 
connected to the girder: 
 
elem. 10, ext. plaster: 
 

X_1: 400 

X_2: 1525  
Y_1: 895 
Y_2: 1200  
elem. type :Material 

material: exterior plaster 
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elem. 11, ext. insulation: 

 
X_1: 400 

X_2: 1525 

Y_1: 900  
Y_2: 1200  
elem. type :Material 

material: insulation 
 
elem. 12, adh. mortar: 
 

X_1: 400 

X_2: 1525 

Y_1: 1020 

Y_2: 1200  
elem. type :Material 

material: adhesive mortar 
 
elem. 13, reinf. concrete: 
 

X_1: 325  
X_2: 1525 

Y_1: 1025  
Y_2: 1200  
elem. type :Material 

material: reinf. concrete 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

The interior flooring over the concrete slab is built up with the last five elements of the aggregate:  
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elem. 14, sand: 
X_1: 345 

X_2: 1525 

Y_1: 1200  
Y_2: 1310 
elem. type :Material 

material: sand 

 

 
 
elem. 15, exp. strip: 
 

X_1: 345  
X_2: 1525 

Y_1: 1220  
Y_2: 1310  
elem. type :Material 

material: exp. strip 
 
elem. 16, isol. layer: 
 

X_1: 349 

X_2: 1525 

Y_1: 1220 

Y_2: 1310  
elem. type :Material 

material: isol. layer 
 
elem. 17, concrete (then wrapped with heat/power source): 
 

X_1: 349  
X_2: 1525 

Y_1: 1250 

Y_2: 1310  
elem. type :Material 

material: concrete topping 
 
The concrete shall also be attached to the power source (heating source). This is being done by wrapping the assigned are 
by the Power Box type of a element - as described in the reference, a Power Box has not interior, it does wrap interiors of 
Material Boxes. 
 
To get exactly the same rectangle assigned to the next element as that of element 17, select Duplicate from the context 
edit menu (by right-clicking either at the last element in Element Browser or right-clicking over Box Editor an selecting 
Duplicate) 
 
elem. 18, concrete wrapper with heat/power source: 
 

X_1: 349 

X_2: 1525  
Y_1: 1250 

Y_2: 1310  
elem. type :Power Box 

power name: concrete 
 
TAB to Box Type and change the entry to "Power Box". The TAB to Power(source) name and enter "concrete" thus 
naming the Power Source Boundary Condition which can later be assigned with Power. 
 
 
After confirming the entry of this Power Source continue with the last material element: 
 
elem. 19, concrete topping: 
 

X_1: 349  
X_2: 1525 

Y_1: 1260 

Y_2: 1310  
elem. type :Material 

material: concrete topping 
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This conclude the entry of the two dimensional model. 
 
To verify the input, select View→Windows→Data-Entry Report and check details of the input. 
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Obtaining basic results - evaluation 
 

First characteristics of the component can be obtained immediately without any special calculations - materials and 
properties used within the model plus characteristic U-Values at profiles near to adiabatic boundaries.  
To receive this basic documentation select View→Data Input&Entry→Modelling Report and check characteristics of the 
model: 
 
 
 
  

                   
 
 
 
 
 
To receive further results some calculation is required. 
 
 

 

http://help.antherm.eu/Forms/MinGridReportForm/MinGridReportForm.htm
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Activate the main menu Results... option. 
 
You will be asked to save the project data and to provide fine-grid and solver parameters. Confirm all the three dialogs 

with Ok. Default parameters for fine-grid and solver are sufficient for most cases and thus to complete this tutorial. 
 
The construction file of a model must be accompanied by a grid file for calculation in the next branch of the program. Based 
on standard parameters, a grid file of the current model is generated. The calculation branch is automatically started. 
Convergence behaviour of the iterative calculation process is displayed in the form of running status messages. 
 
As soon as the calculation of base solutions has been terminated successfully, the Conductance-Matrix-Report is generated 
and shown. Also a Boundary-Conditions window is revealed to receive your input for further evaluation steps - covered just 
below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Note: The conductance matrix results shown here are only "borderline acceptable" in terms of precision. For some purposes, 
a re-calculation of the base solutions with a more stringent termination condition may be called for at this point, before 
continuing with evaluation. For a demonstration object, however, the precision of these results will suffice. 
 
The table of heat source distribution factors is printed out separately. These results imply that the heat source, i.e. the 
simulated electric heating assembly meant to heat space "concrete", would lose approximately 8% of its power to the 
exterior space - without flooring over the concrete topping. 
 
Note: Just as the conductance matrix, the heat source distribution factors are condition-independent, i.e. valid for any 
temperatures and source powers of evaluation. 
 
Activate View→Windows→Psi-Value Determination menu.

http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
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Calculating the Psi-Value (linear thermal transmittance) characteristic for that component is still independent from any 
boundary conditions too. 
 
Obtaining results dependant on particular boundary conditions (space air temperatures and power source intensities) 
requires the input of that data at first: 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 

The heat source is thus "turned off" for the first round of evaluation. Confirm the set of boundary conditions by clicking at  
Apply on the Boundary Conditions window. 
 
After a short waiting period, during which the temperature distribution in the component is calculated by the program, the 
following results are shown in Results-Report.

http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
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Note: Though weighting factors (g-Values) as a whole are not dependant on boundary conditions, they are included here in 
association with the coldest surface points (the location of which is in general condition-dependant). 
 
> Continue reading with "Graphic results" ... 
 
 
 

http://help.antherm.eu/Tutorials/tutor02en/2d/2d_50_GraphicResults.htm
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Graphic results 
 

 
Graphic results will be obtained in the sophisticated Results-3D-View which is commonly used for two- and three-
dimensional output. If yet not visible go to to view menu and select Results 3D View to reveal the graphics evaluation 
window. 
 
Cause we currently analyse a two-dimensional case, make sure perspective view is turned off in the general panel 
shown. Also you can turn full opacity of the surface with the surface panel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
 
To pass the image for farther processing, press Copy Image. The image is being placed into the clipboard from where you 
can insert it into any application for report generation or high quality printing. You can adjust the size of the image 
produced within application settings of the edit menu. 
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Isolines (Isotherms) 
 

Next, a rendering of the temperature distribution in the form of isotherms shall be generated using the panel Isolines (for 
Isotherms). 
 
Cause Isolines plotted will be plotted over the surface already visible thus rendering them in the same color would make 
them invisible, let the surface be fully transparent by deselecting "Opaque" and changing the opacity to 0 on the surface 
panel. 
 
After selecting "Active" on the Isolines panel, enter 2.0 for the step (interval) specification. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
To pass the image for further processing via clipboard use either Copy Image or Edit Menu→Copy. 

 

 

 

 

 

Annotated (Labelled) Isolines (Isotherms) 

 

Next, a rendering of the temperature distribution in the form of annotated (labelled) isotherms shall be generated using 
the Z Slice. 
Since the Slice placed "within" the construction it would render invisible if the surface would not be turned off. Therefore 
on the surface panel make the surface inactive by turning it off. 
On Slice Z panel select the value of 500. 
The slice surface is also coloured. To reveal isotherms only, make the slice fully transparent by turning its opacity value to 
0.00. 
On the labels panel adjust the label distance and size parameters. 
To reveal the structure of materials within the model, now shown as lines only, select Model Slices to be Solid on the 
Model Panel. 
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Streamline analysis 
 

Before going to the streamline analysis, turn Model completely off (both Model and Model Slices). 
Using the Slice X and Slice Y controls place the crossing of both somewhere within the construction revealing the 
streamline. On the Streamline panel make the tube radius larger to emphasize the streamline shown. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 

You can optionally turn Isolines or Labels off for less obscured representation. 
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Streamline analysis - multiple streamlines (2D only) 
 

 
There is also an option to show multiple streamlines at the Z-Slice of this 2-dimensional model. To achieve this select "Start 
at: Space Boundary" option on the Streamline panel. By default the heat flow of the first room is subdivided into 5 
intervals. At boundaries of this intervals streamlines are drown.  
The diagram below was drawn with 50 intervals for heat flowing into exterior space. Changing the tube radius of 
streamlines to 0 renders them as thin lines. Turn colorize of streamlines to black by clicking on colorize check box once 
(second click would render the white) We've also turned isolines and axes views, the slice X and Y off. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note: Since this model contains only two spaces, the heat flowing out of interior space is the same as the heat entering 
exterior space. Selecting another space would therefore result in same lines being drawn. 
 
 
 
 
This chapter is not finished yet. More evaluation examples shall be included here later on. 
 
> Continue reading with "Comparing Results under Different Conditions"... 
 
 
 

http://help.antherm.eu/Tutorials/tutor02en/2d/2d_60_ComparingResults.htm
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Comparing Results under Different Conditions 
 

The same model shall now be evaluated under the condition of an active heat source element. The electric heating assembly 
embedded in the floor is assumed to have a power output of 60 W/m

2
. In the two-dimensional simulation, which is modelled 

as a layer of 1 m thickness, this output corresponds to 60 Watts per meter length of heating element in the section. The 
power density of such 10 mm thick heating assembly is then: 
 

60 W/m
2
 / 0.010 m → 6000 W/m

3
 

 
and this is what has to be provided as input to the program. This also show how to calculate the power density based on 
manufacturer data and construction entered. 
 
Alternatively one could calculate the total power of the source and divide it by the resulting volume. The total power to be 
assigned to the heat source here is therefore: 
 

60 W/m
2
 x 1.176 m x 1.000 m → 70.56 W 

 
Having that and the total volume of the power source (this can be obtained from earlier basic reports) On the other hand, 
for the two-dimensional simulation being modelled as a layer of 1 m thickness the power density of the whole heat source 
results in: 
 

70.56 W / 0.01176 m
3
  → 6000 W/m

3
 . 

 
or 
 

70.56 W / (1.176 m x 1.000 m x 0.010 m) → 70.5 W / 0.01176 m
3
 = 

6000 W/m
3
 . 

 
and this is what hat to be provided as input to the program and same as the value computed earlier above. 
 
To re-define the conditions of evaluation, activate the window Boundary conditions (if hidden turn to 
View→Evaluation→Boundary Conditions). Move the cursor to the power input field (the temperature values can be left as is) 
and enter the new power density value [W/m

3
]: 

 
 
 
 
 
 
 

 

 

 Confirm the entry with Apply. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://help.antherm.eu/Tutorials/tutor02en/2d/2d_40_ObtainingBasicResults.htm
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Numeric Results 
 

Since the conductance matrix and heat source distribution factors remain the same for any given evaluation conditions, 
these need not be printed out again. 
 
The Evaluation results printout, however, does show new data: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

The coldest interior surface point is no longer at the floor/wall corner. The temperature on the floor surface is also 
considerably warmer than without the heat source (nearly 8° higher). 
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Graphic Results 
 

 
Having the graphic results window open from the previous evaluation the significant change could be observed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Note different shape of streamlines drown! 
 
Let's change back to single streamline view (turn all Slices on, select streamline to start at Slice X/Y/Z and eventually 
change the tube radius back to earlier value of about 12 and colorizing on). 
 
Now turn the isolines back on to see the temperature distribution. 
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This time the evaluation range of temperatures is noticeably broader. As could be expected, the isotherm lines, drawn at 
the same temperature interval as before, are highly concentrated in the insulation. 
 
Pleas go to Isotherms an adjust the evaluation range properly to reflect the change. Also the Colorbar needs some 
adjustment for this new, extended, range of temperatures to be coloured sufficiently. This is the matter of choice if you 
want same colour structure be kept for comparative analysis with the earlier (powerless) evaluation or not. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This chapter is not finished yet. More evaluation examples shall be included here later on. 
 
> Continue reading with "Three-dimensional Analysis"... 
 
 
 

http://help.antherm.eu/Tutorials/tutor02en/3d/3d_00_ThreeDimensionalAnalysis.htm
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Three-dimensional Analysis 
Modelling the Object 
 

Three-dimensional objects are entered as a series of component groups, each describing a two-dimensional section of the 
object for a specified thickness. A sketch of the model should therefore be made as an orientation aid for input of layers in 
the z direction. 
 
Such an orientation sketch should show the object in orthogonal sections, including reference coordinates consistent in all 
three directions. For the three-dimensional demonstration object, the sketch would show the geometry as follows: 

 

 

x/y section 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

see sketch of 2-dimensional model! 

http://help.antherm.eu/Tutorials/tutor02en/2d/2d_00_TwoDimensionalAnalysis.htm
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x/z section 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

z/y section 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The reference list of material properties for the two-dimensional section modelled in the last chapter covers nearly all of 
the materials required here. The only new material is that of the perimeter brick, for which λ = 0.500. 
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> Continue reading with "Generating the Model - Input"... 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

layers thickness 

1 1175 

2       1 

3       4 

4     20 

5   200 

6    40  

7    60 

8    25 

9  100 

http://help.antherm.kornicki.com/Tutorials/tutor02en/3d/3d_10_GeneratingThe3dModel.htm
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Generating the Model - Input 
 

As already mentioned, the three-dimensional input model of the demonstration object need not be generated "from 
scratch". A section of the first layer in the z direction already exists in the form of the two-dimensional model, including 
nearly complete tables. These files can be transformed and used as the basis for the model to be generated in this 
chapter. 

 

 

Transforming an Existing 2-Dimensional Model 
 

In order to load two-dimensional files for editing in three-dimensional mode, the input branch of the program ha a Convert 
menu. Assuming the 2D model generated in the last chapter was named tutor2, load it into the program via File→Open and 
then choose File→Convert→Layerd 3D Project. 
 
The project description shows with the text as it was entered for the two-dimensional files. This can be appropriately 
edited here, e.g. 
 
 
 
 
 
 
 
 

 

 

Input can be continued from here as described below. Before leaving the input branch, however, the model must be 
explicitly saved in 3D files which are accessible for the rest of the program package in three-dimensional mode. 
 
To save the intermediate data into the new project file select File→Save As... and apply a new name (e.g. tutorial3). 
 
Within the Layer Browser double-click onto the (currently) only layer 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

to open the Layer Editor and enter layer data: 
 

Layer Name :Floor/wall Depth.:1175 

 
 
 
 
 
 
 
 
 
 
 
 

Use TAB-key to move between the input fields and to confirm the data entered. 
 
Element 2D view still shall show the same picture as of the two-dimensional model since we have not made any changes to 
the layer 1 except of its thickness which is perpendicular to the view shown. 
 

http://help.antherm.eu/Tutorials/tutor02en/2d/2d_10_GeneratingThe2dModel.htm
http://help.antherm.eu/Tutorials/tutor02en/2d/2d_20_CompletingTheTables.htm
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To secure the data select File→Save which immediately will write to the file named tutotr3 as defined and the beginning of 
this section. 
 
Select File→Exit to terminate the program now. 
 
The formerly two-dimensional model is now transformed and ready for completion. To run the entire program package for 
continued work on this model either start the program from the Windows Start Menu or double click onto the file 
tutor3.antherm which shall start the program with the data already read in. 
 
> Continue reading with "Completing the Model in Three Dimensions"... 
 
 

http://help.antherm.eu/Tutorials/tutor02en/3d/3d_20_CompletingThe3dModel.htm
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Completing the Model in Three Dimensions 
 

The construction will be built up by copying and editing component layers in succession. 
 
Starting with layer 1, floor/wall section, displayed as illustrated above (use view menu), right-click over the Layer Browser to 
reveal its context menu and select Duplicate. 
 
The geometric and material data of all the elements in layer 1 is hereby copied into the currently displayed second layer. 
 
Now edit the name and thickness of this layer by moving the cursor to the name field (press TAB): 
 
 

Layer 2: Floor/stucco Depth.:1 
 
 

The section through the stucco (layer 2 of the model) is simpler than the previous one, i.e. composed of fewer material 
elements. The first stage of editing is to page to those copied elements which are not needed for this section and simply 
delete them, one by one. 
 
Starting at the "top" of layer 2, that is, from the last element (18), page down in order to display and then delete the both 
"exterior plaster" elements - these are originally listed in Element Browser at positions 6 and 10. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

element # material 
  

10 ext. plaster 
  

6 ext. plaster 
  

 
 

Select the Element by clicking on it and press Delete command button. Delete only those two elements! 
 
The second stage of component group editing is to make any necessary adjustments in the input values of the remaining 
elements. 
 
For this layer of the model, only the size of one element needs to be changed. Select element 2 - stucco and by double 
clicking on it open Element Editor, move the cursor to input of Y_1 (using TAB key), and enter: 
 
 

X_1: 0 

X_2: 1525 

Y_1: 0 

Y_2: 2200 
 
 

Press TAB to confirm the change and re-draw the component. It should look like this: 
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Now the same copy and editing procedure shall be repeated to establish the next layer of the model, component layer 3: 
 
Right-click the second layer within the Layer Browser and select Duplicate. 
 
within Layer-Editor provide input: 

 
Layer 3: Exp.strip layer Depth.:4 

 

Within Element Browser form delete following elements: 

 

element # material 
  

17 concrete topping 
  

16 heat source over concrete topping 
  

15 concrete topping 
  

14 isol. underlayment 
  

10 adhesive mortar 
  

9 insulation 
  

8 reinf. concrete 
  

7 adhesive mortar 
  

6 insulation 
  

 

Edit element 6 (formerly 11) - reinf. concrete 

 
X_1: 125  
X_2: 1525 

Y_1: 1025 

Y_2: 1200 
 
 

The cross-section for this and several of the following model layers shows the perimeter brick as well as the insulation along 
the edge of the floor slab. For this part of the construction, two new elements must be inserted into the component group 
"under" the element of reinforced concrete. 
 
Select "Reinf. concrete" in Element Browser. Right-Click on it and select "Add→Before Selected". Edit the input Data:
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X_1: 85 

X_2: 1525 

Y_1: 1025  
Y_2: 1200 

Type: Material Box 
 
Double-Click over the Lambda field to reveal the list of Materials. Select insulation and drag it onto Element Editor - drop it 
there assigning properties of insulation to the newly create element. 
 

Material Name: insulation 

Lambda: 0.041 
 
The new element 6 - insulation - is generated upon confirmation (TAB), and the reinforced concrete element is now 
number 7. 
The perimeter brick element shall be inserted "under" the insulation. Select "insulation" in Element Browser. Right-Click 
on it and select "Add→Before Selected". Edit the input Data: 
 

X_1: 25 

X_2: 1525 

Y_1: 1025 

Y_2: 1200  
Type: Material Box  
Material Name: Perimeter brick 

Lambda: 0.5 
 
Make sure, that the sequence of elements corresponds to the following (starting from element 5 down 
here): ? 
 

element # material 
  

5 (space) int. transfer coeff 
  

6 perimeter brick 
  

7 insulation 
  

8 reinf. concrete 
  

 
Layer 3 is now complete. Duplicate that last layer to the fourth now. 
 
The rest of the layers of the demonstration object require editing of copied groups only with respect to name and 
thickness, followed by a successive deletion of elements: 
 
 Layer 4: Int.plaster Depth.:20 

Delete following elements:         
         

   element #  material  
          

   10   expansion strip  
          

   9   sand cushion  
         

   5 (space) int. transfer coeff  
        

Duplicate the last layer to the fifth now.      
      

 Layer 5: Masonry layer Thick.:200 

Delete:         
        

    element #  material  
        

   4   interior plaster   
       

  Edit element 3 - Masonry wall      

          
 X_1: 25        

 X_2: 1525      
          

 Y_1: 0        

 Y_2: 2200      
          

 
Layer 6 (via Duplicate of layer 5): 
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 Layer 6: Slab perim.insul.  Thick.:40 

Delete:            
              

  element #    material  
             

  6    

reinf. 
concrete  

             

Layer 7 (via Duplicate of layer 6):            
            

 Layer 7: Perimeter brick Thick.:60 

Delete:            
            

    element #  material   
             

    5   

insulatio
n   

Layer 8: 

           

           
         

 Layer 8: Stucco layer   Thick.:25 

Delete:            
           

   element #    material  
           

   4    perimeter brick  
            

   3      masonry   

Layer 9: 

           

           
       

 Layer 9: Ext.space  Thick.:100 

Delete:            
         

     element #  material  
          

    2    stucco  
              

 
The construction is now complete; the eight component layers can be paged through using the Layer Browser. Save the 
model data as a construction file in the usual manner: 
 

File→Save 
 
For model documentation, use the options from View→Evaluation&Reports→Data Entry Report. 
 
> Continue reading with "Evaluation and Output"... 
 
 
 
 

http://help.antherm.eu/Tutorials/tutor02en/3d/3d_30_EvaluationAndOutput.htm
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Evaluation and Output in Three Dimensions 
 

Activate the main menu Results... option. 
 
You will be asked to save the project data and to provide fine-grid and solver parameters. Confirm all the three dialogs 
with Ok. 

 

 

Numeric Results 
 

As soon as the calculation of base solutions has been terminated successfully, the Conductance-Matrix-Report is generated 
and shown. Also a Boundary-Condition window is revealed to receive your input for further evaluation steps - covered just 
below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

(Here again, the conductance matrix would not symmetrical enough for some purposes; in which case, the base solutions 
would have to be further calculated.) 
 
These results imply that in the corner, the heat source would lose approximately 11% of its output to the exterior space 
(compared to 8% for the floor regions modelled two-dimensionally). 
 
By entering same boundary conditions as for the two dimensional modelling earlier 
 
 
 
 
 
 
 
 
 
 

the Evaluation results option provides: 
 

http://help.antherm.eu/Tutorials/tutor02en/2d/2d_60_ComparingResults.htm
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Graphic Results 
 
 

A picture of the overall temperature distribution within the component can be obtained by generating isotherm diagrams 

for characteristic cross-sections of the model. For this object, these are the x/y and z/y sections (see model sketches). 
 
Within Results 3D View adjust the position of the rendering by rotating it appropriately to your need. You will eventually 
have to turn perspective view on within the 3D panel. 
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Now turn off the unneeded elements of the rendering by: 

 

 deactivating the outline (on general panel) 

 deactivating model and model slices (on model panel) 

 deactivating surface (on surface panel) 

 
The view might be partly obscured by 3d-axes. Let them be drawn "at outer edges" on Axes panel. 
 
To see the model boundaries (edges) turn them on (on surface panel) 
 
Adjust colorizing range of the colorbar to 30 °C for example. 
 
Now experiment by moving Slices X/Y/Z to emphasize the temperature distribution within the component. Right-clicking 
on the corresponding panel of SLice X, Y or Z exposes a context menu listing all coordinates where surfaces of the model 
exist. Selecting them from this context menus move the particular slice exactly to this coordinate. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

By changing the opacity of the Slices X, Y and Z you can produce more understandable results. Turn them all to fully 
opaque. 
 
To view Isolines, turn them on, select step of 2 °C and turn colorizing to black on isoline panel. On Labels panel turn 
labelling off. 
 
Continue rotating, scaling and panning the view according to your needs
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Showing the temperature distribution on the surface can be archived by turning the surface view on and making it full y 
opaque (on Surface panel). 
 
Turn Slices X/Y/Z off since their rendering are fully obscured now by the model surface and thus hidden. 
 
Turning labelling on (Labels panel) gives more value information to the rendering. Adjust label proximity to 150 and set 
the "distance along line" to 1000 for reducing eventual cluttering of labels. 
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VAPOUR - Tutorial 
Water Vapour – Vapour Diffusion, Water Vapour Bridges 
 

Mit AnTherm mit der DAMPF-Option ist die Analyse des Wasserdampf-Diffusionsverhaltens in den Bauteilen möglich! 
 
AnTherm verfügt über die Möglichkeiten zur Beurteilung des Kondensationsrisikos im Bauteilinneren – in 2- und auch in 3-
dimensionalen Aufbauten!  
Durch die Differenzbildung von Sättigung- und des berechneten Partialdruckes im Bauteil kann die Begrenzungsfläche 
(bzw. Linie) der vom Kondensat gefährdeten Bereiche ermittelt werden.  
Zudem besteht die Möglichkeit den Weg des Wasserdampf-Diffusionsstromes als Stromlinie (ähnlich des Wärmestromes) 
graphisch zu verfolgen und damit die Schwachstellen der Konstruktion auch in 3-dimensionalen Fällen zu finden (die 
Dampfdiffusionsbrücken). 

 

 

Die Vorgangsweise 
 

Zusätzlich zu der Angabe der Wärmeleitfähigkeit der Baustoffe (Lambda) ist die Wasserdampfdiffusionszahl 
„Mü“ anzugeben (wie Sie dieses effizient auch nachträglich machen können lesen Sie unter „Ändern von 
Baustoffeigenschaften mehrerer Elemente“ auf Seite 13.  
Fehlen diese Angaben, wird das Programm Sie darauf vor der Berechnung der Ergebnisse aufmerksam machen. 
 
Die Durchführung der Dampfdiffusionsberechnung wird in den Solver-Parametern (Menü Bearbeiten) angefordert (im 
Normalfall ist diese Berechnung abgeschaltet)  
Haben Sie die Mü-Zahlen eingegeben, aber die Dampfdiffusionslösung nicht aufgefordert, wird das Programm Sie auf 
diese Möglichkeit ebenfalls erinnern. 
 
Achtung: Gegebenenfalls prüfen Sie in den Programmeinstellungen (Menü Bearbeiten->Einstellungen) welche der  
Auswertefunktionen aktiv sind. Im Punkt „Sekundärfunktionen Welche?“ sind möglicherweise einige abgeschaltet, welche 
sie jetzt einschalten sollten!  
Vor allem sind 

 Partialdruck, 

 Druckdifferenz, 

 Diffusionsstromdichte und gegebenenfalls auch –Vektor 

 
jetzt von Interesse. 
 
Im Leitwertbericht sehen Sie zusätzlich zu den Genauigkeitsangaben der Wärmeströmungsberechnung (Schließfehler) 
auch die entsprechenden Angaben der Dampfdiffusionsberechnung (soll <<10e-4) 
 
Als Randbedingungen geben Sie neben den Temperaturen auch die relativen Raumluftfeuchten (in %) ein. 
 
Erst in der graphischen Auswertung der Wasserdampfdruckdifferenz bekommen Sie die Aussagen über die 
(überschätzte) Kondensationsgefahr: 

 Graphische Auswertungen anfordern (auch via Menü Ansicht->Evaluierung&Auswertungen->Ergebnis3D) 

 Im Allgemein als Auswertefunktion „Druckdifferenz“ wählen – bereits hier sehen Sie den Werteintervall welches 
der Farbtabelle zugewiesen wurde – liegt der Randwert der Druckdifferenz unterhalb von 0, dann Kondensatrisiko! 

 Im 3D-Fall Isofläche mit Wert 0 Visualisieren (sollte es eine geben, schließt diese den Kondensationsbereich ein!) 

 Im 2D-Fall die Oberfläche Visualisieren  
oder eine Schnittfläche Z bei 500  
oder Model mit Isolinie bei 0 (und 0-Intervalle) sichten (sollte es eine geben, schließt diese den 
Kondensationsbereich ein!) 
 

 
Mit Probepunkten und dann im Probepunkteteil des Ergebnisberichtes werden neben den Temperaturen auch die 
Druckdifferenzwerte ausgegeben. 
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Anmerkung: Wir haben derzeit mit Absicht keine „automatisierte“ Auswertung der Fragestellung „Kondensatgefahr“, da 
es vom Interesse ist nicht nur diese aber auch die Ortinformation zu erhalten – deswegen geht es nur über die 
Visualisierung und gegebenenfalls die Probepunkte. 
 
Es geht aber noch weiter! 

 
 Schalten Sie die Oberflächensicht aus, Legen Sie ein Schnitt X/Y/Z im Bauteil (im 2D-Fall soll Z=500 sein) und 

Schalten Sie die Stromliniendarstellung ein – es wird die Wärmestromlinie dargestellt. Jetzt ändern Sie im 
Allgemein die Vektorfunktion auf „Dampfvektor“ (*) und betrachten Sie die Wasserdampfdiffusionsstromlinie 
– diese nimmt einen vollkommen anderen weg! 

 Ändern Sie in Allgemein die Funktion auf Dampfdiffusionsstromdichte und betrachten Sie mit einer Isofläche 
(oder Isolinie bzw. Farbendarstellung) die Wasserdampfdiffusionsbrücken bei den hohen Werten des 
Dampfdiffusionsstromes – ähnlich der Suche nach Wärmebrücken finden Sie so die Schwachstellen der 
Konstruktion im Bezug auf Wasserdampfdiffusion. 
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See also: Multidimensional Vapour Diffusion, Multidimensional vapour diffusion processes 
 
 
 
 

http://help.antherm.eu/Introduction/81_Dampfdiffusion.htm
http://help.antherm.eu/Introduction/81_Dampfdiffusion.htm
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Usage Hints Introductory Tutorial 
 

Following pages collect important introductory instructions about the use of the application in the form of a cookbook. 
 
Use examples included in the installation to become acquainted with the software. As soon as you get comfortable with the 
handling of the software you shall start easily with your own examples of course. You can also enter model data from 
scratch or transfer other projects (e.g. WAEBRU file) into AnTherm (by using the import). 
 

Continue reading on Starting the Program and its Windows... 
 

 

Hint: The application help window will always display on top (in front of) all other application windows when invoked 

directly from the application (via F1 key or the Help menu) and eventually overlap them. To have help window be 

freely switchable via desktop manager (which will allow you to bring the application windows to front) you shall start 

the application help from the windows start menu instead (Start-All Programs-AnTherm-Help) and browse the 

contents manually to the chapter of your choice.  
With the application setting "Help Window shown TopMost" the user can decide if the Help window will be shown 

topmost to all application windows and automatically minimize with the application (which is the windows default 

behaviour) or it can be set behind the application window via typical desktop window manager (default application 

setting). 

 
 
 
Starting the application - main windows 
 

Start the application by navigating within windows menu Start→Programs→AnTherm→AnTherm. 
 
If the application's installation has been completed successfully, the main window is shown with further work windows 
embedded in it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

All windows of AnTherm are shown on screen exactly at same positions as they were saved at earlier execution of the 
application. 
Windows initially shown and their initial positions are preset according to the template included in the installation. All 
windows can be moved freely. This allows the user to arrange the screen area according to his needs. 
 
 
 

http://help.antherm.eu/Tutorials/index.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Tutorials/tutor01/00_Start.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Install/Installation.htm
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Datei/Startup_LayoutPersistence_xml.htm
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Remark: The graphical user interface (GUI) of the application is initially presented in the Language set for the operating 
system (Standard/Default Language). This can be changed. Use the menu Edit→Settings... ( or Bearbeiten→Einstellungen...) 
and within the setting dialog change the User Interface Language (or Sprache der Benutzeroberfläche). If the language 
requested cannot be provided by the program (current distribution contains English and German), AnTherm will show in 
English. 
 
 

Position the windows and adjust their 
size according to your needs. 

The application saves window positions into settings file AnTherm.exe.Settings.xml. 
Deleting this file will reset all application settings to its initial state - including 
window positions.  
We have provided some template settings with the installation. 

During application's start-up the 
template project file projekt.xml has 
bean loaded automatically. 

If there is a file named projekt.xml within the applications installation folder it will 
be loaded automatically.  
You can use this file as a template project, containing some standard text and 
material definitions available immediately in the program. 
This behaviour can be changed by within application's settings, by requesting 
automatic load of latest project edited. 

The main window of the application 
contains the menu bar of all 
application's functions.  
If required, move the menu bar to the 
position on the screen not obscured by 
other windows. 

Via the menu File you create new or load existing projects and save them to project 
files - and you exit the program form this menu.  
The menu function File→Import… provides import function of WAEBRU.?BT 
components or the  import function from DXF files and from other supported data 
formats. 
The menu Results… will lead you directly to results for the current project – to 
several reports and 3-dimensional graphical evaluations. If there are no results 
available yet the calculation is performed automatically. 

For a new project you decide if it shall 
be 2-dimensional or 3-dimensional. 

With the menu File→New you create new projects.  
Within the creation step you define the project type by deciding if it will be a 2-
dimensional or 3-dimensional model and calculation. 

    

  
continue ... 
 
 
 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Datei/Settings_xml.htm
http://help.antherm.eu/Datei/Startup_LayoutPersistence_xml.htm
http://help.antherm.eu/Datei/Standard_projekt_xml.htm
http://help.antherm.eu/Datei/Standard_projekt_xml.htm
http://help.antherm.eu/Datei/Standard_projekt_xml.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Letztes Projekt öffnen
http://help.antherm.eu/Forms/MainForm/MainForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Datei
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Importieren
http://help.antherm.eu/Datei/Import/WAEBRU_Import.htm
http://help.antherm.eu/Datei/Import/WAEBRU_Import.htm
http://help.antherm.eu/Datei/Import/DXF_Import.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Ergebnisse...
http://help.antherm.eu/Auswertungen.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Neu
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Neu
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm#2D Projekt
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm#2D Projekt
http://help.antherm.eu/ProjectTypes/ProjectTypes.htm#3D Projekt
http://help.antherm.eu/Tutorials/tutor01/10_Einlesen.htm
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Loading a component, primary windows 
 

Select the menu Help->Example Load... and The application saves projects as XML files. Such files can be viewed 

select one of the examples included in the within any standardised parser or even within browser, thus allowing 

example folder created during installation. processing of project's data even outside of the application. 

Following the selection press Ok to load the 
Remark: To quickly load examples included with the application's use 

project's data. 
the menu Help->Example Load... .  

  

Most important data of the project immediately  

loaded and its graphical representations will be  

shown.  
  

The window Description contains the short The project's description is displayed within headings of all project's 

description of the project reports. 

 You can change the project's description arbitrarily within the window 
 Description 
  

The Elements-2D window displays the 2- Instructions required to change the view and on how to efficiently work 

dimensional slice through the modelled with the mouse within this window are available in the next chapter of 

construction. this tutorial called „further instructions“ 
  

The Elements-3D window display a 3-dimensional Instructions required to adjust the 3D view according to your needs 
view of the modelled construction. are available in the next chapter of this tutorial called  „further 

 instructions“ 
  

The Element selection (browser) window lists all From that list you can select elements of the construction for detailed 

elements of the modelled construction. editing, add new elements or delete obsolete ones, etc.. 
  

Within the Elements 3D window press the button The 3D view will be created and copied to clipboard of the operating 

„Copy Image“ system. During the creation of the image the cursor changes to a 

 clock symbol. 

 The image can be pasted from the clipboard into any suitable 
 application for further processing, e.g. integration of an image within 
 your personalized report. 

 The image placed on the clipboard will be always created over white 
 background to make it suitable for printing. 
  

 
continue ...  

  
  
 
 
 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/DescriptionForm/DescriptionForm.htm
http://help.antherm.eu/Forms/DescriptionForm/DescriptionForm.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Tutorials/tutor01/40_WeitereTipps.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Tutorials/tutor01/40_WeitereTipps.htm
http://help.antherm.eu/Tutorials/tutor01/40_WeitereTipps.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Tutorials/tutor01/20_Berechnung.htm
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Calculation and Results 
 
 

Click the main menu item Results and confirm 
with Ok the Fine-Grid-Parameters followed by 
Solver-Parameters and save project's data to a 
project file naming it arbitrarily. 

You will be automatically alerted to save project's data to a file prior to 
simulation start to avoid any accidental data loss. If the request to save 
data is always shown can be set within application settings. 
Within the project's data also parameters of the fine grid and precision 
setting for the solver are saved. 

The Solver window lets you observe the 
progress of the simulation process. 

The animation shown at the top edge of the window informs you, that 
the application is currently calculating a new solution. Further 
messages issued by the computational part of the application shall be 
also shown in this window. 
If there are simulation results available from an earlier calculation, they 
will be compared to the project data just saved. If no changes of the 
input are detected the calculation step will be skipped.. 

Soon after the calculation is finished the 
matrix of thermal coupling coefficients and 
precision information for that calculation are 
shown. 

The report window displays characteristic values of the construction in 
the form of the matrix of thermal coupling coefficients (L2D or L3D). 
The precision results shall be checked and evaluated against 
conformance to standardised criteria the relative close-up error < 10-4). 
If this criteria is not satisfied the computation shall be repeated with 
different parameters (of a fine grid or the solver). 
Thermal coupling coefficients shown might be immediately used to 
assess thermal energy performance of the construction just calculated 
(e.g. to determine the Ψ (psi) or Χ (chi) values for energy rating 
evaluation, energy pass or energy demand calculation). 

The Boundary Conditions window lists all spaces 
for which temperatures (the boundary 
conditions) can be entered. 

Temperatures of spaces will be pre-assigned automatically: 

 first space listed receives air temperature of  -10°C 

 all other spaces are pre-assigned the temperature of +20°C. 
Spaces are shown sorted alphabetically by their names. By using some 
consistent naming conventions the pre-assignment might match your 
requirements in most cases: 

 Exterior is listed before Interior 

 Space 00 prior to Space 03 and prior to Space 10 

 Room 11 is listed prior to  Room 1. 
If the model contains power sources (heat sources) also, they are listed 
in the window to allow the entry of their power density [W/m³]. 

To confirm the values of temperatures entered in 
the Boundary Conditions window press the 
button Apply 

Boundary conditions entered are applied onto basic solutions  
(the g- values).  
The resulting temperature distribution within the construction is 
calculated as a superposition of basic solutions multiplied by the 
corresponding boundary condition value. 

Actual results are calculated and displayed 
withinseveral evaluation windows. 

Results are formatted as printable textual reports which can be also 
saved as Adobe PDF, MS-Word or MS-Excel files for further processing. 
The temperature distribution is available as starting point for various 
graphical evaluations. 

The Coupling Coefficients and Precision report 
and the Results report are shown as standard 
reports automatically. 

Via the menu View→Evaluation & Reports you shall request further 
available reports. 

 
 
continue ... 
 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
http://help.antherm.eu/Forms/SolverParamsForm/SolverParamsForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/PsiValueCalculatorForm/PsiValueCalculatorForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/BoundaryConditionsForm/BoundaryConditionsForm.htm
http://help.antherm.eu/Forms/Auswertefenster.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/LeitwertReportForm/LeitwertReportForm.htm
http://help.antherm.eu/Forms/ErgebnisReportForm/ErgebnisReportForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/Tutorials/tutor01/30_Auswertungen.htm
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Evaluation of results 
 

Within the Results report window click with the mouse 
onto the arrow symbol adjacent to magnifying glass and 
select the zoom factor of the report view 

By default the application attempts to show the full report page 
within the window. You can adjust the magnification factor of 
that view.  

Press the printer symbol and confirm various printing 
parameters to send the report to the printer for hard copy 
output. 

Printing of a report can be requested via the menu File→Print 
also.  
Reports can be saved as Adobe PDF, MS-Word or MS-Excel 
documents for further processing. 

Select the menu View→Windows→Coupling Coeff. Report. The matrix of thermal coupling coefficients and precision output 
is shown. 

    

Select the menu View→Windows→Results 3D. 

  

The Results 3D window display the three dimensional graphical 
evaluation of temperature distribution and of further secondary 
functions (heat flux, relative surface humidity etc.) 
 
Visualizations shown can be distinguished as follows:  
 

 Surface temperature (Surface)  

 Surface of equal temperatures (Isosurface)  

 Distribution of temperature on a slice plane (SliceX, 
SliceY, SliceZ) and so on. 

The view can be arbitrarily moved with the mouse within the 
window allowing detail interrogation onto and into the calculated 
temperature distribution. 

Within the Results 3D window rotate the view just a bit 
towards you (the viewer). 

Likewise in Elemente 3D Fenster use the mouse to move the view 
by a „Track-Ball“ held under the mouse. 

At the right side of the Results 3D window select Surface. 
Turn the  switch Solid off. You will see the wire frame view 
onto the discretisation grid used during the simulation.  
Reduce the Opacity to 0.1 by using the arrows of the 
Opacity input field. 

With the tabs Surface, Isosurface, SliceX etc. you select the tab 
containing parameters of respective evaluation part.  

 Solid switches between solid model view and wireframe 
view.  

 Opaque switches the transparency on and off.  

 Opacity defines the level of transparency between 0 
(transparent) and 1 (opaque)  

 Active turns the visibility of the selected evaluation part 
on and off  

Select the Isosurface and change the value of the 
temperature the isosurface shall express – move the slider 
with the mouse. 

The isosurface connects points of equal values of temperature.  
 
By moving the slider you are changing the isosurface.  
 
The colour of the isosurface corresponds to the temperature 
shown on the colour scale. 

Within the window Results 3D click onto the button „Copy 
Image“ 

The 3D view will be created on the clipboard of the operating 
system. 
The image can be then pasted from the clipboard into any 
suitable application (e.g. Word) for example for integration into 
personalized report.  
The image placed on the clipboard is always drawn over white 
background for proper hardcopy output. 

Within the window Results 3D select the tab General and 
change the primary function chosen. 

If there were secondary functions calculated (this is decided by 
the switch „Secondary functions" of "General" panel) a set of 
them can be chosen as the primary function for 3-dimensional 
visualization:  

 temperature °C  

 heat flux W/m² (the modulus and the vector field)  

 relative surface humidity % (only at component's 
surface) 

http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Results
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CrReports/Symbolleiste_CrReports.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Datei
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Ansicht→Evaluierung & Berichte
http://help.antherm.eu/Forms/ReportBuilder/ReportBuilder.htm#Coupling
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Ansicht→Evaluierung & Berichte
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#Sekundärfunktionen
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#Sekundärfunktionen
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm#Steuerungspaneel
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Solid/Solid.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Opak/Opak.htm
http://help.antherm.eu/Forms/Result3DForm/Aktiv/Aktiv.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala_Farbtabellen/Farbskala_Farbtabellen.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/CopyImage/CopyImage.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#AktiveFunktion
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm#Sekundärfunktionen: welche
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm#Sekundärfunktionen
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etc. 

Close the window Results 3D by clicking onto the X-symbol 
at the top-right corner of theis window. 

  

Close the Coupling Coefficients Report and Results Report 
by clicking onto the X-symbol at their top-right corner. 

  

Select File→Exit from the main menu. If some project's data has been changed you shall save the 
project via the  menu File→Save prior to exiting the application. 

continue with further hints and instructions ... 

 
 
 
 
Further hints and instructions 
 
 
 

Elements 2D    

Move the mouse pointer over 
the picture shown in within the 
Elements 2D window.  
Press and hold the left mouse 
button, then move the pointer. 

You can adjust the view according to your needs.  
The view can be „scrolled“ arbitrarily.  
You can use scrollbars to pan the visible view area also. 

Press the button Fit The position and scaling of the view will be adjusted in such a way, that the whole 
construction is made visible within the window. 

Turn the mouse wheel The view is scaled (Zoom-In/Zoom-Out).  
Scaling is cantered around the current mouse pointer position. This allow zooming directly 
into the region of interest. 

    

Elements 3D,  Results 3D   

Place the mouse pointer over 
the view within the Elements 3D 
window.  
Press and hold the left mouse 
button, then move the pointer. 

You can adjust the 3D view according to your needs.  
Moving the mouse with left button depressed results in a rotation like by turning a „Track-
Ball".  
The view behaves as if it were attached to a "ball" whose centre is at the centre of the view 
window. The mouse cursor is attached to the part of the ball that protrudes above the 
surface of the window.  

Hold the Ctrl-key of the 
keyboard depressed, then press 
the and hold left mouse button, 
then move the pointer. 

The 3D view is rotated around the axis in the geometrical centre of the view and 
perpendicular to the screen surface (rotation around the block axis, also called "Rolling"). 
You will need this function to flip the view "upside down" for example. 

Hold the Shift-key of the 
keyboard depressed, then press 
the and hold left mouse button, 
then move the pointer. 

The view is translated in the plane of the window following the mouse pointer, 

Press and hold the right mouse 
button, then move the pointer. 

The view is scaled (zoom-in and zoom-out).  
Scaling operation is executed relative to the geometrical centre of the 3d view in virtual 
space 

Press the button Fit The position and scaling of the view will be adjusted in such a way, that the whole building 
component fits into the view. 

    

Fine Grid parameters   

After Results… (in the main 
menu) has been requested the 
window of Fine-Grid-parameters 
is shown. 

You have the choice of two procedures:  
You define all the parameters, including the maximum step of the grid (MaxStep) 
You set the number of cells to be included in the equations (Target model size) and let the 
software estimate the MaxStep accordingly.  
In the letter case (the model size has been input) the application will iteratively adjust the 
MaxStep until the requested number of cell matches  the current value +/- 10% 

http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Beenden
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Datei
http://help.antherm.eu/Tutorials/tutor01/40_WeitereTipps.htm
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/Elements3DForm/Elements3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.eu/Forms/SonstigeBedienelemente/Navigation_3d/TrackBall_rotation.htm
http://help.antherm.eu/Forms/FineGridParamsForm/FineGridParamsForm.htm
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Streamline parameters   

To receive nice  streamline 
visualization it might be required 
to adjust few settings 

The integration step length is given in millimetres. The number entered is used only at 
initial stage of the Runge-Kutta method implemented. Particular step lengths are adjusted 
adaptively - from one cell to the other. This provides the ability of very detailed 
visualization of streamlines! 
 
The maximum propagation length is given in millimetres also. During tracing a streamline 
the trace length is cumulated (the sum of all segment lengths of a streamline traced) and if 
the limit set here is reached, tracing of that streamline aborts. 
 
The next parameter which limits the length of a streamline is given by the maximum 
number of steps. The limit of 100000 segments is hard coded within the application. Higher 
number would overwhelm the capacity of today's hardware equipment when combined 
with tube visualization. 
 
The tube radius is given in millimetres. The initial value of the tube radius is computed 
based on median extent of current component (1/200 of it). 
Setting the tube radius = 0 will show it as simple line. 
 
Start at – Probe X/Y/Z: Only one streamline passing the point of intersection of the three 
slice planes X/Y/Z will be created. To get the streamline drawn all three slice planes must 
intersect within the model's body. 
 
Start at – Space Boundary: Produces a set of streamlines started at selected space 
boundary. The application calculates the sum of stream flowing to the space and the sum of 
stream leaving the space through the boundary (for exterior space, case with two spaces 
without powers sources one of this values is always 0). The sum with the largest modulus is 
divided into the number of intervals entered. Along the space boundary the application 
repeats the calculation of the stream function and places start points for the streamline at 
interval boundary values calculated earlier (interpolated). 

    

Streamlines at equidistant 
intervals of heat stream from 
space boundary in 2D case 

Create or load a 2D project;  
Results;  
Apply boundary conditions -> Graphical evaluation (Results 3D window)  
All streamlines will start (and in 2D case will fall into) the Z slice plane, therefore the slice Z 
must be active (even if transparent and thus invisible).  
Recommended combination of settings (allows quick initial visualization):  

 General: Perspective OFF (it is 2D only), Outline OFF  

 Model: Model active OFF, Model Slices active OFF (later you eventually can vary 
the visibility of model slices at Z plane, tube radius of a streamline and colouring)  

 Surface: Surface active OFF (otherwise it would obscure the interior, including 
streamlines!), Edges OFF, Slice Edges ON (or OFF), Colorize Slice Edges 
ON/BLACK/WHITE (upon to your favour)  

 Slice X active OFF (required only for intersection of  slice X/Y/Z, now disturbing 
only by the intersection cross shown in the view)  

 Slice Y active OFF (see above.)  

 Slice Z active ON, Value 500; Opaque ON, Solid ON, Colorizing ON (later you can 
vary Opaque/Solid/Colorize, the value does not need to be 500 - it is arbitrary 
within z-homogenous/2D models)  

 Isolines OFF (the combination with streamline might be very interesting later, for 
know let it OFF)  

 Labels n/a (actually no preference)  

 Isosurface OFF  

 Streamlines active ON, eventually Tube-Radius=0 (memory demand), Start-At 
SPACE-BOUNDARY, Opaque ON, Solid ON, Colorize WHITE  

 Colorbar OFF (actually no preference)  

 Probe OFF  

 Axes OFF (actually no preference)  

 3D: View from TOP (The middle box-button at the right column) Perspective OFF 

http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm#2D Fall
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Allgemein.htm
http://help.antherm.eu/Forms/Result3DForm/Model.htm
http://help.antherm.eu/Forms/Result3DForm/Oberflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/SchnittXYZ.htm
http://help.antherm.eu/Forms/Result3DForm/Isolinien.htm
http://help.antherm.eu/Forms/Result3DForm/Isoflaeche.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/Farbskala.htm
http://help.antherm.eu/Forms/Result3DForm/Probe.htm
http://help.antherm.eu/Forms/Result3DForm/Achsen.htm
http://help.antherm.eu/Forms/Result3DForm/ThreeDee.htm
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(button not shown depressed)  
Now, within the Streamlines tab select the components edge by selecting the space by its 
name and set the number of intervals At initial view we advise you to turn the tube 
function of the streamline off (radius = 0) - the 3D representation of a tube has potentially 
very high complexity (millions of polygons!) and might result in very high demand on 
graphics memory. 
Collect Parameters (also 3D), eventually transfer it to "standard", adjust detail (right mouse 
button over the list of evaluation settings).  
Save the project (together with evaluation settings collected), standard setting will be 
saved automatically at application exit.  

 
 
 
 
 
 
 
 
 
 
 
 

http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm#Einstellung Merken
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Speichern...
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Modelling by dynamic overlapping of elements 
 

Finding helpful windows    

Start the application via the Start 
Menu→Programs→AnTherm→AnTherm. 

Preset primary editing windows of the application are exposed at their 
positions as saved at previous application run. The file projekt.xml, if it 
could be found within the application's folde, will be automatically 
loaded. 

Look at the window Element Browser. If that window 
is not visible, select the menu View→Primary Edit 
Windows or View→Windows→Elements. 

By using the menu View one can open or close any of the application 
windows.  
View→All Edit Windows will expose all application windows – this is the 
quick option allowing opening of ALL windows. It will open large 
number of windows, therefore we advise you to use more selective 
alternatives instead..  
View→Primary Edit Windows exposes only most important windows 
required for the input. Further windows, if required, will be opened 
within the current editing context via submenus or clicks/double clicks 
within primary windows.  
Window→Close All Windows will close all windows to cleanup the user 
interface – only the main application window remains open. 

Select the menu Window→Close All Windows. All windows, except the main window, will be closed. 

Select File→Load (or Help→Example Load) and look 
for the example file overlap.antherm within the 
example folder (Beispiele) of the distribution. 
Confirm your selection with Ok. 

The 3D model of the project will be shown within editing windows. 
Several primary windows will be opened. 

Within the Elements 2D window press the button Fit.  
 
Then, place the mouse pointer over the centre of the 
view within this window and turn the mouse wheel 
until the view of the slice shown fill 70% of the 
window. 

The display of the model is scaled (Zoom-In/Zoom-Out). 
  
Scaling is executed centred under the mouse pointer. This provides 
zoomed view of the region of interest or shrinking to show parts earlier 
outside of the window's area. 

    

Overlapping of elements   

After the example project overlap.antherm has been 
loaded, it will show an example containing two 
elements overlapping one another. The first element, 
here a SpaceBox, is overlapped by the second 
element, here the EmptyBox. 

By overlapping the elements in the order of their entry you 
automatically receive dynamic excavation of elements earlier in the list.  
 
The window Element Browser shows the list of elements – the order of 
elements within that list is significant for overlapping results!  
 
Within our example the SpaceBox is listed PRIOR to EmptyBox. 
Therefore the  SpaceBox (Element 1) is overlapped by the EmptyBox 
(Element 2), resulting in the excavation of the SpaceBox. 

Within the Element Browser window click (with left 
mouse button) onto the line listing the SpaceBox. 

A click onto the Element line in Element Browser the particular Element 
is marked selected – it is shown marked within the list.  
The edges of selected elements are shown emphasized within the 
Elements 2D- und Elements 3D- windows. 

Within Element Browser click onto EmptyBox. Now the EmptyBox is selected and shown emphasized.  
The way elements are displayed within graphical views (2D, 3D) 
depends on Element type and selected colour, whereas:  
EmptyBox is visible as an edge of the „empty area“ (within the 3D view 
EmtyBox-es are shown and visible only if selected)  
SpaceBox is shown overlaid by wave lines within 2D view, and within 3D 
view is is displayed partly transparent.  
The EmptyBox is used for excavation or to create cut-off planes. A 
metaphor of „vacuum“ without any form of heat transport might be 
helpful.  
A SpaceBox renders the idea of a space with defined temperature and 
the heat transport occurs only at the surfaces of modelled construction 
(MaterialBox-es) connected to that space. 

http://help.antherm.eu/Datei/Standard_projekt_xml.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Men%C3%BC%20Ansicht%20Dateneingabe
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Men%C3%BC%20Datei
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Men%C3%BC%20Hilfe
http://help.antherm.eu/Tutorials/index.htm#BeispielProjektdateien
http://help.antherm.eu/Forms/Elements2DForm/Elements2DForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm#Elementtype%20(Art/Type%20eines%20Elements)
http://help.antherm.eu/Forms/EditForm/EditForm.htm#Elementtype%20(Art/Type%20eines%20Elements)
http://help.antherm.eu/Introduction/30_Overlap.htm
http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm#Elementtype%20(Art/Type%20eines%20Elements)
http://help.antherm.eu/Forms/EditForm/EditForm.htm#Elementtype%20(Art/Type%20eines%20Elements)
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Changing the overlapping order   

Within the Element Browser window select the 
EmptyBox (by clicking on it) and then press the 
button Relegate to move the selected element (the 
EmptyBox in this example) one position back in the 
list. 

                           

By changing the order of elements with the element list different 
overlapping effect results.  
Because the EmptyBox is now placed prior to the SpaceBox within the 
list, the EmptyBox is overlapped now – the SpaceBox is visible in its 
original size and not excavated. 

Within the Element Browser window select the 
EmptyBox and then press the button Promote to 
move the selected element (the EmptyBox in our 
example) one position forward in the list. 

The original state of the project shall be now restored - the first 
element, the SpaceBox, is overlapped by the second element, the 
EmptyBox. 

  

http://help.antherm.eu/Introduction/30_Overlap.htm
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Various types of elements 
 
 
 

Within the Element Browser window double-click onto the 
EmptyBox to expose the Edit Window of the element 
(Element Editor). Position the Element Editor window upon 
to your needs. 
 
Remark: Select Help→Example Load and look for the 
example file overlap.antherm within the example folder 
(Beispiele) of the distribution. 

The window Element Editor is used to ender and modify 
properties of one element selected for editing.  
Following properties shall be entered:  
geometrical placement (the coordinates x1,x2,y1,…  
Element type:  
EmptyBox – a deletion element  
MaterialBox – an element filled with material  
PowerBox – a range covered by a power source  
SpaceBox – a room (filled with air of constant temperature) 
optionally: an assignment to a editing group(s)  
Die Thermal Conductivity (lambda) or Thermal Transfer 
Coefficient (alpha)  
optionally: colour for visualization (currently no images nor 
patterns can be defined)  
Name of a Space or of a Power Source 

Within Element Editor window change the y1 coordinate of 
the element EmptyBox from  11 to 9.  
To accomplish this click onto the input field y1, delete the 
content by using the Del and/or Backspace key and enter 9. 

If the data has not been confirmed yet by leaving the input field, 
the current input has no influence onto the modelled 
construction. 

Confirm entered data with the TAB key. The change will be visible immediately in all other windows. 

Rotate the 3D view by 90° to the left - click onto the 
window  Elements 3D and while holding the left mouse 
button pressed over the 3D view move the pointer to the 
left. 

In our example (project file "overlap") the EmptyBox extends out 
of the SpaceBox – we wont to change it now: 

Click onto the Element Editor window  (if the Element Editor 
window is obscured or hidden by other windows, double-
click onto the  EmptyBox within Element Browser). 

You can reveal and activate the Element Editor window by:  
a double click onto a element within Element Browser  
via a context menu Edit of the Element Browser - the menu is 
shown when the right mouse button is pressed. 

Within Element Editor use the TAB key to proceed to the 
input field z1 

By pressing the key TAB (or Shift-TAB) you move the input focus 
between the input and control elements of a window – not only 
input fields but switches and buttons also.  
The exact focus transfer and usage scenarios are described within 
the documentation of the windows operating system. 

For z1 enter 1, press TAB and for z2 enter 9. Press TAB. The change has been applied and made visible immediately in all 
other windows. 

Within the Type field select MaterialBox by choosing that 
type from the list (or make the selection with up- or down-
arrow key). 

The change has been applied and made visible immediately in all 
other windows. 
The MaterialBox is displayed as solid and opaque object.  
During the change of Type other input fields are renamed and 
activated for the input. The input fields of Lambda and Colour are 
active now. 

Press TAB key to focus onto the input filed Material Name 
and enter „Material XYZ“.  

The entry of material properties (Name, Thermal Conductivity, 
Representation Colour) can be provided directly within the 
Element Editor window.  
Alternatively you could pick material properties from the 
Material List also  – but within this tutorial we would like to focus 
on basic data entry methods at first. 

With the TAB key move on to the input field Lambda, enter 
1 and confirm the input with the TAB key. 

  

Change the Colour used to display the element - double-
click onto the rectangle next to the label Colour: . 

The standard windows' colour editor will be exposed. 

Select the Colour within the Colour window and confirm the 
choice with a click onto the Ok button. 

The change of the colour is immediately shown within the 
graphical view. 

    

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm#Elementtype (Art/Type eines Elements)
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/MainForm/MainMenu.htm#Menü Hilfe
http://help.antherm.eu/Tutorials/index.htm#BeispielProjektdateien
http://help.antherm.eu/Forms/EditForm/EditForm.htm#Elementtype (Art/Type eines Elements)
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm#Elementtype (Art/Type eines Elements)
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The Spaces (the boundary conditions)   

Within the Element browser window select the SpaceBox. 
Double-click onto the SpaceBox to expose the Element 
Editor window . 

  

In the input field Surface name enter „Exterior surface“. Analogically to materials the surfaces shall have different 
properties too.  
Akin to material's Thermal Conductivity the surface is described 
in terms of its Thermal Transfer Coefficient. 

Confirm the name entry with a TAB key and enter 10 into 
the input field Alpha. 

  

With the TAB key move to the field Space name and 
enter  „Exterior space“ . 

- one creates the list of the boundary conditions for the 
simulation All SpaceBoxes are consolidated by their space name 
to one space. Each such space will be assigned a value of 
temperature (the boundary conditions).  
With consistent assignment of space names – e.g. exterior, living 
room, kitchen, bath – or – e.g. Room 0, Room 1, …. 

Confirm the entry with the TAB key Changed data is reflected in all windows. 

 
 
 

http://help.antherm.eu/Forms/ElementBrowserForm/ElementBrowserForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm#Elementtype (Art/Type eines Elements)
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The order of elements - overlapping effects 
 

 

Within the Element Browser window click New with the 

mouse. 
A new, empty element will be created and appended to the list 
of elements. 
The Element Editor displays properties of the new element. It is 
an EmptyBox with zeroed dimensions (elements of zeroed 
dimensions have no effect within the model) 

Following the earlier description enter following data 
within Element Editor for the new element: 

 X1: 2, X2: 8 

 Y1: 2, Y2: 8 

 Z1: 2, Z2: 8 

 Type: SpaceBox 

 Surface name: Interior surface 

 Alpha: 10 

 Space name: Interior space 
 
and confirm the entry with the TAB key. 

The new element is enclosed by other elements. Due to the 
fact being the last element in the list it overlaps all other 
elements. 

Within the Element3D window switch the visualization 
from Solid to Wireframe by turning the switch Solid off. 

The wire frame representation within the 3D view allows us to 

see selected elements not being covered (obscured) by surfaces 
shown for solids. 

Within Element Browser click onto various elements and 
observe the changes to the selection display in graphical 
windows. 

 

Within Element Browser click onto the last element – it 
shall be the SpaceBox of the „Interior space" – to select 
that element. 

 

Within the Element Browser click several times onto the 
button Relegate - until the SpaceBox of the interior space 
has moved to the Front of the List. 

While changing the order of elements please observe the 
effects of overlapping within graphical views which 
significantly change being dependant on current sequence. 

Reorder elements to receive following final sequence: 
 

 Exterior space 

 Material 

 Interior space 
 

to create overlapping effect resembling the modelled 
construction by using Promote/Relegate command from 
the Element Browser. 

The element "Exterior space" encloses the rest, but it is 
overlapped (hollowed) by element following it in the list. 
Similarly the material element is hollowed by the interior space 
box. 

 

 
 

Why is overlapping/hollowing of elements done dynamically? Where is the gouge function. 
 

Many CAD application provide a static hollowing function (i.e. you select an element or a group of 3D objects and the 
application to gouge through them). Such hollowing operation result in extremely large number of oddments, normally much 
higher then the original number of elements. At the same time the original structure gets lost after such operation If the user 
decide, that the operation had undesired effect he can either repeat the data entry or must undo the whole operation. 
 
To compensate on that tree element structures are used often – each element, after being hollowed by other elements, 
brakes into a new branch holding all resulting oddments. As a result of many such operations a very deep tree structure is 
created which is very difficult to undo and, with very complex models, cannot be managed without additional, extensive and 
potentially very sophisticated tools. 
 
For the both reasons (unmanageable complexity at each further step, high learning costs, error-prone programming effort) 
we have decided to keep things simple within a simple, linear list and use the order of the list for dynamic hollowing 
providing same result at much less learning effort. 
 
Return to Tutorial Selection... 

http://help.antherm.eu/Tutorials/tutor01/60_Elementarten.htm
http://help.antherm.eu/Tutorials/index.htm
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Example images 
 

We have collected few pictures of evaluation results here. Large choice of images is available in the web. 
 
 
 
 
 
 
 
 

                                                                
 
 
 
 
 
 
 

                                                             
 
 
 
 
 
 
 
 
 

      

http://antherm.kornicki.com/


Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 9.136.1 
 
 

438 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 9.136.1 
 
 

439 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Handbook Thermal Bridge Heat Transfer and Vapour Diffusion Simulation - AnTherm - Version 6.115 – V 9.136.1 
 
 

440 
 

 
 
FAQ - frequently asked questions 
 

How to find and where to get the complete user documentation? Can it be downloaded? 
Complete user documentation is provided electronically and can be viewed by following means: 
directly within the program by choosing Main menü->Help->Help ; or 
 
by pressing the F1-Key on the Keyboard. This functionality is provided for each application window; or 
from the windows start menu. Therein choose "All programs->AnTherm" to get further option to open program 
documentation, tutorial and so on. 
 
The documentation browser (MS Help Viewer) can show table of contents and provides search functionality. There is also 
possibility to page forward and backwards sequentially through the documentation. The usage of the documentation 
browser shall be very intuitive and easy. There is also exhaustive documentation for this browser which can be reached via 
the menu "Help on Help". 
 
Separate documentation pages can be also printed. Printing of the whole documentation is currently not supported nor 
allowed by the copyright and the license terms. 
By choosing this (electronic) solution we are able to provide the most current documentation content to the user. 
Up to date online version can be found at http://help.antherm.eu/ . 
How much RAM memory does the software need? 
 
We recommend having 1 Gigabyte RAM or more installed, to be able to efficiently use versatile abilities of evaluation. We 
explicitly dissuade you from extensive use of virtual memory (paging file, swap-space). 
 
Memory requirements of AnTherm will double with VAPOR-option active (i.e. when AnTherm calculates the vapour diffusion 
solution and such results are included in the evaluation also) 
See also: System requirements 
 
Which operating systems can AnTherm be used on? 
 
AnTherm has been tested on various configuration of Windows-XP Professional, Windows Vista 32bit and 64bit, Windows 7 
32bit and 64bit. It shall also properly execute on MS Windows XP Home, Windows NT 4.0SP6, Windows 2000 with possible 
limitations . 
Microsoft .NET must be installed prior to installing AnTherm. 
 
This software cannot be used nor installed on Windows ME, Windows 98 or older. See also: System requirements. 
 
Why it is only possible to show and enter rectangular elements? How to deal with sloped boundaries? 
 
In this version you you use the part of the application which does only support input of rectangular or cubic elements. 
Boundaries of these elements must be parallel to coordinate axes. The limitation to work only with rectangles or cubes 
originates in the computational algorithms used. 
 
It is intended to provide sloped or curved input processing in some future version of the program. This future software 
component will dissolve such sloped boundaries into stepped lines. 
 
Currently you cannot process sloped or curved lines directly. To support the input of constructions with slopes or curvatures 
however, you must resolve such figures into stepped lines by turning to functionalities of typical CAD-programs. In such case 
you create DXF files which can be then imported via the CAD interface of AnTherm. 
 

 




http://help.antherm.eu/Forms/MainForm/MainMenu.htm
http://help.antherm.eu/
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Install/Systemvoraussetzungen.htm
http://help.antherm.eu/Datei/Import/DXF_Import.htm
http://help.antherm.eu/Datei/Import/DXF_Import.htm
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Modelling the construction component and Element Types 
 
Modelling of the construction component is done by input of elements. Boundaries created by intersections of such 
model elements are automatically created. 

 
Initial modelling space is filled with adiabatic condition. This initial condition is equivalent to an “Empty” element type 
of infinite dimensions. “Empty” elements can be also used to create additional adiabatic boundaries if required later 
in the resulting model. Intersection of material elements of a component results in creation of adiabatic boundaries 
thus no heat flow is possible through such boundary (for vapour diffusion an “Empty” means no vapour diffusion at 
the boundary at all). 

 
Modelling of thermal boundaries is done by placing “Space” type elements. Different spaces are distinguished by their 
names (text like “exterior”, “interior”, “room A” or “Bathroom”, “Loggia” etc.). Intersections of material elements with 
spaces create a surface boundary described by its thermal transfer coefficient and respective space name. Later on 
(during evaluation) spaces are assigned to real boundary conditions – in steady state case represented by the air 
temperature of that space (relative humidity is used also during vapour diffusion simulation). Varying of thermal 
transfer coefficient is done by entry of multiple space element with different surface property but still assigned the 
same space name (later assigned to temperature). 

 
Modelling the constructions themselves is done with “Material” elements described in terms of heat conductivity 
(vapour diffusion number µ is also used for vapour diffusion calculation). Intersection of material elements creates 
material boundaries. Intersection of material with space creates surface boundaries. Intersection of material with 
empty creates adiabatic boundary. 

 
There is also a term of “Power Source” elements defining extents producing or consuming heat (sources or sinks). 
Heat sources can only be applied to material thus telling that these regions produce/consume power. Different power 
sources are distinguished by their names (text like “heating coating”, “floor heating”, etc.). The interior of “Power 
Source” elements overlapping material create power source areas. Power sources are in that case different from other 
element types in that they overlap materials only, but they can still be overlapped by any other element type. Later on 
(during evaluation) power sources are assigned to real boundary conditions – in steady state (stationary) case 
represented by power density. 
 
How to Undo mistaken editing? 
Can undone action be redone? 
 
AnTherm keeps track of the editing sequence up to 1000 editing actions which can be easily undone to revert to the 
input state valid prior to the respective action. 
Actions Undone recently can be redone in the same order.  
Regardless of this powerful ability of the program you shall save your project data regularly. 

 
How to model decreasing transfer coefficient at corners? 
 
In the area of decreased transfer coefficient apply additional space element assigned to the same space name but 
with different surface property. Same applies at areas of increased transfer surfaces. 

 
Currently there is no means of automatically generate such areas.  
Best and easiest method is to copy the space of the required name, reduce its extents to the area of interest and 
apply the changed transfer coefficient to it (eventually also changing the name given to the surface) – but still 
keeping the space name unchanged. 
 
How to create adiabatic boundary? 
Initially, modelling space is automatically filled with adiabatic medium, thus any material element is placed within 

adiabatic boundary conditions at first. By entering space type elements you apply thermal conditions at 

intersections with materials. Use power source elements to mark areas of heat source/sink over materials. Placing 

“empty” elements creates adiabatic boundary at intersections with materials. 

 

Can AnTherm show heat stream lines? 
 

 
Yes. One can define a starting point from which the heat flow will be traced and shown as a stream line. Detailed 
description of this function can be found in chapters Results 3D and Stream lines. 

 
In 2-dimensional cases in particular multiple heat streamlines can be shown simultaneously.

http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/ElementsContextMenu/ElementsContextMenu.htm
http://help.antherm.eu/Introduction/40_Raum.htm
http://help.antherm.eu/Introduction/40_Raum.htm
http://help.antherm.eu/Forms/EditForm/EditForm.htm
http://help.antherm.eu/Forms/Result3DForm/Result3DForm.htm
http://help.antherm.eu/Forms/Result3DForm/Stromlinien.htm
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Important: Showing vector fields requires the calculation of the particular secondary function being turned on. 
Please check the state of the switch "secondary function" within the "General" tab and the name of the vector 
function chosen for evaluation also.  
If the respective function is not shown please check the application setting "Which Secondary Functions" if the right 
one is active also. 

 

 
How to show multiple heat streamlines in equidistant intervals of the heat stream from one space boundary in 2D 
case? 

 
Such an evaluation is only possible for 2D projects (actually for all such projects in which the construction is 
homogenous in the Z-directions and without space boundaries in this direction). You will be notified that such 
evaluation is possible or not within the control tab „Streamline“ of the Results 3D window. If the option „Start at: 
Space“ is disabled then this specific evaluation is not available in the context of supplied computational results of 
the calculated model. 

 
Because multiple streamlines will be drawn from (or in 2D case onto) the Z slice plane, this slice plane must be 
active (and also visible). Following recommended setting combination cab be used for quick initial display: 

 
 General: Perspective OFF (because only 2D), Bounding box OFF  
 Model: Model active OFF, Model slices: active OFF (later you can vary the visibility of model slices by varying 

Slice-Z, Streamline-Tube-Radius and Colour)  
 Surface: Surface active OFF (otherwise the interior, incl. streamlines, is obscured!), Edges OFF, Slice-Edges ON 

(or OFF), Slice Edges Colouring ON/BLACK/WHITE (up to your favour)  
 Slice X Active OFF (alls slices only needed for the streamline from the cross point of Slices X/Y/Z, otherwise only 

disturbing cross lines shown)  
 Slice Y Active OFF (see above)  
 Slice Z Active ON, Value 500; Opaque ON, Solid ON, Colouring ON (you can later vary 

Opaque/Solid/Coloured; Value need not be 500 - does not matter on Z-homogenous/2D-Modell)  
 Isolines OFF (later can try the combination of isolines and streamlines resulting in very interesting pictures)  
 Labels n/a (does not matter)  
 Isosurface OFF  
 Streamlines Active ON, ev. Tuberadius=0 (to save memory), Start-At SPACE, Opaque ON, Solid ON, 

Colouring WHITE 
 Colormap OFF (actually don't care)  
 Probe OFF  
 Axes OFF (actually don't care)  
 3D: View from TOP (right-middle box button) Perspective OFF (button not sunken) 

 
Now, within the tab "Streamline" you can choose the space boundary by its name and the number of intervals It is 
recommended to turn the tube streamline off (by setting the radius to zero) at the beginning because the3D 
representation of the tube is very complex and can cause high memory demands when drawing many millions of 
polygons! 

 

Can AnTherm show heat stream by vectors / arrows? 

 
Yes. Such visualization can be created by using the Vectors (Hedge-Hog) evaluation. 
 
Can AnTherm show traces of vapour transport? 

 
Yes. One can define a starting point from which the vapour diffusion flow will be traced and shown as a stream line. 
Detailed description of this function can be found in chapters Results 3D and Stream lines. 

 
In 2-dimensional cases in particular multiple vapour transport streamlines can be shown simultaneously. 

This evaluations are available only with the VAPOUR-Option of AnTherm. 
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Where to find harmonic thermal coupling coefficients? 
How to calculate the phase shift (time lag) due to dynamic heat capacity effects?  
Can AnTherm calculate dynamic, transient heat transport problems incl. heat capacity? 

 
Yes. In addition to solving the steady state thermal transport problem AnTherm can solve harmonic, periodic 
problems for arbitrary period lengths (typically one year and/or one day).  
AnTherm will output harmonic thermal coupling coefficients (also by their amplitude and the phase shift, time lag) 
calculated directly and independent from boundary conditions.  
With modelling periodic boundary conditions (fully automated Fourier analysis) time dependant evaluations are 
achieved - either a 3D view at some point in time, then available to creating time series animation, or timelines of 
temperature changing in time at selected location of the 3D model.  
Subject to the TRANSIENT / HARMONIC license option. 
 
Can AnTherm show isolines (isotherms)? 

 
Yes. AnTherm can display isolines of temperature (the isotherms), isolines of steam density magnitude (heat or 
vapour flux), isolines of dew point etc. at all construction surfaces. Isolines can also be displayed on slice planes 
cutting through the building construction.  
Detailed description can be found in chapters Results 3D and Isolines. 

 

Is there any validation, benchmarks of AnTherm? 
 
It is self-evident, that AnTherm is validated according to EN ISO 10211:2007 and therefore it qualifies as three 
dimensional precision method of "class A" according to this standard. The validation of AnTherm as conforming to 
the standard EN ISO 10077-2:2003 is also in place. 

 
Furthermore, methods and algorithms implemented in AnTherm are conformant with such standards as EN ISO 
6946, EN ISO 13788, EN ISO 13370 etc. 
 
Is it possible to change the automatically assigned colouring of material elements based on the value of thermal 
conductivity? 

 
Yes. By default AnTherm assigns colour to each material element based on its thermal conductance. Data is passed to 
the colour table which defines different colours for different intervals of thermal conductivity values. This colour 
table can be modified by the user. The user has to edit default colour table LambdaToColor.ColorList manually.  
On each change to element's thermal conductivity the program will automatically reassign the colour according to 
definitions provided in the above colour table.  
Furthermore, the user can assign any colour to any selective element manually overriding this automatic setting. 
When the coloured rectangle in the Element-Editor is double clicked the user is presented a colour chooser. It shall be 
noticed, that such explicit assignment of colour will be lost as soon as change to the thermal conductivity of that 
element is applied and automatic assignment will tale place again. 

 
This default behaviour of automated colour assignment by lambda can be turned off. 
See also: Element Editor, default colour table LambdaToColor.ColorList 

 
How to change the colour gamut of the temperature field? 
How to change colouring of isolines? 

 
Within the evaluation window "Results 3D" you will find a control panel "Colortable". Therein you can make 
modifications of the colour gamut. You can define the interval to be coloured and switch cropping of the chosen 
range. You can also choose different Colour table instead of the "Default" one.  
There is preconfigured Collection of standardized Colour tables included of which one can be selected but not 
customized. The chosen colour table applies to all "Evaluation functions" equally - there is no means of applying 
different colour tables to different functions selectively. Also displaying of more then one function during evaluation 
(temperature, heat flux, dew point values).  
See also: Results 3D window, Colortable (control panel), General (control panel) 
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Where to find the material catalogue? 

 
Exhaustive function of material catalogue can be found Material master data. 
Material data can also be merged from other AnTherm projects.  
You can create your own material list an (optionally) save it as projekt.xml. 
 
I can't enter values with decimal places! 
 
This is related to localisation settings of your operating system and your keyboard. 
Please read additional information about country specific localisation. 

 

How can I create a report containing graphical evaluations and adjust it to my needs? 

 
Reports created with the program can be saved PDF-, RTF-, XLS- or DOC-files. 3D displays can be copied to the 
clipboard, saved as Image file (PNG, JPG, GIF, TIF, BMP, ...) or even as complete "3D scene" saved in 3D scene file 
(VRML, IV, OOGL, ...). 

 
Please proceed with following steps: 
1. Create a 3D display in AnTherm and customize its representation according to your needs.  
2. Open the application commonly used by you to create reports (e.g. MS-Word ) optionally applying your personal 
templates, footnotes, headings a.s.o..  
3. Copy the Text from the project description to the clipboard (right mouse button, copy) and then transfer it into 
your report (right mouse button, paste).  
4. Copy the graphical 3D display to the clipboard (use the button Copy image) and transfer is into your report (right 
mouse button, paste). 

 
Where to find the calculated f

*
Rsi-values? 

 
Temperature factors f

*
Rsi are output in Results report. The calculation f

*
Rsi values assumes, that the coldest space 

represents exterior space. AnTherm searches and calculates coldest points on surfaces for all other spaces. This 
points are output in the Results report together with its coordinates, surface temperatures and corresponding f

*
Rsi-

values.  
See also: Temperature factor fRsi 
 
According to EN ISO 10077-2, when calculating the thermal conductance coefficient of a window profile, one 
needs two dimensional thermal conductance (Leitwert) L

2D
 in W/mK. AnTherm shows conductance matrix in 

W/K. Which length shall be applied in the division to get correct L
2D

 value? 
 

For a 2D project Antherm will report the thermal conductance values directly. AnTherm calculates two dimensional 
construction as homogenous in third dimension and having an extent of 1 meter. 
While within a 3D project you can calculate L

2D
 only if you take care of keeping the construction homogenous in one of 

the tree dimensions. Then divide by the thickness of the model in this direction - however we recommend to use 2D 
project to calculate L

2D
 only. 

 

 
In between the messages shown during the calculation (in Solver window) there is a message telling "error", but the 
computation continues and results are shown. Is there any error in construction entry? Can I trust the results? 

 
Under certain, rare circumstances, the solver will fire few "error/warning" messages. If the condition which led to such 
message has no influence onto calculation results the program will step further and continue with the computation. To 
keep things simple there are design measures taken, taking care to provide computational results if the construction 
input has no formal errors. If this is not the case the program will stop the calculation, show some diagnostic message 
and will not create any results at all.  
According to this workflow within calculation step one has to analyse such warning or error message from 

 
calculation step only if the program has not shown any results.. 
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How can I create a two dimensional model (2D project)? 

 
The "type of the project" is set up during creation of the project itself; choose: . File→New→2D/3D-Schichten/3D. A 
2D project can always be converted to 3D layered project. Upon your need one can convert a 3D layered project to 3D 
project. Converting of a three dimensional project to a 2D project is not always possible! 

 
During evaluation of 2D projects it is advised to reduce the analysis solely to Z slice plane - having turned 
perspective view off also. 
 
Does two dimension simulation result in correct results if it has been input in tree dimensions (i.e. as 3D 
project)? 
 

All results are correct and can be immediately used for further calculations if the thickness of the layer (in a layered 

3D project) is kept at 1000 mm, or, for a 3D project, all elements share the same Z dimension of 1000 mm. 

Please note, that in such case all elements of the conductance matrix have exactly same values as those of the 
length related conductance matrix. Only the unit of W/K has to be replaced with W/(m*K). 

 
Is it possible to view results on slices through the construction (to cut through)? 

 
Yes. Slicing (or cutting) through evaluation results is possible on slices parallel to axes planes - with the only 
exception to dew point values (those are defined on the construction's surface only). 
Follow following steps to get visualizations of sliced results: 

 
1. Within Results 3D view select the view direction you wish (either within 3D panel or from the view menu). 
2. Turn off the visibility of the Surface (or make it transparent) to see the interior of your model.  
2. Turn (optionally) the perspective off (in the view menu or in the panel General). 
3. Select one of the slice plane panels (x, y or z) and set the slice Position of your choice.  
4. Select the function which values shall be visualized. 
5. Now you can combine the display with isolines by turning them on and optionally making the slice surface  
transparent. 
6. You can combine the view further if you want. For example turn the model on. 

 

How to get the detailed view of the model construction? 

 
By activating the model edges line view within the 3D-View material boundaries can be shown on surface and/or 
slices.  
The solid view of the model can be shown as exploded parts by applying a shrink factor. 

 
How to transfer or combine, import, paste or insert an already entered constructions (e.g. a complex 
Isokorb) from other projects into the one currently processed? 

 
Preferred method of combining projects is by using the clipboard function of copy and paste. You will find them in 
the context menu of element editing. You can follow exemplary steps below: 

 
 Save the project which shall receive the other construction inserted.  
 Open the project containing the other component you want to reuse.  
 Select those (or all) elements you want to reuse in the other project (e.g. use the select function of the context 

menu). 
 Copy selected elements (the data of them) onto the clipboard.  
 Reopen the target project (the one you want to insert elements to).  
 Select the element after which the elements from the clipboard shall be inserted.  
 Paste elements of the construction on the clipboard into current project. All inserted elements will be 

automatically selected for further processing (for group assignment or position adjustments). 
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 Use editing functions to translate, rotate etc. to position the inserted component elements into its final place 

within your construction. 
 Save the project. 

 
How to create a 3D project from a DXF file (import)? 

 
Currently the import function from DXF file interprets such files as two dimensional drawings. By using element 
grouping latched on one of DXF attributes when importing the file it is possible interpret such element groups as 
layers of 3D-layered project and to process them accordingly. 

 
Use following process steps: 

1. Use one attribute to assign DXF objects to groups of 3D-layers (independently of the assignment of 
other attribute for the purpose of material identification).  

2. In the DXF import settings select that attribute for grouping  
3. The imported project (import always creates a 2D project) shall now be converted to a 3D layered 

project. After such import all elements will be located on the first layer. 
4. Create a new layer .  
5. Go to the first layer and select elements by group. Group names are taken based on the grouping 

import setting set during the import.  
6. By using the context menu function "Cut" place all selected elements on to the clipboard. This 

function will also remove the elements from the model, that these cut element are now only on the 
clipboard.  

7. Go to the new layer created above an by using the context menu function "Insert" paste elements 
from the clipboard to that new layer.  

8. Repeat steps 4. through 7. for all further groups until elements of each group have been moved to 
distinctive layers. 

9. Assign thickness to all layers properly.  
10. Save the project. 

 
How to calculate Psi-values with AnTherm? 

 
The Psi-Value Determination provides automatic calculation of the Psi-Value for a two dimensional (linear) thermal 
bridge. The calculation is based on the conductance matrix output by AnTherm and the U-Values output in Modelling 
Report for layered construct at adiabatic cut-off planes determined automatically. 

 
The additional tool "Psi-Value Calculator" allows quick calculation of linear correction factors for any arbitrary 
thermal bridge also. 

 
It shall also be considered, that the calculation of Psi-Value depends on the used one dimensional model and it is 
ambiguous. Furthermore, reasonable definition of Psi-Value applies to two space cases. 

 
Will future version of AnTherm calculate and output Chi-values also? 

 
Currently one can calculate Chi-Values by simple manual calculation based on the conductance matrix output by 
AnTherm automatically. However it is planned to provide a very simple tool for calculating Chi-Values automatically in 
the future. 

 
It shall also be considered, that the calculation of Chi-Value depends on the used one dimensional model and it is 
ambiguous. Furthermore, reasonable definition of Chi-Value applies to two space cases. 

 
The licensing procedure of this application requires a MAC address of physical network LAN adapter. How to 
discover the MAC address? 
 
Complete listing of all adapters available for licensing shall be found in the About window, output just beyond the 
licensing information. To otherwise retrieve MAC addresses of physical LAN adapter ne can use the tools of the 
operating system (e.g. by using a command "ipconfig /all"). Alternatively, there is a tool application installed along 
with AnTherm to its installation folder called „adaptersAddresses.exe“ which will show adapters available in your 
system suitable for license activation.  
Remark: As an alternative of binding the license to the computer by its network adapter (i.e. via 


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the MAC address) there is an activation option with a hardware dongle which adds mobility of the license between 
multiple computers. 
See also: License activation procedure. 

 

An exception message "SAFcdtsi crash" or "security exception SHA1" is shown. 

 
This exception is catch due to severe damage of the installation. It indicates possible damage to one or more 
binaries of the application components. You are notified not to use program's results for any purpose - under no 
circumstances. Caused by such severe error results could be in error too!  
Please report such conditions to the vendor. Analysis and sufficient measures shall be started immediately. Thank 
you! 
 
A message "CrystalReports.Engine.LoadSaveReportException" is shown instead of all reports. 
 
This exception is catch due to severe damage of the installation of the reports engine used. It indicates possible 
limitation of user rights to access application components. Typically this occurs if the software has been installed for 
exclusive use by one user and accessed from an account of some another user.  
To resolve the issue you are advised to install the software for all users instead for the one user only. Uninstalling 
and installing the software by the user with administrative right will be required.  
Advice: If the software shall be run by different user than the one who installed it, then the installation for all users 
must be chosen (the choice has to be done within the dialog while selecting the installation folder)! 

 
Reinstalling the Crystal Reports Runtime Components manually shall resolve the issue. 

 
On a computer without the drive C: a message "CrystalDecisions.Shared.CrystalReportsException: The report could 
not be loaded. ---> System.Runtime.InteropServices.COMException (0x80004005): The system cannot find the path 
specified" is shown instead of all reports.  
Manual reinstallation of Crystal Reports Runtime Components does not resolve the issue. 

 
This results from erroneous behaviour of Crystal Reports outside of our influence. Crystal Reports Runtime 
assumes the existence of drive C:. If that drive is not existent the above message will be shown - the Crystal 
Reports installer application sets registry values that point to the C drive. 

 
WORKAROUND 1: Create the drive C: (eg. set some USB Drive to C: within Disk Management). 

 
WORKAROUND 2: Use the following steps to change respective registry values in the Registry Editor. 
====================  
WARNING: The following resolution involves editing the registry. Using the Registry Editor incorrectly can cause 
serious problems that may require you to reinstall the Microsoft Windows operating system. Use the Registry Editor at 
your own risk.  
HELP: For information on how to edit the registry key, view the ‘Changing Keys And Values’ online Help topic in the 
Registry Editor (Regedit.exe).  
RECOMMENDATION: It is strongly recommended that you make a backup copy of the registry files (System.dat and 
User.dat on Win9x computers) before you edit the registry. 
====================  
1. On the ‘Start’ menu, click ‘Run’. 
2. In the ‘Run’ dialog box, type “Regedit” then click ‘OK’.  
3. In the Registry Editor browse to the following subkey: 
HKEY_LOCAL_MACHINE\SOFTWARE\Business Objects\10.5\Report Application  
Server\InProcServer\LocalConnectionMgr  
4. Right-click the ‘ConnectionDirectoryPath’ string value, then click ‘Modify’.  
5. In the ‘Value data’ text box, change “c:\” to the drive letter where the following directory exists (You may need to 
search your computer to find where this directory exists, i.e \Program Files\Common Files/Business Objects\2.8\bin)  
Click ‘OK’. 
If above does not fix the problem:  
6. Right-click the ‘LocalConnectionMgr’ subkey, click ‘New’ then click ‘String Value’. 
7. Name this String Value “ReportDirectoryPath”.  
8. Right-click the ‘ReportDirectoryPath’ string value and click ‘Modify’. 
9 In the ‘Value data’ text box, type the same drive letter as you typed in step 5.  
==================== 

 

http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Datei/Lizenzdatei.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
http://help.antherm.eu/Install/Installation_dotNET.htm
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NOTE:After making changes to the registry, restart the application as required. 

 

 

3D widows are empty or black  
or windows shown on top of 3D windows flash rapidly 
or 3D visualization is corrupt, incomplete or 3D-surfaces look distorted.  
An exception message "SEHException" in vtkWin32RenderWindowInteractor, InitializeVtk, 
vtkControl.OnCreateControl is shown. 

 
This exception is very rare, and there are some known conditions which can be worked around:  
On some graphics systems (graphics adapters, cards) the initialisation of 3D windows cannot be completed 
successfully if the setting of graphics acceleration of the operating system is active.  
We have seen such a conflict between 3D software components and the setting of the 2D acceleration on only few 
systems running Windows XP – symptoms shown where empty (black) 3D windows in AnTherm or even surprising 
crashes with no chance of reproducing the conditions. By turning the 2D acceleration of on these system all such 
symptoms disappeared then.  
Instruction: Go to the Windows control panel, then go to the setting of your graphics adapter (Display->Tab 
Settings->Advanced->Troubleshoot). The "acceleration" is set to highest by default. Try reducing the setting, or 
even turn it off. Then reboot the system prior to testing the condition with AnTherm again. 

 
Please report such and alike difficulties to the vendor too. Thank you! 

 

 
What shall be done if the program does not respond at all? 

 
At first please verify if you're not waiting for computation results to complete. There is either a message shown in the 
Solver window to inform you about the progress. Te computation can be stopped by pressing the Stop button. It the 
application is not responding for a longer period, please use the operating system's task manager to finish AnTherm as 
the last resort. The task manager can be reached by simultaneously pressing the keys Ctrl-Alt-Del. Shall such scenario 
occur repeatedly, then please do not hesitate to report this behaviour to us immediately. Please attach the specific 
AnTherm project file to allow further analysis. Thank you! 

 

 
How to backup complete simulation results of one project? 
How to find the folder of simulation results ? 

 
Intermediate results (simulation results) of each computation belonging to one project are stored to subfolder 
"<projectfile>.dir".  
To avoid accidental manipulation of these results AnTherm applies the hidden attribute to each such simulation results 
folder. By default such hidden objects are not shown within Windows file explorer; they are kept hidden from the 
user. Hidden file system objects are only shown if the setting "show hidden files" is tuned on in windows file explorer, 
thus also showing folders of simulation results created with AnTherm.  
The setting described above can be set in Windows Explorer by selecting the Menu Tools->Folder Options... from the 
tab View . Change the setting for Hidden files and folders. 

 
AnTherm creates hidden data (directories) in significant amounts. How 
does this data relate to AnTherm projects?  
How to remove simulation results folders when they are not needed anymore? 

 
Intermediate results (simulation results) of each computation belonging to one project are stored to subfolder 
"<projectfile>.dir". To avoid accidental manipulation of these results AnTherm applies the hidden attribute to each 
such simulation results folder.  
One can remove this data at any time because AnTherm can recreate this data (recalculate) from project's 
information if needed. 

 
To ease the consistent removal process there is a Tool "Simulation Folders Cleanup" available to the user. 

 
On my notebook only one side of slice planes is coloured, the other side is displayed in black (notebook with 
Intel HD Graphics, Windows XP). 

 

http://help.antherm.eu/Forms/WaebcomForm/WaebcomForm.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Datei/ArbeitenMitDateien.htm
http://help.antherm.eu/Forms/SolutionFolderCleanerForm/SolutionFolderCleanerForm.htm
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This is related to the OpenGL implementation of the graphics card and combination of system settings 
- the FrontFace-Property is not automatically propagated to BackFace-Property (which is not set and 
by that defaults to FrontFace). 

 
WORKAROUND: Within Application Settings please turn on the Extended 
OpenGL Setting "ExplicitBackfaceProperty" (slight performance loss can be 
eventually observed). 

 
After overwriting the activation file AnTherm.HID in the installation folder AnTherm still uses 
the earlier version of the file.  
Replacing the activation file AnTherm.HID within installation folder has no effect to AnTherm. 

 
The preferred method of activation is by placing the file AnTherm.HID into any user folder and setting 
the path to that file within the application setting "alternative license file AnTherm.HID". On computers 
running Vista overwriting the activation file with new content is protected by the file virtualization 
enforced on system folders automatically. Therefore the activation by copying the file AnTherm.HID 
into the installation folder is effective only once on these systems.  
See also: License activation procedure. 






See also: Short reference 

 

http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
http://help.antherm.eu/Forms/ApplicationSettingsForm/ApplicationSettingsForm.htm
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